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Chapter 1
Accessing ClientSpace System Administration
System administration of the ClientSpace system is limited to global administrators. Navigation to the
System Administration area is described as Go to System Admin. This means that from the modules
bar, you select your username, and then select System Admin.

Note: Out of the box, you are not given access to the Advanced system settings. To gain Advanced
Administration access, please create an Extranet case.

Administrative Dashboard

To access the administrative area of ClientSpace:
1. Click your username in the top right corner of the ClientSpace window. EX: developer
2. Click System Admin .

The System Administration dashboard opens. The Advanced system settings box is located in the
bottom right corner.
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Advanced Administration Functions
Advanced Administrative functions require an Advanced Administrator License. Help topics that discuss
Advanced Administration are labeled with .

To configure any of the Advanced system settings:
1. Near the lower portion of the dashboard, locate Advanced.

The Advanced area provides a list of advanced system settings: API Configuration, App Settings
(only available to PrismHR users), Configure Import, Custom Links, Dataform Admin, Field Audit
Scripting, Manage Field Display, Manage Rules, Reports, Scheduled Processes, Tables, Templates,
Third Party Applications, and Time Tracker Categories.
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2. Select an option.
The selected option opens.

Note: Access to Templates requires Internet Explorer. App Settings is only available to
User Developers.

Advanced Administration Training
While the Help Center contains several topics on Advanced Administration Configuration (which we
have referenced in the list below), Advanced Administration training is required to gain access to this
part of the system. In Advanced Administration training, you receive hands on training where you can
ask questions and receive specific guidance as you learn. The training consists of eight (8) one-hour
training sessions. We can set up the sessions to go at your speed. For example, two sessions per week,
one session per week, etc. Anyone from your company is welcome to join!

In Advanced Administration training you will learn how to:

l Create, move, edit, and delete your own dataforms and dataform fields.
Also see Adding a dataform and Adding Dataform Fields.

l Set up your own business rules.
Also see Configuring Rules and Business Logic.

l Add and remove dataform links such as Complete or In Progress.
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Also see Configuring Custom Dataform Links .
l Configure Field Display rules to hide and show fields when certain conditions are met.

Also see Configuring Dynamic Field Display.
l Create and update your own imports.

Some possible use cases might be to import all default hours spent on every case type or to
create your own form and auto-populate the fields from a spreadsheet you use.
Also see Importing data and CSV Import File Creation Macro.

l Learn how to review your scheduled processes.
For instance, review how often ad-hoc reports are sent or how long it takes an email template to
send emails.

These are just some of the topics we'll cover!

System Administration dashboard
The System Administration dashboard is where global administrators perform actions such as
configuring workflow channels, setting up email templates, and assigning roles.

Advanced Administration
Additional functionality for System Administration is available in the Advanced section. Entries are
Advanced Administration and require additional ClientSpace licensing. Advanced Administration topics
are labeled with .
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Follow the links to learn more about Advanced Administration:

• API Configuration: APIs are used in ClientSpace to connect one software system to another to
facilitate the transfer of data between the two systems. ClientSpace Help offers topics about
configuring APIs. See APIs and Configuring the API.

• App Settings: Configure your organization ClientSpace settings to include communications
(configure how the default admin email setting is used throughout the application), system, and
Business Intelligence. For assistance with App Settings, please log a case in the Extranet.

• Configure Import: Configuring import data. See Configuring nightly imports .
• Custom links: Configured links improve the user experience by making related dataforms, reports,

and workflow available from dataforms. See Configuring Custom Dataform Links .
• Dataform Admin: Dataforms are your workspace building blocks. See Dataforms .
• Manage Rules: You can configure business rules on the Client Processing Team dataform so when

a Service Team is selected, the Client Team various roles auto-populate. See Configuring Rules and
Business Logic.

Ensuring ClientSpace email is delivered to your domain
Many of the ClientSpace systems generate emails – Calendar events, Client Service Case, and Task
notifications are among the most frequent email generators. To ensure these auto-generated emails do
not get interpreted as spam, you should authorize the ClientSpace system as a valid sender of mail for
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your domain. There are many ways to do this, but the simplest and most foolproof are one or a
combination of the following methods. Each mail and DNS system can be radically different, so this
topic provides an overview of suggested steps you should take but is not meant to provide step-by-
step instructions on how to perform these actions. Your network or IT Administrator will most likely
perform the following changes.

To authorize ClientSpace for mail in your domain, do one or more of the following:

1. Add the ClientSpace Server IP or hostname to your email system unrestricted list.
n An unrestricted list allows emails from a source, such as ClientSpace, into your email Inbox.

The procedure for adding trusted email addresses to your unrestricted list varies across the
different email clients and internet security platforms.

2. Utilize SPF records in your company DNS servers to authorize the ClientSpace Server IP or
hostname as valid for your domain mail.
n An SPF Record is simply a DNS Record published for a domain that dictates which servers

are allowed to send mail on behalf of that domain. When a mail server receives a message,
it looks up the DNS record from domain to determine if the server sending the message is
published in the SPF record. If the sending server is not in the published SPF record, the
message fails. There are a number of free SPF generators available. Research the phrase
"SPF generator." There are also a number of sites for checking the validity of the SPF record
you create. These sites should be utilized by an administrator in your environment familiar
with DNS and its configuration.

n The generated DNS record for the domain should look similar to the following, but should
be customized based on how your network utilizes DNS : v=spf1 mx
a:mail.clientspace.net ~all

For questions about the IP address of your ClientSpace server for mail authorization, please log an
Extranet case.

ClientSpace FAQs
Some questions keep coming up again and again, look here to find some of the most frequently asked
questions.

Administrative FAQs
• Best practices for standard imports
• Common import errors
• How to find your installed ClientSpace version. See the ClientSpace User Guide.
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• Importing the Comp Code Master records
• Configuring Organization and Workspace Security

Issue resolution FAQs
• pwPermissionViolation when accessing linked dataform. See Application troubleshooting.
• SendMail or other scheduled process does not appear to be working. See Administration

troubleshooting.

Technical FAQs
• ClientSpace security tips
• CSV Import File Creation Macro
• Outlook add-in disables each time Outlook restarts. See Outlook add-in and modules issues.

How to FAQs
• Configuring lookups
• Configuring Dynamic Field Display
• Configuring the PrismHR API for Initial Imports
• Configuring Rules and Business Logic
• Configuring security in Business Intelligence reporting
• Configuring task fields
• Configuring Dynamic Field Display

Finding the basics of Dataform management and
ClientSpace configuration
So, you wake up one day and realize that you are the ClientSpace expert at your company. With your
new found awesome powers comes awesome responsibility - feeling lost? These articles cover the
basics of dataform management and ClientSpace configuration.

Dataforms
• Configuring lookups
• Adding tabbed dataforms to a parent form
• Configuring Dynamic Field Display
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• Configuring field display with multiple values
• Configuring Custom Dataform Links
• Configuring parent form datatypes
• Configuring Rules and Business Logic
• Configuring the Zip Code datatype
• Dataform field naming standards
• Changing the Number of Decimal Places on a Dataform Field
• Dataforms
• Distributing your dataform: Making dataforms accessible
• Parent form datatype morphing
• Required Field Business Rules
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Chapter 2
Email Templates: Basic Configuration
Email Templates enable ClientSpace administrators to configure automated messages that trigger on
specific conditions. Email Templates provide an incredibly powerful method to automate emails. One
way to use them is to detect and prevent fraud attempts when someone changes critical information,
such as direct deposit numbers or email addresses.

Email Templates can produce a multitude of notifications, including:

• Messaging and branding.
• Notifying dynamic recipients, such as internal team members, worksite employees, and contacts.
• Triggering from fields on ClientSpace tables and dataforms, and data changes in PrismHR.
• Data from ClientSpace forms.
• Data imported from PrismHR.
• Data from process triggers, such as onboarding a new client.
• Calendar events.
• Emails to employees when changes occur to critical information, such as direct deposit account

number, address, status, type, social security number, pay rate, and work or personal email.

Configuring Email Templates
Email templates enable ClientSpace administrators to configure automated messages that trigger on
specific conditions. Configuring email templates guides you through a five-step procedure: Initial,
Content, Addresses, Step 4: Conditions, and Attachments.

This topic gets you started. After you click Add, follow the procedures to complete the five-step
process.
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To get started:

1. Go to System Admin > Email Templates.
The Email Templates dashboard opens showing a list of published Email Templates.

2. To configure an existing email template, locate the template in the list and click (Open). Follow
the steps in the following topics.

3. To configure an email template, click Add.
The Choose Email Template Type dialog opens with options to select Real Time or Scheduled.

4. Select an Email Template Type.
The Add Email Template workflow is presented, with a series of steps to start generating your new
template.

5. What do you want to do?

• If you selected Scheduled, refer toConfiguring Scheduled Email Templates for assistance
creating a Scheduled Email Template.

• Otherwise, continue to the next step for setting up a Real Time template: Step 1: Initial.

Step 1: Initial
The Add Email Template workflow opens. In Step1, you provide detail information about your template.
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To begin Step 1:

1. Complete the form fields.

Type For Email notifications:
l Select Email. Default value.

Triggering Form Your selection in the Triggering Form field is the dataform or table where
the trigger resides (a field change, a value change). The change to the
dataform or table is what triggers the email. Triggering Form is used
synonymously with a database table or a dataform1.
To add a dataform that is not in the list:

1. In the Triggering Form field, go to the end of the list and select
Add Untriggered Form.
The Select an Untriggered Form dialog box opens. Table Name
contains a list of all dataforms currently not marked as Triggerable.

2. In Table Name, select a dataform from the list.
3. Click Ok.

The selected dataform is marked as triggerable and now appears in the
Triggering Form list.

Template Code Must be unique and should be related to the purpose of the email
template.

Template Name Provide a short, descriptive name for your template. Displays in the email
template list.

Description Provide a useful description of the email template.

Execute On Will this email be sent the first time the form is saved (Insert), only when
the form is changed (Update), or every time (Insert or Update)? When
there are changes to the dataform that you selected in Triggering Form,
the Execute On value controls triggering for Insert, Update, or both Insert
and Update.

1Dataforms dynamically create and manage configurable data collection points. When you add a data-
form, a new table is added to the database. Dataforms enable workflow systemization.
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Merge Procedure Select an optional Merge Procedure here to provide additional system
information for field replacement. The procedure can be selected from
any stored procedure in the system with a name containing
emailtemplate_merge_proc.
Merge Procedure1 also determines the fields that are available to use in
field replacement.

Execution Pipeline Email templates can support multiple pipelines2 using a multi-select. This
allows you to create a single email template that can apply to multiple
execution pipelines. Select the pipelines on which the email triggering is
to occur.

Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new email template, pipelines
assigned a behavior of Default will auto-fill the Execution Pipeline field.
If you are editing an existing email template, Execution Pipeline entries
remain intact until edited. Changed entries are validated against the
Pipeline Linking table. For instance, if a pipeline has been assigned a
behavior of Allow or Default and you remove it, you will still be able to
select it from the Execution Pipeline list. If the same pipeline is assigned
a behavior of Disallow, you will not be able to add it again.

See Configuring Pipeline Linking.

Workspace Templates Select the Workspace Templates3 to receive this email.

Include as Activity Select this option to attach the email as an Activity. When the email is
triggered, the email message attaches to the triggering record. This
action preserves the communication of the sent email. By default, the
option is cleared, meaning do not include the email as an activity.
If you select this option and the email template includes an attachment,
the system uploads any attachments to the activity when it is created..

2. Click Next to proceed to Step 2: Content.

1A Merge Procedure is a piece of prepared SQL code that can be reused over and over again.
2A pipleline determines which rules are applied when the data is saved.
3Workspace Templates are special workspaces used for cloning during the Workspace creation process.
In this way, ClientSpace allows you to set up multiple workspace configurations (such as an industry-
specific Workspaces with a specific, limited list of TOC items) then choose how you want the workspace
to look and feel by selecting the appropriate template during workspace creation.
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Step 2: Content
In the Content step, you provide a Subject and Body – the email message. You can insert information
using replacement fields from the See Replace Fields link.

To configure the content of the email:

1. In Subject, provide the subject of the email to be generated.
2. In Body, provide the email message.

Body uses a rich text editor and supports font styling, embedded images, hyperlinks, lists, and
tables. For best results, we recommend embedding .jpg or .jpeg images.

3. To use field replacement, click See Replace Fields.
You can paste items in Subject and Body as applicable. See Replacement Fields.

Field replacement includes:
l Any active fields on the triggering dataform
l The active fields from the tabbed dataforms related to the triggering form (any child forms of

the parent dataform)
l When you select Task as the Triggering Form in Step 1 Initial, Task fields are available for field

replacement

ClientSpace Setup & Administration © 2025 PrismHR 41

Chapter 2 Email Templates: Basic Configuration



l The active fields from the related Organization and Org Other Info
l Any fields returned by the Server Data Procs related to the triggering dataform

4. Click Next to proceed to Step 3: Addresses.

Step 3: Addresses
This step defines who the email is from, who will receive it, and any CC recipients. You can use a custom
stored procedure to include email addresses from system objects other than the triggering form. By
default, the system excludes the current user who triggers the email. In Source, you can select Current
User to ensure that user receives an email.

To configure recipients:
1. Complete the form fields.

Address
Source
Procedure

Select a stored procedure (optional) that generates data to provide additional
recipient email addresses. Select from any stored procedure in the system with a
name containing emailtemplate_recipient_proc. The recipient proc list only displays
valid options based on the Triggering Form in Step 1.

Include
Dataform
Subscribe
rs as CC

Adds anyone who has subscribed to the dataform as CC recipients when this
notification is sent in addition to any other recipients you configure here. When
enabled (selected), this option presents a list to notify internal, external, or both
recipient types:

ClientSpace Setup & Administration © 2025 PrismHR 42

Chapter 2 Email Templates: Basic Configuration



Recipients • Internal: When the email template triggers, only internal dataform subscribers are
notified.

• External: When the email template triggers, only external dataform subscribers
are notified.

• Both: If you select Both or leave the field blank, all dataform subscribers are
notified.

Note: If you select this option, use the {RecipientsCC} replacement field in the Body
of the message on Step 2: Content when you want to include the email address of
the CC recipient(s) in the email message. See Step 2: Content.

From
Address

Select the From Address for the email. You can set this field to the email of the default
admin user, a specific user, or from a field on a form.

This field defaults to Admin Email Address, which is the application administrator's
email address. This is the default admin email set in System Admin > Advanced > App
Settings. Only User Developers can change this email address.

To select from a distinct set of options:

1. Click the link Admin Email Address.
The From Address Options dialog box opens.
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2. Select one of the following options:
n Admin Email: Uses the default admin email set in System Admin

> Advanced > App Settings. Only User Developers can change this
email address. For assistance with App Setting, please log an Extranet
case.

n Current User: Uses the address of the user who is triggering the
notification.
Note: Current User is not available if you are creating a Scheduled Email
Template. This option only works with Real Time field analysis to
determine the current user.

n AdHoc: Allows you to manually add to the From list by simply typing the
email address. Additionally, you can specify a friendly name to accompany
the email address. For more details about using AdHoc, see Specifying a
friendly name as From Address.
Note: If you select the AdHoc email address option and enter a
ClientSpace user's email address as a recipient, if the Enable Email for
this account field on their user profile is unchecked, they cannot receive
emails from ClientSpace and will therefore not receive the email
generated from this template. Note that only a Global Administrator can
change this setting.Also see Personalizing Your User Profile.

n User: Select a specific user of the system.
n Procedure: Select an address stored procedure and pick the From

address.
n Field on a Form: Select a dataform from a list of forms in the system that

have relevant email fields. You can set user fields to values that exist on
dataforms across a tabbed set. If the selected user fields are empty, the
default value is the system admin. For more details, review the following
section From a Field on a Form.

3. When done, click Ok.

2. To add a new recipient record to this notification, click Add.
A new row opens for Source, Type, and Address. Each recipient's source, type, and address must be
unique.

3. Complete the fields:
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Source Source is where you select the source of your recipient email addresses or
user contacts. When you select a source from the list, then any available
email addresses or user contacts are available in the Address column.
Recipient Source options are:

l The triggering dataform
selected in Step 1 Initial. In
the example, the
Triggering Form is
Employee.

l Single dataforms that exist
in workspaces with either
email fields or user fields.

l Tabbed dataforms that are
children of the triggering
dataform. The tabbed
dataforms (child forms)
appear immediately after
the triggering form in the
Source list and are
preceded by a dash (–).
The Source list includes all
tabbed dataforms included

in the tabbed set.
l Adhoc Email Address: When you select as Source, type the email

address in the Address field.
l Employee: When you select Employee, you can specify Employee

Work or Personal Email address in Address. See Specifying Employee
Work and Personal Email.

l Address Source Procedure: An email address selected from the
Address Source Procedure. The email addresses appear in Address if a
proc with email fields has been selected in the Address Source
Procedure field.

l Current User: Includes the logged in user who triggers an email
template. By default, the system excludes the current user who triggers
an email template.
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Type What kind of email recipient type are you setting? Options are To or CC.

Note: Use the {RecipientsTO} and {RecipientsCC} replacement fields in
the Body of the message on Step 2: Content when you want to include
the email addresses of the TO and CC recipients in the email message. See
Step 2: Content.

Address • For a dataform source, select the user or contact type field on the form
from which you would like to extract the email address.

• When Source is Address Source Procedure, select a recipient type
such as AdminEmail, CaseSubscribers, CaseTypeRoleUsers,
ImmediateSupervisor, EmployeePersonalEmail, EmployeeWorkEmail,
ReportedByEEPersonalEmail, or ReportedByEEWorkEmail.

Note: Recipient type options may vary depending on the selected
Address Source Procedure.

• When Source is Adhoc Email Address, use this field to type an email
address to use every time manually.

4. Click Next to proceed to Step 4: Conditions.

From a Field on a Form

From the From Address Options dialog box, when you select From a Field on a Form, you can set user
fields to values that exist on dataforms across a tabbed set. You can choose from which Dataform and
then when you select a dataform, choose the Field. The Dataform drives the items in the Field list that
you choose. The user fields include any child forms in a tabbed relationship. The child form has an
asterisk in the name, as in *Form One -- F1 User(F1User).
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Specifying Employee Work and Personal Email

You can use the email address fields on the Employee dataform as recipient options for Email
Templates. You must select Employee as the Source for the Work Email and Personal Email fields to be
available in the Address column.

Using an Address Source Procedure can make the Employee Work and Personal Email addresses
available when the Triggering Form (selected in Step 1 Initial) is not Employee. For more details, see
Configuring email templates to notify external employees. If you have questions, please log an Extranet
case.
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To specify Employee Work or Personal Email addresses:
1. Click Add.

A row opens for Source, Type, and Address.

Source Select Employee to enable the Work and Personal Email in the Address
column.

Type What kind of email recipient type are you setting? Options are To or CC.

Address Select Work Email or Personal Email.

2. To add more recipients, click Add.
3. When complete, click Next.

Specifying a friendly name as From Address

In Step 3 Addresses, you can specify an optional friendly name to display when the From Address uses
AdHoc for Email Address Source. This makes it less likely that recipients will view the email as spam.
When you select the AdHoc option, specify the Email Address and a From Friendly Name. The friendly
name displays in the email along with the actual email address.

Note: If you select the AdHoc email address option and enter a ClientSpace user's email address as
a recipient, if the Enable Email for this account field on their user profile is unchecked, they
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cannot receive emails from ClientSpace and will therefore not receive the email generated from this
template.

Note that only a Global Administrator can change this setting.

Also see Personalizing Your User Profile.

For example, let's say you want the friendly name to be your organization name and a function or
department, such as PrismHR Support, along with support@prismhr.com as the actual email
address. The email recipient would see:

PrismHR Support <support@prismhr.com>

To specify a friendly name:

1. In the Email Template wizard, go to Step 3 Addresses.
2. On From Address, select the Admin Email Address link.

The From Address Options dialog box opens.

3. Select AdHoc and complete the form:

Email Address Enter the from email address. This is the actual email address, such as
support@prismhr.com.
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From Friendly Name Enter the friendly name that you want users to see, such as
PrismHR Support.

4. Click Ok.
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Step 4: Conditions
Conditions determine how and when the email notification triggers. You can configure display
conditions (in the Add section), and you can use the display conditions in the Condition Expression
field. When the Condition Expression field is empty, the display conditions process as ORs. In the
example, the Condition Expression examines 1 and 2. Both conditions must be met. Without the
Condition Expression, the display conditions process as 1 or 2. Only one of the conditions must be met.
For a detailed explanation about conditions, see the topic Condition Expressions.

The following procedures guide you through configuring conditions. You can clone conditions and also
set up a condition based on the number of days, months, or years from a date.

To configure conditions:

1. Complete the fields:
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No Primary Trigger When selected, no single condition must be met to trigger the email
template. When selected, the Primary Trigger Field is disabled.

Only Trigger Once When selected, the email template is triggered only once when the
conditions are first met. Do not select this option if you want the email
template to trigger each time the conditions are met.

Primary Trigger Field Optional. From the Triggering Form selected in Step 1, which, when
changed, triggers the event. This can also be a HdrAction, such as a
configured action link on the form.

The following statements refer to the condition entries in the Add area.
Condition entries are identified with a Label (the last column).
• If a Primary Trigger Field is selected, that field MUST change values to

trigger this template and evaluate the conditions.
• If a Primary Trigger Field is not selected, only the conditions are

evaluated.
• If a Primary Trigger Field is selected, the conditions are combined

with the Primary Trigger Field using an implied AND.
• If no Condition Expression is used, the additional conditions are

treated as OR conditions.
The Primary Trigger Field only displays fields associated with the
triggering dataform and includes the ability to Add Untriggered Field.

To add display conditions:

2. Click Add.
A row opens with columns Source, Field, Operator, Value, and Label. The Add section is where you
can add more granular triggering conditions. Each row you add is a display condition. When
Condition Expression is empty, the display conditions process as ORs, meaning only one of the
conditions must be met for the email notification to trigger.

Source The Source list includes the triggering form and its tabs, the channel trigger
(i.e., the original form that started the channel), all triggerable, active single-
forms, and the tabs of those single-forms. Applicable server data procs, if
configured, may also be included.

When you select Task as the Triggering Form in Step 1 Initial, in this step
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Source sets to Task.

Field Select the dataform or Stored Procedure
field to compare to the trigger value.
A few notes:
l Email Template triggering provides

multi-lookup fields (Multi Lookup
(MultiLookup)) as triggering conditions.

l Field supports parent form fields.
Available operators are Empty, Not
Empty, and Is Dirty.
Note: If you are creating a Scheduled
Email Template, the Is Dirty operator is
not in the list as real time analysis of a
field is required to determine an "Is
Dirty" state.

l Field supports the Active dataform setting. Available operators are
Does Not Equal, Equals, and Is Dirty (if choosing the triggering form as
the Source). Value options are Unchecked and Checked.
Note: If you are creating a Scheduled Email Template, the Is Dirty
operator is not in the list as real time analysis of a field is required to
determine an "Is Dirty" state.

l You can Add Untriggered Fields dynamically as well as current, active,
triggerable fields from the Source.

l When you select Task as the Triggering Form in Step 1 Initial, the
options for Field include all task fields. For example, when you select
Send Notification, and this option is enabled in the Task, then the email
notification is triggered.

To add a trigger field:

1. In Field, go to the end of the list and select Add Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as Triggerable.

2. In Field, select an entry.
3. Click Ok.
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The selected field is marked as triggerable and now appears in the Field
list.

Operator Choose the type of comparison. Each value from a Multi Lookup Trigger Field
can be added as a separate "=" condition. This supports complex AND, OR,
and NOT conditions as well.

Note:

l Is Dirty is not available in the Operator list when the Source is set to
something other than the Triggering Form.

l If you are creating a Scheduled Email Template, the Is Dirty operator is
not in the list as real time analysis of a field is required to determine an
"Is Dirty" state.

Value The criteria against which the trigger field is compared. For a condition that is
using a user datatype as the Field, the Value field uses a typeahead1 method
so that you do not need to look up the User ID for the text field.

Label The label to use when constructing Condition Expressions for triggering.
ClientSpace assigns a label to a new condition with the naming convention C#.
For example, C1 for the first condition that you create, C2 for the second, and
so on. You can change the label name by selecting the name of the label and
typing a new name for the label. For example, you can select the C1 label and
enter Condition1 as the new label name.

Tip: Make this label short and representative of the Trigger Field. Labels are
used in the Condition Expression field.

Condition
Expression

Allows for AND, OR, and NOT conditions using the trigger conditions (Label)
from the Add section. Using the Label field that corresponds to the entries in
the Add section, you can combine the conditions into more complex
expressions. The Condition Expression field could state, for example
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR
Condition5. Condition Expressions adhere to AND/OR/NOT across tabbed
dataform conditions. For a detailed explanation about conditions, see
Condition expressions.

When the Condition Expression field is empty, the row entries are treated
as OR conditions. Only one of the conditions must be met.

1As you type in the field, one or more matches for the term are found and immediately presented.
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To clone a trigger condition:
To save some time, you can clone a trigger condition and then edit as appropriate.

1. In the Add section, locate an entry that you want to copy.

2. Click Clone.
A new row opens, with the trigger condition copied. Source, Field, and Operator are copied.

3. You can now edit the new condition as appropriate.
4. Click Apply or Save.

To trigger conditions based on number of days/months/years from a date:

3. Complete the form fields:

Field Select a Date or Date Time datatype field. This action makes the Aging
operators available in Operator.
Note: When comparing Date to Date Time datatypes (or vice versa)
12:00:00AM is used as the comparison time for the Date datatype.

Operator Select one of the following:
l Aging (from now) > =

o Greater than or equal to the number of days/months/years in
Value.

l Aging (from now) < =
o Less than or equal to the number of days/months/years in

Value.
The less than operator requires that the evaluated date occurs between
the calculated date and today. It has to be between the date set in the
configuration. For example, if the value is 6d, the from date must be
between 6 days ahead and today.
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Value Type a number accompanied by:
l mm: for minutes
l h: for hours
l d: for days
l m: for months
l y: for years

4. Click Apply or Save.

Putting it all together
The following example illustrates three conditions named 1, 2, and 3. The Condition Expression is (1
and 2) OR 3. The OR indicates that only one data point must be met. For an aging evaluation, this
condition expression is looking for a date that is greater than 3 days and less than 12 days. Or, a date
that is greater than 5 days.

5. Click Next to proceed to Step 5: Attachments.

Condition Expressions

Condition expressions are used in email templates, workflow channels, widget layouts, and custom
links. Condition expressions are used to control when an event or action is triggered.

Condition Expressions use Labels from Display Conditions along with AND, OR, and NOT operators to
control precedence and sequence.

• The AND operator specifies that all specified conditions must be met for a query to return true. The
AND is exclusive. AND narrows a search by telling the database that all keywords used must be
found.

• The OR operator specifies that if one of two or more conditions is met, then the query is true. The
OR only needs one data point to be present. OR broadens a search by telling the database that any
of the words it connects are acceptable.
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• The NOT operator allows you to exclude items that are not relevant to your search. NOT narrows
your search by telling the database to eliminate all terms that follow it.

AND expressions

AND expressions are used when you want to include all conditions. For example, consider an expression
that specifies that the month must be January and the day of the week must be a Monday (January
AND Monday). This expression specifies that all data points must be present; it is exclusive.

OR expressions

OR expressions are used when you want to find an overlap between items. For example, (January OR
Monday) specifies that the day could be in January or could be a Monday of any month. This
expression specifies that any data point can be present and is inclusive.

NOT expressions

NOT expressions are used when you are interested in a very specific list by letting you eliminate items
that are not relevant. For example, (January NOT Monday) specifies that the day could be in January but
cannot be a Monday.

Where to start

The first step in creating Condition Expressions is to determine your objective. A good place to start is
with a flowchart using Yes and No logic. Determine the fields and values and whether the condition is
to meet all conditions or just one data point. Next, determine how you want to group the criteria. You
then must add the conditions (from within a form) and then determine how to group them using
Condition Expressions. The remaining portion of this topic describes and illustrates how to compose
Condition Expressions.

Before you can build a condition expression, you must first add the conditions from within a form such
as Configure Data Links Details.

1. Add Display Conditions

For forms that offer conditions, when you click Add (lower portion of the form), a row opens where you
can assign values to within fields such as Source, Field, Operator, Value, and Label (see the following
image). The values must correspond to what is stored in the database. For example, lookups would be
the Code value, and for parent form fields, such as Case Type, the value would be the ID of the form.

The following example illustrates two expressions, HOL1 and HOL2. These entries are Display
Conditions. When the Condition Expression field is empty, the Display Conditions are processed as
ORs. For example, in the following example, there is no Condition Expression. Therefore, HOL1 and
HOL2 are processed as ORs. The result would be the match for each condition; it would be all-inclusive
(WHERE Holiday Name = Christmas OR Holiday Name = New Year's Day).
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2. Add a condition expression

But what if you want to treat the Display Condition statements differently? What if OR is not enough?
You can use a Condition Expression by referencing the display condition statements (through Labels)
and adding the AND and OR operators: (Cond1 AND Cond2) OR (Cond3). With a Condition Expression,
you can control how many conditions you use and how they are used.

When building a Condition Expression, you use the condition Label value of the Display Conditions. You
can create complex conditions by using unique combinations of the conditions. Condition Expressions
can use AND as well as OR conditions.

For example, to trigger a workflow when there is a new training request, the expression could be stated
as (CaseTypeTR AND CaseNEW) where:

• CaseTypeTR: When case type = Training Request
• CaseNew: When case status = New
Using the Label field, you can combine trigger conditions into more complex expressions. For example:
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR Condition5.

The following example has three Display Conditions: STAT, CITY, GEN. Two of the three Labels are used
in the Condition Expression.

• The (STAT AND CITY) Condition Expression is looking for employees who are married and reside in
Sarasota. This result is exclusive.

• When the three separate conditions (STAT, CITY, GEN) are used without a Condition Expression, the
search is for employees who are married, or reside in Sarasota, or are female. The result is inclusive.

Continue to the next topic, Order of operation.
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Order of operation

The order of execution can significantly affect the resulting value. To control order and precedence you
use parentheses to group functions. Everything within the parentheses is evaluated first to yield a single
value before that value can be used by any operator outside the parentheses. If an expression has
nested parentheses, the most deeply nested expression is evaluated first.

When a condition is met, the evaluation ends, using the results of the first successful condition. For 
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR Condition5, if the first set 
(Condition1 AND Condition2) is met, then the remaining OR statements are ignored.

Note: You can only use Labels and the AND, NOT, and OR operators in your Condition Expression.
The Condition Expression cannot contain SQL keywords.

Condition expression example
The following example illustrates multiple expressions for filtering attributes of a physical property
(structure) and user rights:

• Is the property owner-occupied?
• Is the property located in one of the following states: Georgia, Alabama, Arizona?
• Is the property height in the number of stories greater than or equal to 5?
• Does the user have the security entity named biz_RequestTypeCategory_Envornmental?

Example
Each expression Label is brief and descriptive: OO, GA, AL, SECenv, 5PLUS, AZ. 

Type Description Label

FieldValueExpression gen_Property.OwnerOccupied Equals Yes OO

FieldValueExpression gen_Property.State Equals GA GA

FieldValueExpression gen_Property.State Equals AL AL

SecurityEntity Security Entity Equals biz_RequestTypeCategory_Environmental SECenv

FieldValueExpression gen_Property.NumOfStories Greater Than or Equal 5 5PLUS

FieldValueExpression gen_Property.State2 Equals AZ AZ

Condition expression example
The Labels are used in the Condition Expression along with the AND and OR operators. Additionally,
grouping and nesting control the evaluation.
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The following example has two major groupings delineated by sets of parentheses. Within each major
group, there is a sub-group, also delineated by a set of parentheses.

(OO AND (GA OR AL)) OR (SECenv AND (5PLUS AND AZ))

First group - the AND Parentheses and
groupings

The first grouping has two sets of parentheses: 
• The first group specifies owner-occupied as OO. You need a set of

parentheses for OO. Sub-groups are placed inside the parentheses of
the major group.

(OO AND (GA OR AL))

• Within the owner-occupied group, the location must be GA or AL. You
need a second set of parentheses for the locations GA and AL.

(OO AND (GA OR AL))

Second group - the OR

The second grouping has two sets of parentheses:
• The first group is SECenv. You need a set of parentheses for this major

group.

(SECenv AND (5PLUS
AND AZ))

• The second group is the number of stories and location. Place the sub-
group within a set of parentheses.

(SECenv AND (5PLUS
AND AZ))
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The following diagram explains how the sample condition expression is evaluated.

Result
For the expression (OO AND (GA OR AL)) OR (SECenv AND (5PLUS AND AZ))

• If the property is owner-occupied and is located in Georgia or Alabama, then the evaluation ends
because the condition has been met. The OR portion is ignored.

• However, if there are no properties that are owner-occupied in either Georgia or Alabama, then the
OR expression is evaluated. The OR portion looks for:
• user view rights to RequestTypeCategory_Environmental
• and the property must be in Arizona with a minimum height of 5 stories
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Summary
The examples provided in this topic use nested groupings along with the AND and OR operators. Keep
in mind that your needs may vary. Additionally, plan ahead. Determine your Display Conditions and use
brief Labels. After you have defined your Display Conditions, then you are ready to compose the
Condition Expression.

Step 5: Attachments
At this step, you can add attachments to the email template for all recipients. When you add
attachments to System email templates with a prefix CSCRPLY (Case Discussion Replies), the
attachment is available to all recipients. For example, you might have a template named
CSCRPLYPayrollProblem for a generic payroll form that an employee or manager must complete.
Attaching the form to the template saves time and streamlines the process.

To complete the Attachments step:

1. Click Add to begin adding the attachments.
A row opens with Dataform and Field.

Dataform Select the dataform from with the attachment will be copied.

Field Select the Field from the dataform.

2. To add static attachments, from the right pane, click Attachments > Upload File.
The Upload File dialog box opens.

3. Click Choose File.
File Explorer opens.
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4. Locate the file and click Open.
You are returned to the Upload File dialog box.

5. Optionally, you can provide Description, Category, and Tags information.
6. Click Save.
7. Click Finish to complete your email template configuration.

Continue to the next topic, What's next.

What's next
What's next in configuring Email Templates?

1. When you click Finish, you receive a prompt "This email template is currently unpublished. Would
you like to publish?"
• Yes: returns you to the Email Templates list, with the Published view. Your new email template is

displayed in the Published list at the bottom.
• No: returns you to the Email Templates list. You can view your unpublished item by toggling the

Status chiclet to Unpublished.

2. To publish your unpublished email template, select the Published option. See Viewing and
publishing email templates.

3. To unpublish a template, from the Email Templates list, clear the Published option.
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4. Click Search to refresh the list.

Learning how: Email Template Overview

Video

View the video about Using Email Templates in ClientSpace.

Sending notifications using tabbed dataforms
Tabbed dataforms comprise a parent (home form) and child forms, which are extensions of the parent.
Here is an example of the Employee dataform with four tabs: Employee Benefits, Employee 401k,
COBRA, and State Continuation. This is a tabbed set of dataforms.

When sending notifications using email templates, you have options to include fields from a tabbed set:

• On the Addresses step
• On the Conditions step

On the Addresses step
On the Addresses step, when adding a new address in the Source list, the recipient source can be:

• The triggering dataform selected in Step 1 Initial
• Tabbed dataforms that are children of the triggering dataform
• Ad-Hoc email address that you type in the Address field
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• Or an email address selected from the Address Source Procedure. This option only appears if an
Address Source Procedure has been selected.

Tabbed dataforms

In the Source column, when a tabbed dataform is selected, the Address field displays a selector for user
and email type fields that are on the dataform from the tabbed set. The Source list includes all tabbed
forms included in the tabbed set. The tabbed dataforms appear immediately after the triggering form
in the list and are preceded by a dash (–). The example shows -Form One, which is a child dataform of
the parent, Tony Test Form.

On the Conditions step
Items in the Add section denote more granular triggering conditions. For Field Source, you can choose
all active child dataforms included in the tabbed set when the triggering form (Table Name selected in
Step 1 Initial) is the parent form.

In the example, Employee is the parent form. The child forms display immediately after the parent. The
child dataform names are prepended with a dash (–): -Employee Benefits, -Employee 401k, -
COBRA, -State Continuation.
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Viewing and publishing email templates
Email templates can be viewed and published by global administrators.

To view email templates:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. From the Email Templates list, you can do the following:

Action Description

Add To add an email template, click Add. See Configuring Email Templates.

Details To view details about an email template, click Details.

Delete To delete the selected email template, click Delete.

Clone To clone an email template, click Clone.

Publish and Unpublish When selected, the Published column indicates the email template is
published.
• To unpublish the email template, clear the Published option.
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Action Description

• To publish an unpublished email template, select the Published
option.

View Published and
Unpublished Email
Templates 

By default, the Status chiclet is set to Published.
To toggle the Status:

1. Click the Status chiclet Published.
The More dialog opens.

2. Select a Status: All, Published, Unpublished.
3. Click Search.

The Email Templates list is displayed according to your selection.
Unpublished email templates are displayed in italics and bold.
Published entries display as normal and have the Published column
selected.

4. You can also click the X beside Status Published.
This action displays all email templates: published and unpublished.

5. To reset the view back to Published, click Reset.

Sending task notifications through Email Templates
System administrators can produce task notifications through email templates, enabling flexibility for
messaging and branding. These email templates are System email templates. Task notifications include
System Email Template with the code value INCIDENT. If the INCIDENT template does not exist,
ClientSpace uses the original notification style. For emails generated from the INCIDENT template, the
Email Admin dashboard displays TaskSystemEmailTemplate in the Source column (otherwise displays
Task).

Note: If the logged in user is a notify user on the task, ClientSpace will not send an email notification
to that user, but will notify other users: Owner, Assigned To, and Subscribers of the task.

System Email Templates include:
l The System Email Template for Incidents contains the Task Comments field (The Comments field

is not included in the fields that changed list).
l On creation of a new Task, the Updated By User replace field populates.
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Note: By default, ClientSpace provides an INCIDENT Email Template.

To create a System Email Template for task notifications:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Click Add.

The Add Email Template form opens.
3. Complete the form.

For Type, select System.

Type For Task Notifications:
l Select System.

For Case Discussion Replies:
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l Select System.
For system-level templates. Use System to configure Case
Discussion Replies. This type is designed for dataform and system
notifications. When System is selected, additional fields are
enabled, and the workflow steps are not displayed.

o Subject line of the email generated by this template.
Available when the type is System.

o Body is used to generate the body of the email. Use the rich
text controls for formatting items such as font and
background color. Field replacement can also be used to
insert application data. Available when the type is System.

Template Code Type code is INCIDENT.

Template Name Provide a short, descriptive name for your template. Displays in the email
template list.

Description Provide a useful description of the email template.

Execute On Will this email be sent the first time the form is saved (Insert), only when
the form is changed (Update), or every time (Insert or Update)? When
there are changes to the dataform that you selected in Triggering Form,
the Execute On value controls triggering for Insert, Update, or both Insert
and Update.

Merge Procedure Select an optional Merge Procedure here to provide additional system
information for field replacement. The procedure can be selected from
any stored procedure in the system with a name containing
emailtemplate_merge_proc.
Merge Procedure1 also determines the fields that are available to use in
field replacement.

Workspace Templates Select the Workspace Templates2 to receive this email.

1A Merge Procedure is a piece of prepared SQL code that can be reused over and over again.
2Workspace Templates are special workspaces used for cloning during the Workspace creation process.
In this way, ClientSpace allows you to set up multiple workspace configurations (such as an industry-
specific Workspaces with a specific, limited list of TOC items) then choose how you want the workspace
to look and feel by selecting the appropriate template during workspace creation.
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4. Click Save.

Adding attachments
Email Templates can have attachments that are included with the email when it is sent. Email Templates
can have two different attachments:

• Attach file using a file field on a dataform. If there is a file housed in the dataform field, then you can
attach the file.

• Attach a desktop file from the Attachment panel, using Upload File after the template is saved.

To add an attachment from a dataform:
1. While adding an Email Template, in Step 5 Attachments, click Add.
2. Select the Dataform from which the attachment will be copied.
3. Select the Field from the dataform selected previously that holds the attachment to be copied.
4. Click Finish to complete your email template configuration.

To add an attachment to a saved email template:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens showing a list of published Email Templates.
2. Open an Email Template.
3. Expand the Attachments panel (on the right).
4. Click Upload File.

The Upload File dialog box opens.
5. Click Choose File.

The Open dialog box opens.
6. Locate and select the file and click Open.

You are returned to the Upload File dialog, with the file name displayed in File.
7. Click Save.
The selected file now displays in the Attachments panel.

Attaching Activities from Email Templates
You can attach email messages sent from a trigger on a dataform as Activities. The email message
attaches at the time the email triggers and is attached to the triggering record.
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To attach Activities:

1. Open an email template.
2. On the Initial step, select the option Include as Activity.

3. Click Save.

The email message attaches at the time the email triggers. The email message is attached to the
triggering record and appears in the Activities panel, in the Action Center.

If you select the Include as Activity option and the email template includes an attachment, the system
uploads any attachments to the activity when it is created..

Triggering Email Templates from Tasks
System administrators can trigger email templates from saved tasks. This functionality enables system
admins to control the conditions by tailoring the task email templates. For example, you might
configure an email template for any updates to a Task and a separate email template for when a Task is
marked as closed.

When you set Triggering Form to Task:

• Task and associated fields are available for field replacement in Step 2 Content.
• Task and associated fields are available from Step 4 Conditions for use as triggering conditions.
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Step 1 Initial
This is the detail information of your email template. When the Triggering Form for an Email Template
is Task, ClientSpace does not expose the Include as Activity option in Step 1 because you cannot add
Activities to Tasks.

To trigger an email from a Task:
1. Complete the form fields:

Type For Email notifications:
l Select Email. Default value.

Triggering Form Select Task.
Your selection in the Triggering Form field is the dataform or table where
the trigger resides (a field change, a value change). The change to the
dataform or table is what triggers the email. Triggering Form is used
synonymously with a database table or a dataform1.

1Dataforms dynamically create and manage configurable data collection points. When you add a data-
form, a new table is added to the database. Dataforms enable workflow systemization.
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When you set Triggering Form to Task, this action makes any associated
Task fields available on Step 4 Conditions for use as triggering conditions.
Task and associated fields are also available for field replacement.

Template Code Must be unique and should be related to the purpose of the email
template.

Template Name Provide a short, descriptive name for your template. Displays in the email
template list.

Description Provide a useful description of the email template.

Execute On Will this email be sent the first time the form is saved (Insert), only when
the form is changed (Update), or every time (Insert or Update)? When
there are changes to the dataform that you selected in Triggering Form,
the Execute On value controls triggering for Insert, Update, or both Insert
and Update.

Merge Procedure Select an optional Merge Procedure here to provide additional system
information for field replacement. The procedure can be selected from
any stored procedure in the system with a name containing
emailtemplate_merge_proc.
Merge Procedure1 also determines the fields that are available to use in
field replacement.

Execution Pipeline Email templates can support multiple pipelines2 using a multi-select. This
allows you to create a single email template that can apply to multiple
execution pipelines. Select the pipelines on which the email triggering is
to occur.

Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new email template, pipelines
assigned a behavior of Default will auto-fill the Execution Pipeline field.
If you are editing an existing email template, Execution Pipeline entries
remain intact until edited. Changed entries are validated against the
Pipeline Linking table. For instance, if a pipeline has been assigned a
behavior of Allow or Default and you remove it, you will still be able to
select it from the Execution Pipeline list. If the same pipeline is assigned

1A Merge Procedure is a piece of prepared SQL code that can be reused over and over again.
2A pipleline determines which rules are applied when the data is saved.
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a behavior of Disallow, you will not be able to add it again.

See Configuring Pipeline Linking.

Workspace Templates Select the Workspace Templates1 to receive this email.

2. Click Next to proceed to Step 2 Content.

Step 2 Content
This is the content of the email template. To include contextual field information from a Task, (your
Triggering Form in Step 1), you can use replacement fields.

To configure the content of the email:
1. Provide a Subject line of the email to be generated.
2. Provide the email message in the Body.

This field uses a rich text editor and supports font styling, embedded images, hyperlinks, and so on.

1Workspace Templates are special workspaces used for cloning during the Workspace creation process.
In this way, ClientSpace allows you to set up multiple workspace configurations (such as an industry-
specific Workspaces with a specific, limited list of TOC items) then choose how you want the workspace
to look and feel by selecting the appropriate template during workspace creation.
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3. Click See Replace Fields to select items to copy to the clipboard.
You can paste items in Subject and Body as applicable. See Replacement Fields.

Field replacement includes:
• When you select Task as the Triggering Form in Step 1 Initial, Task fields are available for field

replacement
• The active fields from the related Organization and Org Other Info
• Any fields returned by the Server Data Procs related to the triggering dataform

4. Click Next to proceed to Step 3 Addresses.

Step 3 Addresses
In this step you define who the email is from, who it will be sent to, and any CC recipients. The available
options on this step are controlled by the Triggering Form. When the Triggering Form is Task (Step 1
Initial), then Source options are Adhoc Email Address and Task. Anyone who is currently marked as a
Notification user on the triggering Task, is included as a subscriber.

To configure Addresses:
1. Complete the form fields:

From Address This field is set to Current User. For Task, only the person performing the
action displays as the task From Address.
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Include Task
Subscribers as CC
Recipients

When this option is selected, it includes anyone who is currently marked as
a Notification user on the triggering Task.

2. To add Addresses, click Add.
A row opens to add recipients to the notification.

Source The Source list includes:
• Ad-Hoc Email Address: When you select this option, type an email

address in the Address column.

Note: If you select the AdHoc email address option and enter a
ClientSpace user's email address as a recipient, if the Enable Email for
this account field on their user profile is unchecked, they cannot
receive emails from ClientSpace and will therefore not receive the email
generated from this template.

Note that only a Global Administrator can change this setting.

Also see Personalizing Your User Profile.

• Task: When you select this option, User fields are available for selection
in the Address column, such Assigned To.

Type What kind of email recipient type are you setting? Options are To or CC.

Address Use this field to manually type an email address to use every time.

3. Click Next to proceed to Step 4 Conditions.

Step 4 Conditions
In this step you can specify Task fields in the Field column. When Task is the Triggering Form (from Step
1 Initial), Source is set to Task. Available options for Field are any of the Task fields.
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To add conditions:
1. Complete the form fields:

No
Primary
Trigger

When selected, no single condition must be met to trigger the email template. If this
field is selected, the Primary Trigger Field is disabled.

Primary
Trigger
Field

Optional field (from the Triggering Form selected in Step 1), which, when changed
triggers the event. The following statements refer to the condition entries in the Add
area. Condition entries are identified with a Label (the last column).
l If a Primary Trigger Field is selected, that field MUST change values to trigger

this template and evaluate the conditions.
l If a Primary Trigger Field is not selected, only the conditions are evaluated.
l If a Primary Trigger Field is selected, the conditions are combined with the

Primary Trigger Field using an implied AND.
l If no Condition Expression is used, the additional conditions are treated as OR

conditions.
Primary Trigger Field options for tasks include:
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l Assigned To l Priority
l Body l Stage
l Category l Start Date Source
l Comments l Subject
l Due Date Source l Status
l fkIncidentTemplateTriggerID l Type
l Owner l HdrAction

Condition
Expressio
n

Condition Expressions use Labels from the display conditions along with AND, OR, and
NOT operators to control precedence and sequence. The Add section is where you can
add more granular triggering conditions. Entries in this section are called display
conditions. If the Condition Expression field is empty, then the entries under Add are
treated as OR conditions. 
Allows for AND, OR, and NOT conditions using the display conditions (Label) from the
Add section. Using the Label field that corresponds to the entries in the Add section,
you can combine the conditions into more complex expressions. The Condition
Expression field could state, for example (Condition1 AND Condition2) OR (Condition3
AND Condition4) OR Condition5.

Condition Expressions adhere to AND/OR/NOT across tabbed dataform conditions.
For a detailed explanation about conditions, see Condition expressions.

Source When you select Task as the Triggering Form in Step 1 Initial, Source is set to Task.

Field When you select Task as the Triggering Form in Step 1 Initial, the options for Field
include all task fields.
Note: When the Primary Trigger Field is HdrAction, select HdrAction instead of a
field name here. You can select the name of the HdrAction link in the Value field as
shown in the example below.
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Operator Choose the type of comparison. Each value from a multi-lookup Field can be added as
a separate "=" condition. This supports complex AND, OR, and NOT conditions as well.

Value The criteria against which the trigger field is compared. The Value corresponds to the
Field of the Task. For example, if you select Assigned To for Field, then select a user for
the Value.

Label The label to use when constructing Condition Expressions for triggering. Make this
label short and representative of the Field. Labels are used in the Condition Expression
field.

2. Click Next to proceed to the next step.

Step 5 Attachments
You can add attachments at this step to be included with each copy of the email sent. Static
attachments can be included through the Attachments panel. Recipients receive any attachments
added from the Attachment panel when the template is triggered.
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To complete the Attachments step:
1. Click Add to begin adding the attachments.
2. Select the Dataform from which the attachment will be copied.
3. Select the Field from the dataform selected previously that holds the dataform to be copied.

A panel displays on the right for adding attachments.
4. To add static attachments, click Attachments and (Upload File).

The Upload File dialog box opens.
5. Click Choose File to locate the file.
6. Click Save.
7. Click Finish to complete your email template configuration.

Triggering Email Templates from Org fields
System administrators can trigger an Email Template from fields on the Org record. Organization is
available for triggering as:

l Triggering Form: Can select Organization as the Triggering Form.
l Field replacement: Contains Organization field level information (with proper field

configuration)
l Fields as Primary Trigger Condition
l Fields as additional Conditions

Note: Before configuring an email template from the Organization, please log an Extranet case to
ensure proper table setup is in place.

When you set Triggering Form to Organization:
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l Associated fields are available for field replacement in Step 2 Content.
l Associated fields are available for recipient assignment on Step 3 Addresses.
l Associated fields are available for Field in Step 4 Conditions for use s Primary triggers (field has

changed) or as additional triggering conditions and support complex Condition expressions (with
proper field configuration).

Step 1 Initial
In Step 1, you provide detail information for your email template.

To trigger an email from Organization fields:
1. Complete the form fields:

Type For Email notifications:
l Select Email. Default value.

Triggering Form Select Organization.
Your selection in the Triggering Form field is the dataform or table where

ClientSpace Setup & Administration © 2025 PrismHR 81

Chapter 2 Email Templates: Basic Configuration



dataform1.

Template Code Must be unique and should be related to the purpose of the email
template.

Template Name Provide a short, descriptive name for your template. Displays in the email
template list.

Description Provide a useful description of the email template.

Execute On Will this email be sent the first time the form is saved (Insert), only when
the form is changed (Update), or every time (Insert or Update)? When
there are changes to the dataform that you selected in Triggering Form,
the Execute On value controls triggering for Insert, Update, or both Insert
and Update.

Merge Procedure Select an optional Merge Procedure here to provide additional system
information for field replacement. The procedure can be selected from
any stored procedure in the system with a name containing
emailtemplate_merge_proc.
Merge Procedure2 also determines the fields that are available to use in
field replacement.

Execution Pipeline Email templates can support multiple pipelines3 using a multi-select. This
allows you to create a single email template that can apply to multiple
execution pipelines. Select the pipelines on which the email triggering is
to occur.

Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new email template, pipelines
assigned a behavior of Default will auto-fill the Execution Pipeline field.
If you are editing an existing email template, Execution Pipeline entries
remain intact until edited. Changed entries are validated against the
Pipeline Linking table. For instance, if a pipeline has been assigned a
behavior of Allow or Default and you remove it, you will still be able to
select it from the Execution Pipeline list. If the same pipeline is assigned

1Dataforms dynamically create and manage configurable data collection points. When you add a data-
form, a new table is added to the database. Dataforms enable workflow systemization.
2A Merge Procedure is a piece of prepared SQL code that can be reused over and over again.
3A pipleline determines which rules are applied when the data is saved.
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a behavior of Disallow, you will not be able to add it again.

See Configuring Pipeline Linking.

Workspace Templates Select the Workspace Templates1 to receive this email.

Include as Activity Select this option to attach the email as an Activity. When the email is
triggered, the email message attaches to the triggering record. This
action preserves the communication of the sent email. By default, the
option is cleared, meaning do not include the email as an activity.
If you select this option and the email template includes an attachment,
the system uploads any attachments to the activity when it is created..

2. Click Next to proceed to Step 2 Content.

Step 2 Content
In this step, you provide the content of the email template. To include contextual field information from
an Organization, (your Triggering Form in Step 1), you can use replacement fields.

1Workspace Templates are special workspaces used for cloning during the Workspace creation process.
In this way, ClientSpace allows you to set up multiple workspace configurations (such as an industry-
specific Workspaces with a specific, limited list of TOC items) then choose how you want the workspace
to look and feel by selecting the appropriate template during workspace creation.
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To configure the content of the email:
1. Provide a Subject line of the email to be generated.
2. Provide the email message in the Body.

This field uses a rich text editor and supports functions, such as font styling, embedded images, and
hyperlinks.

3. Click See Replace Fields to select items to copy to the clipboard.
You can paste items in Subject and Body as applicable. Field replacement includes the active fields
from the related Organization and Org Other Info. See Replacement Fields.

4. Click Next to proceed to Step 3 Addresses.

Step 3 Addresses
In this step, you define who the email is from, who it will be sent to, and any CC recipients. The
Triggering Form controls the available options on this step. When the Triggering Form is Organization
(Step 1 Initial), then Source options are Adhoc Email Address and Organization.
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To configure Addresses:
1. Complete the form fields:

Field Description

From Address This field is set to Current User.

2. To add Addresses, click Add.
A row opens to add recipients to the notification.

Source The Source list includes:
• Adhoc Email Address: When you select this option, type an email

address in the Address column.

Note: If you select the AdHoc email address option and enter a
ClientSpace user's email address as a recipient, if the Enable Email for
this account field on their user profile is unchecked, they cannot
receive emails from ClientSpace and will therefore not receive the email
generated from this template.

Note that only a Global Administrator can change this setting.

Also see Personalizing Your User Profile.

• Organization: When you select Organization, user fields become
available in the Address column.
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Type What kind of email recipient type are you setting? Options are To or CC.

Address • When Source is Adhoc Email Address, use this field to type an email
address to use every time.

• When Source is Organization, select a user field.

3. Click Next to proceed to Step 4 Conditions.

Step 4 Conditions
In this step, you can specify Organization fields as the trigger fields. When Organization is the
Triggering Form (from Step 1 Initial), Source is set to Organization. Available options for Field are any of
the Organization fields.

To add conditions:
1. Complete the form fields:

No Primary Trigger When selected, no single condition must be met to trigger the email
template. If this field is selected, the Primary Trigger Field is disabled.

Primary Trigger Field Optional field (from the Triggering Form selected in Step 1), which, when
changed, triggers the event. The following statements refer to the
condition entries in the Add area. Condition entries are identified with a
Label (the last column).
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• If a Primary Trigger Field is selected, that field MUST change values to
trigger this template and evaluate the conditions.

• If a Primary Trigger Field is not selected, only the conditions are
evaluated.

• If a Primary Trigger Field is selected, the conditions are combined
with the Primary Trigger Field using an implied AND.

• If no Condition Expression is used, the additional conditions are
treated as OR conditions.

Condition Expression Condition Expressions use Labels from the display conditions along with
AND, OR, and NOT operators to control precedence and sequence. The
Add section is where you can add more granular triggering conditions.
Entries in this section are called display conditions. If the Condition
Expression field is empty, then the entries under Add are treated as OR
conditions. 
Allows for AND, OR, and NOT conditions using the display conditions
(Label) from the Add section. Using the Label field that corresponds to
the entries in the Add section, you can combine the conditions into more
complex expressions. The Condition Expression field could state, for
example (Condition1 AND Condition2) OR (Condition3 AND Condition4)
OR Condition5.

Condition Expressions adhere to AND/OR/NOT across tabbed dataform
conditions. For a detailed explanation about conditions, see Condition
expressions.

Source When you select Organization as the Triggering Form in Step 1 Initial,
Source is set to Organization.

Field When you select Organization as the Triggering Form in Step 1 Initial,
the options for Field include all Organization fields.

Operator Choose the type of comparison. Each value from a multi-lookup Field can
be added as a separate "=" condition. This supports complex AND, OR,
and NOT conditions as well.

Value The criteria against which the trigger field is compared. The Value
corresponds to the Field. For example, if you select
OrganizationOwnerName in Field, then enter a name in Value.

Label Make this label short and representative of the Field. Labels are used in
the Condition Expression field for triggering.
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2. Click Next to proceed to the next step.

Step 5 Attachments
You can add attachments at this step to be included with each copy of the email sent. Static
attachments can be included through the Attachments panel. Recipients receive any attachments
added from the Attachment panel when the template is triggered.

To complete the Attachments step:
1. Click Add to begin adding the attachments.
2. Select the Dataform from which the attachment will be copied.
3. Select the Field from the dataform selected previously that holds the dataform to be copied.

A panel displays on the right for adding attachments.
4. To add static attachments, click Attachments and (Upload File).

The Upload File dialog box opens.
5. Click Choose File to locate the file.
6. Click Save.
7. Click Finish to complete your email template configuration.

Configuring calendar event notification template
You can configure email notification of calendar events using email templates in ClientSpace allowing
for customization of the HTML email. If no calendar event template is published, the system generates
email notifications as it always has. For help configuring a calendar event notification template, log an
Extranet case.

Calendar events utilize a non-triggered email template. This template is used for both Internal and
External (to ClientSpace) recipients.
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To configure a calendar event notification template:

1. Go to System Admin > Email Templates.
The Email Templates dashboard opens.

2. Click Add.
The Add Email Template form opens.

3. Complete the form fields.

Type Select System.

Template Code Select CALEVENT. Template Code must be unique.

Template Name Use Calendar Event. This name is displayed in the system lists.

Description Provide a brief description.

Subject,
Body

Replace fields are available in both Subject and Body. For more details, see
Using replace fields.

4. Click Save.

The Email Template must be published. If the Template cannot be located (not published, Template
Code incorrect), the default notification format is used.
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Using replace fields
Replace fields must be properly formatted and wrapped in curly braces { } to be recognized by
ClientSpace as data that you want to replace. Fields available for use as replace fields are from the
calendar event, from the related Organization, and from the Contact related to the calendar event.
When adding replacement fields, follow these guidelines.

Event Fields
• Only the field name is required: {EventBody}

Organization and Contact fields
The type and field name are required, separated by a period (.).

• {Organization.Name}
• {Contact.LastName}, {Contact.FirstName}
The following list contains a complete list of available fields.

Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

Enter the field name without a
prefix, {Subject}

EventBody Event Body text This is the
Body

ShortStartDate Event Start Date
(short)

5/30/2017

ShortEndDate Event End Date (short) 5/30/2017

FormattedDate Event Duration
(formatted)

5/30/2017 2:00 PM-2:30 PM

ProjectName Event Workspace
Name

Jim's Testing Workspace

OrganizerUserName Event Organizer User
Name

Developer User
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

CreatedByUser Event Created By
UserID (decoded)

User, Developer

DateCreated Event Create Date
(short)

5/29/2017

OrganizationName Associated
Organization Name

415 Group

Location Event Location text Jim's Office

DisplayStartDate Event Start Date
(formatted)

Tuesday, May 30 2017 11:00
AM

DisplayEndDate Event End Date
(formatted)

Tuesday, May 30 2017 11:30
AM

MeetingTypeDecode Event Meeting Type
(Decode value)

Standard Meeting

MeetingStatusDecode Event Status (Decode
value)

Pending

MeetingCategoryDecode Event Category
(Decode value)

Sub Meeting 1

OrganizerEmail Event Organizer User
Email

DateCreatedUtc Event Create Date in
UTC

2017-05-30T14:22:40.43-04:00

DateUpdatedUtc Event Update Date in
UTC

2017-05-30T14:22:40.43-04:00

StartDate Event StartDate (raw) 2017-05-30T14:00:00-04:00

EndDate Event EndDate (raw) 2017-05-30T14:30:00-04:00
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

OriginalStartDate Event Original Start
Date (raw)

2017-05-30T14:00:00-04:00

OriginalEndDate Event Original End
Date (raw)

2017-05-30T14:00:00-04:00

UtcStartDate Event Start Date (UTC
raw)

2017-05-30T18:00:00-04:00

UtcEndDate Event End Date (UTC
raw)

2017-05-30T18:00:00-04:00

fkOrganizerUserID Event Organizer
UserID

5204

fkProjectID Event ProjectID 5218

pkCalendarEventID The primary key of the
Event

543

CreatedByUserID Event Created By
UserID

5204

RowGUID The RowGUID of the
Event

a1505fd6-ddc8-47cf-953f-
fdd192287c51

IsRecurring Recurring Event flag FALSE

IsAllDay All Day Event flag FALSE

IsPrivate Private Event flag FALSE

luMeetingType Meeting Type (code
value)

Standard

luCalendarEventStatus Event Status (code
value)

Pending
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

luCalendarEventCategory Event Category (code
value)

SubMeeting1

fkContactID Associated Contact ID 2376

Sequence Event Sequence 0

fkOrganizationID Associated
Organization ID

3289

ParentRowGUID Parent RowGUID

OrganizerGUID Event Organizer User
GUID

RecurrenceEditMode Recurrence Edit Mode
text

Accepted Invitee's who have
Accepted

User, Developer

Tentative Invitee's who have not
yet Accepted

Dude, Barry

Declined Invitee's who have
Declined

Organization Name Org Name 415
Group

Enter the field name, beginning
with Organization.
{Organization.AKA}

EmployerIDNumber FEIN 555666-
8888

AKA DBA Jim Test DBA

Address1 Org Address 1

Address2 Org Address 2
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

City Org City

State Org State
(abbreviated)

NE

PostalCode Org Postal Code

Country Org Country

County Org County

Phone Org Phone (303) 221-3155

Phone2 Org Phone 2

Fax Org Fax (303) 221-2431

Website Org Website http://www.netwisetech.com

GeneralNotes Org General Notes Zoom Info Company search…

OrganizationOwnerName Org Owner Name JA

pkOrganizationId Org primary key

fkContactIDPrimary Org Primary Contact
primary key

fkUserIDOwner Org Assigned To
primary key

Active Active or Inactive Org
flag

TRUE

crCategory Org Category (code
value)

Cat2

crSource Org Source (code
value)

Source1
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

crStatus Org Status (code
value)

Status1

crBusinessType Org Business Type
(code value)

BusType1

HotList Org Hot List

Locked Org Locked flag FALSE

CreateDate Org Create Date (raw) 2007-08-10T00:00:00-04:00

CreateUserId Org Create UserID 4656

UpdatedDate Org Update Date (raw) 2017-05-15T15:34:14-04:00

UpdatedUserId Org Updated By
UserID

5204

Lineage Org Lineage

IndustryCode Org IndustryCode

ImportID Org ImportID IBMC

AllowImport Org Allow Import Flag TRUE

OrganizationGUID OrganizationGUID

AuditTrail Org Audit Trail ** User, Admin 10/23/2014…

DoNotCall Org Do Not Call Flag FALSE

Email Org Email jim@nwt.industry

fkPrimaryProjectID Org
fkPrimaryProjectID

5218

SoundexValue Org Soundex Value 0

ZoomInfoID Zoom Info ID 75759934
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

DateLastZoomSync Date Last Zoom Info
Sync

2017-01-12T00:00:00-05:00

luZoomSyncStatus Org Zoom Info Sync
Status (code)

Complete

StatusDecode Org Status (Decode
value)

Status 1

CreateUserName Org Created By User
Name

Kingston1, David

AssignedTo Org Assigned To User
Name

User, Admin

DepartmentName Org Department
Name

Sales

ContactName Org Contact Name Bundy, Al

Contact FirstName Contact First Name Al

Enter the field name, beginning
with Contact.
{Contact.LastName}

MiddleName Contact Middle Name

LastName Contact Last Name Bundy

Prefix Contact Name Prefix Mr.

Suffix Contact Name Suffix Jr.

Title Contact Title Manager

Address1 Contact Address1 1 Tech Way

Address2 Contact Address2 Suite 101

City Contact City Bradenton
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

State Contact State
(abbreviated)

FL

PostalCode Contact Postal Code

County Contact County Manatee

Country Contact Country US

BusinessPhone Contact Business
Phone

Ext Contact Phone Ext

CellPhone Contact Cell Phone

Email1 Contact Email1 albundy@nwt.com

Email2 Contact Email2

Pager Contact Pager

Fax Contact Fax

GeneralNotes Contact General Notes

ContactName Contact Full Name Bundy, Al

OrgName Contact Org Name 415 Group

Organization Contact Organization 415 Group

pkContactId Contact primary key

fkOrganizationId Contact's Org ID

Active Active flag TRUE

CreateDate Contact Create Date
(raw)

2013-10-28T19:55:06-04:00
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Object Field Name Field Description Sample

Event Subject Event Subject text This is
the
Subject

CreateUserId Contact Created By
User ID

UpdatedDate Contact Updated Date
(raw)

2017-05-08T15:41:02-04:00

UpdatedUserId Contact Update By
User ID

Category Contact Category
(code value)

ContactGUID Contact GUID

fkAssignedToUserID Contact Assigned To
User ID

SyncWithOrganizationAddress Sync With
Organization Address
flag

TRUE

Nickname Contact Name
Nickname

ImportID Contact ImportID

ProfileImage Contact Profile Image
Link GUID

CreateUserName Created By User Name User, Admin

LoginId Contact Login Id

Replacement Fields
Field replacement allows you to select fields from an associated dataform within the workspace from
which the task is triggered. Field replacement is available when configuring Email Templates and
Workflow Channels. For example, when configuring an Email Template for employee termination, you
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can select fields for employee-related information such as email, state, city, and SSN. The replacement
fields help to customize your message.

l For Email Template configuration, replacement fields are available from the link See Replace
Fields.

l For Workflow Channel configuration, replacement fields are available from the link Get Replace
Fields.

You can use replacement fields for Workflow Channel configuration and Email Templates.

Field replacement includes
l Any active fields on the triggering dataform
l The active fields from any additional condition source dataform
l Task fields when you select Task as the Triggering Form on an Email Template
l The active fields from the tabbed forms related to the triggering form
l The active fields from the related Organization and Org Other Info
l Any fields returned by the Server Data Procs related to the triggering dataform
l Any field from the most recent parent dataform, even when tasks are multiple levels deep. See

Ancestor fields.

To use replacement fields:

1. For Email Templates, in the Content step, click See Replace Fields. For Workflow Channels, in the
Content step, click Get Replace Fields.

2. The Replace Fields dialog box opens, displaying fields grouped by source section and collapsed.
The Replace Fields dialog box opens, displaying fields grouped by source section and collapsed. A
field count is displayed for each group.

3. Expand and collapse fields as desired.
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4. To search for fields, in the Filter by name box, start typing your keyword. As you type, the
matching fields display for any groups you have expanded. Collapsed groups remain collapsed
but the count changes to reflect only the Replace Fields which meet the filter criteria. For example,
type date and all entries containing date are either displayed in the expanded groups or reflected
in the count of the collapsed groups.
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5. Click the fields you want to select as Replace Fields (as many fields as applicable) and then click
Copy.
The Clipboard dialog box opens with the selected fields.

Note: Performing multiple searches and selecting fields from each result set will not impact your
selections. All selections are retained until you copy them to the clipboard.
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6. Click Ok.
7. On the Email Template or Workflow Channel, click in the field (Subject, Body, or Text Area) where

you want to insert the replacement fields.
8. Paste the copied fields (Ctrl+V).
9. You can move the fields around as appropriate (copy and paste). You can invoke the Replace

Fields dialog as often as necessary to paste your required fields.
10. Click Apply.

Alternate values
The following fields provide alternate values.

Field Value

Contact • TableName.FieldName.FirstName (blank if empty) example Client
Master.PrimaryContact.FirstName

• TableName.FieldName.LastName
• TableName.FieldName returns LastName, FirstName
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Field Value

Users • TableName.FieldName.FirstName example ClientMaster.SalesRep.FirstName
• TableName.FieldName.LastName
• TableName.FieldName returns LastName, FirstName

Text area • TableName.FieldName returns the first 250 characters (appends "..." if the field
contains more than 250 characters)

• TableName.FieldName.All returns entire field
• TableName.FieldName.<integer> returns first ## number of characters

(replace <integer> with the numeric character count). If the field contains more
than <integer> number of characters, it appends "..." For example,
Clientmaster.DescriptionOfOps.7 returns the first 7 characters from this field. If
the field contains more than 7 characters, these will end with ... indicating more
info is available.

Lookup • TableName.FieldName returns Decode value displayed in the application
• TableName.FieldName.Code returns Code value stored in the field

Integer • TableName.FieldName returns comma formatted value (##,###)

Decimal or
Money

• TableName.FieldName returns comma formatted value (##,###.##) or 0.00 if
blank

Ancestor fields
The following image illustrates pulling ancestor fields as replacement fields into the Body field. The
fields are from the nearest dataform ancestor.

Example: 2379 gen_Employee.FirstName

l The Workflow item is 2379
l The form is gen_Employee
l The field is FirstName
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Configuring Direct Deposit Notifications in ClientSpace
This topic provides ClientSpace System Administrators with step-by-step instructions for configuring a
customized direct deposit email notification. The notification helps worksite employees and service
providers to be more proactive in detecting and preventing fraud attempts.

When a worksite employee’s direct deposit account number or transit number is added or changed, a
notification is sent to the employee. If the employee did not add, edit, or authorize a change to their
direct deposit information, the employee can contact their service provider.

To learn more about configuring an Email Template for missing Employee records, see Configuring
Direct Deposit notifications for missing Employees.

Video

View the video about Creating a Direct Deposit Notification.
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Condition for: Has Direct Deposit Changed?
System administrators want to ensure that the Direct Deposit notifications are only sent when a true
Direct Deposit change occurs. The objective is to avoid alerting users when changes are applied to an
HSA account or during a pre-notification process.

On the email template, in the Conditions step, you can add a condition that is configured for Direct
Deposit notification. In the Add section, the selected Source is PrismHR Event, and the Field is set to
Additional Information (xmlAdditionalInformation) Has Direct Deposit Changed?:

Review the following procedure (see To configure conditions, click Add.) to learn how to add this
condition.

Condition for: Who made the change to data in Prism?
System administrators want to identify the source of who made the change to data in Prism. This
information aids in configuring workflows based on if an internal or external user changed data.

On the email template, in the Conditions step, you can add a condition to identify the source of the
change. In the Add section, the selected Source is PrismHR Event, and the Field is set to Additional
Information (xmlAdditionalInformation) and then User Type or Username.

Review the following procedure (see To configure conditions, click Add.) to learn how to add this
condition.

Configuring the Direct Deposit Notification
The following procedure guides you through the steps to configure a direct deposit notification using
email templates.

To configure a direct deposit notification in ClientSpace:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Click Add.

The Email Template wizard opens at Step 1 Initial.
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3. Complete Step 1 Initial.

Triggering Form Select PrismHR Event.

Template Code Add a short descriptive code to identify this template, such as
DDNotice.

Template Name Add a brief, but descriptive name to display in any list in ClientSpace
where you may be able to select an Email Template. EX: Direct Deposit
Activity Notice

Description Include a brief description of the template, such as Employee Direct
Deposit Notification.

Execute On Select Insert or Update.

Merge Procedure Select an optional Merge Procedure to provide additional system
information for Field Replacement. For instance, if you want to merge
information such as the employee's name at the top of the body of the
email, you can select the peo_directdeposit_emailtemplate_merge_
proc option. This adds additional merge replacement information for
this email template in Step 2 Content.

Alternatively, you can select peo_directdeposit_emailtemplate_
recipient_v2_proc which contains similar fields but also includes the
following additional fields:  Previous Personal Email and Previous
Work Email.

Execution Pipeline Indicates how the data enters ClientSpace. Remove the option for
Default and select PrismHR Event.

Workspace Templates Select the Workspace Templates that will receive this email. Default is All
Templates.

When you have finished configuring the Step 1 Initial tab, your screen should appear similar to the
following:
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4. Click Next and complete Step 2 Content.

Subject The subject line of the email that is generated. The email recipients see
this subject. EX: Direct Deposit Change Notification.

Body The body of the email that is generated. This is seen by the email
recipients. This field supports rich text. Therefore, you can customize
fonts, add a logo, add a signature block, include links, and more.
You can use replacement fields to customize the message.

To use replacement fields, click See Replace Fields. For details about
using replacement fields, see Replacement Fields.
Note: Ensure that you have selected a Merge Procedure on the Step 1
Initial tab as outlined in the preceding step so that you can access the
replacement fields.

When you have finished configuring the Step 2 Content tab, your screen should appear similar to
the following:
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5. Click Next and complete Step 3 Addresses.

Address Stored
Procedure

Select peo_directdeposit_emailtemplate_recipient_proc for this email
template. The peo_directdeposit_emailtemplate_recipient_v2_proc
includes the Previous Personal Email and Previous Work Email.

Include Dataform
Subscribers as 'CC'
Recipients

Adds anyone who has subscribed to the dataform as CC recipients when
this notification is sent in addition to any other recipients you configure
here. When enabled (selected), this option presents a list to notify
internal, external, or both recipient types:
• Internal: When the email template is triggered, only internal

dataform subscribers are notified.
• External: When the email template is triggered, only external

dataform subscribers are notified.
• Both: If you select Both or leave the field blank, all dataform

subscribers are notified.

From Address This field defaults to Admin Email Address (the application
administrator's email address). This is the default admin email set in
System Admin > Advanced > App Settings.
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To change this setting:

1. Click the link (Admin Email Address).
The From Address Options dialog box opens.

2. Select one of the following options:
o Admin Email: Uses the default admin email set in App

Settings. For assistance with App Settings, please log a case
in the Extranet.

o AdHoc: Allows you to manually add to the From list by
simply typing it in. This should be an active mailbox address
so the employee can reply directly to the email if they need
to contact you immediately. Additionally, you can specify a
friendly name to accompany the email address. For more
details about using AdHoc, see Specifying a friendly name as
From Address.

o User: Select a specific user of the system.
o Procedure: Select an address stored procedure and pick the

From address.
o Field on a Form: Select a dataform from a list of forms in

the system that have relevant email fields. You can set user
fields to values that exist on dataforms across a tabbed set. If
the selected user fields are empty, the default value is the
system admin. For more details, see From a Field on a Form.

3. When done, click Ok.

6. To add the Employee as a recipient, click Add.
A row opens. This is where you specify the Employee's work or personal email addresses.

Source For this email template, select Address Source Procedure. This
selection makes the Employee's email address available in the Address
column. To include additional team members as recipients, you can
select Client Team or Adhoc Email Address. When you select Adhoc
Email Address as the Source, you type a specific email address in
Address.

Type Type can be To or CC.
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Address You can select the employee's personal or work email address. This
address triggers the employee notification when their direct deposit
information changes.

When you have finished configuring the Step 3 Addresses tab, your screen should appear similar
to the following (although some of your selections will vary from the examples shown here):

7. Click Next and complete Step 4 Conditions.

No Primary Trigger Enable this option. (Select the option.)

Primary Trigger Field Not used.

Only Trigger Once Not used. This setting triggers the email template the first time the
conditions are met. This setting is not for use with an ongoing
notification email template such as the Direct Deposit Notifications
email template.
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Condition Expression Allows for AND, OR, and NOT conditions using the display conditions
(Label) from the Add section. Using the Label field that corresponds to
the entries in the Add section, you can combine the conditions into
more complex expressions. The Condition Expression field could state,
for example (Condition1 AND Condition2) OR (Condition3 AND
Condition4) OR Condition5. In the example, the Condition Expression
uses the display condition labels 1, 2, 3 and 4. Condition Expressions use
AND/OR/NOT across tabbed dataform conditions. For a detailed
explanation about conditions, see Condition expressions.

8. To configure conditions, click Add.
A row opens for adding conditions to include Source, Field, Operator, Value, and Label. You can add
multiple conditions.

Source Indicates the dataform or stored procedure that provides the triggering
condition. Select PrismHR Event.

Field This is the field that is evaluated for the conditions. Select Class Name.
This field captures the classification of event records that come through
the API.
l To add the condition Has Direct Deposit Changed: Select

Additional Information (xmlAdditionalInformation) Has
Direct Deposit Changed?

l To add the condition for who made the change: Select Additional
Information (xmlAdditionalInformation) Username or User
Type.

Operator The type of comparison between Field and Value. For the condition Has
Direct Deposit Changed? or who made the change (i.e., Username or
User Type), select Equals.

Value The criteria against which Field is compared.
l For the condition Has Direct Deposit Changed, select True.
l For the condition who made the change (i.e., Username or User

Type, enter a value such as Internal, External, or a username.

Label The label to be used when constructing Condition Expressions for
triggering. Make this label short and representative of the selection in
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Field. Labels are used in the Condition Expression field. You can also
choose to use the default labels of C1, C2, C3, etc or shorten them to 1,
2, 3, and 4 as we've done in our example.

When you have finished configuring the Step 4 Conditions tab, your screen should appear similar
to the following (although some of your selections will vary from the examples shown here):

9. Click Next.
10. Skip Step 5 Attachments.
11. Click Finish to save your work.
After you click Finish, you are returned to the Email Template list. This email template does not work
just yet because it is unpublished (inactive). You must publish the new email template to make it active.

If you are ready to publish immediately:

1. Select the row for DDNotice (or the Template Name you entered on the Step 1 Notice tab.)
2. Click Publish.

The entry is now published.

ClientSpace Setup & Administration © 2025 PrismHR 112

Chapter 2 Email Templates: Basic Configuration



If you would like to publish later:

1. Navigate to the Email Template list.
2. Clear the Published option.

The entry is now unpublished.

Activity Tracking
ClientSpace maintains a history of Direct Deposit Notification activity on the PrismHR Event dataform.
This can help you prove that notification of a change to an employee's direct deposit information was
sent if the receipt of a notification is disputed. To support Activity tracking of Direct Deposit
Notifications, the following fields are set on the PrismHR Event dataform properties (System Admin
>Advanced > Dataform Admin):
l The Enable Activities checkbox is checked by default.
l The Enable Attachments checkbox is checked by default.

Additionally, the Include as Activity checkbox is checked by default on the Direct Deposit Active
Notice email template (Template Code = PHRDDNOTICE).
Note: This template is predefined in ClientSpace. If you have custom Direct Deposit Notifications and
you want Activity tracking on those as well, apply the same settings outlined here to those templates.

With these settings in place, when a direct deposit notification is triggered, an Email activity record
(which includes an attachment of the generated email) is added to the PrismHR Event dataform in the
correct workspace.

When you open the Prism HR Event record, the generated email is located in the Action Center under
Activities.
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Configuring Direct Deposit notifications for missing
Employees
A Direct Deposit notification is driven from a PrismHR Event entering ClientSpace after Direct Deposit
information changes in PrismHR. A direct deposit event should always be associated with an Employee.
In the event it is not (Import issues, for example), you can configure an Email Template to send a
notification to a designated recipient, alerting them that the direct deposit was changed and a
notification was not sent to an Employee.
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To configure this email template, we recommend that you clone the Direct Deposit notification
template, and then edit as follows. If you need assistance, please log an Extranet case.

To configure the notification:

1. Go to System Admin > Email Templates.
The Email Templates dashboard opens.

2. Locate and select the entry for your organization's Direct Deposit and click Clone.
The Add Email Template wizard opens to Step 1 Initial.

3. Complete the following fields:

Template Code Enter a unique template code that indicates the purpose.

Template
Name

Provide a short, descriptive name for your template. Displays in the email
template list.

Description Edit the description to indicate the purpose.

4. Click Next.
The form for Step 2 Content opens.
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5. Edit the following fields:

Subject Edit the Subject to indicate no employee was identified.

Body Edit the Body to indicate no employee was identified.

6. Click Next.
The form for Step 3 Addresses opens.

7. Click Add.
A new row opens.

Source Select Adhoc Email Address.

Note: If you select the AdHoc email address option and enter a
ClientSpace user's email address as a recipient, if the Enable Email
for this account field on their user profile is unchecked, they cannot
receive emails from ClientSpace and will therefore not receive the
email generated from this template.

Note that only a Global Administrator can change this setting.

Also see Personalizing Your User Profile.

Type Select To.

Address Enter the email address for the designated recipient when no employee
is identified. This is the person who will receive the notification.

8. Click Next.
The form for Step 4 Conditions opens.

9. Add a condition for Employee Empty.

Source Select PrismHR Event.

Field Select Employee (fkEmployeeID).

Operator Select Empty.

Label Enter a label for this new condition, such as NoEmp.

10. In Condition Expression, add an AND for the new condition. The following example uses
AND NoEmp, where NoEmp is the Label for the condition Field=Employee and Operator=Empty.
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11. Click Save.
The new template is published and displayed in the Email Templates list.

Tracking data modifications in PrismHR
Additional Information allows you to customize your Workflow Channels and Email Templates related
to data that is changed in Prism to reflect the source of the change. When data is modified in PrismHR
(for example, a Client’s address changes, or an Employee is added), the PrismHR API generates an Event
in a queue. The ClientSpace Ongoing scheduled process polls the Event queue for new Events (relative
to the last time the scheduled process ran). If the Events contain data that is mapped by ClientSpace
(using Import mappings), the Event is processed, and data in ClientSpace is updated.

AdditionalInformation is a data element provided by the PrismHR API. Each Event contains an
AdditionalInformation element that, in turn, contains data appropriate to the type of the Event
(Schema). For example, if an Employee’s email address changes, the AdditionalInformation informs us
which User made the change and the Type of that User (Internal or External).
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The purpose of

AdditionalInform
ation is to allow Workflow Channels and Email Templates to react to specific conditions unique to each
dataform save. AdditionalInformation data is available to ALL dataforms in the system. It is a pseudo-
field in that it is not a true dataform field, but it is available in code to be exposed to the dataform save
data. It is not visible on the dataform in the application.

In Workflow Channels and Email Templates, the additional information is available as Additional
Record Information and has an associated user type.

To use Additional Information in a Workflow or Email Template, go to Tracking Additional Information
in Prism events: Triggering from Additional Record Information.

Tracking Additional Information in Prism events: Triggering from
Additional Record Information
ClientSpace can track what type of user made a data change in Prism when that data imports into
ClientSpace. Administrators can then use that information and alter workflows based on who applied
the change – a PEO employee or a worksite employee.

The data change information is available from a column in the import queue, named Additional
Information. All dataforms accommodate the Additional Information column data to show the
prismUserName and the userType. The userTypes are as follows:

• I = service provider
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• E = employee
• A = worksite trusted adviser
• M = worksite manager
Additional Information data is only available as a trigger condition from the Triggering Form configured
on a Workflow Channel or Email Template

To view the Import Queue:

1. Go to System Admin > Imports > Manage Import Queue.
The Import Queue dashboard opens.

2. Select an entry and click View.
The Import Queue record opens.
In the following example, Additional Information shows userType = I, which represents the
service provider.
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To use Additional Information in a Workflow or Email Template:

1. Go to System Admin > Workflow Channels.
The Workflow Channels dashboard opens.

2. Select a Workflow Item that uses the Client Master as the Triggering Form and click Details.
3. Go to Step 4 Conditions.
4. Click Add.

A row opens for Source, Field, Operator, and Value. In your conditions, specify user type or user
name, and then the Value. Value represents the type of user that made the change. Was it a
service provider, employee, worksite trusted employee, or a worksite manager who made the
change?

Source Source auto-fills with Client Master.

Field In Field,

1. Select Additional Record Information.
2. Select UserType.

Operator Auto-fills with Equals.

Value Enter a value:
• I = service provider
• E = employee
• A = worksite trusted adviser
• M = worksite manager

Label The Label value is used in the Condition Expression. See Condition Expressions.

5. Click Save.
6. For Email Templates, configure Source, Field, Operator, and Value in Step 4 Conditions.

The following example has six conditions with Label 1 through 6. The Condition Expression states
that when any of the employee address fields change (address, city, state, or zip code), AND the
user type is an Employee (value = E), then trigger this email. When an employee changes the
employee address information, then the email is sent to the recipients listed in Step 3 Addresses.
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Configuring notifications for Employee email address
changes
When a worksite employee’s work or personal email address is added or changed, you can send a
notification to the employee. If the employee did not add, edit, or authorize a change to their email
address, they can contact their service provider. The notification helps worksite employees and service
providers to be more proactive in detecting and preventing fraud attempts.

How does it work? When an Employee’s Work Email and Personal Email changes occur in PrismHR, a
business rule sets the Previous Email fields. The business rule (SetPreviousEmails) is set on the
Employee dataform for when PersonalEmail or WorkEmail is changed. This rule stamps the old value
into the corresponding PersonalEmailPrevious and WorkEmailPrevious fields. This rule is set to run on
the Default and Imports pipelines.

To configure an email address change notification template:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Click Add.

The Email Template wizard opens at Step 1 Initial.
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3. Complete Step 1 Initial.

Triggering Form Select Employee. The Employee dataform is where the previous email
addresses reside.

Template Code Add a short descriptive code to identify this template, such as
EmailChanged.

Template Name Add a descriptive name (this is displayed in the application list), such as
Email address change notification.

Description Include a brief description, such as Employee email address change
notification.

Execute On Select Insert or Update.

Merge Procedure Select an optional Merge Procedure to provide additional system
information for Field Replacement.

Execution Pipeline Indicates how the data enters ClientSpace. Keep the setting as Default.

Workspace Templates Select the Workspace Templates that will receive this email. Default is All
Templates.
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4. Click Next and complete Step 2 Content.

Subject The subject line of the email that is generated. The email recipients see
this subject. For example, Alert: Your email address has changed.

Body This is the body of the email. This field supports rich text, so the email
can be branded with links. This is seen by the email recipients. You can
use replacement fields to customize the message. To use replacement
fields, click See Replace Fields. For details about replacement fields, see
Replacement Fields.

5. Click Next and complete Step 3 Addresses.
In this step you add the recipients. You want to select Previous Work and Previous Personal email
addresses to ensure that when an employee's email address is changed, the notification is sent the
previous email addresses in the event the system is compromised by a hacker. Sending the
notification to the changed email (a new email address that could be supplied by a hacker) would
potentially never reach the employee. Sending the notification to the previous email, would reach
the employee because the previous email is most likely the employee's true email address.

Address Stored Optional.
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Procedure

Include Dataform
Subscribers as 'CC'
Recipients

When you select this option it adds anyone who is subscribed to the
dataform as CC recipients when this notification is sent. This is in
addition to the recipients you configure in the Add section. When
enabled (selected), this option defaults Subscriber Type to Both.
• Internal: When the email template is triggered, only internal

dataform subscribers are notified.
• External: When the email template is triggered, only external

dataform subscribers are notified.
• Both: If you select Both or leave the field blank, all dataform

subscribers are notified.

From Address This field defaults to Admin Email Address (the application
administrator's email address). This is the default admin email set in
System Admin > Advanced > App Settings.
To change this setting:

1. Click the link (Admin Email Address).
The From Address Options dialog box opens.

2. Select one of the following options:
o Admin Email: Uses the default admin email set in App

Settings. Only User Developers can change this email. For
assistance with App Settings, please log a case in the
Extranet.

o AdHoc: Allows you to manually add to the From list by
simply typing it in. This should be an active mailbox address
so the employee can reply directly to the email if they need
to contact you immediately. Additionally, you can specify a
friendly name to accompany the email address. For more
details about using AdHoc, see Specifying a friendly name as
From Address.

Note: If you select the AdHoc email address option and
enter a ClientSpace user's email address as a recipient, if
the Enable Email for this account field on their user
profile is unchecked, they cannot receive emails from
ClientSpace and will therefore not receive the email
generated from this template.
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Note that only a Global Administrator can change this
setting.

Also see Personalizing Your User Profile.
o User: Select a specific user of the system.
o Procedure: Select an address stored procedure and pick the

From address.
o Field on a Form: Select a dataform from a list of forms in

the system that have relevant email fields. You can set user
fields to values that exist on dataforms across a tabbed set. If
the selected user fields are empty, the default value is the
system admin. For more details, see From a Field on a Form.

3. When done, click Ok.

6. To add the affected employee as a recipient, click Add.
A row opens. This is where you specify the Employee's work and personal email address. We
recommend that you add four rows for current work, current personal, previous work, and previous
personal email addresses. See the example.

Source For this email template, select Employee. This selection makes the
Employee's email addresses (Previous Work and Personal) available in
the Address column. To include additional team members as recipients,
you can select Client Team or Adhoc Email Address. When you select
Adhoc Email Address as the Source, you can type a specific email
address in Address.

Type Type can be To or CC.

Address The Address you select triggers the employee notification when their
email addresses change. Select the previous email addresses to ensure
the employee receives a notification if, indeed, the change was an
attempt to commit fraud.
Add four rows, for current and previous email addresses.
• Select Previous Work Email (WorkEmailPrevious).
• Select Previous Personal Email (PersonalEmailPrevious).
• Select Work Email (WorkEmail).
• Select Personal Email (Email).
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7. Click Next and complete Step 4 Conditions.
When configuring the email template, Step 4 Conditions is where you specify a condition for
checking if the employee Work and Personal email fields have changed. When these fields change
(Value: Is Dirty), that condition triggers the notification to the affected employee.

8. Click Add.
A row opens for adding conditions to include Source, Field, Operator, Value, and Label. You can add
multiple conditions.

Source Indicates the dataform or stored procedure that provides the triggering
condition. Select Employee. The Employee dataform contains the
employee's work and personal email addresses.

Field This is where you specify the Work and Personal email addresses. Add
two rows for:
• Work Email (WorkEmail)
• Personal Email (Email)

Operator Select Is Dirty. This value detects when the email address has changed.

Value Not applicable for email address changes.

Label Not applicable for email address changes.

ClientSpace Setup & Administration © 2025 PrismHR 127

Chapter 2 Email Templates: Basic Configuration



9. Click Next.
10. Skip Step 5 Attachments.
11. Click Finish to save your work.
After you click Finish, you see the Email Template list. This email template does not work just yet
because it is unpublished (inactive). You must publish it to make it active.

If you are ready to publish immediately:
1. Select the row for the new email template.
2. Click Publish.

The email template is published.

If you want to publish later:
1. Navigate to the Email Template list again.
2. Clear the Published option.

The email template is unpublished.

Configuring email templates to notify external employees
You can configure an email template to send an email to the related employee on a case. For example,
you can send notifications to external employees who submit an inquiry through the Employee Portal
Submit a Question.
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The Employee Address stored procedure peo_clientservicecase_external_emailtemplate_recipient_
v2_proc contains the employee email address fields EmployeePersonalEmail and
EmployeeWorkEmail. You can add these fields to the To or CC Address on Step 3 Addresses.

When configuring for external notification, you can configure your own template (making sure Client
Service Case is the Triggering Form) and use the recipient proc on Step 3 Addresses.

To configure external employee notification:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Open any email template created from a Case dataform.

The email template displays.
3. Select Addresses Step 3.

4. In Address Source Procedure, ensure that peo_clientservicecase_external_emailtemplate_
recipient_v2_proc is selected.

5. Click Add.
A new row opens. At this step, you add the employee personal or work email as a To or CC
recipient.
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6. Complete the fields:

Source Select Address Source Procedure. Ensure that you have specified the correct
proc in the previous field Address Source Procedure. When the proc is
selected along with Address Source Procedure in Source, then the external
email addresses become available in Address.

Type Select To or CC.

Address Select EmloyeePersonalEmail or EmployeeWorkEmail.

7. Repeat Step 5 to add another row as applicable for To or CC.
8. Click Save.
External employees should now be able to receive notifications from Client Service Cases.

Configuring Scheduled Email Templates
You can schedule email templates to trigger on a specific date. This topic details how to schedule an
email to trigger and be automatically sent to a recipient using the Generate Scheduled Email
Templates scheduled process.  

To configure scheduled email templates:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Click Add.

The Choose Email Template Type dialog opens with options to select Real Time or Scheduled.
3. When you select Scheduled, the Add Email Template wizard opens with Step 1: Initial. In this step,

you configure the date that triggers the scheduled email template.
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4. Configure the following options:

Type Type is a "read only" field for scheduled email templates. Email is
selected by default for email notifications.

Triggering Form Select the form that will trigger the email notification to be sent.

To add a dataform that is not in the list:

1. In the Triggering Form field, go to the end of the list and select
Add Untriggered Form.
The Select an Untriggered Form dialog box opens. Table Name
contains a list of all dataforms currently not marked as Triggerable.

2. In Table Name, select a dataform from the list.
3. Click Ok.
The selected dataform is marked as triggerable and now appears in the
Triggering Form list.

Template Code Must be unique and should be related to the purpose of the email
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template.
Note: Global Admins can only edit codes that begin with CSCRPLY.

Template Name Provide a short, descriptive name for your template. This displays in the
email template list.

Description Provide a useful description of the email template.

Merge Procedure Select an optional Merge Procedure here to provide additional system
information for field replacement. The procedure can be selected from
any stored procedure in the system with a name containing
emailtemplate_merge_proc.
Merge Procedure1 also determines the fields that are available to use in
field replacement.

Workspace Templates Select the Workspace Templates2 to receive this email. By default, this
field is set to All Templates.

Include as Activity Select this option to attach the email as an Activity. When the email is
triggered, the email message attaches to the triggering record. This
action preserves the communication of the sent email. By default, the
option is cleared, meaning do not include the email as an activity.
If you select this option and the email template includes an attachment,
the system uploads any attachments to the activity when it is created.

Scheduled Email Action

Scheduled Field This is the Date or Date/Time field (from the selected Triggering Form)
that ClientSpace will check to determine when to trigger the email.
Note: ClientSpace only uses the Date portion of Date/Time fields to
determine the trigger date.

Frequency Limit The number you enter here limits the frequency that the email is sent.
The email is triggered once every X days based on the value in this field.
This way, even if a change is made to the date field used as the

1A Merge Procedure is a piece of prepared SQL code that can be reused over and over again.
2Workspace Templates are special workspaces used for cloning during the Workspace creation process.
In this way, ClientSpace allows you to set up multiple workspace configurations (such as an industry-
specific Workspaces with a specific, limited list of TOC items) then choose how you want the workspace
to look and feel by selecting the appropriate template during workspace creation.
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Scheduled Field which makes it eligible for triggering, the recipient will
not receive additional emails until the set Frequency Limit has passed.

Date Offset The number of days plus (+) or minus the (-) triggering date that the
email template is triggered. For example, to trigger the email template 5
days before the Date or Date/Time specified in Scheduled Field, type -5
in Date Offset. To trigger the email template 5 days after the Date or
Date/Time specified in Scheduled Field, type 5 in Date Offset.

Grace Period This is the number of consecutive days you want the system to continue
to try to trigger the email if, for some reason, the email could not be sent
on the first eligible day.

Include When Inactive When this field is unchecked, only Active triggering forms are checked
when the scheduled email template is run.

5. After you have configured the Scheduled Email Action section, you receive a brief synopsis of the
schedule.

6. Click Next to go to Step 2: Content.

Note:
• As you proceed with configuration through the various tabs of the Email Templates wizard, you

may notice that Current User is not available as an option in Step 3: Addresses. This option only
works with Real Time field analysis to determine the current user.

• You may also notice that the Is Dirty trigger operator is not available when setting conditions in
Step 4: Conditions. This option only works with Real Time field analysis to determine if a field
has changed. This kind of analysis cannot happen with a scheduled email template; therefore,
the Is Dirty qualifier is not available when adding additional triggering conditions to scheduled
email templates.

• Once you complete and save the scheduled email template, the configured conditions in the
Scheduled Email Action section of Step 1: Initial are evaluated by a scheduled process named
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Generate Scheduled Email Templates to determine if the date or date/time field combined
with the other email template schedule options and any additional conditions added in Step 4:
Conditions are met. If they are met, the email template will trigger at the set time.

Related Topics:

l Step 2: Content
l Step 3: Addresses
l Step 4: Conditions
l Step 5: Attachments
l Scheduled Processes
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Chapter 3
Workflow Channels
Making sure things happen on time and in the proper order can be crucial to your business's success.
Workflow Channels enable you to automatically create tasks and dataforms (and associated
notifications) based on predefined triggering conditions.

As always, before
you begin, it is a
recommended
best practice to
diagram the
workflow.
Flowcharts can
be very helpful in
the design
process, as long
as you ensure
that you include
the starting
point, ending
point, steps in
between, and the
trigger
conditions that
lead from one
step to another.

While the
example diagram
is simplistic, it
demonstrates the
power of
Workflow
Channels to
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automate tasks to execute in a consistent and timely fashion, even allowing multiple workflow items to
be triggered simultaneously from the same event. Understanding the process through diagramming
saves a time and may help you to streamline processes. After you understand the process steps and
triggering conditions that you need, you are ready to start.

Setting clone-configurable dataforms
Before you create a Workflow Channel, you must determine if the channel will contain any dataform
cloning1. If so, you need to determine which fields on the cloneable form will be available for
configuration by the system.

To add fields for dataform cloning:
1. Go to System Admin  > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Select the dataform you would like to clone and click Edit.

The Dataform Properties form opens.
3. In Features, select Enable WFC Cloning.
4. Click Save.

Searching Workflow Channels
It is helpful to search the workflow list to find specific items and also to avoid configuring redundant
workflows. From the Workflow Channels list, use the Quick Search and More search options to filter the
list.

1Cloning is when an object is generated by copying a template example of that object. Cloning is often
used to provide consistency of data, or for workflow design.
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To search Workflow Channels:

1. Go to System Admin > Workflow Channels.
The Workflow Channels dashboard opens.

2. In Quick Search, you can type text or numbers to find matching entries quickly. Use the % symbol
to search fields for records matching the search string.

3. In More search, you can further refine the criteria by Workflow Channel #, Channel Name,
Triggering Form, Workspace Template, Owner, Workflow Item Name, Workflow Item #, Triggered
Form, Pipeline, and Type. The default setting is to search for items with the Status of Published.
You can change this to All or Unpublished.
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4. Select your criteria and click Search.
The filtered list is displayed.

Configuring your Workflow Channel
Configuring a workflow is a five-step process that includes setting up the Triggering, adding Content,
adding Notifications, creating Conditions, and adding Attachments.
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To configure your workflow:

1. Go to System Admin > Workflow Channels.
You are presented with a list of published Workflow Channels currently configured on your
site. For more details about published and unpublished Workflow Channels, see Publishing and
unpublishing workflows.

2. If you have a large number of workflows already configured, it is helpful to search the list to
ensure that there is not already a workflow configured for your goal. Use the Quick Search and
More search options.

3. To review an existing Workflow Channel, select it and click Details.
4. When you are satisfied that there are no conflicts, click Add to begin creating your new workflow.

The Choose Workflow Triggering Type dialog opens with "What type of triggering will the new
Workflow use?".

5. Select Real Time or Scheduled.
The Add Workflow Channel form opens. The following topics follow the Real Time workflow. For
information about scheduled workflows, see Configuring Scheduled Workflows.

You are presented with a five-step process wizard: Channel, Content, Notifications, Conditions, and
Attachments.

1. Step 1: Channel
2. Step 2: Content
3. Step 3: Notifications
4. Step 4: Conditions
5. Step 5: Attachments

Step 1: Channel
From the Add Workflow Channel form:

n Define your channel by giving it a name.
n Select which workspace template it affects.
n Determine how it triggers.
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To configure the channel:

1. From the Add Workflow Channel form, complete the form fields.

Channel Name Provide a unique Channel Name. This should be descriptive and short.

Triggering Form This is the form that triggers the workflow. Select a form or add a
triggering form that is not in the list. The list also includes single
dataforms that do not already exist in a workspace when triggering
occurs. Selecting a single form is best for custom created single
dataforms.

To add a dataform that is not in the list:

1. In Triggering Form, go to the end of the list and select Add
Untriggered Form.
The Select an Untriggered Form dialog opens.

2. In Table Name, select a dataform from the list.
3. Click Ok.

The selected dataform is marked as triggerable and now appears in
the Table Name list.

Execute On • Insert: Item will be triggered only on the creation of a record.
• Update: Item will be triggered on a save of an existing record.
• Insert/Update: Or both?

Execution Pipeline Choose a pipeline. Ensure that anything connected to the workflow
(dataforms or imports) is configured to use one of the pipelines
configured on the workflow. For questions or help with this configuration,
log an Extranet case.
Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new workflow channel, pipelines
assigned a behavior of Default will auto-fill the Execution Pipeline field. If
you are editing an existing workflow channel, Execution Pipeline entries
remain intact until edited. Changed entries are validated against the
Pipeline Linking table. For instance, if a pipeline has been assigned a
behavior of Allow or Default and you remove it, you will still be able to
select it from the Execution Pipeline list. If the same pipeline is assigned
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a behavior of Disallow, you will not be able to add it again.

See Configuring Pipeline Linking.

Workspace Template Select a template to apply to workspaces that will use this workflow. The
Workspace Templates field is a multi-select, which allows you to apply a
workflow channel across multiple workspace templates. If no specific
templates are selected, the Workspace Templates field defaults to All
Templates.

Save triggering form
when last task
complete?

This field indicates whether the system will trigger business rules that use
the Workflow Tasks Complete pipeline when the final task in the workflow
chain is complete. When selected, this field indicates that the system will
trigger business rules when completing the final task in the workflow
chain. When not selected, the system does not trigger the business rules
when the final task in the workflow chain is complete.

Channel Description Provide a brief description of this channel.

Channel Owner Defaults to the current user. Set it to the owner of this process.

Workflow Action This section is dedicated to the primary triggering condition for the
workflow.

No Primary Trigger When selected, this field indicates no single condition must be met to
trigger the Workflow. If this option is selected, at least one condition must
be provided on the Conditions step. When you select No Primary Trigger,
Field, Operator, and Value are not available because they are not
applicable.

Field What field on the triggering form (or HdrAction configured on a link) will
fire this workflow? This field must have been changed to the triggering
value for the trigger to fire. You can also add a trigger field.

To add a trigger field:

1. In Trigger Field, go to the end of the list and select Add
Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as Triggerable.

2. In Field, select an entry
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3. Click Ok.
The selected field is marked as triggerable and appears in the
Trigger Field list.

Scheduled Workflows
For scheduled workflows, when the triggering form is the home form in a
tabbed set, Field returns all Date fields across the tabbed form set. Field
points to a date field on the triggering form.

Operator Comparison type used to determine if the trigger condition is met.
(Contains, Equals, Does Not Equal)

Value The value evaluated to ensure the trigger condition is met. For system
selectors such as lookups, or for Header actions, this is a select list.

Triggered Form Can be a dataform (with Workflow Cloneable fields) or a task. The selected
dataform affects the displayed fields in Step 2 Content.

If the Triggered Form field is set to Task, you must select a form in
the Attach To field.

If the Triggered Form field is no longer cloneable, a warning
message displays: Workflow channel cloning is no longer enabled
for this triggered form. If you still wish to use this as your triggered
form, go to Dataform admin and select the Enable WFC Cloning
option.

2. When done, click Next. Step 2: Content opens.
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Step 2: Content
This is where the rubber meets the road. Information entered into these fields is copied to each cloned
object created by this step. On the Content step, you can set user fields to values that exist on
dataforms across a tabbed set. For more details about selecting users across tabbed dataforms, see
Workflows and Tabbed Dataforms.

The fields that are available for cloning are based entirely on the work done when defining clone-
configurable fields (see Setting clone-configurable dataforms). Clone configurable fields follow the
datatype of the field and act as those fields do on the dataform. For example, a lookup displays the
appropriate values.

Field Replacement

You may have
noticed a Get
Replace Fields
link on the
Content step.
This link allows
you to insert field
content for
Subject and Body
from:

l Triggering
dataform

l Triggering
task

l Server data
procs

l Any
associated
tabbed
dataforms

l Related
Organization
and Org
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Other Info
l Closest dataform ancestor
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To use Get Replace Fields:
The list can be extensive because it can include fields:

l From the triggering dataform
l From its server data proc
l From any associated tabbed dataform
l From the closest dataform ancestor.
l Field content from the related Organization and Org Other Info

To use replacement fields:

1. For Email Templates, in the Content step, click See Replace Fields. For Workflow Channels, in the
Content step, click Get Replace Fields.

2. The Replace Fields dialog box opens, displaying fields grouped by source section and collapsed.
The Replace Fields dialog box opens, displaying fields grouped by source section and collapsed. A
field count is displayed for each group.

3. Expand and collapse fields as desired.

4. To search for fields, in the Filter by name box, start typing your keyword. As you type, the
matching fields display for any groups you have expanded. Collapsed groups remain collapsed
but the count changes to reflect only the Replace Fields which meet the filter criteria. For example,
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type date and all entries containing date are either displayed in the expanded groups or reflected
in the count of the collapsed groups.

5. Click the fields you want to select as Replace Fields (as many fields as applicable) and then click
Copy.
The Clipboard dialog box opens with the selected fields.

Note: Performing multiple searches and selecting fields from each result set will not impact your
selections. All selections are retained until you copy them to the clipboard.
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6. Click Ok.
7. On the Email Template or Workflow Channel, click in the field (Subject, Body, or Text Area) where

you want to insert the replacement fields.
8. Paste the copied fields (Ctrl+V).
9. You can move the fields around as appropriate (copy and paste). You can invoke the Replace

Fields dialog as often as necessary to paste your required fields.
10. Click Apply.

For more details, see Replacement Fields.

Triggered Form: Task

In Step 1 Channel, in Triggered Form, when you select Task, the fields in Step 2 are as follows.
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1. Complete the fields:

Item Name Provide a short descriptive name for what this workflow object is.

IsMarkedForDelet
ion

When this option is selected, the Workflow clones the task with this field
selected. Then, when the scheduled process, Delete Marked Tasks, runs, it
finds all the tasks with this field select, and deletes the task.

Attach To This field is available only when a user selects Task in the Triggered Form
field. This field indicates the form that the task will be assigned to. Select This
Form to indicate that the form that triggered the workflow will be the form to
which the task is attached.

Note: If a form selected in the Attached To field is inactivated or removed
from the workspace at some point in time and the workflow item is not
edited to select a different form, then the task will attach to the triggering
form.

Subject Subject Line that displays on the task. This field supports field replacement.
See Field Replacement.
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Body Include any instructions that you feel could be helpful. This field should
contain information to provide steps to complete the task. This field supports
field replacement. See Field Replacement.

Category Choose the appropriate Task Category.

Status Select the appropriate Task Status.

Priority What is the criticality of this task?

Type Within the category, what is the task type?

Stage Also called workflow. Where in the process does this task fall?

Assigned To,
Owner

For Assigned To, select the person responsible for accomplishing this task
from the following options. For Owner, select an owner.

To change Assigned To and Owner:

1. Select Current User.
The Assigned To or Owner Options dialog box opens.

2. Select an option:
l Current User: The logged in user who triggers the task.
l Specific User: A specific user in the Workspace. When you select

Specific User, the User field is enabled. This displays all active user
accounts.

l From a Field on a Form: Any user field on the triggering
dataform is available.

o When you select From a Field on a Form, Dataform is
enabled.

o Select the Dataform that has a field from which to select
a User. Field becomes available.

o Select a user field.
3. Click Ok.

You are returned to the Add Workflow form.

For details about referencing users from tabbed dataforms (parent and child
dataforms), see Workflows and Tabbed Dataforms.

Start Date Source, Date Source options are Create Date, Specific Date, and From a Field on a
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Due Date Source Form. Additionally, you can select the Offset as Days, Weeks, Months, Years,
Business Hours, Business Days, Beginning of Month, End of Month, Beginning
of Year, or End of Year. For Date/Time fields you have an additional option to
set Minutes.

Due Date Source: Tasks created by this workflow can have their due date set
by the task create date, or to a specific date from a dataform field. Choose
from the create date of the task or a Date type field on the triggering
dataform.

To configure dates:

1. Select On Create Date.
The Date Options dialog box opens.

For date or date/time fields that are not required, the None option
becomes available. For required (red ink) date fields, None is not an
option.

2. Select an option:
l Create Date: Default value. Optionally, you can use Offset to

specify a number of days, weeks, months, years, business hours,
end of month, beginning of year, or end of year. For Date/Time
fields you have an additional option to hours and minutes.

l Specific Date: Enables the Date field where you can use the date
picker. Optionally, you can use Offset to specify a number of days,
weeks, months, years, business hours, end of month, beginning of
year, or end of yearFor Date/Time fields you have an additional
option to hours and minutes.
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l From a Field on a Form: Includes the triggering form for that
workflow, all single dataforms with date fields, and child tab forms
when the Triggering Form (from Step 1) is a home form of a
tabbed set.

When you select From a Field on a Form, Dataform is
enabled. Select the Dataform that has a date field.

o When you select a dataform, Field becomes available.
Select a date field.

o Optionally, you can use Offset to specify a number of
days, weeks, months, years, business hours, end of
month, beginning of year, or end of year. For Date/Time
fields you have an additional option to hours and
minutes.

l Offset: You can use Offset with Create Date, Specific Date, and
From a Field on a Form. Default value is 0 Business Days.

3. When ready, click Ok.

You are returned to the Add Workflow form, where the Start and/or Due Date
Source fields show (as applicable): nn Business Days after Create Date, nn
Business Days after Specific Date, nn Business Days after Field Label (Contract
Effective Date).

Lookup and
Multi-Lookup
fields

Lookup and Multi-Lookup field names vary by dataform. To display as an
available field on a workflow item, a Lookup or Multi-Lookup field must be set
as a workflow cloneable field.
Note: Multi-Lookup fields work the same as a regular Lookups except that
users can pick more than one selection from the list of available options.

To configure a lookup field:

1. Click next to a Lookup or Multi-Lookup field.
The Status Options dialog box opens.

ClientSpace Setup & Administration © 2025 PrismHR 152

Chapter 3 Workflow Channels



2. Select an option: 
l None: This is the default initial state. When the workflow item

triggers, any Lookup or Multi-Lookup field set to None will be
blank on the new or updated task. The only exception is when the
field is a required field (designated by red text). You must set a
value for required fields.

l Specific Value: When the workflow item triggers, the Lookup
field value or Multi-Lookup field value(s) that you select will be set
in the corresponding field on the new or updated task.

l From a Field on a Form: When the workflow item triggers, the
set value(s) from the Lookup field or Multi-Lookup field on the
form you select auto-fills the corresponding field on the new or
updated task. The From a Field on a Form option is only
available when there are Lookup or Multi-Lookup fields on other
forms in the same workspace that have the same Lookup Group.

Note: Tabbed form Lookup and Multi-Lookup fields have the following
naming convention to help you determine where the field you are
selecting is located: *<Dataform Tab Name> -- <Field Label>
(FieldName).

See the example image below showing two Lookup fields in the Field
selection. The first field in the Lookup is located on the home form (i.e.,
parent form). The second field is located on a tabbed extension of the
parent form (or child form) and uses the aforementioned naming
convention.

See the example image below showing two Multi-Lookup fields in the
Field selection. Just as with the example above of a regular Lookup field,
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the parent form field and child form field are easily distinguishable.

3. When ready, click Ok.

Triggered Form: Dataform

In Step 1 Channel, in Triggered Form, when you select a dataform, the available fields in Step 2 are
variable and dependent on the specific form fields. You will only see fields for the form you are cloning,
and the fields have to be marked as cloneable for that form.

Additionally, date fields can vary. Some dataforms may have Date One and Date Two, and others may
have Due Date. On Step 1, when the Triggered Form is a dataform, and the date field is not required,
you have the option to set the On Create Date to None.

2. In Step 1 Channel, in Triggered Form, if you selected a dataform, the displayed fields vary,
depending on your selections in Step 1. The following fields focus on date.

Item
Name

Provide a brief descriptive name for what this workflow item does.

Date
One,
Date
Two,
Due
Date

Date field names vary by dataform. Date fields in red ink are required and black ink are
not required. When the date field is not required, an additional option of None is
available.

To configure a date field:

1. Select On Create Date.
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The Date Options dialog box opens.

For date fields that are not required, the None option becomes available. For required
(red ink) date fields, None is not an option.

2. Select an option:
l None: Indicates the date does not require a value when configuring. The field

will be empty when the workflow channel is triggered.
l Create Date: Default value. Optionally, you can use Offset to specify a

number of days, weeks, months, years, hours, end of month, beginning of
year, or end of year.

l Specific Date: Enables the Date field where you can use the date picker.
Optionally, you can use Offset to specify a number of days, weeks, months,
years, hours, end of month, beginning of year, or end of year.

l From a Field on a Form: Includes the triggering form for that workflow, in
addition to all single dataforms with Date fields.

o When you select From a Field on a Form, Dataform is enabled.
Select the Dataform that has a date field.

o When you select a dataform, Field becomes available.
o Optionally, you can use Offset to specify a number of days, weeks,

months, years, hours, end of month, beginning of year, or end of
year.

l Offset: You can use Offset with Create Date, Specific Date, and From a Field
on a Form. Default value is 0 Business Days.

3. When ready, click Ok.

Looku Lookup and Multi-Lookup field names vary by dataform. To display as an available field
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p and
Multi-
Looku
p
fields

on a workflow item, a Lookup or Multi-Lookup field must be set as a workflow cloneable
field.
Note: Multi-Lookup fields work the same as a regular Lookups except that users can pick
more than one selection from the list of available options.

To configure a lookup field:

1. Click next to a Lookup or Multi-Lookup field.
The Status Options dialog box opens.

2. Select an option: 
l None: This is the default initial state. When the workflow item triggers, any

Lookup or Multi-Lookup field set to None will be blank on the new or
updated dataform. The only exception is when the field is a required field
(designated by red text). You must set a value for required fields.

l Specific Value: When the workflow item triggers, the Lookup field value or
Multi-Lookup field value(s) that you select will be set in the corresponding
field on the new or updated dataform.

l From a Field on a Form: When the workflow item triggers, the set value(s)
from the Lookup field or Multi-Lookup field on the form you select auto-fills
the corresponding field on the new or updated dataform. The From a Field
on a Form option is only available when there are Lookup or Multi-Lookup
fields on other forms in the same workspace that have the same Lookup
Group.

Note: Tabbed form Lookup and Multi-Lookup fields have the following naming
convention to help you determine where the field you are selecting is
located: *<Dataform Tab Name> -- <Field Label>(FieldName).

See the example image below showing two Lookup fields in the Field selection. The
first field in the Lookup is located on the home form (i.e., parent form). The second

ClientSpace Setup & Administration © 2025 PrismHR 156

Chapter 3 Workflow Channels



field is located on a tabbed extension of the parent form (or child form) and uses
the aforementioned naming convention.

See the example image below showing two Multi-Lookup fields in the Field
selection. Just as with the example above of a regular Lookup field, the parent form
field and child form field are easily distinguishable.

3. When ready, click Ok.

Nume
ric
Fields

To display as an available field on a workflow item, a numeric fields must be set as a
workflow cloneable field.
Note: Numeric datatype fields are defined in ClientSpace with a field properties Element
Type of Integer, Decimal, Money, or Percent.

To configure a numeric field:

1. Click next to a numeric field.
The Options dialog box opens.

2. Select an option: 
l None: This is the default initial selection. When the workflow item triggers,

any numeric field set to None will be blank on the new dataform. The only
exception is when the field is a required field (designated by red text). You
must set a value for required fields.

l Specific Value: When the workflow item triggers, the numeric field value you
enter will be set in the corresponding field on the new dataform.

l From a Field on a Form: Select a source Dataform and a source Field from
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the selected dataform. When the workflow item triggers, the set value from
the numeric field on the source dataform auto-fills the corresponding field on
the new dataform.

o The From a Field on a Form option is only available when there are
numeric fields of the same datatype on other single forms in the
same workspace.

o The fields available for selection in the Field drop down list are
filtered by datatype. They must have the same datatype as the
triggering form field. Example: If the field on the triggering form is a
Decimal datatype, numeric fields from the source dataform with a
Decimal datatype display in the list of available source fields.

o Numeric datatype source fields come from single forms only with
one exception: Numeric datatype fields from a multi-form only
display if it is the triggering form.

o Tabbed form numeric fields have the following naming convention
to help you determine where the field you are selecting is
located: *<Dataform Tab Name> -- <Field Label>(FieldName).
See an example below:

o When the workflow is triggered, the system evaluates and respects
any Minimum and Maximum values set in the field properties. Any
value not within the set range will not be applied.

3. When ready, click Ok.

3. When ready, click Next. Step 3: Notifications opens.
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Step 3: Notifications
In this optional step, you can select users to notify when the workflow is triggered. You can notify the
current user (logged in user) as well as other users.

To add notifications:

1. To notify the current user (the triggering user), select Notify Current User.
2. To notify additional users, click None.

The Options dialog box opens, with User Source options: None, Specific User, and From a Field
on a Form.

n For Specific User, select a User and click Ok. You can select multiple users to receive
notifications. As you select users, the list is displayed.
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n For From a Field on a Form, you have additional choices — from which Dataform and then
which Field. The Dataform selection drives the items in Field. From a Field on a Form allows
you to select users across tabbed dataforms. For more details about selecting users across
tabbed dataforms, see Workflows and Tabbed Dataforms.

3. When ready, click Ok.
The notification list displays the users that are to receive the notification.
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To remove users from the notifications list:

4. Click (Remove).
5. When you are ready to move to Conditions, click Next. Step 4: Conditions opens.
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Step 4: Conditions
In this step, you can add one or more conditions to use in conjunction with the Workflow Action in Step
1 when determining if the workflow is triggered. What additional conditions would you like to have met
to trigger this workflow?

Trigger on number of days from a date: You can set a condition based on the number of
days/months/years from a date. This feature uses the Field, Operator, and Value columns. See the
procedure later in this topic.

Clone a trigger: For triggers that are similar, use the Clone feature to copy a trigger condition. See the
procedure later in this topic.

Decide when you want to publish: When you reach the end of the initial item of a Workflow Channel,
you have the option to go back a step, continue, or finish. These options allow you to decide when you
want to publish the newly added Workflow Channel. See the procedure later in this topic.

To configure Conditions:

1. Complete the form:

Only trigger this
workflow once

Sometimes you only want a workflow to happen once. For example, the
first time an employee marital status changes, you may want to send a
notification about how this can affect their tax status and W4. You can use
this option to ensure that this triggering condition is unique and only
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happens once.
When a single dataform is selected as the Triggering Form in Step 1, then
Only trigger this workflow once is enabled (selected) and marked read-
only. When a single dataform is selected as the Triggering Form, its
respective Replace Fields and Condition options are removed from the
workflow item. This works for Scheduled Workflows as well. Single
dataforms such as Client Master and Client Team are not candidates for
cloning because these forms have a one-to-one relationship with the
workspace.

Publish By default, this option is enabled. When the configuration is complete and
you click Continue or Finish, a prompt is displayed asking if you want to
publish.

Condition Expression The Workflow Action condition was set in Step 1. This is the dataform or
task field (or HdrAction) that when changed, it triggers the workflow.
• In Step 4, you can also add more complex triggering conditions to this

primary condition by selecting dataform/task fields and setting a
Value, Operator, and Label. You can also add triggering conditions
based on a Value comparison. The comparison Value can be a
manually typed, static value or a field value located on the same
dataform or a different single dataform. (If you are selecting the same
dataform, it can be a either be a single dataform or a multi-form. If you
are selecting a different dataform, it must be a single dataform.)

• These conditions are combined with the Workflow Action set in Step 1
using an implied AND.

• If the Condition Expression field is not filled, the additional conditions
that are set in Step 4 are all treated as OR conditions. Example: The
Workflow Action AND Condition 1 OR Condition2 OR Condition3.

• The Condition Expression field allows for AND as well as OR conditions
using the Condition Expression feature.

• Using the Label field on the Condition, you can combine trigger
conditions into more complex expressions, overriding the default OR
behavior combined with the implied AND for the Workflow Action. For
example, the Workflow Action AND (Condition1 AND Condition2) OR
(Condition3 AND Condition4) OR Condition5.

For a deeper discussion about Condition Expressions, see Condition
expressions.
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2. To add conditions, click Add and complete the following fields:

Source The Source list includes the triggering form and its tabs, the channel
trigger (i.e., the original form that started the channel), all triggerable,
active single-forms, and the tabs of those single-forms. Applicable server
data procs, if configured, and other workflow items, such as a HdrAction,
may also be included.

Note: 

l HdrAction is only available when the Source is the parent triggering
form. If Source is anything other than the Triggering Form,
HdrAction is not available in the Field list.

l Condition Expressions operators (AND, OR, and NOT) work across
multiple dataforms.

l IsDirty does not appear in the trigger operator list because the task
can be separated from the dataform by several other tasks; the
dataform may not be dirty.

l The Add Untriggered functionality option is available when adding
fields from this source. If you select an untriggered field, ClientSpace
will set the field to triggerable in the field settings.

l If the dataform is the main triggering dataform for the workflow, the
condition Source is Channel Trigger: <NameOfTriggeringForm>.

l If the dataform is a cloned dataform workflow item, the condition
Source is Workflow #<ItemNumber>: <ItemName>.

For additional details about tabbed dataforms, see Workflows and Tabbed
Dataforms.

Field If you selected either a dataform or task for Source, Field contains an
appropriate list of fields for the triggering task or form. You can add a
triggered field and also use multi-lookup fields (Multi Lookup
(MultiLookup)) as triggering conditions.

A dataform Active field can even be used to trigger a task or form. (If you
are building a dataform condition using the Active field, the Source must
be the Triggering Form.) Workflow conditions can be built based on a
specific Active field value (i.e., Checked or Unchecked) or whether the
Active field was changed from its current value (i.e., IsDirty):
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l Field = Active, Operator = Equals, Value = Checked or Unchecked.
l Field = Active, Operator = IsDirty.

However, keep in mind that when you add a new record (such as a Client
Service Case record), behind-the-scenes the system is applying a default
Active status to the record which places the Active field in an edit or
"IsDirty" status upon "Add". If you do not want a workflow condition that
uses the Active field as a trigger condition to trigger on the initial "Add" of
a record, be certain to change the Execute On field value (located on the
Step 1: Triggering page of the Workflow Items wizard) to Update.

See Step 1: Triggering.

A triggered form field is only editable on Add. Trigger Fields also support
parent form fields (only available operators are empty, not empty, and
dirty).

For Source such as Client Master, you can select Additional Record
Information. Additional Record Information is for determining who made a
change to employee information, such as email address changes. See
Tracking data modifications in PrismHR.

To add a trigger field:

1. In Field, go to the end of the list and select Add Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as triggerable.

2. In Field, select an entry and click Ok.
The selected field is marked as triggerable and now appears in the
Field list.

Operator Operator is based on the type of Field selected but ranges from IsEmpty
(nothing in a field) to a specified value. Each value from a Multi Lookup
field can be added as a separate = condition. This supports complex AND,
OR, and NOT conditions as well. Is Dirty is not available in the Operator list
when the Source is set to something other than the Triggering Form.

Value This is the value you are comparing the field to when attempting to meet a
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triggering condition.

Label A label is used when combining conditions into a complex Condition
Expression. ClientSpace assigns a label to a new condition with the naming
convention C#. For example, C1 for the first condition that you create, C2
for the second, and so on. You can change the label name by selecting the
name of the label and typing a new name for the label. For example, you
can select the C1 label and enter Condition1 as the new label name.
Note: If a Label is not used in a Condition Expression, then the condition is
an implied OR. In the example, if the Condition Expression was blank, this
workflow would be triggered in the following manner: Workflow Action
Trigger (Step 1) AND Condition1 OR Condition2

To trigger conditions based on number of minutes/hours/days/months/years from a date:

3. Complete the form fields:

Field Select a Date or Date Time datatype field. This action makes the Aging
operators available in Operator.

Note: When comparing Date to Date Time datatypes (or vice versa)
12:00:00AM is used as the comparison time for the Date datatype.

Operator Select one of the following:
l Aging (from now) > =

o Greater than or equal to the number of days/months/years in
Value.

l Aging (from now) < =
o Less than or equal to the number of days/months/years in

Value.
The less than operator requires that the evaluated date occurs between
the calculated date and today. It has to be between the date set in the
configuration. For example, if the value is 6d, the from date must be
between 6 days ahead and today.

Value Type a number accompanied by:
l mm: for minutes (Only works with Date Time fields)
l h: for hours (Only works with Date Time fields)
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l d: for days
l m: for months
l y: for years

Putting it all together
The following example illustrates two conditions: GreaterThan_2days and LessThan_8Days. The
Condition Expression is stated as GreaterThan_2days AND LessThan_8Days. For an aging evaluation,
this condition requires more than 2 days and less than 8 days.

These trigger conditions can be a bit complex. If you need assistance, please log an Extranet case.

Cloning a trigger condition

To save some time, you can clone a trigger condition and then edit as appropriate.

To clone a trigger:

1. In the Add section, locate an entry that you want to copy.

2. Click Clone.
A new row opens, with the trigger condition copied. Source, Field, and Operator are copied.
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3. You can now edit the new condition as appropriate.
4. Click Apply or Save.

What's next?

You can optionally add attachments or publish the workflow without adding attachments. See Step 5:
Attachments and Publishing and unpublishing workflows.

Condition expressions

Condition expressions are used in email templates, workflow channels, widget layouts, and custom
links. Condition expressions are used to control when an event or action is triggered.

Condition Expressions use Labels from Display Conditions along with AND, OR, and NOT operators to
control precedence and sequence.

• The AND operator specifies that all specified conditions must be met for a query to return true. The
AND is exclusive. AND narrows a search by telling the database that all keywords used must be
found.

• The OR operator specifies that if one of two or more conditions is met, then the query is true. The
OR only needs one data point to be present. OR broadens a search by telling the database that any
of the words it connects are acceptable.

• The NOT operator allows you to exclude items that are not relevant to your search. NOT narrows
your search by telling the database to eliminate all terms that follow it.

AND expressions

AND expressions are used when you want to include all conditions. For example, consider an expression
that specifies that the month must be January and the day of the week must be a Monday (January
AND Monday). This expression specifies that all data points must be present; it is exclusive.

OR expressions

OR expressions are used when you want to find an overlap between items. For example, (January OR
Monday) specifies that the day could be in January or could be a Monday of any month. This
expression specifies that any data point can be present and is inclusive.
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NOT expressions

NOT expressions are used when you are interested in a very specific list by letting you eliminate items
that are not relevant. For example, (January NOT Monday) specifies that the day could be in January but
cannot be a Monday.

Where to start

The first step in creating Condition Expressions is to determine your objective. A good place to start is
with a flowchart using Yes and No logic. Determine the fields and values and whether the condition is
to meet all conditions or just one data point. Next, determine how you want to group the criteria. You
then must add the conditions (from within a form) and then determine how to group them using
Condition Expressions. The remaining portion of this topic describes and illustrates how to compose
Condition Expressions.

Before you can build a condition expression, you must first add the conditions from within a form such
as Configure Data Links Details.

1. Add Display Conditions

For forms that offer conditions, when you click Add (lower portion of the form), a row opens where you
can assign values to within fields such as Source, Field, Operator, Value, and Label (see the following
image). The values must correspond to what is stored in the database. For example, lookups would be
the Code value, and for parent form fields, such as Case Type, the value would be the ID of the form.

The following example illustrates two expressions, HOL1 and HOL2. These entries are Display
Conditions. When the Condition Expression field is empty, the Display Conditions are processed as
ORs. For example, in the following example, there is no Condition Expression. Therefore, HOL1 and
HOL2 are processed as ORs. The result would be the match for each condition; it would be all-inclusive
(WHERE Holiday Name = Christmas OR Holiday Name = New Year's Day).

2. Add a condition expression

But what if you want to treat the Display Condition statements differently? What if OR is not enough?
You can use a Condition Expression by referencing the display condition statements (through Labels)
and adding the AND and OR operators: (Cond1 AND Cond2) OR (Cond3). With a Condition Expression,
you can control how many conditions you use and how they are used.
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When building a Condition Expression, you use the condition Label value of the Display Conditions. You
can create complex conditions by using unique combinations of the conditions. Condition Expressions
can use AND as well as OR conditions.

For example, to trigger a workflow when there is a new training request, the expression could be stated
as (CaseTypeTR AND CaseNEW) where:

• CaseTypeTR: When case type = Training Request
• CaseNew: When case status = New
Using the Label field, you can combine trigger conditions into more complex expressions. For example:
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR Condition5.

The following example has three Display Conditions: STAT, CITY, GEN. Two of the three Labels are used
in the Condition Expression.

• The (STAT AND CITY) Condition Expression is looking for employees who are married and reside in
Sarasota. This result is exclusive.

• When the three separate conditions (STAT, CITY, GEN) are used without a Condition Expression, the
search is for employees who are married, or reside in Sarasota, or are female. The result is inclusive.

Continue to the next topic, Order of operation.

Order of operation

The order of execution can significantly affect the resulting value. To control order and precedence you
use parentheses to group functions. Everything within the parentheses is evaluated first to yield a single
value before that value can be used by any operator outside the parentheses. If an expression has
nested parentheses, the most deeply nested expression is evaluated first.

When a condition is met, the evaluation ends, using the results of the first successful condition. For 
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR Condition5, if the first set 
(Condition1 AND Condition2) is met, then the remaining OR statements are ignored.

Note: You can only use Labels and the AND, NOT, and OR operators in your Condition Expression.
The Condition Expression cannot contain SQL keywords.
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Condition expression example
The following example illustrates multiple expressions for filtering attributes of a physical property
(structure) and user rights:

• Is the property owner-occupied?
• Is the property located in one of the following states: Georgia, Alabama, Arizona?
• Is the property height in the number of stories greater than or equal to 5?
• Does the user have the security entity named biz_RequestTypeCategory_Envornmental?

Example
Each expression Label is brief and descriptive: OO, GA, AL, SECenv, 5PLUS, AZ. 

Type Description Label

FieldValueExpression gen_Property.OwnerOccupied Equals Yes OO

FieldValueExpression gen_Property.State Equals GA GA

FieldValueExpression gen_Property.State Equals AL AL

SecurityEntity Security Entity Equals biz_RequestTypeCategory_Environmental SECenv

FieldValueExpression gen_Property.NumOfStories Greater Than or Equal 5 5PLUS

FieldValueExpression gen_Property.State2 Equals AZ AZ

Condition expression example
The Labels are used in the Condition Expression along with the AND and OR operators. Additionally,
grouping and nesting control the evaluation.

The following example has two major groupings delineated by sets of parentheses. Within each major
group, there is a sub-group, also delineated by a set of parentheses.

(OO AND (GA OR AL)) OR (SECenv AND (5PLUS AND AZ))
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First group - the AND Parentheses and
groupings

The first grouping has two sets of parentheses: 
• The first group specifies owner-occupied as OO. You need a set of

parentheses for OO. Sub-groups are placed inside the parentheses of
the major group.

(OO AND (GA OR AL))

• Within the owner-occupied group, the location must be GA or AL. You
need a second set of parentheses for the locations GA and AL.

(OO AND (GA OR AL))

Second group - the OR

The second grouping has two sets of parentheses:
• The first group is SECenv. You need a set of parentheses for this major

group.

(SECenv AND (5PLUS
AND AZ))

• The second group is the number of stories and location. Place the sub-
group within a set of parentheses.

(SECenv AND (5PLUS
AND AZ))
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The following diagram explains how the sample condition expression is evaluated.

Result
For the expression (OO AND (GA OR AL)) OR (SECenv AND (5PLUS AND AZ))

• If the property is owner-occupied and is located in Georgia or Alabama, then the evaluation ends
because the condition has been met. The OR portion is ignored.

• However, if there are no properties that are owner-occupied in either Georgia or Alabama, then the
OR expression is evaluated. The OR portion looks for:
• user view rights to RequestTypeCategory_Environmental
• and the property must be in Arizona with a minimum height of 5 stories
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Summary
The examples provided in this topic use nested groupings along with the AND and OR operators. Keep
in mind that your needs may vary. Additionally, plan ahead. Determine your Display Conditions and use
brief Labels. After you have defined your Display Conditions, then you are ready to compose the
Condition Expression.
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Step 5: Attachments
You can optionally add attachments to a workflow. The attachments are added to the triggered form
when the workflow is executed. You can add two kinds of attachments:

l File upload field attachment: Select a file upload field from a form. The form can be a single
form located in the workspace where you are building the workflow OR a multiform if it is the
triggering form.

l Static attachment: A static attachment is an attachment not associated with a dataform. Once
you click Apply or Save on a new workflow, an Attachments panel displays. You can browse to
any file on your computer and upload it to the workflow. When the workflow executes, it is added
to the triggered form along with any file attachments.

l Attachment link: You can also add a link to a site on a triggered form from the workflow
Attachments panel. When the workflow executes, it is added to the triggered form along with any
file attachments.

Also see Putting It All Together: Workflow Attachments.

To add an attachment:

1. Click Add.
2. To add file upload field attachments, complete the form:

Dataform Select the dataform where the file upload field containing the attachment is
located. The listed forms are single forms only with exception of the triggering
form. If it is a multiform and not a single form, it is also included in the list.

Field Select the field upload field containing the attachment you want to add to the
triggered form.

Note: If the field is blank when the workflow is executed, no workflow attachment
will be added to the triggered form.

3. Repeat step 2 above until all desired file upload field attachments are added.
4. Click Apply or Save.

If this is a new workflow, the Attachments panel displays.
5. Optionally, you can add a static attachment that is not associated with a dataform from the

Attachments panel.
Follow these steps to add a file attachment:
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a. Click the Attachments panel.
b. On the Attachments tab, click Add to upload a new file.

The Upload File window displays.
c. Click Choose File.
d. Locate the file on your computer and click Open.

The file name displays in the File field of the Upload File window.
e. Optionally, you can provide Description, Category, and Tags information
f. Click Save on the Upload File window.

The Upload File window closes and the attachment file you just added is listed on the
Attachments panel. You can click the file name or click (Edit) next to the attachment
file name to view your file.
Note: You can discard an uploaded file by clicking (Remove) next to the attachment
file name.

6. Optionally, you can add an attachment link to a site on the triggered form from the Attachments
panel.
Follow these steps to add a link attachment:

a. Click the Attachments panel.

b. Click the Links tab, click Add to add a link.
The Link File window displays.

c. Type the URL in the Link field.
d. Optionally, type a link description in the Description field.
e. Click Save on the Link File window.

The Link File window closes and the link you just added is listed on the Links tab of the
Attachments panel. You can click the link name or click (Edit) next to the link to test
the link.
Note: You can discard a link by clicking (Remove) next to the link name.

Completing the Configuration

You can decide the next action: Back, Continue, or Finish.

To complete the configuration, when ready, you can click Back, Continue, or Finish:

1. Click Back to return to the previous step of the Workflow item.
2. Click Continue and respond to "This Workflow Channel is unpublished. Would you like to

publish?" with the options Yes or No. Either selection takes you to the first step of the dependent
Workflow item (the next item in the workflow). This allows you to add cascading steps that trigger
from the workflow you just created.
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Note: Alternatively, you can click Continue Workflow from Here in the Dependent Workflow
panel to add a dependent workflow.

3. Click Finish and respond to "This Workflow Channel is unpublished. Would you like to publish?"
with the options Yes or No.

l Yes returns you to the Workflow Channel search list with the new Workflow Channel in a
published state.

l No returns you to the Workflow Channel search list with the new Workflow Channel in an
unpublished state.

Putting It All Together: Workflow Attachments
l When the workflow executes, any workflow attachments (file upload field attachments, static file

attachments, and attachment links) are added to the Workflow Attachments panel located in
the Action Center of the triggered form. See the Workflow Attachments section of Workflow
Channel Action Items.

l Workflow Attachments links are links to the original URL.
l Workflow Attachments are links to the original source file as it existed when the workflow was

executed.
l If a source file is later updated after the workflow has been executed, the link to the version of the

file at the time of workflow execution remains intact on the triggered form.

Note: If you no longer want that version of the file associated with the triggered form, you can
delete it by clicking (Remove) next to the attachment file name in the Workflow Attachments
panel of the triggered form.

l If a source file is deleted by a user, the file cleanup process bypasses deletion of the file if any
Workflow Attachments panel file links to that file are found.

What's next?

You can publish or unpublish from the Workflow Channels list. See Publishing and unpublishing
workflows.

Learning how: Configuring Workflow Channels

Note: Some parts of this video may not represent the most recent changes to the ClientSpace user
interface.

View the video Configuring Workflow Channels.
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Learning how: Advanced Workflow Configuration
View the video Advanced Workflow Configuration.

Searching Workflow Items
It is helpful to search the workflow items to find specific items or items that share a characteristic (for
example, the same pipeline). From the Workflow Items dashboard, use the Quick Search and More
search options to filter the list.

To search Workflow Items:

1. Go to System Admin > Workflow Channels.
The Workflow Channels dashboard opens.

2. Click Workflow Items.
The Workflow Items dashboard opens.

3. In Quick Search, you can type text or numbers to find matching entries quickly. You can search
for the Item Number and Triggered Form (starts with).

4. In More search, you can further refine the criteria by Item #, Channel #, Template, Specific User,
Triggered Form, Pipeline, and Type. The default setting is to search for items with the Status of
Published. You can change this to All or Unpublished.
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5. Select your criteria and click Search.
The system displays the filtered list. If the filtered list includes unpublished workflow items, they
will display in italics and bold with the Published checkbox unchecked. Published workflow items
display in normal text with the Published checkbox checked.

ClientSpace Setup & Administration © 2025 PrismHR 179

Chapter 3 Workflow Channels



Configuring Workflow Items
When you have completed the four-step process for creating a workflow channel, you are returned to
the Channel. Channel is the top-level item that can have multiple workflow items, all potentially
triggered from unique conditions. In our example, a Risk case in the Southeast region could generate a
different workflow than the same case in the Northwest region and so on. All these top-level Workflow
items are attached to the Workflow Channel.

Workflow Channels can contain many workflow items, and each item can have dependent workflow
items. You can add, edit, and remove workflow items from the channel using this interface.

From the Workflow Channels list, you can edit a workflow channel and complete one of the
following actions in the Workflow Items in this Channel section:
l Open: Select an existing workflow item and click (Jump) to begin editing an existing workflow.

l

Delete: Select an existing workflow item and click (Delete) to delete the selected
Workflow Item and any dependent items.

l

Add: Click (Add) to add a new Workflow Item for this channel.

To configure a new workflow item:

1. From an open workflow channel, select .
2. Select Real Time or Scheduled.

The Add Workflow form opens. The following topics follow the Real Time workflow. For
information about scheduled workflows, see Configuring Scheduled Workflows.

You are presented with a four-step process wizard: Triggering, Content, Notifications, and Conditions.
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1. Step 1: Triggering
2. Step 2: Content
3. Step 3: Notifications
4. Step 4: Conditions
5. Step 5: Attachments

To publish or unpublish an existing workflow item:

1. From an open workflow channel, click the workflow item you want to publish or unpublish
"Workflow Items in the Channel" section and select (Jump).

2. Click the Step 4: Conditions tab.
3. Place a check mark in the Publish checkbox to publish the workflow item or remove the check

mark from the Publish checkbox to unpublish a workflow item.
4. Click Save.
5. Return to the main workflow channel page.

Published workflow items display as normal text. Unpublished workflow items display in italics
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and bold.

Workflow Items Dashboard
A global admin user can click the Workflow Items button on the Workflow Channels dashboard to
access the Workflow Items dashboard. A global admin user can use the Workflow Items dashboard to
find and then edit workflow items without drilling into each individual workflow channel. The Workflow
Items dashboard provides an efficient mechanism for workflow item maintenance. For example, a
global admin user can use the More search option to find all workflow items for a specific pipeline and
apply edits to those workflow items. For more information, see workflow items or Searching Workflow
Items.
The following graphic illustrates the Workflow Items dashboard.
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Step 1: Triggering
In this step create a Workflow Item name and define how this Workflow Item is triggered.
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To configure the triggering:

1. From the Add Workflow form, complete the form fields:

Channel Name Provide a unique Channel Name. This should be descriptive and short.

Triggering Form This is the form that triggers the workflow. Select a form or add a
triggering form that is not in the list. The list also includes single
dataforms that do not already exist in a workspace when triggering
occurs. Selecting a single form is best for custom created single
dataforms.

To add a dataform that is not in the list:
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1. In Triggering Form, go to the end of the list and select Add
Untriggered Form.
The Select an Untriggered Form dialog opens.

2. In Table Name, select a dataform from the list.
3. Click Ok.

The selected dataform is marked as triggerable and now appears in
the Table Name list.

Item Name Provide a short descriptive name for what this workflow object is.

Execute On • Insert: Item will be triggered only on the creation of a record.
• Update: Item will be triggered on a save of an existing record.
• Insert/Update: Or both?

Display Order This allows the admin to add ordering information on the detail record of
a workflow item that is then reflected in the order the workflow items
appear in both the workflow item list and the visualizer. This does not
affect the triggering of workflow items but is merely a visual reference to
better allow admins to organize these lists.

Execution Pipeline Choose a pipeline. Ensure that anything connected to the workflow
(dataforms or imports) is configured to use one of the pipelines
configured on the workflow. For questions or help with this configuration,
log an Extranet case.
Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new workflow channel, pipelines
assigned a behavior of Default will auto-fill the Execution Pipeline field. If
you are editing an existing workflow channel, Execution Pipeline entries
remain intact until edited. Changed entries are validated against the
Pipeline Linking table. For instance, if a pipeline has been assigned a
behavior of Allow or Default and you remove it, you will still be able to
select it from the Execution Pipeline list. If the same pipeline is assigned
a behavior of Disallow, you will not be able to add it again.

See Configuring Pipeline Linking.

Workspace Template Select a template to apply to workspaces that will use this workflow. The
Workspace Templates field is a multi-select, which allows you to apply a
workflow channel across multiple workspace templates. If no specific
templates are selected, the Workspace Templates field defaults to All
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Templates.

Save triggering form
when last task
complete?

This field indicates whether the system will trigger business rules that use
the Workflow Tasks Complete pipeline when the final task in the workflow
chain is complete. When selected, this field indicates that the system will
trigger business rules when completing the final task in the workflow
chain. When not selected, the system does not trigger the business rules
when the final task in the workflow chain is complete.

Channel Description Provide a brief description of this channel.

Channel Owner Defaults to the current user. Set it to the owner of this process.

Workflow Action This section is dedicated to the primary triggering condition for the
workflow.

No Primary Trigger When selected, this field indicates no single condition must be met to
trigger the Workflow. If this option is selected, at least one condition must
be provided on the Conditions step. When you select No Primary Trigger,
Field, Operator, and Value are not available because they are not
applicable.

Field What field on the triggering form (or HdrAction configured on a link) will
fire this workflow? This field must have been changed to the triggering
value for the trigger to fire. You can also add a trigger field.

To add a trigger field:

1. In Trigger Field, go to the end of the list and select Add
Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as Triggerable.

2. In Field, select an entry
3. Click Ok.

The selected field is marked as triggerable and appears in the
Trigger Field list.

Scheduled Workflows
For scheduled workflows, when the triggering form is the home form in a
tabbed set, Field returns all Date fields across the tabbed form set. Field
points to a date field on the triggering form.
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Operator Comparison type used to determine if the trigger condition is met.
(Contains, Equals, Does Not Equal)

Value The value evaluated to ensure the trigger condition is met. For system
selectors such as lookups, or for Header actions, this is a select list.

Triggered Form Can be a dataform (with Workflow Cloneable fields) or a task. The selected
dataform affects the displayed fields in Step 2 Content.

If the Triggered Form field is set to Task, you must select a form in
the Attach To field.

If the Triggered Form field is no longer cloneable, a warning
message displays: Workflow channel cloning is no longer enabled
for this triggered form. If you still wish to use this as your triggered
form, go to Dataform admin and select the Enable WFC Cloning
option.

2. When done, click Next. Step 2: Content opens.

Step 2: Content
In this step this is where the rubber meets the road. Information entered into the fields below will be
copied to each cloned object created by this item.

Field Replacement

To use Get Replace Fields:

Triggered Form: Task

In Step 1 Triggering, in Triggered Form, when you select Task, the fields in Step 2 are as follows.
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To configure the content:

1. Complete the fields:

Item Name Provide a short descriptive name for what this workflow object is.

IsMarkedForDelet
ion

When this option is selected, the Workflow clones the task with this field
selected. Then, when the scheduled process, Delete Marked Tasks, runs, it
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finds all the tasks with this field select, and deletes the task.

Attach To This field is available only when a user selects Task in the Triggered Form
field. This field indicates the form that the task will be assigned to. Select This
Form to indicate that the form that triggered the workflow will be the form to
which the task is attached.

Note: If a form selected in the Attached To field is inactivated or removed
from the workspace at some point in time and the workflow item is not
edited to select a different form, then the task will attach to the triggering
form.

Subject Subject Line that displays on the task. This field supports field replacement.
See Step 2: Content.

Body Include any instructions that you feel could be helpful. This field should
contain information to provide steps to complete the task. This field supports
field replacement. See Step 2: Content.

Category Choose the appropriate Task Category.

Status Select the appropriate Task Status.

Priority What is the criticality of this task?

Type Within the category, what is the task type?

Stage Also called workflow. Where in the process does this task fall?

Assigned To,
Owner

For Assigned To, select the person responsible for accomplishing this task
from the following options. For Owner, select an owner.

To change Assigned To and Owner:

1. Select Current User.
The Assigned To or Owner Options dialog box opens.

2. Select an option:
l Current User: The logged in user who triggers the task.
l Specific User: A specific user in the Workspace. When you select

Specific User, the User field is enabled. This displays all active user
accounts.

l From a Field on a Form: Any user field on the triggering
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dataform is available.
o When you select From a Field on a Form, Dataform is

enabled.
o Select the Dataform that has a field from which to select

a User. Field becomes available.
o Select a user field.

3. Click Ok.
You are returned to the Add Workflow form.

For details about referencing users from tabbed dataforms (parent and child
dataforms), see Workflows and Tabbed Dataforms.

Start Date Source,
Due Date Source

Date Source options are Create Date, Specific Date, and From a Field on a
Form. Additionally, you can select the Offset as Days, Weeks, Months, Years,
Business Hours, Business Days, Beginning of Month, End of Month, Beginning
of Year, or End of Year. For Date/Time fields you have an additional option to
set Minutes.

Due Date Source: Tasks created by this workflow can have their due date set
by the task create date, or to a specific date from a dataform field. Choose
from the create date of the task or a Date type field on the triggering
dataform.

To configure dates:

1. Select On Create Date.
The Date Options dialog box opens.
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For date or date/time fields that are not required, the None option
becomes available. For required (red ink) date fields, None is not an
option.

2. Select an option:
l Create Date: Default value. Optionally, you can use Offset to

specify a number of days, weeks, months, years, business hours,
end of month, beginning of year, or end of year. For Date/Time
fields you have an additional option to hours and minutes.

l Specific Date: Enables the Date field where you can use the date
picker. Optionally, you can use Offset to specify a number of days,
weeks, months, years, business hours, end of month, beginning of
year, or end of yearFor Date/Time fields you have an additional
option to hours and minutes.

l From a Field on a Form: Includes the triggering form for that
workflow, all single dataforms with date fields, and child tab forms
when the Triggering Form (from Step 1) is a home form of a
tabbed set.

When you select From a Field on a Form, Dataform is
enabled. Select the Dataform that has a date field.

o When you select a dataform, Field becomes available.
Select a date field.

o Optionally, you can use Offset to specify a number of
days, weeks, months, years, business hours, end of
month, beginning of year, or end of year. For Date/Time
fields you have an additional option to hours and
minutes.

l Offset: You can use Offset with Create Date, Specific Date, and
From a Field on a Form. Default value is 0 Business Days.

3. When ready, click Ok.

You are returned to the Add Workflow form, where the Start and/or Due Date
Source fields show (as applicable): nn Business Days after Create Date, nn
Business Days after Specific Date, nn Business Days after Field Label (Contract
Effective Date).

Lookup and Lookup and Multi-Lookup field names vary by dataform. To display as an
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Multi-Lookup
fields

available field on a workflow item, a Lookup or Multi-Lookup field must be set
as a workflow cloneable field.
Note: Multi-Lookup fields work the same as a regular Lookups except that
users can pick more than one selection from the list of available options.

To configure a lookup field:

1. Click next to a Lookup or Multi-Lookup field.
The Status Options dialog box opens.

2. Select an option: 
l None: This is the default initial state. When the workflow item

triggers, any Lookup or Multi-Lookup field set to None will be
blank on the new or updated task. The only exception is when the
field is a required field (designated by red text). You must set a
value for required fields.

l Specific Value: When the workflow item triggers, the Lookup
field value or Multi-Lookup field value(s) that you select will be set
in the corresponding field on the new or updated task.

l From a Field on a Form: When the workflow item triggers, the
set value(s) from the Lookup field or Multi-Lookup field on the
form you select auto-fills the corresponding field on the new or
updated task. The From a Field on a Form option is only
available when there are Lookup or Multi-Lookup fields on other
forms in the same workspace that have the same Lookup Group.

Note: Tabbed form Lookup and Multi-Lookup fields have the following
naming convention to help you determine where the field you are
selecting is located: *<Dataform Tab Name> -- <Field Label>
(FieldName).
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See the example image below showing two Lookup fields in the Field
selection. The first field in the Lookup is located on the home form (i.e.,
parent form). The second field is located on a tabbed extension of the
parent form (or child form) and uses the aforementioned naming
convention.

See the example image below showing two Multi-Lookup fields in the
Field selection. Just as with the example above of a regular Lookup field,
the parent form field and child form field are easily distinguishable.

3. When ready, click Ok.

Triggered Form: Dataform

In Step 1 Triggering, in Triggered Form, when you select a dataform, the available fields in Step 2 are
variable and dependent on the specific form fields. You will only see fields for the form you are cloning,
and the fields have to be marked as cloneable for that form.

Additionally, date fields can vary. Some dataforms may have Date One and Date Two, and others may
have Due Date. On Step 1, when the Triggered Form is a dataform, and the date field is not required,
you have the option to set the On Create Date to None.
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2. In Step 1 Triggering, in Triggered Form, if you selected a dataform, the displayed fields vary,
depending on your selections in Step 1. The following table illustrates some of the fields that you
might see when using a dataform.

Item Name Provide a short descriptive name for what this workflow object is.

IsMarkedForDelet
ion

When this option is selected, the Workflow clones the task with this field
selected. Then, when the scheduled process, Delete Marked Tasks, runs, it
finds all the tasks with this field select, and deletes the task.

Attach To This field is available only when a user selects Task in the Triggered Form
field. This field indicates the form that the task will be assigned to. Select This
Form to indicate that the form that triggered the workflow will be the form to
which the task is attached.

Note: If a form selected in the Attached To field is inactivated or removed
from the workspace at some point in time and the workflow item is not
edited to select a different form, then the task will attach to the triggering
form.

Subject Subject Line that displays on the task. This field supports field replacement.
See Step 2: Content.

Body Include any instructions that you feel could be helpful. This field should
contain information to provide steps to complete the task. This field supports
field replacement. See Step 2: Content.

Category Choose the appropriate Task Category.

Status Select the appropriate Task Status.

Priority What is the criticality of this task?

Type Within the category, what is the task type?

Stage Also called workflow. Where in the process does this task fall?

Assigned To,
Owner

For Assigned To, select the person responsible for accomplishing this task
from the following options. For Owner, select an owner.

To change Assigned To and Owner:

1. Select Current User.
The Assigned To or Owner Options dialog box opens.
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2. Select an option:
l Current User: The logged in user who triggers the task.
l Specific User: A specific user in the Workspace. When you select

Specific User, the User field is enabled. This displays all active user
accounts.

l From a Field on a Form: Any user field on the triggering
dataform is available.

o When you select From a Field on a Form, Dataform is
enabled.

o Select the Dataform that has a field from which to select
a User. Field becomes available.

o Select a user field.
3. Click Ok.

You are returned to the Add Workflow form.

For details about referencing users from tabbed dataforms (parent and child
dataforms), see Workflows and Tabbed Dataforms.

Start Date Source,
Due Date Source

Date Source options are Create Date, Specific Date, and From a Field on a
Form. Additionally, you can select the Offset as Days, Weeks, Months, Years,
Business Hours, Business Days, Beginning of Month, End of Month, Beginning
of Year, or End of Year. For Date/Time fields you have an additional option to
set Minutes.

Due Date Source: Tasks created by this workflow can have their due date set
by the task create date, or to a specific date from a dataform field. Choose
from the create date of the task or a Date type field on the triggering
dataform.

To configure dates:

1. Select On Create Date.
The Date Options dialog box opens.
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For date or date/time fields that are not required, the None option
becomes available. For required (red ink) date fields, None is not an
option.

2. Select an option:
l Create Date: Default value. Optionally, you can use Offset to

specify a number of days, weeks, months, years, business hours,
end of month, beginning of year, or end of year. For Date/Time
fields you have an additional option to hours and minutes.

l Specific Date: Enables the Date field where you can use the date
picker. Optionally, you can use Offset to specify a number of days,
weeks, months, years, business hours, end of month, beginning of
year, or end of yearFor Date/Time fields you have an additional
option to hours and minutes.

l From a Field on a Form: Includes the triggering form for that
workflow, all single dataforms with date fields, and child tab forms
when the Triggering Form (from Step 1) is a home form of a
tabbed set.

When you select From a Field on a Form, Dataform is
enabled. Select the Dataform that has a date field.

o When you select a dataform, Field becomes available.
Select a date field.

o Optionally, you can use Offset to specify a number of
days, weeks, months, years, business hours, end of
month, beginning of year, or end of year. For Date/Time
fields you have an additional option to hours and
minutes.
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l Offset: You can use Offset with Create Date, Specific Date, and
From a Field on a Form. Default value is 0 Business Days.

3. When ready, click Ok.

You are returned to the Add Workflow form, where the Start and/or Due Date
Source fields show (as applicable): nn Business Days after Create Date, nn
Business Days after Specific Date, nn Business Days after Field Label (Contract
Effective Date).

Lookup and
Multi-Lookup
fields

Lookup and Multi-Lookup field names vary by dataform. To display as an
available field on a workflow item, a Lookup or Multi-Lookup field must be set
as a workflow cloneable field.
Note: Multi-Lookup fields work the same as a regular Lookups except that
users can pick more than one selection from the list of available options.

To configure a lookup field:

1. Click next to a Lookup or Multi-Lookup field.
The Status Options dialog box opens.

2. Select an option: 
l None: This is the default initial state. When the workflow item

triggers, any Lookup or Multi-Lookup field set to None will be
blank on the new or updated task. The only exception is when the
field is a required field (designated by red text). You must set a
value for required fields.

l Specific Value: When the workflow item triggers, the Lookup
field value or Multi-Lookup field value(s) that you select will be set
in the corresponding field on the new or updated task.

l From a Field on a Form: When the workflow item triggers, the
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set value(s) from the Lookup field or Multi-Lookup field on the
form you select auto-fills the corresponding field on the new or
updated task. The From a Field on a Form option is only
available when there are Lookup or Multi-Lookup fields on other
forms in the same workspace that have the same Lookup Group.

Note: Tabbed form Lookup and Multi-Lookup fields have the following
naming convention to help you determine where the field you are
selecting is located: *<Dataform Tab Name> -- <Field Label>
(FieldName).

See the example image below showing two Lookup fields in the Field
selection. The first field in the Lookup is located on the home form (i.e.,
parent form). The second field is located on a tabbed extension of the
parent form (or child form) and uses the aforementioned naming
convention.

See the example image below showing two Multi-Lookup fields in the
Field selection. Just as with the example above of a regular Lookup field,
the parent form field and child form field are easily distinguishable.

3. When ready, click Ok.

3. When done, click Next. Step 3: Notifications opens.

Step 3: Notifications
In this optional step, you can select users to notify when the workflow is triggered. You can notify the
current user (logged in user) as well as other users.
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To add notifications:

1. To notify the current user (the triggering user), select Notify Current User.
2. To notify additional users, click None.

The Options dialog box opens, with User Source options: None, Specific User, and From a Field
on a Form.

n For Specific User, select a User and click Ok. You can select multiple users to receive
notifications. As you select users, the list is displayed.
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n For From a Field on a Form, you have additional choices — from which Dataform and then
which Field. The Dataform selection drives the items in Field. From a Field on a Form allows
you to select users across tabbed dataforms. For more details about selecting users across
tabbed dataforms, see Workflows and Tabbed Dataforms.

3. When ready, click Ok.
The notification list displays the users that are to receive the notification.
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To remove users from the notifications list:

4. Click (Remove).
5. When you are ready to move to Conditions, click Next. Step 4: Conditions opens.

Step 4: Conditions
In this step, you can add one or more conditions to use in conjunction with the Workflow Action in Step
1 when determining if the workflow is triggered. What additional conditions would you like to have met
to trigger this workflow?

Trigger on number of days from a date: You can set a condition based on the number of
days/months/years from a date. This feature uses the Field, Operator, and Value columns. See the
procedure later in this topic.

Clone a trigger: For triggers that are similar, use the Clone feature to copy a trigger condition. See the
procedure later in this topic.

Decide when you want to publish: When you reach the end of the initial item of a Workflow Channel,
you have the option to go back a step, continue, or finish. These options allow you to decide when you
want to publish the newly added Workflow Channel. See the procedure later in this topic.
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To configure Conditions:

1. Complete the form:

Only trigger this
workflow once

Sometimes you only want a workflow to happen once. For example, the
first time an employee marital status changes, you may want to send a
notification about how this can affect their tax status and W4. You can use
this option to ensure that this triggering condition is unique and only
happens once.
When a single dataform is selected as the Triggering Form in Step 1, then
Only trigger this workflow once is enabled (selected) and marked read-
only. When a single dataform is selected as the Triggering Form, its
respective Replace Fields and Condition options are removed from the
workflow item. This works for Scheduled Workflows as well. Single
dataforms such as Client Master and Client Team are not candidates for
cloning because these forms have a one-to-one relationship with the
workspace.

Publish By default, this option is enabled. When the configuration is complete and
you click Continue or Finish, a prompt is displayed asking if you want to
publish.

Condition Expression The Workflow Action condition was set in Step 1. This is the dataform or
task field (or HdrAction) that when changed, it triggers the workflow.
• In Step 4, you can also add more complex triggering conditions to this

primary condition by selecting dataform/task fields and setting a
Value, Operator, and Label. You can also add triggering conditions
based on a Value comparison. The comparison Value can be a
manually typed, static value or a field value located on the same
dataform or a different single dataform. (If you are selecting the same
dataform, it can be a either be a single dataform or a multi-form. If you
are selecting a different dataform, it must be a single dataform.)

• These conditions are combined with the Workflow Action set in Step 1
using an implied AND.

• If the Condition Expression field is not filled, the additional conditions
that are set in Step 4 are all treated as OR conditions. Example: The
Workflow Action AND Condition 1 OR Condition2 OR Condition3.

• The Condition Expression field allows for AND as well as OR conditions
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using the Condition Expression feature.
• Using the Label field on the Condition, you can combine trigger

conditions into more complex expressions, overriding the default OR
behavior combined with the implied AND for the Workflow Action. For
example, the Workflow Action AND (Condition1 AND Condition2) OR
(Condition3 AND Condition4) OR Condition5.

For a deeper discussion about Condition Expressions, see Condition
expressions.

2. To add conditions, click Add and complete the following fields:

Source The Source list includes the triggering form and its tabs, the channel
trigger (i.e., the original form that started the channel), all triggerable,
active single-forms, and the tabs of those single-forms. Applicable server
data procs, if configured, and other workflow items, such as a HdrAction,
may also be included.

Note: 

l HdrAction is only available when the Source is the parent triggering
form. If Source is anything other than the Triggering Form,
HdrAction is not available in the Field list.

l Condition Expressions operators (AND, OR, and NOT) work across
multiple dataforms.

l IsDirty does not appear in the trigger operator list because the task
can be separated from the dataform by several other tasks; the
dataform may not be dirty.

l The Add Untriggered functionality option is available when adding
fields from this source. If you select an untriggered field, ClientSpace
will set the field to triggerable in the field settings.

l If the dataform is the main triggering dataform for the workflow, the
condition Source is Channel Trigger: <NameOfTriggeringForm>.

l If the dataform is a cloned dataform workflow item, the condition
Source is Workflow #<ItemNumber>: <ItemName>.

For additional details about tabbed dataforms, see Workflows and Tabbed
Dataforms.

Field If you selected either a dataform or task for Source, Field contains an
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appropriate list of fields for the triggering task or form. You can add a
triggered field and also use multi-lookup fields (Multi Lookup
(MultiLookup)) as triggering conditions.

A dataform Active field can even be used to trigger a task or form. (If you
are building a dataform condition using the Active field, the Source must
be the Triggering Form.) Workflow conditions can be built based on a
specific Active field value (i.e., Checked or Unchecked) or whether the
Active field was changed from its current value (i.e., IsDirty):
l Field = Active, Operator = Equals, Value = Checked or Unchecked.
l Field = Active, Operator = IsDirty.

However, keep in mind that when you add a new record (such as a Client
Service Case record), behind-the-scenes the system is applying a default
Active status to the record which places the Active field in an edit or
"IsDirty" status upon "Add". If you do not want a workflow condition that
uses the Active field as a trigger condition to trigger on the initial "Add" of
a record, be certain to change the Execute On field value (located on the
Step 1: Triggering page of the Workflow Items wizard) to Update.

See Step 1: Triggering.

A triggered form field is only editable on Add. Trigger Fields also support
parent form fields (only available operators are empty, not empty, and
dirty).

For Source such as Client Master, you can select Additional Record
Information. Additional Record Information is for determining who made a
change to employee information, such as email address changes. See
Tracking data modifications in PrismHR.

To add a trigger field:

1. In Field, go to the end of the list and select Add Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as triggerable.
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2. In Field, select an entry and click Ok.
The selected field is marked as triggerable and now appears in the
Field list.

Operator Operator is based on the type of Field selected but ranges from IsEmpty
(nothing in a field) to a specified value. Each value from a Multi Lookup
field can be added as a separate = condition. This supports complex AND,
OR, and NOT conditions as well. Is Dirty is not available in the Operator list
when the Source is set to something other than the Triggering Form.

Value This is the value you are comparing the field to when attempting to meet a
triggering condition.

Label A label is used when combining conditions into a complex Condition
Expression. ClientSpace assigns a label to a new condition with the naming
convention C#. For example, C1 for the first condition that you create, C2
for the second, and so on. You can change the label name by selecting the
name of the label and typing a new name for the label. For example, you
can select the C1 label and enter Condition1 as the new label name.
Note: If a Label is not used in a Condition Expression, then the condition is
an implied OR. In the example, if the Condition Expression was blank, this
workflow would be triggered in the following manner: Workflow Action
Trigger (Step 1) AND Condition1 OR Condition2

To trigger conditions based on number of minutes/hours/days/months/years from a date:

3. Complete the form fields:

Field Select a Date or Date Time datatype field. This action makes the Aging
operators available in Operator.

Note: When comparing Date to Date Time datatypes (or vice versa)
12:00:00AM is used as the comparison time for the Date datatype.

Operator Select one of the following:
l Aging (from now) > =

o Greater than or equal to the number of days/months/years in
Value.

l Aging (from now) < =
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o Less than or equal to the number of days/months/years in
Value.

The less than operator requires that the evaluated date occurs between
the calculated date and today. It has to be between the date set in the
configuration. For example, if the value is 6d, the from date must be
between 6 days ahead and today.

Value Type a number accompanied by:
l mm: for minutes (Only works with Date Time fields)
l h: for hours (Only works with Date Time fields)
l d: for days
l m: for months
l y: for years

Putting it all together
The following example illustrates two conditions: GreaterThan_2days and LessThan_8Days. The
Condition Expression is stated as GreaterThan_2days AND LessThan_8Days. For an aging evaluation,
this condition requires more than 2 days and less than 8 days.

These trigger conditions can be a bit complex. If you need assistance, please log an Extranet case.

Cloning a trigger condition

To save some time, you can clone a trigger condition and then edit as appropriate.
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To clone a trigger:

1. In the Add section, locate an entry that you want to copy.

2. Click Clone.
A new row opens, with the trigger condition copied. Source, Field, and Operator are copied.

3. You can now edit the new condition as appropriate.
4. Click Apply or Save.

What's next?

You can optionally add attachments. See Step 5: Attachments.
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Step 5: Attachments
You can optionally add attachments to a workflow. The attachments are added to the triggered form
when the workflow is executed. You can add two kinds of attachments:

l File upload field attachment: Select a file upload field from a form. The form can be a single
form located in the workspace where you are building the workflow OR a multiform if it is the
triggering form.

l Static attachment: A static attachment is an attachment not associated with a dataform. Once
you click Apply or Save on a new workflow, an Attachments panel displays. You can browse to
any file on your computer and upload it to the workflow. When the workflow executes, it is added
to the triggered form along with any file attachments.

l Attachment link: You can also add a link to a site on a triggered form from the workflow
Attachments panel. When the workflow executes, it is added to the triggered form along with any
file attachments.

Also see Putting It All Together: Workflow Attachments.

To add an attachment:

1. Click Add.
2. To add file upload field attachments, complete the form:

Dataform Select the dataform where the file upload field containing the attachment is
located. The listed forms are single forms only with exception of the triggering
form. If it is a multiform and not a single form, it is also included in the list.

Field Select the field upload field containing the attachment you want to add to the
triggered form.

Note: If the field is blank when the workflow is executed, no workflow attachment
will be added to the triggered form.

3. Repeat step 2 above until all desired file upload field attachments are added.
4. Click Apply or Save.

If this is a new workflow, the Attachments panel displays.
5. Optionally, you can add a static attachment that is not associated with a dataform from the

Attachments panel.
Follow these steps to add a file attachment:
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a. Click the Attachments panel.
b. On the Attachments tab, click Add to upload a new file.

The Upload File window displays.
c. Click Choose File.
d. Locate the file on your computer and click Open.

The file name displays in the File field of the Upload File window.
e. Optionally, you can provide Description, Category, and Tags information
f. Click Save on the Upload File window.

The Upload File window closes and the attachment file you just added is listed on the
Attachments panel. You can click the file name or click (Edit) next to the attachment
file name to view your file.
Note: You can discard an uploaded file by clicking (Remove) next to the attachment
file name.

6. Optionally, you can add an attachment link to a site on the triggered form from the Attachments
panel.
Follow these steps to add a link attachment:

a. Click the Attachments panel.

b. Click the Links tab, click Add to add a link.
The Link File window displays.

c. Type the URL in the Link field.
d. Optionally, type a link description in the Description field.
e. Click Save on the Link File window.

The Link File window closes and the link you just added is listed on the Links tab of the
Attachments panel. You can click the link name or click (Edit) next to the link to test
the link.
Note: You can discard a link by clicking (Remove) next to the link name.

Completing the Configuration

You can decide the next action: Back, Continue, or Finish.

To complete the configuration, when ready, you can click Back, Continue, or Finish:

1. Click Back to return to the previous step of the Workflow item.
2. Click Continue and respond to "This Workflow Channel is unpublished. Would you like to

publish?" with the options Yes or No. Either selection takes you to the first step of the dependent
Workflow item (the next item in the workflow). This allows you to add cascading steps that trigger
from the workflow you just created.
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Note: Alternatively, you can click Continue Workflow from Here in the Dependent Workflow
panel to add a dependent workflow.

3. Click Finish and respond to "This Workflow Channel is unpublished. Would you like to publish?"
with the options Yes or No.

l Yes returns you to the Workflow Channel search list with the new Workflow Channel in a
published state.

l No returns you to the Workflow Channel search list with the new Workflow Channel in an
unpublished state.

Putting It All Together: Workflow Attachments
l When the workflow executes, any workflow attachments (file upload field attachments, static file

attachments, and attachment links) are added to the Workflow Attachments panel located in
the Action Center of the triggered form. See the Workflow Attachments section of Workflow
Channel Action Items.

l Workflow Attachments links are links to the original URL.
l Workflow Attachments are links to the original source file as it existed when the workflow was

executed.
l If a source file is later updated after the workflow has been executed, the link to the version of the

file at the time of workflow execution remains intact on the triggered form.

Note: If you no longer want that version of the file associated with the triggered form, you can
delete it by clicking (Remove) next to the attachment file name in the Workflow Attachments
panel of the triggered form.

l If a source file is deleted by a user, the file cleanup process bypasses deletion of the file if any
Workflow Attachments panel file links to that file are found.

Changing the display order of workflow items
You can adjust the display order of workflow items, so they present in a logical order. Changing the
display order does not affect the triggering of workflow items but is merely a visual reference to better
allow administrators to organize these lists. Workflow items are adjusted by numerical value. You can
use negative numbers to move an entry above an item numbered 0 (zero).

To alter the display order of workflow items:

1. Open a workflow channel with multiple workflow items.
The Channel opens, with the Workflow Items listed. Note the column Display Order. In the
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following example, both workflow items have a display order of 0 (zero).

2. To change the display order, select and open (double-click the item or ) the item you want to
move. Let's move Benefits item.
The item opens in the workflow wizard.

3. In Display Order, type the new order number and click Save. For this example, let's change the
order for Benefits item from 0 to 1.

You are returned to the Channel list of Workflow Items. Note the Display Order column now shows
Benefits item as the second entry with the Display Order number set to 1.
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Publishing and unpublishing workflows
When you return to the Workflow Channel search list, you can publish and unpublish items. The
Workflow Channels list displays published Workflow Channels by default when opened initially.

Additionally, you can publish and unpublish sections of a workflow within a channel. You can publish
and unpublish Workflow Channel items individually so that you can set up complex workflows without
keeping the entire channel in the same published/unpublished state. Changing the publish/unpublish
state for a workflow item does not affect any dependent workflow items. The dependent workflow
items remain in their respective state. If the parent item of a child is unpublished, a warning message is
issued.

To view unpublished Workflow Channels:
1. In More search, click Unpublished.
2. Alternatively, you can toggle the Status chiclet to Unpublished.
3. This action also displays the More search dialog. In the dialog, the Status options are All, Published,

and Unpublished. When you change the status in More, the Status chiclet also changes.

To view published and unpublished Workflow Channels:
1. When viewing the Workflow Channels list, you can view both published and unpublished from

More search > All.
2. Alternatively, while viewing the Workflow Channels list, you can also remove the Status chiclet by

clicking the X.
3. This action displays both published and unpublished workflow channels.

To unpublish a Workflow Channel:
• From the Workflow Channels list, while viewing published items, select the Published option. The

entry is now unpublished.

To publish a Workflow Channel:
• From the Workflow Channels list, while viewing unpublished items, select the Published option. The

entry is now published.
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Viewing and publishing Workflow Channels
Workflow channels can be viewed and published by global administrators.

To view Workflow Channels:
1. Go to System Admin > Workflow Channels.

The Workflow Channels dashboard opens.
2. From the list you can do the following:

Action Description

Add • To add a workflow channel, click Add.

Delete • To delete the selected workflow channel, click Delete.

Details • To view details about a workflow channel, click Details.

Visualize • To view the item number and name, click Visualize.
• To open an item in the workflow channel configuration, click an item.

Download as CSV file You can download the workflow as a CSV file:
• The file name is Workflow Channel <number>-<workflow channel
name>.csv.
For example, Workflow Channel 36-Scheduled Test.csv.

• The contents resemble the layout, where indentations represent
children workflow items.

• The workflow items and their children names are formatted as
#<number>:<name>.

You can do the following:

• Edit the data.
• Report on the data with a graph or table.

To download the workflow as a CSV file:
1. From the list, select a channel (highlight the entry).
2. Click Visualize.

The Workflow Channel visualize dialog opens.
3. Click (Download as CSV file).

• For Chrome, when the download finishes, you see it at the bottom
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Action Description

of your browser.
• For Internet Explorer, to view downloads, select Tools > View

downloads.

Publish and
Unpublish

When selected, the Published column indicates the workflow channel is
published.
• To unpublish the workflow channel, clear the Published option.
• To publish an unpublished workflow channel, select the Published

option.

View Published and
Unpublished
Workflow Channels 

By default, the Status chiclet is set to Published.

To toggle the Status:
1. Click the Status chiclet Published.

The More dialog box opens.
2. Select a Status: All, Published, Unpublished.
3. Click Search.

The list displays according to your selection.
• Unpublished workflow channels display in italics and bold.
• Published entries display as normal with the Published column

selected.
4. You can also click the X beside Status Published.

This action displays all workflow channels: published and unpublished.
5. To reset the view to Published, click Reset.

Visualize • To view the item number and name, click Visualize.
• To open an item in the workflow channel configuration, click an item.

Workflow Items To view workflow items associated with a workflow channel, click the
workflow channel to select it and then click the Workflow items button
located above the grid in the upper left corner.
l Unpublished workflow items display in italics and bold with the

Published checkbox unchecked.
l Published entries display as normal text with the Published

checkbox checked.
l To open a workflow item in workflow channel configuration, double-

click the item or click (Jump) next to the item.
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Workflows and Tabbed Dataforms
Tabbed dataforms comprise a parent (home form) and child forms, which are extensions of the parent.
The following image is an example of the Employee dataform with four tabs: Employee Benefits,
Employee 401k, COBRA, and State Continuation. This is a tabbed set of dataforms.

When configuring Workflows, you can reference data from a tabbed dataform set on the:

• Content step
• Conditions step
• Notifications step

On the Content and Notifications steps
On the Content and Notifications steps, you can set user fields to values that exist on dataforms across
a tabbed set. Let's say that you have a parent dataform, and it has a few child dataforms — we call this a
tabbed relationship. You want to be able to reference user fields on both dataform types. (Note, we can
also have a parent-child relationship that is not tabbed.)

• In the Content step, when you select Assigned To, the Assigned to Options dialog box offers the
User Source as Current User, Specific User, and From a Field on a Form.

• In the Notifications step, when you select None, the Options dialog box offers User Source as None,
Specific User, and From a Field on a Form.

• For both steps, when you select From a Field on a Form, when you select From a Field on a Form,
you must complete the configuration by choosing a dataform and field.
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The user type fields on workflow item tasks and dataforms include any child forms containing a user
datatype field in a tabbed relationship with the available selected dataform when the user source
option of From a Field on a Form is selected. The child form name has an asterisk, as in the following
example: *Employee -- Project User (ProjectUser).

These tabbed form fields appear in the Field list below the primary form field in the tab relationship
and are formatted as follows:

*<ChildFormName> — <UserFieldName>

Example: A form named Form Parent is in a tabbed relationship with Form Two and Form Three. Form
Two and Form Three are child forms to Form Parent. Each form has user fields.

Let's say you have the following scenario in the Assigned To Options dialog:

• In Dataform, Form Parent is selected.
• In Field, the fields for Form Parent are listed at the top of the Field selector, and fields from the

child forms are available below the primary form in the following format:

*Form Two -- User By Role (fkUserByRoleID)
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*Form Two -- Specialist User (fkSpecialistUserID)

*Form Three -- Other User (fkOtherUserID)

Keep in mind, all these fields are user fields. You can select any user field from a child dataform. You can
also select a user field from the parent form and any single dataforms.

Example: The following example shows a parent form named Tony Test Form in the Dataform list.
Tony Test Form is a parent form to Form One. When Tony Test Form is selected, the Field field displays
all user-related fields from the parent form and child form. For Fields, you can select a field from the
parent form (in this case Tony Test Form) or you can select fields from any child dataforms. Child forms
are denoted with an asterisk (*), as shown in the following example.
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On the Conditions Step

Source and Field lists

The Source list includes the triggering form and its tabs, the channel trigger (i.e., the original form that
started the channel), all triggerable, active single-forms, and the tabs of those single-forms. Applicable
server data procs, if configured, and other workflow items, such as a HdrAction, may also be included.

Note: HdrAction is only available when the Source is the parent triggering form. If Source is anything
other than the Triggering Form, HdrAction is not available in the Field list.

In the Source list, the primary tabbed dataform precedes the child tabbed forms. The child dataform
names are prepended with a dash (–). The Field list is filtered based on the selected Source.
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This example shows that for the Source column, Tony Test Form is the parent, and Form One is the
child.

The following example shows the Source column with a child dataform selected (-Form One) and in the
Field column, a field named State Lookup 2 is selected.
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Conditions

Condition Expressions operators (AND, OR, and NOT) work across multiple dataforms. You can
configure conditions for task workflow channel items from the most recent parent dataform if your
tasks are multiple levels deep. This enables you to refer back to the child dataform logically. (For
example, a milestone triggers a Case, and the Case triggers multiple layers of Tasks, all Tasks can
reference the Case).

• Source includes the most recently referenced dataform that would trigger the initial task (single or
multi).

• Condition Expressions operators (AND, OR, and NOT) work across multiple dataforms.
• IsDirty does not appear in the trigger operator list because the task can be separated from the

dataform by several other tasks; the dataform may not be dirty. IsDirty is only available for the
triggering form. Child forms or other single dataforms in the workspace should never be dirty
unless the change is occurring there.

• The Add Untriggered functionality is available when adding fields from this source.
• If the most recent dataform is the main triggering dataform for the workflow, the condition Source

is Channel Trigger: <NameOfTriggeringForm>.
• If the most recent dataform is a cloned dataform workflow item, the condition Source is Workflow

#<ItemNumber>: <ItemName>.
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For tabbed form fields that are used in triggering workflows, you cannot delete or inactivate any
of the fields. The system indicates where the field is used: Channel: <Workflow Channel Name>,
Item: <Workflow Channel Item Name> (with a clickable link to the affected Workflow Channel
configuration). Delete is enabled when all dependencies are cleared.

Workflow Channel Action Items
Workflow Channel action items appear in the Action Center
pane. This topic reviews Links, Dependent Workflow, and
Attachments.

Links: Delete Item

Deleting
workflow items
and any
dependent
items

1. To delete a
workflow
item and any
dependent
items, click
Delete.
A message
displays in
the form of a simplified flowchart showing the dependents. When you delete the workflow item,
the dependents are also deleted.

2. Click Delete or Cancel.
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Workflow items with dependent conditions

You cannot
delete a
workflow item
dependent on a
condition in a
different
workflow item, in
the same tree,
but not a
descendant. If
you attempt this,
an error displays
with a link to the
dependent items.

The first message is in the form of a simplified flowchart showing the dependents: "This action cannot
be undone."

When you click Delete, another message displays "Unable to delete Workflow" with the workflow items
that contain a trigger condition that references this workflow. These dependent items prevent deletion.
You can link directly to the workflow items preventing deletion.
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Dependent Workflow

The

Depende
nt Workflow Action Item allows you to trigger additional steps based on the original workflow item that
was triggered. You can trigger multiple items simultaneously from the same triggering condition as
dependent workflows. These items can then trigger additional workflow items, allowing for a cascading
workflow. Triggering a dataform workflow always ends the cascade.

The Dependent Workflow Action Item includes:

l Workflow counter badge: Displays a count of the dependent workflow items immediately
following this item.

l Continue Workflow from Here: Allows you to add more dependent workflow items from this
point in the workflow.

l Workflow list: Displays the individual workflow items that are dependent at this point.
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Workflow Attachments

Workflow Attachments store file or link attachments created when a
workflow item generates a task or dataform. These attachments are
specific to the workflow that created the record. When that workflow
item is automatically generated, it contains a link back to the original
file or URL linked to the workflow during configuration.

This process does not clone the file or link; it merely provides a link to
the original object. Workflow Attachments are useful for workflows
designed around standardized processes such as employee
onboarding, where you need to use the same document every time.

Note: When a workflow triggers and the workflow item includes a file
or link attachment, the system adds the attachment to the Workflow
Attachments action item on the Task or Dataform.
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Configuring Scheduled Workflows
Business processes can sometimes be triggered upon reaching a specific date, such as a task that needs
to be completed two weeks prior to a client's first payroll date. Workflow channels allow you to
configure these types of automatic business processes using scheduled workflows.  This topic provides
a high-level overview of scheduled workflows as well as step-by-step instructions that can help you to
begin using this robust feature to schedule the creation of workflow generated tasks and cloned
dataforms.  

To configure scheduled workflows:
1. Go to System Admin > Workflow Channels.

The Workflow Channels dashboard opens.
2. Click Add.

The Choose Workflow Triggering Type dialog opens with options to select Real Time or
Scheduled.

3. When you select Scheduled, the Add Workflow Channel wizard opens with Step 1 Channel. In this
step, you need to configure the date that triggers the scheduled Workflow Action.
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4. Configure the following options:

Channel Name Provide a descriptive name of the workflow process.

Triggering Form Select the form to trigger the workflow.

Field Presents a list of available Date fields from the Triggering Form selected.

Frequency Limit The Workflow task or dataform is triggered once every X days based on the
value of this field.

Date Offset The number of days (before or after the date stored in the triggering field) this
workflow item triggers.

Grace Period The number of days, starting with the offset date that the workflow attempts
to trigger. When this grace period has ended, the workflow does not trigger
again until the frequency limit has passed, and the triggering conditions are
again met. 

Include When
Inactive

Optional field. When the checkbox is checked, triggering of the scheduled
workflow will occur for both active and inactive triggering forms. When the
checkbox is unchecked, triggering of the scheduled workflow will only occur
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for active triggering forms.

Triggered Forms The task or dataform to be generated when the triggering conditions are met. 

5. After you have configured the Scheduled Workflow Action, you receive a brief synopsis of the
Schedule.

6. When the last field is completed, the wizard progresses to Step 2 Content.
7. After your configured workflow is saved, these conditions are evaluated by a scheduled process

(Generate Scheduled Workflows) to determine if the date field combined with the other workflow
schedule options as well as any additional Conditions added in Step 4 (Conditions) are met. 

Note: Because these workflow triggers are scheduled, the real time field analysis to determine if a
field has changed (IsDirty) cannot happen. Because of this, notice that the IsDirty qualifier is not
available when adding additional triggering conditions to scheduled tasks.

If all the triggering conditions are met, the dataform or task is generated from the Workflow. These
actions can then trigger other dependent workflow items (such as a second task spawned when the
scheduled task is complete) or completely new workflow channels. In this way, scheduled workflows can
drive your business processes based on milestone triggering dates stored in your system.

Visualizing your workflow
You can use the Visualize function to see a graphical representation of your workflows. Workflow
channel configuration provides the ability to move dependent workflow items through a simple drag
and drop interface. The intelligent drag functionality is aware of the parent item type for the child
workflow object that you are attempting to move and only allows this item to be moved to a workflow
parent of the same type – because of this, triggering conditions of the parent always match that of the
child that is being moved. Workflow items are displayed with an item number and item name: #<Item
Number>: <Item Name>
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To visualize your workflow:
1. Go to System Admin  > Workflow Channels.

The Workflow Channels dashboard opens.
2. Select an entry and click Visualize.

The visualize window opens showing the parent and any child items graphically. Additionally, you
can see the item number and name.

3. Click Close.

Workflow History
Workflow history is available for dataforms and tasks created from a workflow. It provides the history of
how the dataform or task was created and shows the workflow item that generated the event. History is
available from the Workflow History link in the Links panel of the Action Center. The Workflow History
link is available to Global Admin and Developer users by default. Additionally, the workflow history link
is available to users in a role that contains the Can_Access_Workflow_History role entity.

Note: The system only displays the Workflow History Link if a triggering event executed a workflow
item on the dataform or task.
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The triggering history shows the most recent event for the current task or dataform and cascades to the
first triggering event.

To view workflow history:

1. Open a dataform or a task.
The following example illustrates an open task. Note the Workflow History link in the Links panel
of the Action Center.

2. In the Links panel of the Action Center, click Workflow History.
The Workflow Triggering History opens. The Workflow Triggering History shows that the task was
triggered by Client Master 695 from Workflow Item 1212. This example shows one entry because
that is the extent of the triggering events.
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The triggering history displays as many events as having occurred to this point. The following
example shows multiple events, with the last one as the first event that was triggered.

To view the dataform, task, or workflow item:

1. Select the This task was triggered by link to open the triggering form.
2. Select the From link to go to that item in the workflow configuration.
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3. Click Close.

Moving or inserting tasks at another level
With the Visualizer, you can move or insert tasks to different levels. Workflow items are displayed with
an item number and item name: #<Item Number>: <Item Name>.

To move or insert a task at another level:

1. From the Workflow Channels list, select an entry.
2. Click Visualize.

The visualize window opens showing the items graphically, with parent and any child items.

3. Click (Move Workflow Items).
The function activates, showing a shaded background.

4. Hover on an entry to view the description.
5. When ready, click an entry and drag to a new location. The new location turns a darker shade

within the block to which you are moving the entry.
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6. When ready, click Save.

Triggering a workflow item from other task items
System administrators can configure a workflow item that can trigger from the Status of other Task
workflow items in the same item channel.

Workflow configuration includes triggering based on the Status of Task workflow items other than the
triggered item's immediate parent. To take advantage of this functionality, administrators must change
the immediate parent item to fire the workflow item trigger, allowing the admin to build complex
workflow triggers based on multiple workflow tasks.

Using workflow conditions, you can specify additional task triggering conditions not related to the
immediately preceding workflow task. Admins can use the Status from any task in the related workflow
chain as an additional triggering condition by selecting the option for Workflow Item from the Source
list and then selecting the related workflow task when prompted to select a workflow item. The only
field available for triggering configuration, in this case, is Status, and the only operator that can be
selected is Equals.

The following example shows two parallel workflows: #2135 and #2286. Each of the workflows is a
parent workflow.

• Workflow #2135 triggers three dependent tasks: #2138, #2136, and #2140.
• Workflow #2286 triggers tasks #2422 and #2425. Task #2422 is not directly related to the preceding

workflow.
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The following example shows the Parent Workflow 2286 with a Condition: Source as Workflow Item
#2422 and Status Equals.
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Cloning Surcharges with Workflow Channels
You can clone Surcharges with Workflow Channels with some simple setup configurations. First, you
must update the business rules on Surcharges. Next, you must configure a Workflow Channel to clone
the Surcharge. This topic guides you through the configuration.

The surcharges clone when you click Generate Quote on the Pricing Console. If there is more than one
Surcharge to clone, just add it as another item on the same Workflow Channel. Also, you may want to
restrict Surcharges to clone for only certain Contract Types. If so, just configure additional conditions.

Note: Instead of using workflow channels to clone surcharges, the R100 release introduced the
option of setting a surcharge type to clone surcharges during the Quick Create of the Pricing Batch.
See Surcharge Types and Creating Pricing for more information about using that method to clone
surcharges.

Configure the Business Rules
In this step, you want to update Business Rules on Surcharges to run on the Quick Create and Default
pipelines. You must configure the following rules: SetSurchargePricingBatchID, SetBillRate,
UpdateProfitability, AddSurcharge, RecalPayPeriodSurcharge.
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To configure the business rules:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules display.

2. In More, search for Rule Type > Biz Logic, Dataform > Surcharge, to locate the methods (see
screenshot).

3. Open ( Jump) a Method Name, such as SetSurchargePricingBatchID.
The Rule Details form opens.

4. In Execution Pipeline, add Default and QuickCreate (if not present).
5. Click Save.
6. Repeat this procedure for all 5 rules.

Configure a Workflow Channel to clone the Surcharge
In this section, you will configure a Workflow Channel with Triggering Form = Pricing Batch and
Execution Pipeline = QuickCreate. If there is more than one Surcharge to clone, add it as another item
on the same Workflow Channel.

Step 1: Initial

In this step, we create the Channel descriptor. In the top section, we define the Channel name and the
Dataform from which the Workflow will be triggered, as well as who owns the Channel. The Workflow
Action configures the triggering action for the first workflow as well as what form or task will be
generated.
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To configure a Workflow Channel:

1. Go to System Admin > Workflow Channels.
The Workflow Channels dashboard opens.

2. Click Add to begin creating your new workflow.
The Choose Workflow Triggering Type dialog opens with "What type of triggering will the new
Workflow use?".

3. Select Real Time.
4. Complete the form fields.

Channel Name Provide a unique Channel Name. For example, Surcharge Clone from
Pricing Batch during Quick Create.

Triggering Form Select Pricing Batch.

Execute On Select Update.
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Execution Pipeline Select QuickCreate.

Workspace Template Keep the default: All Templates.

Channel Description Provide a brief description of this channel.

Channel Owner Defaults to the current user. Set it to the owner of this process.

Workflow Action This section is dedicated to the primary triggering condition for the
channel.

No Primary Trigger Select this option.

Triggered Form Select Surcharge.

The wizard progresses to Step 2 Content.

Step 2: Content

Information entered into the fields is copied to each cloned object created by this channel.

Let the Business Rules manage the default values on the Surcharge. Ensure that only the
Surcharge Type fields are visible on this step. If other fields are exposed, they will be cloned as
shown and override the default values usually handled by the Business Rules. To remove the
visibility of these extra fields, on Field Properties, set the fields as not triggerable.

1. In Item Name, enter a brief description of what this workflow does.
2. In Surcharge Type, click the link None.

The Surcharge Type Options dialog box opens.
3. Select Admin Workspace.
4. In Record, select an appropriate Surcharge, such as Client Setup.
5. Click Ok.

You are returned to the wizard.
6. Click Next.

Step 3: Notifications

l Click Next. You can skip this step.

Step 4 Conditions

This is where you add conditions. A Workflow Channel requires at least one condition. A Pricing Batch is
always added with the Status set to New, so this is a safe assumption. This is where you configure

ClientSpace Setup & Administration © 2025 PrismHR 238

Chapter 3 Workflow Channels



Pricing Batch = New and any other additional conditions that may be applicable such as Contract Type
= X.

1. Select Only trigger this workflow once.
2. Select Publish.
3. Click Add.

A row opens to add a condition.

Source Select Pricing Batch.

Field Select Status (luBatchStatus).

Operator Select Equals.

Value Select New.

Label Leave empty or provide a Label if you need to use Condition Expression.

4. Click Finish.

Note: In Step 1, we do not use a Primary Trigger Condition because a field must be dirty. A Stored
Procedure creates the Pricing Batch outside of Biz Logic; therefore, it is not dirty. After created, the
Pricing Batch is then saved back through the Dataform Pipeline as an Update and run through Biz
Logic. When this happens, the Batch Status is not evaluated as dirty.

5. Publish and test your workflow.

Server Data Proc 1 for workflow tasks triggered from
Client Service Case dataform
There are times in Workflow Channel triggering when configuring a trigger condition, triggering data is
not on the Client Service Case dataform. You can use Server Data Proc 1 to configure the Trigger
Condition on Workflow Channels for Client Service Cases.

Server data procs provide a methodology for retrieving relational data for dataforms of a client
workspace. Format server data field replacement as {SDP1.Fieldname} or {SDP2.Fieldname}.

Server Data Proc 1 returns the following data from the Client Master dataform.

 Field Field name 

Client Number  ClientNumber
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 Field Field name 

Contract Type  ContractType

Pay Frequency  PayFrequency

Legal Entity  LegalEntity

Processing Center  ProcessingCenter

Sales Region  SalesRegion

Workflow Group  WorkflowGroup

If an Employee is selected, Server Data Proc 1 also returns the following data from the Employment
dataform.

 Field Field name 

Employment Status  EmploymentStatus

SUTA State  SutaState

Employment Type  EmploymentType

Job Code  JobCode

Comp Code  CompCode

The Client Service Case dataform is provided for the PEO systems with a Server data proc. More
information about the default Server Data Procs is in Default Server Data Procs.

Tracking data modifications in PrismHR
Additional Information allows you to customize your Workflow Channels and Email Templates related
to data that is changed in Prism to reflect the source of the change. When data is modified in PrismHR
(for example, a Client’s address changes, or an Employee is added), the PrismHR API generates an Event
in a queue. The ClientSpace Ongoing scheduled process polls the Event queue for new Events (relative
to the last time the scheduled process ran). If the Events contain data that is mapped by ClientSpace
(using Import mappings), the Event is processed, and data in ClientSpace is updated.

AdditionalInformation is a data element provided by the PrismHR API. Each Event contains an
AdditionalInformation element that, in turn, contains data appropriate to the type of the Event
(Schema). For example, if an Employee’s email address changes, the AdditionalInformation informs us
which User made the change and the Type of that User (Internal or External).
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The purpose of

AdditionalInform
ation is to allow Workflow Channels and Email Templates to react to specific conditions unique to each
dataform save. AdditionalInformation data is available to ALL dataforms in the system. It is a pseudo-
field in that it is not a true dataform field, but it is available in code to be exposed to the dataform save
data. It is not visible on the dataform in the application.

In Workflow Channels and Email Templates, the additional information is available as Additional
Record Information and has an associated user type.

Time Tracker
The Time Tracker module offers the following features:

l Resource utilization tracking through the creation of time tracking records.
l Allocation of tracked time to configured time tracking categories.

Note: The system can automatically set the category for any time tracking record by using the
associated task category metadata configured on the time tracking category.

l The ability to track time spent on tasks and on certain dataforms (such as a Worker's Comp case).
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Customizing Workflow: Adding and Editing Time Tracker Categories
Tracking Time can be a very important part of your business acumen, but tracking the time is only part
of it. You also need to make sure that tracked time is allocated appropriately. This can be accomplished
by configuring Time Tracking categories to match your business needs. This topic provides details on
how to configure time tracking in your ClientSpace installation.

To configure Time Tracking categories:
1. First, determine if the appropriate Category Groups have been configured for your environment. Go

to System Admin > Lookups.
The Lookups dashboard opens.

2. Click More and for Group, select Time Tracker Category and click Search.
3. Review the lookup list and If required, add any additional time tracker groups you need.
4. Go to System Admin > Advanced > Time Tracker Categories.

The Time Tracker Categories dashboard opens.
5. Click Add.

The Time Tracker Categories form opens.
6. Provide a Category Name and select an appropriate Category Group.
7. Click Save.
8. Continue until all Time Tracker Categories have been configured.

To verify your new categories:
1. Open a case, task, or workspace.
2. Verify your new categories by adding a time tracker record and reviewing the Time Tracker

Categories list.

Related Topics:

l Configuring Default Time Tracking for Task Categories
l Using Time Tracking Categories
l Customizing Workflow: Adding and Editing Time Tracker Categories

Using Time Tracking Categories
When configured, the metadata allows the system to automatically set the category for any time
tracking record by using the associated task category metadata in the following way.
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To configure default time tracking for task categories:
1. From the user modules bar, click Tasks.

The Task Manager dashboard opens.
2. Click Add.

The Workspace Selector list displays.
3. Select a Workspace and click GO.

The New Task form opens.
4. Select a Category.

TIP: Select a Category before you click Start Timer. Each time you start the time tracker, a new
record is created. If you click Start Timer before you select a Category, the record is created with no
associated category. Additionally, you cannot save the new task until a category has been selected.
If you start the timer before you select a Category, then after you select a Category and Save, you
must then start the timer again.

5. Complete the remaining necessary fields.
6. Click Save.
7. In the Action Center, click Start Timer.
The timer begins for the newly created task.

To view the time tracker dashboard:
• From the user modules bar, click Time Tracker. You may need to click View > Time Tracker.

The Time Tracker dashboard displays.

Related Topics:

l Configuring Default Time Tracking for Task Categories
l Customizing Workflow: Adding and Editing Time Tracker Categories
l Using Time Tracking Categories

Configuring Default Time Tracking for Task Categories
Tracking time can be an essential daily process to ensure that you are focusing on resource utilization.
To help streamline your processes, you can configure the system so that it automatically sets the
default time tracking category from the task category. The configuration occurs on the metadata of the
Task Category lookup.
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To configure default time tracking for task categories:
1. Go to System Admin > Lookups.

The Lookups dashboard opens.
2. Filter the list for task category.

The Task Category entries display.
3. Review the list, select an entry, and click Edit (if applicable).

The Lookup Details form opens.
4. In the Action Center, click Open Metadata.

The Task Category Metadata form opens.
5. In the Default Time Tracker Category list, select an appropriate entry.
6. Click Save.

Related Topics:

l Customizing Workflow: Adding and Editing Time Tracker Categories
l Using Time Tracking Categories
l Configuring Default Time Tracking for Task Categories

Adding Time Tracking to a Dataform
This topic provides the step-by-step process to track time for workers comp cases by using the worker's
comp claim function. This is easier than opening a second case just for the purpose to track time.

To add time tracking to a dataform:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Search for the dataform to which you wish to add time tracking.
3. Select the name of the dataform to highlight it.
4. Click Form Properties.
5. In the Actions set, select the Enable Time Tracking option.
6. Click Save.
The dataform that you updated should now display the TimeTracker Action Item in the Action Center.

Related Topics:

l Configuring Default Time Tracking for Task Categories
l Customizing Workflow: Adding and Editing Time Tracker Categories
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l Using Time Tracking Categories
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Chapter 4
Dataforms
The heart of the ClientSpace system is configurable dataforms. Dataforms are your workspace building
blocks. ClientSpace has been tailored to the unique needs of the PEO industry, primarily using the
dataform architecture. Dataforms enable administrators to modify forms or create entirely new forms
and sub-systems all without writing a line of code.

Configurable data management through dataforms provides some of the most dynamic and powerful
capabilities embedded within ClientSpace. Global administrators can create and maintain configurable
web-based data entry forms to match their data management requirements. The dataform schema
should be carefully modeled with the same care and strategic mindset as would be taken during the
data modeling phase of any custom software development project. With careful planning and
implementation, ClientSpace dataforms can provide the tools to design and build the solution most
suited to your business needs.

We’ll start with the basics and together build a form from scratch reviewing all the various properties of
the form and field objects as well as the growing variety of data types. We’ll explain other topics
understood by few outside of PrismHR such as dataform security, lookup metadata, and tabbed forms.
Fasten your seat belts, this ride is not for the faint of heart.

Dataform administration is a ClientSpace Advanced Administrative function and requires Global
Admin permission and an Enterprise License.

This chapter describes dataforms, what happens when they are created or changed, and how they are
managed within the application. The following topics are included in this chapter.

What is a dataform?
• Dataforms dynamically create and manage configurable data collection points.
• When you add a dataform, a new table is added to the database.
• Dataforms enable workflow systemization.
• Additionally, dataforms provide granular security down to the field level.
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Before you begin
This area of the system requires an Enterprise license with access to Advanced Admin. If you do not
have an Enterprise License and are interested, please log an Extranet case.

Using dataforms, global administrators can create new forms, add, delete, or modify fields on existing
forms.

An error message displays and prevents you from completing certain "delete" or "modify" actions on a
dataform or dataform field when a field on a Parent or Tab dataform is used in other configurations
which depend on a dataform field.

Below is a list of actions that cannot be performed on a Parent or Tab dataform with a business rule,
workflow channel or email template dependency:

l Unlinking, deleting, or inactivating a dataform that is used a triggering form, target form, or
source form in business rule, email template or workflow channel configuration.

l Unlinking, deleting, or inactivating a single-form parent dataform, multi-form parent dataform, or
child tabbed dataform that contains a triggering field, target field or source field used in business
rule, email template or workflow channel configuration.

l Deleting or inactivating a field on a single-form parent dataform, multi-form parent dataform, or
child tabbed dataform that is used as a triggering field, target field or source field in business rule,
email template or workflow channel configuration.

All dependencies must be removed to proceed. In certain instances, a link to the dependency is
provided to help you assess whether a dependency can be safely removed or must stay in place.

Additionally, global administrators can relate forms in one-to-one or one-to-many relationships to
each other. The configuration of these forms results in a relational data model with tables and properly
typed (such as integer, decimal, varchar) data fields embedded within the ClientSpace database. During
creation, a set of stored procedures (one set for each dataform) are generated to allow various parts of
the application to interact with the tables and fields.

All dataforms must exist within a workspace. The one exception to this rule is a special dataform that is
associated with the Other Info tab on the Organization Detail page or the Contact Manager. Different
types of workspaces may include various sets of relational dataforms with some forms overlapping
from workspace to workspace. The dataforms that are related to a workspace are inherited from the
template used to create the workspace.    

Dataforms are a suite of tools that comprise the Dataforms Engine. The dataform engine allows you to:

l Dynamically create and manage configurable data collection points
l Generate Web forms and fields for data collection
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l Allow for Workflow systemization
l Allow for extremely granular security, down to the field level

Adding a dataform to the system:

l Generates a new SQL table in the server
l Adds your configured fields to this table as columns
l Automatically configures the data columns with appropriate values based on field selection

options
l Automatically generates foreign key relationships between tables (Parent / Child forms, Lookups,

and so on) 

Dataform security tips
Draw a diagram of the dataform before adding security to it so that you can map out how you would
like the field access to occur. This approach helps you envision users that need access to the dataform
and help you to better plan out how to architect the security and associated user roles.

Naming conventions
System table names (tables generated by PrismHR developers) are automatically generated based on
Dataform Name preceded by gen_.

Example:

gen_DataFormName
Custom tables created by our clients in their individual installs are distinguished from normal gen tables
with a leading z.

Example:

gen_zDataFormName. 
The Dataform Properties form presents the fields in groups. The first step is to configure the general
properties such as, name, type, field, group, and description.

Adding a dataform
Before you create a dataform, consider:

l The type of data you need to track
l How that data is used in ClientSpace and other systems

ClientSpace Setup & Administration © 2025 PrismHR 248

Chapter 4 Dataforms



l The relationship between the new dataform and others in your system
Advanced planning can save time after you publish the dataform and start to collect data. After you
have determined how you would like to build out your new dataforms, you can begin the process. The
first step is to add the dataform. This process creates a new table in the SQL database with the
predetermined system columns.

To add a new dataform:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Click Add.
The Dataform Properties: New Dataform form opens.
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3. For Dataform Configuration, complete the form fields as required.

Dataform Name This is the name of the dataform that is displayed within the application, such
as in lists. Required.

Dataform Type Select the type:
• Standard
• Organization
• Contact

Dataform Group Grouping dataforms makes them easier to search for later.

Description Provide a short description of the dataform and its purpose.

4. After you configure this first section, click Apply.
5. After you Apply changes, then you see the Table Name and Default Field fields.

Table Name Displays the generated table name that is stored in the database. This can be
useful for reporting. You cannot edit this field.

Default Field When you associate one dataform with another through linked fields, the
default attribute is displayed in the list. It is a best practice to make the default
attribute field of the form Required, so any linked forms have something to
display.

Note: If you attempt to delete a field that is set as the default field on the
dataform, the system prevents you from deleting the field until you select a
different default field for the dataform. See Deleting or Inactivating
Dataform Fields for more information.
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Next: Action Center
The next step is to secure the form, add and configure fields, and add and configure tabs. These actions
are performed in the Action Center pane (on the right side of the screen).

To continue with the configuration:

1. In the Action Center, click Fields, Tabbed Forms, or the Form not Secured button .
2. Use the following field descriptions to guide you through the configuration.

• Fields: This is where you add and configure fields for this dataform (see Adding Dataform
Fields).

• Tabbed Forms: This is where you add and configure tabs for any foreign key-related child
forms of this dataform. (Child forms have a Parent form field that uses this dataform as the
Parent Form. See Adding dataform tabs.)

• Form not Secured button : Secures the form and generates a security entity for the field
in the format of gen_TableName. You must click Yes in the Secure Dataform window to add
security to the dataform.

Note: To unsecure a form, click the Form Secured button and click Yes in the Unsecure
Dataform window to remove security for the dataform.
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For more details about dataform security, review Dataform and Dataform Field Security. For
more details about using security entities in Role security, review Configuring Organization and
Workspace Security.

Next: Customize the Actions

To continue customizing your dataform:
1. On the Dataform Properties form, locate the Actions area, where you find an array of options.
2. Use the following field descriptions to guide you through the configuration.

Can Have Multiple Single vs Multi dataform - dataforms come in two basic flavors:
The Single dataform (such as the Client Master) has a one-to-one
relationship with the Workspace, only one can exist in the
Workspace. The Multi dataform (such as Locations) has a one-to-
many relationship with the Workspace, such as physical locations
for a client, or paycheck records for an employee.

Search On Load Multiforms present as a list of records, whether this list is
populated automatically when you land on the dataform search or
have to click the Search button to populate the list is a function of
search on load.

Secure Attachments Secures attachments for this Dataform. This generates a security
entity so that users with that entity can see, add, or edit
attachments (<TableName> $Attachment).

Show on Landing Page Indicates the dataform will be available from the Workspace
landing page. Leave this unchecked if you want to only display the
dataform in Next as a tabbed or linked dataform.

Exclude From BI Checking this box will remove the dataform from the list of
available tables in the Datasources section of Business Intelligence,
effectively hiding the dataform from reporting.

Note: When the Exclude from BI check box is selected (set to
True), the BI Name field is disabled.

BI Name If populated, the Friendly Name stored in this field will display in
Business Intelligence reporting instead of the table name.
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Note: When the Exclude from BI check box is selected (set to
True), the BI Name field is disabled.

Time Category On the creation of a Time Tracking record from this dataform, the
Category field of the record will default to the value selected here.

3. After you configure this section, click Apply.

Next: Customize the Features

To further customize your dataform:
1. On the Dataform Properties form, locate the Features area, where you find an array of options.
2. Use the following field descriptions to guide you through the configuration.

Enable tasks Adds the My Tasks action item to the dataform. Tasks added from
this dataform are linked to this dataform.

Enable Attachments Adds the Attachment Action Item to the dataform, providing the
ability to attach files to the dataform.

Enable Subscribers Adds the Subscribers Action Item to the dataform, which allows
you to automatically notify system users from email, about
changes to the form.

Enable Subscription Emails This field sets which notification system is used when producing
dataform subscription emails. If selected, a core system
notification is produced when the record is changed. If selected
and a published Email Template has been configured for this
dataform, that template is used. If cleared and no template exists,
subscription emails are not sent.

Enable Activities Determines whether Activities may be attached to and displayed
on this dataform.

Enable Time Tracking Adds the Time Tracker action item to the dataform. Time tracked
from this icon is linked to this dataform.
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Enable WFC Cloning Used to determine if a form is available to clone1. This means that
the form can be created by the Workflow Channel as the triggered
form.

Clearing this option initiates a validation to determine if this
dataform is used as a Triggering Form or triggering condition in a
Workflow Channel. When used, a warning message is displayed
with a link to the referenced items. Only published Workflow
Channels are referenced. This option cannot be cleared until the
dependencies are removed.

Enable Triggering Used by Workflow Channels and Email Templates to determine if
this dataform is available as a Triggering Form during the initial
Workflow Channel and Email Template configuration.

Clearing this option initiates a validation to determine if this
dataform is used as a condition in a Workflow Channel or Email
Template. When used, a warning message is displayed with a link
to the referenced items. Only published items are referenced. This
option cannot be cleared until the dependencies are removed.

Enable Active Check box

This option controls if the Active check box
on the bottom of the dataform is present for Non-Global Admin
users.
l Check this box so that Non-Global Admin users can activate

or deactivate a dataform.
l Clear this check box so that Non-Global Admin users can

NOT change the active state of a dataform. For example, you
can clear this box for an active dataform to prevent Non-
Global Admin users from accidentally deactivating the
dataform, which can interrupt workflow processes.

3. After you configure this section, click Apply.

1Cloning is when an object is generated by copying a template example of that object. Cloning is often
used to provide consistency of data, or for workflow design.
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Viewing audit information
The audit trail contains the admin data, as well as other, create and change events for the dataform and
associated fields. Dataform properties also provide the following information:

l Date Created
l Created By
l Date Updated
l Updated By

To view the audit trail:

1. From an open dataform, in the Action Center, click (Audit Trail).
The Audit Trail For: something is displayed.

2. The list shows Date, Table Name, Field Name, Action, Original Value, New Value, and Login ID.
3. Click Close.

Related Topics:

l Dataform Properties
l Distributing your dataform: Making dataforms accessible
l Configuring a Dataform to open as a Module
l Configuring Dataform fields

Moving a Dataform
You can move a dataform from one workspace to another. The following requirements must be met to
move a dataform:

l The Enable Move Record field is checked on the Dataform Properties.
Important: The Enable Move Record setting can only be enabled by a ClientSpace Professional
Services representative. Please contact Professional Services for configuration assistance.

l The dataform you are moving must be a multiform.
l You must have edit rights to all fields on the form, including any secured fields on the form.
l You must be assigned a minimum of View rights to the MoveRecord security entity (System

Admin > Security > Roles).
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Note: Only Non-Global Admins require this entity assignment. Global Admins can move records by
default as long as the Enable Move Record field is checked on the Dataform properties and they
have edit rights to the fields.

l You must have access to the workspace to which you are moving the dataform.
Note: Only workspaces that share the same template will be available when moving the
dataform.

l You must have edit rights to all fields on the form, including any secured fields on the form.

To move a dataform:

1. Navigate to a workspace and open the dataform you want to move.
2. On the Action Center toolbar, click the down arrow and select Move Record.

Note: If the Move Record option is not present, ask your Global Admin to verify the dataform
configuration and your access rights as detailed in the introductory paragraph of this topic.

The Confirm Move popup window displays. It displays a Workspace field for selecting the
destination workspace.
Note: The list of workspaces is filtered to workspaces in the same template.

The Confirm Move popup window also displays fields from the parent form containing values
unique to the original workspace. You will need to specify new values from the destination
workspace for these fields.
For instance, in the example below, the Reported By Employee field is listed. The list of
employees from workspace to workspace is different. Even if the same employee existed in both
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workspaces, they would not have the same unique identifier in both workspaces. Therefore, you
must select a new value that exists in the destination workspace.

Note: 
l Parent form fields that were not filled in (i.e., blank) are not displayed.
l Parent form fields referencing Admin Workspace records are not displayed.
l The parent form fields remain disabled until you select a workspace.

3. Select the Workspace and then select new values for any listed parent form fields.
4. Click Move.

Adding dataform tabs
Create the tabbed dataforms in Dataform Administration, ensuring that you include a Parent Form
datatype field, configured to point at the Parent form where you would like the tab to appear.

Note: 

l You can add up to five tabs to a parent dataform. If you need to add more than the default limit,
please log a case in the Extranet.

l If the parent form and the tabbed form have one or more identically named fields between them,
a validation error message similar to the following displays listing all conflicts that must be
cleared before the tab relationship can be saved:
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To add dataform tabs:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Search for the parent dataform and open the form.
The Dataform Properties form opens.

3. In the Action Center, click Tabbed Forms.
The Tabbed Forms list displays.

4. Click Add.
The Tabbed Form dialog box opens.

5. In the Dataform list, select the tabbed dataform.
6. Provide a Display Order (this is the order in which the tabs will appear at the top of the dataform).

The display order is numeric.
7. Click Ok.

Dataform Properties
Form properties control the basic properties of the SQL table, such as Table Name. After saving the
initial dataform, you cannot change the basic properties of the SQL table. Therefore, be sure to plan
carefully before you save. Consider the name of a dataform carefully because the only way to change a
table name is to delete the dataform and any data you may have stored in it and start over.
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The field Dataform Name is simply a label and can be changed after the initial save to provide a more
descriptive title of the dataform. However, the best practice is to make the table name as short as
possible while still being descriptive. For example, you may want the title of the dataform to read
as Family Medical and Leave Act Data. A better table name would be gen_zFMLA.

To accomplish this:
1. Save the form initially with a dataform name of FMLA.
2. Change the Dataform Name field to the more descriptive Family Medical and Leave Act Data.

Dataform field naming standards
This topic describes the standards and conventions for naming dataforms and dataform fields.

General guidelines

Care should be taken when first creating a dataform, as the underlying database table is generated
from the name at the time of creation. For example, if a dataform is added with the name Certs, a
database table gen_Certs is generated, where gen_CertificateOfInsurance would have been preferable.

So, when adding a dataform, think about what you would want the database table to be named, then,
after it is created, the form name can be changed to something more human readable or industry
jargonized, without having an effect on the underlying database table.

Field names are in Pascal Case, which means that field names are created by concatenating capitalized
words. For example:

• FirstName
• GrossPayroll
• MinAdminPerAccount
Prefixes are all lowercase. For example:

• luState
• fsOrganizationInformation
When using the ID suffix, both letters should be uppercase. For example:

• fkEmployeeID
• fkUserID

Note: Always examine the automatically generated field name after typing in the label to make sure
they are Pascal Case and have the appropriate prefix and suffix. DO NOT leave a field with a long
winded name because of what the label is. For example, a field with the label “Are union workers or
employees under collective bargaining agreements employed?” should not be left as the
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automatically generated name. In this case, it was appropriately shortened to
luEECoveredUnderCBAEmployed.

Datatype guidelines

Prefix fk and suffix ID

Any fields that store an ID to another entity should have the prefix fk and the suffix ID.

Example: fkEmployeeID

A few examples of foreign key datatypes:

• Any of the Organization or Contact datatypes
• Any of the User datatypes
• Parent Form
• Comp Code Suggest
• Employee Type Ahead
• Project Type Selector
• Role Selectors
• Workspace Selectors

Prefix lu

Lookup (core) have the lu prefix.

Example: luStatus

Prefix mlu

Lookup – Multiple (core) have the mlu prefix.

Example:

• mluCommissionMethod
• mluCertifications

Is, Has, Can

Check boxes store a Boolean value (True/False, Yes/No), so they should start with the word Is, Has, or
Can, depending on what sounds more correct.

Example:

• IsBrokerSubmitted
• HasCustomPayroll
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• CanCreateWorkspace

Date

Date fields should begin with the word Date.

Example: DateReported

Prefix fs

Field Sets should have the prefix fs.

Example: fsContactInformation

Prefix sf

Secure attachments should have the prefix sf.

Example: sfLossHistory

Other datatypes

All other datatypes should stick to the Pascal Case convention.

Examples:

• GrossPayroll (Decimal)
• TotalEmployees (Integer)
• GeneralNotes (TextArea or Log)
• LastName (Text)
• PrimaryEmail (Email)

Configuring Dataform fields
Now that you have the container for your data, it's time to start adding the fields to store the individual
pieces of information you want to track. Dataform fields can be as simple as a few fields together on a
page or can be complex, dynamic groupings of fields that hide or display based on predetermined
logic. Taking the time to map out your dataform layout pays off in the overall amount of time you
invest in the final version of the dataform. For more details about dataform fields, see Configuring
Dynamic Field Display.

Best practices for field configuration
n Leave space between your field rows in the numbering scheme should you need to add more

fields later (10, 20, 30).
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n Restart numbering sequences within each fieldset to group the data elements together visually.
n Fieldsets should have their own numbering sequences independent of the numbering within the

fieldsets.
n Multiforms require the additional step of configuring columns for the list display. If this is not

configured, you receive the error "Column headers have not been defined for this dataform"
when you attempt to use the dataform in a workspace.

n You cannot add more than 150 fields to a dataform.

Adding Dataform Fields
Dataform fields contain information that you want to store and track. The maximum number of fields
allowed on a dataform is 250. When this limit is reached, the (New) button is disabled, and a
message displays, "Only 250 fields can be added to a single dataform." If you need more than 250
fields, consider using a dataform tab or add another single dataform link.

To add fields:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. From the list, select an entry and click Edit or click (Jump).

The Dataform Properties form opens.
3. In the Action Center, click Fields.

The Fields list of the dataform displays. From here, you can Open, Delete, and Add (New) fields.
4. Click (New).

The New Field form opens.

Note: You cannot configure a dataform (single or multiform) to contain more than 250 fields. When
this threshold is reached, a message displays, and the New button is inactivated.

5. Use the following field descriptions to continue the configuration. (Fields displayed may vary by
Element Type.)

Element Type Determines the type of data you store in this field. ClientSpace has a full array of
different datatypes. The most commonly used datatypes can be found in the topic
Configuring Your Dataform Datatypes. For an in-depth look at the Lookup
datatype, see Configuring lookups.

Field Set Field sets are not data entry fields, and no corresponding SQL Server field is
created when a new fieldset data type is created. Field sets act as an organization
container for other fields. The use of fieldsets typically makes the layout and
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organization of a data form significantly better.

Field Set
Default

Allows you to control whether fields within a field set are visible or collapsed within
the field set container when the form loads.
Note: 
l This setting affects field display only. Dataform field validation still occurs on

fields contained within field sets that are collapsed by default. Additionally,
this setting does not interfere with workflow channel configurations that
reference fields in collapsed field sets.

l With the ClientSpace Release 132 update, a one-time script will run to check
for instances of Field Set Default that are empty and set them to Expanded
so that you do not have to manually apply field set collapse/expand
functionality to field sets that existed prior to when this feature was
introduced. Previously entered Field Set Default values will be skipped by
the script to preserve your entries.

You can:

l Select Expanded to display all fields within the field set by default upon
form load.
Note: Expanded is the default selection when you add a new field set.
Upon form load, all fields within the field set are visible and a down chevron
appears next to the field set name. The chevron is a toggle switch for
changing between expanded and collapsed views. From the default
expanded view, a user can click the down chevron to switch to a collapsed
view as shown in the example below:
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l Select Collapsed to hide all fields within the field set by default upon form
load. Upon form load, all fields within the field set are hiding and a right
chevron appears next to the field set name. The chevron is a toggle switch
for changing between expanded and collapsed views. From the default
collapsed view, a user can click the right chevron to switch to an expanded
view as shown in the example below:
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l Clear the Field Set Default field to always display all fields in the field set
with no ability to expand or collapse field sets.

Field Label The field label is displayed on the dataform. By default, the underlying field name
is set to the field name with any spaces or special characters removed.
Click (Settings) to open the Style Configuration fieldset and change the style of
the field label (for example, font type, style or color). You can:
l Select Normal, Bold, Underline, or Italic in the Font Type field.

Note: After selecting one type you can select another so that you can add
multiple font type attributes to the field label (For example, Normal and
Underline, or Bold and Italic)

l Select Normal, Small, or Large in the Font Style field.
l Select the Color picker drop-down in the Color field and complete the

following:
o Enter a color Hex code (for example, #0000ff)

Or
Select a color and adjust the color with the slider

o Click Update to set the color

l Review the Sample Text.
l (Optional) Click Discard to remove the style configuration for the field label.
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Field Name The name of the field that is created on the SQL table. By default, the field label is
stripped of its spaces and special characters and used as the Field Name. The field
name can be overridden as needed and can be set to anything that is accepted by
SQL Server as a valid field name. Duplicate field names are not accepted.

Field labels are often duplicated in developing large dataforms. As duplicate fields
are created, you must modify the field name to make it unique to save the field.
After the field is saved the first time, the field name CANNOT be changed.

Carefully map out your field naming standards before creating dataforms.
ClientSpace uses a standard naming convention when naming a field based on the
datatype of the field. It is a recommended best practice to use these same
conventions in your own field names. To discover the best practice for your field
type, see Dataform field naming standards.

Row The row property determines the vertical ordering of fields and fieldsets. Fields
that are within a fieldset are ordered within that fieldset. Though the sort uses a
standard numeric order, it is recommended to set rows in increments of ten. This
allows for reordering fields or adding fields between rows without reordering the
entire form.

Column The column property is hardcoded to dictate a two-column format. Technically,
you can select the same row and column for more than one field, and they align
alphabetically. However, this generally causes problems in the presentation of the
dataform to the user.

Field
Behavior

When ReadOnly is selected, the field cannot be edited. Normally, these fields are
set automatically by business logic.
When Required is selected, the field must be completed in order for the Dataform
to be saved, unless the field is contained in a hidden field set.
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Length Specifies the maximum character length of the field entry. This property is valid for
Text, Text-Wide, and TextArea element types. For example, if the Length property
is set to 10, a user can only enter 10 characters for the field. If this property is blank,
the system does not limit the character length of the field entry.

Comment The text in Comment provides contextual help for dataform users. When
comments are added to any dataform field, the info bubble next to the field label
is enabled, and on hover, the info bubble displays the comment text in a pop-up.

Description Use the Description field to specify how and where a field is used in ClientSpace.
This can help with dataform field maintenance activities, such as:
l Determining which unused fields to delete.
l Reorganizing fields on a form (i.e., determining fieldsets to group fields.)

This field has a 1000-character allowance.

Note: Once you add Description text, you can view it from the Dataform fields list
without needing to open the field properties record when you hover the mouse
over the field name:

Very long descriptions may be truncated. In those cases, you will need to open the
field properties record to view complete details.
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Lookup
Group

The Lookup Group field displays in the Lookup Settings fieldset when you select
an Element Type of Lookup Type Ahead (core), Lookup (core), Lookup Multiple
(core).
l If you have already added a lookup group to associate with this field:

Select the lookup group from the drop down list.
l If you have not already added a lookup group to associate with this

field: Click the down arrow and select Add new item to add the lookup
group and populate the Lookup Group field with it.

Note: Once the Lookup Group field is populated, you can click the Jump to

Related Form button in the field to open the lookup group record.

Filter Value The Filter Value field displays in the Lookup Settings fieldset when you select an
Element Type of Lookup Type Ahead (core), Lookup (core), Lookup Multiple
(core).

Filter Value allows you to filter the values in the specified Lookup Group by a
single value. For instance, you are configuring a US States lookup group, you only
want the list of values in it to contain southeastern states and you have set a filter
of SE (for southeastern states) on the Lookup Details record of each of the
southeastern states. In this scenario, users will see the following values when they
open the US States drop-down list:
l States with a Filter value of SE entered on the Lookup Details record.
l States with a blank or empty Filter value.

See Basic field filtering: Using the lookup Filter and dataform field Filter Value

Filter Source The Filter Source field displays in the Lookup Settings fieldset when you select an
Element Type of Lookup Type Ahead (core), Lookup (core), Lookup Multiple
(core).

Filter Source allows you to filter dynamically, restricting the range of values
displayed in a lookup list based on a selected value in another lookup field on the
same form. You must specify the actual field name of the field in Filter Source
instead of the field label name (i.e., luRegion instead of Region) in the Filter
Source field.

Example: I select "Southeast" from the Region drop-down list and the US States
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drop-down list filters to display southeastern states.

In this scenario, users will see the following values when they open the US States
drop-down list:
l States where this is there is a lookup for "Southeast" in the Region lookup

detail configuration with a Code field value that matches the Filter value on
the US States lookup detail configuration of the southeastern states. For
example, SE displays in the Code field of the Region lookup detail
configuration and SE displays in the Filter fields of the US States lookup
details configuration records for the southeastern states.

l States with a blank or empty Filter value.
SeeAdvanced filtering: Using contents of another field and Filter Source

Quick Search Selecting a value in this list adds the field to the Quick Search on multiform
searches. Fields that link to other dataforms are not eligible for Quick Searches.
Available options (quick search types) include Starts With, Equals, and Contains (%
search).

Org Category This setting is only available when the Element Type of the dataform field is Org
Type Ahead. Selecting a value in this list filters the organization lookup list to
organization records that match the specified category. EX: Brokers or Staffing.

Orgs with
Workspaces

This setting is only available when the Element Type of the dataform field is Org
Type Ahead. Setting this field filters the organization lookup list to organization
records are associated with a workspace.

Advanced
Client Info

This setting is only available when the Element Type of the dataform field is Org
Type Ahead. This section is used enable settings to display additional workspace-
specific information (if entered), such as making the Client Number, PEOID, and
DBA display next to each value in the lookup list which can help users identify the
correct company when there are similarly named companies in the list.

Advanced
Settings

Used when there is a special script or special code entered in Advanced Settings
for a dataform field. For instance, on the Benefit Parent Company field, there is
code entered in Advanced Settings to filter the Org Type Ahead for this field to
only display companies associated with a workspace and an Active Client Master
record. Also see Configuring Your Dataform Datatypes.

Form Is this one of the Search parameters available in a multiform list? This property can
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Searchable be set from the form list page or from within the field property page.

Secured Secures the field and generates a security entity for the field in the format of gen_
TableName_FieldName. For more in-depth documentation about using security
entities in Role security, review Configuring Organization and Workspace Security.

Active Determines if the field appears on the dataform. Deactivating a field is preferential
to deleting it because deleting the field removes it from the underlying SQL table
and erases the data. When you deactivate or hide a field, you retain the data for
later use.

Hidden This property is only available for Field Sets. When selected, the field and its
children are hidden when a dataform record is viewed.

Include in
Document
Index

When selected, this option includes the dataform field when indexing documents
attached to the form so that it can be used as part of the document search.

Audit this
field

Marks the field auditable and is configured in System Admin > Advanced > Tables.

Cloneable Marks the field as configurable when this dataform is created by Workflow
Channels. Clearing this option initiates a validation to determine if this field is used
by Workflow Channel dataform cloning. When used, a warning message is
displayed with a link to the referenced items. Only published Workflow Channels
are referenced.

Allow
Dataform
Notification

If selected, this field is included in a dataform notification when dataform
subscribers are emailed. Updated fields appear in bold in this email.

Triggerable Marks the field as available for use as a Triggering Field or as one of the Triggering
Conditions when configuring Workflow Channels and Email Templates. When a
field is marked (selected) as Triggerable, it displays in the field list on Email
Templates and Workflow Channels.

Clearing this option initiates a validation to determine if this field is used as a
triggering condition in an Email Template or Workflow Channel. When used, a
warning message is displayed with a link to the referenced items. Only published
Email Templates or Workflow Channels are referenced. This option cannot be
cleared until the dependencies are removed.
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System When a developer user selects the System setting for a dataform field, a Global
Admin user can edit the field but can not delete the field.
A Global Admin user can view the System setting, but only a developer user can
change this option for a dataform field. If a developer user deselects the System
option for a dataform field, the system displays a message before the user
confirms the change to the dataform field:
This field is a system field that may be used in business logic. Making this
field 'not system' may impact some functionality.

SortDescendi
ng

If the field displays as the first column in a search list and the SortDescending
check box for the field is checked, the system defaults the sort order to descending
for the column. When this option is unchecked, the sort order for the column is
ascending.

Note: This feature only applies to multiform searches.

6. Click Apply when you are done.

Available field actions

When viewing the list of dataform fields, note the available actions:

Action Action label Description

Open Opens the field properties for the highlighted field.

Delete Deletes the highlighted field. For system fields, the Delete action is not
available and displays as disabled. System fields can be easily identified
because their field names do not begin with z_. Additionally, an error
message may display and you may be prevented from continuing with the
deletion of other dataform fields that are not system fields if the field is
being used in other configurations that depend on the field. See Deleting
or Inactivating Dataform Fields.

New Adds a new field.

Save Saves changes to the dataform fields list.

Visualize Opens a preview of the dataform that illustrates how the fields display.

ClientSpace Setup & Administration © 2025 PrismHR 272

Chapter 4 Dataforms



Related Topics:

l Dataform and Dataform Field Security

Visualize: Previewing Dataform Fields
When you Open (Edit), Delete, and Add (New) fields on a dataform in Dataform Admin, you can use
the Visualize tool to preview how the fields display for the current configuration of dataform You can
use the Visualize preview to guide your dataform editing decisions when you are configuring the layout
of the dataform.

Use the Visualize tool to preview edits to dataform fields:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. From the list, select an entry and click Edit or click (Jump).

The Dataform Properties form opens.
3. In the Action Center, click Fields.

The Fields list of the dataform displays.

4. Click the Visualize button from the toolbar.

The Visualize dataform field preview displays as a new visualize work item.

ClientSpace Setup & Administration © 2025 PrismHR 273

Chapter 4 Dataforms



5. Select the dataform Work Item in the Work Center to return to the field list.
The Fields list of the dataform displays. From here, you can Open (Edit), Delete, and Add (New)
fields.

6. Click Apply when you are done.
7. Select the Visualize dataform Work Item in the Work Center to return to the Visualize dataform field

preview. The preview will each time that you return to Visualize and the preview will show any
changes to fields that you saved.
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Deleting or Inactivating Dataform Fields
You can delete or inactivate a dataform field that you do not want to use on a dataform anymore.

Situations Preventing Field Deletion or Inactivation

A few situations can exist that prevent a field from being deleted or inactivated. When this occurs, a
Hard Error displays and you are not permitted to delete or inactivate the field:

l The field is a system field. For system fields, the Delete action is not available and displays as
disabled. System fields can be easily identified since their field names do not begin with z_.

l The field is a default field. For default fields, the system displays a message.
"This field is used by the following System functions and cannot be deleted while these
dependencies are in place: Default Field - <DataformName>"
The following graphic illustrates this scenario:
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To proceed with deleting the field you must first select a different field in the Default Field
option for the indicated dataform.

l Other system configurations depend on the field. Dataform fields that are referenced by system
functions cannot be removed. Examples of dependencies include display conditions, workflows,
email templates, email integration configuration, and more. In the examples of delete and
inactivation messages below, the bulleted list items are links to the dependencies.

You can click the link to continue to the dependency and remove the field from the system
function. After removing the dependency, you can delete or inactivate the field.

Warnings to Proceed with Caution

Other situations can exist where you can proceed with deleting or inactivating a field but the Soft Error
message warns you to evaluate your settings before continuing:

l The field is a secured field referenced in a workflow condition, link condition, or email template
condition. The system displays the following warning message. The system will allow you to
proceed with deleting a secured field that is not referenced elsewhere or is referenced in a
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business parameter only by clicking Delete on the warning message.

Business Rules:  Soft and Hard Error Validation

Some business rules have hard error validation to prevent deletion or inactivation of a field while others
have soft error validation that allows you to proceed but encourages you to evaluate the business rules
first. Whether a hard error or soft error displays is determined by the Rule Type defined in the custom
logic rule settings (System Admin > Manage Rules).

The messages always list the associated dataform, business rule and business rule method/parameter
so that you can review the affected dataform, business rule and method before proceeding with the
inactivation or deletion of a field. The bulleted list items shown in the message are links that take you
directly to the related custom logic rule.

Deleting and Inactivating Dataform Fields

Deleting a dataform field:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. From the list, select an entry and click Edit or click (Jump).
The Dataform Properties form opens.

3. In the Action Center, click Fields.
The Fields list of the dataform displays.

4. Review the list of fields for the dataform.
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5. Select the row for the field to delete.

6. Select the Delete button in the toolbar.
7. Select Delete in the Confirm Delete window. (The message may vary depending on factors such

as whether the field is a secured field and has been referenced as a dependency.)

8. Click Close to return to the Dataform Properties.

Inactivating a dataform field:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. From the list, select an entry and click Edit or click (Jump).
The Dataform Properties form opens.

3. In the Action Center, click Fields.
The Fields list of the dataform displays.

4. Review the list of fields for the dataform.
5. Double-click the row of the field you want to inactivate.

Field properties display.
6. In the Settings fieldset, uncheck the Active checkbox.
7. Click Savebutton.
8. Select Inactivate in the Confirm Inactivation window. (The message may vary depending on

factors such as whether the field is a secured field and has been referenced as a dependency.)
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9. Click Close to return to the field properties.

Changing the Number of Decimal Places on a Dataform Field
Sometimes you need to adjust the formatting of a decimal field to account for more precision. Use the
following instructions to change the number of decimal places allowed in a decimal field. You must
target a field with an Element Type that enables the Mask field.

To change the number of decimal places:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. In the list, select the targeted dataform and click Edit.
The Dataform Properties for the dataform displays.

3. In the Action Center, click Fields.
The list of fields displays.

4. Double-click the decimal field that needs to be changed. Alternatively, select the field and click 
(Open).
The field form opens.

5. In Mask, specify the number of places allowed before and after the decimal. Example: Insert
00.00 for a number that cannot exceed 99.99.
The following warning message displays: Changing a mask may result in permanent truncation of
data. Are you sure you would like to continue?
Note: If you are performing a change such as reducing the number of places before or after the
decimal, there is a risk of permanent truncation of data. Make certain that this is the change you
want to make before saving.
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6. Click Yes to continue.
7. Click Save.

Adding Time Tracking to a Dataform
This topic provides the step-by-step process to track time for workers comp cases by using the worker's
comp claim function. This is easier than opening a second case just for the purpose to track time.

To add time tracking to a dataform:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Search for the dataform to which you wish to add time tracking.
3. Select the name of the dataform to highlight it.
4. Click Form Properties.
5. In the Actions set, select the Enable Time Tracking option.
6. Click Save.
The dataform that you updated should now display the TimeTracker Action Item in the Action Center.

Related Topics:

l Configuring Default Time Tracking for Task Categories
l Customizing Workflow: Adding and Editing Time Tracker Categories
l Using Time Tracking Categories

Configuring field display with multiple values
Sometimes, there may be a need to display a field conditionally when a field equals more than one
value. The system does not allow the creation of a separate Field Display rule for the same fieldset
(target table). However, a comma-separated list of values can be used instead.

To configure Field Display:

1. Go to System Admin > Advanced > Manage Field Display.
The Field Display Rule Search dashboard opens.

2. Open the targeted field display rule.
3. Enter the targeted value in the equals this value field.

The following example, shows When this field is Case Type with equals this value as 251 or 278.
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Additionally, you can include multiple values for a multi-lookup field. In the following example, the field
When this field can have multiple values. The field equals this value is where you specify the rule
values. Separate the values with a comma-delimited list.

How to determine values for a specific use case

Often System Admins will want to use field display on the Client Service Case form, and that field
display could be driven from Case Types. In the equals this value field, the primary key (Case Type ID,
which is referenced) of the Case is what you would reference, and, you use a number rather than the
display value of a Case. Ultimately, it is not intuitive which Case Type you're picking unless you know.
Use this procedure as navigational help for when configuring field display for a specific use case (Case
Types).

To determine the Case Type ID:

1. Go to System Admin > Administrative Data > Client Service Case Type.
The Client Service Case Type dashboard opens.

2. Open the Type in question.
For our example, we selected Client Name Change.
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3. In the Administrative Fields fieldset, look for the ID of the record in question.

Use this number in the Field Display Rule.

Setting up and configuring Field Audit
Field auditing is helpful when troubleshooting issues to find when and where changes have been made
to a particular field. ***

For a dataform field audits:
1. Select the Audit this field option for the applicable attribute.
2. The Audit this field option on the dataform field admin is disabled for Text Areas, Log fields, and

Multiples.
3. When this option is selected, it creates a record in the Field Audit Configuration form.
4. If a previously selected option is cleared, the Field Audit Configuration record is removed

automatically.

For the Organization only:
You must manually add a record to the Field Audit Configuration.

1. Go to System Admin > Advanced > Tables.
2. Add a tblOrganization record if it does not already exist.
3. Add the fields you would like to audit.
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For security:
1. Global Admin has automatic access to the Audit icon.
2. Non-Global admins need to be configured as an Admin for the given dataform.
3. If the field being audited is on an Organization or Contact, the user needs to have the

tblOrganization and/or tblContact security entity added to their role.

Note: *** A large number of audited fields can cause performance issues.

You can audit the following list of Org General Tab database field names:

fkContactIDPrimary fkUserIDOwner Active

Name EmployerIDNumber OrganizationOwnerName

AKA Address1 Address2

City State PostalCode

Country County Phone

Phone2 Fax Website

crCategory crSource crStatus

crBusinessType HotList Locked

FollowUpDate StatusChangeDate StatusChangeUserId

CreateDate CreateUserId UpdatedDate

UpdatedUserId fkParentOrganizationID Lineage

IndustryCode ImportID AllowImport

OrganizationGUID fkTeleSalesRepUserID

Defining dataform multiform list column headers
The Multi Col column enables administrators with the advanced license to configure the columns in a
module for multi dataforms, single dataforms, and tabbed sets. If Multi Col is not configured, you may
encounter the following error on a search page or dashboard:

"Grid columns have not been configured for this search page".

The steps outlined in this article will fix the error.
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To access the administrative area of ClientSpace:
1. Click your username in the top right corner of the ClientSpace window. EX: developer
2. Click System Admin .

The System Administration dashboard opens. The Advanced system settings box is located in the
bottom right corner.
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To define the multiform list column headers: 

1. In the Advanced section of the System Administration dashboard, click Dataform Admin.

The Dataform Admin dashboard opens.
2. Click the dataform to select it and click Edit.

The Dataform Properties form opens.
3. In the Action Center, click Fields.
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Dataform fields are presented. The column headers for this list are defined using the field
attribute, Multi Col.

4. Type the numeric values in the Multi Col column for the fields you would like to see displayed in
the list in ascending order.

5. Save your changes.
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Note: 

l For newly created dataforms, your first column in the search module will default to the name of
the Workspace.

l For dataforms that are out-of-the-box, the first columns in the search module may not be
configurable.

Configuring API-Enabled Fields
Global Administrators can define required fields for an API by API User. This allows each API user (i.e.,
consumer) of the API to have their own definition of the required fields for the dataform without
impacting an API user who is running on a different pipeline.

You can set up distinct groupings of required fields for each API User (System Admin > Advanced
> API Users) only if the API User record is configured with a unique pipeline (which is our
recommended best practice). Then, when you associate a group of fields with the pipeline of API User 1,
for instance, you can also associate another group of fields with the pipeline of API User 2 and have
some of those fields be the same as or different from those associated with API User 1. This is illustrated
in the diagram below:

To configure API-enabled fields:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Locate the API-enabled dataform and then click (Open) next to the dataform name.
The Dataform Properties form opens.
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Note: To make a dataform API-enabled, click the Include in API checkbox on the Dataform
Properties. This setting enables the API Configuration link that we will be using to associate
fields to pipelines.

3. Click API Configuration in the Action Center.
The API-Enabled Fields window displays.
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4. Click Add.
The API-Enable a Field window displays.

5. Select the Pipeline. (This should match the pipeline of the API User record which coincides with
the group of required API-enabled fields you are now configuring.)

6. Then, select the Field and click OK.
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7. Continue adding API-enabled fields for this form (which match the pipeline of the API User
record) until you have defined the form for the API User.
Note: When you are finished, you can conduct a More search to filter by pipeline and verify your
entries.

Configuring Your Dataform Datatypes
The following is a list of the most commonly used datatypes in the application, accompanied by a brief
explanation of how they work.  

TypeName Explanation of Datatype

Calendar Event
Selector

Select any non-recurring calendar event to which the user account has access
and create a link within the dataform to this calendar event.
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TypeName Explanation of Datatype

Checkbox True/False (bit). Presents the user with a check box (option). Defaults
to unchecked (cleared). 

Contact Type Ahead Filters the related Org Category list to narrow the list of Contacts. If this
parameter is not set, control returns a complete set of Active Contacts.

Note: You can filter contact types by using the Contact Category filter
option in the Contact Settings field set when you add or edit a field on a
dataform. Add lookups using the CRMContactCategory lookup group to
create multiple values to filter on.

Date Date. The user can enter a date or select a date by clicking the calendar icon to
the right of the field. Only valid dates are accepted as an entry into this field.
Codes can be used as a shortcut to populate the date field. Typing “2d” into a
date field adds two days to the current date. “-2w” subtracts two weeks from
the current date and so on. The valid codes are d=day, w=week, m=month,
y=year.

Date Time Displays the full date and time in one field.

Note the following regarding Date Time field data entry:

l If the user does not set a time in a Date Time field, the time defaults to
00:00:00 unless the Default to Current Date and Time setting in
dataform field configuration has been set (which will result in the current
date and time being auto-filled in the field.)

l Date Time fields accept date/time shortcuts. The valid codes are t =
today, mm = minute, h = hour, d = day, w = week, m = month, and y =
year. Examples: t (current date/time),1w (plus 1 week), 3d (plus 3 days), -
1d (minus 1 day), -1h (minus one hour), or 15mm (plus 15 minutes).

l If the user enters t (today), the computer's system date and time are used
to populate the field with the current date and time.

Decimal Accepts a decimal number with the precision as defined in the mask. If the user
enters a number with higher precision (more digits to the right of the decimal
point), than the mask allows, the number is rounded to the proper precision.

Editor Rich text control. Similar to a text area, but with formatting.

Email Text field. Checks for a valid format of the email address.
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TypeName Explanation of Datatype

Field Set Fieldsets are not data entry fields, and no corresponding SQL Server field is
created when a new fieldset data type is created. Fieldsets act as an
organization container for other fields. The use of fieldsets typically makes the
layout and organization of a data form significantly better.

File Upload
Manager - Database

Enables file attachment. Files are stored in the database. Multiple instances of
the same file are stored as one file with multiple linking records.

Image Attach an image file.

Integer Consists of the natural numbers (1, 2, 3), zero (0), and the opposites of the
natural numbers (−1, −2, −3). If no minimum or maximum is specified in the
field properties, the user can enter a number up to 2.146 billion.

Link Text field with hyperlink control attached. CAUTION: The hyperlink control
always attaches the HTTP protocol before a URL is stored in this field and can
result in protocol doubling up.

Location Sync Creates a list that contains all the locations for a given workspace. Upon
selection from the list, it pre-fills other address fields on the form. Only works
on the Location form

Log Wide text area. Enables the user to enter standard text in paragraph
form. When the entry is saved, the user that entered the text and the date/time
of entry is recorded with the entry stored at the top of the field (above all
previously entered text). 

Lookup (core) The list is populated from the specified lookup. See Configuring lookups.

Lookup - Multiple
(core)

Text box (500 characters) stores multiple selections as text strings separated by
!.!. See Configuring lookups.

Money Decimal (14,2). You can enter a value of up to 10 billion dollars. The mask is set
by the system to allow for a decimal scale of two with automatic rounding to
two places. Minimum/maximum property settings can control the data entry as
needed. The input is automatically formatted with dollar signs and decimal
scale of two places.
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TypeName Explanation of Datatype

Org Contact List of contacts for the Org attached to the workspace.

Note: You can filter contact types by using the Contact Category filter
option in the Contact Settings field set when you add or edit a field on a
dataform. Add lookups using the CRMContactCategory lookup group to
create multiple values to filter on.

Org Contact (Field
Related)

List of contacts for an Org referenced in an Organization field on the dataform.

Note: You can filter contact types by using the Contact Category filter
option in the Contact Settings field set when you add or edit a field on a
dataform. Add lookups using the CRMContactCategory lookup group to
create multiple values to filter on.
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TypeName Explanation of Datatype

Org Type Ahead Typeahead field that performs auto-complete foreign key to
Organization record. Note: You can filter organizations by the Category field
when configuring this datatype. You filter for organizations with an active Client
Master by using the ActiveClientMaster filter on this datatype. This is done
from Advanced Settings on the field properties.

Access the Advanced Settings by going to System Admin > Advanced
> Dataform Admin, select the dataform and then double-click the field to
access field properties. Click Advanced Settings and set ActiveClientMaster
to 1 to enable the filter. Setting the property to 0 removes the filter.

Note: When configuring Advanced Settings, be careful of syntax:

l Properties should contain no spaces and be closed in quotation marks.
l Multiple properties should by separated by a comma (no spaces).
l The entire string should begin with a left curly brace { and end with a

right curly brace }.

Parent Form Integer field contains custom logic to tie it to a parent dataform. For more
information see Configuring parent form datatypes.

Percent Decimal (14,2). Formatted as a percent.

ClientSpace Setup & Administration © 2025 PrismHR 294

Chapter 4 Dataforms



TypeName Explanation of Datatype

Phone By default, this is a text field formatted as phone number: ### - ### - ####.
When you check the Allow International Phone Numbers checkbox, the
input mask is removed to allow entry of international phone numbers.

Note:

l The Allow International Phone Numbers checkbox setting does not
impact Phone datatype fields on CRM forms (i.e., Contact and
Organizations) as these forms are treated differently in the system. To
allow international phone number entry on these forms, the Allow
International Phone Numbers on CRM forms checkbox must be
checked in App Settings (System Admin > Advanced > App
Settings).

l Only Developer Users can access App Settings. If you need this feature,
please contact your ClientSpace representative or log an extranet ticket.

Project User List of active users for the workspace the form resides on

Project User Type
Ahead

Typeahead list of users associated with the workspace in which you are
currently working.
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TypeName Explanation of Datatype

SSN By default, the text is formatted as SSN ### - ## - ####. However, a security
mask (xxx-xx-####) is also automatically applied when a user opens a form with
an existing SSN or types an SSN into a field.

An eye button mask entity is also created for each SSN datatype
field: <dataform>.<fieldname>.Mask. This is separate from and in addition
to the standard SSN field security entity.

Example: gen_Employees.SSN.Mask

This entity enables a View/Hide (i.e., eye) button next to the SSN. This serves as
a toggle switch to remove the mask for temporary viewing of the complete SSN 

and to reapply the mask .

Example:

Note: 
l Although the eye button mask entity is automatically created when new

SSN datatype fields are created, it is not assigned. You must manually
assign it to roles with View rights if you want those roles to have access
to the eye button.

l If you do not assign the eye button mask entity, the SSN mask will still be
applied but users without the eye button cannot remove the mask to
view the complete SSN.

l The security mask is applied to both accessible and "read only" fields.
o If a field is disabled by a field display setting and the eye button

mask entity is applied, the eye button still displays but is disabled.
l On an accessible field, if you try to edit an SSN by backspacing over any

part of it, the entire value clears and you must re-enter the SSN.

Text Standard text input field accepts alphanumeric and special characters. Limited
to 500 characters unless a smaller number is entered into the max length
property.

Text-Wide Wide text area. Takes two columns on form.
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TypeName Explanation of Datatype

TextArea Wide text area. Expands to large note area for editing. Identical to the text entry
field but the field spans two columns and 3 rows to accommodate longer text
entry.

Time - Military Text field formatted to accept military time, such as 21:40.

Time - Standard Text field formatted to accept standard time (9:40pm).

User Integer. List of all active users in ClientSpace. The primary key of the user record
is stored in the integer field.

UserByEntityTypeAh
ead

Typeahead List of users filtered by Security Entity (Entity configured in the
Advanced Settings property of the dataform field).

User by Role Type
Ahead

Typeahead list of users filtered by role entered in the Advanced Settings
property of the dataform field.

User Filtered By
Entity

List of users filtered by Security Entity (Entity configured in the Advanced
Settings property of the dataform field).

User Filtered By
Entity Type Ahead

Text box. Uses typeahead functionality to select available users filtered by a
security entity.

User Filtered By Role List of users filtered by associated RoleID entered in the Advanced Settings
property of the dataform field.

User Multiple Select Allows for the selection of multiple users from a pop-up.

User Project A list of the projects the user has access to.

User Type Ahead Typeahead list of users.

WC Policy List of Workers' Comp Policies. Use the Advanced Settings property to filter
the list of policies. For example, enter
{"CompModel":"Master","ExcludePolicyStatus":"Expired"} to display
policies with a Master policy type and to exclude expired policies.

Zip Code Text. Formatted as a zip code. Zip code fields also can use custom logic to set
associated fields on the dataform. For more information, see Configuring the
Zip Code datatype.
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Configuring parent form datatypes
Parent-child relationships between dataforms allow you to build a fully relational structure to your
ClientSpace information, knitting dataforms together to create a data structure that mirrors the real
world. An example of this in our PEO system is the Employee demographics and related forms. For
clients, there are one or more employees, each with a singular record. If the employee moves or gets
married, you want to update that record instead of creating a new one.

The employee’s employment history,
however, is a different story. There are
many reasons to historically track
employment information. Take for
example a theme park that terminates
employees at the end of the season, then
re-hires them at the beginning of the
next season. By historically tracking this
employment record, we can view an
employee’s history, pay grade changes, and reasons for termination. The person is the same but the job
changes.

In database administration, this is known as a One-to-Many relationship: one employee record, with
many employment records. To take this a step further, each Employment record has multiple paycheck
or voucher records associated with it and each voucher record can have multiple deduction records and
so on. The ability to dynamically associate data together in a cohesive structure is one of the most
powerful capabilities of the ClientSpace system.

Parent form fields are always added from the Child form. So, in our example, there would be an
Employee field on the Employment record, an Employee Employment (Job) field on the Voucher record,
and so on. This is important to understand when completing the setup of this relational datatype.

Let's use the Employee field and the following dataform as a guide.
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To configure the Employment dataform:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Open Employment.

The Dataform Properties: Employment form opens.
3. In the Action Center, open Fields.

The Employment fields list displays.
4. Open Employee.

The Employee dataform opens.

Field Description

Element Type Determines the type of data you store in this field. Parent Form is the default.

Field Set A fieldset is a group of fields delineated by a box. You use a fieldset to
organize fields.

Field Label This value displays on the dataform, so Employee makes sense.

Field Name This is the column name for this field as it is stored in the database.
On these parent form datatype fields, the system stores the ID of the parent
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Field Description

form record. This is called a Foreign Key (when joining data tables together in
these relationships, the primary ID of the record on another table is the
foreign key of that record on the referencing table), so we would use a
standard naming convention for this field of fk (foreign key) Employee
(dataform name) ID or fkEmployeeID.

As a best practice, use camel case for the Field name. Begin with lowercase to
indicate datatype (such as fk for foreign key or lu for lookup). This is a best
practice and makes the data easier to understand when you use this
information in reports.

Row Row property determines the vertical ordering of fields and fieldsets. Fields
that are within a fieldset are ordered within that fieldset. A best practice is to
set this in increments of ten, which allows for re-ordering fields or adding
fields between rows without re-ordering the entire form.

Column Column property is hard-coded to dictate a two-column format. 

Field Behavior • When ReadOnly is selected, the field cannot be edited.
• When Required is selected, the field must be completed before you can

save the dataform unless the field is in a hidden fieldset. 

Length The maximum length of the field entry. This property is valid for text and
integer data types.

Comment Comments provide online help for dataform users. When comments are
added to any dataform field, the info bubble is enabled and on hover, the info
bubble displays the comment text in a pop-up.

Quick Search Select a value to add the field to the Quick Search on multiform searches:
• Starts With
• Equals
• Contains (% search)

Parent Form Dataforms can be related to each other in a parent-child relationship using
the Parent Form data type. When this data type is selected, the related form
fields are enabled (One to One and Form Link Name), allowing you to
define the relationship.
The Parent Form is selected from the list of all dataforms because the
relational field is placed on the child form. Recursive relationships where a
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Field Description

record is related to another record of the same dataform are supported. For
example, a person dataform may be related to itself to represent the mother
and father of the person.

One to One By default, One to One is enabled (selected). This means that each parent
form can be related to only one child form. One-to-many relationships allow
a parent form to relate to many children records.
• If One to One is enabled (selected), the link to the child form from the

parent presents the child form directly.
• If One to One is cleared (not selected), this means you have a one-to-

many relationship. The link to the child form from the parent presents a
list of related records giving the user the option to edit an existing related
record or add a new related record.

Form Link Name Employment Information. This is what appears in the form link in the upper
left of the Parent dataform.

Form Searchable When selected, the form is one of the Search parameters in a multiform list.

Secured When selected, the field is secured and generates a security entity for the
field in the format of gen_TableName_FieldName.

Active Determines if the field displays on the dataform. Deactivating a field is
preferential to deleting it because deleting the field removes it from the
underlying SQL table and erases the data. When you deactivate or hide a
field, you retain the data for later use.

Hidden Determines if the field and its children are hidden when a dataform record is
viewed.

Include in
Document Index

When selected, this option includes the dataform field when indexing
documents attached to the form so that it can be used as part of the
document search.

Audit this field Determines if the field is auditable.

Cloneable Determines if the field is configurable when this dataform is created by
Workflow and Email Templates.

Allow Dataform
Notification

When selected, this field is included in a dataform notification when dataform
subscribers are emailed. Updated fields appear in bold in this email.
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Field Description

Triggerable Determines if this field is available for use as the Triggering Field or as one of
the Triggering Conditions when configuring Workflow Channels and Email
Templates

The remainder of the setup for this dataform field is open to configuration on your part but notice that
fkEmployeeID is a required field on this form. You cannot have an employment record without an
attached employee, so the field is required. Careful planning before adding fields to a dataform saves a
lot of cleanup of bad data down the road.

Parent form datatype morphing
By default, if there are less than 250 records when a Parent Form datatype presents on the page, it
displays as a drop-down list. If there are more than this threshold, the field becomes a type ahead with
a search pop-up.

The threshold can be changed in the Advanced Settings property of the dataform field settings by
using the ROWCOUNT command. Records can also be brought in from a different workspace using the
Advanced Settings section as well by adding the partial GUID of the workspace.

For example, to have a threshold of 50 records and to bring in records from a workspace with the
partial GUID 'ce3d5dee' as well as the current workspace, you would add
ROWCOUNT=50;ce3d5dee;CURRENT to the Advanced Settings property of the dataform field
settings.

The ROWCOUNT command can alternatively be used to extend the threshold beyond 250 where the
records can be filtered by other means. For example, there are several places in the application such as
Client Service Cases where a parent form field is filtered by another field on the dataform. An example
of this would be a Client Service heavy environment where you have 275 case types. The case type list
on the dataform is filtered by the case category, but the Morphing aspect of the parent form datatype
converts the field when the dataform loads, prior to the category filtering. In this instance, you can add
the ROWCOUNT=300; switch to the Advanced Settings property, the control remains a drop-down,
but is filtered client side by the Category field. Caution should be exercised when using this option, as
too many rows can exceed the length of the standard drop-down list, making selecting from the
bottom of the list impossible due the limits on scrolling in these controls

Configuring the Zip Code datatype
The Zip Code datatype is a dynamic control that can be configured to auto-fill related fields on the
form. This can be a great time saver, especially when configuring dataforms with multiple address fields.
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The field is configured using a semi-colon separated list of related fields in the Advanced Settings
properties of the dataform field.

To configure a Zip Code datatype on your dataform:
1. Add the zip code field and other related fields such as City, State, and County.
2. In the Zip Code Settings fieldset, complete the fields for City, State, and County. These could be

fields such as BillingCity, BillingState, BillingCounty – as long as the field names are correctly spelled
and in the appropriate zip code settings fields. In this way, you can use the same zipcode datatype
to fill multiple city state and county fields on the same dataform.

3. Save your dataform field.
Now when you fill the zipcode field on the dataform and tab out of the field, the associated City, State,
and County fields are auto-filled.
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Dataform and Dataform Field Security
In this topic, we will show you how to:

l Set dataform level security
l Set dataform field level or fieldset level security
l Grant access to a secured dataform, field or fieldset

Setting Dataform Level Security

To set dataform level security:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Open the desired dataform by either clicking (Open) next to the Dataform Name in the grid or
by double-clicking the line item of the dataform in the grid.

The Dataform Properties form opens. On the Action Center toolbar, a green lock indicates

that the form is not secured. A red lock indicates that the form is secured.
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3. What do you want to do?

• To add security to the dataform: Click the green lock icon. Then, click Yes on the Secure
dataform confirmation message:

• To remove security from the dataform: Click red lock icon. Then, click Yes on the
Unsecure dataform confirmation message:
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4. Click Save.

Setting Dataform Field or Fieldset Level Security

To set dataform field or fieldset level security:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Open the desired dataform by either clicking (Open) next to the Dataform Name in the grid or
by double-clicking the line item of the dataform in the grid.
The Dataform Properties form opens.

3. In the Action Center, click Fields.
The list of fields and fieldsets on the dataform are displayed.

4. Double-click the field or fieldset you want to secure.
This displays the field or fieldset properties.

5. In the Settings fieldset, click the Secured checkbox to add field or fieldset security.
This creates a security entity for the field or fieldset using the following format: gen_tablename_
fieldname or gen_tablename_fieldsetname. A user must be assigned a minimum of View rights to
the security entity for a field or fieldset to appear on the form. To edit the field (or fields within a
fieldset), the user must be assigned Edit rights.
Note: See Security topics for general guidance on administering security. Also see Configuring

Organization and Workspace Security for more information on security inheritance (or hierarchical
security) in ClientSpace.
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Granting Access to a Secured Dataform, Field or Fieldset
Note: This section is a quick tutorial on how to edit existing roles to add the new security entity you
created. This allows users to access a dataform or dataform field/fieldset that you have secured. For
complete details on administering security, review all of the topics in the Security section, including
Administering role security.

To grant access to a secured dataform, field, or fieldset:
1. Click your username in the top right corner of the ClientSpace window. EX: developer
2. Click System Admin .

3. Go to Security > Roles.

The Security Roles dashboard opens.

4. Click (Open) next to the role that you will configure to have access to the secured dataform, field
or fieldset.

Tip: Type the Wildcard (% ) Search symbol followed by several characters contained in the security
role name to help you quickly locate the security entity. Example: %Service Case
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5. In the Action Center, click Entities to view Security Role Entities.
6. Click Add.

The Add Role Entities window displays.

7. Select the security entity for the dataform, dataform fieldset, or dataform field.

Tip:  Type the Wildcard (% ) Search symbol followed by several characters contained in the security
entity name to help you quickly locate the security entity.

8. Add the appropriate View, Add, Edit, Delete, and Admin rights to the entity for the role.

Note: Saving is not required. The settings are automatically applied.
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Related Topics:

l Dataform Properties
l Distributing your dataform: Making dataforms accessible
l Configuring a Dataform to open as a Module
l Configuring Dataform fields
l Security

Configuring Dynamic Field Display
Configurable field display provides an administrator with vast control over the general look and feel of
a dataform. This is much more than just grouping fields into fieldsets or tabs but includes the ability to
dynamically enable or disable fields and show or hide fields, fieldsets, or even tabbed dataforms based
on the other data on that dataform. In combination with custom header links, an administrator can
virtually set up any workflow or process in ClientSpace using dynamic field display.

When configuring field display, keep in mind what you would like to accomplish and map out how the
result should work on your dataform. For example, when you select Organization as the Location,
Organization fields can be made read-only or hidden based on configurable properties just as dataform
fields. The source for these properties can be either based on Organization fields (where Field Source is
This Table) or other related fields in ClientSpace using a field display proc (Field display Proc 1 or 2).

Field display can be cascaded. Combine this with required field rules, and it allows you to build
incredibly complex workflows within a dataform. An example of this could be a form, where filling out a
Pay Frequency field with a value of Weekly displays a Weekly payroll fieldset containing a required Pay
Type field with values of Check or Direct Deposit. Selecting Direct Deposit displays a field for Bank
Authorization, which is also required to save the form.

Required dataform fields hidden through configurable field display do not present their required
attribute to the system’s dataform save logic, meaning these fields are only required if visible. This
allows you to structure complex dataform logic and workflow within a dataform. This flexibility should
be tempered with planning to ensure that appropriate data is captured when required. In short, make
sure you are not hiding a required field (or a tab that contains a required field) that should be
completed.

Field Display Validation
Validation for conflicts is in place to ensure that the target field does not already have a field display
rule set up with a conflicting behavior. For instance, if a previous rule was set up to expand a fieldset
and another rule that references the same Type, Field Source, controlling field (i.e., When this field),
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value (i.e., equals this value), and target field (i.e., this item) is set up to collapse the same fieldset on
the same dataform, an error message similar to the following displays:

"There is already a 'State' Rule configured for the specified Table, Controlling Field, Target Field and
Value."

This is illustrated in the image below:

The following ten behaviors are validated for conflicts:

This behavior... is validated to check for this conflicting behavior
Hide Display
Hide Expand
Hide Collapse
Display Hide
Disable Enable
Enable Disable
Expand Collapse
Collapse Expand

Field Display Configuration

To configure and manage dynamic field display:

1. Go to System Admin > Advanced > Manage Field Display.
The Field Display Rule Search dashboard opens. It is helpful to filter the presented list for the
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dataform to which you are adding field display. This helps you to understand the existing field
display logic and determine if this affects the changes you want to make.

2. When ready, click Add.
The Field Display Rule Detail form opens. This form provides a number of configuration options to
customize your field display.

The following graphic illustrates the Field Display Rule Detail form when the Type field contains
State.

The following graphic illustrates the Field Display Rule Detail form when the Type field contains
Style.

ClientSpace Setup & Administration © 2025 PrismHR 312

Chapter 4 Dataforms



3. Complete the form:

General(fieldset)

Location Required. Select the location for which you would like to configure the field
display. Many of the items on the list are dataforms. However, some are not,
such as Organization. The Location selection affects several other choices on
this form.

Field Source Required. Select one of the following:
l This Table: Indicates your field source is from the Location field (such as

a dataform).
l Field Display Proc 1: Indicates your field source is from a custom stored

procedure.
l Field Display Proc 2: Indicates your field source is from a custom stored

procedure.

A Field Display Proc is a custom SQL stored procedure that allows you to
aggregate information from other dataforms in the system. For example, this
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allows you to disable all of the fields on workspace Employee and Employment
forms if the Client Status on the Client Master page is Terminated.

Type Required. Determines whether this is a field display change that affects State
or Styling:
l State: Field interaction. Visibility / read-only attributes (default). 

o When you select State, the will and Clear Field On Disable/Hide
fields display in the Result fieldset.

l Style: Sets CSS Styling changes to the field label based on a specific
triggering condition. 

o When you select Style, the Font Type, Font Style, Color, and
Sample Text fields display in the Result fieldset.

When this field Required. Presents a series of fields based on your choice of Location and Field
Source. The selection in this field acts as the trigger for your field display
action.

equals this value Required. This is the triggering value and should be set to something
appropriate for the triggering field selected in When this field. For example, a
check box selected as the triggering value should equal either True or 1 to
trigger your field display off the checked state.

The value of a Lookup trigger field should equal the code value of either one of
the lookup options or a comma-separated list of code values.

You can set the triggering value to #Empty or #NotEmpty to trigger the field
display rule when the triggering field is empty (i.e., blank) or not empty (i.e.,
populated).

You can also build OR statements using a comma-separated list of values in
this field for distinct value fields such as lookups, text, or parent form fields.
Lets' say you have a lookup field to store the days of the week. To trigger field
display for weekend days using equals this value as Saturday,Sunday
equates to where value equals Saturday OR Sunday. Note, there are NO spaces
between the values in a comma-separated list.

this item Required. This is the field, fieldset, or tab upon which to perform the field
display.

ClientSpace Setup & Administration © 2025 PrismHR 314

Chapter 4 Dataforms



Result (fieldset)

will Note: This field only applies to Type of State.

Required. Choose a field display action:
l Enable: Opens field for edits, allows changes to the field to be saved.
l Disable: Marks the field or tab as read-only and not editable.
l Hide: Hides the field or tab from displaying.
l Display: Shows the field or tab on the dataform.
l Expand: Displays all fields within a fieldset. This can cue a user that one

or more fields in the fieldset will require consideration based on a user's
selection or action. The user can still click the chevron to collapse it again.

l Collapse: Hides all fields within a fieldset. This can cue a user that the
fields in the fieldset can be ignored based on a user's selection or action.
The user can still click the chevron to expand it again.

Note:

l If you set a field display rule to hide a required field or hide a tab that
contains a required field, ClientSpace does not enforce the required field
when the rule hides the field or tab. Also, the system does not create a
copy of a hidden tabbed dataform when a user adds a new dataform that
contains that hidden tabbed form.

l Dynamic field display Expand/Collapse rules on fieldsets always
supersede any default Expand/Collapse settings created on fieldsets in
Dataform Administration.

l If you apply a dynamic field display Expand/Collapse rule on a fieldset
that has no Expand/Collapse settings configured on the fieldset in the
Dataform Administration, the fieldset will necessarily become an
Expand/Collapse fieldset and display the chevron.

l Expand/Collapse rules may only applied to fieldsets - not to individual
fields.

Clear Field On
Disable/Hide

Note: This field displays in the Result fieldset when a user selects State in
the Type field up in the General fieldset.

Clear Field on Disable/Hide does precisely that. It removes any information
previously stored in this field when it is hidden or disabled. This is a hard delete
from the system, so exercise careful planning when choosing this option.
Hiding a fieldset hides all fields within the fieldset, masking any required field
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actions for those fields.

This option is hidden when a tab is selected in When this field.

Font Type Note: This field displays in the Result fieldset when a user selects Style in
the Type field up in the General fieldset.

Select one or more of the following options:
• Normal
• Bold
• Underline
• Italic

Font Style Note: This field displays in the Result fieldset when a user selects Style in
the Type field up in the General fieldset.

Select one of the following options:
• Normal
• Small
• Large

Color Note: This field displays in the Result fieldset when a user selects Style in
the Type field up in the General fieldset.

Select the color picker drop-down to select a color or to enter a color
hex value (for example, #d31414). Click Update to apply the color, or click
Discard to close the color picker.
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Sample Text Note: This field displays in the Result fieldset when a user selects Style in
the Type field up in the General fieldset.

The Sample Text is a preview of how the Font Type, Font Style and Color
settings will display when applied.

If you do not approve of the current style settings, select the Discard button

to remove the current settings and then reapply changes to Font
Type, Font Style, and Color.

4. After you have configured all the field display options, click Save.

Examples
On the Organization, when the field DoNotCall is selected (equals 1), then the tab Org Other Info is
hidden.

ClientSpace Setup & Administration © 2025 PrismHR 317

Chapter 4 Dataforms



When the field named MultiTest has a value of 20 or 25, then the tab named Tab One is hidden.

Adding tabbed dataforms to a parent form
This topic provides step-by-step instructions on adding tabs to a dataform. Much of the process
involves creating a new dataform. Only the key points of this process are touched on as this is well
documented elsewhere. Adding tabs requires access to the dataform pipeline configuration and is only
available with Developer rights in the system.

To add tabbed dataforms to a parent form:
1. Create the tabbed dataform(s) in Dataform Administration, ensuring that you include a Parent Form

datatype field, configured to point at the Parent form of the tab.
2. In Dataform Administration, search for the Parent Dataform and go to Form Properties >

Customization > Pipeline(default) > Tabs.
3. Click Add.
4. Select the tab dataform from the Dataform list.
5. Set the Display Order (this is the order the tabs appear at the top of the dataform).
6. Click Save.
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Distributing your dataform: Making dataforms accessible
After a dataform is created and configured, you need to provide some way for it to be used, and this
can be accomplished in several ways. A dataform might need to be workspace specific, so you would
need to add it to a single workspace, or it may need to be more widespread, so you would want it
copied to each workspace as they are generated. You may also want to only expose access to the
dataform from the header of another dataform. Certain financial dataforms in the PEO system are
exposed through header links from the dataforms for which they contain financial data. This document
discusses each of these methods of Dataform Distribution.

Adding a dataform to a workspace

To add a dataform to a workspace:

1. Navigate to the Workspace in question. This can be a single administrative workspace, or you can
have the dataform generated on Workspace creation. Go to System Admin > Workspace
Templates.
The Workspace Template Search dashboard opens.

2. Locate and open the template in question.

3. In the Action Center menu, select Dataforms.

The Workspace Dataforms list is displayed.

4. Click Add.
The Add Dataforms dialog opens.

5. Find and select the dataform.
When adding a dataform, if the entry in the dataform search dialog is disabled, this means the
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dataform already exists in the workspace.
6. Click Ok.

The dataform is added to all child workspaces of that template.

Adding a new link to the dataform
Dataforms can also be accessed from custom links in another dataform header. Configuring a header
link is detailed in the topic Configuring Custom Dataform Links . This topic discusses the link
configuration items to create a Workspace Dataform link.

To add a new link to the dataform:

1. Go to System Admin > Advanced > Custom Links.
The Configure Links dashboard opens.

2. Click Add.
The Configure Links Detail form opens.

3. Use the following field descriptions to guide you through adding a new link.
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Location The name of the dataform on which you want to link to appear.

Group Where will the link appear in the header?

Display Value The text that is displayed in the Action Items area as a selectable link.

Display Action Lists the possible actions for the selected link group. The available actions
are based on the selected Group and include items such as running a report
or merge. This then creates a HdrAction to fire a business rule or open a
system dataform.

Sort Order When multiple links are displayed in the header, this determines their order
within the link group.

Sort/Merge Select the report or merge to run using the appropriate display action when
a Report link is selected.

Target Dataform The dataform you would like the user to access from this link.

Code Value This is the HrdAction produced when an Action link is selected.

Custom Function This is the custom function that is called from an Action link.

Custom Function
Data

This is the data that is passed to a custom function if required.

URL Use this field to configure the URL that opens on a URL Display Action.
When defining an external URL, include the protocol (http:// or https://) as
links. Without the protocol, the link is treated as internal to the application.

Confirmation
Message

Provide a confirmation message that displays an OK / Cancel dialog box
before running the link action. This is most often used with Action Links.

Description A short description of the dataform and how it should be used. This text
appears when you point to the link.

Display this Link
when adding

This section can be used to set parameters for when the link should display.
For a complete discussion of configuring link display see Configuring
Custom Dataform Links .

Pinned Open When selected, this forces the link to always display in the Action Items
area. The link does not collapse when the associated group is collapsed.

Condition
Expression

This field uses the Labels from any conditions that you added under Add.
You can combine multiple triggers into more complex expressions and
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override the default OR behavior. Conditions that are not included in this
field are ignored.

Active By default, configured links are active.

4. To add a link display condition, click Add.
Link display conditions might be used to control when the link appears, such as when the client is
in the approved status. For details on how to add a link display condition, see Configuring Link
Display Conditions.

5. To add link security, click the Security icon in the Action Center to access the Security Roles
window where you can add one or more roles and secure the custom link to unlimited roles. For
details on how to configure link security, see Configuring Link Security.

6. After configuring the Dataform Link, remember to Save your changes.

For questions about Admin Dataforms, please log an Extranet case.

Configuring a Dataform to open as a Module
Did you know that you can create a module from a dataform? This allows you to access a single or
multi-dataform without having to enter the Workspace first.

To create a module:

1. Go to System Admin > Modules.
The Modules dashboard opens.

2. Click Add.
The Module Details form opens.

3. Complete the form:
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Name Enter a name for the new Module.

Category Select a category for the new Module.

Description Enter a description.

Target Select Main Window.

Type Select Dataform. The Dataform field becomes available.

Dataform Select a dataform from the list. These are single dataforms (not tabbed forms).

Active Select to activate the new module.

4. Click Save.

Example of how to use
Let's say that you want to configure a module named Employee Search to display a list of Employees.

To configure:

1. Go to System Admin > Modules.
2. Enter the Name as Employee Search.
3. For Category, select Other.
4. For Target, select Main Window.
5. For Type, select Dataform.
6. For Dataform, select Employee.
7. Click Save.

To view your new module:

1. Go to System Admin > Modules.
The Modules dashboard opens.

2. In the list, locate your new module, Employee Search.
3. To open, click (Jump).

The list of employees is displayed with the columns that are configured in the Dataform Admin for the
Employee dataform, under Multi Col (see Defining dataform multiform list column headers). Numeric
values (not zero) in Multi Col determine the columns that you see in the Employee Search list.
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Viewing dataforms and their related items
While administering dataforms, you can view dataform fields and related items from the Action Center.
This information can help you avoid deleting items that are essential, such as triggers and rules. The
following items appear in the Action Center with a badge count to indicate the quantity:

l Workflow Channels
l Email Templates
l Business Rules
l Custom Links
l Lookups
l Field Display Rules

If related items exist, a badge counter indicates the quantity. When you select the item, the
corresponding dashboard opens, filtered by the item. For example, when you select Email Templates,
the Email Templates dashboard opens for those specifically related templates.

To view the related items:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Select a dataform, such as Client Master (shown in our example).
The Dataform Properties form opens.
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3. In the Action Center, select an item with a badge count, such as Email Templates.
4. The dashboard for that item opens, with a filtered list specific to the selected dataform.

Our example shows that an Email Template named DocuSign is related to the Client Master
dataform.
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Learning how: Providing services to your clients through
Dataforms
As you may know, dataforms are the backbone of the ClientSpace system. Dataforms store information
about the day-to-day operation of providing services to your client. Dataforms can help you work more
efficiently and effectively. Dataforms come in two flavors: the single form such as a Client Master or the
Client Team form, and the multiform such as a client Location or the Employee form.

Video

Watch the video about Client Services Overview.

Default Server Data Procs
Server Data procs are designed to return data from elsewhere in the system which can then be used for
field replacement or trigger conditions.

• When using Server Data Proc data for field replacement, the standard format of the field
replacement code is {SDP#.FieldName} - with the number indicating the layer to which the server
data proc is attached.

• For CORE and PEO server data procs, this would be SDP1.
• For Custom Server Data procs this would be SDP2. (For example - {SDP1.ClientNumber) would be

the ClientNumber field returned from the stored procedure configured in Server Data Proc 1
position of that dataforms default pipeline configuration).

The following worksheets provide the default server data procs that come with the ClientSpace PEO
system, the dataforms on which they are configured, a list of the field names returned, and the
adjoining dataform fields from which the data is mined. In all cases the replacement precursor was
taken from the default configuration of the dataform in our PEO system.

Client Master worksheet

Client Master

Replacement Precursor: SDP1

The server data proc peo_server_data_clientmaster accepts the ProjectID parameter and returns the
following Pricing Batch form.
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Field From

BatchOverride PB.Override

BatchContractType_Decode PB.ContractType

BatchPricingMethod_Decode PB.PricingMethod - Decoded

BatchContractType_Code PB.AdminPercentage - Decoded

BatchPricingMethod_Code PB.PricingMethod

BatchAdminPercentage PB.AdminPercentage

BatchPerCheckFee PB.PerCheckFee

BatchPerHeadFee PB.PerHeadFee

BatchFirstCheckSupplement PB.FirstCheckSupplement

Client Service Case

Replacement Precursor: SDP1

The server data proc peo_server_data_clientmaster accepts the ProjectID parameter and fkEmployeeID
from the case form returns the following Client Master and Employment forms.

Field From

WorkflowGroup CM.WorkflowGroup

ClientNumber CM.ClientNumber

ClientStatus CM.Status

ContractType CM.ContractType

PayFrequency CM.PayFrequency

LegalEntity CM.LegalEntityName - decoded

ProcessingCenter CM.ProcessingCenter

SalesRegion CM.SalesRegion

EmploymentStatus Employment - Status for employee attached to
case
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Field From

SutaState Employment - SUTA State for employee attached
to case

EmploymentType Employment - Type for employee attached to the
case

JobCode Employment - Job Code for employee attached to
case

CompCode Employment - Comp Code for employee attached
to case

Project Milestone

Replacement Precursor: SDP1

The server data proc peo_server_data_clientmaster accepts the ProjectID parameter and returns the
following info primarily from the Client Master and Payroll Information forms.

Field From

Status CM.Status

ClientNumber CM.ClientNumber

ContractType CM.ContractType

PayPeriodBegin PINFO.PayPeriodBegin

PayPeriodEnd PINFO.PayPeriodEnd

FirstCheckDate PINFO.FirstCheckDate

DBA Org.DBA

ImplementationSpecialistID CT.ImplementationSpecialist - ID

ImplementationSpecialist CT.ImplementationSpecialist - Name

Client Service Case worksheet
Replacement Precursor: SDP1

The server data proc peo_server_data_clientmaster accepts the ProjectID parameter and fkEmployeeID
from the case form returns the following Client Master and Employment forms.
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Field From

WorkflowGroup CM.WorkflowGroup

ClientNumber CM.ClientNumber

ClientStatus CM.Status

ContractType CM.ContractType

PayFrequency CM.PayFrequency

LegalEntity CM.LegalEntityName - decoded

ProcessingCenter CM.ProcessingCenter

SalesRegion CM.SalesRegion

EmploymentStatus Employment - Status for employee attached to case

SutaState Employment - SUTA State for employee attached to case

EmploymentType Employment - Type for employee attached to the case

JobCode Employment - Job Code for employee attached to case

CompCode Employment - Comp Code for employee attached to case

Project Milestone worksheet
Replacement Precursor: SDP1

The server data proc peo_server_data_clientmaster accepts the ProjectID parameter and returns the
following info primarily from the Client Master and Payroll Information forms.

Field From

Status CM.Status

ClientNumber CM.ClientNumber

ContractType CM.ContractType

PayPeriodBegin PINFO.PayPeriodBegin

PayPeriodEnd PINFO.PayPeriodEnd

FirstCheckDate PINFO.FirstCheckDate
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Field From

DBA Org.DBA

ImplementationSpecialistID CT.ImplementationSpecialist - ID

ImplementationSpecialist CT.ImplementationSpecialist - Name
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Chapter 5
Configuring Rules and Business Logic
Dataform rules can trigger events, ensure that data does not become corrupt (no duplicate SSN and
FEIN), and manage the requirements of a workflow, along with any number of custom functions.

You can configure rules to auto-populate another field when a value is selected. For example, let’s say
that you select a Primary trigger field and a Secondary trigger field. If the values match, you can set a
destination value. You have choices for operator and trigger value datatypes. For example, you can
create a rule when you want to set the Implementation Specialist to X when the Payroll Specialist is Y.

To configure a rule:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. To add a business rule, click Add.
The Rule Details form opens.
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3. Complete the form using the following guidelines.

Table
Name

This is the dataform where this rule will execute when the dataform is saved.

Method Select a method. Is this rule for a field, calendar event, a date value, etc? Our example
shows _SetFieldValue. Also see Business Rule Methods.

Rule Title Provide an abbreviated explanation of what this rule does, for example, "Set
Implementation Specialist for Green Team".

Rule Type ClientSpace controls this field automatically. Rule Type is determined by the Method.

Descriptio
n

Provide a more thorough explanation of what this rule is to accomplish.
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Primary
Source

Select the dataform or tabbed child form to use as the source for the primary trigger
evaluation.
Note: To save a Primary Source field value, you must select a corresponding

trigger field, operator, and value. If you do not, the source value clears upon saving.

Secondary
Source

Select the dataform, tabbed child form, Server Data Proc 1 (SDP1) or Server Data Proc
2 (SDP2) to use as the source for the secondary trigger evaluation, if applicable.
Note: To save a Secondary Source field value, you must select a corresponding

trigger field, operator, and value. If you do not, the source value clears upon saving.

Primary
Trigger
Field

Select or type the name of the field that is going to cause the change. This field is a
lookup of all the fields on the specified Primary Source form.

Secondary
Trigger
Field

Select or type the field name of an additional trigger condition that must be met if
necessary. This field is a lookup of all the fields on the specified Secondary Source
form. The lookup may include Server Data Proc 1 (SDP1) and Server Data Proc 2
(SDP2) fields. The fields appear at the bottom of the Secondary Trigger Field drop
down list prefaced with SDP1 or SDP2.

Note:  Not all organizations will have SDP2 fields displayed in the list. The Server
Data Procs are stored procedures that allow you to access and add fields on one
dataform that reside on a different dataform. SDP1 is typically set up in the
implementation phase for all customers to provide access to some fields that we feel
may be helpful to most organizations. SDP2 fields are only present if custom
development was requested from Professional Services that required additional
access to fields.

Primary
Trigger
Operator
Secondary
Trigger
Operator

Select the operator datatype. The following operators apply to their respective
datatypes:
l Contains: Text
l Does Not Equal: Text, Integer, Date, DateTime, Lookup, User, Parent
l Empty: Text, Integer, Date, DateTime, Lookup, User, Parent
l Equals: Text, Integer, Date, DateTime, Lookup, User, Parent, XML
l Greater Than: Text, Integer, Date, DateTime, User
l Greater Than or Equal: Text, Integer, Date, DateTime,User
l Is Dirty: Text, Integer, Date, DateTime, Lookup, User, Parent
l Is Dirty And Is Empty: Text, Integer, Date, DateTime, Lookup, User, Parent.

Executes if the Trigger Field on this form has changed and is now empty.
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l Is Dirty And Is Not Empty: Text, Integer, Date, DateTime, Lookup, User, Parent.
Executes if the Trigger Field on this form has changed and now contains a
value.

l Less Than: Text, Integer, Date, DateTime, User
l Less Than or Equal: Text, Integer, Date, DateTime, User
l Not Empty: Text, Integer, Date, DateTime, Lookup, User, Parent
l Starts With: Text
l Org, Contact, and some other special fields present as an integer and share

those operators
Note:

l If you are selecting an SDP1 or SDP2 field as the Secondary Trigger Field, be
aware that the system cannot identify the datatype of an SDP1 or SDP2 field
and therefore, cannot filter the Secondary Trigger Operator field to only
show applicable operators for the datatype (as it currently does for regular
form fields). You must evaluate the field's datatype and select a valid operator
that applies to its respective datatype.

l Is Dirty, Is Dirty And Is Empty, and Is Dirty And Is Not Empty are not available
options for SDP fields.

Primary
Trigger
Value
Secondary
Trigger
Value

Type or select a value to be met as a triggering condition.
Note: Primary and Secondary trigger values are selectable from a drop down list
when the associated Primary or Secondary trigger field is a HdrAction or a Lookup.
The following list is the standard behavior of the value field based on datatype:
l Text: Shows a text field.
l Integer: Shows an integer field.
l Checkbox:
l Date: Shows an integer field. You can use date settings for today (t), 1 day (1d),

1 week (1w), etc.
l Lookup: Provides a drop-down field with the corresponding lookup values

prefilled.
l User field: Displays a list of all users.
l Contact/org typeaheads: Integer.
l XML: A sub-selector with the associated lookup and integer.
l Parent field: Brings back decoded data.
l Project User: Integer.
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Other valid values include:

l #CurrentUser: Allows you to trigger a rule when the logged in user (i.e.,
current user) matches the user selected user in the Trigger Field.

l #CurrentDepartment: Allows you to trigger a rule when the logged in user's
default department on their user profile matches the default department on
the user profile of the selected user in the Trigger Field.

Note:

l To use #Current User or #CurrentDepartment, the Trigger Operator must be
Equals or Does Not Equal and the Trigger Field must be a valid user data type
of Project User, Project User Type Ahead, User, User by Role Type Ahead, User
Filtered By Entity, User Filtered By Entity Type Ahead, User Filtered By Role, or
User Type Ahead.

l For #CurrentDepartment, if either the logged in user's default department on
their user profile is not set or the default department on the user profile of the
selected user in the Trigger Field is not set, the rule will not trigger. The default
department must be present on both user profiles for this Trigger Value to
work.

Execution
Pipeline

This is typically set to Default but can be changed to include other pipelines in
addition to the default pipeline. The default pipeline indicates that the rule will be
applied when data entered in the system is saved. If, for example, you want a rule to
execute on data manually entered into the system and on data imported into the
system, you would select Default and Imports as pipelines for that business rule.

Select All Pipelines as the Execution Pipeline when you want to apply a "catch all"
to always trigger the rule. Only use this when it is truly applicable.

Example: If it is true that no matter how a new case is created, a case number should
always be generated, you can set the Execution Pipeline field to All Pipelines.

Selecting All Pipelines results in a warning message similar to the following
displaying. You must click Continue to acknowledge the warning and apply the
selection.

ClientSpace Setup & Administration © 2025 PrismHR 335

Chapter 5 Configuring Rules and Business Logic



Notes on Pipeline Linking:

l If you are using the Pipeline Linking table to manage Pipeline Behaviors and
you are configuring a new rule, pipelines assigned a behavior of Default will
auto-fill the Execution Pipeline field.

l If you are editing an existing rule, Execution Pipeline entries remain intact
until edited. Only then are entries are validated against any changes you may
have made to the Pipeline Linking table.
Example: A pipeline has been assigned a behavior of Allow or Default in the
Pipeline Linking table. You remove the pipeline from the Execution Pipeline
field of the business rule and later decide to add it back to the business rule
again. You can easily add it to business rule again because the new selection is
validated against the Pipeline Linking table and remains a valid selection.
However, if instead you had assigned the pipeline a behavior of Disallow in the
Pipeline Linking table, when you open a rule with that pipeline assigned, the
Execution Pipeline you disallowed will still be shown and will continue to work
until you delete that pipeline from the business rule record (i.e., remove it from
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the Execution Pipeline field on the business rule record). At this point, you
cannot add it to the business rule again as the new selection is validated
against the Pipeline Linking table and the former pipeline is no longer a valid
selection.

l Selecting All Pipelines in the Execution Pipeline field on the business rule
does not bypass the Pipeline Linking table. The functionality respects the
configuration of the Pipeline Linking table. If a pipeline is configured as
"Disallow" in the Pipeline Linking table, the business rule will not run.
See Configuring Pipeline Linking.

Execution
Order

This field controls the order in which rules will execute. Rules execute from the lowest
to the highest number. It may be necessary to look at other rules already configured
on this dataform to determine the order of precedence for executing rules.
Execution Order of Precedence: Within the Rules system, there is a distinct order of
precedence that occurs, that being HardError, SoftError, BizLogic. This means that
setting a field to a specific value automatically with BizLogic, then validating that field
with a Hard Error will never occur in the correct order, as the Hard Error will fire
before the BizLogic fills the field. This order of precedence happens irrespective of
the execution order placed on the configured rule, so Hard Errors will fire in
Execution Order least to greatest, then Soft Errors will fire in their order of execution,
then the Biz Logic will happen, again in the order of execution set on each rule.

Save
Action

Will this rule be applied on Insert of a new dataform, the Update of an existing
dataform, or on Both?

Workspace
Templates

Select the templates under which this rule will run.

System If selected, the system restricts access to only developer users for some of the rule
fields.

Tags This field indicates a tag that associates the rule with a ClientSpace feature (for
example, SIDES, Pricing, or Gradient).

Note: Global admin users can not edit the value in the Tags field if the System
check box is selected.

Method
Parameters

Method Parameters are dependent on the selected rule method for this rule. Hover
over the info bubble for more parameter information or submit an Extranet case with
your questions.
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Note: When setting TargetField and SourceField parameters, the datatypes must
either match exactly (EX: Text to Text) or be otherwise compatible (EX: Decimal to
Currency). Validation occurs at Save to check for an exact or compatible datatype
match. If a match is not found, a soft error message displays:  "The TargetField
'<TargetField Value>' on Dataform '<Dataform Name>' may not be compatible with
the SourceField '<SourceField Value>'. Do you wish to continue?"

The soft error allows you to continue with the Save but if you do not correct the
issue, errors may occur when the rule is triggered.

4. Click Save, Apply, or Save & New.
Save & New clones the selected dataform from the previous rule, making it easier to add multiple
rules to the same dataform.

To find the technical database names and the values stored in the database representing the
value on the dataform, use a combination of Ad-hoc Reports, the Dataform Specifications Report,
Lookup Admin, or Dataform Admin.

If you need further help with configuring custom rules in your system, please log a case in the Extranet.

Related Topics:

l Business Rule Methods
l Configuring Case Discussion business rules for replies
l Configuring rules to auto-complete tasks
l Configuring Create Discussion business rules
l Configuring rules to generate custom messages
l Reactivate Case business rule

Business Rule Methods
This topic provides a list of methods, a description of the method, and the accompanying parameters.

Dataform rules include Biz Logic, Hard Errors, and Soft Errors. These rules can trigger events, ensure
that data does not become corrupt (for example, no duplicate SSN and FEIN), and manage the
requirements of a workflow, along with any number of custom functions.

• Business Logic Rules compare fields, perform calculations, change values of fields, validate values,
and more.

ClientSpace Setup & Administration © 2025 PrismHR 338

Chapter 5 Configuring Rules and Business Logic



• Hard Errors (HE) are hard and fast requirements that must be met before the action can be
completed. These are most commonly used to require that data be entered before a certain step in
the process but without making it a hard requirement to save the current dataform.

• Soft Errors (SE) are used as reminders and warnings. These can be configured as custom and
complex warnings, or they can be simple warnings to remind someone to complete a specific field.

For details about adding a business rule, see Configuring Rules and Business Logic.

Clear Field rules
You can automatically clear a field based on a specific trigger condition.

Method Description Parameters

_ClearFieldValue Clears the value in a specific field on save. • sFieldName (field
to be set)

• sFieldValue (value
to be entered in
the field)

_ClearTabFieldValue Clears a field on the sTabTableName dataform on
save.

• sTabTableName
(Dataform Table of
Tabbed Dataform)

• sFieldName (field
to be set

Create Field rules

Method Description Parameters

_CreateCalendarEvent • FieldName
• Subject
• Invitees
• StartTime
• EndTime
• MeetingType

_CreateExportTransaction • ExportConfigGUID

_CreateExportTransactionAndData • ExportConfigGUID
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Method Description Parameters

_CreateExportTransactionAndDataByUser • ExportUser
• ExportConfigProc

Required Field rules
The Required Field business rules enable a dataform field to be completed under certain circumstances.

Method Description Parameters

_RequireFieldOnForm Allows you to make a core form field
required for data entry. Trigger fields are
optional. You can simply make the field
required by identifying the field name in
sFieldName or you can use the trigger
fields in conjunction with sFieldName to
make the field required when triggered.
Note:
l Since this is a core form and not a

dataform, you will need to open the
core form to get the field name
instead of going to Dataform Admin.

l sFieldName is case-sensitive. Type
the field name exactly as shown on
the form.

l As there is some setup required to
utilize this method, please contact
ClientSpace Professional Services for
first-time setup assistance.

sFieldName
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Method Description Parameters

_SE_RequireField
_HE_RequireField

Displays a hard error (_HE_RequireField)
or soft error (_SE_RequireField) on a
parent or child/tab dataform when you
attempt to save the form without entering
a value in the specified required field. If
you are configuring a hard error, you are
unable to continue the Save process
without providing a value. If you are
configuring a soft error, you can choose to
provide a value or you can continue the
Save process without providing a value.

Note: 

l These methods are only
configurable on the primary form of
a tab set but you can reference
triggering fields from tabbed forms.

l These methods replace the _
RequireFieldOnThisForm and _
RequireTabField business rule
methods. Beginning with
ClientSpace Release 147, while these
methods will no longer be available
to configure for new rules, existing
rules using these methods will
continue to trigger and be available
for editing.

• RequiredDataformName:
The Dataform where the
required field is located.
#ThisForm or the name of
the current dataform can be
used to indicate the same
form on which this rule is
configured. The name of
the tabbed dataform must
be used for tabbed
dataforms.

• RequiredFieldName: The
required field on dataform
or tabbed dataform
specified in the
RequiredDataformName
parameter.
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Method Description Parameters

_RequireAdHocField Checks for a value in a field that resides in
a node that is embedded in the dataform
XML packet.
For example, there could be an Org node
(on the PEO Client Master), and you want
to require the Source field. In that case, the
parameters would be:
• sFieldPath:  Org/crSource
• sFieldLabel: Source

• sFieldPath
• sFieldLabel 

Prevent duplicate records
By default, these rules validate other active dataforms of the same type within the same workspace. You
can configure the rules with an All Workspaces flag, which allows the rule to validate across all
workspaces with the dataform. Similarly, an Include Inactive flag allows the rule to include inactive
records both within a workspace and across workspaces.
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Method Description Parameters

_HE_PreventDuplicateRecords Hard Error that validates a unique
dataform record based on a
configured Field Name parameter
(such as ImportID). Default behavior
validates active dataforms within
the same workspace. The default
error message for this rule states,
"This form cannot be saved because
the value for '<fieldName>' is not
unique."

l FieldName (text): The
field which the rule will
validate for duplicate
records.

l AllWorkspaces
(checkbox): When
selected, the rule validates
the current record against
all dataforms of its type
across all workspaces,
overriding the default
same workspace behavior.

l IncludeInactiveRecords
(checkbox): When
selected, the rule
validation includes
Inactive records,
overriding the default
active only behavior.
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Method Description Parameters

_SE_PreventDuplicateRecords Soft Error that validates a unique
dataform record based on a
configured Field Name parameter
(such as ImportID). Default behavior
validates active dataforms within
the same workspace. The default
error message for this rule states,
"The value for <fieldName> is not
unique to the system, are you sure
you want to proceed?"

l FieldName (text): The
field which the rule will
validate for duplicate
records.

l AllWorskspaces
(checkbox): When
selected, the rule validates
the current record against
all dataforms of its type
across all workspaces,
overriding the default
same workspace behavior.

l IncludeInactiveRecords
(checkbox): When
selected, the rule
validation includes
Inactive records,
overriding the default
active only behavior.

Core rules
In addition to the standard required field rules, CORE rules allow for multiple trigger conditions when
requiring fields. Core rules add an additional Trigger field and Trigger value in the parameter area of
HE/SE_RequiredFieldEngine rule. Essentially this allows you to have multiple triggers for a required field
rule.
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Method Description Parameters

_AddRowSecurity Add Row
Security

When triggered, adds row level (i.e., record
level) security to the affected record for the
current user that triggered the rule, any
Global Administrator and an optional user,
such as the "Assigned To" user, specified in
the SecuredUser method parameter.

Note:
l SecuredUser can be blank if no

additional user is being specified.
l If SecuredUser is specified, field

validation ensures a correct user field
name is entered.

l Row level security overrides form level
security.

l Row level security respects field level
security and tab level security.

l When row level security is applied, a

Remove Row Level Security
icon displays in the Action Center of
the open record for Global Admins and
users with Admin rights to the current
Table Name.

_AddUserToWorkspace Add User When triggered, adds a user from a specified
form and field to the workspace user list. The
source form can be any single dataform in a
workspace. The source field can be any user
field on the trigger form.

SourceForm: #ThisForm
SourceField: FkUserID
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Method Description Parameters

_CalculateTimeDifference Calculate Value
and Set Value

When triggered, calculates the time
difference between two DateTime datatype
fields in Seconds (S), Minutes (MM), Hours
(H), Days (D), Weeks (W), or Months (M)
between and writes the value as a whole
number to a specified TargetField.
Set the following method parameters as
applicable:
l SourceForm1: Specify the form where

the first field in the difference equation
is found. Only allows #ThisForm or
Single dataforms.

l SourceField1: Specify the first field in
the difference equation. Only
DateTime datatype fields are valid.

l SourceForm2: Specify the form where
the second field in the equation is
found. Only allows #ThisForm or Single
dataforms.

l SourceField2: Specify the second field
in the difference equation. Only
DateTime datatype fields are valid.

l TargetForm: Specify the form where
the results of the equation will be set.
Only allows #ThisForm or Single
dataforms.

l TargetField: Specify the field where
the results of the equation will be set.
Only allows Text, Integer, or Decimal
datatypes.

l TimeUnit: Specify the unit of
measurement for the time difference
calculation results: S = Seconds, MM =
Minutes, H = Hours, D = Days, W =
Weeks, and M = Months.

Note: When selecting a time unit, keep
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Method Description Parameters

in mind that ClientSpace writes the
calculated time difference as a whole
number. For example, if you select a
time unit of Months (M) and there is a
time difference of two weeks between
the two DateTime datatype fields you
identified, the TargetField will show 0
as no partial months are being written
to the TargetField.

l UseBusinessHours: Select this option
to base time difference calculations on
business hours and work week settings
specified in your ClientSpace install
settings. The fields used to determine
business hours are Business Open,
Business Close, Business Week
Begin Day and Business Week End
Day. If you require help with these
settings, please log a case with your
Professional Services representative.

l When calculating across holidays,
ClientSpace is using the holidays
entered in the Company Holiday table
(   (System Admin > Advanced >
Company Holiday) to determine the
holiday hours that should be excluded
from time difference calculations.
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Method Description Parameters

HE_ExistingWorkspace Hard Error When triggered, if there is a workspace
associated with the triggering organization,
the following hard error displays: "This
organization already has a Workspace
associated with <WorkspaceName>. Please
contact your system admin if you believe this
is in error."

Note: Site must be configured to use rules
on the organization. Please contact
ClientSpace Professional Services if you want
to activate this rule.

HE_RequireRateGroup Hard Error When triggered, validates Offered Benefit
Plan (OBP) Rate Group(s) as follows on Add
and Edit of an OBP:
l If the plan has no associated Rate

Groups and the OBP Rate Group field
is blank, the rule does not trigger.

l If the plan has rate groups but they are
all Inactive, the rule does not trigger.

l If the plan has one or more associated
Active Rate Groups and the OBP Rate
Group is blank, the rule triggers and
the hard error message displays: "This
Offered Benefit Plan must have a Rate
Group selected."
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Method Description Parameters

_SE_RequireFieldOnFormOnTrigger
_HE_RequireFieldOnFormOnTrigger

Soft Error
Hard Error

• TriggerTable: must be gen_x or
#ThisForm. 
• #ThisForm uses live data from the

current form PRIOR to the save. 
• gen_x evaluates the TriggerField

value in the database to determine if
TriggerField = TriggerValue

• TriggerField: must be a valid field on
Trigger Table.

• TriggerValue: must be a value or
#IsEmpty.

• RequiredTable: must be gen_x or
#ThisForm. 
• #ThisForm uses live data from the

current form PRIOR to the save.
• gen_x evaluate the RequiredField

value in the database to determine if
RequiredField is populated.

• RequiredField: must be a valid field on
RequiredTable.
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_HE_DateBetween Hard Error This method calculates the time in days
between two dates and determines whether
the value is greater than or less than a limit
(in days) that you set. This method is
typically used to trigger a hard error when a
date entered on a SIDES questionnaire does
not fit the required SIDES parameters but
could be repurposed for other scenarios
where this type of comparison is required.

Method Parameters:
l SourceField: Specify the first date in

the calculation. Only Date datatype
fields are valid.

l TargetField: Specify the second date
in the calculation. Only Date datatype
fields are valid.
Note: CurrentDate can also be used
as the TargetField to calculate the
days between the SourceField and the
current date.

l Operator: Type the operator (without
spaces) as GreaterThan or LessThan.
No other operators are permitted.

l DaysLimit:The maximum or minimum
(depending on the Operator used) of
days between the SourceField and
TargetField. If the calculated number
of days does not fall within the limit,
the hard error is triggered.
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_HE_DateComparison Hard Error This method compares two dates to
determine if the first date is greater than or
less than the second date. This method is
typically used to trigger a hard error when a
date entered on a SIDES questionnaire does
not fit the required SIDES parameters but
could be repurposed for other scenarios
where this type of comparison is required.

Method Parameters:
l SourceField: Specify the first date in

the comparison. Only Date datatype
fields are valid.

l TargetField: Specify the second date
in the comparison. Only Date Cloning
or Clonedatatype fields are valid.
Note: CurrentDate can also be used
as the TargetField to compare the
SourceField to the current date.

l Operator: Type the operator (without
spaces) as GreaterThan or LessThan.
No other operators are permitted.

l IncludeDay: If checked, the Source
Field and Target Field date can be the
same day and cause the hard error to
trigger. If unchecked, the Source Field
and Target Field must be greater than
or less than the other to trigger the
error.

_HE_RequireFileDescription Hard Error Requires a document uploaded to a field
that has a description before saving

_HE_RequireFileCategory Hard Error Requires a document uploaded to a field
that has a category before saving
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_HE_LimitFileUploadTypes Hard Error Limits the file types that can be saved into a
field.

_HE_ValidateMinMax Hard Error Validates the minimum and maximum values
for specific datatypes that support Integer,
Number, Decimal, and Money. If the
imported amount exceeds the minimum or
maximum values, the import fails and
records each failed issue. When all the values
in the field meet the acceptable range, the
dataform is updated.
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_HE_ValidateIncidents Hard Error This method checks for open tasks
associated with a case when a user changes
the status of the case to Complete and the
user attempts to save the case.

If the case includes any incomplete tasks that
are not marked Private, the system displays
the following message:

The following error(s) were found in your
submission:

l There are associated tasks that are not
complete. You must complete these
tasks before resolving the case.

If the case includes any incomplete tasks that
are marked Private, the system displays the
following message:

The following error(s) were found in your
submission:

l There are associated tasks that are not
complete that may be Private. The
users assigned to these tasks must
complete them before resolving the
case.

If the case includes any incomplete tasks that
are marked Private AND the user is a Global
Administrator, the system appends the
following additional information to the end
of message above: 

If private, please contact the following users

- (<FirstName> <LastName>)

Set Field rules
Sometimes you want to automatically set a field value based on a set of triggering parameters; for this
reason, the _SetField rules were created.

The _SetField rules provide several non-specific trigger values:
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• #IsEmpty: fires the rule if the trigger field on the Triggering Form has no value
• #IsNotEmpty: fires the rule if the trigger field on the Triggering Form has some value - anything but

empty
• #IsDirty: fires the rule if the trigger field on the Triggering Form has any value other than empty and

has been changed prior to save
These options and descriptions are in the contextual help (click the field label). The Trigger Values of
this help are selectable links that fill the trigger field automatically.

Method Description Parameters

_SetDateFieldValue Sets a Date field on the
TableName dataform.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field accepts
datetime shortcuts
(t,d,w,m,y, mm, h),
such as, t (current
time),1w (+1 week),
1h (+ 1 hour), 30mm
(+ 30 minutes), -1d (-
1 day), etc.

_SetDateFieldValueFromSourceField Sets the Date field from a field
on another dataform.

• TargetField: Field on
form to be set.

• SourceField: Field on
SourceForm to be
inserted.

• SourceForm:
Dataform providing
inserted value.

• OffsetInterval
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_SetDateTimeFieldValue Sets a Date Time field on the
TableName dataform.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field accepts
datetime shortcuts
(t,d,w,m,y, mm, h),
such as, t (current
time),1w (+1 week),
1h (+ 1 hour), 30mm
(+ 30 minutes), -1d (-
1 day), etc. and
specified date times,
if desired. (Must be in
Military or Zulu time.)

_SetDateTimeFieldValueFromSourceField Sets the Date Time field from a
field on another dataform.

• TargetField: Field on
form to be set.

• SourceField: Field on
SourceForm to be
retrieved and
inserted into the
TargetField.

• SourceForm:
Dataform providing
inserted value.

• OffsetInterval: May
be used standalone
or combined with
datetime shortcuts
(t,d,w,m,y, mm, h). If
no offset is
necessary, field can
be left blank.
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_SetFieldFromKey The Field Name of the field (on
the Dataform Name dataform)
into which the Record ID is
inserted if the field is empty.
Sets a Text or Integer field to
that form's ID. If the field is
already filled out, it does not
replace the value. 

• TargetField: The
TargetField must be
either a Text or
Integer Input
datatype. Can be
used on new or
existing records.

_SetFieldFromLookupMetadata Sets a dataform field value on
the triggering dataform from a
field value on an associated
metadata dataform when a
lookup is selected that contains
metadata. The source and
target data types must be the
compatible. Metadata field to
Target field validation prevents
you from specifying
mismatched data types.
Note: If there is no metadata
available when the rule is
triggered, the rule is skipped.

• SourceLookup:
Lookup field on the
source form.

• MetadataField:
Metadata field
associated with
SourceLookup.

• TargetField: Lookup
field to be set.
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_SetFieldFromForm*** Sets a field on the TableName
dataform from a field on
another dataform.
Sets a field on the current single
dataform from a field on a
different single dataform. Must
be in the same workspace. The
data types must match. 

For configuration purposes,
TableName is the current
(target) dataform. This is to be
configured for single dataforms
only. Leaving the TriggerField
and TriggerValue blank when
configuring this rule sets the
value on save of trigger
dataform. If improperly
configured using multi-forms,
the data is set from the most
recently created form, even if it
is inactivated.

***Can only be used on gen_
dataforms that are not
Multiforms.

• TargetField: Field on
form to be set.

• SourceField: Field on
SourceForm to be
inserted.

• SourceForm:
Dataform providing
inserted value.

• AllowEmptyValue:
Clears the target field
if SourceField is
empty. When
unchecked,
the target field
remains unchanged.
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_SetFieldFromRelatedForm Sets a field on the child
dataform from a field on a
dataform that is defined as the
related parent dataform
regardless of workspace.
Sets a field on the current:

l Single dataform from a
field on a different single
dataform
Or

l Single dataform from a
field on a different
multiform
Or

l Multiform from a field on
a different multiform

Note: 

l Both fields can be in the
same workspace OR in
different workspaces. If
the fields are in different
workspaces, a parent form
field must connect the
two forms.

l Data types must match. 
l If the child field

referenced by the rule is
empty, the system will
take no action.

• TargetField: The
Field Name of the
field (on the
'Dataform Name'
dataform) into which
the system will insert
the SourceField
value.

• SourceField: The
field on the
SourceForm from
which the system will
retrieve data and
insert it into the
TargetField.

• SourceForm: The
Dataform from which
the data will be
retrieved. Tip:
'#ThisForm' can be
used to indicate the
same form on which
this rule is configured

• AllowEmptyValue: If
checked, allows the
TargetField to be
cleared if the
Sourcefield value is
empty. If unchecked
and the Sourcefield
value is empty, the
system will not
update the value in
the TargetField.

• RelatedParentField:

ClientSpace Setup & Administration © 2025 PrismHR 358

Chapter 5 Configuring Rules and Business Logic



Method Description Parameters

The field on the
Table Name that is
the relationship to
the SourceForm from
which data will be
retrieved and
inserted into the
TargetField.

ClientSpace Setup & Administration © 2025 PrismHR 359

Chapter 5 Configuring Rules and Business Logic



Method Description Parameters

_SetFieldOnFormFromFormTabs Takes a value from a field on a
dataform or tab dataform and
sets it on another dataform or
tab dataform. The new method
supports the following
configurations:

l Singleform to singleform
l Multiform to singleform
l Multiform to multiform if

both dataforms are within
the same tab set

l Tab field to Tab field if
both fields are within the
same tab set

Note:

l _SetFieldFromTabOnTab
is only configurable on
the primary form of a tab
set but the triggering
fields can come from
tabbed forms.

l Target Field and
SourceField datatypes
must be compatible. See
Field Datatype Validation
- Compatible Datatypes.

l TargetForm: The
dataform
containing the
TargetField. The
dataform to which
data will be copied.
This can be the
Primary form, a
singleform or any
tab form within the
tab set.
'#ThisForm' can be
used to indicate
the same form on
which this rule is
configured.

l TargetField: The
field where the
data will be
inserted.

l SourceForm: The
dataform
containing the
SourceField. The
dataform from
which data will be
copied.

l SourceField: The
field on the
SourceForm from
which the system
will retrieve the
data being inserted
into the
TargetField.
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Method Description Parameters

_SetFieldOnRelatedForm Sets a field on the parent
dataform from a field on a
dataform that is defined as the
related child dataform.
Sets a field on the current:

l Single dataform from a
field on a different single
dataform
Or

l Single dataform from a
field on a multiform
Or

l Multiform from a field on
a different multiform

Note: 

l Both fields must be in the
same workspace and the
data types must match. 

l If the child field
referenced by the rule is
empty, the system will
take no action.

• TargetField: The
Field Name of the
field (on the
'Dataform Name'
dataform) into which
the system will insert
the SourceField value

• SourceField: The
field on the
SourceForm from
which the system will
retrieve data and
insert it into the
TargetField.

• SourceForm: The
Dataform from which
the data will be
retrieved. Tip:
'#ThisForm' can be
used to indicate the
same form on which
this rule is configured

• AllowEmptyValue: If
checked, allows the
TargetField to be
cleared if the
Sourcefield value is
empty. If unchecked
and the Sourcefield
value is empty, the
system will not
update the value in
the TargetField.

•
RelatedParentField

ClientSpace Setup & Administration © 2025 PrismHR 361

Chapter 5 Configuring Rules and Business Logic



Method Description Parameters

: The field on the
Table Name that is
the relationship to
the SourceForm from
which data will be
retrieved and
inserted into the
TargetField
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_SetFieldOnFormFromForm*** Sets a field on another dataform
( gen_DataformName) from a
field on the current dataform
(#ThisForm) or from another
dataform (gen_
DataFormName).
Sets a field on a single dataform
from a different single dataform
in the same workspace. This is
triggered by a third, completely
different single dataform in the
same workspace.
The source and target data
types must be the same. This is
to be configured for single
dataforms only. Leaving the
TriggerField and TriggerValue
blank when configuring this rule
sets the value on save of trigger
dataform. If improperly
configured, when the source
dataform is a multi-form, the
data is set from the most recent
source multiform, even if it is
inactive. If the target dataform
is a multiform, the data is set on
the most recent multiform, even
if it is inactive. 
When a rule uses this method
and the system executes that
rule, the system can copy up to
500 characters from the source
field on the source dataform to
the target field on the target
dataform.
***Can only be used on gen_

• TargetField: Field on
the form to be set.

• SourceField: Field on
SourceForm to be
inserted.

• TargetForm: The
dataform to which
the data will be
copied.

• SourceForm:
Dataform providing
inserted value.
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dataforms that are not
Multiforms.

_SetFieldValue Sets a field on the TableName
dataform on save.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field.

_SetFieldValueFromPattern This rule has the ability to
extract the first instance of a
value from within a text field
using a valid .Net RegEx pattern
and set the value of another
text field on the same page to
this extracted value. Some .Net
regex patterns found online
begin with the ^ character,
which must be removed when
configuring this rule.
This business rule operates
based on the following:
The SourceField value is always
be treated as textTargetField
must be a Text data
typeTargetField is ALWAYS
overwritten with the results of
the pattern matchSourceField
and TargetField must be on the
current dataform and cannot be
used on tabbed forms. If the
pattern match returns no value,
the TargetField is cleared.

• TargetField: Text
datatype

• SourceField: text
• Pattern
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SetImportID Sets the ImportID on the State
Master form equal to the State
field on the same form. The
ImportID will be refreshed if the
State is updated.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field.

_SetTabDateFieldValue Sets a Date field on the
sTabTableName dataform (i.e.,
Tab dataform associated with
the triggering dataform)

• sTabTableName :
Dataform Table of
Tabbed Dataform.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field accepts
datetime shortcuts
(t,d,w,m,y, mm, h),
such as, t (current
time),1w (+1 week),
1h (+ 1 hour), 30mm
(+ 30 minutes), -1d (-
1 day), etc. and
specified date times
if desired. (Must be in
Military or Zulu time.)
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_SetTabDateTimeFieldValue Sets a DateTime field on the
TabTableName dataform (i.e.,
Tab dataform associated with
the triggering dataform).

• sTabTableName :
Dataform Table of
Tabbed Dataform.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field accepts
datetime shortcuts
(t,d,w,m,y, mm, h),
such as, t (current
time),1w (+1 week),
1h (+ 1 hour), 30mm
(+ 30 minutes), -1d (-
1 day), etc.

_SetTabFieldValue Sets a field on the
sTabTableName dataform on
save.

• sTabTableName:
Dataform Table of
Tabbed Dataform.

• sFieldName: Field to
be set.

• sFieldValue: Value to
be entered in the
field.

ClientSpace Setup & Administration © 2025 PrismHR 366

Chapter 5 Configuring Rules and Business Logic



Method Description Parameters

_SetTabUserField Sets a user field on the
dataform tab that is a from a
user field on the parent
dataform of the tab. This only
works from the Parent form to
the Child form.

• TabTableName:
Dataform Table of
Tabbed Dataform.

• TargetField: Field to
be set.

• SourceField
• Use #CurrentUser

to set the target
user field to the
current logged in
user. 

• Use #LoginID
(with LoginID
replaced by a
specific user
login ID) to
automatically set
the target user
field to a specific
user.)
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_SetUserField Sets a user field on the same
dataform.  

• TargetField: Type
the field for a user to
be inserted into.
• If a non-user field

is selected as the
TargetField, such
as a text field, the
UserID will be set
in the
TargetField.

• SourceField: Type
the field on the
SourceForm from
which data will be
retrieved and
inserted into the
TargetField.
• Does not accept

user fields on
other forms.

• Additionally, use
#CurrentUser to
set the target
user field to the
current logged in
user.

• Additionally use
#LoginID (with
LoginID replaced
by a specific user
login ID) to
automatically set
the target user
field to a specific
user. This sets the
target field to the

ClientSpace Setup & Administration © 2025 PrismHR 368

Chapter 5 Configuring Rules and Business Logic



Method Description Parameters

specified user
(i.e., #bob_smith.)

• Leaving the
TriggerField and
TriggerValue
blank when
configuring this
rule sets the
value on save of
trigger dataform.

SetDueDateFromCaseTypeOffset Sets the Client Service Case Due
Date based on the Due Date
Offset and Due Date Offset
Method configured on the
Client Service Case Type record
in the Admin Workspace.

The default Due Date Offset
Method is Calendar Days. This
optionincludes non-business
days and company holidays in
the Due Date Offset
calculation.

Select Business Days to
calculate the Due Date Offset
using business days. This
method excludes non-business
days and company holidays
from the Due Date Offset
calculation.

No method parameters
are required. This
method uses the Due
Date Offset and Due
Date Offset Method
settings located on the
Client Service Case Type
record. See Configuring
Case Types.
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SetFieldFromSalesEntity Sets a field on a form from a
field on a Sales Entity dataform
(System Admin >
Administrative Data > Sales
Entity) when the Client Master
dataform is saved.
Example:Update the Contract
Effective Date on the Client
Master with the Effective Date
on the Sales Entity record.

The Sales Entity form used to
update the TargetField is
identified by matching the
assigned user in the Sales Rep
field and Contract Type on the
Client Master with the sales
entity record. If there is more
than one Sales Entity form
associated with the assigned
user and matching Contract
Type, the Sales Entity form with
the Is Primary flag checked is
used.

Note: This business rule
method should only be used on
a single form in the same
workspace.

l SalesEntityField:
 Field name on the
Sales Entity form
used to update the
TargetField on the
TargetForm.
Note: The field will
allow non system
fields (i.e., fields
beginning with z_).

l TargetForm:
 Dataform to which
the data will be
copied. Must be a
single form in the
same workspace.
Note: #ThisForm
can be used when
TargetForm is
Client Master.

l TargetField: Field
on the
TargetForm to be
set. Must match
the datatype of the
SalesEntityField
field.
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SetPayrollFrequency Sets the Payroll Frequency field
on a Pay Group. The
SetPayrollFrequency method
uses the difference between the
Period Start and Period End
date fields on the Pay Group to
determine the pay frequency.
The following list illustrates how
the system determines the pay
frequency:

l If the difference between
the start and end dates
equals seven, the system
sets the pay frequency to
Weekly.

l If the difference between
the start and end dates
equals 14, the system sets
the pay frequency to Bi-
Weekly.

l If the difference between
the start and end dates
equals 13,15, or 16, the
system sets the pay
frequency to Semi-
Monthly.

l If the difference between
the start and end dates is
greater than 27, the
system sets the pay
frequency to Monthly.

l If the difference between
the start and end dates is
anything else, the system
sets the pay frequency to
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Other.

SetStaffingEmployeeRelatedFields Sets the Location, Comp Code,
and Jurisdiction State from the
selected Staffing Placement
when the Staffing Placement
field on the Comp Claim
Claimant dataform is edited.
The field state must be "IsDirty"
and "NotEmpty".

Stage Field rules
StageField rules allow you to prepare a field value to be saved to a target form and apply the change
later in the save process based on a set of triggering parameters.

The _StageField rules provide several non-specific trigger values:
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_StageChangesOnFormFromForm Prepares a field value on the source
dataform ( gen_DataformName or
#ThisForm) to be saved to a specified
field of the same datatype on the
target dataform (gen_
DataFormName). The rule stages the
field on a single dataform from a
different single dataform in the same
workspace. The rule is triggered by a
third, completely different single
dataform in the same workspace.

Note: 
l The rule can be used on single

dataforms only, not multiforms.
l The source and target datatypes

must be the same.
l The system can copy up to 500

characters from the source field
on the source dataform to the
target field on the target
dataform.

l If the rule is triggered and not
followed up at any point by a _
SaveStagedChanges rule, the
triggered change will not occur
on the target form.

• TargetField: The
field name of the
field on the target
dataform into which
the system will insert
the SourceField
value.

• TargetForm: The
dataform to which
the data will be
copied.

• SourceField: The
name of the field on
the source dataform
from which the
system will retrieve
data and insert it into
the TargetField.

• SourceForm: The
dataform from which
the data will be
retrieved. #ThisForm'
can be used to
indicate the same
form on which this
rule is configured.

• AllowBlankValues:
When this parameter
is set and the rule is
triggered, the
TargetField on the
TargetForm is
cleared if the
SourceField on the
SourceForm has no
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value.

_SaveStagedChanges Works in conjunction with _
StageChangesOnFormFromForm.
Saves any staged changes from a
source form to an associated target
form while following the specified
pipelines that have been triggered
prior to the triggering of this method.

Note: 
l The rule will validate the

existence of the TargetForm and
that it is not a multiform.

l Hard and soft errors will be
ignored when saving the target
form.

l The rule can trigger business
logic, email templates and
workflow channels.

TargetForm: The
dataform to which the
data will be copied.

Pipeline: The pipeline
the rule should follow
once triggered.
(Validates against the
Pipeline Code from the
Pipeline Linking table.)

Generating Merge File Rule
To assist in generating the merge files to prepare to send to DocuSign, the _GenerateMergeFile
business rule can be configured to run the merge document and deposit the file in a field. This business
rule can be configured multiple times to generate each file needed. After the business rules are run, you
can review the documents in their individual file fields before you click the workflow link to send the
files to DocuSign for signatures.
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_GenerateMergeFile When you create the
rule, use the method _
GenerateMergeFile.

l MergeGUID: The 8 or 36 character
Merge GUID (from the Merge
form).

l TargetForm: Enter the table name
for a single form dataform in the
current workspace on which the
system will store the merge output.
Tip: You can enter "#ThisForm" to
indicate the same form on which
this rule is configured (this can be a
multi-form).

l TargetField: Enter a field name for
a field on the TargetForm to
indicate the field to which the
system will store the merge output.
Tip: You can enter "#Attachment",
to attach the merge output to the
TargetForm (this will not version
the attachment).

l FilePrefix: Enter a value to add as a
prefix to the merge output (for
example, the system uses the
format 'FilePrefix-
YYYYMMDDHHMMSS.ext').

Note: Enter only valid file name
characters or an error may occur

l SaveRecord: If the checkbox is
checked then the triggering
dataform record will be saved
before generating the merge.

Change Workspace Template Rule
You can create a rule that will allow you to change the workspace template. When triggered, the current
workspace will be set to the template specified on the rule.

ClientSpace Setup & Administration © 2025 PrismHR 375

Chapter 5 Configuring Rules and Business Logic



Method Description Parameters

SetWorkspaceTemplate When you create the rule, use the
method SetWorkspaceTemplate.
Changing the workspace template
will rebuild the workspace, inheriting
the user and dataform values
configured on the new template.

l TemplateCode: The
workspace template
code of the template
workspace that the rule
will use for the current
workspace.

Complete All Non-Archived Tasks Rule
You can create a rule that will close all associated tasks on a dataform regardless of the origin of the
task so that you do not have to close tasks manually.

Method Description

_TaskAutoCompleteAll When you create the rule, use the method _TaskAutoCompleteAll.
This method completes all non-archived tasks that are associated
with a dataform except for tasks that define a recurring rule.

Create Incident Rule
You can create a rule that will import historical incident/task data from another application into a
ClientSpace task within the correct Workspace.
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CreateIncident When you create the rule, use the method CreateIncident.
The CreateIncident method uses the Import_Incidents dataform to
temporarily store incident information until the task information is
extracted from it.
Once a rule is triggered using the CreateIncident method, an
Import_Incident file is uploaded through Import Management. The
file is processed, and each row is read and stored in the Import_
Incident dataform until the task is generated. Then, the dataform is
deleted. Any errors encountered during file processing are stored in
the Log File (without any disruption to Import_Incident file
processing). Finally, the imported task information is imported into
new ClientSpace task records within the correct Workspaces.

Configure the rule using the following settings:

Note: Not all General settings are listed. These are the settings
necessary for the rule to work.

l Table Name: Import_Incident
l Rule Title: Create Incident/Task
l Description: Used to create and update tasks (also known as

incidents) imported from another application.
l Method:CreateIncident
l Primary Source: Import_incident
l Primary Trigger Field: HdrAction
l Primary Trigger Operator: Equals
l Primary Trigger Value: Convert
l Execution Pipeline: Default
l Execution Order: 10 is the default setting. Controls the order

in which rules execute. Hard errors, soft errors and business
logic execute first. Other rules execute from lowest to highest
Execution Order. It may be necessary to review other rules
configured on the dataform specified in the Table Name to
determine the proper execution order.

l Save Action: Both
l Workspace Templates:  All Templates
l Save Action: Both
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Method Parameters Field Definitions:

No Method Parameters are required.

Add Subscribers by Role Rule
You can create a rule that will add subscribers based on their role on the client team instead of adding
subscribers as specific users to each client service case.

Method Description Parameters

_AddSubscriber When you create the rule, use the
method _AddSubscriber. This
method adds a subscriber to a
case by using a user field from an
active, single dataform (for
example, the client master).

l SourceForm: The
Dataform from which the
data will be retrieved.
'#ThisForm' can be used
to indicate the same form
on which this rule is
configured.

l SourceField: The user
field on the SourceForm
that will be used to add a
subscriber.

Mark Rehire Rule
You can create a rule that sets the Rehire checkbox on the Employment dataform to checked when the
employee’s Employment Status is updated from Terminated to Active so that you do not have to
remember to click the Rehire checkbox manually.

Method Description

MarkRehire When a rule is triggered using the MarkRehiremethod, it sets the Rehire
checkbox on the Employment dataform to checked when Employment
Status is updated from Terminated to Active and the Last Hire Date is
different from the Original Hire Date.
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Inactivate Deleted Employee Rule
You can create a rule that sets the Employment Status field in the ClientSpace Employment record to
"Deleted" and then deactivates the Employment record. The rule is triggered when a deleted employee
record is imported by the PrismHR User Import API.

Method Description

InactivateDeletedEmployee The rule is triggered when a deleted employee is imported by the
initial or ongoing PrismHR User Import API. The rule sets the
Employment Status field on the Employment record to "Deleted",
then deactivates the Employment record and related employee
record by removing the check marks from the Active checkboxes on
those forms. When you create the rule, use the following settings:

l Table Name: Employment
l Rule Title: Inactivate Deleted Employee
l Description: Rule triggers when an employee is deleted in the

connected PrismHR install. When the import queue record is
processed, the Employment Status will be set to "Deleted" and
the Employment and related Employee record will be
deactivated.

l Method: InactivateDeletedEmployee
l Primary Trigger Field: Employment Status
l Primary Trigger Operator: Is Dirty
l Secondary Trigger Field: Employment Status
l Secondary Trigger Operator: Equals
l Secondary Trigger Value: D
l Execution Pipeline: Imports, Initial Import
l Save Action: Both
l System: Checked

Inactivate Child Forms Rule
When an imported PrismHR batch is in "Deleted" status, the Inactivate Child Forms rule deactivates the
Payroll Batch as well as the associated Pay Groups and Billing Vouchers. The rule is triggered when a
deleted Payroll Batch is imported by the PrismHR Payroll Batch Import API.
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InactivateChildForms The rule is triggered when a deleted Payroll Batch is imported by the
PrismHR Payroll Batch Import API. The rule sets the Batch Status
field on the Payroll Batch form to "Deleted", deactivates the Payroll
Batch and deactivates associated Pay Groups and Billing Vouchers
by removing the check marks from the Active checkboxes on these
forms.

Note: The rule needs to be configured on the same pipeline as the
HRPAPI_payroll_batch*.csv import configuration so that it triggers
when Payroll batches are imported.
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Field Calculation Rule
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Method Description

_FieldCalculation The _FieldCalculation method allows you to calculate a field value
using numeric field values on a dataform and then set the resulting
calculation in a numeric field on the same dataform. The rule
triggers when the dataform is saved. Configure the rule using the
following settings:
l Table Name: The dataform containing the numeric fields you

want to use in a mathematical expression.
l Method: Select _FieldCalculation.
l Expression: The expression is the mathematical equation. It

can consist of:
o The numeric field names from the identified dataform

(from which ClientSpace will retrieve the values used in
the calculation.)

o Manually typed numeric values.
o Permitted mathematical symbols listed in the Note

section below.
l TargetField: Field on the same dataform identified in Table

Name that will hold the resulting calculation.

Note:
l The Expression field has a 500 character limit.
l Only the following symbols may be used to build an

expression: +, -, *, /, or ( ).
l The field calculation rules follow the appropriate order of

operations when performing calculations. For example, in the
following expression, the field values in parentheses are
divided before the multiplication step occurs:
(Field1/Field2) * (Field3/Field4) + 100

l An expression can be entered with or without spaces around
the symbols. For instance, both expressions below are valid:
(Field1/Field2) * (Field3/Field4)
(Field1 / Field2)*(Field3 / Field4)

l Field validation is used to ensure that the fields used in the
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expression and target field are numeric. The field names
cannot be misspelled and the fields must be an Integer,
Decimal, Money or Percent element type. Field validation
errors are presented on the page in an error message.

l The identified target field should match the desired format of
the resulting calculation. For instance, if an expression is
configured which could result in a decimal value or percentage
being returned but the target field is an Integer element type
instead of a Decimal, Money or Percentage element type, the
decimal places will be truncated in the target field as only
whole numbers display in Integer fields.

l Using a field in the expression with a blank or null field value
results in that field value being treated as a zero.

l Divide by zero errors will cause a calculation to be ignored and
skipped. Divide by zero errors are presented on the page in an
error message and logged in the Exception Log.
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Benefits Batch and OBP Renew Rule
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Method Description

Renew The Renew business rule method clones the Benefits Batch, the
Offered Benefits Plans associated with the original batch in
"Selected" Status and any new Offered Benefit Plans associated with
the original batch. This method also clones all of the enrollment
count values (including any null or blank values) from the original
batch and updates all of the cloned Offered Benefit Plans with the
same Effective Date as the newly renewed Benefits Batch.

Configure the following settings.

General Settings Field Definitions:
Note: Not all General settings are listed. These are the settings
necessary for the rule to work.

l Table Name: Select Benefits Batch. This is the dataform
where the rule will be executed.

l Method: Select Renew.
l Rule Title: Enter a brief description of what the rule

does. Renew is the default description entered for this pre-
configured rule.

l Description: A default description detailing what the rule
does is provided.

l Primary Source: Select Benefits Batch. This the dataform
where the Primary Trigger Field is located.

l Primary Trigger Field: Select HdrAction.
l Primary Trigger Operator: Select Equals.
l Primary Trigger Value: Enter Renew. This is the value to be

met for the Primary Trigger comparison.
l Execution Pipeline: Default
l Execution Order: Controls the order in which rules execute.

Hard errors, soft errors and business logic execute first. Other
rules execute from lowest to highest Execution Order. It may
be necessary to review other rules configured on the dataform
specified in the Table Name to determine the proper
execution order.

l Save Action: Both
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Method Parameters Field Definitions:

No Method Parameters are required.

Benefits Batch OBP Sync Rule

Method Description

BBIsActiveOBPSync The BBIsActiveOBPSync business rule method inactivates or
activates the associated Offered Benefit Plan (OBP) records, setting
them to match the state (checked or unchecked) of the Active
checkbox on the parent Benefits Batch.
l Table Name: Benefits Batch
l Method: Select BBIsActiveOBPSync.
l Execution Pipeline: Default, Imports
l Save Action: Both

No additional General Settings or Method Parameters are required.

Note:
l The Status field value on the OBPs is not affected when the

business rule is triggered.
l Using the Mass Update OBPs process to set OBPs to Cancel

status still works to inactivate OBPs. The business rule offers an
alternative way of activating/inactivating OBPs without
affecting the Status.
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Increment Integer Rule
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Method Description

_IncrementIntegerFieldOnForm The _IncrementIntegerFieldOnForm business rule method allows
you to increment an integer field value on the same form
(#ThisForm ), the gen_tablename of the triggering form, or a
different form when a specified trigger action occurs.

Example: Add a field to the Client Master named Indemnity
WC Claims to track the number of indemnity worker's comp claims
for a workspace. Set up the _IncrementIntegerFieldOnForm
business rule to increase the the Indemnity WC Claims field by 1
when a WC Claim is saved with a Claim Type of Indemnity.

For the above scenario, set up a business rule using the _
IncrementIntegerFieldOnForm business rule method as follows: 
Primary Source = Comp Claim, Primary Trigger Field = Claim
Type, Primary Trigger Operator = Equals, Primary Trigger Value
= Indemnity, TargetField = IndemnityWCClaims, TargetForm
= gen_ClientMaster and IncrementAmount = 1.

Note: This rule can be configured on multiple forms to update the
same form and field.

General Settings Field Definitions:
Note: Not all General settings are listed. These are the settings
necessary for the rule to work.

l Table Name: Select the dataform where the rule will be
executed.

l Method: Select _IncrementIntegerFieldOnFomr.
l Rule Title: Enter a brief description of what the rule does. 
l Description: Enter a more detailed description of what the

rule does.
l Primary Source: Select the dataform where the Primary

Trigger Field is located.
l Primary Trigger Field: Select the field or HdrAction to

evaluate for the triggering condition.
l Primary Trigger Operator: Select the operator to use for the

ClientSpace Setup & Administration © 2025 PrismHR 388

Chapter 5 Configuring Rules and Business Logic



Method Description

Primary Trigger comparison. Example: Equals.
l Primary Trigger Value: If applicable, type the value to be met

for the Primary Trigger comparison.
l Execution Pipeline: Default, PowerAutomate, ScheduledWFC
l Execution Order: Controls the order in which rules execute.

Hard errors, soft errors and business logic execute first. Other
rules execute from lowest to highest Execution Order. It may
be necessary to review other rules configured on the dataform
specified in the Table Name to determine the proper
execution order.

l Save Action: Both

Method Parameters Field Definitions:
l TargetField: Enter the field name integer field being

incremented.
l TargetForm:  Enter the form name of the dataform where the

TargetField is located or use the #ThisForm code value to use
the form listed in Table Name.

l IncrementAmount: Enter the amount by which you want the
TargetField to increase when this rule is triggered. For
example, if you want the field to increase by 1, enter 1.
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Modify Field Value Rule
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_ModifyFieldValue The _ModifyFieldValue business rule method allows you to append,
prepend or overwrite an existing text field value on single forms and
related multi-forms.

Note: This rule method can only be configured by Developer users
only. If you are interested in configuring a rule using this method,
please contact Professional Services or log an Extranet ticket.

Configure the following settings.

General Settings Field Definitions:
Note: Not all General settings are listed. These are the settings
necessary for the rule to work.

l Table Name: Select the dataform where the rule will be
executed.

l Method: Select _ModifyFieldValue.
l Rule Title: Enter a brief description of what the rule does.
l Description: Enter a more detailed description of what the

rule does.
l Primary Source: Select the dataform where the Primary

Trigger Field is located.
l Primary Trigger Field: Select the field or HdrAction to

evaluate for the triggering condition.
l Primary Trigger Operator: Select the operator to use for the

Primary Trigger comparison. Example: Equals.
l Primary Trigger Value: Type the value to be met for the

Primary Trigger comparison.
l Execution Pipeline: Default, ScheduledWFC
l Execution Order: Controls the order in which rules execute. If

you are using the StageChanges option, you set an execution
order which ensures that the _ModifyFieldValue rule runs
before the corresponding _SaveStagedChanges rule so that
your changes are available to be applied.

l Save Action: Both
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Method Description

Method Parameters Field Definitions:
l Modification: Enter Append, Prepend or Overwrite.

o Prepend: Add text in front a standard text input field
value (i.e., short text field datatype of 500 characters or
less) or above a long text field value (such as Editor, Log
or Text Area field datatypes). Example 1: Add the
current date and time above the body text of an Editor
field used to hold comments. Example 2: Add text
(such as A:, B:, or C:) to the beginning of a short text
field value to ensure control of the sorting of the value
on reports.

o Append: Add text behind standard text input field value
or after a long text field value. Example: Add text such
as ( - SF) to the end of a prospect name to denote that
the prospect came from Salesforce.

Note: The exception to this is inserts to log fields, where
the text is always prepended as appending to the end of
a log field would interfere with the date/time stamp
functionality of the log. If you set an Append
Modification value when configuring the business rule
method on a log field, the following error message
displays upon clicking Save or Apply on the business
rule record: "The Modification value for log fields may
only be Prepend and cannot be Overwrite or Append."

You must correct the Modification value to proceed
with saving the rule.

o Overwrite: Replace an existing text field value.
Example 1: Replace an incorrect value with a correct
value. Example 2: Clear a field and remove a value
entirely. This replaces the field with a blank or null value.

Note: The exception to this is overwriting log fields,
which is a data integrity issue. If you set an Overwrite
Modification value when configuring the business rule
method on a log field, the following error message
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displays upon clicking Save or Apply on the business
rule record: "The Modification value for log fields may
only be Prepend and cannot be Overwrite or Append."

You must correct the Modification value to proceed
with saving the rule.

l TargetField: Enter the field name of the field receiving the
changes.

l TargetForm:  Enter the form name of the form receiving the
changes or use the #ThisForm code value to use the form
listed in Table Name.

l Value: Specify the text you are appending, prepending or
using to overwrite. You can leave it blank if you are using an
Overwrite modification to set the field to a blank or null value.
You can enter text, Replace fields from Email Templates for
Organization records, a Related Parent Field (see additional
step below), Server Data Proc (SDP) fields, and code logic
fields such as:

o #CurrentDateTime
o #CurrentUser
o {ExistingFieldValue} - Inserts the current field value of

the Target field.
o {ThisForm.FieldName}
o {ThisForm.fkFieldID} - Decodes the parent form field

referenced on the triggering form.
o {ThisForm.fkFieldID.Code} - Returns the ID stored in the

parent form field on the triggering form
o {ThisForm.TabForm.TabFieldName}

Keep in mind that Replace fields are case-sensitive.
l RelatedParentField: If you want to use Replace fields from a

Related Parent Field, specify the field name of the Related
Parent Field here. We use this to identify the correct form
containing the Replace fields.

l Separator: Specify a Separator when making an Append or
Prepend modification to a long text field (such as Editor, Log
or Text Area field datatypes) where you want the addition to
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appear on a separate line. Use the non-printing control
characters {CRLF} or {NewLine} as separators to indicate the
end of a line or a line break.

Note:
o When adding values to a Multi-Lookup field, enter '!.!' in

the Separator field and at the end of the value.
o The following soft error warning displays when you are

appending or prepending a long text field without
adding a separator upon clicking Save or Apply on the
business rule record: "The Separator is not filled out."
However, you can click Save Anyway to continue
without adding the separator.

l StageChanges: Stage the changes for single forms only by
clicking the StageChanges checkbox. This interacts with the _
SaveStagedChanges business rule method. Set the _
SaveStagedChanges business rule with an Execution Order
that occurs after your _ModifyFieldValue rule triggers so that
your changes are ready to be applied when the _
SaveStagedChanges business rule runs.

Note:
l On a multi-tabbed form, when the rule is triggered from a

main form field, you can set a value using a Child tab Replace
field. For instance, the rule can be set to use the main form as
the TargetForm with a Child tab TargetField if using the
{ThisForm.TabForm.TabFieldName} code logic in the Value
field of the Method Parameters.

l There is built in error handling for incorrect applications of the
rule, such as trying to update an integer field with text. The
error details are logged in the Exception Log and an error
message such as this example also displays on the target form: 
"An unhandled exception occurred {_ModifyFieldvalue Rule
Execution}. Please contact your system administrator."

Primary and Secondary Trigger fields
When configuring business rules, the Primary Trigger Field and Secondary Trigger Field lists include
fields that are User datatypes. Trigger value fields are text fields that support the following
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configurations:

• A single User ID
• #IsDirty
• #IsEmpty

Primary Trigger

• Primary Trigger Field: can specify HdrAction or a field on the current dataform
• Primary Trigger Value: the HdrAction value or the field value used for comparison
• Compares Primary Trigger Field HdrAction value or the dataform field value with Primary Trigger

Value entered
• The Primary Trigger Value must have changed for the rule to fire, based on the following criteria:

• If comparing HdrAction value, the HdrAction is assumed changed
• If comparing dataform field values (e.g., luState=MA), the dataform field must have changed
• If #IsEmpty, #IsNotEmpty, dataform field is assumed changed
• If #IsDirty dataform field must have changed

• Click the label for a list of # conditions that are hyperlinked to set the condition in Primary Trigger
Value.

Secondary Trigger

Secondary trigger field and value fields are enabled when a primary trigger condition has been set and
are optional. Criteria for secondary trigger conditions are as follows:

• Primary Trigger condition must be met. Secondary Trigger acts as an AND with Primary Trigger.
• Secondary Trigger Field: can specify HdrAction, a field on the current dataform, or a field from

ServerDataProc1 or ServerDataProc2
• Secondary Trigger Field: when using Server Data Procs, the format is SDP1.FieldName or

SDP2.FieldName
• Secondary Trigger Value: the HdrAction value or the dataform/SPD1/SPD2 field value
• Compares Secondary Trigger Field HdrAction value or the dataform/ServerDataformProc field value

with Secondary Trigger Value entered
• The Primary Trigger Value must have changed for the rule to fire, based on the following criteria:

• If comparing HdrAction value, the HdrAction is assumed changed
• If comparing SDP1/SDP2 value, the current value is assumed changed
• If comparing dataform field values (e.g., luState=MA), the current dataform field must have

changed
• If #IsEmpty, #IsNotEmpty, current dataform/SPD1/SPD2 field is assumed changed
• If #IsDirty dataform field must have changed
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• If #IsDirty previous value is assumed Empty, field must have changed (contains a value)
• Click the label to for a list of # conditions that are hyperlinked to set the condition in Secondary

Trigger Value.

Required Field Business Rules
Often you want to require a dataform field to be completed, but only under certain conditions. Making
the field required at the dataform level is not a good solution. That's where the required field business
rules come into play.

The following list comprises the required field rules.

Rule Description

_HE_RequireField
_SE_RequireField

Displays a hard error (_HE_RequireField) or soft error (_SE_
RequireField) on a parent or child/tab dataform when you attempt to
save the form without entering a value in the specified required field.
If you are configuring a hard error, you are unable to continue the
Save process without providing a value. If you are configuring a soft
error, you can choose to provide a value or you can continue the Save
process without providing a value.

Note: 

l These methods are only configurable on the primary form of a
tab set but you can reference triggering fields from tabbed
forms.

l These methods support the following configurations:
o Singleform to singleform
o Multiform to singleform
o Multiform to multiform if both dataforms are within the

same tab set
o Tab field to Tab field if both fields are within the same tab

set
l These methods replace the _RequireFieldOnThisForm and _

RequireTabField business rule methods.
Parameters: RequiredDataformName and RequiredFieldName.
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_RequireAdHocField Checks for a field value that resides in a node embedded in the
dataform XML packet.
Parameters: sFieldPath and sFieldLabel

Related Topics:

l Business Rule Methods

Configuring rules to auto-complete tasks
You can create a rule that will close all associated tasks on a dataform regardless of the origin of the
task (Workflow Channel or manual). This means you do not have to close tasks manually. Our example
dataform (in the following image) uses the method _TaskAutoCompleteAll. This method completes all
non-archived tasks that are associated with a dataform except for tasks that define a recurring rule.

To configure an auto-complete rule:
1. Go to System Admin > Advanced > Manage Rules.

The Custom Logic Rules dashboard opens.
2. To add a business rule, click Add.

The Rule Details form opens.
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3. Complete the form fields:

Dataform This is the dataform where this rule will execute when the dataform is
saved.

Method Select _TaskAutoCompleteAll.

Rule Title Provide an abbreviated explanation of what this rule does.

Rule Type ClientSpace controls this field automatically. When you select the
method _TaskAutoCompleteAll, the Rule Type is set to Biz Logic.

Description Provide a more thorough explanation of what this rule is to
accomplish.
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Primary Source Select the dataform or tabbed child form to use as the source for the
primary trigger evaluation.
Note: To save a Primary Source field value, you must select a

corresponding trigger field, operator, and value. If you do not, the
source value clears upon saving.

Secondary Source Select the dataform, tabbed child form, Server Data Proc 1 (SDP1) or
Server Data Proc 2 (SDP2) to use as the source for the secondary
trigger evaluation, if applicable.
Note: To save a Secondary Source field value, you must select a

corresponding trigger field, operator, and value. If you do not, the
source value clears upon saving.

Primary Trigger Field Select the field that auto-completes the task.

Primary Trigger Value Type the value of what is stored in the database for the Trigger Field.

Secondary Trigger Field Select an additional trigger condition that must be met if necessary.

Secondary Trigger Value Set the secondary trigger value.

Execution Pipeline Leave this set to Default.

Execution Order This field controls the order in which rules will execute first. Rules
execute from lowest to the highest number. It may be necessary to
look at other rules already configured on this dataform to determine
the order of precedence for executing rules.
Execution Order of Precedence: Within the Rules system, there is a
distinct order of precedence that occurs, that being HardError,
SoftError, BizLogic. This means that setting a field to a specific value
automatically with BizLogic, then validating that field with a Hard Error
will never occur in the correct order, as the Hard Error will fire before
the BizLogic fills the field. This order of precedence happens
irrespective of the execution order placed on the configured rule, so
Hard Errors will fire in Execution order least to greatest, then Soft
Errors will fire in their order of execution, then the Biz Logic will
happen, again in the order of execution set on each rule.

Save Action Will this rule be applied on Insert of a new dataform, or the update of
an existing dataform or on both?
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Workspace Template Select the Workspace Template(s) to which this rule applies.

SendNotification When the method _TaskAutoCompleteAll is selected, then the
SendNotification option is enabled. Select this option to send
notifications when all tasks are auto-completed.

4. To activate the rule, select Active. Active is enabled by default.
5. Click Save.

Configuring rules to generate custom messages
System administrators can configure rules to produce custom messages for fields that only display for
Hard and Soft errors.
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When rules trigger, if a custom error is configured, the custom error is displayed. If no custom error is
configured, the standard system message is displayed.

To configure a rule to generate custom messages:
1. Go to System Admin > Advanced > Manage Rules.

The Custom Logic Rules dashboard opens.
2. To add a business rule, click Add. To edit an existing rule, click Edit.

The Rule Details form opens.
3. Complete the form:

Dataform This is the dataform where this rule will execute when the dataform is
saved.
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Method Choose from the list. For a list of Methods, see Business Rule Methods.

Rule Title Provide an abbreviated explanation of what this rule does.

Rule Type ClientSpace controls this field automatically. Rule Type is determined
by the Method. To customize messages, the Rule Type must be Hard
Error or Soft Error.

Description Provide a more thorough explanation of what this rule is to
accomplish.

Primary Source Select the dataform or tabbed child form to use as the source for the
primary trigger evaluation.
Note: To save a Primary Source field value, you must select a

corresponding trigger field, operator, and value. If you do not, the
source value clears upon saving.

Secondary Source Select the dataform, tabbed child form, Server Data Proc 1 (SDP1) or
Server Data Proc 2 (SDP2) to use as the source for the secondary
trigger evaluation, if applicable.
Note: To save a Secondary Source field value, you must select a

corresponding trigger field, operator, and value. If you do not, the
source value clears upon saving.

Primary Trigger Field Select the field that is going to cause the change.

Primary Trigger Value Type the value of what is stored in the database for the Trigger Field.

Secondary Trigger Field Select an additional trigger condition that must be met, if necessary.

Secondary Trigger Value Set the secondary trigger value.

Execution Pipeline Leave this set to Default.

Execution Order This field controls the order in which rules execute. Rules execute from
the lowest to the highest number. It may be necessary to look at other
rules already configured on this dataform to determine the order of
precedence for executing rules.
Execution Order of Precedence: Within the Rules system, there is a
distinct order of precedence that occurs, that being HardError,
SoftError, and BizLogic. This means that setting a field to a specific
value automatically with BizLogic, then validating that field with a Hard
Error will never occur in the correct order, as the Hard Error fires before
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the BizLogic fills the field. This order of precedence happens
irrespective of the execution order placed on the configured rule:
1. Hard Errors fire in execution order least to greatest.
2. Soft Errors fire in their order of execution.
3. Biz Logic fires in the order of execution set on each rule.

Save Action Will this rule be applied on Insert of a new dataform, or the update of
an existing dataform, or on both?

Workspace Template Select the Workspace Template to which this rule applies.

Error Message Override Type your custom message. This rich text area field supports advanced
formatting options including font selection, size, color, as well as
additional formatting, such as bold, italics, and bullet points. This field
is available when the Rule Type is Hard Error or Soft Error. The text in
this field displays when the rule fires.

4. Click Save.

Configuring Case Discussion business rules for replies
With the advent of email to case discussions, there are two flavors of Case Discussions. This topic
pertains to the original version of Case Discussions that supports a REPLY link in the discussion
message. While there are certain areas of similarity in the two configurations, the required business
rules are not compatible. For purposes of this topic, the SendReply rule must be enabled on the
Discussion message and its email integrated equivalent must be deactivated.
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SendReply (original)

• Uses CSCDISC [sent to external user] and CSCDISCNEW [sent to internal user, notifies that a new
reply has been posted]

• Set on Default Pipeline
• Must inactivate the SendEMailIntegrationReply rule

Configuring Create Discussion business rules
The Client Service Case rule Create Discussion, automatically creates a case discussion based on
configured triggers. The rule is scripted as inactive and requires the following parameter configuration:
EmailTemplateCode and InitialRecipients. After you configure and activate, the rule creates a new
discussion and triggers an automated email to the initial recipients based on the rule parameters.
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Related data:

n Method: CreateDiscussion
n Rule Title: Create Discussion
n Rule Type: Biz Logic

To configure the rule:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Open the rule Create Discussion (click Jump).
The Rule Details form opens.

3. Complete the form.
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Primary Trigger Field (Optional) Select a field from the Table Name, which is the Client
Service Case.

Primary Trigger Operator Select one of the following operators if you select a value for the
Primary Trigger Field:
l Does Not Equal
l Equal
l Is Dirty

Primary Trigger Value When you specify a Primary Trigger Field and you select Does Not
Equal or Equal in the Primary Trigger Operator field, you can then
select a value in the Primary Trigger Value field. For example, for
Primary Trigger Field = Communication Method, you can specify a
value, such as Employee Portal.

Secondary Trigger Field (Optional) Select a field from the Table Name, which is the Client
Service Case.

Secondary Trigger
Operator

Select one of the following operators if you select a value for the
Secondary Trigger Field:
l Does Not Equal
l Equal
l Is Dirty

Secondary Trigger Value When you specify a Secondary Trigger Field and you select Does Not
Equal or Equal in the Secondary Trigger Operator field, you can then
select a value in the Secondary Trigger Value field.

EmailTemplateCode Enter the template code of the system email template that is used
when replying to discussion threads. The template code must begin
with CSC. See Configuring Case Discussion Email Templates.

InitialRecipients This is a comma-delimited list of User, Contact and Email type fields
on the associated case or employee form that will be used to create
the initial email recipients for the discussion response. Field names
must follow the tableName.fieldName format. For example, gen_
ClientServiceCase.BrokerContact.

Active Select Active to enable the rule.

ClientSpace Setup & Administration © 2025 PrismHR 406

Chapter 5 Configuring Rules and Business Logic



4. Click Save.

Reactivate Case business rule
The Reactivate Case business rule runs on the Discussion Message dataform on the Default Pipeline.
This rule triggers when the system receives a reply to a case discussion message after the case is in a
resolved status and inactive. When triggered, the system reactivates the case by calling business logic
and passing an HdrAction of Activate.

ClientSpace Setup & Administration © 2025 PrismHR 407

Chapter 5 Configuring Rules and Business Logic



Reactivate Case

• Set on Default Pipeline
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Requiring a dataform for workflow channels
To require a dataform to be completed before you can change the Contract Status, configure the HE_
RequiredTablePerCodeEngine biz rule. This also puts a link on the Client Master header to access the
dataform and complete it.

To configure the rule:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Locate and open the entry with Method Name HE_RequiredTablePerCodeEngine.
The Rule Details form opens.
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3. Configure accordingly:
o The CodeList field cannot have any spaces.
o The CodeList field can be comma-separated with no spaces after the comma.

4. Click Save.

Configuring Recurring Visits
One of the best
features of client
visits is the ability
to set
automatically
recurring visits.
For a recurring
visit, when you
mark the visit as
Completed, the
visit is saved and you are returned to the Client Visit dashboard. When you refresh the list, you see that
another Planned visit has been set up.

The recurring planned visit can be established from the Client Master Company Other Info tab of the
Client Master, when you select a Visit Type of R but other forms can be used.

For recurrence to work, your system administrator must configure Lookup metadata for Type of Visit
and Visit Schedule. The following procedures guide you through the configuration.

Note: If you need additional fields on the Client Visit Add form than the default fields, advanced
administrative access or billable assistance (without a Gold service plan) is required. See ClientSpace
Service Plans to learn more about available service plans.

Step 1: Activate the Rule
First, you must activate the rule, CreateNextVisit.

To activate the rule:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Locate the Dataform Client Site Visit with the Method Name CreateNextVisit and click (Open).
The Rule Details form opens.
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3. Select the Active option.
Typically this rule is set to Active.

4. Click Save.

Step 2: Configure the Lookups
The next step is to configure the Lookup metadata for the Type of Visit and Visit Schedule. Different
visit types can have different recurrence frequencies. Additionally, there are multiple entries for each of
the Lookups. For recurrence to work, you must configure each one.

To configure the Type of Visit:

1. Go to System Admin > Lookups.
The Lookups dashboard opens.

2. Filter on TypeOfVisit.
There are multiple entries for TypeOfVisit. Configure each type where you want recurrence.

3. Select an entry and click (Open).
The Lookup Details form opens. Our example uses RetentionVisit.
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4. In Auto Create Next Visit, select Yes.
The Next Visit Setting fieldset becomes available, with the required fields Dataform for
Frequency and Field for Frequency.

Datafor
m for
Frequen
cy

Select a dataform containing the field that you will use to determine how often a
recurrence will occur. The Company Other Info dataform is often used. However, this
can be any dataform.

Field for
Frequen

Enter the Field Name (not Field Label) in this field. This must be a field located on the
selected Dataform for Frequency. Additionally, the designated Field for Frequency
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cy must have an Element Type of Lookup (core) in the Lookup Group Visit Schedule and
Visit Schedule metadata must be configured.

Note:
l If you have advanced administrative access, you can locate the Field Name by

opening the dataform properties and displaying the fields of the dataform you
specified in Dataform for Frequency. To do this, on the Dataform Admin
dashboard (System Admin > Advanced > Dataform Admin), click (Jump)
next to the dataform name. To view the fields, in the Action Center, click Fields.
Double-click the desired field to display the field properties. This is where the
Field Name is found.

In the example below, we are displaying the field properties for the HR General
Visit field. You can see that it has a Field Name of luHRGeneralVisitSchedule. If you
wanted to use this field as the Field for Frequency, you would enter
luHRGeneralVisitSchedule.

l If you do not have advanced administrative access, alternative ways of getting
the Field Name are to ask a Global Admin for assistance, create a BI report so
that you can see field names, or log an Extranet case for assistance.

5. Click Save.
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To configure a new frequency:
Lookups for Visit Schedule are already configured with frequency.

1. To view frequency, in Lookups, filter for Visit Schedule.
The entries are already configured. However, you may want to review or add a new frequency.

2. To add a new frequency, click Add.
The Lookup Details form opens.

3. Complete the fields:

Group Select Visit Schedule.

Code Enter a name, such as Weekly.

Decode Enter the name again, such as Weekly.

4. Click Apply.
The Additional Settings fieldset becomes available.

5. In Days per Frequency, enter a number. For example, for Weekly, type 7.
6. Click Save.

Related Topics:

l Adding Client Visits
l Updating visit status using Mass Update
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Chapter 6
Configuring lookups
Lookups are one of the most flexible datatypes in ClientSpace and are easily configurable when you
understand how they work. Lookups are predetermined, selectable lists of information to ensure data
are recorded consistently, instead of a straight text field, which leaves room for errors in spelling and
formatting. When you decide to use lookups, you need a Lookup Group (our example – in the
subsequent topics – uses US States) and the associated Lookup values (in our example, the individual
states are the values). The following procedures and subsequent topics show you how you can use
lookups to get the most out of your ClientSpace system.

Exercise extreme caution when administering Lookup Groups and the corresponding Lookup
values. The system uses values, such as CSC_Status, in triggering business logic. Changing or
deleting these values can result in system issues, which may require programming to resolve. If
you are unsure about changing or deleting a value, please log an Extranet case. It is far better to
deactivate a value than delete it, but it is even better to err on the side of caution and ask first.

Before you Begin: Review Existing Lookup Groups
Before you begin adding lookup groups, run the Lookup Value by Group Business Intelligence report
and review the existing lookups. Use the Lookup Values by Group to export a list of lookup field values.

The following graphic illustrates the Lookup Value By Group report.
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Run the Lookup Value by Group Business Intelligence report

1. From the modules bar, select Business Intelligence.
The list of Business Intelligence reports displays.

2. Select Administration > Lookup Values by Group.
The report displays.

3. (Optional) Enter a value in the Group Name field to filter the results.
4. (Optional) Enter a value in the Lookup Decode field to filter the results.
5. Select the Results Per Page drop-down arrow and select Show all results.
6. Click Update Results.
7. Select the Export drop-down arrow and select one of the following export options.

o Export to Excel
o Word Document
o CSV
o XML

The system saves the file to your Downloads folder.

1. Add a Lookup Group
Lookups consist of a Lookup Group and Lookup values, which contain, at a minimum, a Code and
Decode value. For new lookups, first, create the Lookup Group. Then you create the Lookup values.

To add or configure a Lookup Group:

1. Go to System Admin > Lookups > Manage Groups.
The Lookup Groups dashboard opens. From here, you can manage or add groups or edit the
values of an existing group.

2. To add a new group, click Add.
The Lookup Group Details form opens.
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Group Name Enter a unique group name to avoid confusion when using lookups.

Metadata Dataform A lookup can reference associated metadata through another dataform.
However, if not configured correctly, it can cause errors. Before you
configure lookup metadata, please log an Extranet case. For more
information about metadata, see Lookups with Metadata.

Description Enter a unique description to avoid confusion.

System Indicates this group is a building block of the system. When marked as
System, it is locked down and not editable.

Active Select this option to activate the new group.

3. Click Save.

You are returned to the Lookup Groups dashboard.

2. Add Values to the Lookup Group
Now let's add values to your group.

To add values to the new group:

1. Go to System Admin > Lookups.
The Lookups dashboard opens.

2. Before adding values to a group, it is helpful to first search for the group in question and then
review the existing values (Code and Decode columns) to make sure you do not create duplicates.
Remember to select More > Show > All when searching because archived values are hidden from
the list by default.

3. Click Add.
The Lookup Details form opens.
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4. Complete the form:

Note: You may see additional fields on the Lookup Details form which are not defined in the table
below. These are metadata fields which can vary as they are unique to the Lookup Group.

Group Select the new group you just added.

Filter Filter can further refine the lookups or use a lookup group more flexibly.

Note: Once configured, you can select filter you want to use in the Filter Value field
of dataform properties or in the Response Option field on a Survey Design form.

For dataforms, a filter can be a word or single characters that represent what you are
filtering.

To specify multiple filter values, enter the list in the Filter field using a comma-
separated list with no spaces. For example, South,SE or Purple,JewelTone .
When you specify multiple values, it acts as an OR mechanism. For a list of US States,
you might specify a state as South and SE (Southeast). So, when a geographic region
is selected, the state is available in two regions.

Note: The Filter field will not accept special characters (with the exception of commas
used to specify multiple filter values).

For survey ratings, filters represent the rating scale of the Survey Rating Lookup
Group. Assign the survey rating lookup values to a filter group by entering the filter
group name in the Filter field. In the example below, we have created filters named 1-
10, 1-5, and 1-7. We want the lookup value "1" to be included as a rating value in the
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1-10, 1-5 and 1-7 filter groups so we add them all to the Filter field separated by
commas):

For details on how to configure filters on dataforms, see Basic field filtering: Using the
lookup Filter and dataform field Filter Value.
For details on how to set up a case survey, see Configuring a Dataform Survey Email
Template.

Code The Code value is the actual data value stored in the database when a record is saved.
l You determine the Code value of a lookup that does not have the System check

box checked (i.e., a non-system lookup). However, keep in mind that a mistyped
Code value cannot be edited once the lookup is saved. If you save a mistyped
Code value on a newly added lookup that is not yet being used by the system,
you can delete the lookup and re-enter it. If you are unsure about whether it is
safe to delete a lookup, please log an Extranet case.

l Remove spaces and special characters from the Code value when creating a new
lookup record. Use PascalCase formatting – that is, the first letter of each word
is capitalized – for example, WinterMonth and SummerMonth.

Note: If the Import Map detail is set to not allow invalid lookup values when
importing, the system will check to see if there is an ImportID to validate against
(standard functionality). If the ImportID field is not populated, then the system will
validate against the Group/Code value of the lookups to try and import.

Decode The Decode value is what displays on the dataform. Code and Decode are often the
same but are not required to be.
Note: You can add duplicate Decode values to a Lookup Group for filtering purposes.
However, the Code values must remain unique within the Lookup Group. When
adding a duplicate Decode value (with a unique Code value), the following soft error
confirmation message displays upon clicking Apply or Save:
"The chosen Decode value already exists for the specified Lookup Group."
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Click Save Anyway to add the duplicate Decode value.

Descriptio
n

If the Decode value does not provide a logical description of its purpose, then add a
description.

Display
Order

Display Order assigns how the values display in the list. Lower numbers display
before higher numbers. In the example below, we have 5 items in a lookup list and we
are using a display order scale of 1 to 5. The "New" lookup value with a Display Order
of 1 will display at the top of the lookup list while the"Complete" lookup value with a
Display Order of 5 will display at the bottom of the list.
Value Display Order

New 1

In Progress 2

Deferred 3

On Hold 4

Complete 5

Note:

l You do not have to use consecutive numbers from 1 to 5 as we did in the
scenario above. The numbers just need to reflect a progression from lowest to
highest. For example, you could have used 10, 20, 30, 40 and 50 to achieve the
same result.

l If no Display Order is defined, the value does not populate the lookup list.
l This Display Order is also used to determine the order of values on the

Progress Bar widget. Lookup values with no Display Order defined do not
display on the Progress Bar. See Widget: Progress Bar.

Default You can set one value as the default when a dataform field is configured to this
lookup. For example, on the Workers’ Comp Claim dataform, the Claim Type field
(which is configured as a lookup field) can default to Medical Only (a lookup value).
When you add a new dataform, the field defaults to this value instead of blank. You
would set Default for commonly used values.

System Indicates this value is a building block of the system. When marked as System, it is
locked down and not editable.
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Import ID After the lookup is saved, the Import ID field displays. This field is in the
Administrative fieldset. Import ID is used for translation during imports that are
configured with the lookup datatype. By default, this field is blank and must be set for
imports.
l This field can either have a single value such as W to match what is exported

from your external system or has a pipe-delimited list of optional values that
translate to the lookup such as |W|w|Weekly|WEEKLY|WEEK|Week|.

l When passing multiple values, each value is evaluated. The inspection is case
sensitive, so W is a different value than w.

l When passing multiple values, use the pipe delimiter between values – for
example, |W|Week|.

l When stringing multiple values together, the pipe delimiter | must be the last
character in the string.

Note: If the Import Map detail is set to not allow invalid lookup values when
importing, the system will check to see if there is an ImportID to validate against
(standard functionality). If the ImportID field is not populated, then the system will
validate against the Group/Code value of the lookups to try and import.

Active Select Active to activate the new value.

5. Click Save.

What's next? Now you need to configure the dataform targeted to use the new lookups. Go to
Configuring Dataform fields to use Lookups.

Related Topics:

l Lookups with Metadata

Configuring Dataform fields to use Lookups
After the group and values are defined, the next step is to connect a field that uses lookups to the new
group. The following procedure and subsequent topics use the dataform Client Location and the field
State. The State field uses a lookup group US States. This topic guides you through configuring a
dataform field to use a lookup.
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To configure a dataform field to use a lookup:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Locate the dataform and double-click the row or click (Open).
The Dataform Properties form opens. Our example uses the Client Location dataform.

3. In the Action Center, click Fields.
The dataform fields are displayed. Our example configures the dataform field State to use a
lookup.

4. Locate the field in question and double-click or click (Open).
The form configuration opens for the selected field. Our example shows we selected the field
State.

5. In Lookup Group, select the group.
Our example shows that we selected US States as the Lookup Group.
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6. Click Save.

The next step is to reload the dataform to use the new lookup settings.

To reload the dataform:
l On the dataform, on the Action Center toolbar, click (Reload).

This action refreshes the dataform to use the configured lookup group.

Putting it all together
Let’s summarize what we did. We have a dataform field named State that needs to be configured as a
lookup field to standardize the value selections. We configured the field to use the Lookup Group
named US States.
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Basic field filtering: Using the lookup Filter and dataform
field Filter Value
ClientSpace provides lookup field filtering, which allows you to reduce the number of value choices
selected from a dataform field. This is accomplished using the Filter field on the Lookup Details form.
You can use the Filter field to filter the dataform field using either a straightforward basic filter or a
controlling field using advanced filtering. We discuss advanced filtering in the next topic.

For basic field filtering, let's continue
to use the US States as an example.
The Lookup Group, named US States,
is already established.

Note: You can add a Lookup Group
from Dataform Field Administration
(System Admin > Advanced
> Dataform Admin> Action Center
> Fields) or from Lookup Groups
Management (System Admin >
Lookups > Manage Groups). See
Adding Dataform Fields and Configuring lookups.
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The lookup values are also established: the states from Alaska to Wyoming (in alpha order). In the
preceding topic, we configured the Client Location dataform to use the lookup group US States for the
field State. Because no filter value is applied, the field displays all the lookup values in the group US
States, as shown in the adjacent image.

So then, how can you apply further filtering to limit the list? Let's first look at basic field filtering.

Now let's step through the procedure for configuring basic field filtering using the Filter value in the
lookup details. For our example, we use Florida and assign a value to indicate a geographic region.

Basic filtering applies to the Lookup (core), Lookup Type Ahead (core), and Lookup - Multiple
(core) datatypes.

1. Assign a Filter value to the lookup detail

To assign a Filter value:

1. Go to System Admin > Lookups.
The Lookups dashboard opens.

2. Filter the list to search for your lookup group.
Our example uses US States as the search filter.

3. Open a state.
The Lookup Details form opens. Our example uses Florida. Let's assign a Filter value to indicate a
geographical region.
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4. In Filter, enter a value.
We assigned a value SE to represent the Southeast geographic region.

5. Click Save.
6. Repeat this process for each of your lookups. For this example, US States, we need to assign an

appropriate Filter value to each state (such as, SE, NE, or MW). For your lookup group and values,
apply the same approach.

2. Configure the dataform field to use Filter Value
Now with a Filter value assigned to our states, let's see it in action. Note, we have already set the Filter
value for all of the Southeastern states. The lookup values (states) have a filter value (such as SE for
Florida, Georgia, North Carolina, and South Carolina). However, to use the filter value to limit what is
displayed in a dataform field, we must perform additional field configuration. Let's continue the
example using Southeastern states. We want to narrow the dataform field to only list states with a filter
value of SE so that only Southeastern states appear in the list.

To configure the dataform field using Filter Value:

1. Return to the field configuration. Go to System Admin > Advanced > Dataform Admin >
Fields.

2. Open the field in question, and in Filter Value, enter a value.
Our example shows the State field with SE in Filter Value.
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3. Click Save.

The next step is to reload the dataform to use the new lookup settings.

To reload the dataform:
l On the dataform, on the Action Center toolbar, click (Reload).

See it in action
Now that we have hard-coded a value in Filter Value for the State field let's see how this looks on the
dataform. We only want the Southeastern states to display in the list. So, we assigned a Filter for each
state lookup and then set a Filter Value on the dataform field. The State selections are now just the
Southeastern states. **
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** It is essential to understand that filtered lookup fields display only the lookup values with filters
that match the Filter Value on the dataform field configuration and any lookup values in the
lookup group that do not have a filter set. For example, states that are not assigned a Filter, such
as SE or NE, will, by default, appear in the list of available values. States that display in the list and
are not in the Southeast indicate that you need to assign a value to Filter in the lookup details. In
other words, assign a Filter value for all the lookups that belong to a Lookup Group – if you do not
want irrelevant items in the lookup field list.

Advanced filtering: Using contents of another field and
Filter Source
For advanced filtering, we reference two fields, so that when the field value changes for A, then the list
for B is filtered with that value. In advanced filtering, you copy the field's Name value that you want to
be the source for your filter to another field's Filter Source.
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With this in mind, let's take filtering a bit further using our US States example. We want to restrict the
range of values displayed in the lookup field State using a new field Region to hold the values to filter
the State field.

Advanced filtering applies to the Lookup (core), Lookup Type Ahead (core), and Lookup - Multiple
(core) datatypes.

To guide you
through this
process, we
configured a new
lookup group
Region, and a set
of lookup values
for this group.

Note: You can
add a Lookup Group from Dataform Field Administration (System Admin > Advanced > Dataform
Admin> Action Center > Fields) or from Lookup Groups Management (System Admin > Lookups
> Manage Groups). See Adding Dataform Fields and Configuring lookups.

The code value of the Region lookup matches the filter values we applied to the US States lookups. We
use NE, SE, N, P, SW, NW, MW, and MA.

The following procedure guides you through advanced filtering using our example of US States and
Region, and the State field.

1. Add a new dataform field
Our example uses a new dataform field named Region.

To add a new dataform field:

1. Return to the dataform. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Open the dataform in question. Our example opens the Client Location dataform.
The Dataform Properties form opens.

3. In the Action Center, click Fields.
The field list opens.
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4. Add a new lookup or multi-lookup field to the dataform and set this field to use the new lookup
group (in our scenario, the new field is Region) with no filtering on the field. We set the Region
field to use a Lookup Group named Region.

5. Click Save.

2. Configure the dataform field
We return to the dataform and configure the State field to use the new Region field as its Filter Source.
Make sure that the Filter Value field has been cleared. If Filter Source is used in configuring lookup
field types, the Filter Value field is ignored.

1. From the dataform field list, copy the Name value of field A. In our example, field A is Region, and
the value we are copying is luRegion.
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2. Open the related field (field B, which in our example is State).
The field configuration form opens.

3. In Filter Source, paste the copied value.
Our example shows that we pasted luRegion in the State field Filter Source.
Note: 

• If you are configuring a multi-lookup field, you cannot set another multi-lookup field as the
Filter Source. You can only set another standard lookup field as the Filter Source.

• You cannot use a field name that does not exist on the dataform as the Filter Source.
• If you change multi-lookup field filter settings after a user has already made a dataform

selection using a value that no longer displays, their selection will be preserved. However, if
they delete the selected value from the field, they will not be able to reselect it as it will no
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longer appear in the list of available choices. (This does not apply to the Lookup (core) and
Lookup Type Ahead datatypes. For those datatypes, if the filter settings are changed, a user's
selection may be cleared if the new filter settings no longer contain their selection.)

5. Click Save.

The next step is to reload the dataform to use the new lookup settings.

To reload the dataform:
l On the dataform, on the Action Center toolbar, click (Reload).

See it in action
Now let's see this in action. With the new configuration, the value selected in the Region field filters the
list of available values in the State field of the same form. The Client Location dataform field for State
now presents a new list of values – the Region values of MidAtlantic, Midwest, North, Northeast,
Northwest, Pacific, Southeast, and Southwest. You might use this form of filtering when selecting a
group of values (in our scenario Region is a group of states) to simplify and standardize lists.
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Lookups with Metadata
Metadata is data about data and provides even more flexibility for lookup use, enabling data associated
directly with a particular lookup value. When adding a lookup group, you can select a dataform to act
as the metadata form for that group (see 1. Add a Lookup Group in Configuring lookups). These forms
store information related to the lookup values used with the lookup group.

The Uses Metadata column shows whether a lookup has a metadata dataform associated with its
lookup group and whether associated metadata has been configured for a specific lookup value:

Three possible values can display in the Uses Metadata column:

Value Definition

No There is no metadata associated with the lookup.

Yes (Not Created) There is metadata associated with the lookup but it is not configured.

Yes There is metadata associated with the lookup and it is configured.
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Note: If you delete a lookup value, the associated metadata is deleted with it.

Examples
The Contract Type lookup in ClientSpace PEO has associated metadata that can determine:

l What Template is associated with the contract type?
l What Legal Entity / SUTA defaults are available when that contract type is selected?
l Default Workers' Comp Configuration for a workspace.

The Pay Frequency lookup in ClientSpace PEO has metadata associated that can determine:

l How many pay cycles per year for that frequency, such as Weekly = 52, SemiMonthly = 24, Bi-
Weekly = 26.

l Minimum per check fee to ensure a certain amount of administrative costs are submitted for the
year.

The Survey Rating lookup group is automatically linked to a Survey Metadata dataform. It contains a
single field named Survey Rating (Integer Only). The field is used to store the integer equivalent of a
survey rating value. This allows you to store survey results as numeric value (i.e., integer) metadata and
use the metadata for calculations in Business Intelligence reports.

For example, if four survey recipients select 10 on a 1-10 point star rating scale, an integer value of 10 is
associated with their selections. If another survey recipient selects 3, an integer value of 3 is associated
with their selection. You can then use the integer metadata to calculate an average score of 8.6.

If you need help configuring metadata, please log an Extranet case.

Configuring task fields
Task fields are configured as other lookup type fields through System Admin > Lookups.

To configure task fields:
1. Go to System Admin > Lookups.

The Lookups dashboard opens.
2. Click More.

The More dialog box opens.
3. In Group, type task.

The list of task configurations becomes available.
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4. Select an item and click Search.
If the Task Type or Workflow fields are hidden on the Task detail, it is because there are no values
configured. After you add a Task Type to the lookup list, it automatically appears.
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Chapter 7
Configuring Pipeline Linking
The Pipeline Linking table (System Admin > Pipeline Linking) allows Global Administrators to
define which Pipeline Behaviors can be applied in the following functional areas: Rules, Import
Mapping, Email Templates and Workflow Channels. You define which behaviors can be applied by
reviewing each Pipeline record in the Pipeline Linking table and setting a behavior for each functional
area within the selected Pipeline.
Upon updating a record, the Pipeline Linking table filters the Execution Pipeline field in each of the
aforementioned functional areas using the Pipeline Behavior designations you set.

This change will not impact existing Execution Pipeline entries until you edit the entries. For instance,
if you were to remove an Execution Pipeline entry from a Workflow Channel that now has been
assigned a Workflow Channel behavior of Disallow, upon save you will not be able to add it again as it
will be filtered out of the Execution Pipeline list. Alternatively, if that same pipeline had been assigned
a behavior of Allow or Default and you removed it, you would still be able to select it from the
Execution Pipeline list.

The Pipeline Linking table includes preloaded Pipeline Names that match the current Pipeline Lookup
Decode names in the Lookups table as illustrated in the graphic below:
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If you have custom pipelines, our Professional Services staff can assist you in adding them.

To configure Pipeline Linking behaviors:

1. Go to System Admin > Pipeline Linking.
The Pipeline Linking dashboard opens. From here, you can review the preloaded behaviors and
edit each pipeline's functional area (Rules, Workflow Channel, Email Template, and Import)
represented by the Behavior Rule, Behavior Workflow Channel, Behavior Email Template,
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and Behavior Import columns.

2. To edit pipeline behaviors, double-click the selected row or click (Open) next to a Pipeline
Name.
The Pipeline Linking Details form opens.
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Edit the Pipeline Behavior fields for the functional areas shown by selecting the appropriate option:

Pipeline Behavior Definition

Default Pipelines assigned to use this behavior auto-fill the Execution Pipeline
field by default.

Note: The Execution Pipeline fields in the Rules, Email Templates and
Workflow Channels areas are multi-select fields. Therefore, you can
specify unlimited default pipelines. The Import Mapping area, however, is
not a multi-select field. Only one default pipeline can appear in the
Execution Pipeline field and validation is in place to prevent more than
one lookup from being assigned as the default behavior for Import
Mapping.

Allow Pipelines assigned to use this behavior do not get added to the
Execution Pipeline by default. Instead, they are made available in the
Execution Pipeline list for selection.

Disallow Pipelines assigned to use this behavior cannot be added and are
excluded from the available selections in the Execution Pipeline list.

3. Click Save.

You are returned to the Pipeline Linking dashboard.
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What's next? Remember: Existing entries in the Execution Pipeline fields of Business Rules, Workflow
Channels, Email Templates, and Imports are not affected by Pipeline Linking configuration changes.
Review these forms and edit them as necessary to match the newly configured pipeline behaviors. The
Execution Pipeline fields of any new Rules, Workflow Channels, Email Templates, and Imports that you
create will auto-fill with pipelines designated with a Default behavior and any pipelines assigned a
behavior of Allow can be selected and added manually.

Related Topics:

l Configuring Rules and Business Logic
l Step 1: Channel
l Step 1: Initial
l Configuring the Email Integration Reply Template
l Configuring the Import Map Header
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Chapter 8
Configuring Custom Dataform Links
Configurable links enable administrators to control the accessibility of data in the system dynamically.
Configurable links can significantly improve the user experience by making related dataforms, reports,
and workflows available from the dataform a user is currently on at specific points in the workflow. You
can link to custom reports, merges, and dataforms within the current workspace or the Admin
Workspace, or even configure a workflow from scratch. An example of configured links creative use is
to make reports or workflow links available when specific data is entered. For example, a salesperson
can only submit an order for approval when there is a resolution.

This topic provides the tools you need to start configuring custom links. To learn how you can configure
link display conditions, see Configuring Link Display Conditions. To learn how you can configure link
security, see Configuring Link Security.

To configure and manage custom dataform links:

1. Go to System Admin > Advanced > Custom Links.
The Configure Links dashboard opens. To search the list, see Searching Custom Links.

2. Click Add.
The Configure Links Detail form opens.

3. Complete the form.
The value selected in Group drives the other form fields. The remaining form fields are listed
under Display Action with their corresponding Group link.

Location Name of the dataform or system object on which you want the link to
appear.

Display Value This is what displays in the action area of the dataform or system
object as the selectable link. When Workspace Dataform is selected,
Linked Field becomes available.

Group Denotes the type of link you are creating and drives the other fields
on the form to complete the configuration:

ClientSpace Setup & Administration © 2025 PrismHR 442

Chapter 8 Configuring Custom Dataform Links

../../../../../Content/Admin_Config/Config_LinkSecurity.htm


• Action
• Report
• Link 1
• Link 2

Sort Order Orders the Links in the Action Center Workflow Actions first, then
Links (Link1), then Reports. The Sort Order determines how the
individual items are displayed within the groups.

Display Action Lists the possible actions for the selected link Group. Display Actions
are based on the Group selection.

When Group = Action,
the Display Actions are:

l Custom Function: Call a custom
JavaScript function to perform an
action (requires additional coding by
our development team). Custom
Function enables the Custom
Function and Custom Function Data
fields.

l Submit w/Action: Generates a
HdrAction on the page to trigger
rules or workflow. Enter this
HdrAction in Code Value.

l Submit w/Action (close): Generates
a HdrAction on the page to trigger
rules or workflow, and after
generated, the page closes. Enter this
HdrAction in Code Value.

l Submit w/Action (close and
refresh): Generates a HdrAction on
the page to trigger rules or workflow,
and after generated, the page closes
and the list containing the record the
action occurred on is refreshed. Enter
this HdrAction in Code Value.

When Group = Link1 or
Link2, the Display
Actions are:

l Custom Function: Call a custom
JavaScript function (requires
additional coding by our
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development team). Custom Function
enables Custom Function and
Custom Function Data.

l Workspace Organization: Open the
workspaces associated Organization.

l Workspace Organization
Contacts: Open the workspaces
associated Organization Contacts.

l Workspace Dataform: Open a
workspace dataform from the header
of this dataform.

o Select the dataform in the
Target Dataform field.

o If configured for a dataform
with a foreign key relationship,
this brings back associated
records.

o Workspace dataform links
adhere to the relationship to
the dataform on which the link
is configured, filtering the
returned data appropriately.
For example, configuring a
workspace dataform link on
the Employee dataform to the
WC Claims dataform returns
only claims associated with the
employee in question.

l Admin Dataform: Open an Admin
dataform from the header of this
dataform (Admin dataforms live in
the Admin Workspace).

o Select the dataform in the
Target Dataform field.

l URL: Open another web page in a
new tab or window depending on
your browser configuration settings.
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When Group = Report,
the Display Actions are:

l Run Report: This
is the Report or
Merge that
executes when
you select the link.

o Run Report
enables the
Report/Mer
ge field. 

l Run BI Report:
This is the link
displayed in the
Action Center.

o Run
BI Report
enables the
Report
field. Select
from a list
of available
target BI
reports.

o BI Report
links can
use
CurrentUse
r, RecordID,
and
CurrentWor
kspace
filtering.
See
Creating
Links for
Business
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Intelligence
 Reports.

l Open Filter Page:
This is the link
displayed in the
Action Center.

l Custom
Function: This is
the custom
function to be
called.

Report / Merge The Report or Merge to execute using a Display Action when a Report
link is clicked. When the link is clicked, a form ID of the dataform is
passed. Report/Merge are only available when Group = Report.
• Report is available when you select Run BI Report in Display

Action.
• Report/Merge is available when you select any other Display

Action when Group = Report.

Target Dataform This is the dataform to be opened from configured dataform links
(Link1). This field is enabled when a Link Group is selected.

Code Value The HdrAction that is produced when the link is clicked (Action).

Linked Field The selections in this field are driven by the parent-child relationship
of the Location dataform and the Target Dataform. The link on the
Location dataform will link to the selection in Linked Field. When
there is only one field, it automatically displays. For example, when
there are two parent fields on the Client Service Case connected to
the Employee, the Linked Field determines which field the Employee
link references.

Custom Function The custom function to be called from an Action link.

Custom Function Data The data that is passed to a custom function, if required.

URL This is where you configure the URL that you want to open on a URL
Display Action. For an external URL, you must include the protocol
(http:// or https://) as links without this are treated as internal to the
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application.

Confirmation Message Before running the link action, display an OK / Cancel dialog box with
a message. Most often used with Action Links.

Description Provide a description of what action the link does. This description
displays when you hover over the link on the dataform or system
object.

Display this Link when
adding

Prior to Save, dataforms generally do not display links. This option
allows you to display the link before the initial form Save. Single
dataforms with defaulted fields can appear as though they have been
saved before the database's actual record exists. If you configure a
link and it does not appear when you are testing, try saving the
dataform. If you want the link to always appear, regardless of whether
the dataform has been saved, select the Display this link when
adding option.

Pinned Open When this option is enabled (selected), it forces the link to display in
the Action Items area. The link does not collapse when the associated
group is collapsed.

Badge Counter Proc Select a stored procedure to display a count of the Active and Inactive
records for the Location.

Condition Expression Condition Expressions use Labels from Display Conditions along with
AND, OR, and NOT operators to control precedence and sequence.
You can create complicated Link Display Conditions using unique
combinations of the configured display conditions configured in the
Add section.

Using the Label field on the Link Display Condition, you can combine
trigger conditions into more complex expressions, overriding the
default OR behavior. For example: (Condition1 AND Condition2) OR
(Condition3 AND Condition4) OR Condition5. Link Display Conditions
that are not included in the Condition Expression are ignored.

The expression in this field is derived from the added conditions. See
Configuring Link Display Conditions.
For more information about Condition Expressions, see Condition
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expressions.

Project Code is set in Workspace Settings. Link configurations accept
ProjectCode or TemplateCode as a Field trigger, allowing you to use
Template Code to limit link display to all children of a given Template
or Project Code to limit displaying a single Client Workspace.

4. To add a link display condition, click Add.
Link display conditions might be used to control when the link appears, such as when the client is
in the approved status. For details on how to add a link display condition, see Configuring Link
Display Conditions.

5. To add link security, click the Security icon in the Action Center to access the Security Roles
window where you can add one or more roles and secure the custom link to unlimited roles. For
details on how to configure link security, see Configuring Link Security.

6. Click Apply or Save.

Related Topics:

l Custom Dataform Links to Try: Related Companies

Configuring Link Display Conditions
When you customize a link, you can control how and when it displays. Display conditions ensure that
your configured link displays only when and to whom you want. These link display conditions can
trigger either from a field on the dataform, or from a trigger value returned in a Header proc (custom
code developed by our development team). Display conditions appear in the Add section of the
Configure Links Detail form. You can add multiple display conditions.

By default, multiple display conditions are treated as OR statements when determining display behavior
unless a Condition Expression is configured for this link. Adding a Condition Expression makes the
triggering condition explicit, meaning that display conditions not included in the Condition Expression
are ignored. For a detailed explanation of how condition expressions work, see Condition expressions.
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In the Add area of the form, you define conditions using Source, Field, Operator, and Value. You
assign the condition a name using Label. Label values are used in the Condition Expression field
located before the Add area.

You can use multi-lookup fields for triggering conditions (Field and Value columns in the Add section).
Each value from the multi-lookup can be added as a separate = condition. This supports complex AND,
OR, and NOT conditions. The following image is an example of conditions using the = Operator and a
Condition Expression. The example specifies that both conditions SYR and NY must be met.

To configure link display conditions:

1. Click Add.
A row opens with the following fields: Source, Field, Operator, Value, and Label.

2. Complete the fields as appropriate.

Source This is where the system looks to find the trigger value that matches your condition.
The options are:
• Form Data: The system looks at the dataform to find the triggering field and

value.
• Header Proc (1 or 2): The system runs a stored procedure when the dataform

opens. Can pull information from other dataforms in the system.

Field This is the field that is interrogated for the trigger Value. The available fields are
determined by what you selected in Source.
You can use multi-lookup fields as triggering conditions. Each value from the multi-
lookup can be added as a separate = condition. This supports complex AND, OR,
and NOT conditions.
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Operator Operator options are dynamic and are driven by the combination of the Source and
the datatype of the selection in Field. For instance, when Source equals Form Data
and the Field is from a parent form (which means its datatype or Element Type in
Dataform Admin is "Parent Form"), the options available in the Operator field are
Empty, Not Empty, Equals, and Not Equals.

The complete list of possible operators is Does Not Equal, Empty, Greater Than,
Greater Than or Equal, Less Than, Less Than or Equal, and Not Empty.

Value This is the value in the trigger Field that evaluates to true and must match the value
stored in the database. Start typing a Value when Field is a parent form or a lookup.
Value can also be blank (Empty) when triggering links from Form Data, enabling
display conditions when a field is empty. Blank is only valid when the Source is Form
Data.

Label Provide a Label when building a condition expression in the Condition Expression
field. Examples of a Label could be Cond1, Cond2, Cond3. Additionally, you may
want to be more descriptive. If you are filtering for a city, then use the city name,
such as NYC, or use NY to represent a filter for the state. A best practice is to use
short names.

To clone a trigger:

1. In the Add section, locate an entry that you want to copy.

2. Click Clone.
A new row opens, with the trigger condition copied. Source, Field, and Operator are copied.

3. You can now edit the new condition as appropriate.
4. When ready, click Apply or Save.
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Searching Custom Links
From the Configure Links dashboard, you can search using Quick Search and More search. The search
looks for matches in the Location, Display Value, and Display Action columns.

To search the Configure Links dashboard:
1. Go to System Admin > Advanced > Custom Links.

The Configure Links dashboard opens.
2. In Quick Search, you can search using:

• equals: Finds the entry with the search string entered.
• starts with: Search for entries that start with the search string entered.
• contains: Use the % symbol to search fields with the search string that follows %.

3. Click More to add more search parameters.
The More search dialog box opens. Options in this dialog box reflect columns in the Configure Links
dashboard along with Security Entity and Keywords.

4. Select your options and click Search.

More Search provides:
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l Field-specific searches.
l Creates filter chiclets, which display your current search parameters.
l Filters are additive. For example, you can search for entries with Location Employee and

Display Value Terminate.
l The Show filter is standard across all searches. You can filter for Active, Archived (inactive),

and All records (both).

Custom Dataform Links to Try: Related Companies
The Related Companies link is a very helpful custom dataform link to add to your Client Master
dataform. The Related Companies link displays a popup of all companies related to a single parent
company and allows you to jump to the Client Master record of a related company.

Note: Advanced administrative access is required to set this link up, inactivate this link, or move this
link. If you need assistance setting up this link, please enter an extranet case.

Here's how it works!

First your Global Administrator must configure the Related Companies link to display on the
Client Master dataform (see Configuring Custom Dataform Links ).

Then, for ClientSpace to display related companies, you must identify parent and child relationships for
your companies. This is easily and quickly done on the Client Master dataform.

Identify a parent company by setting the Parent Company field of a parent company to itself.

In the example below, we have opened the Client Master record of a fictitious company named
MysteryMall and have set the Parent Company field to MysteryMall:
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Then, we set the Parent Company on the Client Master of other child companies to MysteryMall as
shown in the example below:
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Now, when we click the Related Companies link on the Client Master record of the parent or child
records, a list of related companies displays:

Clicking the up arrow next to a related company in the list opens the Client Master record.

Related Topics:

l Configuring Custom Dataform Links
l Searching Custom Links
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Chapter 9
Cases
Cases help you manage assignments and resolve issues - whether they are for internal to your
organization or relate to client issues. Case types are a way to group cases so that you can manage the
resolution by more effectively managing by types. Case discussions allow you to communicate
effectively with your clients in a conversational manner, directly from the case that they log. When you
use case discussions, you can keep much of the communication outside of the case but still connected
should you need to reference the discussions.

Configuring client service case discussions
ClientSpace supports Client Service Case (CSC) discussions, which are threaded discussions attached to
Client Service Cases designed to make communicating with external Case users more fluid. Discussions
support specific email templates that provide standard replies to common case types. This chapter
includes detailed information about configuring the API record, Email Integration, and the Email
Templates to automate and standardize your messages.
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Configuring the API
First, you need to set up an API configuration to allow the external discussion thread replies to attach to
ClientSpace and create the Client Service Case Discussion message. The purpose of the API record is to
sign in the external user for access to the case discussion threads.
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To configure the API fields:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. Click Add.
The New API Configuration form opens.

3. Complete the form fields required to configure Client Service Case Discussions.

API Type Select Web Service.

Application Code Select CSCDiscuss.

Application Name Type Client Service Case Discussion.

UserName Provide a username.

Password Provide an appropriate password.

Description Suggested description: Used by the Client Service Case Discussion process
to sign in an external user, allowing access to discussion forms and attached
files.

4. Click Save.
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Configuring Case Discussion Email Templates
Case Discussions use email templates to send the content of the Discussion Message to the designated
recipients. The email templates that make this happen are CSCDISC: Case Discussion, CSCRPLY: Case
Discussion Reply, and CSCDISCNEW: Case Discussion New. ClientSpace administrators can configure
these email templates to meet the needs of the organization. For example, you may need several reply
templates to address stop payment authorizations or payroll issues.

Send a Reply and Reply Above This Line

Recipients can reply to the email using an embedded Send a Reply link in the email message that
opens the discussion thread. The Send a Reply link is always available. Optionally, you can configure
ClientSpace to allow responses using the email mailbox Reply button. The Reply button initiates Reply
Above This Line functionality.

Reply Above This Line allows users to reply to a Case Discussion directly from their email mailbox using
the Reply button, as you would with any other email reply. This functionality requires additional
ClientSpace configuration for Email Integration. While the email templates (CSCDISC and
CSCDISCNEW) themselves do not require Email Integration, the reply above the line functionality does.
For Reply Above This Line to work, both CSCDISC and CSCDISCNEW must have a From Email Override
address that matches an Active Email Integration mailbox. See Configuring Case Discussion: Reply
Above This Line.
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Field Replacement

Case Discussion templates provide replacement field functionality represented as brackets { }. For a list
of the fields, see Client Service Case field replacement.

Accessing the email templates

To access the email templates:

1. Go to System Admin > Email Templates.
The Email Templates dashboard opens.

2. Locate the entries that begin with CSC.
3. Open and edit the email template, as noted in the following procedures.

CSCDISC: Case Discussion Template

CSCDISC is the wrapper for the outgoing message to the recipients indicated on the Discussion
Message. In a Discussion Message, the user can type their message in the Body section, and that
content is then merged in as the Comments of this email template. Alternatively, users can select a pre-
populated message from a list of CSCRPLY email templates. If one of those is selected, the body is
automatically populated and then merged into the Comments of the CSCDISC email template.

ClientSpace Setup & Administration © 2025 PrismHR 459

Chapter 9 Cases



The CSCDISC template is included as part of the PEO installation. The only required configuration is to
customize the Body and set the value in From Email Override if you are using reply above the line
functionality. See Configuring Case Discussion: Reply Above This Line.

To configure the email template for CSCDISC:

1. Complete the form fields.

Template Code Use CSCDISC for this template.

Template Name Use Client Service Case Discussion.

Description Use Client Service Case Discussion, wrapper for outgoing
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discussion, sent to external recipient.

From Email Override Specify an email address to override the default noreply address
commonly used by the system. The default Admin Email configuration is
stored in App Settings. For help configuring this setting, log an Extranet
case.

Subject This field indicates the subject line for the email that the system
generates by using this template. You can enter text and you can
configure the subject by using replacement fields.
By default this field contains the {CSCDISCSubject} replacement field.
The system uses this replace field to pull the subject content from the
case discussion message that triggered the email. With this replacement
field, the system can use the same subject for the discussion message
and the initial email that the system sends.
See Client Service Case field replacement.

Body Body uses a rich text editor and supports font styling, embedded
images, hyperlinks, lists, and tables. For best results, we recommend
embedding .jpg or .jpeg images.

Body contains a custom HTML table that holds appropriate field replace
characters from the generated Discussion dataform and can include:
l Discussion: Contents of the discussion Comments field. This can

be dynamically altered using field replacement in the selected
email template.

l Last Discussion: Previous discussion threads comments area.
l Reply To Url: Direct URL link to the Discussion page.
l Reply To Link: This link automatically signs in the user using the

API configuration and opens the appropriate discussion.

Note: You can use the {PreviousMessages} replacement field in the
body of the email template. Important: You should place the
{PreviousMessages} replacement field on the bottom line of the body
in the email template so that the previous messages display after the
current message.

2. Click Save.
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CSCRPLY: Case Discussion Reply Template

Use CSCRPLY to create customized reply templates for distinct categories of responses, such as an
authorization form for a stop payment. These categories can be as flexible as required by the business
case – from a series of 2 or 3 standard responses to specific responses for each case type. You can use a
CSCRPLY template within a CSCDISC template.

The templates CSCRPLY1, CSCRPLY2, and CSCRPLY3 are included in the standard PEO installation. You
can modify these templates to suit the needs of your organization. Additionally, to further customize
your template, you can add attachments to be included in Case Discussion replies and also display in
the Case Discussion thread. For example, let's say you have a template named CSCRPLYPayrollProblem
that you use for a generic payroll form that an employee or manager must complete. Attaching the
form to the template saves time and streamlines the process.
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To configure the email template for CSCRPLY:

1. Complete the form fields.
If you are adding a CSCRPLY template, for Type, select System.

Type Select System.

Template Code Template code must begin with CSCRPLY and must be unique. Can be
up to 100 characters in length.

Template Name Configure to suit business requirements. Displays when selecting Reply
Template from the internal discussion.

Description Configure to suit business requirements.

From Email Override Specify an email address to override the default noreply address
commonly used by the system. The default Admin Email configuration is
stored in application settings. For help configuring this setting, log an
Extranet case.

Subject Can configure using replacement fields. Formatted as WorkspaceName
- Template Subject Line. Any additional text can also be configured in
this line up to the limits of the field.

Body Body uses a rich text editor and supports font styling, embedded images,
hyperlinks, lists, and tables. For best results, we recommend embedding
.jpg or .jpeg images.

Use the HTML editor controls to customize each reply template.

You can also use field replacement to enhance customization. See Client
Service Case field replacement.

2. To add attachments, expand Attachments, and click .
The Upload File dialog box opens.

3. Click Choose File to upload a file, and then click Save.
4. To save your changes and close the template, click Save.

When viewing the Discussion Thread, a counter indicates if any attachments are present.
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How the templates work together

The following image shows how CSCDISC and CSCRPLY work together. Additionally, we also show you
how your custom text is added from the discussion message.

l CSCDISC is the standard template
l CSCRPLY is the reply template
l The customized message entered in the discussion New Message box appears below the reply

template content.

CSCDISCEMINT: Case to Email Reply
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CSCDISCEMINT is the message to external users when a discussion response has been posted to the
thread.

If the CSCDISCEMINT email template is unpublished, the system will send out a standardized response
stating: "Your ClientSpace Email Request has been received and processed. This is an automatically
generated email. Please do not reply." The CSCDISCEMINT template is part of the standard PEO
package.

This template is referenced in the Email Integration record, in the Action step. The template is included
in the standard PEO installation.
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CSCDISCNEW: Case Discussion New Template

CSCDISCNEW is used when a recipient replies to the Case Discussion. CSCDISCNEW is the email
template and wrapper that is used for the response to the Assigned To user's mailbox. CSCDISC is the
template that acts as a wrapper for the discussion recipients. Both templates can either:

l Act as the email content if no reply template is selected in the discussion OR
l Act to wrap the content of the selected reply template should the user completing the discussion

select a reply template
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CSCDISCNEW is included with a standard PEO installation.

To configure the email template for CSCDISCNEW:

1. Complete the form fields.

Template Code Use CSCDISCNEW for this template.

Template Name Use CSC Discussion New Reply Notification.

Description Use When external recipient sends a message, this is sent to the
AssignedTo user.
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From Email Override Specify an email address to override the default noreply address
commonly used by the system. The default Admin Email configuration is
stored in App Settings. For help configuring this setting, log an Extranet
case.

Subject Use New Discussion Created. This is the subject line of the inbound
email, which can be configured.

Body This is the contents of the inbound message. Body uses a rich text editor
and supports font styling, embedded images, hyperlinks, lists, and tables.
For best results, we recommend embedding .jpg or .jpeg images.
Body can be configured using the following field replacements:
l {LASTREPLY_Comments} - Include to capture the response from

the external user in the discussion.
l {LASTREPLY_FromEmailAddress} - Include to capture the sender

email address on email replies to case discussion emails.
l {LASTREPLY_FromName} - Include to capture the sender First

and Last name separated by a space on email replies to case
discussion emails.

Note: You can use the {PreviousMessages} replacement field in the
body of the email template. Important: You should place the
{PreviousMessages} replacement field on the bottom line of the body
in the email template so that the previous messages display after the
current message.

2. Click Save.

Client Service Case field replacement

Fields with { } indicate that you can use field replacement. Any of the following fields are available for
decode when constructing an email reply template.

{CaseNumber} {fkUserIDCreatedBy} Created By

{CaseDetails} This is a fieldset. {CreateDate}

{CreateTime} {EscalationDate} Level 1 Escalation
Date

{EscalationTime} Level 1 Escalation Time {Escalation2Date} Level 2 Escalation
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Date

{Escalation2Time} Level 2 Escalation Time {crCategory}

{ResolutionDate} {CaseAssignment}

{ResolutionTime} {fkCaseTypeID} Case Type

{fkUserIDAssignedTo} {fkContactIDClientContact} Client
Contact

{PhoneNumber} {CallerName}

{IncludeinNotification} {luStatus}

{EmailAddress} {CaseAudit}

{luPriority} {DueDate}

{BrokerContact} {fkEmployeeID}

{Subject} {CaseInfo} This is Description.

{Resolution} {InternalNotes}

{CaseNotes} {CommunicationMethod}

{luClientSatisfied} {hasNotificationsDisabled}

{HoursToComplete} {GenKey} This is ID of the current case
record.

{RowGUID} {IsActive}

{fkProjectID} {_GenKey}

{DateCreated} {DateUpdated}

{ImportID} {_UpdatedByUserNameDecode}

{_RowDecode} {AttributeTableName} Name of the
table, such as gen_ClientServiceCase.

{pkClientServiceCaseID}

The following fields are also decoded.

{ClientNumber} {PEOID}
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{Org_Name} {Org_Address1}

{Org_Address2} {Org_City}

{Org_State} {Org_Zip}

{CSC_DateCreated} {CSC_DateUpdated}

{CSC_UpdatedByFullName} {CSC_UpdateByFirstName}

{CSC_UpdateByLastName} {CSC_CaseNumber}

{CSC_TimeCreated} {CSC_Escalation2Date}

{CSC_Escalation2Time} {CSC_EscalationDate}

{CSC_EscalationTime} {CSC_CreatedByFullName}

{CSC_CreatedByFirstName} {CSC_CreatedByLastName}

{CSC_ResolutionDate} {CSC_ResolutionTime}

{CSC_BrokerFullName} {CSC_BrokerFirstName}

{CSC_BrokerLastName} {CSC_CommunicationMethod}

{CSC_Category} {CSC_DueDate}

{CSC_ClientContactFullName} {CSC_ClientContactFirstName}

{CSC_ClientContactLastName} {CSC_EmployeeFullName}

{CSC_EmployeeFirstName} {CSC_EmployeeLastName}

{CSC_AssignedToFullName} {CSC_AssignedToFirstName}

{CSC_AssignedToLastName} {CSC_AssignedToTitle}

{CSC_Status} {CSC_Priority}

{CSC_Phone} {CSC_Resolution}

{CSC_Issue} {CSC_Subject}

{CSC_CaseType} {CSC_FormLabel}

{CSCDISCSubject}
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Configuring Case Discussion: Reply Above This Line

The Reply Above
This Line
functionality is an
optional method
for replying to
case discussion
messages. The
reply is through
the email
mailbox Reply button, as you would normally reply to any email message. When you type the response
and send it, the message is integrated with the ClientSpace case discussion thread.

The Reply button method is more direct than that of the original method, Send a Reply link, which is
embedded in the email message. Both methods are shown in the accompanying image. The Send a
Reply link is always available and does not require additional configuration. However, using the Reply
button requires an Email Integration record with a mailbox address that matches the From Email
Override address in the CSCDISC and CSCDISCNEW email templates.

The
accompanying
diagram
illustrates an
overview of the
configuration
steps for using
the Reply button.
The first step is to activate a rule and disable an older rule. Next you will configure the Email Integration
mailbox. Then you add the Email Override address. The configuration steps for using the Reply button
follow.
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Step 1: Configure the rules

In this step, let's activate SendReply and disable SendEmailIntegrationReply.
SendEmailIntegrationReply is an older rule that has been replaced with SendReply.

To activate SendReply:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Filter the list for the Table Name Case Discussion Message with the Rule Title SendReply and
click (Jump).
The Rules Detail form opens.

3. Complete the fields:

Execution Pipeline Select Default and EmailIntegration.

Active Select this option to enable the rule.

4. Click Save.
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Next, you must disable SendEmailIntegrationReply.

To disable SendEmailIntegrationReply:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Filter the list for the Table Name Case Discussion Message with the Rule Title
SendEmailIntegrationReply and click (Jump).
The Rules Detail form opens. If you cannot find the rule, it may be archived. In More Search,
select All and click Search.

3. Clear the Active option (disables the rule). See the following image.
4. Click Save.
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Step 2: Configure the Email Integration Mailbox

The Email Integration record is where you configure the mailbox for routing the discussion messages.
The email address for the mailbox is also set in the case discussion email templates CSCDISC and
CSCDISCNEW.

Our example shows a mailbox with a Username payroll.bigtimepeo@gmail.com. We will refer to this
email address in the next step.

To configure the mailbox:

1. Go to System Admin > Email Integration.
The Email Integration dashboard opens.

2. Click Add.
The New Email Integration form opens.

3. Complete the form fields.

Mailbox  Required. The email address for the email account with which you would
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like to integrate. Email addresses are case insensitive and must be in a
valid format. This address must be attached to a supported email
provider (such as Gmail, AOL). The address must be an actual email
address associated with this mailbox and not an alias for the mailbox.

Later in the configuration process, an email alias is created using this
email address. The alias provides to ClientSpace the default values for
the workspace, project type, and client.

Password Required. The user account password. Depending on the email provider,
this field may be case sensitive, so ensure that you use the appropriate
case when you enter the value.

When editing an existing credential, the Password field is hidden. To
change the password, see Edit a credential.

Host  Required. The IMAP mail host for the mail client. This setting is used
when connecting to the mailbox. For information on your IMAP host
settings, contact your mail provider.

Port Required. The secured firewall port used by your provider to allow
access to the mailbox. Most IMAP providers use Port 993, so we default
the field to this.

Use Secure Connection
(HTTPS) 

Connect to the mail provider over the internet via unsecured (HTTP) or
secured (HTTPS) access. Defaults to selected (secured).

Configuration Name  Required. Should contain the application name associated with the
application code. This name will appear in Lists, so it should provide a
hint at the mailbox association.

Description Required. Should contain a brief description of this credential.

Test Connection  Test Connection is disabled until all required fields are completed, at
which point the button color indicates it is ready for use.
Select Test Connection to ensure the connection information connects
to the mailbox successfully before proceeding to the next step. A
successful test presents the message: We were able to connect to your
mailbox.

Unsuccessful tests yield an error message. Some examples of common
errors and their causes:
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l xm001 NO [AUTHENTICATIONFAILED] Invalid

credentials (Failure) - Bad username or password
l No such host is known - Bad hostname
l Object reference not set to an instance of an

object. This message is more generic but is most commonly
caused when a secure connection is required, and the Use Secure
Connection option is cleared.

Before deleting a credential, you must ensure that it is not associated
with any email aliases, else an error will be logged.

4. Select Active. This enables the Email Integration.
5. Click Apply.

The Alias step opens. An Email Integration record can have multiple aliases on a mailbox. The
email address is how it connects to the mailbox. The alias defines what it does with the mailbox. In
this step, specify the email address to match an email mailbox, such as
payroll.bigtmepeo@gmail.com. You will use this email address in the email template
configuration (next topic).

6. Select both options: Default Alias and Include Attachments.
7. Click Next.

The Action step opens.
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8. Complete the form fields.
For Business Object, ensure that you specify
ClientSpace.PEO.Business.EmailIntDiscussionMsg.

Workspace Required. Contains the workspace that will be used by this email alias for the
dataform creation if no matches for the sender's address are found. This is the
default workspace used during the processing of the email. This value may be
overridden by including the workspace in the body of the email. The override
value must contain a valid workspace ID and be formatted as WSID=# with no
spaces between the WSID= and the workspace ID. 
• Select a workspace from the list.

Reply Template Required. Must contain the reply template to be used to send the process
complete notification. Select a Reply Template from the list. This can be an
existing triggered template, or you can create one just for this reply. See
Configuring the Email Integration Reply Template.
l For case discussions, select Case to Email Reply.

Business Object Required when implementing Reply Above This Line functionality. Set the
value as ClientSpace.PEO.Business.EmailIntDiscussionMsg.

The ClientSpace.PEO.Business.EmailIntDiscussionMsg business object reads
the inbound email and connects it to the appropriate discussion thread. This
business object performs the heavy lifting, so it is important it is properly
configured.

If Always Use Default Workspace is not selected and the business object is
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configured, the system checks the body of the email for the CSID / WSID
information. If no match is found, the system uses the Email Integration
Processing hierarchy to determine which workspace is used when creating
the new dataform.

Always Use
Default
Workspace

When selected, this option forces the system to use the default workspace set
in the Workspace field, regardless of the other methods of workspace
selection.

Dataform Required. Contains the project type associated with this email alias. This
determines what type of dataform to create. Select the Project Type from the
list.
l For case discussions, select Case Discussion Message.

9. Click Save. You do not need to complete the Field Mapping step.
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Step 3: Configure the Email Templates

The email
templates for
case discussions
are CSCDISC:
Case Discussion,
CSCDISCNEW:
Case Discussion
New, and
CSCRPLY: Case
Discussion Reply.
These templates
are already
configured for
case discussions. However, you need to set a value in CSCDISC and CSCDISCNEW for the From Email
Override address, which is the connection to the Email Integration Mailbox (see the accompanying
image). The From Email Override address in the email template CSCDISC and CSCDISCNEW must match
the Mailbox address that you specified in the Email Integration record. Our example uses
payroll.bigtimepeo@gmail.com. In this topic, you will edit From Email Override in the email templates
CSCDISC and CSCDISCNEW.

To configure the From Email Override:

1. Go to System Admin > Email Templates.
The Email Templates dashboard opens.

2. Locate and open CSCDISC Client Service Case Discussion (click (Jump)).
The email template opens.

3. In From Email Override, enter the email address that you set in the Email Integration record. Our
example uses payroll.bigtimepeo@gmail.com.
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4. Click Save.
5. Repeat the procedure for CSCDISCNEW and Save.
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Step 4: Review the Email Integration scheduled process

The scheduled process for email integration is named Process Email Integration. When the scheduled
process runs, it sweeps through the mailbox looking for unread messages, grabs the information such
as the From and To address, and the body of the email. It then uses the Email Integration record that is
related to the email address, such as payroll.bigtimepeo@gmail.com. It references the Alias and Action
parts of the Email Integration record (as shown) and processes accordingly.

For case discussions, it creates a Case Discussion Message. The Business Object logic directs it to look
for a ReplyID in the Subject line that matches a case discussion that already exists and then updates
that case discussion. When a user responds, it uses the Reply Template Case to Email Reply.

To review the scheduled process configuration:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. Open Process Email Integration (click (Jump)).
The Process Email Integration form opens.

3. Review the Frequency, Frequency Type, and Valid Days.
Typically, you want this to run every minute, every day of the week.

4. For any changes, please log an Extranet case.
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Reviewing how this works

This diagram
illustrates the
ClientSpace
process to
determine if case
discussions are
integrated into
the case
discussion thread
when using the Reply button. This diagram shows a successful result when configuration steps are
followed, and what happens if the configuration process is not followed.

Configuring the Case Discussion Thread Logo
Optionally, you can add a logo that displays in the upper left corner of the discussion thread.
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To configure the logo:

1. Go to System Admin > Administrative Data > PEO Configuration.
The PEO Configuration form opens.

2. Complete the following fields in the "PEO Feature Administration" section.

Discussion Logo Select your logo file.

Note: You must resize your logo file to the proper display size before
uploading the file.

a. Click (Upload File).
The Upload File dialog box opens.

b. Click Choose File.
c. Locate the file on your computer and click Open.

The file name displays.
d. Optional: For Description, type a description of the uploaded file.
e. Optional: For Category, select an entry from the list.
f. Click Save.

Enable Logo for
Discussion

Click the Enable Logo for Discussion checkbox.

3. Click Save.

Configuring "Exclude Attachments" Functionality
Optionally, you can set up the SendReply OR SendEmailIntegrationReply business rule to suppress
attachments on case discussions.

ALERT: SendReply and SendEmailIntegrationReply business rules are not compatible with
each other. SendEmailIntegrationReply is used for the original version of the Case Discussions.
It embeds a Send a Reply link in the email message. The newer SendReply business rule still
supports the embedded Send a Reply link in the email message but also adds a "Reply above
this line"/ Reply button at the top of the case discussion email thread. (See Configuring Case
Discussion: Reply Above This Line for more details.) When configuring "Exclude Attachments"
functionality, make sure you are configuring it only on the business rule your company uses.
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To configure "Exclude Attachments":

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Filter the list for the Table Name Discussion Message, highlight the Rule Title SendReply or
SendEmailIntegrationReply as applicable and then click (Jump).
The Rules Detail form opens.

3. Under Method Parameters, click the ExcludeAttachments checkbox to place a check mark in it.

4. Click Save.

Configuring the Discussion Links

To configure the discussion links:

1. Configure the Header Proc on the Client Service Case (if not already done).
2. Configure the Dataform Links.
3. Dataform links to the Case related discussion dataform and Discussion list.
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Case Related Discussion

1. In Custom Function, type clientServiceCase.showDiscussion.

Link Display Condition

If both the Case AssignedTo user and the Associated Contract on the case have an email address:

1. Set Show Discussion to True.
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Finding your case types
You can run a
Business
Intelligence (BI)
report to list your
organization's
case types,
categories, and
any notes. You
can run the
report in BI or
from the Client
Service Case
Details page,
which can be
accessed when
adding or editing
a Client Service
Case.

Report
security: By
default, all users
can run the
report and view
the output. If
changes to the
report are
needed, a Global
Admin can save the report as a new report and make the necessary changes.

To run the report from BI:

1. On the modules bar, click Bus Intelligence.
Business Intelligence opens in a new tab.

2. In the left pane, select Administration.
The Case Type Definitions report appears.

3. Click Case Type Definitions.
The report opens.
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To run the BI report from Client Service Cases:

1. On the modules bar, go to Workspaces.
The Workspace Search dashboard opens.

2. Select a Workspace and click (Jump).
The Workspace opens.

3. On the Client Service Cases widget, click (View Client Service Cases).
The Client Service Case dashboard opens.

4. To add a case click Add. To edit a case, click Edit.
The Client Service Case form opens.

5. On the page banner, click (Help).
The Help list opens.

6. In the list, click Case Type Definitions.
Your BI report opens in a new tab, showing the Case Type Definitions (Administration) report.
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Configuring Case Types
You can add case types with default values so that when your users add cases, some of the fields are all
set! To add client service case types, you must be a Global Admin and assigned a role with Edit rights to
the Client Service Case Type (gen_AdminCaseTypes) form. To view a list of your case types, see Finding
your case types.

To add client service case types:

1. Go to Admin Workspace.
There is more than one way to access the Admin Workspace:

o From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

o Type "Admin" in the search box to filter the list of workspaces and locate Admin
Workspace.

OR
o On the modules bar, on the right side, click <username> > Modules.

The Modules Search dashboard opens. The Admin Workspace is listed at the top of the
dashboard.

2. In the Search for Dataform section, search for Client Service Case Type or select Client Service >
Client Service Case Type.
The Client Service Case Type dashboard displays.

3. Click Add to add a new case type or click Edit to update an existing case type.
The Client Service Case Type form opens.

4. Complete the form as required:

Fieldset Field Description

Case Type Details Title Enter a title for the Case Type.

Category Select a category for the Case Type.

Secure When the Case Type is secured, the system
generates a CaseType_#TypeName# security
entity that can then be used to provide
secure case type access to users other than
those directly associated with the Case Type.
(The Assigned To user as well as Users in the
Notification role, Escalation Level 1 or
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Fieldset Field Description

Escalation Level 2 roles always have rights
to the case regardless if it is a secure case
type.) Refer to Case security for additional
details.

Generates Distress Call Configured Client Service Case Types that
have the Generates Distress Call option
selected automatically creates a Client
Rescue record and relates it to the case.
The Owner of the Client Rescue record is
determined by the user who is defined in the
Distress Call Owner role. This role should
only contain one user.

Default Subject The Default Subject field can be used to set
the Subject line for the Case Type in question
on create. After this field is filled, the subject
line no longer defaults. This is by design. We
want to preserve any additional information
that may have been added.

Default Issue The Default Issue field can be used to set
the Issue field for the Case Type in question
on create. After this field is filled, the Issue
field no longer defaults. This is by design as
we want to preserve any additional
information that may have been added.

Case Type notes Enter notes about the case type.

Disable Notifications Select the Disable Notifications option to
disable notifications to users or roles
associated with the case type.

Due Date Offset The Due Date on the case is can
automatically set using the Due Date Offset
days you enter here.
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Fieldset Field Description

For instance, if you want the Due Date on
the case to be automatically set as 5 days
from the date the case was created or
updated, enter 5 here.

ClientSpace business logic applies the Due
Date Offset based on Case Type and sets
the date automatically on Save if the Due
Date field on the case record is currently
empty. If the Due Date has been set
manually, it will not be overwritten.

Due Date Offset
Method

Select Calendar Days to calculate the Due
Date Offset using calendar days. This
method includes non-business days and
company holidays in the Due Date Offset
calculation.

Select Business Days to calculate the Due
Date Offset using business days. This
method excludes non-business days and
company holidays from the Due Date Offset
calculation.

Note: Business days are as configured in
your ClientSpace install settings and
company holidays are configured in your
Company Holiday table (System Admin >
Company Holiday). If you require help with
these settings, please log a case with your
Professional Services representative.

Require Employee When Require Employee is checked, the
Employee field on Client Service Case: Add
window and the Quick Case window are is
required for data entry. The Employee field
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Fieldset Field Description

label also displays in red indicating that it is a
required field.

Label Override Contents of this field will be displayed
instead of the Case Type Title when this case
type is exposed in PrismHR . If blank the
Employee Portal will display the Title of this
case type.

Case Type Billing Billable? TBD

Avg. Hours To
Complete

TBD

Cost Rate TBD

Default Assignment Default Assignment,
Assigned To User,
Assigned To Field,
Backup Assignment,
and Backup Assigned
To

Note: The fields in the Default Assignment
fieldset change depending on the selection
in the Default Assignment field.

When you assign a case, you can specify the
Default Assignment as Creator, Single User,
or Client Role.

o Creator: Defaults the Assigned To
user on the case to the person that
creates the case.

o Single User: Defaults to the user
selected in the Assigned To User
field.

n The Assigned To User field
displays as a required field
once Single User is selected.

n Selecting Single User also
causes the required field,
Backup Assignment, to
display. You can select an
assignment type of Single
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Fieldset Field Description

User or Client Role.
n Once the Backup

Assignment is set, the
Backup Assigned To field
displays. It is also a required
field. This is where you select
the backup user or role based
on the backup assignment
type selected.

o Client Role: Defaults to the user
determined by the Client Team role
selected in the Assigned To Field.

n The Assigned To Field
displays as a required field
once Client Role is selected.

n Selecting Client Role also
causes the required field,
Backup Assignment, to
display.) You can select an
assignment type of Single
User or Client Role.

n Once the Backup
Assignment is set, the
Backup Assigned To field
displays. It is also a required
field. This is where you select
the backup user or role based
on the backup assignment
type selected.

Backup Assignment ensures that if the
selected Single User or Client Role is not
valid (i.e., is blank, Inactive, or Expired), the
case type defaults to a meaningful value
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Fieldset Field Description

using the following validation order:
o Validation Step 1: If the Default

Assignment on the Case Type
Assignment record is Single User and
that user is valid, the Assigned To
user on the case displays the default
assigned single user.

o Validation Step 2: If the Default
Assignment on the Case Type
Assignment is Single User and that
user becomes invalid, the Assigned
To user on the case displays the user
or role from Backup Assigned To
field.

o Validation Step 3: If the Backup
Assigned To field user or role is
invalid, the Assigned To user on the
case displays the Manager of the
responsible department from the Case
Type category metadata associated
with the case type. For example, if the
Category field on the Case Type
record for 401K is "Benefits", the
system will check the Department
Admin/Department Details record for
"Benefits" and display the name
shown in the Manager field as the
Assigned To user on the case.

o Validation Step 4: If no valid default
assignments can be found, the
Assigned To field will be left blank,
and the following error message
displays when you click Apply or Save
on the case: "There is no Assigned To
selected and the associated case type
does not have a default user selected.
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Fieldset Field Description

Please either set a default user on the
case type or select an Assigned To
user. "

Roles Notification Role Select the user role that should receive case
type notifications on this Case Type.

Assigned To Field If a role is selected, when the Case Type is
changed on a Client Service Case record, the
list of users available in the Assigned To
field will be updated to only the users in the
configured role.

Escalation Level 1 Role This role will be used in the Level 1 escalation
of this Case Type.

Escalation Level 2 Role This role will be used in the Level 2 escalation
of this Case Type.

Case Type Exposure
Setup

Case Type Visible to
External Users

Exposes the case type to the user for the
purpose of Case creation. If this option is not
selected, external users do not have this case
type as an option when creating a case.

Allow External Access to
This Case Type

Allows External users that are involved in the
Case (CreatedBy, AssignedTo, or Owner)
access to see and open the Case from the
External Case Dashboard.
External Case Creators always have access to
view the cases they create, if the Case Type
remains one which is exposed to external
users.

Expose Case Type in
PrismHR Previously, when this checkbox was checked,

it allowed a case type to be selected in the
PrismHR Employee portal widget. If checked
you could also change the displayed case
type title using the Label Override field.
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Fieldset Field Description

Now, this field has been replaced by the
Expose to Portal field. It no longer
determines if a case is used in the PrismHR
Employee Portal as of Release 143. The field
will be removed from the Client Service Case
Type form in a future release.

Expose Case Type to
Quick Case

Check this box to allow this case type to be
selected from the Type field of the

Quick Case window. (The Quick Case
feature is accessible from the Cases
dashboard and is used for quickly adding a
case using minimal required fields.)

Case Type Position Tags Case Type Position Tags allow you to
choose which case types are visible to portal
users by their PrismHR User Type. Both the
Manager and Employee tags are set by
default. To display a Case Type to only one
group, remove one of the default tags from
the Case Type Position Tags field as
applicable on each Case Type record.

Expose to Portal The Expose to Portal field allows you to
identify which case types can be selected in
the HCM and/or Prism portals. Select HCM to
make the Case Type available for selection
in the HCM portal only. Select Prism to make
the Case Type available for selection in
Prism portal only. Or, select both HCM and
Prism to make the Case Type available for
selection in both the HCM and Prism portals

5. Click Save.
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Video
View the video about Configuring Case Types.

Configuring case type subscriptions
ClientSpace provides the ability to select Case Type subscriptions (within security limits), which means
you can subscribe to a given case type and if you have security appropriate to see the case type you will
be notified when cases of this type are created. This topic describes Case Type Subscriptions and how
to manage them through the Case Type Subscriptions module.

An administrative Case Type Subscriptions allows users to subscribe to specific case types either by
individual workspace (filtered by the workspaces to which the selected user has access ) or by selecting
My Clients, which subscribes the user to the selected case type for any workspace where they are a
member of the Client Team role in workspace security settings.

To configure case type subscriptions:
1. From the modules bar, select Case Type Subscriptions. You may need to select it from the View

list.
The Case Type Subscriptions dashboard opens.

2. Click Add.
The Subscription Selection form opens.

3. Complete the form fields. All fields are required.
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User Global Admin users can either subscribe themselves in the same way or add
subscriptions for other users by selecting a different user in the list. Altering
user selection is limited to Global Admin users.

Workspace This is a filtered list of workspaces for the selected user. My Clients
subscribes to workspace where the selected user is in one of the fields on the
Client Team dataform. Select a Workspace.

Category and Type Select the Category and Type of case to which you would like to subscribe.

4. Click Save.
The Case Type Subscription follows the ClientSpace security model. Users cannot subscribe to or
receive notifications for any case type to which they do not have access.

Configuring Case Category Metadata
The Client Service Case Category Metadata form allows you to specify metadata that can be used to link
case category information directly to a particular code or drive business logic related to cases types
within a case category.

Adding Case Categories

To add client service case category metadata:

1. Go to Admin Workspace.
2. In the Search for Dataform section, search for Client Service Case Category Metadata or select

Client Service > Client Service Case Category Metadata.
The Client Service Case Category Metadata dashboard displays.

3. Click Add to add a new Case Category Metadata record or click Edit to update an existing Case
Category Metadata record .
The Client Service Case Category Metadata form opens.

4. Complete the form as required. Required fields are shown in red:

Field Description

Category Case type category. Example: Assign all accounting related case types, such as
Invoice Question and Banking Issues, to a case category named Accounting.
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Field Description

Short
Name

A "nickname" for a case category. Example: Assign a Short Name of Acct for the
Accounting case category. Once assigned, the Short Name is appended to the front
of the case type and can be used in typeahead selection lists and searches to filter
values and expedite data entry. In the example image below, entering "acct" in a
typeahead selection list filters the selections to only display values with the "Acct"
Short Name.

Workspac
e Group

Click in the field to select one or more workspace groups. Indicates the workspace
group to associate with the case category and controls whether the case types
associated with that case category are available for selection when adding and
managing cases. For example, you may determine that case types in the Accounting
category may only be associated with the Clients and Prospects workspace groups.
As a result, the case types in the Accounting category are available as a case type
assignment when managing Client and Prospect workspaces but are NOT available
when managing Internal workspaces.

Avg Bill
Rate

Enter the Average Bill Rate for the services represented by the case types within this
case category.

Default
Time
Tracking
Category

Select the default time tracking category used for this case category.

Responsib
le
Departme

Assign the department responsible as the backup assignment when both the
Assigned To user and the Backup Assigned To user on a case become invalid (i.e.,
are blank, Inactive, Expired, or marked "Out of Office). The system will assign the
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Field Description

nt manager of the Responsible Department listed on the Case Category Metadata
record as the Assigned To user for the case.

5. Click Save.

Configuring the Quick Case Feature
Some of the elements which support the Quick Case feature can be configured by a Global
Administrator.

Client Service Case Types
On the Client Service Case Type form, review the following configuration:

l Specify the case types users can access from the Quick Case Type field list by setting the Expose
Case Type to Quick Case flag on the Client Service Case Type form.

l Optionally, set the Require Employee flag on the Client Service Case Type form of each case
type where you want to make the Employee field required for data entry.

For details on updating Client Service Case Type records, see Configuring Case Types.

Client Service Case Category Metadata
On the Client Service Case Category Metadata form, optionally add a Short Name for each case type
category on the Client Service Case Metadata form. This allows users to filter the Quick Case Type field
lookup list by case type category Short Name during data entry.

For details on updating Client Service Case Category Metadata, see Configuring Case Category
Metadata.

Quick Case Window Access Permissions
Add Quick Case window access permissions. Access permissions to the Quick Case dialog are controlled
by a new security entity: biz_ClientServiceCase_QuickCase. Add the entity to desired roles and
configure the entity to match role requirements.

For more details on updating role security, see Administering role security.
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Related Topics: 

l Adding a Quick Case

Learning how: Configuring Case Escalation
Responding to client requests in a timely manner can make all the difference to your clients' perception
of your customer service. One way to ensure that cases are handled quickly and efficiently is through
case escalations. This gives you the administrator the ability to configure cases to automatically escalate
if there has been no action on a case in a specified time. This is done through case escalation.

Escalation is configured through the admin workspace and can be configured either very broadly at the
category level or very granularly all way down to case type. Regardless of whether case escalation is
configured at the category or case type level, escalation triggers based on updates to the case within a
configured time threshold. What this means is you can set cases to escalate at different rates based on
the conditions you select at the category or case type level.

View the video about Configuring Case Escalation.

Configuring recurring tasks
You may have a task that needs to be performed repeatedly within a workspace, perhaps once a day, or
once a year. You can set up recurring tasks at the workspace level to automate the process.

To configure recurring tasks:

1. Go to a workspace.
2. In the Action Center, expand My Tasks, and click Add Task.

The New Task form opens.
3. Complete the task fields and click Apply.

4. In the Action Center, click (Configure Recurrence).
The Select a Recurrence Pattern dialog box opens. You can set the task to recur Daily, Weekly,
Monthly, or Yearly.
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5. Complete the fields:

Interval Every n days/weeks/months/years, create this task.

Start Date Offset Start n days/weeks/months/years.

Due Date Offset Due n days after the first day of the month/week/month/year.

Recurrence
Configuration

Options vary depending on what you selected for Interval.
l Daily: Weekdays Only means that the task is only created during the

week.
l Weekly: Select the day or days of the week.
l Monthly: Select Date of Month or Day of Month. Your selection

then presents On Date of Month or Every x Sunday, Monday
Tuesday, Wednesday, Thursday, Friday, Saturday of the month
(respectively).

Recurrence Pattern Displays a synopsis of how you configured the pattern.

6. Click Save.

After you set a recurring pattern, it becomes read-only. To change the recurring pattern, you must
delete the recurrence and reset the pattern.

Learning how: Configuring Recurring Tasks
You may have a task that needs to be performed repeatedly within a workspace, perhaps once a day, or
once a year. You can set up recurring tasks at the workspace level to automate the process.

Video

View the video Configuring Recurring Tasks.
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Chapter 10
Configuring ClientSpace for the Employee
Support Center
The PrismHR Employee Support Center provides a portal for employee self-service for items, such as
requesting vacation and reviewing benefits. The Employee Support Center allows you to set up a direct
way for your worksite managers and employees to submit questions to your team. This functionality
utilizes the ClientSpace Client Service Module to process those cases and allows your internal team to
process requests and questions efficiently. Additionally, the Employee Support Center allows
employees to submit questions that are then processed as ClientSpace Cases.

To enable the self-service functionality, you must configure the Employee Support Center and
ClientSpace. This topic guides you through the ClientSpace configuration, which involves configuring
the case types on the Client Team dataform for employee questions processed as Cases. To learn more
about the PrismHR Employee Support Center, see the PrismHR documentation on the CRC.

Configuring Case Types
You can configure any case type to be exposed to the Employee Support Center. Case types that you
enable in ClientSpace (Case Type Visible to External Users) determine what users see in the Submit a
Question dialog box on the Employee Support Center. Additionally, you must enable the option Expose
Case Type in PrismHR.

To configure:

1. Go to System Admin > Administrative Data > Case Type. In some systems, Case Type may
be listed as Client Service Case Type.
The Client Service Case Type dashboard opens. You can configure any case type to be exposed to
the Employee Support Center.
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2. Open a case type (select and click (Jump)).
In our example, we selected Client Name Change. Our example shows that the value for Label
Override was changed to "Request Name Change", which is what the user will see as an option
when submitting a question or request. We also enabled the options Case Type Visible to
External Users and Expose Case Type in PrismHR. (See the table below for field definitions.)
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3. Complete the form.

Default Subject Leave blank. This field populates directly from the Support
Center, Submit a Question.

Default Issue Leave blank. This field populates directly from the Support
Center, Submit a Question.
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Case Type Visible to External Users Enable this option to allow users to create cases for the
selected type: Employee Question, General Question, and
Manager Question. If disabled, the case type does not
appear in the Case Type lookup on the Support Center.

Expose Case Type in PrismHR Enable this option to allow users to select this case type on
the Support Center. You can also change the displayed
case type title using the Label Override field.

Label Override Specify a different label for case type. This field applies
when you enable Expose Case Type in PrismHR. If blank,
the title of the case type is displayed.

Default Assignment Note: The fields in the Default Assignment fieldset
change depending on the selection in the Default
Assignment field.

When you assign a case, you can specify the Default
Assignment as Creator, Single User, or Client Role.
l Creator: Defaults the Assigned To user on the case

to the person that creates the case.
l Single User: Defaults to the user selected in the

Assigned To User field.
o The Assigned To User field displays as a

required field once Single User is selected.
o Selecting Single User also causes the required

field, Backup Assignment, to display. You can
select an assignment type of Single User or
Client Role.

o Once the Backup Assignment is set, the
Backup Assigned To field displays. It is also a
required field. This is where you select the
backup user or role based on the backup
assignment type selected.

l Client Role: Defaults to the user determined by the
Client Team role selected in the Assigned To Field.

o The Assigned To Field displays as a required
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field once Client Role is selected.
o Selecting Client Role also causes the required

field, Backup Assignment, to display.) You
can select an assignment type of Single User
or Client Role.

o Once the Backup Assignment is set, the
Backup Assigned To field displays. It is also a
required field. This is where you select the
backup user or role based on the backup
assignment type selected.

Backup Assignment ensures that if the selected Single
User or Client Role is not valid (i.e., is blank, Inactive, or
Expired), the case type defaults to a meaningful value using
the following validation order:
l Validation Step 1: If the Default Assignment on

the Case Type Assignment record is Single User and
that user is valid, the Assigned To user on the case
displays the default assigned single user.

l Validation Step 2: If the Default Assignment on
the Case Type Assignment is Single User and that
user becomes invalid, the Assigned To user on the
case displays the user or role from Backup Assigned
To field.

l Validation Step 3: If the Backup Assigned To field
user or role is invalid, the Assigned To user on the
case displays the Manager of the responsible
department from the Case Type category metadata
associated with the case type. For example, if the
Category field on the Case Type record for 401K is
"Benefits", the system will check the Department
Admin/Department Details record for "Benefits" and
display the name shown in the Manager field as the
Assigned To user on the case.

l Validation Step 4: If no valid default assignments
can be found, the Assigned To field will be left blank,
and the following error message displays when you
click Apply or Save on the case: "There is no
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Assigned To selected and the associated case type
does not have a default user selected. Please either
set a default user on the case type or select an
Assigned To user. "

Case Type Position Tags Case Type Position Tags allow you to choose which case
types are visible to portal users by their PrismHR User Type.
Both the Manager and Employee tags are set by default. To
display a Case Type to only one group, remove one of the
default tags from the Case Type Position Tags field as
applicable on each Case Type record.

4. Click Save.

What else can you do with this?
l Email Templates: You can configure Email Templates for the selected Case Types to send

notifications when a question is submitted through the Employee Support Center. See Email
Templates: Basic Configuration.

l Case Discussions: You can configure Case Discussions to provide standard replies to your
Employee Support Center case types and possible avenues of communication with the employee
that submitted the case. See Configuring client service case discussions.

Learning How: Creating Cases in the Employee Portal
Support Center
This video walks you through how to create a case in the Employee Portal Support Center.

Video
Watch the video Creating Cases in the Employee Portal Support Center.
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Chapter 11
Business Intelligence Admin Dashboard
The Business Intelligence Admin dashboard provides Business Intelligence functionality directly from
the Admin dashboard. To access this dashboard, you must be a system administrator.

To access Business Intelligence Admin:

1. Go to System Admin > Outputs > Business Intelligence.
The Business Intelligence Admin dashboard opens.

2. To search, you can do any of the following:
n Sort by columns.
n Use Quick Search.
n Use More search to search by Name, Category, Report Type, XML, Last Run User and Date,

and Last Design User and Date, Attribute Type and Value.
3. To search by Report Type, you can enable the column Report Set Type or use More search.
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The Report Set Type column appears. Types are Report, Dashboard, Scheduled, and Datasource.

To view reports:
l Select the report and click Run.

The report opens in Business Intelligence, in View mode.
To edit reports:
l Select the report and click Edit.

The report opens in Business Intelligence, in Design/Edit mode.
To delete reports:
l Select the report to delete and click Delete.

The Delete Report confirmation window displays.
l Click Yes to delete the report.

Note: Global Admin users cannot delete the following:

o Reports with the PHR_SystemAdmin Role (secured for PrismHR)
o Reports that are configured as datasource reports
o Reports that are used in a BI widget
o Reports that are used in a Dashboard

If a Global Admin user attempts to delete a report that meets at least one of the above-
mentioned criteria, a message displays to the user and they are prohibited from proceeding.

To mark a report "Do Not Archive":
l Click the checkbox in the Do Not Archive column next to the reports you want to exclude from

being archived.
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The report becomes exempt from being archived by the scheduled process Auto
Archive BI Reports effective immediately. The report is also exempt from being archived when the
Archive button is used to manually archive a report.

To manually archive a report:
l Select the report to delete and click Archive.

The Archive Report confirmation window displays.
l Click Yes to archive the report.

Note: Global Admin users cannot archive the following:

o Reports with the PHR_SystemAdmin Role (secured for PrismHR)
o Reports that are configured as datasource reports
o Reports that are used in a BI widget
o Reports that are used in a Dashboard

If a Global Admin user attempts to archive a report that meets at least one of the above-
mentioned criteria, a message displays to the user and they are prohibited from proceeding.

To restore an archived report:
l Click Archived Reports.

The Business Intelligence Admin (Archived) dashboard displays.
l Use More search to search by Name, Category, Report Type, XML, Last Run Use, and Last Design

Date, and Archived Date
l Select the report to restore and then click Restore.

The report is added to the Business Intelligence Admin dashboard.

To delete an archived report:
l Click Archived Reports.

The Business Intelligence Admin (Archived) dashboard displays.
l Use More search to search by Name, Category, Report Type, XML, Last Run Use, and Last Design

Date, and Archived Date
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l Select the report to delete and then click Delete.
The Delete Report confirmation window displays.

l Click Yes to delete the archived report.

Note: Only Global Admin users can delete archived reports.

Related Topics:

l Configuring the Auto Archive BI Reports Scheduled Process
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Chapter 12
Email Admin
The Email Admin dashboard lists emails generated from calendar events, activities, emails, tasks, email
templates, and dataforms. The scheduled process looks at this table, and for any UNSENT items, it
sends them. The Date Sent column reflects the status as either a date or UNSENT, which indicates the
email cannot or has not yet been sent. For emails generated from the INCIDENT template, the
dashboard displays TaskSystemEmailTemplate in the Source column. Otherwise, it displays Task. When
there are attachments, you can view them in the Attachments pane.

To access Email Admin:

1. Go to System Admin > Email Admin.
The Email Admin dashboard opens with a list of entries. You can view entries and search them
using Quick Search and More search.

2. To search using More search, click More.
The More search dialog box opens. You can search by Status, Workspace, User, Date Sent range,
Source, Failed Emails Only, and Email Template.
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3. After you have entered the search criteria, click Search.
The results are displayed on the dashboard.

4. To change the column view, on a column, click (Column Settings).
A list of columns displays where you can add or remove to customize the view. By default, the
columns Email Template and Failed are hidden. From the Email Template column, you can link to
the email template.

5. To view a dashboard entry, select and click (Open).
The item opens.
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6. If there are any attachments for the opened item, you can view them from Attachments in the
right pane.

7. For entries that are still active tasks, to view the task, click (Open).
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Chapter 13
Email Integration
Email Integration allows your company to automatically create a case based on an email being sent to a
designated mailbox. With Email Integration you can streamline communication in ClientSpace from a
designated mailbox outside ClientSpace. Email integration is a ClientSpace component that provides
automated dataform creation (Client Service Case) from email requests. The integration accesses an
email account from a third-party email provider and creates dataforms based on the email account or a
specific email alias. After the request processes, an email notification is generated from a configurable
template and transmitted as a response back to the sender of the originating email.

Workflow Overview
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How does this work behind-the-scenes?

A background scheduled process called Process Email Integration runs approximately every minute.
This process checks System Admin > Email Integration for configured Email Integrations. If
configured Email Integrations exist, the system locates the specified mailbox of each integration and
searches each mailbox for unread emails.

l If unread emails exist: The Process Email Integration scheduled process uses the content of the
emails to create the Cases or Forms specified in the Email Integration configuration details. After
creating the Cases/Forms, the Process Email Integration scheduled process then flags the emails
as “Read” to prevent duplicate Cases or Forms from being created.

Note: If any errors occur during processing, they are logged in System Admin > Exception Log.
l If no unread emails exist: The Process Email Integration scheduled process does nothing.

Configuration Prerequisites
Before you configure Email Integration, you need to gather some necessary components for
configuration:

n Email address of the mailbox to be integrated. The email address cannot be an alias; it must be
the actual mailbox email address.

ALERT: Multi-factor authentication (MFA) must be disabled on the Email Integration
account.

n Password to access the mailbox.
n Host URL of the email address (for example, outlook.office.com, or payroll.gmail.com).
n The IMAP connections port to the mailbox. The default port is 993, but this can be changed at

the firewall.
Email Integration supports the following email providers that support the IMAP protocol:

n Aol.com
n Aim.com
n Gmail.com: Currently does not support SaslOAuth
n iCloud.com
n Outlook.com/Office 365

Note: Before you configure for Outlook.com/Office 365, see Configuring distribution groups
for Email Integration with Office 365.
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n Hotmail.com
n Yahoo.com

Next Steps
The following topics guide you through the Email Integration configuration steps.

Overview of Configuring Email Integration
Email Integration allows your company to automatically create a case based on an email being sent to a
designated mailbox.

The following steps provide an overview of configuring Email Integration. Links to the individual steps
are included. Additionally, follow the link in What's next at the end of this topic.

Overview of the configuration for Email Integration:

1. Create your email account.
n If using Gmail, enable the Access for less secure apps option. See Setting the "Allow less

secure apps" setting on Gmail.
n If using Exchange, the mailbox must be IMAP enabled.
n Multi-factor authentication (MFA) must be disabled on the Email Integration account.

2. Before you configure email integration, create the Email Integration Reply Template for the
response email message from System Admin > Email Templates.
See Configuring the Email Integration Reply Template.

3. Create an Email Integration credential from System Admin > Email Integration > Add.
See Creating, modifying, or deleting Email Integration credentials.

4. Add an Email Integration Alias for the email account and any associated mailbox aliases from
System Admin > Email Integration.
See Creating Email Integration aliases.

5. Complete the Step 3: Field Mapping for the dataform to be created by this Email Integration from
System Admin > Email Integration.

6. Enable and schedule the Email Integration process from System Admin > Advanced >
Scheduled Processes.

What's next
Proceed to the next topic (Configuring the Email Integration Reply Template) to begin the process.
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Learning How: Email Integration Demo

This video is a brief demo of how Email Integration works in ClientSpace to automatically create cases
from emails and send notifications of case creation.

Video
View the video Email Integration Demo.

Configuring the Email Integration Reply Template
When configuring an email template for the Email Integration response, use the Email Template wizard.
You do not need to complete all the steps required for triggered email templates.

To configure the Email Integration Reply Template:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Click Add to add a new template.

You are presented with a series of steps to start generating your new template.

Step 1: Initial
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1. Complete the form fields.

Type For Email notifications:
l Select Email. Default value.

Triggering Form Your selection in the Triggering Form field is the dataform or table where
the trigger resides (a field change, a value change). The change to the
dataform or table is what triggers the email. Triggering Form is used
synonymously with a database table or a dataform1.
To add a dataform that is not in the list:

1. In the Triggering Form field, go to the end of the list and select
Add Untriggered Form.
The Select an Untriggered Form dialog box opens. Table Name
contains a list of all dataforms currently not marked as Triggerable.

2. In Table Name, select a dataform from the list.
3. Click Ok.

The selected dataform is marked as triggerable and now appears in the
Triggering Form list.

Template Code Must be unique and should be related to the purpose of the email
template.

Template Name Provide a short, descriptive name for your template. Displays in the email
template list.

Description Provide a useful description of the email template.

Execute On Will this email be sent the first time the form is saved (Insert), only when
the form is changed (Update), or every time (Insert or Update)? When
there are changes to the dataform that you selected in Triggering Form,
the Execute On value controls triggering for Insert, Update, or both Insert
and Update.

Merge Procedure Select an optional Merge Procedure here to provide additional system
information for field replacement. The procedure can be selected from
any stored procedure in the system with a name containing

1Dataforms dynamically create and manage configurable data collection points. When you add a data-
form, a new table is added to the database. Dataforms enable workflow systemization.
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emailtemplate_merge_proc.
Merge Procedure1 also determines the fields that are available to use in
field replacement.

Execution Pipeline Email templates can support multiple pipelines2 using a multi-select. This
allows you to create a single email template that can apply to multiple
execution pipelines. Select the pipelines on which the email triggering is
to occur.

Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new email template, pipelines
assigned a behavior of Default will auto-fill the Execution Pipeline field.
If you are editing an existing email template, Execution Pipeline entries
remain intact until edited. Changed entries are validated against the
Pipeline Linking table. For instance, if a pipeline has been assigned a
behavior of Allow or Default and you remove it, you will still be able to
select it from the Execution Pipeline list. If the same pipeline is assigned
a behavior of Disallow, you will not be able to add it again.

See Configuring Pipeline Linking.

Workspace Templates Select the Workspace Templates3 to receive this email.

Include as Activity Select this option to attach the email as an Activity. When the email is
triggered, the email message attaches to the triggering record. This
action preserves the communication of the sent email. By default, the
option is cleared, meaning do not include the email as an activity.
If you select this option and the email template includes an attachment,
the system uploads any attachments to the activity when it is created..

2. Click Next.

1A Merge Procedure is a piece of prepared SQL code that can be reused over and over again.
2A pipleline determines which rules are applied when the data is saved.
3Workspace Templates are special workspaces used for cloning during the Workspace creation process.
In this way, ClientSpace allows you to set up multiple workspace configurations (such as an industry-
specific Workspaces with a specific, limited list of TOC items) then choose how you want the workspace
to look and feel by selecting the appropriate template during workspace creation.
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Step 2: Content
In the Content step, you provide a Subject and Body – the email message. You can insert information
using replacement fields from the See Replace Fields link.

To configure the content of the email:

1. Provide a Subject line of the email to be generated.
2. Provide the email message in the Body.

This field uses a rich text editor and supports font styling, embedded images, hyperlinks, and so
on. Note: Nothing from this field is used in DocuSign email functionality. DocuSign email
templates cannot contain replaceable fields.

3. Click See Replace Fields to select items to copy to the clipboard. You can paste items in Subject
and Body as applicable.
See Replacement Fields.

4. Click Next to proceed.

Step 3: Addresses
Skip this step.

• Click Next.
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Step 4: Conditions
Conditions are display conditions and can also include Condition Expressions. Condition Expressions
use the labels that you define for your Display Conditions. For a detailed explanation about conditions,
see Condition Expressions.

To configure conditions:

1. Complete the fields:

No Primary Trigger When selected, no single condition must be met to trigger the email
template. When selected, the Primary Trigger Field is disabled.

Only Trigger Once When selected, the email template is triggered only once when the
conditions are first met. Do not select this option if you want the email
template to trigger each time the conditions are met.

Primary Trigger Field Optional. From the Triggering Form selected in Step 1, which, when
changed, triggers the event. This can also be a HdrAction, such as a
configured action link on the form.

The following statements refer to the condition entries in the Add area.
Condition entries are identified with a Label (the last column).
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• If a Primary Trigger Field is selected, that field MUST change values to
trigger this template and evaluate the conditions.

• If a Primary Trigger Field is not selected, only the conditions are
evaluated.

• If a Primary Trigger Field is selected, the conditions are combined
with the Primary Trigger Field using an implied AND.

• If no Condition Expression is used, the additional conditions are
treated as OR conditions.

The Primary Trigger Field only displays fields associated with the
triggering dataform and includes the ability to Add Untriggered Field.

To add display conditions:

2. Click Add.
A row opens with columns Source, Field, Operator, Value, and Label. The Add section is where you
can add more granular triggering conditions. Each row you add is a display condition. When
Condition Expression is empty, the display conditions process as ORs, meaning only one of the
conditions must be met for the email notification to trigger.

Source The Source list includes the triggering form and its tabs, the channel trigger
(i.e., the original form that started the channel), all triggerable, active single-
forms, and the tabs of those single-forms. Applicable server data procs, if
configured, may also be included.

When you select Task as the Triggering Form in Step 1 Initial, in this step
Source sets to Task.

Field Select the dataform or Stored Procedure
field to compare to the trigger value.
A few notes:
l Email Template triggering provides

multi-lookup fields (Multi Lookup
(MultiLookup)) as triggering conditions.

l Field supports parent form fields.
Available operators are Empty, Not
Empty, and Is Dirty.
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Note: If you are creating a Scheduled Email Template, the Is Dirty
operator is not in the list as real time analysis of a field is required to
determine an "Is Dirty" state.

l Field supports the Active dataform setting. Available operators are
Does Not Equal, Equals, and Is Dirty (if choosing the triggering form as
the Source). Value options are Unchecked and Checked.
Note: If you are creating a Scheduled Email Template, the Is Dirty
operator is not in the list as real time analysis of a field is required to
determine an "Is Dirty" state.

l You can Add Untriggered Fields dynamically as well as current, active,
triggerable fields from the Source.

l When you select Task as the Triggering Form in Step 1 Initial, the
options for Field include all task fields. For example, when you select
Send Notification, and this option is enabled in the Task, then the email
notification is triggered.

To add a trigger field:

1. In Field, go to the end of the list and select Add Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as Triggerable.

2. In Field, select an entry.
3. Click Ok.

The selected field is marked as triggerable and now appears in the Field
list.

Operator Choose the type of comparison. Each value from a Multi Lookup Trigger Field
can be added as a separate "=" condition. This supports complex AND, OR,
and NOT conditions as well.

Note:

l Is Dirty is not available in the Operator list when the Source is set to
something other than the Triggering Form.

l If you are creating a Scheduled Email Template, the Is Dirty operator is
not in the list as real time analysis of a field is required to determine an
"Is Dirty" state.

Value The criteria against which the trigger field is compared. For a condition that is
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typeahead1 method so that you do not need to look up the User ID for the
text field.

Label The label to use when constructing Condition Expressions for triggering.
ClientSpace assigns a label to a new condition with the naming convention C#.
For example, C1 for the first condition that you create, C2 for the second, and
so on. You can change the label name by selecting the name of the label and
typing a new name for the label. For example, you can select the C1 label and
enter Condition1 as the new label name.

Tip: Make this label short and representative of the Trigger Field. Labels are
used in the Condition Expression field.

Condition
Expression

Allows for AND, OR, and NOT conditions using the trigger conditions (Label)
from the Add section. Using the Label field that corresponds to the entries in
the Add section, you can combine the conditions into more complex
expressions. The Condition Expression field could state, for example
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR
Condition5. Condition Expressions adhere to AND/OR/NOT across tabbed
dataform conditions. For a detailed explanation about conditions, see
Condition expressions.

When the Condition Expression field is empty, the row entries are treated
as OR conditions. Only one of the conditions must be met.

To clone a trigger condition:
To save some time, you can clone a trigger condition and then edit as appropriate.

1As you type in the field, one or more matches for the term are found and immediately presented.
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1. In the Add section, locate an entry that you want to copy.

2. Click Clone.
A new row opens, with the trigger condition copied. Source, Field, and Operator are copied.

3. You can now edit the new condition as appropriate.
4. Click Apply or Save.

5. Click Next to proceed through the remaining steps until you Finish the template.

What's next
Proceed to the next topic (Creating, modifying, or deleting Email Integration credentials) to begin the
process.

Creating, modifying, or deleting Email Integration
credentials
The Email Integration login credentials are stored in the API Credentials table (tblAPICredentials) and
are maintained from System Admin > Email Integration. For existing credentials, the Password field is
hidden. To change the password for an existing credential, see Edit a credential.

ALERT: Multi-factor authentication (MFA) must be disabled on the Email Integration account.

Add a credential

To add a credential:

1. Go to System Admin > Email Integration.
The Email Integration dashboard opens. From here, you can add, edit details, and delete records.

2. Click Add.
The New Email Integration form opens.
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3. Complete the following fields:

Mailbox  Required. The email address for the email account with which you would
like to integrate. Email addresses are case insensitive and must be in a
valid format. This address must be attached to a supported email
provider (such as Gmail, AOL). The address must be an actual email
address associated with this mailbox and not an alias for the mailbox.

Later in the configuration process, an email alias is created using this
email address. The alias provides to ClientSpace the default values for
the workspace, project type, and client.

Password Required. The user account password. Depending on the email provider,
this field may be case sensitive, so ensure that you use the appropriate
case when you enter the value.

When editing an existing credential, the Password field is hidden. To
change the password, see Edit a credential.

Host  Required. The IMAP mail host for the mail client. This setting is used
when connecting to the mailbox. For information on your IMAP host
settings, contact your mail provider.

Port Required. The secured firewall port used by your provider to allow
access to the mailbox. Most IMAP providers use Port 993, so we default
the field to this.

Use Secure Connection Connect to the mail provider over the internet via unsecured (HTTP) or
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(HTTPS)  secured (HTTPS) access. Defaults to selected (secured).

Configuration Name  Required. Should contain the application name associated with the
application code. This name will appear in Lists, so it should provide a
hint at the mailbox association.

Description Required. Should contain a brief description of this credential.

Test Connection  Test Connection is disabled until all required fields are completed, at
which point the button color indicates it is ready for use.
Select Test Connection to ensure the connection information connects
to the mailbox successfully before proceeding to the next step. A
successful test presents the message: We were able to connect to your
mailbox.

Unsuccessful tests yield an error message. Some examples of common
errors and their causes:

l xm001 NO [AUTHENTICATIONFAILED] Invalid

credentials (Failure) - Bad username or password
l No such host is known - Bad hostname
l Object reference not set to an instance of an

object. This message is more generic but is most commonly
caused when a secure connection is required, and the Use Secure
Connection option is cleared.

Before deleting a credential, you must ensure that it is not associated
with any email aliases, else an error will be logged.

4. Click Save.

Edit a credential

To edit the password for an existing credential:

1. Go to System Admin > Email Integration.
The Email Integration dashboard opens. From here, you can add, edit details, and delete records.

2. Select the credential and click (Open) or Details.
The Email Integration form opens.

3. In the Action Center, click (Change Password).
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The Change Password dialog box opens.
4. Complete the fields:

New Password Enter the new password.

Confirm Password Enter the new password again.

5. Click Ok.
6. On the Email Integration form, click Test Connection to test the password.
7. If the new password matches the password for the mailbox, a green-shaded Connected

Successfully message dialog box opens. To close, click Ok.
8. If the password does not match, an Invalid Password security error appears.

What's next
Proceed to the next topic Creating Email Integration aliases to continue the process.

Learning How: Setting Up Advanced Email Integration Security

This video details how to set up advanced email integration security.

Video
View the video Setting Up Advanced Email Integration Security.

Creating Email Integration aliases
Email Integration aliases link a credential to an email address and identify and group several default
values for processing the email requests. The Email Integration Aliases are stored in the Email
Integration table (tblEmailIntegration). An example of how an alias links to an email address, is when
you want to enable functionality for replying above the line with case discussion messages. See
Configuring Case Discussion: Reply Above This Line.

For an email address to be processed, it must have an Alias specified in the alias table. If no alias is
found, an email integration error is logged as “Email Contains Missing or Invalid Key Information -
Workspace ID: # Project Type ID: 0”. When this occurs, the reply message is not generated and
transmitted. When adding email aliases to your mailbox, coordinate this activity with your email
administrator.

Review the topic Email Integration Processing for a comprehensive picture of the process.
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Step 1: Alias step
An Email Integration record can have multiple aliases on a mailbox. The email address is how it
connects to the mailbox. The alias defines what it does with the mailbox. In this step, specify the email
address to match an email mailbox, such as payroll.bigtmepeo@gmail.com.

To create email integration aliases:
1. Go to System Admin > Email Integration.

The Email Integration dashboard opens.
2. Select an entry from the list and click Details.

The Email Integration form opens
3. In Aliases, click (New).

The Alias step opens.

4. To create, delete, or modify an email template, access the Email Integration Alias page and set the
following fields:

Email Alias Required. Should contain the email address associated with this alias. The
email To address is used to match an email to its associated alias. Each
credential should have at least one email alias associated with the
account email address. Additional, email aliases can be created so that
email accounts with multiple email aliases can be mapped to different
Project Types. You can create as many email aliases as the provider
allows. There may be differences in the “To address” format of email
aliases between providers. For example:
l Credential Username: client@gmail.com
l Email Account: client@gmail.com
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l Email Alias 1: client+clientservicecase@gmail.com
l Email Alias 2: client+createemployee@gmail.com

In this example, you would create 3 email aliases, the first using the Email
Account as the email Alias value. This creates the default email alias to be
used. The second would be created using email Alias 1 and the project
type set to the Project Type associated with creating a Create Client
Service Case project type. The third would be created using email Alias 2,
and the project would be set to the Project Type associated with creating
an employee (the only supported dataform created using this method is
the Client Service Case dataform).

Default Alias If an alias cannot be located by the email address for the incoming email,
this alias is used to process the email for the API configuration
mailbox. Only one default alias can be defined.

Include Attachments Optional. When set, email attachments are downloaded and attached to
the dataform during processing. File attachments are checked against the
list of Valid Email attachment types stored in the Lookup ValidAttachExt.
Unrecognized email attachments are added to a .zip archive and attached
with the message: "CAUTION! The original file is NOT AN ALLOWED FILE
TYPE in ClientSpace, and it has been converted to a Zip Archive"

5. Click Next.
The Step 2: Action step opens.

Step 2: Action step
The Action step determines how the dataform is created, including where to create it, how to reply to it,
what dataform will be created, and what to do if we cannot find an email match.
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1. Complete the form fields:

Workspace Required. Contains the workspace that will be used by this email alias for the
dataform creation if no matches for the sender's address are found. This is the
default workspace used during the processing of the email. This value may be
overridden by including the workspace in the body of the email. The override
value must contain a valid workspace ID and be formatted as WSID=# with no
spaces between the WSID= and the workspace ID. 
• Select a workspace from the list.

Reply Template Required. This field indicates the reply template that the system uses to send
the process complete notification reply.
If no email reply is necessary, select No Reply.The system does not reply to
the sender after completing the actions for the email integration
If an email reply is necessary, select a reply template from the list. This can be
an existing triggered template, or you can create one just for this reply. See
Configuring the Email Integration Reply Template.
l For case discussions, select Case to Email Reply.

Business Object This is the ClientSpace business object that stores any code to be run during
the email integration process. This should either be left blank or filled in with
the appropriate business object.

Important: If you are configuring this for Case Discussion Replies, the
requirements are quite different. See Step 2: Configure the Email Integration
Mailbox.

The business object looks up the workspace using a CLID 
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(ClientNumber) or WSID (ProjectID) to modify the data before the dataform is
created or to modify the data before the reply template is generated and
sent. In this way, you can add layer-specific data values to the form or layer-
specific replace code values to the reply email.
l The business object for a standard email integration is

ClientSpace.PEO.Business.EmailIntegrationBase.

Pipeline Business Logic
• CLID represents ClientID or Client Number from the Client Master page in

the PEO system.
• WSID represents WorkspaceID or ProjectID. This is a unique key used as a

Foreign Key on all dataforms related to a workspace or project.
These options are powerful because the Workspace selection is not
dependent on the email being sent from a specific email address. This allows
your clients to send from personal email at home or on a mobile device, but
they must always include the CLID or WSID in the exact format:
CLID=123456 or WSID=654321

These strings cannot contain additional spaces and must use the appropriate
Client Number or ProjectID. If you have questions about this, please log an
Extranet case. Note: Clients should insert the CLID or WSID in the body of the
email message.

If Always Use Default Workspace is not selected and the business object is
configured, the system checks the body of the email for the CSID / WSID
information. If no match is found, the system uses the Email Integration
Processing hierarchy to determine which workspace is used when creating
the new dataform.

Configuring the business pipeline
The default PEO business object resides in the DLL Custom Path folder and its
complete name is ClientSpace.PEO.Business.EmailIntegrationBase. This
name is case-sensitive and must match precisely in the configuration. If no
business object is specified and the message contains a CLID tag, an
exception occurs.

Always Use
Default
Workspace

When selected, this option forces the system to use the default workspace set
in the Workspace field, regardless of the other methods of workspace
selection.
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Dataform Required. Contains the project type associated with this email alias. This
determines what type of dataform to create. Select the Project Type from the
list.
l For case discussions, select Case Discussion Message.

2. Click Next.
The Field Mapping step opens. Go to the next topic, Step 3: Field Mapping.

Step 3: Field Mapping
Use field mapping to complete the fields for the Dataform you selected. Fields are exposed to Email
Integration by selecting the Cloneable option on field properties under Dataform management. These
fields can either be configured with static values, such as selecting a specific lookup value from a field
or by using replacement fields to fill a field with information from the received email.
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To use replacement fields:

1. Click Get Replace Fields.
The Replace Fields dialog box opens with a list of fields from the email.

2. Select as many fields as required and then click Copy.
The Clipboard dialog box opens with the selected fields.

3. Click Ok.
4. Paste the copied fields into the appropriate field, such as Subject or Text Area.

When the task or dataform is produced through the cloning process, these fields are replaced with the
appropriate field data. The Communication Method field, unless filled in, defaults to Email Integration.

Email Integration Email Field Replace codes

The following field replacement codes are available for use in email template data map fields as well as,
the email alias data map fields.

{EmailBody} The entire email body.

{EmailBodyHTML} The entire email body plus embedded images and any html
formatting.

{EmailSubject} The email subject.

{EmailToAddress} The email To address. In the event there are multiple email
addresses, this is the first email address. 

{EmailFromAddress} The email sent From address. 

{EmailHasAttachments} True or False depending on if the email had attachments. This
does not indicate that the attachment was downloaded and
attached. It only indicates the email had an attachment.

{EmailAttachmentCount} The number of attachments on the email.

{EmailAttachmentsRefused}

{EmailAttachmentsRefusedReason}

{EmailAttachmentsUploaded}

{EmailCCAddressAll}  The copied recipient email addresses.  

{EmailEmailForwardedFromAddress}  The forwarded From email address.
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{EmailToAddressAll}  The email recipient addresses.

{EmailMessageId} The email message ID.

{WSSource} Information about which of the source selection methods was
used to determine the workspace in which to create the case.

What's next

Review the topic Email Integration Processing for a comprehensive picture of the process. And then
create the Email Integration Reply Template (Configuring the Email Integration Reply Template.

Setting up an email alias on Gmail
One way to maximize the mileage of the ClientSpace Email Integration is through aliases to create
specific case types or create cases in a specific workspace. For this to work, however, you must first have
a unique email address to which mail will be sent. For Gmail, this is accomplished using custom tags
appended to your Gmail user account.

Gmail does not offer traditional aliases, but you can receive messages sent to
your.username+any.alias@gmail.com. For example, messages sent to jane.doe+payroll@gmail.com are
delivered to jane.doe@gmail.com.

You can also set up filters in Gmail to automatically direct these messages to Trash, apply a label or
star, skip the inbox, or forward to another email account.

In ClientSpace, you can then use this aliased email address to create custom API Configurations, Email
Integrations, and Email Templates that can then be used to either create a specific type of Client Service
case, generate the case in a specific workspace or both, as well as send customized responses back to
whoever logged the request. In the example, your email template response could begin "Thank you for
logging a Payroll Case with BigPEO. Your payroll representative has been alerted and someone will be
contacting you shortly to help you resolve your issue."

Setting the "Allow less secure apps" setting on Gmail
1. Open the Gmail account and go to My Account.
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2. Click Sign-in & Security.
3. If enabled, set 2-Step Verification to Off.

4. Turn on the Allow less secure apps option.
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Email Integration Processing
Email integration processes an external email account and creates a Client Service Case (dataform). The
Email Integration scheduled process performs multiple actions to process the emails and save them as
a case.

Action Description

Credentials The credential is looked up from the API Credentials table using the
Application Code that matches the mailbox being searched.

Unread emails are
downloaded

The list of unread emails is downloaded.
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Action Description

Determine workspace l If Always use Default Workspace is selected, the system uses the
Default Workspace ID.

l The Email Alias is looked up based on the email To address. If a match
is found, it uses this to determine the workspace.

l The body is searched for the CLID (Client Number) token, and if
found, the business object is called to interpret the CLID and return
the appropriate workspace ID++++.
Note: In multi-tenant environments, the CLID includes both the
Client Number and the PEO ID from the Client Master record of a
workspace when the Use Multi-tenancy flag is set in
PEO Configuration. In multi-tenant environments, the Client Number
may not be unique across Prism database instances. Therefore,
including the PEO ID in the CLID ensures proper workspace
identification.
For example, a CLID of 165::000110 signifies the Client Number is
000110 and the PEO ID is 165.
Also see Multi-tenant Environments in ClientSpace.

l The body is searched for the WSID token, and if found, and the
workspace was not set by the business object CLID request, the
workspace ID is set to the WSID value.

l The email From address is compared to all employee email addresses
(both Personal and Work email) in the system and tries to match the
email. If a match is found, the workspace associated with that
employee is used and if multiple instances of the employee email
(Personal and Work) exist, the most recently changed instance is used.
The email addresses are used for workspace lookup purposes to
determine where to generate the case.

l If no workspace is determined, the contacts are searched for one with
the same email as the email From address. If found, the primary
project ID for the contact is used as the workspace ID and the Client
Contact information on the newly created Client Service case is
updated using the "From" email address from the matching contact
record.

l If the contact is not found, the Organization table is searched for an
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Action Description

organization with the same email domain. If found, the default
workspace for this organization is used.

l If no workspace is found, the default workspace from the alias is used
along with the project type to create the appropriate data form.

Body scanned l When the dataform type and workspace are found, the body is
scanned for additional data value tokens that are added to the form
data XML document in addition to the email data items to set valid
fields.

l Any invalid special characters found in the email subject and body are
scrubbed. This process does not log an error message.

Business object l If a business object is specified, the EmailIntegrationCreateNewForm
is called to allow the business layer to set data values before creating
the form.

l If the Business Object does not cancel the save, then the dataform is
saved.

Dataform saved The attachments are downloaded and attached to the form based on the
alias Include Attachments indicator.

XML document In addition to the email fields, the saved data is placed into an XML
document to generate the reply message.

Set data values If a business object is specified, the EmailIntegrationNotifySender is called
to allow the business layer to set data values before generating and
transmitting the notification.

Notification sent If the business object does not cancel the notify action, then the notification
is sent.

Marked as read The email is then marked as read.

Configuring distribution groups for Email Integration with
Office 365
To create distinct client Email Integration aliases with an Exchange mail server in Office 365, you first
need to create custom distribution groups on your exchange mailbox. This topic walks you through the
process of creating these unique groups.
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To configure distribution groups for email integration:
1. Log into Office 365 Online using an account that has administrative rights on the targeted mailbox.
2. Go to the Admin Area of the account.
3. Select Groups and choose Set up distribution lists and other Exchange groups in the

Exchange Admin center.
4. Choose Add new > Distribution group.
5. Complete the Distribution group setup by adding the following:

DisplayName Best practice is to make this the email address without the domain
(@somewhere.com).

Alias Best practice is to make this the same as the Display Name.

Email address Generated automatically by the system but can be altered before you save.

Members Add the primary mailbox to the Members area.

6. Save the Group Record.
7. Edit the record and select Delivery Management.
8. Select Senders inside and outside of my organization.
9. Save the record again.
The alias email address is now ready to use when configuring ClientSpace Email Integration alias
records. These instructions require Admin access to the Exchange mailbox. Contact your Exchange
administrator for help configuring these group options.
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Chapter 14
Email add-in for Outlook
This topic provides step-by-step instructions for installing and configuring the email add-in for Outlook
for:

n outlook.live.com
n Office 365 Online
n Outlook in Windows

Why use the email add-in?
The email add-in connects your Outlook email Inbox with ClientSpace to automate the process of
creating an activity record when you send an email. The add-in eliminates the need to maintain activity
records in multiple places. When you send an email from ClientSpace, the activity is captured for the
client, prospective client, or lead. Additionally, the email add-in enables an easy way to create activities,
cases, and tasks from received emails listed in the External Mailbox dashboard. All activity is performed
from within ClientSpace.

Overview of configuration
1. The first step is to install and configure the email add-in for Outlook.

o Select your preferred method of accessing Outlook (outlook.live.com, Office 365 Online, or
Outlook in Windows).

o Follow the installation procedures in this topic.
2. The second step is to select an email message and post it to ClientSpace.

o See the ClientSpace User Guide for selecting the email and posting to ClientSpace.
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Microsoft Outlook add-in deployment
The following instructions for distributing the Add-In though Exchange Admin should be used when
publishing the Outlook add-In. Any deviation from this procedure may produce unexpected results and
falls outside the scope of support for this product.

Per Microsoft, Outlook add-in deployment requires:

n Office 365, Exchange Online, or Exchange Server 2013 or later
n Outlook 2013 or later

It is also highly recommended that you apply the latest service pack / patches for Exchange server to
ensure you have Microsoft's latest deployment code. More details about this and the technology used
for these add-ins can be found here: https://docs.microsoft.com/en-us/outlook/add-ins/

Installing from outlook.live.com
This section describes how to configure the add-in from outlook.live.com.

Keep ClientSpace and Outlook open during the installation procedure. You will need to toggle
between your ClientSpace site and Outlook session. The procedure requires that you keep the
sessions open while gathering the various pieces of information.

To install the email add-in for Outlook:
1. Sign in to your Outlook account.
2. Open an existing email.
3. At the top of the email message, on the right side, click . . . (More actions).

A list of options is displayed.
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4. Click Get Add-ins.
The Add-Ins for Outlook dialog opens.

5. Click My add-ins.
6. Under Custom add-ins, click Add a custom add-in > add from URL.

The Add private add-in from a URL dialog opens.
7. In Enter the URL of the add-in's manifest file, paste the following URL:

https://shared.clientspace.net/Content/Manifest/OfficeManifest2.xml

8. Click OK.
A Warning message is displayed: "This custom add-in may access your personal data and send it to
a third-party service. It hasn't been verified by Microsoft. Make sure you trust the source of the add-
in."
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9. Click Install.
The ClientSpace for Outlook add-in is added and displayed in the Custom add-ins area.

10. Click X to close the dialog.
The next few steps configure the settings: URL, Username, and Mail Key.

Next: Check your email address in ClientSpace

To ensure that your email address is added to your ClientSpace User Details:
1. From ClientSpace, click <username> > My Profile.

The User Details form opens.
2. In Email, ensure that the appropriate email address is recorded. This email should be the same

email address as the one you use for Outlook (for example jsmith@outlook.com).
3. Update the information in ClientSpace if required and click Save.

Next: Obtain Mail Key from ClientSpace

To obtain the Mail Key:
1. In ClientSpace, from your User Details page, in the Action Center, select More Options >

Manage Mail Key.

The Your Mail Key form opens.

2. If no Mail Key is set up, click Generate to create one.
Your Mail Key is displayed so that you can copy and use it for connecting to your external mail
system to ClientSpace.
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3. Click the key to copy it to your clipboard.
The Clipboard opens showing the key.

4. Click Ok.
5. Click Close.
At this point, the key is copied to your clipboard and you are ready to paste the Mail Key in the Outlook
configuration pane.

Next: Back to Outlook

To continue the configuration:
1. In Outlook, from the previously opened email, click . . . (More actions).

2. From the list of options, click ClientSpace for Outlook.
The ClientSpace for Outlook pane opens beside the open email. You must open this pane for every
Outlook email that you want to post to ClientSpace.
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3. In the ClientSpace for Outlook pane, if you do not see fields for URL, Username, and Mail Key, click
Settings.
The fields are now displayed.

4. In Mail Key, paste the key that you just copied. Let's fill this field first so that you retain what you
just copied to the clipboard.

5. Go to your ClientSpace site and copy the ClientSpace URL (for example,
https://yoursite.clientspace.net). Note: DO NOT append /next to the end of the URL.

6. In URL, paste the URL of your ClientSpace site.
7. In Username, type your ClientSpace username (for example, jsmith).
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Now you are ready to post the opened email message to ClientSpace.

8. Click Post to ClientSpace.

This action logs you into ClientSpace displaying the email message from Outlook, which is now
visible in ClientSpace.

9. If pop-ups are blocked, click the Pop-up blocker and select Always allow pop-ups and redirects
from https://outlook.live.com.

What's next?

When you click Post To ClientSpace, you are then logged into ClientSpace. The Post To ClientSpace
page appears.

From the Post To ClientSpace page, you can:

• Attach the email to a dataform (record)
• Create an activity
• Create a case
• Create a task
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Additionally, Global Admins can post Help topics for this page and make them available to your users.
You are now logged into ClientSpace, ready for the next action.

Installing from Office 365 Online
This topic describes how to configure the add-in from Office 365 Online.

To install from Office 365:
1. Log into your office 365 account online (portal.office.com) and access your Outlook mailbox.

If your Administrator has installed the add-in as Optional - Enabled by default, or Mandatory,
always enabled, when you select an email in the list you will see the add-in icon in the upper right:

2. If the add-in has been installed as Optional, disabled by default, perform the following steps to
enable it.
• Click the settings icon (gear) and select Manage add-ins.
• If the Manage Add-ins option is missing, it is likely that Outlook Web Access has been disabled

in your environment. Speak with your Exchange administrator about enabling this functionality.
• If your administrator has installed the add-in in Exchange and you have rights, you will have the

option for Admin-managed add-ins.
• Click Admin-managed.
• Then click Add for the Outlook Add-in.

3. When you return to your Outlook Mail and select an email you will see the add-in icon in the upper
right:
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Installing from Outlook in Windows
This topic describes how to configure the add-in from Outlook in Windows.

To install from Windows:
1. If your Administrator has installed the add-in as Optional - Enabled by default, or Mandatory,

always enabled, and you have logged into Outlook via portal.office.com, the add-in should be
present when you open your windows install of Outlook (Office 2013 and newer).

2. For environments where the admin has made this add-in Optional, disabled by default, or if you
have not opened Outlook from portal.office.com, you need to manually install the add-in using the
following instructions.

3. Open the Outlook application (2013 and newer) on your Windows desktop.
4. In the upper left, click File.
5. Scroll down until you see Manage Add-ins.

If the Manage Add-ins tile is missing, it is likely that Outlook Web Access has been disabled in your
environment. Speak with your Exchange administrator about enabling this functionality.

6. Click Manage add-ins.
It takes you to a login for Office 365.

7. Log in to Office 365.
8. After you log in, if your administrator has installed the add-in in Exchange and you have rights, you

see the option Manage add-ins.
9. Click Manage add-ins.
10. Select the ClientSpace for Outlook add-in option.
11. When you return to Outlook and have an email selected, you see the icon for the add-in in your

toolbar .

Configuring the Outlook add-in module for Create
Through the Outlook add-in, you can create new cases, tasks and claim notes directly from your email
Inbox. You can indicate the fields that will be auto-filled and the information from the email to fill them.
This topic walks you through configuring the Create Case, Create Task and Create Claim Notes
modules for the Outlook add-in.

The Outlook add-in uses a system module when creating a new case, task or claim note directly from
the add-in. You must be a global admin to perform this configuration. Additionally, your global admin
can configure a Create module for creating any workspace dataform from the Email add-in, such as
Create WC Claim.
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To configure the Outlook add-in modules:
1. Go to System Admin > Modules.

The Modules dashboard opens.
2. In the Search box, filter the Modules list by typing Outlook.

Modules that apply to Outlook are displayed. The three relevant modules are Create Case, Create
Task, and Create Claim Notes.

3. Open Create Case.
The Module Details form for Create Case opens.

4. Complete the form (referring to the field definitions table near the end of this topic as needed) and
click Save.

5. Open Create Task.
The Module Details form for Create Task opens.
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6. Complete the form (referring to the field definitions table near the end of this topic as needed) and
click Save.

7. Open Create Claim Notes.
The Module Details form for Create Claim Notes opens.

8. Complete the form (referring to the field definitions table below as needed) and click Save.

Name Defaults to Create Case, Create Task or Create Claim Notes depending on
your selection.

Category Defaults to Outlook.
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Description • For Create Task, defaults to Create a Task from the email client Add-In.
• For Create Case, defaults to Create a Client Service Case from the email

client Add-In.
• For Create Claim Notes, defaults to Create Claim Notes.

Target Will this open in a new window or in the main view? The add-in opens a new
instance of the system, so this is set to Main Window, ensuring the case or task
is opened normally (within the page frame).

Type Defaults to Outlook.

Url This is used by the Outlook add-in to find the appropriate code path when
generating a new dataform or task. This field is pre-configured and should not
be altered, or unexpected behavior occurs.

Email Addin
Configuration

This field enables the global admin to selectively fill fields in the newly created
case, task, or claims note using data from the selected email. Pair case, task or
claim notes fields with email fields. Separate the pairings with a semi-colon, no
spaces between them, and no ending semicolon.
Example format for a Task: Case/TaskField=EmailField
Example format for a
Case: Subject=Subject;CaseInfo=Body;EmailAddress=Sender;z_
ClientReportDate=DateSent
Example format for a Claim Note:
Notes=Body;Subject=Subject;DateCreate=DateSent
The second example above is for a case. The following information will be
brought in: 

• Subject of the case is filled with the Subject line in the email.
• CaseInfo of the case is filled with the Body of the email.
• Email Address on the case is filled with the From address on the email.
• The custom Client Report Date field is filled with the DateSent of the

email.
Available fields retrieved from the email are:

• DateSent: mailboxItem.dateSent
• Subject: mailboxItem.subject
• Body: mailboxItem.body
• Sender: mailboxItem.from
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• Recipient: mailboxItem.to

Additional Optional Parameters: 

l Show EMBActivity: You can also add the ShowEMBActivity parameter
to this field (for cases and tasks only). The ShowEMBActivity parameter
exposes the Add Email as Activity check box when a user creates a
client service case, task, or claim note.

The following graphic illustrates the check box option that the system
displays for a new case or task when using the ShowEMBActivity
parameter.

l HTMLBody: The HTMLBody formatting parameter can be added to any
Outlook Add-In module as long as it is mapped to an Editor field. When
the parameter is correctly mapped to an Editor field, HTML formatting in
the original Outlook email body text is applied to the imported email
body text in ClientSpace. To configure the option, enter
<NameOfEditorField>=HTMLBody as shown in the example image
below:

9. Click Save.

For Create Case, Create Task, or Create Claim Note functionality to appear in the add-in, the
respective module must be active in System Admin > Modules.

To add custom Outlook modules:
1. Go to System Admin > Modules.

The Modules dashboard opens.
2. Click Add.

The Module Details form opens.

Name Enter a name that fits your new module. Example: Create WC Claim.
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Category Select Outlook.

Description Enter a description of the new module.

Target Will this open in a new window or in the main view? The add-in opens a new
instance of the system, so this is set to Main Window, ensuring the case or task
is opened normally (within the page frame).

Type Select Outlook.

Url This is used by the Outlook add-in to find the appropriate code path when
generating a new dataform or task.
For a new module, such as Create WC Claim, type
~/api/MailService/Create/gen_CompClaim.

3. Click Save.

Publishing the Outlook add-in through Exchange Admin
To begin using the Outlook add-in in your environment, you need to publish the add-in through the
Exchange Admin > Manage Add-ins. This topic provides step-by-step instructions on installing this
add-in in the Office 365 environment.

Microsoft now supports publishing Outlook Office add-ins through the Microsoft Store. This method of
centralized deployment allows you to define groups that can use the add-in and is recommended for
clients that use a hosted environment from a third-party IT provider. When using centralized
deployment to publish through the Microsoft store, the provider should select the URL method of
publishing and use the URL provided in this article. It is critical before proceeding with any method of
publishing Outlook Add-ins that the server through which you will publish the add-in is up to date with
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the latest Microsoft service packs and updates for exchange. Instructions for centralized deployment
through the Microsoft store may be found here.

You must use the following instructions for distributing the Add-In though Exchange Admin when
publishing the Outlook Add-In. Any deviation from this procedure can produce unexpected
results and falls outside the scope of support for this product.

Per Microsoft, the Outlook add-in deployment requires:

• Office 365, Exchange Online, or Exchange Server 2013 or later
• Outlook 2013 or later
It is also highly recommended that you apply the latest service pack / patches for Exchange server to
ensure you have Microsoft's latest deployment code. More details about this and the technology used
for these add-ins can be found here: https://docs.microsoft.com/en-us/outlook/add-ins/

To publish the Outlook add-in through Exchange Admin:
1. Open the Office 365 Admin Center and navigate to Admin Centers > Exchange.

2. In the Exchange Admin Center Dashboard, under Organization, select add-ins.
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You are presented with a list of currently available add-ins.

3. To add the new add-in to this list, click + and select Add from URL.

4. In the Add from URL dialog, complete the URL field using the following web address:
https://shared.clientspace.net/Content/Manifest/OfficeManifest2.xml
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5. Then click Install.
6. At the options selection screen, select the Make sure this add-in available to users in your

organization option.
7. Select the appropriate install option for your environment.

Available options are as follows:

• Optional, enabled by default (*recommended): Users of Outlook via ofOffice365 online will
automatically have access to the add-when using Outlook on the web. When enabled on their
online account, the add-in will automatically be installed to their desktop Outlook. Desktop-only
users will need to manually install the add-in using these instructions (click link to open). Once
installed they may uninstall.

• Optional, disabled by default: Users of both Office365 online and desktop Outlook will need to
manually install the add-in using these instructions (click link to open). Once installed they may
uninstall.
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• Mandatory, always enabled: Users of Outlook via Office365 online will automatically have access
to the add-when using Outlook on the web. When enabled on their online account, the add-in will
automatically be installed to their desktop Outlook. Desktop only users will need to manually install
the add-in using these instructions (click link to open). Users will be unable to uninstall the add-in.
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Chapter 15
Widget layouts
Widgets deliver targeted information within ClientSpace, which alleviates the need for custom
programming to present departmental dashboards or dataform headers. You can present data using
configurable widget layouts using condition expressions. Condition expressions enable presenting
many views of a home page, workspace landing page, or dataform header, depending on department
or role security.

Adding Widget Layouts
This procedure involves adding the widget layouts, browsing the library, configuring the widget and
widget layouts, and publishing.

To add widget layouts:
1. Go to System Admin > Widget Layouts.

The Widget Layouts dashboard opens. From here, you can add and manage widget layouts for your
ClientSpace installation.

2. From the Widget Layouts list, you can do the following:
n Search / More: Works as the standard ClientSpace searches. By default, the list only displays

published widgets.
n Add: Click to add a new widget layout.
n Edit: Select a widget from the list and click to edit an existing widget layout.
n Delete: Delete a selected widget layout.
n Clone: Clone a selected widget layout.

3. To add a new widget layout, click Add.
The Widget Layout Details form opens.

4. Complete the form:

Name Name of your new layout. This should be descriptive of layout type and
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audience, for example, Payroll Home.

Target Type Target Type determines where the configured widget layout is displayed
within the ClientSpace application, as well as what display conditions are
available for use:
l Workspace: Adds the widget to the Workspace Landing page based on

the assigned Weight and Conditions set.
l Home: Creates a Home page that displays based on the assigned

Weight and Conditions set.
l Dataform: Creates a dataform header widget layout that displays when

that dataform opens based on the assigned Weight and Conditions set.

Weight Determines the priority with which layouts are presented to the ClientSpace
user, meaning their placement in the list. All things being equal (conditions),
the weight given the layout determines what is presented. The greater the
weight number, the more likely the dashboard is selected. For example, a
weight of 20 is more likely to be selected than 15.

Add Widgets Select and add widgets from the widget library to your widget layout.

Set Conditions Use Set Conditions after you have added a widget layout to determine the
conditions under which a layout is displayed. These conditions range from
departmental or role-based to field value expressions, such as the status of a
client. The conditions that are available for use will vary based on the selected
Target Type.

Browsing the widget library
Next, let's browse the widget library, which is the current list of available widget types that you can add
to layouts. You can view the widget library from the Add Widgets action in the Widget Layout Details
form. This procedure continues from the previous steps.

To view the widget library:
1. From the Widget Layout Details form, click Add Widgets.

The Widget Library is displayed showing the current list of widget types that are available,
accompanied by a brief description of what the widgets display.
n Search: While the widget library is currently small and easily manageable, we envision the list

will grow to the point you may need to search to find the widget type you want to add.
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n Add Widgets: Select one (or more) widgets and click to add the widget(s) to your layout. You
can then re-arrange the widgets to your liking.

2. After you add widgets, you are returned to the Widget Layout Details form. The newly added
widget appears in the grid.

Configuring the widget and widget layouts

To configure the widgets and widget layouts:
1. From the grid, the Global Administrator can determine the size and placement of the selected

widgets.

2. Follow the numbers in the image and table.

1. Settings The settings control allows you to add settings to Widget Types that require
additional configuration. If the Widget type does not require configuration, the
settings control does not appear.

2. Delete Remove this widget from the layout.

3. Re-size Drag the arrow in the lower right corner of the widget to re-size the widget
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control. The system automatically snaps to the nearest grid line when you
release it. Some widget types cannot be re-sized, such as Notifications and
Watch. Attempts to re-size these widget types in your layout will lead to
unexpected behavior in the application.

4. Grid area The grid area represents the white space on the page for adding widgets to your
layout. To change your Widget Layout, drag widgets to this grid area.

Publishing the widget layout
Next, you are ready to publish the new widget layout. You can publish the widget layout after it is
saved.

To publish the new widget layout:
1. After you have configured your widget layout, click Save.

You are returned to the Widget Layouts list. Your new Widget Layout is displayed in the list as
unpublished. The newly added entry is displayed in italics and bold – meaning it is unpublished.

2. To publish the new widget layout, select the Published option (far right column).
3. To unpublish, clear the Published option.

Cloning widget layouts
To save time setting up widget layouts, locate an existing widget layout that is similar to the layout you
want to set up, clone it, modify it as necessary and then apply it to the desired home page, workspace
landing page, or dataform header.

To clone a widget layout:
1. Go to System Admin > Widget Layouts.

The Widget Layouts dashboard opens. From here, you can add and manage widget layouts for your
ClientSpace installation.

2. From the Widget Layouts list, you can do the following:
n Search / More: Works as the standard ClientSpace searches. By default, the list only displays

published widgets.
n Add: Click to add a new widget layout.
n Edit: Select a widget from the list and click to edit an existing widget layout.
n Delete: Delete a selected widget layout.
n Clone: Clone a selected widget layout.
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3. To clone a new widget layout, select the layout you want to clone by clicking it in the Widget
Layouts dashboard and then click Clone.
The Clone Widget Layout - Items form opens.

4. Complete the form:

Layout Name Enter the name of your new layout. It should be descriptive of layout type and
audience, for example, Payroll Home.

Note: If you do not enter a Layout Name, a system default name is created
for the new widget layout using the following naming convention:  Cloned
From {Original Widget Layout Name}.

Copy Conditions The Copy Conditions checkbox only displays if the original widget layout had
display conditions configured. Check this setting to copy those display
conditions to the new widget layout.

Copy Settings The Copy Settings checkbox only displays if one or more widget(s) on the
original layout supports configuration settings. Currently these include BI,
Image Display, Help Center, and Query Widgets . Check this setting to copy
these configurable widgets from the original widget layout to the new widget
layout.

Note: If you do not clone the widgets listed above, ClientSpace will rearrange
the layout by justifying the remaining widgets from the top of the new layout.

Publish Check this option to publish the new widget layout upon creation. (If you do
not want to publish the new layout now, leave it unchecked. You can click the
Published checkbox next to the new layout in the Widget Layouts dashboard
when you are ready to publish.)

See an example of the completed form below:
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5. Click Clone to create and save the new widget layout. The new layout is also published if you
checked the Publish option.

Related Topics:

l Adding Widget Layouts
l Adding security and display conditions

Adding security and display conditions
Adding conditions to your widget layout is essentially adding the trigger conditions that determine if
the widget displays.

Primary condition
This procedure continues from the previous steps, from an open Widget Layout Details form.

To set conditions:
1. Open a widget layout.

The Widget Layout Details form opens.
2. To set conditions on your widget layout, click Set Conditions.

The Execution Trigger Detail form opens.
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Area Function

1. Primary Condition The primary condition must be met before all other conditions are
evaluated. Primary Conditions are not required, but if present they must
be satisfied.

2. Add Additional
Conditions

Additional conditions allow you to configure complex display
conditions, which when combined with the weighting system provides
the ability to create complex trigger conditions when used in an
expression. When adding Additional Conditions, you will have a Label
field to complete. The Label value is used when constructing
Expressions.

3. Expression As conditions (other than the primary) are added, they act as an OR
condition. For example, adding three additional conditions without an
expression would mean: If 'This' or 'That' or 'The Other Thing' – then
display the widget. Expressions can be used to create more complex
conditions under which the widget will display. Example: "('This' AND
'That') OR 'The Other Thing'"
For an extensive discussion about conditions, see the topic Condition
expressions.

Departments and Security Entities
Departmental and Security Entity Conditions work in a similar fashion.

1. From the open widget layout, in the Execution Trigger Detail form, select Department or
Security Entity.
The Trigger Condition form opens.
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2. Departmental and Security Entity Conditions work in a similar fashion. For type Department or
Security Entity select the associated value. These are always an Equals condition.

Trigger Condition Options

Department Select the user's Default department as selected on the user profile. If a
Department trigger is set, the user must be in that department to satisfy
the condition.

SecurityEntity Select a Security Entity associated with a role in which the user is a
member. If an Entity trigger is set, the user must be in a role with at least
View access to that Entity.

Expression
When adding additional conditions, the Expression field is exposed. The option is used when building
condition expressions.

Field Value Expressions
Commonly used in Workflow, Field Value Expressions are the most robust of the trigger conditions.

Field Description

Type When FieldValueExpression is selected as the type, additional fields display to
allow configuration of the source dataform and associated elements.

Source Select the Dataform that determines the triggering condition.

Trigger Field Select the trigger field from the Source dataform.

Operator Select the logical operator:
l Equals
l Does Not Equal
l Contains
l Starts With
l Empty
l Not Empty
l Is Dirty
l Greater Than, and so on
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Field Description

The operators are field specific. If the Trigger field selected is a Text field,
numerical operators will not be available.

Trigger Value Trigger Value is the value to the right of the operator in the equation. The trigger
value determines whether the condition is met. For example: Pricing State
Source | State Field | Equals Operator | "FL" Trigger Value means "If the Pricing
State, State field Equals Florida."

Expression Label
(option)

When adding additional conditions, the Expression Label field is exposed. This is
used when building condition expressions.

Condition Expression: Bringing it all together
After additional conditions have been configured with labels, you can use these labels to build complex
Condition Expressions.

In the Dataform header widget example:

• The Primary condition is the Number Of Stories field, which must be greater than 2.
• If this primary condition is met, the system then analyzes the Additional Conditions using the

Condition Expression. This condition expression is built using the Expression labels on the
additional conditions and applying the appropriate logic. In the example, this would be:
• EITHER (the Owner Occupied field = 'Yes' AND (the Property State field equals 'GA' OR 'AL'))

ClientSpace Setup & Administration © 2025 PrismHR 569

Chapter 15 Widget layouts



• OR (the User has at least view rights to the biz_RequestTypeCategory_Environmental entity AND
(Number of Stories field is Greater than 5 AND the Property State field equals 'AZ'))

In this way, very complex trigger conditions can be built to display or hide the appropriate Widgets.

Configuring BI Reporting Widgets
Report widgets require additional configuration when creating a BI Dashboard. Any part of a report can
be added to a widget, including Charts.

From a BI report:

1. When configuring a BI report inside a BI Widget, to filter on #currentworkspace,
a. In Filter Field, add the fkprojectID from the client master.
b. In Operator, select Equals .

2. Leave Value blank.
3. Leave the Parameter selected.

To configure a BI report widget:

1. From the Widget Layout Details form, click Settings.
The Widget Settings form opens.
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2. Complete the fields:

Report Select the report to be used in your widget.

These widgets adhere to report security as well as report filters, such as
fkprojectid or pkorganizationid equals blank. The widget fills in this filter
when the report runs using its own Current Workspace filter logic. There is
no need to add a value into the report filter in BI. NOTE: if you try to add a
value, such as #currentworkspace into the BI report filter, it will not work in
the widget.

BI System Administrators and Global Admins can see the report filters.

Filter Select Current Workspace.

Type Select the report part you would like to include such as Chart, Summary, or
Detail.

Suppress Report
Header

When enabled (selected), the report header does not display. Default
setting is disabled (cleared).

Run On Demand When this setting is applied to a BI report widget, it does not load
automatically. It is triggered by a "Click to Load" link in the center of the
widget frame.
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Use this setting to prevent specific BI Report widget(s) from attempting to
load at once on Widget layouts containing a lot of BI Report widgets. This
can improve performance by reducing page load times.

Link Enter a website address as a fully qualified hyperlink (for example
,https://www.google.com instead of www.google.com) to convert the
Link Text(see below) into a hyperlink. Once the Link is entered, the Link
Text turns blue and it becomes an active hyperlink on associated Home
pages, workspace landing pages, or dataform headers and opens the
specified site in a separate browser window when clicked.

Note: You must enter Link Text to create a hyperlink. If either Link or
Link Text is blank, no hyperlink is created.

Link Text If you entered a Link (see above), enter the hyperlink text you want to use
here.

3. When you have completed your configuration, click Save Settings.

If you have any questions, please submit an Extranet service ticket to ClientSpace.
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Configuring the Client Contacts widget
Certain contacts appear in the Client Contacts Widget, but how does the system determine which
contacts to show? This topic describes how to configure which contacts are displayed on the
Workspace Landing Page widget.

To configure the Client Contacts widget:

1. Go to System Admin > Lookups.
2. Search for a lookup group of ContactTypeOtherInfo, and click (Open).

The Lookup Details form opens with the contact type you selected.
3. Select the option Show in Client Contact Widget.
4. Click Save.
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Configuring the Client Team widget
The ClientSpace workspace landing page is
the central hub for Client data. This is the
home of the configurable Client Team widget
and it allows up to 10 Client Team members
to be displayed. By default, it shows 4.

The header of the Client Team widget
contains a header bar with a link to jump to
the Client Team dataform as well as an
expansion control that allows the panel to
show more team members. Configuring the
widget involves configuring the Client Team
Role lookup value and associated metadata.

To configure the Client Team widget:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens. We will select a Client Team field to display on the
workspace landing page widget. Alternatively, you can add a new Client Team member by adding
a new user field to the dataform. Our examples use Snack Manager, which has already been
added.

2. Open the Team dataform and in the Action Center, click Fields.
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The list of fields displays.

3. Select a field and click (Open).

Our example uses Snack Manager.

4. Copy the field name.
Our example shows the field as fkSnackManagerID.

5. Go to System Admin > Lookups.
The Lookups dashboard opens.

6. Filter the list to match your selection. Our example uses Client Team Roles, fkSnackManagerId.
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7. Open the record.
The Lookup Details opens.

8. Find the corresponding Client Team Field lookup (or create a new one) making sure to paste the
field name you copied in the last step as the Code value. Our example uses Code as
fkSnackManagerID and Decode as Snack Manager.
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9. In Additional Settings, apply any lookup changes and display order (up to 10 Client Team fields).

10. Save your changes and refresh the Client Team dataform.

Widget List
Review the topics for specific widgets to learn about widget functionality and configuration settings
pertinent to the widget (if applicable).

Widget: Benefit Parent Company
The Benefit Parent Company widget displays the parent company or child company relationships on a
Benefits Batch. The widget contains links to the related workspaces so that you can quickly reference a
workspace while working on benefits offerings. This can help you maintain consistency in benefits
across related companies.

When you view the widget from a parent company Benefits Batch, the header of the widget displays as
Benefit Child Companies and all related child companies and associated workspace links are listed:

When you view the widget from a child company Benefits Batch, the header of the widget displays as
Benefit Parent Company. The related parent company and link are listed:
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If a workspace has no parent/child company relationship, the Benefit Parent Company widget displays
the following message:

To configure the Progress Bar Widget:

1. Go to System Admin > Widget Layouts.
2. Click (Open) next to the Benefits Batch layout in the grid to edit the widget layout.

Note: Typically, this widget is added to an existing Benefits Batch widget layout. If you are
creating a new Benefits Batch layout, also see Adding Widget Layouts.

3. Set the Target Type as Benefits Batch.
4. On the Widget Layout Details window, click the Add Widgets button.

The Widget Library window displays.
5. Click Benefit Parent Company and then click Add Widgets as shown in the example screen

below:
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The Widget Library window closes. The Benefit Parent Company Widget control displays on the
Widget Layout Details screen.

6. Optionally, move or resize the widget frame:
l To resize the widget frame: Drag the bottom right corner of the widget control to the

desired dimensions.
l To move the widget frame: Click anywhere in the blue area of the widget control area,

hold down the
7. Click Save on Widget Layout Details.
8. You are returned to the Widget Layouts list. If your widget layout is new, it is displayed in the list

as unpublished. (A new layout is displayed in italics and bold – meaning it is unpublished.)
9. To publish a new widget layout, select the Published option in the far right column.

10. Test the widget on a Benefits Batch dataform.
Note: If you make changes to the widget settings and return to an open dataform to test the
changes, remember to click the Reload button in the Action Center to refresh the form with the
latest changes.

Widget: Employee Detail Info

The Employee Detail Info widget is on the Workers'
Comp Claim and other Employee related forms. This
widget provides insight into the details of the Employee
/ Employment records without the need to expand the
record.

Widget Definition

Employee Data Employee name (EmployeeID) (Status).

Job Title Current Employee Employment Job Title (Workers Comp Code). Click
(Jump) to open the Employment record.
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Widget Definition

Employee Location Current Employee Employment Location. Click (Jump) to open the
Location record.

Last Hire Date From the Employment Record.

Pay Frequency From the Employment Record.

Last Payroll Date Most recent Pay Date from Employee Voucher records. Click (Jump) to
open the Employee Voucher record.

Widget: Employee Info

The Employee Info widget is on the Workspace
Landing Page when the Client Master Status is Client,
Pending Termination, or Terminated. This widget
provides insight into the variance of employee
counts from the Pricing Batch in relation to actual
payrolls produced. Employee numbers may appear
skewed in specific scenarios where the client is
seasonal or in cases where there are gaps in pay for
employees.

Widget definition

Active EE Count of the Employee records in the workspace where the Employment
Status = Active.

Payrolled EE (90 days) Count of distinct Employee IDs for Payrolls in the last 90 days.

Contract EE Sum of Employee Counts for each WC Code on the current activated Pricing
Batch. 

Variance Difference between the Payroll EE and Contract EE.
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Widget: Employee Info

The Employee Info widget is on the Workspace
Landing Page when the Client Master Status is Client,
Pending Termination, or Terminated. This widget
provides insight into the variance of employee
counts from the Pricing Batch in relation to actual
payrolls produced. Employee numbers may appear
skewed in specific scenarios where the client is
seasonal or in cases where there are gaps in pay for
employees.

Widget definition

Active EE Count of the Employee records in the workspace where the Employment
Status = Active.

Payrolled EE (90 days) Count of distinct Employee IDs for Payrolls in the last 90 days.

Contract EE Sum of Employee Counts for each WC Code on the current activated Pricing
Batch. 

Variance Difference between the Payroll EE and Contract EE.

Widget: Help Center
The Help Center Widget allows you to make your organization's external online documentation, such as
a Help Center, Knowledge Base or Wiki, searchable from the ClientSpace Home page. Your
documentation system remains its own external Help project. ClientSpace queries the system from
within a widget frame. The widget frame is a customizable Search page with a built-in Search field as
shown in the example below:
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Users can enter keywords and phrases in the Search field and then click the Search button (or press the
Enter key on the keyboard) to initiate a search of the documentation system. Search results display in
new browser tab.

Note: 
l Configuration by a global administrator is required.
l Your global administrator can optionally customize the background color of the widget Search

page to make it match your organization's branding colors, add a logo, adjust text font sizes, etc.
The example image shown above reflects several customizations including the addition of an
image, adjustments to font colors, font sizes and the background color. If no customizations are
made, the default settings are a white background with black text.

l Your organization can display unlimited Help Center widgets, each pointing to a different Help
system.

Configuration

Step 1: Add a Lookup Value to the Help Project Lookup Group

A Lookup Group named Help Project has been created in System Admin > Lookups > Manage
Groups). This is set up the URL record that ClientSpace will use to point to the Help system. You will
select this lookup value from the Widget settings later in the configuration.

Note: You can add unlimited lookup values to the Help Project lookup group. This allows you to set up
multiple Help Center widgets if desired, with each widget pointing to a different Help system.
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To add a lookup value to the Help Project lookup group:

1. Go to System Admin > Lookups.
2. The Lookups dashboard opens.
3. Optional: Locate the Help Project lookup group and review existing codes.

Note: This step is not required for initial setup but is recommended as you continue to maintain
the lookup group and add values to it over time. Doing this ensures you are not attempting to
add duplicate values.  

a. Click More.
b. Next to Show, click All. Note: Doing this shows any archived values that may be hidden in

the list.
c. Type Help Project in the Group field and then click Search.

e. Open the existing lookup records and review the Code and Decode values to ensure you
are not attempting to add duplicate values and then close the records.

4. Click Add on the Lookups dashboard.
The Lookup Details form opens.
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5. Complete the form:
Note: Any fields not listed below are either optional or not applicable for this configuration.

Group Select the Help Project group.

Code Enter the URL of the Help system.

Example: https://extranet.clientspace.net/Helpdoc/search.htm

Tip: If the Help system has a search results page, set the URL to point to it
(as shown in the example above) instead of pointing to the default page,
such as a Home landing page, that launches when you first open the system.
Then, when a user enters a search, the default page is bypassed and they are
taken directly to the search results. If you do not do this, the widget will still
function but may briefly display the default page before rerouting to display
the search results page.

Decode The Decode value displays in the Project drop down field in the Help Center
widget settings when configuring the Help Center widget.

Example: ClientSpace Help

Active Leave the Active checkbox selected if you want the lookup Decode value to
be available for selection when configuring the Help Center widget.

6. Click Save.
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Step 2: Configure Widget Settings

1. Go to System Admin > Widget Layouts.
2. Click Add Widgets to add a new widget layout or click (Open) next to an existing layout in the

grid to edit the widget layout.
3. On the Widget Layout Details window, click the Add Widgets button.

The Widget Library window displays.
4. Click Help Center Widget and then click Add Widgets as shown in the example below:
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The Widget Library window closes. A Help Center widget control displays on the Widget Layout
Details screen.

ClientSpace Setup & Administration © 2025 PrismHR 587

Chapter 15 Widget layouts



5. Drag the bottom right corner of the widget control to dimensions that will properly display the
Help Center widget Search page. (Once you finish configuring the widget and test how the
widget renders in the target location, you may need to adjust dimensions.)

6. Click the Settings button on the Help Center widget control.
The Widget Settings window displays.

7. Complete the following fields as applicable.

Title Enter the text to display in the title bar of the widget.

Message Enter the text to display on the Search page above the Search field. Use the rich text
editor toolbar settings to make customizations such as:

l Changing the font color of the text from the default of black:

l Adding a block of background color to text:

l Applying boldface, italics or underline styling:
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l Increasing or decreasing font size:

l Adding a logo or other image:

Tips:
l When changing text color or text background, there is a limited palette of

colors:
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To achieve an exact color to match branding, use an online color selector tool
or a desktop image editor's color selector tool to get the hex color code. Then

select the View HTML option on the rich text editor toolbar, enter the
hex color code and click Update to save the change:
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Note: You can use the View HTML option to make other changes and apply
other custom effects that are not available on the toolbar.

l To add an image, such as a logo, drag and drop the image from your PC to the
Messagefield. Then, drag the corners of the image. (It will resize
proportionally.)

l Consider experimenting with adding a table and embedding an image
(such as a logo) and any nearby text within its cells to hold those elements in
place and control spacing between them. Drag the cell borders of the table
cells to adjust cell widths and achieve the desired spacing as shown below:
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Backgrou
nd Color

Change the background color of the Search page. The default color is white.
You can create a custom color by dragging the selector along the color bar and then
dragging the selector in the color box to create a custom color. Alternatively, you can
type a hex color code as shown below:
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8. When finished configuring the Help Center widget, click Save.
You are returned to the Widget Layouts list. If your widget layout is new, it is displayed in the list
as unpublished. (A new layout is displayed in italics and bold – meaning it is unpublished.)

9. To publish a new widget layout, select the Published option in the far right column.
10. Test the widget by going to the target location identified in the Widget layout and adjust the

widget control frame as necessary to ensure proper display.

Related Topics:

l Adding Widget Layouts

Widget: Image Display
The Image Display widget displays a selected image on a defined Target Type: the Home page, any
single-form dataform header, or a workspace landing page. (See Adding Widget Layouts for details on
adding a new widget layout and a description of each Target Type.)

Optional configuration allows you (i.e., the Global Administrator) to also associate a link with the image
so that when the image is clicked, a separate browser tab opens to the location. The link source can
come from a field on a dataform or it can be specified in the URL field of the widget layout.
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Note: When you configure the widget layout, you are responsible for sizing the widget and selecting a
placement that allows the image dimensions to display properly.

To configure the Image Display Widget:

1. Go to System Admin > Widget Layouts.
2. Click Add Widgets to add a new widget layout or click (Open) next to an existing layout in the

grid to edit the widget layout.
3. On the Widget Layout Details window, click the Add Widgets button.

The Widget Library window displays.
4. Click Image Display and then click Add Widgets as shown in the example screen below:
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The Widget Library window closes. An Image Display widget control displays on the Widget
Layout Details screen.

5. Drag the bottom right corner of the widget control to dimensions that will properly display the
image. (Once you finish configuring the widget and test how the widget renders in the target
location, you may need to adjust dimensions to ensure the image displays properly.)
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6. Click the Settings button on the Image Display widget control.
The Widget Settings window displays. This is where you point to the location of the image that
displays in the widget and where you define hyperlink details (if you want the image to be used to
open a web location when the image is clicked).

7. Complete the following fields as applicable. Some fields display or hide according to their
relevance as you make selections. Therefore, all of the fields listed here may or may not display as
you configure the widget.

Location Defining an image Location is the starting point as you drill down from
an initial image location to the exact file upload field containing the
image you want to display in the widget.

o Current Workspace - Select this option to allow the system to
dynamically reference the dataform and file upload field of a
currently accessed workspace as the image source.

Example Use Case: You have added a widget layout with a
Target Type of Workspace. You want the Image Display widget
on the workspace landing page to change dynamically for users
depending on which workspace is open and always show the logo
of the current accessed workspace. To do this, select Current
Workspace in the Location field. Specify a single-form dataform
in the Dataform field, such as the Client Master, and then select
the file upload field containing the logo in Field. For the desired
outcome to occur, the following must be true:

n The specified dataform must exist for each workspace.
n The specified file upload field must exist on each

workspace.
n The specified file upload field must used solely for

storing a logo image for each workspace and cannot be
empty or blank.

If all requirements are met, the result of this setup is that each
time a user accesses a workspace (i.e., the "Current Workspace"),
the logo for the current workspace displays in the Image Display
widget on the Workspace Landing page.

o Other - Select this option to set the dataform and file upload field
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of a specific workspace as the image source. When you select this
option, the WSID field becomes available and is required. You
must enter a workspace ID in the field.

Example Use Case: You have added a widget layout with a
Target Type of Home. There is a static image that you want to
always display on the ClientSpace Home page. To do this, select
Other in the Location field. Specify the workspace ID in the
WSID field. Select a single-form Dataform , such as the Admin
Workspace, where you are storing the image for the Home page
and then select the file upload field containing the image in Field.
For the desired outcome to occur, the following must be true:

n The workstation ID must be valid.
n The specified dataform must be valid on the workspace
n The specified file upload field must exist on the

workspace.
n The specified file upload field must contain a file with an

image data type and cannot be empty or blank.
If all requirements are met, the result of this setup is that each
time the ClientSpace Home page is accessed, the selected image
always displays in the Image Display widget.

WSID WSID is active only when a Location of Other is selected. This field
allows you to pick a specific workpace ID as the image location. See the
example use case in this table under Location.

Dataform Select the Dataform where the image is located.
Note: The selection list is filtered to display only single forms as multi-
forms are not permitted for this configuration.

Field Select the file upload Field where the image is located.
Note: The selection list is filtered to display only file upload fields.

If the selection list is empty, no file upload fields exist for the selected
Dataform. Selecting a file upload field that does not contain an image
data type or is empty results in an error message displaying in the
widget frame. "See the Troubleshooting: Error Message Meanings"
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section for details.

Hyperlink Location Optionally, pick a Hyperlink Location if you want a web location to
display when the image is clicked. Select one of the available options:

o Field (on same form) - Select this option if the external link is
stored in a field located on the selected Dataform. When you do
this, Link Field displays as a required field. Click the down arrow
in Link Field and select the dataform field containing the external
link details.

o Hardcoded - Select this option to type the web URL for the link.
When you do this the URL field displays. Type the external link
details in this field.

Link Field Link Field displays when the Hyperlink Location is set to Field (on
same form). Click the down arrow in Link Field to point to a dataform
field that contains the external link details. This location displays in a
separate browser tab when the image is clicked.

URL  URL displays when the Hyperlink Location is set to Hardcoded. Type
external link details in this field. This location displays in a separate
browser tab when the image is clicked.

8. When finished configuring the Image Display widget, click Save.
You are returned to the Widget Layouts list. If your widget layout is new, it is displayed in the list
as unpublished. (A new layout is displayed in italics and bold – meaning it is unpublished.)

9. To publish a new widget layout, select the Published option in the far right column.
10. Test the widget by going to the target location identified in the Widget layout (i.e., the Home

page, a single form dataform header, or a workspace landing page) and adjust the widget control
frame as necessary to ensure proper display.

Troubleshooting: Error Message Meanings

The error messages below display in the widget control frame in red letters when the value in the Field
setting is invalid or missing.

Error Cause Solution

Unable to
Display, not
an image file

The file stored in the field that is being referenced in the Field
setting is not a recognized image data type of .gif, .jpg, .jpeg,
.png or .tif.

Upload an image
file with a
recognized image
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Error Cause Solution

type. file type.

No Image to
Display.

There is no file present in the field that is being referenced in
the Field setting.

Upload a valid
image file.

Related Topics:

l Adding Widget Layouts

Widget: Milestones

The Milestones widget displays a list of project
milestones. The Milestones widget can be
added to the workspace landing page. Project
milestone records are sometimes triggered by
workflow conditions or they can be manually
added by clicking (View Project
Milestones) > Add.

By system default, all milestone categories are
displayed. To pin a specific category as the
default view, click the down arrow and select
the desired category:

Then, click (Pin This Search) to set the
category as the new default view.

To restore the system default view, click
(Restore System Default).
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Widget: Payroll Batch Info

The Payroll Info widget is on the
Workspace Landing Page when the
Client Master Status is Client, Pending
Termination, or Terminated. This
widget provides insight into the
variance of the proposed payroll from
the Pricing Batch concerning actual
payroll. Payroll numbers may appear
skewed in specific scenarios where
the client is seasonal or in cases
where there are gaps in pay for
employees.

Widget Definition

Gross (90 days) The sum of Gross Payroll values for the last 90 days based on the Pay Date where
the payroll batch record has a Batch Type of R (Regular).

Additional
Compensation (90
days)

The sum of additional compensation values for the last 90 days based on the Pay
Date where the payroll batch record has a Batch Type of S (Special).

Annualized The sum of Gross (90 Days) multiplied by 4.

Average Wages The Annualized Payroll divided by a count of distinct Employees paid in the last
90 days.

Contract Payroll The sum of Gross Payroll for each WC Code on the current activated Pricing
Batch. 

Variance The difference between the Annualized Payroll and the Contract Payroll.

Widget: Progress Bar
The Progress Bar is a living status bar. It is designed to display at the top of a dataform. It updates when
a user sets a value in the dataform lookup field that you have designated to populate the Progress Bar.
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For example, you can use a Progress Bar on the Client Service Case dataform to display case statuses of
New, In Progress, Deferred, On Hold, Other, Complete, etc. The current status displays with a dark blue
background, prior statuses display with a lighter blue background while future statuses display with a
gray background.
Clicking the current status once collapses the prior statuses:

Clicking the current status a second time returns the progress bar to its prior state:

To configure the Progress Bar Widget:

1. Go to System Admin > Widget Layouts.
2. Add a new widget layout or click (Open) next to an existing layout in the grid to edit the widget

layout.
3. Set the Target Type . The Target Type must be a dataform, such as the Client Service Case

dataform.
4. On the Widget Layout Details window, click the Add Widgets button.

The Widget Library window displays.
5. Click Progress Bar and then click Add Widgets as shown in the example screen below:
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The Widget Library window closes. A Progress Bar Widget control displays on the Widget Layout
Details screen.

6. Click the Settings button on the Progress Bar Widget control.
The Widget Settings window displays.

7. Complete the following fields as applicable.

Widget
Title

Add a widget title. Example: Case Progress

Note: 
l Suppress Header must be unchecked to display a header.
l If you leave the Widget Title field empty (with Suppress Header unchecked), a

default header is displayed comprised of the form name and the name of the
Lookup Field you select to populate the progress bar. Example: Client Service
Case - Status.

Lookup
Field

Select the lookup group containing the values you want to use to populate the
progress bar.
Note:

l The system uses the lookup value Display Order setting to determine the order
in which statuses display on the progress bar. You may need to adjust the
display order of field values in the selected lookup to make the Progress Bar
widget represent a meaningful workflow for users. (See Configuring lookups for
details.)

l Lookup up values with no Display Order entered do not display on the
progress bar.

l Up to twenty (20) statuses are displayed. The first twenty (sorted by Display
Order) are used to populate the Progress Bar.

l A horizontal scroll bar is used on the target dataform to allow users to view all of
the statuses (up to twenty) if there are too many to display all at once on the
form:
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Suppre
ss
Header

Select this option to keep the widget header (i.e., Widget Title) from displaying.

Hide
Border

Select this option to keep the widget border from displaying.
Note: Hiding the widget border (and title) causes the progress bar to blend in to the
top of the dataform as if part of the dataform. Keeping the border and title retains a
traditional widget look and feel.

8. Click Save Settings.

The Widget Settings window closes and you are returned to the Widget Layout Details window.
9. Optionally, move or resize the widget frame:

l To resize the widget frame: Drag the bottom right corner of the widget control to the
desired dimensions.
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Note: If you are displaying a title and borders or a horizontal scroll bar is being generated
to display more than 20 lookup values, the default dimensions work well. If you are
suppressing the title and borders to achieve a status bar that blends into the top of the
dataform, you may wish to decrease the widget height to reduce the space between the
Progress bar and any widget you set to display beneath it.

l To move the widget frame: Click anywhere in the blue area of the widget control area,
hold down the left mouse button and drag it to the desired position on the grid.
Note: Ideally, the Progress Bar widget is set as the first widget displayed in the layout. It is
designed to display at the top of a dataform for an "at-a-glance" view of workflow
progress.

10. Click Save on Widget Layout Details.
11. You are returned to the Widget Layouts list. If your widget layout is new, it is displayed in the list

as unpublished. (A new layout is displayed in italics and bold – meaning it is unpublished.)
12. To publish a new widget layout, select the Published option in the far right column.
13. Test the widget on a dataform matching the Target Type you selected in Step 3.

Note: 
l If you make changes to the widget settings and return to an open dataform to test the

changes, remember to click the Reload button in the Action Center to refresh the form
with the latest changes.

l Error handling is built into the Progress Bar widget. If there is an issue with the widget
settings (such as no Lookup Field identification) that prevents the widget from rendering,
an error is displayed in the widget frame as shown in the example image below:

ClientSpace Setup & Administration © 2025 PrismHR 605

Chapter 15 Widget layouts



Widget: Query (XSLT)

The
Query
Widget
displays a
table

containin
g ClientSpace query results from a selected stored procedure in the following locations:

l Home page
l Workspace landing page
l Dataform header

Optionally, upload an XSLT file containing custom table styles in the Widget Settings. (If no XSLT file is
uploaded, the default ClientSpace table styles are used.)

A Refresh button in the Query Widget title bar allows you to refresh the widget to see the latest
updates.

To configure the Query Widget:

1. Go to System Admin > Widget Layouts.
2. Add a new widget layout or click (Open) next to an existing layout in the grid to edit the widget

layout.
3. On the Widget Layout Details window, click the Add Widgets button.

The Widget Library window displays.
4. Click Query Widget and then click Add Widgets as shown in the example screen below:
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The Widget Library window closes. A Query Widget control displays on the Widget Layout Details
screen.

5. Click the Settings button on the Query Widget control.
The Widget Settings window displays.

6. Complete the following fields as applicable.

XSLT File Optionally, upload an XSLT file containing custom table style settings. If you do not
upload a file, ClientSpace default table style settings are used.

Stored
Procedur
e

Select a stored procedure for the widget data.
Note: The stored procedures used to populate the list are in the Stored Procedure
Register and have a type of Query Widget.

Title Type a widget title. The title displays in the top left corner of the table header.

Suppress
Widget
Header

Select this option to keep the widget header from displaying.
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Force Late
Loading

When this setting is applied, a dataform with XSLT widgets will finish loading even if
the XSLT widgets on the page have not finished loading. Placeholders for the XSLT
widgets will be visible on the dataform while the widgets continue to load.

Link Enter a website address as a fully qualified hyperlink (for example
,https://www.google.com instead of www.google.com) to convert the Link Text or
Title (if no Link Text is entered) into a hyperlink. Once the Link is entered, the Link
Text or Title turns blue and it becomes an active hyperlink on associated Home
pages, workspace landing pages, or dataform headers and opens the specified site
in a separate browser window when clicked.
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Note: You must enter Link Text or a Title to create a hyperlink. If you enter Link
Text, the system uses it as the hyperlink text, overriding any Title field value that
may be present. If you do not enter Link Text, the system uses any Title field value
that may be present. If both Link Text and Title fields are blank, no hyperlink is
created.

Link Text If you entered a Link (see above), enter the hyperlink text you want to use here. If
you prefer to use the Title text as the hyperlink text, you may leave this field blank.

7. Click Save Settings.
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The Widget Settings window closes and you are returned to the Widget Layout Details window.
8. Drag the bottom right corner of the widget control to the desired dimensions. (The table widget

has horizontal and vertical scroll bars to allow users to view rows and columns that do not fit
within the frame dimensions.)

9. Click Save.
10. Test the widget in the selected display location (i.e., on a Home page, a workspace landing, or a

dataform header.)
Note: Error handling is built into the Query widget. If there is an issue with the widget settings
that prevents the widget from rendering, the error details are displayed in the widget frame as
shown in the example image below:
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Widget: Watch

The Watch widget
displays watch items
in a list. Watch items
are pinned dataforms
that you want to track
and review by a
specified Review
Date. The Watch
widget can be added
to the ClientSpace
Home page or to a
workspace landing
page.

Pinning Dataforms

To pin a dataform to the Watch widget:

1. Open the dataform.

2. In the Action Center toolbar, click (Add this Dataform to your Watch List).
The Select Review Date window displays with the Review Date field defaulting to the current
date.

3. Accept the current Review Date, type a different date, or click (Calendar) to select a different
date.
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4. Optionally, click the Freeze Review Date checkbox to preserve the selected Review Date if the
record is updated and saved.

Note: Watch widget functionality verifies the user who updates a dataform before determining if 
review date settings should be updated.

o If Freeze Review Date is selected, the Review Date for your pinned items stays the same
when you make changes.

o If Freeze Review Date is not selected, the Review Date for your pinned items stays the
same when you make changes.

o If Freeze Review Date is not selected, the Review Date for your items updates when
others make changes.

5. Click Save.
The watch item is listed in the Watch widget. The watch item name is comprised of the value from
the Default field of the “watched" dataform followed by the workspace name in parenthesis.
Note: If there is no Default field chosen for the dataform, then the dataform name will be
displayed.

Managing Pinned Dataforms

To manage Watch widget items:

l If the watch item name is greater than 50 characters, you will see an ellipsis after the 50 character
limit is met. To view the entire name, hover your mouse pointer over the watch item to see the full
description.

l By default, the view is set to Current. Current watch items have a Review Date of the current date
or prior (i.e., they are currently due for review or past due for review). Click the down arrow and
select All to switch to a view that includes currently due, past due and not yet due items.
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l To open the watch item dataform from the watch list, click (Jump) next to the watch item.
l To remove a pinned watch item from the list or to quickly edit a Review Date, access the Modify

Review Date window using one of the following options:
o From the Watch widget, click (Modify the Review Date).

o
Open a pinned dataform. Then, click (Remove this Dataform from your Watch List).
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Both methods display the Modify Review Date window.

From here, you can:
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o Update the review date in the New Review Date field.
o Select Freeze Review Date to keep the Review Date for your pinned items the same

when you make changes.
o Click the Unpin button to remove a pinned watch item from the list.

l To quickly see the review date associated with the form for the current user login, hover over the

pin icon in the Action Center:

Note: The hover text updates on dataform load. If you have recently applied changes to the

current form which affect the review date, you can click Reload to update the hover text.
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Chapter 16
Importing data
Need to know about imports and file uploads? Look no further! The following topics guide you through
best practices, importing CSV files, configuring nightly imports, and configuring the import mapping
record.

Best practices for standard imports
This process discusses the standardized data sets that should be captured with any client file upload.
The data falls into two main categories, and several scripts sets within those categories: Initial upload
scripts and Ongoing upload scripts.

Initial and ongoing script files import different sets of data. For example, initial load of the employee
records grabs all employees of Active clients. Thereafter, the ongoing script grabs all active and any
employee termed in the last three months. Further details of the differences are as follows.

Script Description

Company_initial  All Clients, active and termed not specifically excluded.

Company_ongoing  Smaller subset of initial data – but the filter criteria do not
change as the data set is small and Client termination data
needs to be captured.

Contacts Primary contact and address information for Clients main
division (Division 0)

Employee_initial  All employees of All Clients (Active and termed)

Employee_ongoing  All employees of Active Clients that are active or have termed
in the last three months.  If the client is utilizing the Workers’
Compensation claim system, they may want to broaden the
parameters to include termed clients.
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Script Description

Employment_initial/ongoing  All employees of Active Clients that are active or termed in
the last three months.

Employee Deduction Vouchers_Initial  All deductions from checks in the last year. This can be
filtered for specific deduction codes.

Employee Deduction Vouchers_
ongoing 

All deductions from checks in the last 21 days. This can be
filtered for specific deduction codes.

Locations All Physical locations, marking primary location as such and
all other locations as Alternate.

Voucher_initial  All payroll voucher data for employees that have collected
checks with an amount greater than 0 in the last 365 days.
More historical data can also be uploaded, but the standard
initial set is the last 365 days – uploading larger historical
data sets will require these sets to be broken down into
acceptable size chunks.

Voucher_ongoing  All payroll voucher data for employees that have collected
checks with an amount greater than 0 in the last 21 days.

Pricing Imports  While pricing data can be imported, this is not recommended
due to the inherent issues involved in data mapping. A
recommended best practice is to not import pricing data, but
to enter the data into ClientSpace on first re-price.

Managing Import Data
ClientSpace provides a powerful toolset to import and connect data with external systems. It can be
tricky to manage. Connecting imported data to existing data in the system is useful and requires
understanding your data and how the underlying tables relate.

When configuring imports, it is essential to understand the data relationships within your installation.
Each record to be imported must have a unique identifier (ImportID) as well as at least one column
containing a method for relating that imported record to another record in the system, be it an
Organization, Workspace, Contact, or a combination of these. An incorrectly configured import can
corrupt or overwrite existing data, which can then be difficult or even impossible to fix or replace.

When importing data, the system will only insert one instance of a single dataform into a workspace.
The system performs validation for single dataforms to prevent the creation of duplicates for a
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workspace. For example, if you attempt to import data into a single dataform in a workspace and there
is an existing single dataform of that type in the workspace but the import ID in the import file does not
match, the system will not insert the record. When this occurs, the system displays an error that
indicates the workspace already has a record, and that the import will not continue.

Now is the time to thoroughly map how the imported records tie to the existing data. If you need
assistance, please log an Extranet case. It is much easier (and frankly less expensive) to request help in
setting up an import than incorrectly importing records and then requesting help cleaning up the
associated fallout. This topic provides an overview of the functionality for managing system imports.

To perform data imports, you must be a Global Admin or be in a role with the SYS_
ImportManager security entity appropriately defined. For details, refer to Configuring import
management for non-Global Admins.

To manage data imports:

1. Go to System Admin > Imports > Manage Import.
The Manage Import dashboard opens. If you have never imported a file, the dashboard opens
without any files in the list. When there are no files, your options are limited to Adding a file.

2. Click Add.
The Upload File dialog opens.
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3. Click Choose File to browse to a local or network drive and select a file.

4. Click Save.

The file is listed in the dashboard grid area.

Note: 

l If you selected a file whose file name does not match one of the configured import mappings
in your installation, the following error displays:
Please correct the following error(s): The file you are attempting to upload does not match a
current Import Map Header and cannot be uploaded.

Log an Extranet case if you received this error and are not sure why.
l If you are uploading a large file where the Max Row Size field has been set on the Import

Map Header Detail window (System Admin > Advanced > Configure Import) to split a
single large file into smaller files to improve processing, a progress indicator may appear on
your screen while the files are being created as shown in the example image below:

Once processing is complete, you will see multiple files listed. Each file will have "X of X"
appended to the end of each file name to as shown in the example image below:
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Note that each file is validated and run individually and separate log files containing any import
errors will be created for each file.

See Configuring the Import Map Header and Managing Import Data.

5. When a file (or files) has/have been properly added, Validate File becomes available.
Validation compares the file structure to a preexisting import configuration to ensure that the file
has all the required columns. Additionally, high-level validation is performed to ensure that the
data types match the field into which the data is imported.

Successful validation enables the Run Import function.

6. With the record in Validate Complete status, click Run Import to begin the import process.
The action button reflects that the import process is Running. When complete, the action displays
as Completed.

7. To review the success of your import or troubleshoot import issues, open the record and use the
action item Links on the right: View File, Log File, Error Log File, Log Data, and Reset Status.
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l View File - Creates a download file in CSV format of your original import file in your Windows
Downloads folder. The import file opens in Excel by default.

l Log File - Creates a download LOG file (text file) showing the time stamp of when the import file
processing began and ended. It lists both import failure errors and warnings by row number and
lists a summary section of Rows Inserted, Rows Updated, Rows Skipped, and Rows Processed.

Log File errors include a detailed import failure reason:

EX: Error for Update Only Imports: Dataform Insert Not Allowed for data row [Row Number]
[Import ID]: - This Import Map configuration only allows Updates, not Inserts of new records. No
existing record was found based on the Record Source Column.

EX: Errors for Insert Only Imports:
o Dataform Update Not Allowed for data row [Row Number] [Import ID]: - This Import Map

configuration only allows Inserts. A record was found based on the Record Source Column
and cannot be updated.

o Dataform Saved Errors for data row [Row Number] [Import ID]: - This workspace already
has a record saved for this dataform. Please reload the page and try again.

The Log File opens in Notepad by default.
l Error Log - Creates a download file in CSV format of rows that did not import from the original

file. It does not include warnings. The Error Log File option only displays in the Action Center
when rows did not import from the original file.

Note: The error log file honors import map detail settings that determine whether an issue is
logged as an import failure. For example, if you have the Allow Invalid Lookup Values option
set on the Import Map Detail record of an imported lookup field, any records with invalid lookup
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values still import and will not appear in the Error Log. If Allow Invalid Lookup Values is not
checked, the record does not import the import failure is logged in the Error Log File.
The Error Log file opens in Excel by default.

l Log Data - Displays import failure errors and warnings by row number on your screen.
l Reset Status - Sets the row status back to "Ready for Import" removes all previous log

information. This is typically used when a row import fails and the reason for the import failure
can be fixed. The next step is to click Reset Status to place the row back in "Ready for Import"
status so that you can attempt to import the row again.

Note: Reset Status is only available to Developer and Global Administrator users.

8. To view the log data for import errors: 

• From the dashboard: Select the import record and then click View Log (located above the
dashboard grid area).

OR
• From the import record: On the dashboard, click (Open) next to an import file record and

then click Log Data in the Action Center.

The log data displays similar to the following:
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9. To view the error file for import errors: 

• From the import record: On the dashboard, click (Open) next to an import file record and
then click Error Log File in the Action Center.

This generates the error log file and saves it to your Windows Downloads folder as a .csv file. It
includes the original row number from the import file. Error log file contents appear similar to
the following:
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Note: If you use the Business Intelligence module, you can create a report showing import metrics.
View and/or schedule a report showing summary import metrics for multiple import processes in one
report. The following information is included: : Processing File Name, Rows Inserted, Rows Updated,
Rows Skipped, and Rows Processed. See Generating a BI Imports Report.

Review the data that you just imported for completeness. Navigate to the dataform in the
workspace and verify your work. Confirm that you have the expected number of records and that
the appropriate data appears in each of the imported fields.

Related Topics: 

l Configuring the Import Map Header
l Generating a BI Imports Report

Generating a BI Imports Report
If you use the Business Intelligence (BI) module with ClientSpace, you can run a Business Intelligence
(BI) Imports report to generate a report showing aggregated import metrics for multiple import
processes.

The report contains the following column data: Date Created, Date Updated, UF_File Name (Upload
File Name), Import Status, Rows Inserted, Rows Updated, Rows Skipped, Rows Processed, and
Row GUID.

The report interface also includes built-in filters for Date Created (Between), Date Updated
(Between), Import Status (Equals), and File Name. You can add additional filters by clicking the Add

New Filter button in the report interface header.
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For more information on building your own BI reports, see Reporting with Business Intelligence .

Data Sources Tab Settings:
The Imports report uses the following default data sources on the Data Sources tab.

Fields Tab Settings:
The Imports report is configured with the following default fields and field formats on the Fields tab..
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Configuring import management for non-Global Admins
You can allow users to upload and run imports without giving them the Global Admin rights. The SYS_
ImportManager entity provides access to manage imports through the Import Management module.

The steps to do this include:

1. Add the SYS_ImportManager entity to an existing role or add a new role. Ensure the appropriate
users are assigned to the role. (Global Admins must perform this step.)

2. Add the Run Import module to your user profile. (Non-Global Admin users can perform this step.)

Step 1: Create a new role (optional) or use an existing role
Determine if you need to create a new role or use an existing role. You need to be a Global Admin to
perform this step.

To begin:

1. Go to System Admin > Security > Roles.
The Security Roles dashboard opens.
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To create a new role:

1. Click Add.
The New Security Role form opens.

2. Complete the fields as specified.

Title Type Can Manage Imports.

Description Type Users in this role can manage imports.

3. Click Apply.
4. Go to Step 3 in the "To use an existing role" procedure below to add security entities and

complete steps 3 through 15.

To use an existing role:

1. Select and open a role from the list.
2. In the Action Center, select Entities.

The Security Role Entities dashboard opens.
3. Click Add.

The Add Role Entities dialog opens.
4. Select SYS_ImportManager and click Ok.

You are returned to the Security Role Entities dashboard with the newly added Entity Name.
5. On the SYS_ImportManager row, select the appropriate security entity rights for the role

assignment.
Note: The Delete option is not applicable for SYS_ImportManager security entity configuration.

View View rights must be assigned to open the module and view
the Manage Import window.

Note: Users with only View rights can also view any import
files they may have previously added at a time when they
were in a role with Add rights. However, without Add rights,
they cannot add any new upload files or otherwise interact
with their older upload files as the Run Import, Add, and
Cancel Import buttons are hidden.

View + Add • Users can open the module and view the import files they
upload on the Manage Import window.
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• Users can access the Run Import, Add, and Cancel
Import buttons to run and manage imports.

View + Add + Edit • Users can open the module and view the import files they
upload on the Manage Import window.

• Users can access the Run Import, Add, and Cancel
Import buttons to run and manage imports.

• Users can double-click a row on the Manage Import
window to view the Manage Import Details page where
import error messages are recorded in the Log File
and Log Data for the selected import.

View + Add + Edit + Admin • Users can open the module and view the uploaded import
files of ALL employees on the Manage Import window.

• Users can access the Run Import, Add, and Cancel
Import buttons to run and manage imports.

• Users can double-click a row on the Manage Import
window to view the Manage Import Details page where
import error messages are recorded in the Log File
and Log Data for the selected import.

6. Click Close on the Security Role Entities dashboard.
You are returned to the opened role.

7. In the Action Center, select Users.
The Security Role Users dashboard opens.

8. Click Add.
The Add Role Users form opens.

9. Select the applicable users and click Ok.
The newly added users appear in the Security Role Users list.

10. Click Close.
You are returned to the role form.

11. To close the form, click Cancel.

Step 2: Add the new module to your user profile
Now that the Run Import module is available and the new security entities have been added to a role,
users assigned to the new role can add the new Run Import module to their user profile.

User modules are selectable modules that you can configure by adding modules that you use most
often to the modules bar. The modules bar is located at the top of the workspace, providing quick
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access to your favorite modules.

To add modules to your user profile:

1. On the modules bar, on the right side, click <username> > My Profile.
The User Details form opens along with the Action Center panel on the right.

2. In the Action Center, click Modules > Select Modules.
The Select Modules dashboard opens.

3. Review the modules in the Available Modules list and locate the module to add.
4. To move the module to the Selected Modules list, complete the following drag and drop

method:
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a. Place the mouse cursor over the module name in the Available Modules list.
b. Press and hold down the left mouse button.
c. Move the mouse toward the Selected Modules list while still holding down the left

mouse button.
d. Move the module up or down in the Selected Modules list. When you have moved the

module to the desired location, let go of the mouse button.
5. Click Ok.

You are returned to the User Details screen. Your new module is listed in the Action Center, in the
Modules group.

6. Click Apply or Save.

To manage the order of the modules that display in the Modules bar:

1. Review the current order of the modules that display in the Modules bar.

2. The top to bottom module order in the Modules panel of the Action Center on the User Details
dashboard determines the left to right module order in the Modules bar. Review the modules in
the Modules panel and locate the module to move up or down in the list (for example,
Workspaces).

3. To move the module, complete the following drag and drop method:
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a. Place the mouse cursor over the module name.
b. Press and hold down the left mouse button.
c. Move the mouse up or down while still holding down the left mouse button.

d. When you have moved the module to the desired location, let go of the mouse button.

4. (Optional) Repeat step 3 for additional modules as necessary.
5. Click Apply or Save.

The modules in the modules bar update to reflect the changes.
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CSV Import File Creation Macro
To import .csv files into ClientSpace, the files must be appropriately formatted, with comma delimiting
and quote wrapping the text.  The following instructions walk you through creating a CreateCSV macro
and adding it to the Quick Access toolbar in Excel, which correctly formats the selected spreadsheet
data into an importable format. The information is excerpted from the Microsoft Office online help and
modified to include specific instructions for the CreateCSV macro. These instructions are designed for
Office 2010 and later.

Macros and the Visual Basic Editor
Microsoft Office allows you to run pre-recorded instructions on Excel data. To do so, you must write
your code in a place and in a way that Office can understand; typically, by using the Visual Basic Editor.
Although it is installed by default, many users do not know that it is even available until it is enabled on
the ribbon.

Developer tab

One tab on the Office ribbon is the Developer tab, where you access the Visual Basic Editor and other
developer tools. If Office does not display the Developer tab by default, you must enable it using the
following procedure:

To enable the Developer tab:
1. On the File tab, choose Options to open the Excel Options dialog box.
2. Click Customize Ribbon.
3. Under Choose commands from, select Popular Commands.
4. Under Customize the ribbon, select Main tabs.
5. Select the Developer option.
6. Click OK.
7. After Excel displays the Developer tab, note the location of the Visual Basic, Macros, and Macro

Security.
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Security Issues

To specify which macros can run and under what conditions, click Macro Security.

Although rogue macro code can seriously damage your computer, security conditions that prevent you
from running helpful macros can seriously undermine your productivity. Macro security is a complex
and involved topic that you should study and understand if you work with Excel macros.

For the purposes of this article, be aware that if the Security Warning: Macros have been
disabled bar appears between the ribbon and the worksheet when you open a workbook that contains
a macro, you can click the Enable Content button to enable the macros.

Also, as a security measure, you cannot save a macro in the default Excel file format (.xlsx); instead, you
must save the macro in a file with a special extension, .xlsm.

Visual Basic Editor

The following procedure shows you how to create a new blank workbook in which to store your
macros. You can then save the workbook in the .xlsm format.

To create a new blank workbook:
1. On the Developer tab, click Macros.

The Macro dialog box opens.
For Macro Name, type CreateCSV.
The Create function becomes available.

2. Click Create. 
The Visual Basic Editor opens with the outlines of a new macro ready.

VBA is a full-featured programming language with a correspondingly full-featured programming
environment. This article examines only those tools that you use to get started with programming, and
that excludes most of the tools in the Visual Basic Editor. With this caveat, close the Properties window
on the left side of the Visual Basic Editor, and ignore the two dropdown lists that appear above the
code.
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The Visual Basic Editor contains the following code:

VB
Sub CreateCSV()
End Sub

Sub stands for Subroutine, which you can define for now as macro. Running the CreateCSV macro
runs any code that is between Sub CreateCSV  () and End Sub.

3. Now edit the macro so that it looks similar to the following code. Feel free to copy and paste the
code below – everything between Sub CreateCSV() and End Sub.
VB
Sub CreateCSV()
            Dim lColumnCount As Long
            Dim lRowCount As Long
            Dim strFileName As String
            MsgBox ("This Macro will create a CSV version of the SELECTED ROWS
AND COLUMNS.  It will surround the cell data with quotes and separate each cell
with a comma.  Finally, it will replace any chr(10)s with chr(13)s.")
            strFileName = InputBox("Please enter the destination file
path.", "", "C:\Temp\Imports\" & LCase(ActiveSheet.Name) & ".csv")
            If (strFileName = "") Then
            Exit Sub
            End If
            On Error Resume Next
            Open strFileName For Output As #1
            If Err.Number > 0 Then
            MsgBox ("Error: The path you selected may be bad.")
            Exit Sub
            End If
            lColumnCount = Selection.Columns.Count
            lRowCount = Selection.Rows.Count
            Dim sValue As String
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            For lRow = 1 To lRowCount
            For lColumn = 1 To lColumnCount
            sValue = Selection.Cells(lRow, lColumn).Value
            If lColumn = lColumnCount Then
                        If sValue = "" Then
                        Write #1, ""
                        Else
                        Write #1, sValue
                        End If
            Else
                        If sValue = "" Then
                        Write #1, "",
                        Else
                        Write #1, Replace(Replace(Replace(Replace(sValue, Chr
(10), Chr(13)), Chr(14), ""), Chr(24), ""), Chr(25), ""),
                        End If
            End If
            Next lColumn
            Next lRow
            Close #1
            MsgBox ("CSV file created successfully.")
End Sub

When used this macro will take whatever columns and rows are currently selected in the workbook
and save them in the C:\Temp\Imports directory (if you have not already created this directory, an
"Invalid path" error will be thrown). The CSV file will use the Worksheet name as the file name and
save it with a .csv file extension.

4. Go back to the Developer tab in Excel and click the Macros button again.
You should now see CreateCSV as an option.

You just created and implemented custom VBA code in Excel. 

Making macros accessible
You can also get to the Macros dialog box from the View tab, but if you use a macro frequently, you
might find it more convenient to access it with a keyboard shortcut or a Quick Access Toolbar button.

To create a button for the CreateCSV macro on the Quick Access Toolbar, use the following
procedure. The following procedure describes how to make a button for a macro on the Quick Access
Toolbar:

To create a button for a macro on the Quick Access Toolbar:
1. Click the File tab.
2. Click Options and then click Quick Access Toolbar.
3. In the list under Choose commands from:, select Macros.
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4. Find the text that is similar to Book1!CreateCSV in the list that appears and select that text.
5. Click Add >> to add the macro to the list.
6. Click Modify… to select a button image to associate with the macro.

7. Click OK.
You should see your new button on the Quick Access Toolbar above the File tab. This CreateCSV
button will be available in any workbook now.

8. Now you can quickly run your macro at any time without using the Developer tab. Give it a try.

Configuring nightly imports
The ability to import data into ClientSpace provides a powerful toolset to connect your ClientSpace
data with external systems, but it can be tricky to configure. This topic provides a primer for on-demand
imports as well as some best practices to help make you a data imports expert. The ability to tie
imported data to existing data in the system is critical but requires an understanding of your data and
how the underlying tables relate.
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Importance of ImportIDs
When configuring imports, it is vital that you understand the data relationships within your ClientSpace
installation. Each record to be imported must have a unique identifier (ImportID) as well as at least one
column containing a method for relating that imported record to another record in the system, be it an
Organization, Workspace, Contact, or a combination of these. An incorrectly configured import can
corrupt or overwrite existing data, which can then be difficult or even impossible to fix or replace. 

If you have not spent the time to completely map this out or have questions about how the imported
records tie to existing data, STOP, and log an Extranet case. Request either help in configuring your
import or training about the import process. It is much easier (and frankly less expensive) to request
help in getting an import set up right the first time, than it is to incorrectly import records, and then
request help cleaning up the associated fallout. 

Why won't my imports run?
There is a maximum value of 10 mb for manual imports to ClientSpace. Attempts to validate manually
or import a file larger than 10 mb alerts the user that the file has exceeded this limitation and stops the
validation and run imports processes. Also due to the nature of imports, the standard user interface
time out value is far too short to be useful, so the timeout value for processing manual imports is 90
minutes (5400 seconds). If a manual import takes more than 90 minutes to run, the system times out
the process, stopping the import. Nightly imports that happen on a schedule are not subject to time or
file size restrictions.

Configuring the Import Map Header
ImportIDs are used by the import process to determine if a record already exists in ClientSpace to
update the record if it exists or create a new one if no match is found. Because of this, it is vital to have a
unique ImportID for each row of the import file that is distinct across the entire dataset. ImportIDs
should never be re-used unless the intention is to update an existing record. 

To begin creating a custom import:

1. Go to System Admin  > Advanced > Configure Import.
The Import Map Header Search dashboard opens.

2. Click Add.
The Import Map Header Detail form opens.
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3. Begin creating a new import configuration by completing the fields.

Source File This is the name of the file that you are importing. The file name
should include the file extension (commonly CSV). A best practice is
to add an asterisk before the file extension to account for variations
in the file name.

Dataform Select the dataform to receive the information. For example, if you
select the Employee dataform, the data is mapped to fields in the
Employee form. The system can import to dataforms associated with
the primary dataform in tabs.

Execution Order If the import runs automatically, in which order should the files
import? It is important to set this appropriately if you have multiple
dependent imports, such as an Employee Import, which depends on
the Client Import executing first.

Execution Pipeline When the imported records are saved, which pipeline will
execute? This determines which rules are applied when the data is
saved. Selecting Import, for example, runs the business rules,
triggers email templates, and triggers workflows with the import
pipeline selected.
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Note: If you are using the Pipeline Linking table to manage Pipeline
Behaviors and you are configuring a new import record, the pipeline
assigned a behavior of Default will auto-fill the Execution Pipeline
field. If you are editing an existing import record, the Execution
Pipeline entry remains intact until edited. If you change the entry, it
is validated against the Pipeline Linking table. For instance, if a
pipeline has been assigned a behavior of Allow or Default and you
remove it, you will still be able to select it from the Execution
Pipeline list. If the same pipeline is assigned a behavior of Disallow,
you will not be able to add it again.

See Configuring Pipeline Linking.

Import Type Options include:
l Nightly: Imports run from uploaded files created from

reporting either manually through Admin Settings or
automatically from a Windows schedule on the Server. In most
situations, this option is not available. For assistance, log an
Extranet case.

l API: Imports run using direct connection to an external system
by a scheduled process. When API is selected, API Path is
available on the Import Map Detail form (see Configuring the
Import Map Detail). Currently, the only import configured in
this way is the PrismHR API. For assistance, log an Extranet
case.

l Scheduled Process: Imports run from the Process Scheduled
Imports scheduled process. Files in Ready for Import status of
this type are automatically imported when the scheduled
process kicks off.

Import Action Options include:
l Insert: Only insert new records. Does not update existing

records.
l Update: Only update existing records. Does not insert new

records.
l Both: Insert new records and Update existing records.

Custom Import Class This field is only used if there is a specialized import code written by
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ClientSpace. Log an Extranet case if you have questions.

Execute Business Logic When selected (enabled), any Workflows, Email Templates, Hard
Errors, or Business Rules configured in the Execution Pipeline fire on
save of the data into ClientSpace. Soft errors on the pipeline are
ignored. Hard errors create Log Entries, and the associated record is
not imported.

Description Provide a brief description of the import. It is useful to use this area
to distinguish the purpose of the import and where the data to be
imported originates.

System When selected (enabled), only a developer user can configure the
Import Map Header and Fields. From the Import Map Header Search
dashboard, when this option is enabled, Add and Delete are not
available for global administrators.

Max Row Size This field is used to identify how many rows in the file will be
processed before splitting a large file into smaller pieces. This can
eliminate "timeout" issues with large uploaded files.

Special Import Only used for PrismHR technology custom import code.

Record Source Field This is the field on the selected Dataform (in the General fieldset) for
locating the record. Select ImportID or ID (Record Primary Key).

Record Source Column Specify the name of the column in the import file that contains the
value of the Record Type Field. The column name is used to match
the ClientSpace record you want to update. This is always compared
to the ImportID on the record to be updated. Cannot be identical to
the Workspace Identifier.

Workspace Source Field Specify the type of information on the Workspace Source Dataform
to locate the workspace. The administrator can configure an import
to select the appropriate workspace when inserting a row of data
based on the following:
l ID (Record Primary Key): Inserts/updates the record in the

workspace where the dataform of that type and RecordID
matches the Workspace Source Column from the source file.

l ImportID: Inserts/updates the record in the workspace where
the dataform of that type and the ImportID matches the
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Workspace Source Column from the source file.
l ProjectID: Inserts/updates the record in the workspace where

the WorkspaceID matches the Workspace Source Column
from the source file.

Workspace Source Column This is the column name on the import file that matches the
Workspace record in ClientSpace. Information in this field/column is
compared to the Workspace Source Field of the Workspace Source
Dataform. Cannot be identical to the Records to Update.

Workspace Source
Dataform

This is the dataform name that has the field to which you will match
the Workspace Source Column. The Workspace Source Field of this
dataform is matched against the Workspace Identifier column in the
imported file to select the appropriate workspace in which to put
the data.

Fields This is how you add dataform fields to your configuration. See
Configuring the Import Map Detail.

Active When Active is selected (enabled), the import is active. Inactive
imports are ignored.

4. Click Save.
5. Continue to the next topic Configuring the Import Map Detail to add fields.

Configuring the Import Map Detail
After you configure the Import Map Header (to select the dataform you will insert/update), the next
step is to add the fields using the Import Map Detail form. Add each field from the import file that you
want to import into ClientSpace, selecting the most appropriate values that match both the data you
are importing as well as the field into which you are importing the data.

To configure the Import Map Detail:

1. From the Import Map Header form that you just added/edited (in Configuring the Import Map
Header), in the right pane, click Fields.
The Import Map Search dashboard opens. The list presents the fields that have been added for
the Import Map Header.

2. To add fields, click Add.
The Import Map Detail form opens.
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3. Complete the required fields.

File
Column

Required. This is the exact column header name from the data file you are
importing. This field is case sensitive: Clientname is different from ClientName.

Dataform Select a dataform. The system then provides a list of fields from that dataform in the
Field list.

Field Select the field you want to populate. The Dataform selected on the Import Map
Detail must match either the Dataform selected on the Import Map Header Detail or
the tabbed forms related to that dataform.
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Tabbed dataforms always have a parent form field linked to the primary dataform
selected on the Import Map Header Detail and are associated with the primary form
as a tab. For information about associating tabbed forms, log an Extranet case.

Data Type Required. Indicates the type of information you insert into the field. The following list
describes the types of data that your file should contain and can include:
• Checkbox: Import file should contain a One for True and a Zero for False
• Date: Properly mm/dd/yyyy formatted date string (10/15/2016).
• Email: Properly formatted email addresses (for example,

<RecipientName>@<DomainName>.<TopLevelDomain>). The Email Data Type
uses the Default Value setting to determine how to handle a bad email address.
See Default Value Options (below) for more information about the actions for a
field with the Email Data Type.

• Foreign Key: Foreign Keys use the provided value in the file to match the selected
Table and Field in the configuration and set the foreign key stored in the field to
the primary key of the selected record.

• Lookup: Lookups use the provided value from the file and match that to the
ImportID of the configured Lookup field to select and store the appropriate
associated Code value in the field. If there is no ImportID, then the system
validates against the Group/Code value of the lookups to try and import.

• Number: Whole number or decimal.
• Phone: Formatted or unformatted phone number.
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• Text: Plain text value.
• Time: Similar to date, but should contain the Time value, such as 11:15 PM, that

you would like to store in the field.

Lookup
Table

When the Data Type Foreign Key is selected, use this required field to select the table
(in conjunction with Field) to match the foreign key passed from the file.

Lookup
Field

When the Data Type Foreign Key is selected, use this required field to select the field
(in conjunction with Table) to match the foreign key passed from the file.

Required
Value

When selected, the datarow value must be provided in the file (no blank cells), or the
default value must be entered. If neither of these is present, the system issues a
validation error.

Required
Column

When selected, this column must be in the header and datarow of the imported file
(blank values in the datarow use the default value configured).

Default
Value

You can configure this in several ways on a field-by-field basis.

1. Click None.
The Default Value Options dialog box opens.

2. You can configure the default value field to handle blank values using the
following options:

Standard Imports
• None: If the Import file column is empty, clears the dataform field.
• Current Value: If the Import file column is empty, it leaves the current value in the

dataform field.
• Specific Value: 

• If the Import file column is empty, set the value in the dataform field to the
value provided (for example, "UseThisValue").

• If there is a problem with the configured Default Value, the Current Value is
the default.

Imports with Email Data Type Fields
When you select a Data Type of "Email", the Validation Behavior field displays. This is
a required field used to configure ClientSpace behavior when a missing or invalid
email address is encountered in a PrismHR import record. If you choose the Use
Default Value option, a row with a missing or invalid email address will import but
the system applies a specified Default Value setting (i.e., a permitted substitution) in
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place of the missing or invalid email address in the import record. For complete
details on these settings, see the Validation Behavior field definition below.

Salesforce Imports
• None: If the Import file column is empty, clears the dataform field.
• Current Value: If the Salesforce field value is empty or API Path is set to

UseDefault, it leaves the current value in the dataform field.
• Specific Value: 

• If the Salesforce field value is empty or API Path is set to UseDefault, it sets the
value in the dataform field to the value provided (for example,
"UseThisValue").

• For User, Organization, or Contact fields, the provided value MUST be the PK
of the form to use (no decoding is performed, the raw value is used).

Salesforce Exports
• None: If the Salesforce field value is empty OR API Path is set to UseDefault, it

clears the Salesforce Object field.
• Current Value: If the Salesforce field value is empty OR API Path is set to

UseDefault, it leaves the current value in the Salesforce Object field.
• Specific Value:

• If the Salesforce field value is empty or API Path is set to UseDefault, it sets the
value in the Salesforce Object field to the value provided (for example,
"UseThisValue").

• For Account, Opportunity, or Contact fields, the provided value MUST be the
SalesforceID of the record to use (no decoding is performed, the raw value is
used).

3. When done, click Ok.

Allow
Invalid
Lookup
Values

This option is only available when Data Type is Lookup.
l When enabled, the Allow Invalid Lookup Values option allows column data to

be imported into the field that does not match the ImportID of a valid lookup
(this is normally required). For Lookup (core) and Lookup - Typeahead
datatypes, the invalid data is imported and displayed in the field. For multi-
lookups, the data is imported into the field but does not display. Enabling this
option allows these invalid values and logs the failed validation.

l When cleared, failed validations against lookups with importIDs are logged and
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not imported. If there is no importID on the Lookup value then validation will
occur against the Group/Code value of the records. If this fails then the failed
validations are logged and not imported.

When ClientSpace encounters a lookup error during import, the system displays a
message that indicates whether the import was successful (allowed) or if the import
failed (not allowed).
See Managing Import Data and Common import errors.

API Path Specifies the mapping path used to connect to a third-party API. This field is used only
for imports configured to access directly from a third-party system API. This field is
available when Import Type is set to API on the Import Map Header Detail form.

Validation
Behavior

When a Data Type of "Email" is selected, the Validation Behavior field displays. This
is a required field used to configure ClientSpace behavior when a missing or invalid
email address is encountered in a PrismHR import. Select a configuration option from
the drop down list. Available options are:
l Fail Entire Row: Fails the entire import file row when a missing or invalid email

is encountered. An error message is recorded in the Manage Import Details Log
File and Log Data.

l Use Default Value: Allows the row to import but applies a specified Default
Value setting (i.e., a permitted substitution) in place of the invalid email address
in the import record:

o None: Allows the row to import but sets the ClientSpace email field to
blank if the incoming value is invalid.

o Current Value: Allows the row to import but preserves the current value
in the ClientSpace email field if the incoming value is invalid.

o Specific Value: Allows the row to import but replaces the invalid email
address with a specified value in the ClientSpace email field. The Specific
Value is also validated. If the Specific Value is determined to be invalid,
the entire row fails.

Note: 
If you click the Required Value checkbox on the Import Map Detail screen and the
selected Data Type is "Email", "Fail Entire Row" is set by default in the Validation
Behavior field and cannot be edited (unless you uncheck Required Value). This
informs the system that an email field entry is required in each import row. If the email
value is missing (i.e., blank) in the import row, the row fails. No Default Value
substitutions are permitted.
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Descriptio
n 

A short description of the imported data being imported, such as the data source. For
example, "Payroll System, Client Address 1 field."

Active When selected, this field is actively included in the import and subject to associated
validation. Inactive rows are ignored on import.

4. To add multiple records, click Save & New. Else, click Save.
5. Continue adding fields, until you have included each field in the import file you would like to

insert into ClientSpace.

Activating Import Map Headers
Some of the ClientSpace Import Map Headers are scripted as inactive. Therefore, to use them, you must
activate the Import Map Header record.

To activate:

1. Go to System Admin > Advanced > Configure Import.
The Import Map Header Search dashboard opens.

2. In More Search, select All and click Search.
All records display to include Active and Inactive.

3. Locate the record and click (Jump).
The record opens.

4. Select Active to activate the record.
5. Click Save.

Importing the Comp Code Master records
Often during the initial setup of ClientSpace, you will need to import Comp Code master records, the
individual Code, and title description pairs. This document describes how to automate that process
using an import.

To automate the import process:
1. Go to System Admin > Advanced > Configure Import.

The Import Map Header Search dashboard opens.
2. Open the comp code master entry.

The Import Map Header Detail form opens.
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3. Click Fields.
The Import Map Search list displays, showing the fields.

4. To configure the two text data types, select an entry and click Edit.

Import Mapping Report
IMPORTANT NOTES: Your import must conform to the following standards:

• Comma-delimited files must have all values surrounded by quotation marks.
• Data cannot contain crlfs (char(10) and char(13)).
• File names, column headers, and column order must match the values contained in this report

exactly.
• The first row of the file must contain the column headers described in this report.
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• The column headers must also be surrounded by quotation marks.
• This import is used to load the comp codes that are missing from the Comp Code Master List.

Required Column Data Type

XXX Code Text

XXX DefaultInfoImportID

XXX ImportID

Title Text

Example Import file
"ImportID","DefaultInfoImportID","Code","Title"
"2150","1046","8810","Clerical"
"2576","1046","8742","Outside Salesperson"

DefaultInfoImportID = Identifier in the Admin Workspace URL = 1046

Be sure to set the ImportID field on the Default Info dataform to 1046.

Importing Tasks
You can import tasks, also known as incidents, from another application (other than Salesforce as
Salesforce imports tasks and other information using the Salesforce API.) New tasks or updated existing
tasks are updated in the correct ClientSpace workspaces.

Before you can import mass updates, you must first configure the Import Map Header, review the
business rule, create the Import file, and upload/run the import file.
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Step 1: Configure the Import Map Header and Fields
In this step, configure the Import Map Header and Details (the fields) for the source file CRM_
Incident*.csv. This file should already exist but please verify the configuration and add field mapping.

Locating the Import Mapping Source File

To locate the import mapping source file:

1. Go to System Admin > Advanced > Configure Import.
The Import Map Header Search dashboard opens.

2. Search for the Source File CRM_Incident*.csv.

Verifying the Import Map Header and Mapping Fields

To verify the Import Map Header and Map Fields:

1. From the Import Map Header Search dashboard, click (Open) next to the CRM_Incident*.csv
Source File.
The Import Map Header Detail form opens.

ClientSpace Setup & Administration © 2025 PrismHR 651

Chapter 16 Importing data



2. Verify the fields and edit if necessary. Note: This procedure does not include all form fields. It only
includes fields relevant for the setup of this import. For a complete list of definitions of all import
map header fields, see Configuring the Import Map Header.

Source File Type CRM_Incident*.csv.

Dataform Select Import_Incident.

Execution Pipeline Select Default.

Execution Order 10 is the default setting. It may need adjusting if you have multiple
imports and dataform dependencies.

Import Type Select Nightly. This means that the import will either be run
manually from System Admin > Imports > Manage Import or
if you can run it automatically from a Windows schedule on the
Server.
Note: The automatic option is dependent on several factors,
including the state of the import data from the external application.
If the file requires "clean up" prior to import, automatically kicking
off the file may not be possible. Please log an extranet case for
assistance making the determination. Please also see the article on
CSV Import File Creation Macro which outlines steps for developer
users who want to create a properly formatted import file using a
macro.

For additional assistance, log an Extranet case.

Import Action Select Both.

Custom Import Class Type ClientSpace.PEO.Import.ImportIncident.

Execute Business Logic Select this option. Enabling Execute Business Logic executes
business rules when the imported dataform is saved.

Custom Import Class Type ClientSpace.PEO.Import.ImportIncident.

Record Source Field This is the field on the form used to locate the record. Select Import
ID.

Record Source Column Set the value to IncidentPK. The value in this field must match the
column name in the import file, which means that the import file
you create must have a column named IncidentPK.

ClientSpace Setup & Administration © 2025 PrismHR 652

Chapter 16 Importing data

Asking_For_Help_Extranet.htm
Asking_For_Help_Extranet.htm


During the import process
This column determines if an existing task record exists. If so, that
record gets updated with this row's information. If not, a new record
is inserted.

Workspace Source Field Set the value to Import ID. This field is used to locate the correct
workspace.

Workspace Source Column Set the value to WSID. The value in this field must match the
column name in the import file, which means that the import file
you create must have a column named WSID.

Workspace Source
Dataform

Select Client Master.

3. Click Apply.
4. In the right pane, click Fields.

The Import Map Search dashboard opens. Now you are ready to add the mappings from your
import file (represented by File Column ) that correspond to the fields on the Import_Incident
dataform (represented by Dataform Field). Add mappings for the following Incident_Import
Dataform Fields, taking note of the Datatype as this must be specified on the Import Map Detail
record:

Dataform Field Datatype
Body Text
More Info Text
Category Text
Completed Date
Due Date Date
External Object Text
Completed By Text
Created By Text
Owner Text
Assigned To Text
Delete Text
Priority Text
Start Date Date

Import_Incident Fields and Datatypes
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Dataform Field Datatype
Send Notification Text
SourceID Text
Status Text
Subject Text

5. Click Add.
The Import Map Detail form opens.

6. Complete the mapping for the dataform fields.

7. Click Save & New.
This action saves the mapping and opens the form to add the next one.

8. When complete, you should see a list similar to following on the Import Map dashboard.
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Step 2: Review the Business Rule
Ensure that the Create Incident/Task business rule runs on the Default pipeline. Additionally, verify
that the rule is Active.

To review the Create Incident/Task business rule:

1. Go to System Admin > Advanced > Manage Business Rules.
The Custom Logic Rules dashboard opens.

2. In Quick Search, type %Incident/Task.
The Create Incident/Task rule displays on the dashboard.

3. Click (Open) next to the entry.
The rule details display.

ClientSpace Setup & Administration © 2025 PrismHR 655

Chapter 16 Importing data



4. Ensure that Default is present in Execution Pipeline.

5. Ensure that Active is selected.
6. Click Save.

Step 3: Create the Import File
Now you are ready to create the import file. The import file must contain the same column names as
the mappings you established in Step 1: Configure the Import Map Header and Fields.

The import file must be a CSV file containing the appropriate mapped columns plus the WSID and
IncidentPK columns used to locate the correct workspace and record when inserting/updating.

Step 4: Importing the Task Data
The next step is to import the file to insert and update task data. This can happen as part of a nightly
import or you can import manually. The steps in this section detail a manual import.

Before proceeding, be sure your file is appropriately formatted with comma delimiting and quote
wrapping the text. Follow the instructions in the topic CSV Import File Creation Macro to walk
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through creating a CreateCSV macro. Ensure that the file name begins with CRM_Incident and
ends in .csv.

To import task data:

1. Go to System Admin > Imports > Manage Import.
2. Click Add.

The Upload File dialog box opens.
3. Complete the fields and click Save.
4. When the uploaded file is added, click Validate File.

5. With the record in Validate Complete status, check the results of your validation. Open the record
and use the action item links, and select Log File.

6. If there are no validation errors, click Run Import to begin the import process. If there are
validation errors, make corrections before continuing.
The action button reflects that the import process is Running. The file is processed, and each row
is read and stored in the Import_Incident dataform until the task is generated. Then, the dataform
is deleted. Any errors encountered during file processing are stored in the Log File (without any
disruption to Import_Incident file processing). Finally, the imported task information is imported
into new ClientSpace task records within the correct Workspaces. When complete, the action
displays as Completed.

7. To review the success of your import, open the record and use the action item Links on the right:
View File, Log File, Log Data, and Reset Status. Log Data presents any errors during the import.

8. To view the log file for import errors, click View Log.

Related Topics:

l CSV Import File Creation Macro
l Configuring the Import Map Header
l Managing Import Data

Common import errors
Application Scope: CORE

Problem

Nightly data import has failed, generating an error log.

Cause
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Multiple possible issues - error describes the problem.

Solution

Errors can occur from a discrepancy between the Payroll system you are importing from and the state
of the data in ClientSpace. Some of the most common errors are as follows.

Company / Client Import

Error on data row ###: ClientSpace.PEO.Import.ClientMaster.GetOtherData(): Data cannot be imported
for Client Number #### because the status in the import file status (Client) is different than the status
in ClientSpace (Terminated).

l Most commonly occurs when the Client record is terminated in the Payroll system prior to being
terminated in ClientSpace. A best practice is to begin the termination process in ClientSpace to
utilize the workflow within the application.

Error on data row ###: ClientSpace.PEO.Import.ClientMaster.GetOtherData(): No record found for
ClientNumber ####.

l After the initial Company import, the process merely updates records and will not insert new
records. This error means a Client Number exists in the payroll system that does not exist in
ClientSpace.  Set up a stub Org/Workspace record for this Client Number and the next import will
synch up the data.

Error on data row ###:  ProjectID #### is associated with a workspace that does not allow imports.

l During pricing when the Contract Status changes to "Client" as part of the normal workflow,
many things are updated behind the scenes by business logic. One of these is a flag on the
Projects table to "AllowImport". This error occurs because the Client has been moved to Client
Status in Summit/APEX but still has not been completely processed through Pricing in
ClientSpace.  It is recommended that you move each of these workspaces through Pricing to
allow the AllowImport flag to be properly set. If due to the sheer number of records in this state
this solution is not practical, log an Extranet case to see if a scripted solution can be created to
place the records in a state where the import can be processed.**

CAUTION: Repercussions ** There will be repercussions if Workspaces are not allowed to
proceed through the normal pricing process. When a workspace is in "Client" Status, the system
assumes that any pricing generated is a Re-price and not an RFP. This means that workflow and
functionality associated with RFP pricing such as Underwriting Approval workflow and other
pricing functionality such as comparison batches are likely affected. To discuss the downstream
effects of making scripted changes, log an Extranet case before requesting such changes. 
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Location Import

Business Logic Errors for data row ###: - There is already a Primary location for this client

l Two Location records on the import file for the same Client Workspace are being set as the
Primary location. This normally happens if the Primary flag is set on more than one record, or
multiple locations share the same address as the main Client Address. Update the payroll system
to correct this issue and re-run the import.

Employee/Employment Import

The value (##-#######) in the "EmployeeID" column did not produce a valid lookup for data row #.
The value (##-#) in the "ClientLocationID" column did not produce a valid lookup for data row #.

l Both these errors are commonly caused by a failure in the Company Import, as the ClientNumber
doesn't exist, causing a snowball effect on the downstream imports such as Contact, Location,
Employee, Employment and Voucher.

The following error(s) were found in your submission: An active Employee record already exists for this
Identifier.(PrismHR API)

l This error only occurs with employees who work in multiple client companies. The PrismHR
system stores the Employee ID at the person level, so an employee can have the same Employee
Identifier associated with multiple Client IDs. ClientSpace handles this by concatenating the Client
Number and EmployeeID on the ImportID for the employee record - so 00395-Y14526. If this
ImportID was not properly set for some reason the system will be unable to find a unique match
and will throw this error.

Unable to include Queue Record in Import file, Employee 'R40816-000386' cannot be located in HRP
/PrismHR (HRP error - Employee import PrismHR error - Employment import) (PrismHR API)

l This error commonly occurs due to bad data in the PrismHR system - often the data does not
appear bad, but when viewed by PrismHR directly in the database there are bad values stored in
one of the fields - this most often occurs with date fields or specialty fields such as SSN. Contact
PrismHR and create a support case. Make sure to include the record information such as Client ID
and employee ID when logging your case with PrismHR.

Invalid Lookup Error logging

When ClientSpace encounters a lookup error during import, the system displays a message that
indicates whether the import was successful (allowed) or if the import failed (not allowed).
l If the Allow Invalid Lookup Values option is selected and the import encounters an error with a

lookup value, the error message indicates that the import was successful (was allowed). For
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example:
[01/13/21 15:49:16][509] No lookup mapping: Group:YesNo Code:T Column:YN2 Row:1.
Import will continue for this Row.

l If the Allow Invalid Lookup Values option is NOT selected and the import encounters an error
with a lookup value, the error message indicates that the import failed (was NOT allowed). For
example:
[01/13/21 15:48:22][509] Error on data row 1: No lookup mapping: Group:YesNo Code:T

Column:YN2 Row:1. Import has failed for this Row.

Errors common to all imports

The value (####) in the "ClientNumb" column did not produce a valid lookup for data row ###.

l This error means a Client Number exists in the payroll system that does not exist in ClientSpace. 
Set up a stub Org/Workspace record for this Client Number and the next import will synch up the
data.

Error on data row #: Row #: ProjectID #### is associated with a workspace that does not allow imports. 

l 'AllowImport' flag is set to 'No'. By default, after workspace creation the 'AllowImport' flag is set
to 'No' until the Workspace achieves 'Client' status at which time it flips to 'Yes'.  The Client exists
in the payroll system, but the Client Workspace is not yet a Client.  Update the Client workspace
to 'Client' status and re-run the import to synch up the data.

ERROR: Row column count is not equal to the expected count for data row ####

l The report that produces the import file is not properly quote wrapping empty values, resulting in
less columns in the data row than are expected from the header column count. Fix the report to
properly quote warp and comma separate the NULL data.

 ERROR: Object reference not set to an instance of an object. For any other questions regarding Import
configuration and errors, log an Extranet case.

l One of the key data values used to match the record in ClientSpace such as ImportID does not
match the expected value - the system found a workspace, but not the ImportID that your file has
associated hence the invalid object reference.  Fix the report to properly match the key data value
to the expected value.

- Rows Skipped - Dataform Insert or Update not Allowed:  ####

l The number or rows (####) were skipped because they did not meet the Insert/Update/Both
criteria - for example you have 2000 records in the file, but 1800 of them exist in ClientSpace and
the import is configured as Insert Only - the error message would read - Rows Skipped -
Dataform Insert or Update not Allowed:  1800
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Note: ** There is a known issue with the Error logging on Contact Imports. This error log reports '0
Records updated' even though updates are occurring. Records with errors are reported correctly in
this log. This issue is scheduled to be fixed in an upcoming sprint. Until this time, you should spot-
check the Contact records after import to ensure records that do not show as having import errors are
being updated correctly.

Importing ClientSpace report packages in Informer
Packages offer a method of easily transporting data (reports, mappings, security settings, etc.) from one
Informer instance to another.

For our clients who would like to import data into ClientSpace, PrismHR offers a standard set of reports
for the basic sets of data to include:

• Company
• Contact
• Locations
• Employee
• Employment
• Employee Payroll Vouchers
We also have several specialized reports should clients want to create Custom ClientSpace dataforms
for:

• Payroll Groups
• Payroll Schedules
If provided an account with sufficient rights, PrismHR can import these report packages for you. Should
you wish to import the packages yourself however, the following guide is designed to provide step by
step instructions about the package import process.

To import report packages:
When a package is exported to your hard drive, you can then import it into another instance of
Informer.

1. Open the targeted Instance.
2. Go to Admin > Packages.
3. Click Import Package.
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The Import Package dialog box opens.

4. Select either the downloaded file or enter the URL.
5. Click Next.
6. Go to Documents > Informer > NewPluginTestReports.
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7. Select the appropriate data source. DoNOT select Create New Datasource.
8. Click Import Now.
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9. You can also import from the Reports Home page.

Importing report packages in Informer
Informer is a web-based reporting utility that provides quick and easy access to data stored in
multivalued or SQL-based databases. Packages offer a method of easily transporting data (reports,
mappings, security settings) from one Informer instance to another.

1. Name: Name of the package to easily identify contents.
2. Last Modified: Last time package contents were changed.
3. Force Overwrite: Shows whether a user must accept changes in the package.
4. The download link puts the package on a drive where it can be imported from.
5. Alternatively, you can create a link that you can mail or use that will download the package.
After a package is exported to your hard drive, you can then import it into another instance of Informer.

To import a package:
1. Open the targeted Instance.
2. Go to Admin > Packages.
3. Click Import Package.
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The Import Package dialog box opens.

4. Select either the downloaded file or enter the URL.
5. Click Next.
6. Navigate to Documents > Informer > NewPluginTestReports.
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7. Select the appropriate data source. DoNOT select Create New Datasource.
8. Click Import Now.
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To export individual reports:
1. To export individual reports, you can use the Package link in the Report template.

2. As well as import from the Reports Home page.

External Source Linking
The External Source Linking table is used by the Salesforce API to link records in ClientSpace and
Salesforce. The Import (IMPORT_externalsourcelinking_*.csv) allows you to update existing records in
the External Source Linking table from the field Record Identifier. This field maps to the RowGUID field
(unique identifier) of the external source linking record to ensure the import updates the correct row.

The API system has a supporting import that imports External Source Linking records into
tblExternalSourceLinking. This imports new and existing records. The primary purpose of this import
is to seed the external source linking record in preparation for implementing an integration, such as
Salesforce.
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This import is based on the following configurations:

l Uses the PEO staging form gen_ImportExternalSourceLinking
l Rule CreateExternalSourceLink must be configured on form gen_

ImportExternalSourceLinking
l No soft or hard errors are available during the import process

Using the dashboard
From the External Source Linking dashboard, Global Administrators and Developer users can manage
the data contained in tblExternalSourceLinking. The dashboard is like a library of connections. The
dashboard is accessible from System Admin > Imports > External Source Linking. It is also
accessible from all dataforms and from the following CRM forms:  Organization Detail, Contact Detail,
and Task Detail by going to Action Center > More options > External Source Linking.

You can perform searches plus Add, Edit, and Delete records.

To access the dashboard:

1. Go to System Admin > Imports > External Source Linking
OR
Go to any dataform in a workspace or CRM form (such as Organization Detail, Contact Detail, and
Task Detail) and access it from Action Center > More options > External Source Linking.
The External Source Linking dashboard displays a list of API records.

2. To open a record, click (Jump).
The External Source Linking dialog box opens, showing the imported fields.

3. You can review, add, edit, or delete entries.
The fields and descriptions are as follows:

API Configuration List of library connections.

ClientSpace Table Name The ClientSpace table name for the selected API.Auto-filled when
added from a ClientSpace object such as tblOrganization,
tblContact, tblIncident (task) ,gen_Whatever (ClientSpace Table).

ClientSpaceID This is a generated ID for ClientSpace that maps to the External ID
of the connection.
ClientSpace RowGUID for the ClientSpaceTableName table

External Object Name of the external object. External Object Type, such as Account.

External Object ID The ID of the external object that maps to the ClientSpace ID.
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Export Status The status of the external integration. This field is editable only by
system admins. These values are modified by a system process.

Integration Log Information about the integration. This field is modified by a system

process. However, you can click Add New Log Entry to
manually append a log entry. You cannot edit or delete existing
entries.

4. Click Save.

User Imports
Users are imported into the External Source Linking table using the IMPORT_externalsourcelinking_
*.csv import map. The ClientSpaceID value is tested against the Users table UserGUID field. If a match is
found, the record is inserted into the linking table (non-matching ClientSpaceIDs cannot be inserted
into this table).

The IMPORT_user*.csv import includes Immediate Supervisor and Default workspace. These fields are
imported on both insert and update for internal users, and updates to external users (External users
cannot be created from an import).

How Does ClientSpace Handle External Source Linking Record
Creation When More Than One Salesforce User Record is Associated
with the Same Email Address?
When importing a Salesforce user record into ClientSpace, ClientSpace checks the user mapping
(System Admin > Advanced > Configure Import > Fields > OrgAssignedTo) and then verifies the
email address associated with the user mapping (using the Owner ID) and the Salesforce ESL User table
in ClientSpace.

l If the email address already exists in the Users table: The existing ESL is updated with the
External Object ID of the user who created the Salesforce Work Queue item.

l If the email address does not exist in the Users table: A new ESL record is created.
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Why is API Configuration not Displaying and not Saving When Trying
to Create an External Source Linking Record?
If a custom link uses a custom function that references an API configuration and that configuration is
inactive, the system will then:

l Will not display the existing external source linking record
And

l Will not allow the creation of a new record using that inactive API configuration
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Chapter 17
Scheduled Processes
Scheduled processes are executable code that runs on a schedule, such as contact syncing or polling
the DocuSign system to retrieve document status. Processes are scheduled based on frequency,
frequency type, and valid days. Access to the Scheduled Processes Admin dashboard is only available to
system admins and users with access to the Advanced settings.

To view your scheduled processes:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. To view the configuration, double-click the selected row or click (Open).

Schedule Sleep TimeWindow for Your processes
Use a sleep time window for a scheduled process to prevent the system from running the scheduled
process during that time frame. A developer user can set the days, start time, and end time for a sleep
window. For example, if a system undergoes weekly maintenance from 1:00 AM to 5:00 AM on Sunday
mornings, a developer user can set a sleep time window for a scheduled process to avoid running the
process during the system maintenance. The developer user can set the sleep window for the process
to occur on Sundays with a start time of Midnight and an end time of 6:00 AM (to overlap the
maintenance time frame). During the sleep time window, the system prevents the scheduled process
from running. Using a sleep window for scheduled processes can minimize the chance of an error
occurring during a scheduled process due to conflicts that might occur during activities like system
maintenance.

To view your scheduled processes:

Note: This procedure is for developer users only.

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. To view the configuration, double-click the selected row or click (Open).
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3. Complete the information in the Developer Options: Sleep Window Settings fields set.

Field Description
Days
Of
The
Week

The Days of the Week that will make this Scheduled Process sleep if it is triggered.

Start
Time

The starting time of the Sleep Window. Applies to each selected Day.

Note: If the Start Time and End Time are the same time, or if the Start Time is not blank
and the End Time is blank, the Sleep Window will be for that whole hour. For example, if
the Start Time field contains 1 AM and the End Time contains 1 AM, the time frame for
the Sleep Window is 1:00 AM to 1:59 AM .

End
Time

This field indicates the end time of the sleep window. This setting applies to each day that
you indicated in the Days of the Week field. End time always runs through the end of the
hour selected, so selecting 1 AM as the end time means the sleep window will run through
1:59 AM.

Note: If the Start Time and End Time are the same time, or if the Start Time is not blank
and the End Time is blank, the Sleep Window will be for that whole hour. For example, if
the Start Time field contains 1 AM and the End Time contains 1 AM, the time frame for
the Sleep Window is 1:00 AM to 1:59 AM .

Sleep Fields

4. Click (Save).

Queuing Your Processes
Scheduled processes are Advanced Administration functions. Global administrators can queue
scheduled processes from the Scheduled Processes Admin list from the Queue Process function. When
you queue a process, it sets the Next Run Date to Now and updates the Queued column to 1. If you try
to queue a process that is currently running, you receive an alert to wait for the process to finish
running before queuing it again. In some cases, processes inactivate after they have run. However,
many processes stay active all of the time.

To queue a scheduled process:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.
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2. To queue a process, select an entry, and click Queue Process.
Queue Process sets the Next Run Date to the current date and time so that the process initiates as
part of a scheduled process run, instead of running immediately.

3. To edit the frequency of a process, select the entry, and click Edit.
The scheduled process form opens, ready for your edits.

4. To save your changes, click Save.

List of scheduled processes
The following list comprises both CORE and PEO level scheduled processes, with CORE processes
marked with (CORE).

Scheduled process name Description

ActivatePending Find all Client workspaces with Pending Activation status that
have an activation date equal to or less than today’s
date. Change their status to Client and their Pricing Batch
Status to Activated if using pricing.

Approval Expirations Compare the Date Approved field of the pricing batch to
today’s date and the Approval Expiration # of Days on the
Default Info form of the Admin workspace. If the difference
exceeds the default, expire the pricing batch.

Auto Archive BI Reports Finds Business Intelligence reports that have not been run in
120 days and archives them. (These are default parameters
that can be changed. See Configuring the Auto Archive
BI Reports scheduled process.)

Benefit Batch Activations Activates Benefits Batches in "Pending Activation" status on
their renewal date. If the Effective Date of the batch is less
than (<) today's date, the Status field on the batch changes
from "Pending Activation" to "Active". The process is
scheduled to run daily by default.

BenefitActivations Activates Benefits Plans and associated Offered Plans that are
in Pending Activation status and Effective Date is on or
before the day this process executes.
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Scheduled process name Description

Bidirectional Contact Sync HRPBiDirectionalContactsSync. For Initial Imports, it only
retrieves ClientSpace Clients in Client, Terminated, and
PendingTermination status.

BrokerOutstandingProposalsEmail Generates and sends an email to the primary contact of
Broker Orgs that have associated client workspaces with
a Client Master status of Submitted with a subject line of
Outstanding PEO Proposals with XXXX - XXXX being the
name of the ClientSpace PEO organization.

CaseTypeRowLevelSecurityUpdate Find missing row-level security settings for Client Service
Cases with secured Case Types and inserts or updates as
needed. Deletes row-level security when case type security
has been removed for a role.

ClientSpace Digest Daily (CORE) Sends daily digest of follow-ups.

ClientSpace Digest Weekly (CORE) Sends weekly digest.

CriticalCaseNotification Sends Critical Case notification email with case list. Case
priority must be critical – sends emails to members of Admin
roles.

Delete Email (CORE) Delete all emails and associated attached files older than 30
days from today.

Delete Marked Task (CORE) Find all incidents marked for deletion and delete the
following: Incident Users, Template Triggers, templates
marked for delete, Incident Contacts, Uploaded files attached
to incidents, binary files attached to incidents, and finally,
incidents.

Delete Orphaned Time Records
(CORE)

Deletes time records that are > 1 day old and have no
associated record or workspace.

DocuSign Get Docs Status (CORE) Polls the DocuSign system using an API to find documents
matching Queue records and retrieves the current status of
those docs. Requires a DocuSign account.
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Scheduled process name Description

DocuSign Request Signature (CORE) Polls the Uploaded File Queue for docs in New status then
post the records to DocuSign using an API to request
signatures of the addressees of those docs. Requires a
DocuSign account.

Expire Passwords (CORE) Automatically Expires user passwords based on Install
Security setting and Password Change Date on the user
account.

Expire Sessions (CORE) Automatically Expires user sessions after a set amount of
inactivity based on Install Security Setting.

External Source Linking Cleanup When deleting dataforms and workspaces, External Source
Linking Cleanup deletes any associated external source
linking records to prevent orphaned entries. A warning
message is displayed when deleting dataforms and
workspaces with External Source Linking records.

FileManagement Cleanup (CORE) Interrogates the file linking table for unprocessed links,
determines if they are not orphaned, removes the link if
orphaned, and marks the associated file for deletion. Then
finds all files marked for deletion in uploaded files binary and
uploaded files tables and delete them.

Generate OSHA Forms Runs yearly to generate OSHA forms and append the
resulting attachments to the OSHA Forms dataform of each
associated workspace.

Generate Recurring Tasks (CORE) Evaluates a recurrence table to identify the tasks to be
generated. This only functions on non-
template recurring tasks. The task that is configured to
generate recurring tasks is the Primary task; those generated
from this task's configuration information are Recurring tasks.

Generate Scheduled Workflow Find all scheduled workflow from the Workflow Item table
and trigger scheduled workflows for each based on Date
Offset and Grace Period.
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Scheduled process name Description

Generate Scheduled Email Templates Find all scheduled email templates from the Email Template
table and trigger scheduled emails for each based on the
fields in the Scheduled Email Scheduled Email Action section
of the Step 1 Initial form. This includes Scheduled Field,
Date Offset and Grace Period. See Configuring Scheduled
Email Templates.

Import Cleanup (CORE) This scheduled process deletes the following:
l Completed import files that are ImportComplete and

are greater than 5 days old.
l Completed import queue records that are Completed

and greater than 1 day old.
l Import records with the Status of UploadComplete

that are greater than 1 day old.
l Import records with the status of ImportCanceled that

are greater than 1 day old.
l Import records with the status of ImportInProgress

that are greater than 30 days old.
l Import records with a status of ImportFailed that are

greater than 30 days old.

Manage Non-Active Users (CORE) Internal and External users who have not logged in during
the last 30 days are hibernated. External users who have not
logged in the last 180 days are expired.

Marketo Leads (CORE) Polls the Marketo system using a configured API to
synchronize Lead data. Requires a Marketo account.

Move Queued Files (CORE) Get all files that need to be moved. Create an uploaded file
object for each. Move each file and delete the binary file if
successful.

Offered Benefits Plan Summary
Update

Insert Offered Benefit Plan Summary records on a nightly
scheduled process replicates the data grid from the header of
Offered Benefits Plan dataform for cross workspace reporting
purposes.
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Scheduled process name Description

PFML - State Compliance (Daily
Aggregator

This process supports Delaware's PFML State Compliance. It
identifies active clients with employees in Delaware and
counts active Delaware employees, including those from
related clients. The count of active employees, along with
other programming logic, is used to generate a new PFML -
State Compliance record on the client workspace. The PFML -
State Compliance record is then used to trigger email
templates to the Payroll Specialist on the PEO client team
when the number of Active employees at a company (and
any related companies) reaches a combined threshold that
may require the start or stop of FMLA contributions by the
company.

PrismHR Employee Sync With Prism This process synchronizes ClientSpace Employees with
PrismHR. It validates that Employees in ClientSpace (for
Companies that have Client Numbers in PrismHR) are in
PrismHR. If the Employee record is not in PrismHR, it sets the
Employment status to Deleted and inactivates the Employee
record. This process is scheduled to run once and then
inactivates.
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Scheduled process name Description

PrismHR Bill Records This process exports Workers Compensation
Claim Deductible Billing records to Prism HR when the billing
records are in "Ready to Bill" status (and where the WC
Deductible Bill Opt-Out setting on the Client Master record
of each associated client workspace is unchecked.) It creates
a "Bill Pending" record for each exported bill in PrismHR. Bill
Pending Comment text, if entered, is also exported to the
Comments field of the Bill Pending record in PrismHR. Upon
a successful export, the process updates the status of the
Claim Deductible Billing records in ClientSpace to "Billed" and
writes "Successfully Created Bill Record in Prism" to the
Export Log field of the exported Claim Deductible Billing
records. If the export is not successful, the process updates
the status of the Claim Deductible Billing records in
ClientSpace to "Failed to Export" and writes an error message
to the Export Log field of the affected Claim Deductible
Billing records.

Note:
l Multi-tenancy is supported.
l Contact Professional Services for assistance configuring

API parameters.
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Scheduled process name Description

PrismHR Export Contacts This process exports any contact to PrismHR when the Sync
With PrismHR checkbox on the contact is checked.
The Sync With PrismHR is checked when a user adds a new
contact or when a user updates any of the following fields on
an existing contact:
l contactName
l contactTitle
l contactPhone
l contactPhoneExt
l contactEmail
l comments fields

Note: If these fields changed due to the PrismHR API, the
system does not export the change to PrismHR.

PrismHR Import Initial Locations This scheduled process uses the HRPAPI_initial_
location*.csv import configuration (must be active) to
retrieve a list of Active ClientMaster records where Client
Number is not empty. These Client Numbers are then
matched in PrismHR and used to create a list of locations for
each client. If the client number cannot be matched in
PrismHR, the client is ignored. For Initial Imports, it only
retrieves ClientSpace Clients in Client, Terminated, and
PendingTermination status.

PrismHR Import Initial Sync This processes the Clients to Sync and import remaining
active Import Map data (employee, employment, location).

PrismHR Import Ongoing Only imports ongoing data for Clients that exist in
ClientSpace.
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Scheduled process name Description

PrismHR Import Payroll Batch
Ongoing

The PrismHR Import Payroll Batch Ongoing scheduled
process is one of two Payroll Batch scheduled processes. It
works in conjunction with the PrismHR Import Payroll Batch
Sync scheduled process.

Note: This breakout was done to prevent system
performance issues that could arise when large payroll
batches are processed at once.

Runs first on batches marked Complete in Prism to process
basic payroll information.

PrismHR Import Payroll Batch Sync The PrismHR Import Payroll Batch Sync scheduled process is
one of two Payroll Batch scheduled processes. By default, it
runs on weekends (Saturday and Sunday) to process billing
vouchers, pay groups and costs based on employee count
from payroll batches. It works in conjunction with the
PrismHR Import Payroll Batch Ongoing scheduled process.

Note: By default, only 250 payroll batch records may be
returned and processed at one time. This setting is controlled
by the BillingBatchCount in the PrismHRAPI configuration.

If the Sync with PrismHR checkbox is checked, the PrismHR
Import Payroll Batch Sync schedule process runs after the
PrismHR Import Payroll Batch Ongoing scheduled process on
batches marked Complete in Prism. It processes billing
vouchers, pay groups, and costs based on employee count
information are processed. This process is set by default to
Active and to only run on weekends.

PrismHR Import Queue Initial Clients This scheduled process obtains a list of all clients available
through the PrismHR API, creates Import records for each,
and sets the Sync with PrismHR flag on the Client Master for
each Client imported (company initial import map HRPAPI_
initial_company*.csv MUST be active). The company initial
import map contains the Sync with PrismHR column (scripted
out as active) to allow the setting of that flag on the Client
Master.
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Scheduled process name Description

PrismHR Import OSHA Location Data
CLIENT

This scheduled process is queued from the link on the Client
Master called Retrieve OSHA Location Totals. This link will
check OSHA Location Totals (Import) on every location for
the client. After the process is run, the checkbox is unchecked
on the location.

This scheduled process runs every 15 minutes and obtains
location totals from PrismHR when the user has requested
location totals. This process excludes location totals if the
Obsolete Date on the Client Location dataform does not fall
within the current OSHA year. If the Retrieve OSHA
Location Totals (Import) field on the Client Location
dataform is selected, this process retrieves location totals for
each location that is not obsolete in the workspace. The
scheduled process retrieves totals for the current year from
PrismHR.
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Scheduled process name Description

PrismHR Import OSHA Location Data This process is typically run yearly to pull in the previous
year's worth of OSHA location totals on every client. This will
not bring in the current year's OSHA location totals. You can
update the number of years, via the PrismHRAPI API
Configuration using the OSHAYearsToProcess parameter in
the PrismHR API Configuration. EX: Enter 1 for 1 year of data.
2 for 2 years of data, and so forth.

Note: You must also enable the SyncOSHAClients
parameter in the PrismHR API Configuration by setting it to 1.

This process excludes location totals if the Obsolete Date on
the Client Location dataform does not fall within the selected
OSHA year (or years). The process obtains Total Hours
Worked and Average Employee Count by Location from
PrismHR. This data is then available to run the OSHA 300A
report or OSHA 300A ITA File merge.
The process runs for all PrismHR clients in Under Contract,
Client, Pending Term, and Term statuses.
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Scheduled process name Description

PrismHR Initial Employee Sync This scheduled process uses the HRPAPI_initial_
employee*.csv and HRPAPI_initial_employment*.csv
import configurations (must be active, See Activating Import
Map Headers) to retrieve a list of active ClientMaster records
where Client Number is not empty.

The Client Numbers are then matched in PrismHR to create a
list of Employee and Employment records for each client. If
the Client Number cannot be matched in PrismHR, the client
is ignored. The Employee and Employment records are then
mapped into an import file for the nn number of clients, with
the number of clients (nn) set from the InitialImportClients
parameter (numeric value) of the relevant API configuration.
The import files are based on the initial_employee and initial_
employment import configurations. When all records for the
first nn clients are retrieved, the import begins.

This process seeds the system with any missing or new
Employee and Employment records, batching these records
based on the number previously retrieved until all Employee
and Employment records for the designated clients are
synchronized. At the end of this process, the scheduled
process inactivates itself. For Initial Imports, it only retrieves
ClientSpace Clients in Client, Terminated, and
PendingTermination status.

The process inactivates when all generated records are
processed.

PrismHR Scheduled Initial This scheduled process allows selection of specific types of
PrismHR or HCM Initial Imports to run for a single API
configuration OR for multiple API configurations. The Initial
Import form is completed and queued from the Admin
Workspace. See Scheduling an Initial Import.

ClientSpace Setup & Administration © 2025 PrismHR 683

Chapter 17 Scheduled Processes



Scheduled process name Description

PrismHR Update Web Service User This scheduled process updates Web Service User
permissions for data masking. It is used for ClientSpace-to-
PrismHR integrations such as the View PrismHR Employee
Info feature which allows users to view employee data from
PrismHR when they click the View PrismHR Info link on an
employee record. The frequency must be set to run every
minute since this feature allows users to retrieve data from
PrismHR in real time.

Process Case Escalations  Checks Case Escalation records. Records with escalation date
and time scheduled prior to NOW() are then processed,
including (where applicable) updating priority, updating the
assigned to user, and notifying the selected user or role.

Process Client Statistics Runs once a month to create new entries and updates the
Client Statistics Table. When this process runs, the procedure
aggregates each of the types by month. It searches for all
Employee Vouchers or UIBenefitCharges that are not yet
processed, then sums the totals and creates new Client
Statistics records. Each client has one record per month and
type. If an unprocessed record is found for an already existing
month and type, the process updates the totals on that
Statistics record. When the scheduled process completes, it
enables the IsProcessed option on any records that are used
in creating a Client Statistics record.

Process Email Integration (CORE) The Email Integration feature uses this process to check the
designated mailbox for new entries and generate dataform
records from these emails.

Process Scheduled Imports Imports any uploaded import file whose matching map
header is Import Type = Scheduled Process. The import file
status must be Ready for Import or Validated.

Purge I9 Records Check the date of all I9 records pending purge in the system
against the business rules, and mark all appropriate records
as purged.
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Scheduled process name Description

Salesforce Sync Rest API Synchronizes data between Salesforce and ClientSpace.

Seed Client Team Role The Seed Client Team Role scheduled process deletes all
Client Team Role rows before recreating Client Team Role
forms.

Send Email (CORE) Collect all unsent mail in the system, send them, and mark
them as sent.

ServiceCaseNotification Checks Client Service case records for cases with escalation
date and time prior to NOW(). Sends an escalation case
report with the subject "Cases requiring attention" to users in
escalation roles on the case type. Includes any role that has
the biz_email_ClientServiceCase_notifications entity.

Task Escalation (CORE) Get all the incidents that have passed their due date. Sends
email notifications with the Subject "Tasks requiring
attention" with a list of these tasks to the associated user
email accounts. Notifications are sent to the Assigned To and
Owner users, users with the Send Escalation Email option
enabled in their user profile, as well as anyone in the task
category notification role.

TerminatePending Find all Client workspaces with Pending Termination status
that have a termination date equal to or less than today’s
date. Change their status to Terminated.

Update Client Teams Finds Default Client Team records in Pending status and
updates Client Team records for workspaces with the same
Sales Region.

Update User Time Notifications
(CORE)

• Find all new time tracker users and insert their records
into the Notification and notification users table.

• Find all users with open time records over the preset
threshold and notify them: "You have not updated your
time in X minutes."

• Find all users without open time records and notify them:
"You currently have no open time records."
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Scheduled process name Description

Vouchers HRPImportVoucher. For Initial Imports, it only retrieves
ClientSpace Clients in Client, Terminated, and
PendingTermination status.
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Chapter 18
Merges
With a ClientSpace merge, you can merge specific data from the ClientSpace system dynamically into
your business documents and forms. Merges provide options to export data from ClientSpace and
present the information in a highly organized manner. This functionality removes the need for manual
completion of forms, such as a Request for Proposal, or Client Service Agreement.

Common uses for merges include marketing tools, proposals, personalized letters, detailed forms,
labels, data analysis, and metrics. You can merge data to generate Microsoft Word documents,
Microsoft Excel files, and form-fillable PDFs.

Merge Admin is where you configure the merge and maintain your documents. The Merge Admin
record specifies the:

l Stored procedure that gathers the ClientSpace data.
l File template that contains the merge fields and instructions for presenting the data that is

retrieved using the stored procedure.
l Type and Output Type.

Note: You cannot delete System merges. This includes isdeveloper users.

To access Merge Admin:

1. Go to System Admin > Outputs > Merges.
The Merge Admin dashboard opens, showing a list of your existing merges.
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From here, you can Add, Edit (and view), or Delete a Merge record. However, you cannot delete a
System merge record.

You can also search for merges using Quick Search and More Search. More Search allows searches
by Merge Name, Description, Merge Type, Output Type, and Procedure.

ClientSpace Setup & Administration © 2025 PrismHR 688

Chapter 18 Merges



To add or edit a merge record:

1. On the Merge Admin Dashboard:
• To add a new record, click the Add button.
• To edit an existing record, locate the record and click (Jump).
The Merge Admin Detail window displays.
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2. Complete the applicable fields.

Name Type a descriptive name for this merge record.

Template
File

This is where you upload the template file.
a. Click (Upload File).

The Upload File dialog box opens.
b. Click Choose File.
c. Locate the file on your computer and click Open.

The file name displays.
d. For Version This File?, select one of the options:

n Yes, Pin New File: Default setting. This option retains all file
versions and pins the most recent uploaded file.

n No, Replace File: Do not retain file versions. Replaces the
current file.

e. For Description, type a description of the uploaded file. Optional.
f. For Category, select an entry from the list. Optional.

g. Click Save.

Description Type a descriptive title of the merge record.

Type Select a file type: Word, Excel, PDF.

Password Optional. Type a password to secure the administration of this Merge record.

Procedure Select a stored procedure from the list.

Output Type This field is visible when Type is Word or Excel. For Type Word you can generate
a Word doc or PDF, for Type Excel you can generate an Excel file or PDF.

3. Click Save.

Word Merge Proc

One of the procedures that you can select from the Procedure list is peo_merge_word_companydata.
The following table outlines some of the fields available for this procedure.

Company data Description

Related Sales Rep (fkAssignedToUserID from Org) user
information

Email, Phone, Job Title, First Name, Last
Name
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Company data Description

Admin per Invoice from gen_PricingBatch FirstCheckSupplement

WCCode1State Full name of State

WCCode1Code State code

Excel Merge Proc

One of the procedures that you can select from the Procedure list is peo_merge_excel_companydata.
The following table outlines some of the fields available for this procedure.

Employee information (Employee Tab)

• FirstName
• LastName
• CensusID
• luSUTAState
• CompCode
• AnnualPay
• MiddleInitial
• luPayFrequency
• Address1
• Address2
• City State
• ZipCode

• County
• Phone
• Mobile
• Email
• crGender
• DOB
• crEmploymentStatus
• JobTitle
• crEmploymentType
• StandardHoursPerPeriod
• AnnualPayPctChange

Benefits information (Employee Tab)

• HealthWaived
• HealthPlanCode
• luHealthCoverageLevel
• HealthEffectiveDate
• DentalWaived
• DentalPlanCode
• luDentalCoverageLevel
• DentalEffectiveDate
• VisionWaived
• VisionPlanCode
• luVisionCoverageLevel

• VisionEffectiveDate
• VisionTerminationDate
• LifeEffectiveDate
• LifeTerminationDate
• luDeductionType
• luEnrollmentStatus
• ContributionAmount
• TotalContribution
• WaitingPeriodDate
• EstAnnualWages
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Many other fields are available and are listed by tabbed section of the peo_merge_excel_
companydata Excel report template. These include:

l Contacts l Surcharges
l Locations l Commissions
l PricingStates l ExistingBenefitPlans
l PricingCodes l OffereredBenefitPlans

Note: 

The Company Data merge report procedure (peo_merge_excel_companydata) sets the value in the
Client Report State column using the following logic:
l Step 1: Check the Client Report State on the State Master record.

o If checked (i.e., "True"), set Client Report State to "True"
o If unchecked (i.e., "False"), go to Step 2.

l Step 2: Check the Client SUTA Reporting field on the State Legal Entity.
o If checked (i.e., "True"), set Client Report State to "True".
o If unchecked (i.e., "False"), set Client Report State to "False".

Procedure Fields
The stored procedure (prepared SQL code that can be reused) is the mechanism for retrieving data
from ClientSpace. The stored procedure generates data for the merge fields. You may need to use a
custom stored procedure for your merges, or you can use one from the Procedure list. For any selected
stored procedure in the Procedure list, you can view the fields. This is helpful if you are not familiar with
the procedure names.

To view procedure fields:

1. From the Merge Admin Detail form, in the Action Center, click Show Procedure Fields.
The Fields dialog box opens, showing the fields of the selected procedure in Procedure.

2. To copy the fields, click Copy.
The fields are copied to the clipboard.

3. Click Close when done.
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Microsoft Word example
The following example shows a statement of work in a Word template. Word inserts your content using
variables (placeholders that are replaced by text from the data source, your ClientSpace data). In the
example, the placeholder syntax is represented as <<sometext>>, such as <<CompanyName>>.
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Microsoft Excel example
You can use Excel to pull raw data and perform calculations. The following image illustrates an Excel
template for payroll information.
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Benefits Renewal Merge
The Benefits Renewal merge exports Benefits Plan details and Benefits Batch data from ClientSpace into
an Excel Spreadsheet, referred to as the Benefits Renewal Workbook, so that you can analyze and
compare the offered benefits for each benefits plan in a batch.

This topic covers configuration details, how to enter coverage counts and how to run the merge. There
is also a demo video included.

Note: You can set up your own email template to use with DocuSign to get a client's approval on their
selected Offered Benefit Plans (if you have DocuSign integration). Even if you do not have DocuSign
integration, you can still use the "DocuSign version" of the Benefits Renewal Merge to get client
approval as this version contains signature lines. See the Getting OBP Approval section in this topic for
additional details.

For a video demonstration on how to run the Benefits Renewal Merge and created the Benefits Renewal
Workbook, also see Learning how: Creating a Benefits Renewal Workbook.

Configuration
Both the merge record and associated link are Active and available by default. The link is secured to the
Benefits_Member role. No merge record configuration is required. However, users with access
permissions to view Merge Admin Detail configuration can go to System Admin > Outputs >
Merges and open the Benefit Renewal Workbook record:
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Entering Coverage Counts
While most of the information used in the spreadsheet calculations do not require user data entry, you
are required to provide Coverage Count details on each Offered Benefits Plan record in the batch.
These counts are used in the spreadsheet calculations.

Note: If you are running the Benefit Renewal Workbook Excel merge in a parent company workspace,
ClientSpace also retrieves any coverage counts entered on child workspaces and displays a combined
total for each Coverage Count shown in the spreadsheet if the following is True:

l The parent company must be specified in the Benefit Parent Company field of the child Benefits
Batch dataform.

l There must be a policy and benefit group match found on an offered benefit plan in both the
parent and child workspaces. For example, if the Parent Company has an offered benefit plan
containing Policy A with a Benefit Group of B, the Child Company must also have an offered
benefit plan containing Policy A with a Benefit Group of B.
Counts will not be combined on any offered benefits plans where there is not an exact match to
the policy and benefit group in the parent and child workspaces.

To enter the Coverage Counts:

1. Open the Benefits Batch record from which you want to run the Benefit Renewal Workbook Excel
merge.

a. From the modules bar, click Workspaces.
The Workspace Search dashboard (i.e., workspace landing page) opens.

b. Select a workspace and click (Open).
The Workspace page opens.

c. Scroll down the page to the administrative tiles where you see the dataform categories.
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d. Click Benefits and then click the Benefits Batch tile.

2. On the Benefits Batch dataform, in the Action Center under Links, click Offered Benefit Plans.
If there is only one offered benefit plan, the Offered Benefits Plan dataform displays the plan
details. If there is more than one offered benefit plan, the Offered Benefits Plan dashboard
displays. Click (Open) next to an offered benefit plan to display the plan details.

4. Scroll down to the Coverage Count sub-fieldset (located within the Coverage Details fieldset
and fill in EOCount, ECCount, EKCount, ESCount, and EFCount fields:

l EOCount = Employee Only coverage count
l ECCount = Employee +Children coverage count
l EKCount = Employee + Domestic Partner coverage count
l ESCount = Employee + Spouse coverage count
l EFCount = Employee + Family coverage count

5. Click Save or Apply.
6. If there is more than one offered benefit plan, return to the Offered Benefits Plan dashboard and

repeat steps 4 and 5 until coverage counts are filled in for all offered benefit plans in the Benefits
Batch.

Excluding a Plan from the Comparison
If there is a benefit plan you want to exclude from the calculations, click the Suppress From
Presentation field located on the Benefits Plan record.
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Running the Merge
You can only run the merge on a Renewal batch (i.e., the batch type shown on the Benefits Batch
dashboard must display Renewal in the Type column.)

To run the merge:
On the Benefits Batch from which you want to run the Benefit Renewal Workbook Excel merge, click the
Renewal Workbook link located in the Action Center under Reports.

You can retrieve the merge document from your Windows Downloads folder.

Getting OBP Approval
You can use the DocuSign Benefit Renewal merge record and custom link and then set up your own
email template to use with DocuSign if you have DocuSign integration. (See DocuSign.)

If you do not have DocuSign integration, this document can still be used to obtain a signature even
without DocuSign as it is a summary of selected OBPs and contains placeholders for the signature and
signature date:
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To run the merge:
On the Benefits Batch from which you want to run the Benefit Renewal Workbook Excel merge for use
with DocuSign, click the Docusign Benefit Renewal link located in the Action Center under Reports.

Clicking the link generates a Benefit Renewal Document Merge Template Excel file in your Windows
Downloads folder. The RenewalPlans tab displays a summary of selected OBPs and the
ClientRenewalNotes tab displays exported notes from the Client Renewal Notes field on the Benefits
Batch record.

You can retrieve the merge document from your Windows Downloads folder. (Once the Email Template
is in place, clicking the link will also send the link to the email recipient(s) designated in the Email
Template configuration.)

Note: The Current Contribution and Renewal Contribution fields are rounded to 4-digit decimal
precision.
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Client Benefit Plans Export
Use the Client Benefit Plans Export merge to export Active Offered Benefit Plans (OBPs) to PrismHR via
their built-in import functionality. Plan setup details, rate group tiers, are included in the export.

Configuration
Default configuration on the Merge Admin Detail configuration form is located in System Admin >
Outputs > Merges in the Client Benefit Plans record:

Running the Merge

To run the merge:

1. Open the Benefits Batch where you want to run the merge.
a. From the modules bar, click Workspaces.

The Workspace Search dashboard opens.
b. Select the desired workspace and click (Open).

The Workspace page opens.
c. Move down the page to the administrative tiles where you see the dataform categories.
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d. Enter "Benefits Batch" in the search for dataform field and then click the Benefits Batch
tile.
The Benefits Batch dashboad/search window displays.

e. Locate the batch and click (Open) next to it.
2. In the Action Center, under Reports, click the Export Client Benefit Plans link.
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3. Retrieve the merge document from your Windows Downloads folder.
4. Open the file and then click the Create Export File button to run the macro.
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Note: 
l This gets the file in the correct format for importing into the PrismHR application.
l If you need assistance importing the data into PrismHR, please refer to the "Importing

Company Benefits" topic in the PrismHR application Help.
l The Premium and Contribution fields are rounded to 4-digit decimal precision.

How the Client Benefit Plans Export Sets the Rate Group
For health plans that use risk tiers, set the Default Rate Group for an Offered Benefit Plan from the
parent Benefit Plan. Otherwise set the Default Rate Group on the Benefits Batch associated with the
OBPs. For more information on setting default rate groups, see Setting Default Rate Groups.

Then, when you use the Client Benefit Plans Export, the Default Rate Group is referenced to set the
Rate Group column correctly in the merge for all of the associated Offered Benefit Plans in a batch:
l If the Rate Source on the parent Benefit Plan is defined as "Manual", then set the Rate Group

field for the associated OBPs in the merge to the value in the Title field of the Rate Group Detail
record.

l If the Rate Source on the parent Benefit Plan is defined as "Percentage", then set the Rate
Group field for the associated OBPs in the merge to the Default Rate Group value from the
parent Benefit Plan (not the Default Rate Group from the Benefits Batch.)

l If no Default Rate Group is defined on the parent Benefit Plan, set the Rate Group field for the
associated OBPs in the merge using the Default Rate Group defined on the Benefits Batch, if a
value is present.

l If no Default Rate Group is defined on either the parent Benefit Plan or the Benefits Batch, set
the Rate Group on for the associated OBPs in the merge to STANDARD.
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How the Client Benefit Plans Export Handles Replaced Plans
When a Benefit Plan is renewed and the carrier for the current year plan is remaining the same as the
prior year plan, the Action column in the Client Benefit Plans Export merge file is set to "CHANGE" and
the Start Date field is left blank so that it remains unchanged in PrismHR.

When the new plan is being replaced with a different plan in the renewal year, the merge file shows two
Action line items instead of one (as it does for a CHANGE Action). The two Action line items are added
to reflect addition of the new plan and the termination of the old plan. The following logic is used to
determine this: 
l If the Carrier Plan Code from the Current Year Plan does not match the Renewed plan, insert an

"ADD" Action line item in the Client Benefit Plans Export merge file for the Current Year Plan.
l If the Carrier Plan Code from the Current Year Plan does not match the Renewed plan, insert a

"TERM" Action line item in the Client Benefit Plans Export merge file for the Prior Year Plan.

Note: If you need more information on using this import in the PrismHR application, please contact
PrismHR Support.

Exported Risk Factor Details
ClientSpace checks for a value entered in the Risk Factor field of the OBP and exports the following
column values if that field is populated:

l Column I: Rate Group - Uses the Benefit Plan Title field value. If there is no rate group this will
be set to the Default Rate Group value from the Benefits Batch. If that is empty then it will be set
to “STANDARD”.

l Column AJ: Risk Factor Date - Uses the Benefits Batch Effective Date.
l Column AK: Prem.RiskFactor 1 - Uses the Risk Factor percentage entered on the OPB dataform.

ClientSpace Setup & Administration © 2025 PrismHR 704

Chapter 18 Merges



If the Risk Factor field on the OBP is not populated, ClientSpace checks for a value in the Percentage
field of the Rate Group Detail form and exports the following column values if that field is populated:

l Column I: Rate Group - Auto-fills with the text "STANDARD". If there is a Default Rate Group on
the Benefits Batch this will be inserted instead.

l Column AJ: Risk Factor Date - Uses the Benefits Batch Effective Date.
l Column AK: Prem.RiskFactor - If the Rate Source is set to "Percentage" on the Rate Group

detail form and a value is entered in the Percentage field for the form, Percentage value is used.

Exported Auto Enrollment Settings
There is an Auto Enroll field in the Setup Details fieldset of the Offered Benefit Plan record. If you set
this field to Yes, the offered plan is set up for automatic enrollment upon import into PrismHR. This
selection is saved in column BE (BEN.AUTO.ENROLL.DECISION) of the Client Benefit Plans export.

Related Topics:

l Setting Default Rate Groups

Benefit Batch Billing Rules Export
The Benefit Batch Billing Rules Export merge exports billing rules to PrismHR via their built-in import
functionality. This includes Offered Benefit Plans and plan pricing details.

Configuration
Default configuration on the Merge Admin Detail configuration form is located in System Admin >
Outputs > Merges in the Benefit Batch Billing Rules Export record:
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Running the Merge

To run the merge:

1. Open the Benefits Batch where you want to run the merge.
a. From the modules bar, click Workspaces.

The Workspace Search dashboard opens.
b. Select the desired workspace and click (Open).

The Workspace page opens.
c. Move down the page to the administrative tiles where you see the dataform categories.

d. Enter "Benefits Batch" in the search for dataform field and then click the Benefits Batch
tile.
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The Benefits Batch dashboad/search window displays.
e. Locate the batch and click (Open) next to it.

2. In the Action Center, under Reports, click the Billing Rules Export link.

3. Retrieve the merge document from your Windows Downloads folder.
4. Open the file and then click Enable Content to run the macros in this file before exporting to

PrismHR.

Note: 
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l The Premium and Contribution fields are rounded to 4-digit decimal precision.
l If you need more information on using this import in the PrismHR application, please

contact PrismHR Support.

Employee Termination Merge
The Employee Termination Letter Word merge is designed for PEOs to send letters to their client's
employees informing them that the PEO is canceling their agreement with them.

Note: Currently, to use the Employee Termination Letter merge, you will need to add the merge record
and a custom link. (See Merges and Configuring Custom Dataform Links . If you need assistance, please
log an Extranet case.) In an upcoming release, we will add a pre-configured merge record and custom
link as well as a filter page.

Configuration
The Employee Termination Letter Word merge uses a stored procedure named peo_merge_ee_
termination. The Merge Admin Detail configuration form is located in System Admin > Outputs >
Merges:

A custom link named PEO Term Letter has been configured on the Workspace Landing page in Action
Center > Reports to filter employees and execute the merge.
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Merge Fields
Dataform/Fields Notes

From Client Master:
l Client Number (ClientNumber)
l PEO ID (PEOID)

From Organization Detail:
l Name
l DBA (AKA/DBA)

From Employee:
l Address 1 (Address1)
l Address 2 (Address2)
l Address 1 and 2 (Address1and2) Address 1 and Address 2 are concatenated. A comma and

space are inserted in between Address 1 and Address 2 if
Address 2 is not blank/null.

l City
l State Uses two-letter abbreviation.
l Zip Code (ZipCode)
l City, State and Zip (CityStateZip) City, State, and Zip Code are concatenated. A comma and space

are inserted after City.
l County
l Employer ID (EmployeeIdentifier)
l Employee First Name (EEFirstName)
l Employee Middle Initial (EEMiddleInitial)
l Employee Last Name (EELastName)
l Employee Fule Name (EEFullName) Employee First Name and Employee Last Name are

concatenated.
l DOT Employee (luDOTEmployee) Uses the Decode value from the Lookup.
l Salutation (luSalutation) Uses the Decode value from the Lookup.

l Med Card (MedCard)
l Employee Nickname (EENickname)

l Phone
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Dataform/Fields Notes

l Mobile

l Fax

l Email

l W2 Address 1 (W2Address1)

l W2 Address 2 (W2Address2)

l W2 Address 1 and 2 (W2Address1and2) W2 Address 1 and W2 Address 2 are concatenated. A comma
and space are inserted in between W2 Address 1 and W2
Address 2 if W2 Address 2 is not blank/null.

l W2 City (W2City)

l W2 County (W2County)

l W2 State (W2State) Uses the two-letter state abbreviation.

l W2 Zip Code (W2ZipCode)

l W2 City, State and Zip (W2CityStateZip) W2 City, W2 State, and W2 Zip Code are concatenated. A
comma and space are inserted after W2 City.

From Employee > Employment:

l Employment Status (crEmploymentStatus) Returns Decode value as EmploymentStatus.

l Employment Type (crEmploymentType) Returns Decode value as EmploymentType.

l Hire Date (HireDate) Format is MM/DD/YYYY.

l Home Department (HomeDept) Uses Decode value.

l Job Code (JobCode) Uses Decode value.

Job Title (JobTitle)

Last Date Worked (LastDateWorked) Format is MM/DD/YYYY.

Last Payroll Date (LastPayrollDate) Format is MM/DD/YYYY.

Last Payroll Update (LastPayrollUpdate) Format is MM/DD/YYYY.

Client Location ID (fkClientLocationID) Returns "Location Code - Location Name" as
LocationCodeName.

Original Hire Date (OriginalHireDate) Format is MM/DD/YYYY.
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Dataform/Fields Notes

Pay Frequency (luPayFrequency) Returns Decode value as PayFrequency.

Pay Method (luPayMethod) Returns Decode value as PayMethod.

Seniority Date (SeniorityDate) Format is MM/DD/YYYY.

Employee Shift (luEmpShift) Returns Decode value as EmpShift.

Standard Hours Per Period (StandardHoursPerPeriod)

Start Date (StartDate) Format is MM/DD/YYYY.

StatusChangeDate Format is MM/DD/YYYY.

luSUTAState Returns the two-letter state abbreviation as SUTAState.

TerminationDate Format is MM/DD/YYYY as TermDate.

ReasonforTermination Returned as TermReason.

WageRate Rounded to two decimal places with no dollar sign.

WorkersCompCode Returned as WCCode.

WorkersCompCodeTitle} Returned as WCCodeTitle.

Running the Merge

To run the merge:

1. Access the workspace.
a. From the modules bar, click Workspaces.

The Workspace Search dashboard opens.
b. Type % followed by the Client Number or by the first few letters of the workspace name

in the search box to filter the list of workspaces.
Note: You can also use More search to filter the list of Workspaces by fields such as
Group, Template, or Create Date range.

c. Then, double-click the workspace row in the grid or click (Open) next to the workspace
name.

2. In the Action Center, under Reports, click PEO Term Letter.
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The PEO EE Termination filter page displays.
3. Complete the fields as necessary.

Field Definition

Workspace Name Auto-fills with the current
workspace name.
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Field Definition

Employment Status Select Terminated.

Termination Date To filter for employees terminated
within a specific date range, enter
the date range.

Employee To filter for a single employes,
select the employee name from the
drop down list.

4. Click Execute.

5. Retrieve the merge letters document from your Windows Downloads folder.

OSHA 300/301 ITA Export Merge
The OSHA 300/301 ITA Export Merge is used to generate a combined OSHA 300/301 report in
.XSLX format (which you can then save in .CSV format for OSHA ITA portal submission).
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Configuration
Default configuration on the Merge Admin Detail configuration form is located in System Admin >
Outputs > Merges in the OSHA_ITA_300_301_EXPORT_2024 record:

Running the Merge
The merge is set to run yearly using the Generate OSHA Forms scheduled process if the Generate
OSHA 300/301 ITA checkbox on the Client Master is checked. If this field is checked, it adds the merge
file as an attachment to the OSHA Forms dataform OSHA 300/301 ITA field of each workspace. If the
Generate OSHA 300A ITA checkbox on the Client Master is not check only the original version of the
OSHA 300 report is generated and added to the OSHA Forms dataform.

You can also manually generate the report from the Client Master record of the desired workspace
using the steps outlined in these locations:

l The Generating an OSHA 300/301 ITA Export File section of the OSHA 300 Report Details article.
l The Generating an OSHA 300/301 ITA Export File section of the OSHA 301 Report Details article.

Related Topics:

l OSHA 300A Report Details
l OSHA 300 Report Details
l OSHA 300 and 300A Mass Creation
l OSHA 300A ITA Export Merge
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OSHA 300A ITA Export Merge
The OSHA 300A ITA Export Merge is used to generate the OSHA 300A report in .XSLX format (which
you can then save in .CSV format for OSHA ITA portal submission).

Configuration
Default configuration on the Merge Admin Detail configuration form is located in System Admin >
Outputs > Merges in the OSHA_ITA_300A_EXPORT_2024 record:

Running the Merge
The merge is set to run yearly using the Generate OSHA Forms scheduled process if the Generate
OSHA 300A ITA checkbox on the Client Master is checked. If this field is checked, it adds the merge file
as an attachment to the OSHA Forms dataform OSHA 300A ITA field of each workspace. If the
Generate OSHA 300A ITA checkbox on the Client Master is not checked, only the only the original
version of the OSHA 300A report is generated and added to the OSHA Forms dataform.

You can also manually generate the report from the Client Master record of the desired workspace
using the steps outlined in the Generating an OSHA 300A ITA Export File section of the OSHA 300A
Report Details topic.
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Related Topics:

l OSHA 300A Report Details
l OSHA 300 Report Details
l OSHA 300 and 300A Mass Creation
l OSHA 300/301 ITA Export Merge
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Chapter 19
Integrations
We know ClientSpace isn't the only application that you use, so we have made it easy to tie your
programs together using our application integrations. This is your one stop shop for integration info.

ClientSpace integrations include:

• Email Integration
• Slack integration
• PlanHub
• Email to Case configures ClientSpace to sweep through an IMAP enabled mailbox to generate

Client Service Cases automatically and send automated email responses.

Slack integration
The Slack integration allows you to use slash commands in Slack to retrieve a high-level synopsis of
Case and Task data with links to open these cases and tasks directly from Slack. Integration with Slack
requires configuring Slack as well as the ClientSpace application.

Required prerequisites
Slack integration requires that you are already using Slack in your business and that you have a Slack
Administrator. Additionally, your Slack Administrator must configure the Slack Slash commands. For
ClientSpace clients, after the Slack Slash Command has been created, log an Extranet case for help with
configuring the Slack API.

Configuring Slack
A Slack administrator will have the ability within Slack to Browse and Add new apps to the Slack install.
This normally appears at the bottom of the Slack user list.

To configure Slack:
1. Open Slack.
2. Select Apps.
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The Browse Apps page opens.
3. If not installed, install the Slash Commands app.

If Slash Commands is already installed, click View to add a new configuration.
The Slash Commands page opens.

4. Click Add Configuration.
5. The Integration Settings page opens.
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To configure the integration settings for your installation:
1. Command: The precursor command you will use in Slack to begin requesting data from

ClientSpace. In our example we are using /clientspace.
2. URL: The install URL of your ClientSpace installation with /next/peo/slack appended to the end.

For example, https://yourinstall.clientspace.net/next/peo/slack
3. Method: Select POST. This is the request-response method when connecting the third- party

application.
4. Token: Simply adding the configuration will cause the Slack system to generate a token. This token

identifies the Slack application for third-party integrations and will be used when configuring the
ClientSpace application. Copy this token to notepad because you will use this later.

5. Customize Name: The name that will identify the slash command responses. The Slack username
that your ClientSpace data will come from.

6. Customize Icon: The icon that will appear in Slack next to the response.
7. Preview Message: This field will give you an advance preview of what you can expect the slack

interaction to look like.
8. All other configurations should be left at their defaults.
9. Click Save to save your Slash Command Config.
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Configuring ClientSpace
The next part of the Slack configuration is to configure ClientSpace. The application configuration
consists of two parts:

• The Third Party Application (TPA) configuration
• The user configuration.

To begin:
1. In ClientSpace, go to System Admin > Advanced > Third Party Applications.

The Third Party Application Configuration dashboard opens.
2. Click Add.

The New Third Party Application form opens.

3. Complete the form fields:

Name Type Slack.

Private Token Paste the Token that was generated during the Slash Command configuration
in Slack. This is what identifies the Slack application as a valid third-party
application.

4. Click Apply.
The Administration area of the form is auto-filled. Now you are ready to add users to the
configuration.

To add users to your third-party application configuration:
1. In the Action Center, click Users.

The Third Party Application Users dashboard opens.
2. Click Add.

The Add Third Party User dialog box opens. This is where you add user records for each user who
will connect through Slack.

3. Complete the fields:
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System User Select the ClientSpace user.

Third Party LoginID Type the user's Slack ID.

4. Click Save.
The newly added user displays in the Third Party Application Users list.

Using the Slack integration
To use the Slack integration, simply type one of the available Slash commands after typing the prefix
command you assigned in Step 1 of the Slack integration settings. In our example, we are using
/clientspace.

Note: Sharing data in a Group Channel - When returning data to a group channel using the following
commands, the returned information will be visible only to you, unless you explicitly use the -share
command. If you include -share in your request, the returned data will be visible to anyone in the
Slack channel. Example: /clientspace mycases -share

The following is a list of available commands that can be used in Slack to retrieve ClientSpace
information:

Command Description and examples

case Returns information about a Case by Case Number.
Example: /clientspace case 1234

escalated Returns escalated cases assigned to you, ordered by Escalation Date Descending
(newest first)
Examples:

/clientspace escalated

/clientspace escalated -share

help Lists all of the available commands
Example: /clientspace help
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Command Description and examples

mycases Returns the most recent 10 cases assigned to you, ordered by Date Created
descending (newest first)
Examples:

/clientspace mycases

/clientspace mycases -share

mytasks Returns the most recent 10 tasks assigned to you, ordered by Start Date
descending (newest first)
Examples:

/clientspace mytasks

/clientspace mytasks -share

task Returns information about a specific Task by TaskID
Example: /clientspace task 1234

Using slack requests returns a Slack post containing pertinent information about your request including
a selectable link that opens the case/task in a new browser.
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Chapter 20
APIs
An API is an application programming interface and specifies a software component in terms of its
operations, their inputs and outputs, underlying types, and available methods. ClientSpace APIs
connect one software system to another to facilitate the transfer of data between the two systems. APIs
generally require additional configuration in both ClientSpace and the other software system and may
have an associated cost.

Supported Integrations
Some of the ClientSpace APIs include:

l PrismHR is communication between ClientSpace and the PrismHR payroll system for Client and
Employee data. See PrismHR API.

l Benefit Plan API is a one-way export API that allows you to export benefit plan setup
information from ClientSpace to PrismHR. Once this information is in PrismHR, you can enroll
employees and manage the plans in PrismHR. See Benefit Plan API .

l Salesforce is two-way communication between the sales process in ClientSpace and the
Salesforce API. See Salesforce.

l Single Sign On allows you to connect external system users to ClientSpace. It requires the user
account for the user in your ClientSpace installation and can be an external user. See
Implementing SSO from PrismHR to ClientSpace .

l DocuSign provides for electronic signature of merged ClientSpace documents. See DocuSign.
l CCMSI is a third-party administrator for Workers' Compensation. The CCMSI API allows you to

enter data into ClientSpace and export it to CCMSI. See CCMSI.
l Marketo is marketing automation and lead management software. See Marketo.
l PlanHub integration enables you to request a Slavic 401k PlanHub proposal from within

ClientSpace. See PlanHub.
l Gradient AI Health Benefits uses artificial intelligence to analyze your offered benefits plans

and compare them to potentially thousands of other offered benefits plans submitted by other
PEOs in your area. If you are a small to mid-size PEO and you do not have an on-site benefits
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expert, a Gradient AI Health Benefits analysis can provide insight into how your pricing stacks up
against others to help you to determine if you are pricing benefits properly. See Gradient AI
Health Benefits.

l Gradient AI Risk uses artificial intelligence to analyze Pricing Console batch information such as
payroll, headcount, workers compensation position codes, and worker's compensation loss
history (if available). Data from the submitted Pricing Console batch is processed by Gradient AI
in real time and results are aggregated by each worker's compensation policy included in the
batch. The results include information such as predicted losses and a suggested premium (i.e.,
Target Premium). See Gradient AI Risk.

l SIDES ClientSpace integration is an automated data exchange interface between ClientSpace and
SIDES and is best suited for larger employers, PEOs, and TPAs who typically deal with more than
30 UI information requests per week or who operate in multiple states. ClientSpace retrieves the
claims from SIDES and places them in the correct workspace. See SIDES ClientSpace Integration
Overview.

If you have questions about API availability and upcoming projects, please log an Extranet case.

Unsupported Integrations
l Act-On
l ZoomInfo

Note: While Act-On and ZoomInfo are unsupported marketing platforms, we do offer a Marketo
integration which is also a marketing platform. It can create Organizations, Contacts, and Activities in
ClientSpace. Please see Marketo for details.

PrismHR API
The PrismHR API provides two-way communication between ClientSpace and the PrismHR payroll
system for Client and Employee data. In addition to Client, Employee / Employment, Location, and
Contact data, ClientSpace provides Employee identifying information, Payroll Batch information, and I-9
data.

Employee Identifying Information
ClientSpace provides data mapping through the PrismHR API to enhance the Employee related
workflows. The additional mapping ensures that Employee data from PrismHR is imported into the
fields on the Employee dataform, so that configured workflows trigger. These fields can be used in
Conditions for Workflow Channels and Email Templates.
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Fields on the Employment dataform populate through the API import process (HRPAPI_initial_
employment, HRPAPI_employment, HRPAPI_emp_benefits, HRPAPI_initial_codes_skill, HRPAPI_
ongoing_code_skill). The HRPAPI_initial_employment and HRPAPI_employment import mappings
have additional columns for the following fields.

Field Description

Enrolled Benefits? Multi-lookup

Has Retirement? Yes/No lookup

Has Dependents? Yes/No lookup

Has Garnishments? Yes/No lookup

Is FLSA Exempt? Yes/No lookup. Imports this flag from the Employee > Name > FLSA Exempt
field in PrismHR.

Is FICA Exempt? Yes/No lookup. Imports this flag from the Employee > Tax FICA Exempt field
in PrismHR.

These fields are displayed in the Additional Information fieldset.

Field replacement

All of the fields can be used in field replacement to return the value stored in the related dataform field.

l Use the Yes/No fields to configure trigger conditions by typing Yes or No in the trigger value
field.

l Use Enrolled Benefits for triggering by using a trigger operator of Contains and a decoded value
such as Health, Dental, and Vision.

Enrolled Benefits options

Code/ImportID - Decode: The fields have the following configured values for Enrolled Benefits options.
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l MED: Medical l ADD: Accidental Death and
Dismemberment

l ACC: Accident Benefits

l VIS: Vision l LIS: Life Insurance - Basic - Spouse
Only

l LDA: Additional

l DEN: Dental l LIC: Life Insurance - Basic - Child
Only

l LTD SDA: Additional

l VOL: Voluntary
Benefits

l ANC: Ancillary l STD BLX: Basic Life Extra

l LIF: Life Insurance -
Basic

l CRI: Critical Illness l HOS: Voluntary
Hospitalization

l GTL: Group Term
Life

l CAN: Cancer Benefits l IDT: Identity Theft

l LTD: Long Term
Disability

l MDP: Domestic Partner Medical l LGL: Legal

l STD: Short Term
Disability

l DDP: Domestic Partner Dental l CRL: Critical Illness as
Life

l GAP: Gap Insurance l VDP: Domestic Partner Vision

Employee Benefits Fields Affected by Termination

When an employee is terminated in PrismHR, the PrismHR API import process marks the Employment
Status field to T (Terminated) in ClientSpace. This affects the values in the Employee Benefits fields.

l If the Preserve Benefits Data rule is not active (which is the default state for the rule), the import
process clears the values in the Employee Benefits fields.

l If an admin user sets the Preserve Benefits Data rule to Active, the values in the Employee
Benefits fields are preserved during the import process.

By using the Preserve Benefits Data rule to preserve the values in the Employee Benefits fields, the
enrolled benefits information can be used in any necessary employee termination notifications.

Garnishments

Has Garnishments data is populated when:
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l Initial Employment (both Client and Employee Sync processes) runs.
l An Enrolled Benefit, Dependents, or Retirement change is made in PrismHR (using the PrismHR

ongoing import configurations).
l An Employment change is made.

Configuration:

l A new field was added to Employment form luHasGarnishments (lookup, Yes/No).
l A new Import Field mapping was added to the HRPAPI_employment*.csv and HRPAPI_initial_

employment*.csv Import Mappings.
l Column Name MUST be HasGarnishments, mapped to luHasGarnishment field, API path

Employee/Garnishments/active.
l A new Import Field mapping was added to the HRPAPI_emp_benefits*.csv import mapping.
l Column Name MUST be HasGarnishments, mapped to luHasGarnishment field, API path

Benefits/Garnishments/active.

Payroll Batch information
You can import payroll batch data from PrismHR into ClientSpace for reporting. The imported data
resides in the following dataforms:

l Payroll Batch
l Pay Group
l Billing Voucher

The following topics provide details about the dataforms and the relationships, the PrismHR API that
updates the payroll batch, and the import mappings.
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Payroll Batch dataform

All the fields on
the Payroll Batch
dataform are
read-only and
populate
through the
PrismHR API
Import. By
default, the form
is secured with
View rights for all
users in the PEO
Employees role.
The Payroll
Processor field is
set using a
business rule that finds the Client Team form associated with the workspace and copies the Payroll
Processor field information from the Client Team form into the Payroll Processor field on the Payroll
Batch form. The business rule is triggered when records are inserted either through a normal dataform
save or from an import. The Payroll Batch dataform is a parent to the Billing Voucher dataform.

To view the Payroll Batch dataform:

1. Go to System Admin > Advanced > Dataform Admin.
The Dataform Admin dashboard opens.

2. Select Payroll Batch and click (Open).
The Dataform Properties: Payroll Batch form opens.

3. To view fields, in the Action Center, click Fields.
The Payroll Batch fields list displays.
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4. To view the attributes of a field, hover on a field.

5. To view the type of data stored in the field, select the field and click (Open).
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How Payroll Batch Data Is Updated

The PrismHR API updates the payroll batch throughout the payroll creation process. The system creates
a new ClientSpace Payroll batch record as soon as the record is created in PrismHR. The PrismHR
Import Payroll Batch process uses two separate but related scheduled processes to import and process
payroll details, billing vouchers, and pay groups from PrismHR. This breakout was done to prevent
system performance issues that could arise when large payroll batches are processed.

We retrieve the batch status from Prism.

l If the batch is not Complete in Prism, we do not process it. The batch status remains in the status
it is in (Pending, Reporting, etc.)

l If the batch is Complete in Prism, that signals ClientSpace to place a check mark in the Sync with
PrismHR checkbox on the Payroll batch record which triggers the Prism Import Payroll Batch
Sync scheduled process (described below) to run at the appropriate time.

The two scheduled processes are:

l PrismHR Import Payroll Batch Ongoing: Runs first to process basic payroll information.
l PrismHR Import Payroll Batch Sync: If the Sync with PrismHR checkbox is checked, the Prism

Import Payroll Batch Sync process runs and billing vouchers, pay groups, and costs based on
employee count information are processed. This process is set by default to only run on
weekends.
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If a batch is stopped at a certain point in the payroll system, notification and workflow events are
triggered in ClientSpace based on the status update.

Available statuses include:

Payroll calculation results rejected by
client

Payroll calculation completed
with warning

Payroll printed with errors

Payroll calculation results pending
client approval

Payment pending Time sheet entry in progress

Payroll is ready for time sheet entry Payroll is complete Payroll is ready to print

Payroll is ready to calculate Payroll finalization in progress Payroll finalization complete
with errors

Wire transfer pending Payroll calculation completed
with errors

Finalization pending
approval

Payroll reports are ready for
review

Payroll is ready to ship

Payroll Batch processing handles failed or deleted payroll batches in PrismHR.
l Payroll Batch DELETE events are processed to create Import Queue records.
l A DELETE event triggers business logic that updates the Batch Status field on the Payroll Batch

form to "Deleted" and deactivates the Payroll Batch record along with the associated Pay Groups
and Billing Vouchers

l When a payroll batch record does not have a payDate value, the system marks the record as
Completed with the message: "Pay date is required to import payroll batches into ClientSpace"

l If ClientSpace cannot retrieve a Payroll Batch from an event, that event (Import Queue record) is
marked as Completed with a message: "Batch '#####.###' Unable to include Queue Record in
Import file, no getBillingCodeTotalsForBatch response info, this event will not be processed"

l If no billing vouchers are found for a Payroll Batch from the PrismHR Import Payroll Batch
Complete scheduled event, the system marks the record as Completed (as there is no data to
process) and creates a log entry that indicates that no vouchers were found. For example:
No billing vouchers found for client ID "<api:clientId>" and batch ID "<api:batchId>.

Client validation

In ClientSpace, Client number validation occurs before processing the Payroll Batch Import Queue
records. If the Client is not found, the queue record is completed with a note. The validation occurs for
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queue records created from the Payroll Batch Import process, not the Ongoing Import process. The
Ongoing process checks the Client number in ClientSpace before creating the queue record.

Employee count

When regular payroll batches are processed as Completed, the employee counts are calculated from
the Employee records and their status classifications: full-time active, part-time active, full-time
terminated, part-time terminated, full-time leave, and part-time leave. Use the Employee count records
in the ClientSpace Executive Dashboards to compare the number of active employees to the number of
paid employees.

Voided batches

For voided batches, ClientSpace uses the list of employees to determine the pay groups that are being
voided and builds that batch similar to running a scheduled payroll batch. The billing codes are then
distributed across the pay groups to balance out the original payroll batch. This provides a zero-sum
between the initial run batch and the batch that is voiding the first batch.

Deleted batches

For deleted batches, ClientSpace deactivates the Payroll Batch as well as the associated pay groups and
billing vouchers by removing the check marks from the Active checkboxes on these forms.
Additionally, ClientSpace updates the Batch Status field on the Payroll Batch form to "Deleted".

Payroll Batch Import Mappings

The following procedure provides details for viewing the Payroll Batch mapping.

To view the mappings:

1. Go to System Admin > Advanced > Configure Import.
The Import Map Header Search dashboard opens.

2. Locate HRPAPI_payroll_batch*.csv and click (Open) to open the header detail.
The Import Map Header Detail form opens.
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3. To view the fields, click Fields.
The Import Map Search list displays the Payroll Batch fields.
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Available fields are Actual Ship Date, Batch Status, Batch Type, Billing Amount, Billing Code, Cost
Amount, Delivery Date, Delivery Method, Employee Count, Pay Date, Pay Group, Employee Count,
Payroll Number, Payroll Processor, Period End, Period Start, and Remote Cuttoff Date.

Remote Cutoff Date is the deadline for reporting payroll and helps the payroll processor monitor
the client payroll reporting status. Remote Cutoff Date is only populated when the API Config
parameter GetPayrollBatchCutoffDate is set to 1. Additionally, you must also be on the
API version 1.22 or higher. For more information, see Ongoing Imports: Configuring the API for
Import Map Details.

4. To view a field and its properties, select and click (Open).

Payroll Batch, Pay Group, and Billing Vouchers

Note: Payroll Batch processing uses the PrismHR API and scheduled process: PrismHR Import
Payroll Batch Ongoing and PrismHR Import Payroll Batch Complete. Also see Configuring the
Payroll Batch Scheduled Processes.

Payroll Batch processing involves a few dataforms: Payroll Batch, Pay Group, and Billing Vouchers.

l Payroll Batch – The Payroll Batch import brings in the payroll data for each batch, enabling
ClientSpace to track the number of paid employees. The Payroll Batch dataform stores the payroll
information for each processed batch from PrismHR and allows for tracking of the batch from the
beginning of the process to the end.

l Pay Group – The Pay Group dataform stores information about each pay group type, such as
Weekly and Bi-Weekly, Period Start and End Date, and Employee Count. Pay Groups allows us to
track the frequency of how employees are paid and reflect the employee counts for each
frequency type. The number of pay groups depends on who is being paid at the time of the
payroll batch run. Pay Group names vary by client need and are imported from PrismHR. Payroll
Batches with multiple pay groups will have a pay group dataform for each one associated with
that batch. The system uses the Set Payroll Frequency custom logic rule to set the Payroll
Frequency on a pay group.

l Billing Vouchers – The Billing Vouchers reflect the total amount paid for the payroll batch and
also includes items, such as billing codes for taxes and deductions. Billing Vouchers are viewable
from the Payroll Batch.

Let's look at an example of a Payroll Batch, Pay Group, and Billing Vouchers.

To view the configuration:

1. On the module bar, click Workspaces.
The Workspace Search dashboard opens.

2. Select a workspace and click (Jump).
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The Workspace opens.
3. Move down the page to the dataform tiles, and click Payroll Info.

4. Click the Payroll Batch tile.

The Payroll Batch dashboard opens.
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5. Open an entry.
In our example, we selected an entry with multiple Pay Groups.

6. In the Action Center, click Pay Groups.
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The Pay Group dashboard opens. Our example shows two entries: Bi-Weekly and W. These pay
groups are imported from PrismHR into ClientSpace.

7. To view a Pay Group, highlight a row and double-click or click (Open).
The Pay Group details page opens.
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To view Billing Vouchers from the Payroll Batch:

1. From the Payroll Batch dataform, in the Action Center, click Billing Vouchers.
The Billing Voucher dashboard opens.

Because our example has two Pay Groups, the entries are associated with each Pay Group.
When you total the like entries, (for example, Gross Wages), these will be the totals for the
Payroll Batch. Note, the Billing Voucher reflects the individual items for each Pay Group.

Billing Voucher dataform

Billing Voucher records break out the individual line item billing code entries associated with a payroll
batch. A link is available to the Payroll Batch dataform to display the associated voucher records. The
Billing Voucher dataform is a child to the Payroll Batch dataform.
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Configuring the Payroll Batch Scheduled Processes

The PrismHR Import Payroll Batch process uses two separate but related scheduled processes to import
and process payroll details, billing vouchers, and pay groups from PrismHR. This breakout was done to
prevent system performance issues that could arise when large payroll batches are processed.

We retrieve the batch status from Prism.

l If the batch is not Complete in Prism, we do not process it. The batch status remains in the status
it is in (Pending, Reporting, etc.)

l If the batch is Complete in Prism, that signals ClientSpace to place a check mark in the Sync with
PrismHR checkbox on the Payroll batch record which triggers the Prism Import Payroll Batch
Sync scheduled process (described below) to run at the appropriate time.

The two scheduled processes are:

l PrismHR Import Payroll Batch Ongoing: Runs first to process basic payroll information.
l PrismHR Import Payroll Batch Sync: If the Sync with PrismHR checkbox is checked, the Prism

Import Payroll Batch Sync process runs and billing vouchers, pay groups, and costs based on
employee count information are processed. This process is set by default to only run on
weekends.

Note: 

l Both the PrismHR Import Payroll Batch Ongoing and PrismHR Import Payroll Batch Sync
scheduled processes are Active by default.

l Both the PrismHR Import Payroll Batch Ongoing and PrismHR Import Payroll Batch Sync
scheduled processes have a default limit of 250 payroll batch records that may be returned for
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processing at one time. The BillingBatchCount parameter for the PrismHR Import Payroll Batch
Complete scheduled process is editable in the PrismHR API configuration Additional Parameters.

To edit the PrismHR Import Payroll Batch Ongoing scheduled process default settings:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. Click Jump to open PrismHR Import Payroll Batch Ongoing.
The form opens.

3. Determine the frequency of when to run the process and complete the following settings.

Frequency Specify how often to run this process. This is a numeric field. The
default setting is 1 minute. This means that the process will poll the
system every minute until it finds records to process.

Frequency Type Select a type: Daily, Hourly, Minute, Monthly, Weekly, Yearly. The
default setting is Minute.

Next Run Date Use the date picker to select the next run date.

Next Run Time Specify the time of day. The default setting is 12:00 a.m.

Valid Days Select valid day(s) of the week for the process to run. The default days
all days of the week.

Max Run Minutes Specify how long this process can run. The default setting is 60
minutes.

Sleep Window Settings Specify the time frames when the process should not execute. The
default days are all days of the week between the Start Time of 2 AM
and End Time of 5 AM.

4. Is Active is checked by default. If you do not want this scheduled process to run, uncheck (i.e.,
clear) the Is Active checkbox.

5. Is System is checked by default. Only a developer or other user with special access can delete a
scheduled process flagged as Is System.

6. Click Save.
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To edit the PrismHR Import Payroll Batch Sync scheduled process default settings:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. Click Jump to open PrismHR Import Payroll Batch Sync.
The form opens.

3. Determine the frequency of when to run the process and complete the following settings.

Frequency Specify how often to run this process. This is a numeric field. The
default setting is 5 minutes. This means that the process will poll the
system every 5 minutes until it finds records to process.

Frequency Type Select a type: Daily, Hourly, Minute, Monthly, Weekly, Yearly. The
default setting is Minute.

Next Run Date Use the date picker to select the next run date. (Initially this is set for
you.)
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Next Run Time Specify the time of day. The default setting is 8:00 PM.

Valid Days Select valid day(s) of the week for the process to run. The default days
are Saturday and Sunday.

Max Run Minutes Specify how long this process can run. The default setting is 120
minutes.

Sleep Window Settings Specify the time frames when the process should not execute. The
default days are Monday, Tuesday, Wednesday, Thursday, and Friday
between the Start Time of 2 AM and End Time of 7 PM.

4. Is Active is checked by default. If you do not want this scheduled process to run, uncheck (i.e.,
clear) the Is Active checkbox.

5. Is System is checked by default. Only a developer or other user with special access can delete a
scheduled process flagged as Is System.

6. Click Save.
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Related Topics:

l Scheduled Processes

I-9 HRPAPI Import Mappings
The following procedures provide details for viewing mappings as well as the dataform properties.

To view the mappings:
1. Go to System Admin > Advanced > Configure Import.

The Import Map Header Search dashboard opens.
2. Locate HRPAPI_I9*.csv and click (Jump) to open the header detail.

The Import Map Header Detail form opens.
The following image presents the Import Map Header Detail for HRPAPI_I9*.csv.

3. To view the fields, click Fields.
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The Import Map Search list displays the I-9 Dataform fields.
The following image lists the HRPAPI_I9*.csv fields.

To view the I-9 Dataform properties:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Locate I-9 and click (Jump).

The Dataform Properties for I-9 opens.
3. To view the fields, in the Action Center, click Fields.

The I-9 Dataform fields display.
The I-9 Dataform fields (for HRPAPI_I9*.csv) include Employment Record, I-9 Form, Status, Purge
Date, Reverify Employee, Reverification & Rehires, Document One, Document Two, Document
Three, Eligibility Document, Alien Registration, and Legacy.
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4. To view a field, such as Non-Resident Alien, locate the fieldset Alien Registration and select
Non-Resident Alien.

5. Click (Jump).
The details of the field display.

The following image shows the field Non-Resident Alien, which is located in the Alien Registration
fieldset.
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Can use in Workflows

With the ClientSpace PrismHR HRPAPI, you can import I-9 data into the I-9 management dataform and
then use the dataform in workflows. The import uses HRPAPI_initial_I9*.csv and HRPAPI_I9*.csv
import mappings.

To track an Employee’s alien status within ClientSpace so that service providers can create workflows
for document expiration, you can configure scheduled Workflow Channels to trigger before the
expiration date of a document. Fields for tracking this data are available in the dataform gen_I9 and
marked as triggerable for workflows by default. See the previous image for an example of Triggerable
in the field Non-Resident Alien.

Alien Registration (fsAlienRegistration) fieldset

Non-Resident Alien (IsNonResidentAlien) checkbox

Alien Registration Number (AlienRegistrationNumber) text

Alien Registration Expiration Date (DateAlienRegistrationExpiration) date

Any dataform field that is marked as Triggerable can be used in a workflow. See Adding Dataform
Fields.
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Lookup values

To map the selections for I-9 documents in Prism to ClientSpace, use the lookup values in the
document lookup groups with Import IDs that match the Prism values. The following lookup values are
configured for you in I-9 Documents.

I-9 Documents ImportID

A - US Passport A18

A - US Passport Card A15

A - Perm. Resident (Form I-551) A02

A - Alien Reg. Receipt Card (Form I-551) A03

A - Foreign Passport with Temp. I-551 stamp A04-2

A - Foreign Passport with Temp. I-551 MRIV A05-2

A - Employment Auth. Document (Form I-766) A06

A - Foreign Passport, work-authorized nonimmigrant A07-3

A - FSM Passport with Form I-94 A08-2

A - RMI Passport with Form I-94 A09-2

A - Form I-94/I-94A A11-2

A - Temporary I-551 Stamp A16-2

A - Machine-readable immigrant visa (MRIV) A17-2

A - Form I-20 A13-3

A - Form DS-2019 A14-3

B - Driver's license issued by state/territory B01

B - ID card issued by state/territory B21

B - Government ID B13

B - School ID B03

B - Voter Registration Card B04

B - U.S. Military card B22
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I-9 Documents ImportID

B - U.S. Military draft record B14

B - Military dependent's ID card B06

B - USCG Merchant Mariner card B07

B - Native American tribal document B08

B - Canadian driver's license B09

B - School record (under age 18) B23

B - Report card (under age 18) B15

B - Clinic record (under age 18) B24

B - Doctor record (under age 18) B16

B - Hospital record (under age 18) B17

B - Day-care record (under age 18) B25

B - Nursery School record (under age 18) B18

B - Individual under Age 18 B19

B - Special Placement B20

C - Social Security Card (Unrestricted) C01

C - FS-545 C02

C - DS-1350 C03

C - US Birth Certificate C04

C - Native American tribal document C05

C - Form I-197 C06

C - Form I-179 C07

C - Employment auth. document (DHS) C08

C - FS-240 C09

Note: I-9 inserts and updates are covered by this import configuration.
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Employee Benefits HRPAPI Import Mappings
The following procedures provide details for viewing:

l Employee Benefits HRPAPI mappings for the PrismHR API Employee Benefits import.
l Dataform properties for the Employee Benefits Detail form.

Note: The Employee Benefits Detail form is where imported employee benefits information is
stored. When the PrismHR API import runs, if a record for the plan does not exist, a new Employee
Benefits Detail record is created for each plan that an employee is enrolled in and attached to the
Employee record. If an Employee Benefits Detail record exists but has changed, it is updated.

Import Mappings

To view the mappings:
1. Go to System Admin > Advanced > Configure Import.

The Import Map Header Search dashboard opens. There are two Employee Benefits HRPAPI
mappings:
• HRPAPI_initial_ee_benefits_detail*.csv
• HRPAPI_ee_benefits_detail*.csv

2. Locate each mapping and click (Jump) to open the header detail.
The Import Map Header Detail form opens.
The following image represents the Import Map Header Detail for HRPAPI_initial_ee_benefits_
detail*.csv used for the initial import:
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The following image represents the Import Map Header Detail for HRPAPI_ee_benefits_detail*.csv
used for ongoing imports.
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3. To view the fields, click Fields.
The Import Map Search list displays the Employee Benefits Detail dataform fields.
The following image lists the HRPAPI_ee_benefits_detail*.csv fields. (The fields are the same for
HRPAPI_initial_ee_benefits_detail*.csv.)

Dataform Properties

To view the Skill Code Dataform properties:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Locate Employee Benefits Detail and click (Jump).

The Dataform Properties: Employee Benefits Details window opens.
3. To view the fields, in the Action Center, click Fields.

The Employee Benefits Detail Dataform fields display.
The Employee Benefits Detail Dataform fields related to the Employee Benefits import mappings
(HRPAPI_ee_benefits_detail*.csv and HRPAPI_initial_ee_benefits_detail*.csv) are Related
Employee, Plan ID, Status, Effective Date, Expiration Date, Plan Type, and Coverage Level.
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4. To view field details, double-click the field or select the field and then click (Jump).

Field configuration details display.

The following image shows the Status lookup field details.
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Can Use in Workflows

With the ClientSpace PrismHR HRPAPI, you can import Employee Benefits data into the Employee
Benefit Details dataform and then use the dataform in workflows. The import uses HRPAPI_ee_
benefits_detail*.csv and HRPAPI_initial_ee_benefits_detail*.csv import mappings.

Any dataform field that is marked as Triggerable on the Dataform Properties window can be used in a
workflow. The image above from the preceding section shows the Status lookup field flagged
as Triggerable.

See Adding Dataform Fields.

ClientSpace to PrismHR Field Mapping

The table below lists Employee Benefits Detail dataform import fields in ClientSpace and the path to the
corresponding fields in PrismHR.

ClientSpace Setup & Administration © 2025 PrismHR 753

Chapter 20 APIs



ClientSpace "Import To" Field Name PrismHR "Import From" Path and
Field Name

Related Employee (fkRelatedEmployeeID) getEnrollInputList

Status (luStatus) benefitPlanDetail/status

Effective Date (DateEffective) benefitPlan/planDetail/effectiveDate

Expiration Date (DateExpiration) benefitPlanDetail/stopDate

Offered Benefits Plan (fkOfferedBenefitsPlanID) benefitPlanDetail/planId

Plan Type (luPlanType) benefitPlan/planDetail/planType

Coverage Level (luCoverageLevel) benefitPlan/planDetail/coverage

Employee Skills and Skill Codes HRPAPI Import Mappings
The PrismHR API can import employee skill data from PrismHR when the PrismHR Import Initial and
PrismHR Import Ongoing scheduled processes run. This information comes from the Skills &
Education tab of the Employee record in PrismHR.

The following procedures provide details for viewing the import mappings and dataform properties
used to configure the import:

l An employee Skill Code HRPAPI mapping for the PrismHR API Skill Codes import.
l Employee Skills HRPAPI mappings for the PrismHR API Employee Skill import.
l Dataform properties for the Skill Codes dataform.
l Dataform properties for the Employee Skill dataform.

Note: The Skill Codes and Employee Skill dataforms are where imported employee skill code and
employee skills information is stored.

Import Mappings

To view the mappings:
1. Go to System Admin > Advanced > Configure Import.

The Import Map Header Search dashboard opens. There is an Employee Skill Code mapping and
two Employee Skill HRPAPI mappings:
• HRPAPI_initial_codes_skill*.csv
• HRPAPI_initial_emp_skills
• HRPAPI_ongoing_emp_skills
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2. Locate each mapping. Search for Dataform = Skill Code to locate the Employee Skill Code import
mapping. Search for Dataform = Employee Skill to locate the Employee Skills import mappings.

3. Click (Jump) to open a header detail record.
The Import Map Header Detail form opens.
The following image represents the Import Map Header Detail for HRPAPI_initial_codes_skill*.csv
used for the initial import of skill codes:

The following image represents the Import Map Header Detail for HRPAPI_initial_emp_skills used
for initial import of employee skills.
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The following image represents the Import Map Header Detail for HRPAPI_ongoing_emp_skills
used for ongoing import of employee skills.

4. To view the fields, click Fields.
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The Import Map Search list displays the Employee Skills fields (SkillCode and SkillComment).
The following image lists the HRPAPI_initial_codes_skill*.csv fields.

The following image lists the HRPAPI_initial_emp_skills*.csv fields. (The fields are the same for
HRPAPI_ongoing_emp_skills*.csv.)

Dataform Properties

To view the Skill Codes and Employee Skill Dataform properties:
1. Go to System Admin > Advanced > Dataform Admin.

The Dataform Admin dashboard opens.
2. Locate Skill Code and click (Jump).

The Dataform Properties: Skill Code window opens.
3. Locate Employee Skill and click (Jump).

The Dataform Properties: Employee Skill window opens.
4. To view the fields, in the Action Center, click Fields.
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5. To view field details, double-click the field or select the field and then click (Jump).

Field configuration details display.

The following image shows the Skill Code field details on the Skill Code form.

The following image shows the Competency Level field details on the Employee Skill form.
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Can Use in Workflows

With the ClientSpace PrismHR HRPAPI, you can import Employee Skills data from the Skills &
Education tab of the Employee record in the PrismHR application and then create workflows in
ClientSpace. For instance, you can trigger notifications to follow up when an employee's certification
date (Date Certified) is nearing expiration for a particular skill code (Skill Code) where active
certification must be strictly maintained.

Any dataform field that is marked as Triggerable on the Dataform Properties window can be used in a
workflow. The images above from the preceding section show the Skill Code field from the Skill Code
dataform and the Competency Level field from the Employee Skill dataform flagged as Triggerable.

See Adding Dataform Fields.

Importing from PrismHR to ClientSpace
The following topics discuss importing data from PrismHR to ClientSpace.

Configuring the PrismHR API for Initial Imports

This section describes the PrismHR API Initial Import process with step-by-step configuration
information. Before you start, you need to create a case with PrismHR to request access for ClientSpace
to the API interface.

The Initial Import process, pulls all Client and related data from the PrismHR system into a ClientSpace
installation. You must test the validity of the data retrieved by the API against existing data being
imported into ClientSpace. This is crucial to ensure a smooth transition to API imports. See Before Go
Live.

If you try to configure this on your own and are not sure of your configuration or next steps,
STOP, and log an Extranet case. When enabled, the API overwrites existing data values, potentially
leading to data loss if not properly configured.

To get started, you need the following:
l HRP API URL
l HRP Callback URL
l HRP Username
l HRP Password
l HRP PEO ID

Also ensure that when setting up the PrismHR API for a Client, always request that the API account has
access to the following API services:

ClientSpace Setup & Administration © 2025 PrismHR 759

Chapter 20 APIs



l Login Service
l Subscription Service
l ClientMaster Service
l Employee Service

Web services company restricted list

Certain companies or employees should not be imported into ClientSpace (for example, the PEO itself).
The HRP Configuration tool contains a Web Services Access Control interface. Companies that should
not be imported into ClientSpace should be listed as Deny on the Company List form. 

Perform the following steps in the HRP Configuration tool:

1. Go to System > System Parameters > Action Menu > Web Service User and open the
CLIENTSPACE user.

2. Select Grant Access by Default, Deny Access to Specified. Specify which clients will be denied
access.

3. Under Company Access, in Company ID, type the company IDs that you do not want the
ClientSpace API to access.

4. Save the record.
This prevents ClientSpace from accessing the company data from the listed clients.
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Initial Import Queue management

As records are retrieved from PrismHR, Import Queue (tblImportQueue) records are created and
modified. The Import Queue Management dashboard and detail pages enable you to reset queue item
statuses (reset to Pending, set to Complete) and to interrogate error data using the Log Data field.

All PrismHR import failures are stamped on the Queue record. If the queue record fails to import, it is
put in Failure status. The reason for the error is included in the log data row.

The Import Queue management suite is available from System Admin > Imports > Manage Import
Queue.

Configuration includes:

l ImportIDs for Lookups and other data (ClientSpace)
l Import Map Headers (ClientSpace)
l Import Map Details (ClientSpace)
l API Configuration form (ClientSpace)
l The PrismHR Site

Import IDs

Certain Lookups and other data require translation to Prism values. This is done using ImportIDs on the
following data.

Import IDs

l Contract Type (ClientMaster)
l Contract Status (ClientMaster)
l HR Rep User
l Sales Rep User
l Employment Status (Employee)
l Employment Type (Employee)
l Marital Status (Employee)

l Gender (Employee)
l Ethnic Classification (Employee)
l Work State Filing Status (Employee)
l Home State Filing Status (Employee)
l Pay Method (Employment)
l Pay Frequency (Employment)

Import Map Headers

Import Map Headers must be configured for each file type to be produced and MUST match the
following PEO headers**. Configure the Custom Import Class for each Header.
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File Custom import class

HRPAPI_initial_company*.csv ClientSpace.PEO.Import.ClientMaster

HRPAPI_initial_clientteam*.csv No custom import class

HRPAPI_initial_employee*.csv ClientSpace.PEO.Import.Employee

HRPAPI_initial_employment*.csv ClientSpace.PEO.Import.Employment

HRPAPI_initial_location*.csv ClientSpace.PEO.Import.Location

**These import map configurations should have been pushed to your site but may be inactive. If
you find these configurations do not on your site, log an Extranet case to have these configurations
added.

HRP Subscription Dataforms

The following dataforms are typically used in the Admin Workspace:

l Client Schema
l Employee Schema
l Voucher Schema

Each form contains:

l Schema: For Import Ongoing only, defines the type of data this Subscription ID evaluates.
l Subscription ID: The HRP ID of the registered Subscription for this ClientSpace installation.
l Replay ID: The last Event marker processed, from the last time the Ongoing Scheduled Process

successfully ran.
l Voucher Last Process Date: The last date the Voucher Scheduled Process successfully ran.
l Notes: General information such as the date and time the scheduled process ran, the Replay ID

used.

Excludes Import Map Detail
Review the PrismHR Security subscription record to ensure that Users=activeUser is NOT part of the
Excludes Import Map Detail for the HRPAPI_users import. The import must contain a valid record for the
Active flag.

User status in PrismHR and ClientSpace
The ClientSpace user Active value is automatically set to the PrismHR value so that when a user is
inactivated in PrismHR, the same status is reflected in ClientSpace.
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Contact status in PrismHR and ClientSpace
When a Contact is deleted in PrismHR, the corresponding Contact in ClientSpace is marked as Inactive.

PrismHR API - USERS
When processing User Import Queue records, if the email address is incorrectly formatted or there is no
email address, the system marks the record as Requires Attention and adds a message to the Import
Queue Log Data. The message follows this format: "User '<username>' invalid or missing email address
<invalid email>, queue record set to Requires Attention".

For example, if the email address for the user carlos was carlos@gmail, the system would evaluate the
email address as incomplete (since the email address was missing .com from the end) and add the
message "User carlos invalid or missing email address carlos@gmail, queue record set to Requires
Attention." to the import queue log.

Initial Import: Configuring the API for Import Map Details

This topic guides you through configuring the Import Map Details. In the Add Parameter section, you
specify a set of name-value pairs for each Field to be included in the import file.
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To configure the API:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. If there is no API entry in the list, then click Add.
The API Configuration form opens. The API Configuration form has an API Configuration fieldset
that contains the information necessary to connect to the specific PrismHR installation for the
Client. The example shows test data. Use actual client data when configuring.

API Type Select PrismHR API.
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Application Code Use a unique value to denote the PrismHR installation, such as
PrismHRAPI.

Application Name A description that displays in the ClientSpace lists. Use something to
indicate the installation, such as PrismHR API.

Username The username registered with the PrismHR API for this site.

Password The password that is associated with the PrismHR Account
Username for this site.

Description Provide a description.

Endpoint A formatted URL pointing to the API services for the specific PrismHR
client and site (must include the trailing / character).

For the GetPayrollBatchCutoffDate parameter, specify version 1.22
or higher of the PrismHR API. Note: Failure to update the version in
the API Endpoint config results in the following error in the API log:
Error Processing Batch Control Info '202023.104', error=Unexpected
character encountered while parsing value: }. Path
'PayrollBatchWithOptionsResponse', line 1, position 35., queue record
will be in Pending status.

Secondary ID An identifier that is used to enable the monitoring of all PrismHR
clients at an installation.

Logging Level • The PrismHR Export process for Company Information and
Employee/Employment information contains important log
information to monitor the export activity from ClientSpace to
PrismHR.

• When set to Level 2 (Verbose), ALL log data is stored in the
Scheduled Process History Table. This includes entry/status/exit
entries for every PrismHR API call and ClientSpace action (up to the
Import Phase). Errors and Information entries are created.

• When set to Level 1, only ERRORS are logged to the Scheduled
Process History Table.

• When set to Level 0 (None), No log data is produced.

Active When this option is selected, the configuration is active (enabled).
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To configure Additional Parameters:
This is where you specify a set of name-value pairs to configure the process.

1. Click Add Parameter.
A new row opens.

2. Select from the following list to add parameters.

Parameter Value settings

AllowUserTypes Defines the types of users included in a user import:
l I: Internal User. Someone who works for the PEO or someone

at PrismHR.
l M: Manager. Someone who works in payroll or human

resources for a PEO client.
l A: Trusted Advisor. Same as Manager but without an

Employee ID. Used for consultants.
l E: Employee.
l S: Super User in the legacy HRPWE. Similar to I.
l C: Client Manager in HRPWE.

BillingBatchCount Controls the number of payroll batches processed at once during
the PrismHR Import Payroll Batch Complete scheduled process
(which is one of two scheduled processes used by the Payroll Batch
process.) By default, it is set to 250. This means that an import file
containing more than 250 batches is processed in chunks of 250 to
reduce impact on the server. Also see Configuring the Payroll Batch
Scheduled Processes.
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Parameter Value settings

CanCreateWorkspaces Created to support multi-tenant environments where there are
multiple PrismHR API imports and a need to specify which PrismHR
import feeds create a new workspace from an import record and
which do not.

When PrismHR nightly imports run, ClientSpace evaluates each
import file to determine if the PEOID in the import file matches the
Secondary ID entered on the API Configuration record. If there is a
match, ClientSpace then references the CanCreateWorkspaces
parameter to determine if a workspace should be created using the
following logic:
l If the CanCreateWorkspaces parameter is set to a value of 1

and the Client Number does not already exist for the PEOID,
a new workspace is created.

l If the CanCreateWorkspaces parameter is set to a value of 0
or is blank, a new workspace is not created.

ContactImportBehavior l Insert/Both: Allows Import Queue record creation for
Contacts in PrismHR but not in ClientSpace.

l Update: For Contacts in PrismHR but not in ClientSpace, it
does not create an Import Queue record. It updates existing
ClientSpace Contacts with changes.

DefaultProjectCode Defines where an employee portal case is created if no workspace
match is found. Uses ProjectCode from workspace settings.

ExcludeCompanyFromSync l 0: The Company Initial import map is included in the sync if
the map is active (updates Company information and all
other active Initial maps). Note: Initial sync of company data
can be applied to individual workspaces using the option
Sync with PrismHR on the Client Master. See PrismHR to
ClientSpace Client sync.

l 1: The Company Initial import map is NOT included in the
sync whether or not the map is active (all other active Initial
maps are processed).

ExcludedContractTypes ASO and HRO are the PrismHR Service Types that should not be
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Parameter Value settings

imported into ClientSpace.

ExcludeEmailDomains Email domains that should not be imported into ClientSpace.
Supports comma-separated list.

ExcludeUserNames User names that should not be imported into ClientSpace.

FailureRetryTime l 0: Reprocesses all failed Import Queue records.
l X: Reprocesses failed Import Queue records with an

UpdatedDate greater than X hours.
l If not present (default), failed Import Queue records are not

reprocessed.

GetPayrollBatchCutoffDate Remote Cutoff Date is the deadline for reporting payroll.
l 0: Do not retrieve the Batch Control Remote Cutoff Date in

the import.
l 1: Include the Remote Cutoff Date if available in the Payroll

Batch in PrismHR.
l If GetPayrollBatchCutoffDate not present, defaults to 0.

GetPayrollBatchCutoffDate parameter requires version 1.22 or
higher of the PrismHR API. Specify the version in the URL in
Endpoint. For example, https://api.prismhr.com/api-1.22/services/.

HRPRunImport l 0: The files generated by the API Import appear in the
Manage Import File List at status Ready for Import.

l 1: The files generated by the API Import automatically import
into ClientSpace.

InitialImportClients Sets how many queue records of each import map type are
processed at a time.

InitialMaxEmployeeCount Sets the threshold of maximum number of Employees to import
during a scheduled process run.
l If no Value is set, it processes all Employees for Clients (up to

the InitialImportClients count) during a scheduled process
run.

l If a Value is set, after obtaining a list of Employees, if the
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Parameter Value settings

number exceeds the parameter Value, no additional
processing occurs for that run. Subsequent runs for the
scheduled process resume the import, picking up where the
last run ended when the maximum threshold was met. This
parameter eliminates session timeouts for groups of Clients
with high Employee counts.

KeepLeadingZeros l 0: Any leading zeros on CompanyID in PrismHR are stripped
off before the Client Record is saved.

l 1: Leading zeroes on CompanyID are retained when
importing records into ClientSpace.

NumberOfEvents Sets the max number of records to import per subscription record
on each run of the HRPAPI_Ongoing import. Setting
NumberOfEvents to 0 defaults the max records imported per
subscription to 100. This parameter minimizes the risk of imports
failing due to large record sets.

OSHAYearsToProcess This parameter denotes the number of years to get the OSHA totals
from PrismHR.
l Not Present: If the parameter is not present, then limit the

number of years to the past year.
l 1 or Less: If the parameter is set to 1 or less, then limit the

number of years to the past year.
l 2 If the parameter equals 2, then limit the number of years to

the past two years.
l 3 or Greater: If the parameter equals 3 or greater, then limit

the number of years to the past three years.

ProcessVouchers l 0: Queued Employee Payroll Vouchers are not processed
immediately.

l 1: Employee Payroll Vouchers are processed as they are
imported.

RequireBillingVouchers l 0: If Billing Vouchers cannot be located for a Client, the
Payroll Voucher data is processed (will be missing all Billing-
related mapped fields).
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Parameter Value settings

l 1: The payroll is not processed for that Client (current
behavior). If the parameter is not specified, it is assumed that
RequireBillingVouchers=1 (current behavior).

3. Click Save.

How InitialImportClients and InitialMaxEmployeeCount work together

Let's look at how InitialImportClients and InitialMaxEmployeeCount are processed. The scenario is as
follows:

n API Parameter InitialImportClients = 5 (5 clients will be processed during each scheduled
process run)

n API Parameter InitialMaxEmployeeCount= 10 is the maximum number of Employees to import
during a scheduled process run

First Scheduled Process Run
The first scheduled process run: 5 Clients at a time, Max Employee Threshold is 10

Client Employees processed

Client 1 has 5
employees

5 Employees will be processed

Client 2 has 2
Employees

2 Employees will be processed

Client 3 has 4
Employees

4 Employees will be processed

Client 4 has 20
Employees

Client 4 will not be processed during this run, Max Employee Count has been
exceeded

Client 5 has 30
Employees

Client 5 will not be processed during this run, Max Employee Count has been
exceeded

Second Scheduled Process Run
The second scheduled process run: 5 Clients at a time, Max Employee Threshold is 10
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Client Employees processed

Client 4 has 20
Employees

20 Employees will be processed

Client 5 has 30
Employees

Client 5 will not be processed during this run, Max Employee Count has been
exceeded

Client 6 has 2
Employees

Client 6 will not be processed during this run, Max Employee Count has been
exceeded

Client 7 has 50
Employees

Client 7 will not be processed during this run, Max Employee Count has been
exceeded

Client 8 has 9
Employees

Client 8 will not be processed during this run, Max Employee Count has been
exceeded

If InitialMaxEmployeeCount = 0, all Clients (up to InitialImportClients count) and their Employees will be
processed each scheduled process run.

PrismHR Import Queue Initial Clients scheduled process

Note: Scheduled process PrismHR Import Initial is deprecated and should NO LONGER be used --
It is now scripted out as inactive). Scheduled processes PrismHR Import Queue Initial Clients and
PrismHR Import Initial Sync are used now.

Scheduled process PrismHR Import Queue Initial Clients obtains a list of all clients available through
the API, creates Import records for each, and sets the Sync with PrismHR flag on the Client Master for
each Client imported (company initial import map HRPAPI_initial_company*.csv MUST be active). The
company initial import map contains the Sync with PrismHR column (scripted out active) to allow the
setting of that flag on the Client Master.

The API Configuration Additional Parameter InitialImportClients=x determines how many clients at a
time are processed when the scheduled process runs (Location, ClientTeam, Employee,
Employment). The parameter defaults to 5 clients per PrismHR Import Initial scheduled process run. If
the client number cannot be matched in PrismHR, the client is ignored. These related locations are then
mapped into an import file for all clients based on the initial_location import configuration, and when
all locations for all clients have been retrieved, the import begins. This process syncs the system with
any missing or new client locations, at the end of which the scheduled process inactivates itself.

Scheduled process PrismHR Import Initial Sync then processes the Clients to Sync and imports the
remaining ACTIVE Import Map data (employee, employment, location). The PrismHR Automation
process is the preferred method to use when attempting to sync all client data. It handles the newer
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initial import process. It has logic to turn on/off respective scheduled processes to prevent conflicts (the
Prism Events scheduled process is not included in this, it can be running while initials are running).

Parameters for the PrismHR Site

Use the following parameters to configure the PrismHR site before using the API. This configuration is
done in the client Payroll System.

HRP site Parameters

Valid User account • Username (case sensitive)
• Password (case sensitive)
• PEO ID (case sensitive)
• HRP API URL. The endpoint of the WSDL on the server to be used.

Account The Account must be Enabled.

Subscriptions The Account must have permission to create subscriptions (for Imports only). 
The following subscriptions are automatically created on the PrismHR server
when the process first executes:
• Employee/Person | Client | Compensation. Description is: “ClientSpace

Employee Person-Client-Compensation Subscription All Clients”
• Client/Master | Location. Description is "ClientSpace Client master

Subscription All Clients”
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HRP site Parameters

Requirements PrismHR requires the following for each Client:
• Business Entity Type (Example: LLC, S Corp, etc.) (Client Details)
• Payroll Check Account (Account)
• Garnishments Check Account (Account)
• Receipts Account (Account)
• Processing Schedule (Control)
• GL Template (Control)
• Bill Format (Billing)
• Billing Template (Billing)
• Delivery Method (Payroll)
• Pay Groups (Payroll)

• Pay Groups (Payroll)
• Pay Group
• Description
• Pay Schedule
• Pay Date

• Job Codes (Positions)

Process

1. The Client and Employee records are AUTOMATICALLY populated by the PrismHR Import Queue
Initial Clients Scheduled Process. For the system to auto populate the record, you need to create
stub records for the Client and Employee imports:
l Create two semi-blank PrismHR Subscription dataforms, one for Client and one for Employee.

On these forms, select the Schema and Classes (Client-Master,Location; Employee-
Person,Client,Compensation)

o On those dataforms leave all other fields empty (no Subscription ID, no Replay ID, etc.)
o Run the Import Ongoing scheduled process

l If the connection info is correct and PrismHR has properly configured our user account, the
process

o acknowledges that two new subscriptions have to be created in HRP
o creates the new subscriptions in PrismHR
o updates our subscription dataforms with the new information
o checks for any new events (most likely there will not be any since we grab the highest
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event replay id when the subscription is created)
o exits

2. Run the PrismHR Import Queue Initial Clients scheduled process (before PrismHR Import
Initial Sync).

3. All Companies available on the PrismHR site are imported. 
4. Special Import Queue records are generated for each Company AND FOR EACH ACTIVE INITIAL

IMPORT MAP HEADER (Location, ClientTeam, Employee, Employment), as in:

106!.!106!.!Location (Company 106, Location import map)

106!.!106!.!ClientTeam

106!.!106!.!Employee

106!.!106!.!Employment

107!.!107!.!Location (Company 107, Location import map)

107!.!107!.!ClientTeam

107!.!107!.!Employee

107!.!107!.!Employment

5. Those Import Queue records are set to Status = InitialPending.
6. The PrismHR Import Queue Initial Clients should only execute once. If for some reason it needs to

execute multiple times, DELETE all of the Import Queue Records before proceeding. 
7. Run the PrismHR Import Initial Sync scheduled process. 

A list of active Initial Import Maps is retrieved.  
8. For each Map, a list of Import Queue records for that map are retrieved (the quantity to process is

defined by API Config InitialImportClients=x).
9. Import files are generated

l If HRPRunImport=1, those Import Queue records are marked as InitialCompleted.
l If HRPRunImport=0, those Import Queue records are left at InitialPending and are retrieved

again the next time the process is run.
10. Assuming HRPRunImport=1, running the PrismHR Import Initial again grabs the next set of Import

Queue records (those marked InitialPending). This continues until all Import Queue records are
processed (marked InitialCompleted).

11. To see if the process was successful, review the HRP API Import Ongoing log ad hoc report.

ClientSpace Setup & Administration © 2025 PrismHR 774

Chapter 20 APIs



Employment Status Codes

l Employment Status Codes are recorded in the ClientSpace Employment Status
(EmploymentStatus) field. The code imports from the PrismHR vemployeeStatus field. See the
ClientSpace API Data Mapping file in Attachments.

l To determine a "Termination" code, ClientSpace uses the PrismHR Status Classification
(statusCode) field. See the ClientSpace API Data Mapping file in Attachments.

l If the PrismHR statusCode is set to "Terminated", the ClientSpace Employment Status field is
updated to "Terminated" and the ClientSpace Termination Date is set to the PrismHR statusDate
value. If PrismHR statusCode is NOT set to "Terminated", the ClientSpace Employment Status
field is updated to the value in the PrismHR employeeStatus field.

Before Go Live

When configured, a series of tests should be performed to compare the validity of the data retrieved by
the API against existing data being imported into ClientSpace. This is crucial to ensure a smooth
transition to API imports. 

These tests involve running the imports manually with the additional parameter of HRPRunImport=0
to generate the files, but not import them. Then you should scrutinize the files for accuracy and
completeness. 

Skipping the data validation testing can lead to duplicated or corrupted data, so it is critical to perform
these validations before automating the API imports. If you need help with validation or have questions
about this process, log an Extranet case.

Configuring the PrismHR API for Ongoing Imports

This topic describes the PrismHR API Import process and includes step-by-step configuration
information to help you get started using the PrismHR API. Before you begin, log an Extranet case for
your implementation specialist to configure the API interface. The implementation specialist will need
you to provide:

l HRP Username
l HRP Password
l HRP PEO ID
l HRP API URL

The processes described in this topic are for an Ongoing process, which pulls changes from the
PrismHR system into a ClientSpace installation. If you are not sure of your configuration or the next
steps, stop, and log an Extranet case. After enabled, the API overwrites existing data values, potentially
leading to data loss if not properly configured.
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Web services company restricted list

Certain companies or employees should not be imported into ClientSpace (for example, the PEO itself).
The HRP Configuration tool contains a Web Services Access Control interface. Companies that should
not be imported into ClientSpace should be listed as Deny on the Company List form. 

Perform the following steps in the HRP Configuration tool:

1. Go to System > System Parameters > Action Menu > Web Service User and open the
CLIENTSPACE user.

2. Select Grant Access by Default, Deny Access to Specified. Specify which clients will be denied
access.

3. Under Company Access, in Company ID, type the company IDs that you do not want the
ClientSpace API to access.

4. Save the record.
This prevents ClientSpace from accessing the company data from the listed clients.

Ongoing Import Queue Management

As records are retrieved from PrismHR, Import Queue (tblImportQueue) records are created and
modified. The Import Queue Management dashboard and detail pages enable you to reset queue item
statuses (reset to Pending, set to Complete) and interrogate error data using the Log Data field.
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When the queue record fails to import into ClientSpace, we show the queue record in Failure status
and add a message to the Import Queue Log Data for the following Ongoing import types: Location, I9,
Employee, Employment, Contact, User, PayrollBatch, Company, ClientTeam, Codes, and Employee
Future Change.

When a PrismHR API - USERS import has a missing or invalid email address, we show the queue record
in Requires Attention status and we add a message to the Import Queue Log Data. The message
follows this format: "User '<username>' invalid or missing email address <invalid email>, queue record
set to Requires Attention".

For example, if the email address for the user carlos was carlos@gmail, the system would evaluate the
email address as incomplete (since the email address was missing .com from the end) and add the
message "User carlos invalid or missing email address carlos@gmail, queue record set to Requires
Attention." to the import queue log.

To access the management suite:
l Go to System Admin > Imports > Manage Import Queue.

Configuration includes

The configuration includes the following steps:

l ImportIDs for Lookups and other data (ClientSpace)
l Import Map Headers (ClientSpace)
l Import Map Details (ClientSpace)
l API Configuration form (ClientSpace)
l HRP Subscription Dataforms (ClientSpace)
l The PrismHR site parameters

Import IDs
Certain Lookups and other data require translation to PrismHR values. Translation occurs by using
ImportIDs on the following data:

• Contract Type (ClientMaster) • Contract Status (ClientMaster)

• HR Rep User • Sales Rep User

• Employment Status (Employee) • Employment Type (Employee)

• Marital Status (Employee) • Gender (Employee)
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• Ethnic Classification (Employee) • Work State Filing Status (Employee)

• Home State Filing Status (Employee) • Pay Method (Employment)

• Pay Frequency (Employment)

Import Map Headers
Configure the Import Map Headers for each file type to be produced. The configured headers MUST
match the PEO headers listed in the following table. You must configure the Custom Import Class for
each Header.

Import file Import Map Header

HRPAPI_company_ongoing*.csv ClientSpace.PEO.Import.ClientMaster

HRPAPI_clientteam_ongoing*.csv No custom import class

HRPAPI_employee*.csv ClientSpace.PEO.Import.Employee

HRPAPI_employment*.csv ClientSpace.PEO.Import.Employment

HRPAPI_location*.csv ClientSpace.PEO.Import.Location

HRPAPI_voucher*.csv ClientSpace.PEO.Import.EmployeeVoucher

HRPAPI_payroll_batch*.csv ClientSpace.PEO.Import.PayrollBatch

These import map configurations should have been pushed to your site but may be inactive. If
you find these configurations do not exist on your site, log an Extranet case to add these
configurations.

Ongoing Imports: Configuring the API for Import Map Details

Configure the parameters for the import file.

ClientSpace Setup & Administration © 2025 PrismHR 778

Chapter 20 APIs



To configure the API:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. On the PrismHRAPI item, click (Open).
3. Configure as appropriate for your organization. The API Configuration fieldset connects the

specific PrismHR installation for the client.

API Type Select PrismHR API.

Application Code Use a unique value to denote the PrismHR installation, such as
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PrismHRAPI.

Application Name A description that displays in the ClientSpace lists. Use something to
indicate the installation, such as PrismHR API.

Username The username registered with the PrismHR API for this site.

Password The password that is associated with the PrismHR Account
Username for this site.

Description Provide a description.

Endpoint A formatted URL pointing to the API services for the specific PrismHR
client and site (must include the trailing / character).

For the GetPayrollBatchCutoffDate parameter, specify version 1.22
or higher of the PrismHR API. Note: Failure to update the version in
the API Endpoint config results in the following error in the API log:
Error Processing Batch Control Info '202023.104', error=Unexpected
character encountered while parsing value: }. Path
'PayrollBatchWithOptionsResponse', line 1, position 35., queue record
will be in Pending status.

Secondary ID An identifier that is used to enable the monitoring of all PrismHR
clients at an installation.

Logging Level • The PrismHR Export process for Company Information and
Employee/Employment information contains important log
information to monitor the export activity from ClientSpace to
PrismHR.

• When set to Level 2 (Verbose), ALL log data is stored in the
Scheduled Process History Table. This includes entry/status/exit
entries for every PrismHR API call and ClientSpace action (up to the
Import Phase). Errors and Information entries are created.

• When set to Level 1, only ERRORS are logged to the Scheduled
Process History Table.

• When set to Level 0 (None), No log data is produced.

Active When this option is selected, the configuration is active (enabled).

To configure Additional Parameters:
This is where you specify a set of name-value pairs to configure the process.
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1. Click Add Parameter.
A new row opens.

2. Select from the following list to add parameters.

Parameter Value settings

AllowUserTypes Defines the types of users included in a user import:
l I: Internal User. Someone who works for the PEO or someone

at PrismHR.
l M: Manager. Someone who works in payroll or human

resources for a PEO client.
l A: Trusted Advisor. Same as Manager but without an

Employee ID. Used for consultants.
l E: Employee.
l S: Super User in the legacy HRPWE. Similar to I.
l C: Client Manager in HRPWE.

BillingBatchCount Controls the number of payroll batches processed at once during
the PrismHR Import Payroll Batch Complete scheduled process
(which is one of two scheduled processes used by the Payroll Batch
process.) By default, it is set to 250. This means that an import file
containing more than 250 batches is processed in chunks of 250 to
reduce impact on the server. Also see Configuring the Payroll Batch
Scheduled Processes.

CanCreateWorkspaces Created to support multi-tenant environments where there are
multiple PrismHR API imports and a need to specify which PrismHR
import feeds create a new workspace from an import record and
which do not.
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Parameter Value settings

When PrismHR nightly imports run, ClientSpace evaluates each
import file to determine if the PEOID in the import file matches the
Secondary ID entered on the API Configuration record. If there is a
match, ClientSpace then references the CanCreateWorkspaces
parameter to determine if a workspace should be created using the
following logic:
l If the CanCreateWorkspaces parameter is set to a value of 1

and the Client Number does not already exist for the PEOID,
a new workspace is created.

l If the CanCreateWorkspaces parameter is set to a value of 0
or is blank, a new workspace is not created.

ContactImportBehavior l Insert/Both: Allows Import Queue record creation for
Contacts in PrismHR but not in ClientSpace.

l Update: For Contacts in PrismHR but not in ClientSpace, it
does not create an Import Queue record. It updates existing
ClientSpace Contacts with changes.

DefaultProjectCode Defines where an employee portal case is created if no workspace
match is found. Uses ProjectCode from workspace settings.

ExcludeCompanyFromSync l 0: The Company Initial import map is included in the sync if
the map is active (updates Company information and all
other active Initial maps). Note: Initial sync of company data
can be applied to individual workspaces using the option
Sync with PrismHR on the Client Master. See PrismHR to
ClientSpace Client sync.

l 1: The Company Initial import map is NOT included in the
sync whether or not the map is active (all other active Initial
maps are processed).

ExcludedContractTypes ASO and HRO are the PrismHR Service Types that should not be
imported into ClientSpace.

ExcludeEmailDomains Email domains that should not be imported into ClientSpace.
Supports comma-separated list.
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Parameter Value settings

ExcludeUserNames User names that should not be imported into ClientSpace.

FailureRetryTime l 0: Reprocesses all failed Import Queue records.
l X: Reprocesses failed Import Queue records with an

UpdatedDate greater than X hours.
l If not present (default), failed Import Queue records are not

reprocessed.

GetPayrollBatchCutoffDate Remote Cutoff Date is the deadline for reporting payroll.
l 0: Do not retrieve the Batch Control Remote Cutoff Date in

the import.
l 1: Include the Remote Cutoff Date if available in the Payroll

Batch in PrismHR.
l If GetPayrollBatchCutoffDate not present, defaults to 0.

GetPayrollBatchCutoffDate parameter requires version 1.22 or
higher of the PrismHR API. Specify the version in the URL in
Endpoint. For example, https://api.prismhr.com/api-1.22/services/.

HRPRunImport l 0: The files generated by the API Import appear in the
Manage Import File List at status Ready for Import.

l 1: The files generated by the API Import automatically import
into ClientSpace.

NumberOfEvents Sets the max number of records to import per subscription record
on each run of the HRPAPI_Ongoing import. Setting
NumberOfEvents to 0 defaults the max records imported per
subscription to 100. This parameter minimizes the risk of imports
failing due to large record sets.

OSHAYearsToProcess This parameter denotes the number of years to get the OSHA totals
from PrismHR.
l Not Present: If the parameter is not present, then limit the

number of years to the past year.
l 1 or Less: If the parameter is set to 1 or less, then limit the

number of years to the past year.
l 2 If the parameter equals 2, then limit the number of years to
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Parameter Value settings

the past two years.
l 3 or Greater: If the parameter equals 3 or greater, then limit

the number of years to the past three years.

ProcessVouchers l 0: Queued Employee Payroll Vouchers are not processed
immediately.

l 1: Employee Payroll Vouchers are processed as they are
imported.

RequireBillingVouchers l 0: If Billing Vouchers cannot be located for a Client, the
Payroll Voucher data is processed (will be missing all Billing-
related mapped fields).

l 1: The payroll is not processed for that Client (current
behavior). If the parameter is not specified, it is assumed that
RequireBillingVouchers=1 (current behavior).

3. Click Save.

For GetPayrollBatchCutoffDate, ensure that the correct version of the PrismHR API is reflected in
the Endpoint URL. After the scheduled process runs, review the API log for any errors.

PrismHR Subscription Dataforms

In the Admin Workspace, there are typically three of the following dataforms:

• Client schema
• Employee schema
• Payroll schema
• Security schema
• Voucher schema
Each form contains:

Schema For Import Ongoing only, defines the type of data this particular
Subscription ID evaluates

Subscription ID The HRP ID of the registered Subscription for this ClientSpace
installation.
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Replay ID The last Event marker processed from the last time the Ongoing
Scheduled Process successfully ran.

Voucher Last Process Date The last date the Voucher Scheduled Process successfully ran.

Notes General information such as the date and time the scheduled process
ran, the Replay ID used.

The Client, Employee, Payroll, and Security records are AUTOMATICALLY populated by the PrismHR
Import Ongoing Scheduled Process.

For the system to auto-populate the record, create stub records for the Client and Employee imports.

To create stub records:
1. Create semi-blank HRP Subscription dataforms, one for Client, Employee, Payroll, and Security. On

these forms, all you have to do is select the Schema and Classes (Client-Master,Location; Employee-
Person,Client,Compensation).

2. On those dataforms leave all other fields empty (no subscription id, no replay id, etc.).
3. Run the Import Ongoing scheduled process.
4. If the connection info is correct and PrismHR has properly configured our user account, the process

will:
• acknowledge that two new subscriptions must be created in HRP
• create the new subscriptions in HRP
• update our subscription dataforms with the new information
• check for any new events (most likely there will not be any since we grab the highest event

replay id when the subscription is created)
• exit

5. Review the HRP API Import Ongoing log ad hoc report to see if the process was successful.
6. The Voucher record must be manually generated:

• Schema: Voucher
• Voucher Last Process Date: enter the date from which you wish to Import Vouchers. After this

field is populated and the Import Voucher Scheduled Process runs, the process will update this
field

• No other fields need to be configured

PrismHR Site parameters

The PrismHR Site must be configured with the following parameters before the use of the API can
commence. This configuration is performed in the client Payroll System.
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Valid User account • Username (case sensitive)
• Password (case sensitive)
• PEO ID (case sensitive)
• HRP API URL. The endpoint of the WSDL on the server to be used

The Account must be Enabled

The Account must have
permission to create
subscriptions (for Imports
only).

The following subscriptions will be automatically created on the HRP
server when the process first executes:
• Employee/Person|Client|Compensation. Description is

“ClientSpace Employee Person-Client-Compensation Subscription
All Clients”

• Client/Master|Location. Description is "ClientSpace Client master
Subscription All Clients”

HRP requires the following for
each Client:

• Business Entity Type (Example: LLC, S Corp) (Client Details)
• Payroll Check Account (Account)
• Garnishments Check Account (Account)
• Receipts Account (Account)
• Processing Schedule (Control)
• GL Template (Control)
• Bill Format (Billing)
• Billing Template (Billing)
• Delivery Method (Payroll)
• Pay Groups (Payroll)

• Pay Group
• Description
• Pay Schedule
• Pay Date
• Job Codes (Positions)

The Scheduled Process

There are two scheduled processes involved in the HRP Import function:
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l HRP Import Ongoing process generates the following standard Import files:
o HRPAPI_company_ongoing*.csv
o HRPAPI_clientteam_ongoing*.csv
o HRPAPI_employee*.csv
o HRPAPI_employment*.csv
o HRPAPI_location*.csv

l HRP Import Voucher process generates the following standard Import file:
o HRPAPI_voucher*.csv

Service Provider user type

Prism users who are not Service Provider user types are not imported using the HRPAPI_Users initial
and ongoing imports. The user types included in the user import is determined using the
AllowUserTypes parameter.

Existing inactive users

Existing inactive users are deleted if a change is made to these users in PrismHR and the user is still
inactive. The system will not delete user accounts without being triggered by a change to a user
account in PrismHR.

Import Queue records stuck in In-Progress status

The system converts import queue records to import file rows. As the system processes the file, the
system updates the import queue record status. The first status is In Progress. If the import is aborted,
the queue record will be stuck in the In Progress status. If this occurs, the system will retrieve records
that have been in the In Progress status for more than an hour. The system will reset the status to
Pending and allow the process to retrieve current data via the PrismHR API.

Additional parameters

Additional parameters used by the PrismHR API include:

DefaultProjectCode Sets the default workspace for a record if the system is unable to
determine it

KeepLeadingZeros Tells the system to not strip leading zeroes from the client number value
stored in PrismHR

ExcludedContractTypes Sets the system to ignore clients in the PrismHR system based on the
Service Type. (comma delimited)

• Add ExcludedContractTypes=XXX,YYY to the Additional Parameters
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section of the API configuration replacing XXX,YYY with the comma
separated (or singular) list of PrismHR Service Types.

• Service Types must be comma-separated (if there are multiples to
exclude).

• This setting applies to Import Initial Queue Clients and Import Initials
scheduled processes.

• If a Client is of an excluded contract type, it is not included in the
import file.

• Import Queue records are not created for Clients that are excluded
(for remaining initial import maps).

ExcludeEmailDomains Allows a comma-separated list of partial email domains to be added. If a
user account has an email domain that starts with the excluded string,
the user account is not imported.
Example: ExcludeEmailDomains=PrismHR,gmail would exclude any user
with an email domain beginning with PrismHR or Gmail such as
PrismHR.com.

ExcludeUserNames Allows a comma-separated list of partial UserIDs from the PrismHR
payroll system to be added. If a user account has a UserID that starts
with the excluded string, the user account is not imported.

AllowUserTypes If not valid, user type is blank, will inactivate existing records if present.
UserTypes are:
• E: Worksite Employee
• M: Worksite Manager
• A: Worksite Trusted Advisor
• I: Service Provider

NumberOfEvents Sets the max number of records to import per subscription record on
each run of the HRPAPI_Ongoing import. Setting NumberOfEvents to 0
defaults the max records imported per subscription to 100. This
parameter minimizes the risk of imports failing due to large record sets.
If this parameter is not set on the import configuration, the system adds
the parameter and sets the value to 500.

ContactImportBehavior l Insert/Both: Allows Import Queue record creation for Contacts
that are in Prism but not in ClientSpace.

l Update: Does not allow Import Queue record creation for
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Contacts that are in Prism but not in ClientSpace. Updates existing
ClientSpace Contacts with changes.

Importing to ClientSpace

The PrismHR Import Ongoing process evaluates PrismHR Events (Company and Employee changes)
that may affect existing ClientSpace Client and Employee data, as well as those events that create new
Clients and Employees. All active ongoing import map configurations are processed each time the
scheduled process executes on the same set of PrismHR Events (this minimizes the amount of data
retrieved from PrismHR). Data from PrismHR is extracted and loaded into ClientSpace through
scheduled processes.

Note: During an Import, if an exception occurs during the dataform save, the system logs an
appropriate exception in both the Import logs and the exception log.

Client records

For PrismHR API Ongoing events, ClientSpace ignores inactive Client Master records. When events are
retrieved and converted into Import Queue records, for non-Company ongoing import maps, the Client
associated with the event must be in ClientSpace. If not, the event is discarded, and an Import Queue
record is not created for that event.

l The PrismHR Import Ongoing scheduled process imports ongoing data for clients only when a
matching client number exists in ClientSpace.

l If the Client Number exists, but the Client is not in a Status of Client, PendingTermination,
Termination, or UnderContract, the event is ignored.

l If the ongoing event is a Client schema event (UPDATE or CREATE), the event is processed, and an
Import Queue record is created.

l If the event is a Security schema event, the event is processed, and an Import Queue record is
created.

l All other events test whether the associated Client exists; if not, the ongoing event is skipped. No
Import Queue record is created, and a Business Intelligence report entry is logged "---Create
Import Queue Events, ClientNumber not found in ClientSpace, this event

will not be processed".
l If a DELETE event is received for a Client, the Import Queue record is automatically completed

without attempting to retrieve the Client details. No import row is generated. The Queue record is
marked with a comment indicating the Client was deleted from PrismHR.

l If importing data from a Client Team event, and the 'my SupportTeamDashboard' value is empty,
the system clears the value on the Client Team form (unless a default value is configured in the
import).
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l Activation Date mapping - The system evaluates the Set Activation Date on Import business
rule during import. If the Activation Date is populated, and the status equals Client, the system
accepts the imported value. If the Status does not equal Client (for example, Terminated) the
system reverts to the previous value.

Employee and Employment records

Employee records
l When an Employee record is not found in PrismHR, the associated Event Import Queue record is

marked Completed with a note indicating the Employee was removed from PrismHR.
l For Employee records, when a DELETE queue record is created, ClientSpace inactivates the

associated Employee record.
l For Employment records, when a DELETE queue record is created, ClientSpace sets the status of

the associated Employment record to Deleted.
l Future changes are supported by the import configuration HRPAPI_emp_futurechange*.csv,

which captures Termination Date and Termination Reason from the employee record when that
date occurs in the future. You can synchronize the fields for future changes while leaving the
employment status Active.

Employment records
l For Employment data on an Employee that is not found in ClientSpace, the system creates a stub

Employee record and populates the Employee ID and ImportID. The record is set to Active. The
stub Employee record is created to accept Employment data. The system creates a new Employee
Import Queue record in Pending status. This action populates the new Employee data the next
time the scheduled process runs.

l If the AnnualPay field from PrismHR is not between -10,000,000.00 and 10,000,000.00, the
AnnualPay field value is not imported into ClientSpace. In the Employment record, the field
Invalid Annual Pay field is selected, and the Annual Pay is not set for the Employee. This logic
applies to Employment imports that use the ClientSpace.PEO.Import.Employment Custom
Import Class (in the Import Map Header Detail).

l Employment Status Codes are recorded in the ClientSpace Employment Status
(EmploymentStatus) field. The code imports from the PrismHR employeeStatus field. See the
ClientSpace API Data Mapping file in Attachments.

l To determine a "Termination" code, ClientSpace uses the PrismHR Status Classification
(statusCode) field. See the ClientSpace API Data Mapping file in Attachments.

l If the PrismHR statusCode is set to "Terminated", the ClientSpace Employment Status field is
updated to "Terminated" and the ClientSpace Termination Date is set to the PrismHR statusDate

ClientSpace Setup & Administration © 2025 PrismHR 790

Chapter 20 APIs

../../../../../Content/HOME/Attachments.htm
../../../../../Content/HOME/Attachments.htm


value. If PrismHR statusCode is NOT set to "Terminated", the ClientSpace Employment Status
field is updated to the value in the PrismHR employeeStatus field.

Benefit data
l If the Employment record is not found, the Import Queue record is set to Completed, with a note

indicating the Employment record was not found.

Location records
l For Location records, when a DELETE queue record is created, ClientSpace inactivates the

associated Location record.
l Location events with locationCode values containing # or & are processed.

The process

l Based on the PrismHR configuration data provided, the process logs into the PrismHR server.
Failure to log in terminates the process (a log entry is generated).

l A list of PrismHR Subscriptions is retrieved from PrismHR.
o Typically, there are two Subscriptions: Company Information and Employee Information.
o The Subscriptions establish the type of information that must be monitored for change

(Events).
l The API parameter value for HRPRunImport is retrieved, and if set to 1, a list of Import Map

Configurations is retrieved from ClientSpace in this order:
o HRPAPI_company_ongoing
o HRPAPI_clientteam_ongoing
o HRPAPI_location
o HRPAPI_employee
o HRPAPI_employment
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For each Subscription
l The last ReplayID is retrieved from ClientSpace. This indicates the last event that was retrieved by

the process. All events from that point to the current point in time are evaluated.
l If the last ReplayID is equal to the current value associated with the Subscription (meaning no

events have occurred since the last process run time), no new events are retrieved from PrismHR.
l If the Replay IDs are different, a list of events is retrieved from PrismHR, from the last ReplayID to

the current point in time. These events are associated with this instance of the Subscription ID.
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For each Import Map configuration
l A list of Import Map Fields and Paths is retrieved.
l For each new event, if the event action is Delete, no action is taken on this event.
l For each Modified Attribute in the event, the Modified Attribute (the actual field in PrismHR that

has changed) is compared to the list of Import Map Paths.
o If the Modified Attribute is not found in the Import Map Path list, this event is ignored.

Because it is a change, ClientSpace does not need to process. The associated Subscription
dataform is updated with this Attribute as an Exclude value.

o If the Modified Attribute is found in the Import Map Path list, the Company or Employee
for which thiseEvent is associated is saved for Import.

l After all Events are evaluated, the result is a list of distinct Companies and Employees that will be
queued. For example:

o EventID 1: Company 123 Address changed
o EventID 2: Company 123 Phone changed
o EventID 3: Company 456 Fax changed

l These three Events produce the following list of Companies to be queued:
o Company 123 and Company 456.
o Company 123 is only in the list once even though it had multiple changes. The process only

operates on the unique set of Company or Employee changes.

For each Company or Employee in the list
l An entry is created in tblImportQueue with the following data:

o The current Import Map Header ID
o A formatted Identifier (EventObjectID!.!EventClientID!.!EventSchema)
o Status of Pending

After all Import Map Configurations are processed
l The ClientSpace Subscription dataform associated with this Subscription is updated with the

latest ReplayID from the Event list.
l Regardless of whether new events were available, queued events are then processed, for each

Import Map Configuration, a list of Import Map Fields and Paths is retrieved
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o A call to tblImportQueue is made to retrieve event details for and queued record whose
status = Pending or Failed

o A call is made to PrismHR to retrieve specific Company/Employee/Location data for each
queue record.

o Based on Import Map Fields and Paths and the Company or Employee data retrieved from
PrismHR, an Import file row is constructed for the particular Import Map being processed.

o The Import file row is presented to any Custom Import Business Class for further
manipulation (if configured).

After all Companies or Employees are processed
l The Import File is generated and uploaded to ClientSpace, status = Ready for Import.
l If the configuration value HRP Run Import is set to True, the file is immediately imported using

the ClientSpace Import process.
l The next Import Map configuration is processed.

The next Subscription is processed
l After all Subscriptions are processed, the process logs out of the PrismHR server.

Excludes Import Map Detail

Review the PrismHR Security subscription record to ensure that Users=activeUser is NOT part of the
Excludes Import Map Detail for the HRPAPI_users import. The import must contain a valid record for the
Active flag.

User status in PrismHR and ClientSpace

The ClientSpace user Active value is automatically set to the PrismHR value so that when a user is
inactivated in PrismHR, the same status is reflected in ClientSpace.

PrismHR API user-related processes for initial and ongoing imports

PrismHR Import Users (initial imports), and PrismHR Import Ongoing (includes ongoing user imports)
handle Active / Inactive user records in PrismHR and ClientSpace in the following manner.
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Initial Imports: Insert

PrismHR User Status ClientSpace User Status After Import ClientSpace User

Active N/A Inactive

Inactive N/A Inactive

Excluded N/A Not Imported

Initial Imports: Update

PrismHR User Status ClientSpace User Status After Import ClientSpace User

Active Active Active

Active Inactive Inactive

Inactive Active Inactive

Inactive Inactive Inactive

Excluded Not Imported Not Imported

Ongoing Imports: Insert

PrismHR User Status ClientSpace User Status After Import ClientSpace User

Active N/A Inactive

Inactive N/A Inactive

Excluded N/A Not Imported

Ongoing Imports: Update

PrismHR User Status ClientSpace User Status After Import ClientSpace User

Active Active Active

Active Inactive Inactive

Inactive Active Inactive
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PrismHR User Status ClientSpace User Status After Import ClientSpace User

Inactive Inactive Inactive

Excluded Not Imported Not Imported

When retrieving User Details for a User from an Import Queue record, if PrismHR returns an error "User
xxxx does not exist," the existing ClientSpace User record is set to Inactive (if it exists). The queue record
is set to Completed with the message “User 'userId' cannot be found in Prism, inactivated in
ClientSpace (if exists), queue record automatically Completed."

PrismHR Event Monitoring

ClientSpace watches for data changes in PrismHR and imports a selected set of data related to those
changes. ClientSpace does this by monitoring the event queue, noting events that show changed data
that is also mapped in an Import Map Header record. Changed data that is mapped then triggers
system logic.

Import Map Header Detail

The Import Map Header Detail form defines the import event.
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Field Description

Source File HRPAPI_event*.csv

Dataform PrismHR Event

Execution Order 100

Execution Pipeline Default

Import Type API

Special Import True (selected)

Import Map Field Search

From the Import Map Header Detail form, click Fields to display a list of the HRPAPI_event*.csv fields.

The following graphic illustrates the HRPAPI_event*.csv fields.
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Import Map Detail

From the Import Map Search, click the click (Jump button for a field to display the Import Map
Detail.

The Import Map Detail form manages the settings for the imported fields.
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Field Description

File Column This name has no spaces.

Data Type Text (always)

API Path Schema/Class/field

API Configuration

• Same as a typical PrismHR API Configuration (can use existing)
• Users only the KeepLeadingZeros=0/1 parameter for Client Numbers

PrismHR Subscription forms

• New Type field, Standard, or Event
• Existing Subscriptions must be set to Standard (run attached Script to update)
• This process uses Type Event

Process overview

• Retrieve the Event type Subscription
• Retrieve all Import Map Details with header source file = 'HRPAPI_event*.csv'
• Retrieve all Events from PrismHR for the Subscription
• Resolve each Event into a list of

• Schema (the type of change, such as Employee)
• Class (the category of change, such as Person or Direct Deposit
• Client Number
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• Object ID (typically the Employee ID)
• Modified Attributes (which fields changed for this Event)
• If an Event contains a Modified Attribute that is not in the Import Map it will be added to the

Excludes list on the Subscription
• For each resolved Event

• Populate a new PrismHR Event dataform with the resolved Event data
• Locate the workspace for the Client Number (from CM.ClientNumber)
• if found, save the PrismHR Event dataform in that workspace
• if not found, save the PrismHR Event dataform in the Admin workspace
• Save using the PrismHREvent Pipeline - Any business rules triggered by this will also need to be

set to execute on the PrismHREvent Pipeline.

ClientSpace Data Mapping for the PrismHR API

The PrismHR API enables ClientSpace to connect to the PrismHR system remotely and exchange data.
The attached spreadsheet (see at the end of this topic) provides some insight into the field mappings
and how they are used in ClientSpace.

Through the import process used by the API, the ClientSpace forms and fields are populated. Where
you see PrismHR fields without a ClientSpace corollary, these are PrismHR API fields that are available,
but not currently mapped in ClientSpace. We recommend reviewing the field mappings with
Professional Services as the APIs continuously evolve. For assistance, please log an Extranet case.

Note: When some fields in ClientSpace are changed, the change can trigger business logic that can
affect pricing in the system as well as other workflows. If you are not sure of the effect of adding a
field to an import, before making any changes, please log an Extranet case.

Open the ClientSpace Data Mapping Spreadsheet.

Implementing SSO from PrismHR to ClientSpace

The ClientSpace TSSO link in PrismHR enables you to seamlessly move from the Payroll application into
ClientSpace without the need to log in. Making this magic happen, however, requires some advanced
configuration. This topic describes the configuration and what to do if you encounter errors along the
way. 

• The process utilizes the PrismHR User's PeoID to inform ClientSpace which PrismHR Server to use to
validate the connection. 

• Because you can configure ClientSpace with multiple PrismHR servers, the API Configuration form
for the appropriate PeoID is used for API service endpoints.

• Allows a logged-in PrismHR user to access ClientSpace without the need to log in to ClientSpace. 
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Note: PrismHR settings may require system administration rights. Additionally, this topic only
describes the configuration portion of PrismHR related to ClientSpace. For help with this, refer to your
PrismHR Administration documentation.

ClientSpace Configuration: API Form and User Record Configuration

The PrismHR API configuration form must have a Secondary ID (the PeoID) that matches the PrismHR
User's PeoID. Locate the API configuration record by matching the PrismHR User's PeoID to the API
Configuration Secondary ID.

• The Third Party LoginID must match the User ID of the PrismHR user.
• The Third Party LoginID must be mapped to a valid ClientSpace User through a third party

application (TPA) record. This is the User that will be logged into ClientSpace
• Each PrismHR user that logs into ClientSpace using SSO will need one of these TPA user records.

The user record should also be assigned an Authentication Type of SSO. This activates the following
behavior:

• The Password Never Expires checkbox located in the Administrator Settings section of the
user record is checked and becomes Read Only.

• If an SSO user attempts to login via the ClientSpace login page, the following message displays:

"This user is not configured for login here, please contact your ClientSpace Administrator."

To configure the Third Party Application (TPA):
1. Go to System Admin > Advanced > Third Party Applications.

The Third Party Application Configuration dashboard opens.
2. Click Add.

The New Third Party Application form opens.

3. Complete the form:
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Name Type PrismHRTSSO+PeoID, where the italics indicate the PeoID. There are
NO spaces in this name.

Example: PrismHRTSSO1*DEMO where 1*DEMO is the PeoID.

This allows multiple PrismHR Servers and Users to access ClientSpace.

API Configuration You must select the appropriate PrismHR API configuration.

4. Save the record. 
This action generates the Application Key.

After the new Third Party Application entry has been saved, you need to add Third Party users. The
users act as translation records, essentially mapping a PrismHR account to a matching ClientSpace
account.

To add users to the Application:
1. Open the TPA record.
2. In the Action Center, select Users.

The Third Party Application Users dashboard opens.
3. Locate a user and click (Jump).

The Edit Third Party User form opens.
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4. Click Ok.
The user is added to the application.

To specify the SSO Authentication Type on the ClientSpace User Record:
1. Go to System Admin > Users.

The Users dashboard opens.
2. Scroll through the list of users or use Search to locate the user.
3. When you locate the user, double-click the row or click (Open)next to the user name.

The User Details form opens.
4. In the Administrator Settings fieldset, select an Authentication Type of SSO.

5. Click Save.
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PrismHR Configuration

To specify the ClientSpace TSSO Url:
1. In PrismHR, select Back Office System > Change, System Parameters.

2. Select Tool Menu > SSO Services.

3. Select Service Url: https://extranet.clientspace.net/Next/Netwise/PrismHR/SSO
4. Additional PrismHR configuration is necessary. Consult with PrismHR for details (beyond the scope

of this doc).

Operation overview

1. PrismHR User clicks the ClientSpace link (configured in PrismHR).
2. PrismHR sends the PrismHR User's PeoID and a secret token to the SSO Services Service Url that has

been configured on the PrismHR server.
3. ClientSpace locates an API Configuration record matching that PeoID.
l If not found, display message "Unable to validate User in ClientSpace for PeoID
'x'.  Please contact your ClientSpace Administrator."
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4. ClientSpace attempts to connect to the API using the credentials on the API Configuration record. 
l If unable to connect, display message "Unable to connect to PrismHR for
validation.  Please contact your ClientSpace Administrator."

l If able to connect but no session returned from PrismHR, display message "Unable to
obtain a valid Session from PrismHR. Please contact your ClientSpace
Administrator."

5. ClientSpace sends the secret token back to PrismHR for validation.
l If a validation response if not returned, display message "Unable to validate this
User's Authentication Key, no response from PrismHR. Please contact
the System Administrator of the system from which you are trying to
log in."

l If validation is refused, display message "Unable to validate User in PrismHR,
Error = 'error info'. Please contact your ClientSpace Administrator
and report this error."

6. If PrismHR validates the secret key, it returns the PrismHR User information to ClientSpace.
7. ClientSpace attempts to locate the Third Party Application by name PrismHRTSSO + PeoId and the

PrismHR User ID. 
l If unable to locate a TPA record for that user, display the message "This User or your
Server is not configured for Single Sign On in ClientSpace. Please
contact your ClientSpace Administrator."

l f the TPA User is located, the ClientSpace User associated with that PrismHR UserID is logged
into ClientSpace. 

l If login is unsuccessful, display message "Unable to log in to
ClientSpace. Please contact your ClientSpace Administrator."

8. When logged in, the ClientSpace User is redirected to the ClientSpace home page (honors the
Default to Next User setting).

ClientSpace to PrismHR

You can configure SSO connectivity to PrismHR using a custom link.

To configure a custom link:
1. Go to System Admin > Advanced > Custom Links.

The Configure Links dashboard opens.
2. Locate and open Workspace Landing for PrismHR. Or click Add to add the configuration.

The Configuration Links Detail form opens.
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3. Complete the form fields.
This is available on PEO Landing Pages (Workspace Landing) and Client Service Case Forms.

Location Select Workspace Landing or Client Service Case.

Group Select Link 1 or Link 2.

Display Value Type Connect To PrismHR.

Display Action Select Custom Function.

Custom Function Type one of the following:
• peoLanding.connectToPrismHR (Client Master)
• clientServiceCase.connectToPrismHR (Client Service Case)

Display Conditions • Source: Header Proc 1
• Trigger Field: ShowPrismHR
• Trigger Value: True

4. Click Save.
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PrismHR to ClientSpace Client sync

The PrismHR API import functionality enables initial and ongoing data imports from PrismHR to
ClientSpace. The import process uses the following:

l Scheduled process HRPImportInitialSync.
l On the Client Master, the field Sync with PrismHR (Import). You must enable the option

(select) to import the data.
l API Configuration > Additional Parameters: ExcludeCompanyFromSync=0: The Company Initial

import map IS included in the Sync if the map is active.
l company_initial import map

For questions about this import configuration, log an Extranet case.

When the scheduled process runs, it:

l Locates any Client with Sync with PrismHR selected (and a Client Number is present on the
Client Master).

l Scheduled process HRPImportInitialSync creates a Pending import queue record for each
INITIAL Employee, Employment and I9 import map for every employee associated with a Client.
This ensures that when the PrismHR INITIAL Import runs, the Pending import queue records are
processed first and in this order: Employee, Employer, and I9.

Note: ONGOING imports resume after the INITIAL import queue records have completed.
l For each Client, executes the INITIAL imports for all active INITIAL import maps.
l When completed, the system clears the Sync with PrismHR option and saves the Client Master

using biz logic (HRP pipeline), Biz Logic only.
Why use?
The Sync with PrismHR (Import) option is great for cleaning up any one-off clients that failed to
import due to errors during the initial import.

Scheduling an Initial Import

The Initial Import form is accessed in the Admin Workspace and works in both multi-tenant and
single-tenant environments. It allows you to run specific types of Initial Imports for PrismHR or
HCM. For instance, you can run an initial import for a single API configuration, several
API configurations, or all API configurations.

Note: The form is secured to the Developer role. If you need help configuring imports, please contact
your ClientSpace Professional Services representative.
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Once you create an Initial Import form in the Admin workspace, you click the Queue Me link to queue
the record for the PrismHR Scheduled Initial scheduled process. When the scheduled process runs, it
references only the API configurations, Import mappings, and client Import IDs referenced on queued,
Active Initial Import forms.

Note: You can queue the same form more than once. For example, if the process failed the first time
due to an incorrect entry on the form, you can correct it and run it again. Each time an Initial Import
form is processed, the Queued date and time stamped status change is tracked in the Log Data field at
the bottom of the form so that you can see if the form was queued more than once.

Before You Begin: Configuration Notes

Before initial use of this feature, Global administrators should review the configuration and consult a
ClientSpace Professional Services team member, if necessary to ensure that ClientSpace is configured
properly.

The Initial Import process can be used for single tenant and multi-tenant sites, but not both. The system
evaluates the Use Multitenancy field value on the PEO Configuration record (System Admin
> Administrative Data > PEO Configuration) to determine this.

In single tenant environments:

l The MultiTenant API Configuration parameter must be set to 0.
l The Use Multitenancy field in PEO Configuration must be set to No.
l Client Master dataforms cannot have a PEOID set and the Import ID must be set as the Client

Number only.
l Initial Import maps, other than HRPAPI_initial_company, must have the Workspace Source

column set to the Client Number (ClientNumber).
In multi-tenant environments:

l The MultiTenant API Configuration parameter must be set to 1.
l The Use Multitenancy field in PEO Configuration must be set to Yes.
l Client Master dataforms must have a PEOID set and the Import ID must be set as PEOID:: Client

Number.
l Initial Import maps, other than HRPAPI_initial_company, must have the Workspace Source

column set to the Import ID (ClientNumberImportID).

Accessing the Admin Workspace

There is more than one way to access the Admin Workspace:

1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.
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2. Type %Admin in the search box to filter the list of workspaces and locate Admin Workspace.

OR

1. On the modules bar, on the right side, click <username> > Modules.
The Modules Search dashboard opens. The Admin Workspace is listed at the top of the
dashboard.

Then, double-click the workspace row in the grid or click (Open) next to the workspace name.

Completing the Initial Import Form

To complete the Initial Import form:

1. Once in the Admin Workspace, type "Initial" in the dataform search box to display the Initial
Import tile.

2. Click the Initial Import tile to open the Initial Import dashboard.
This is where previously entered Initial Import records are listed and managed. The Status column
shows which records are New (i.e., not queued), Queued, or Completed. Inactive records display
in bold, italicized text.

3. Click Add.
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The Initial Import: Add window displays.

4. Complete the form.

API Type Defaults to PrismHR API. Click the down arrow to select HCM if you are
configuring the Initial Import form for a PrismHCM API import.

Note: The API Config field is filtered to display only PrismHR or
PrismHCM API configuration records based on your selection.

API Configs To Include Defaults to One or More. Valid selections are One or More and All. If
you select One or More, you can select the APIs you want to run from the
API Config field. If you select All, the API Config field is inaccessible as
all APIs associated with the API Type will run.

API Config If you selected One or More in API Configs to Include, click in the field
to select one or more API configurations from a filtered list of API
configurations associated with the API Type.

Mappings to Include Defaults to One or More. Valid selections are One or More and All. If
you select One or More, you can select the API mappings you want to
run from the Mappings to Update field. If you select All, the Mappings
to Update field is inaccessible as all Import Mappings associated with
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the API Type and API Configs to Include will run.

Mappings to Update If you selected One or More in Mappings to Include, click in the field to
select one or more Import Mappings from a filtered list of mappings
associated with the selected API Type and API Configs to Include.

Should Only Specific
Clients Be Updated?

Defaults to No. Valid selections are Yes and No. Leave the field set to No
if you want the specified initial imports to run for all clients (i.e., all
Import IDs). Select Yes if you want the specified initial imports to run for
selected clients. If you select Yes, the Client Import IDs field displays:

Client ImportIDs If Should Only Specific Clients Be Updated? is set to Yes, add one or
more Client Import IDs where you want the specified initial imports to
run. Separate multiple Client Import IDs with a comma.

Reason Enter a note detailing the reason for the initial import.

Status Displays the current status of the initial import form. This is a system-
generated value that cannot be manually edited.

Time Queue Displays a date and time stamp of when initial import form was last
queued. This is a system-generated value that cannot be manually
edited.

Log Data Tracks Initial Import form statuses (New, InProgress, Queued, Completed,
etc.) This is a system-generated value that cannot be manually edited.

5. What do you want to do?
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l Queue the initial import: Click Queue Record in the Action Center.

The Initial Import record is simultaneously saved and queued.
Click Cancel to close the Initial Import record and return to the Initial Import dashboard where
the Initial Import record is shown in Queued status.

l Save the Initial Import record without queuing it: Click Save.
The Initial Import record closes and you are returned to the Initial Import dashboard where the
Initial Import record is shown in New status.
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Queue the record when you are ready by returning to the Initial Import dashboard, clicking
(Open) next to the record to open the Initial Import form and then clicking Queue Record in the
Action Center of the form.

Related Topics:

l Preventing a Queued Initial Import from Running
l Scheduled Processes

Preventing a Queued Initial Import from Running

If you have already queued an Initial Import form but later decided that you do not want the scheduled
process to run it, you can inactivate the form. Inactive forms are not picked up by the scheduled
process. You can always return to an inactivated, queued form and activate it again when you are ready
for it to be picked up by the scheduled process the next time it runs.

Accessing the Admin Workspace

There is more than one way to access the Admin Workspace:

1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

2. Type %Admin in the search box to filter the list of workspaces and locate Admin Workspace.

OR
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1. On the modules bar, on the right side, click <username> > Modules.
The Modules Search dashboard opens. The Admin Workspace is listed at the top of the
dashboard.

Then, double-click the workspace row in the grid or click (Open) next to the workspace name.

Inactivating a Queued Initial Import Form

To inactivate a queued Initial Import form:

1. Once in the Admin Workspace, type "Initial" in the dataform search box to display the Initial
Import tile.

2. Click the Initial Import tile to open the Initial Import dashboard.
This is where previously entered Initial Import records are listed and managed. The Status column
shows which records are New (i.e., not queued), Queued, or Completed.

3. Click (Open) next to the queued record to open the Initial Import form
4. At the bottom of the form, uncheck the Active checkbox and click Save.
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You are returned to the Initial Import Dashboard where the record is shown in bold, italic text
indicating that it is inactive.
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Related Topics:

l Scheduling an Initial Import
l Scheduled Processes

Scheduled Initial Imports

You can schedule initial imports using the Initial Import form. The Initial Import form is accessed in the
Admin Workspace and works in both multi-tenant and single-tenant environments. It allows you to
run specific types of Initial Imports for PrismHR . 

Scheduling an Initial Import

The Initial Import form is accessed in the Admin Workspace and works in both multi-tenant and
single-tenant environments. It allows you to run specific types of Initial Imports for PrismHR or
HCM. For instance, you can run an initial import for a single API configuration, several
API configurations, or all API configurations.

Note: The form is secured to the Developer role. If you need help configuring imports, please contact
your ClientSpace Professional Services representative.
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Once you create an Initial Import form in the Admin workspace, you click the Queue Me link to queue
the record for the PrismHR Scheduled Initial scheduled process. When the scheduled process runs, it
references only the API configurations, Import mappings, and client Import IDs referenced on queued,
Active Initial Import forms.

Note: You can queue the same form more than once. For example, if the process failed the first time
due to an incorrect entry on the form, you can correct it and run it again. Each time an Initial Import
form is processed, the Queued date and time stamped status change is tracked in the Log Data field at
the bottom of the form so that you can see if the form was queued more than once.

Before You Begin: Configuration Notes

Before initial use of this feature, Global administrators should review the configuration and consult a
ClientSpace Professional Services team member, if necessary to ensure that ClientSpace is configured
properly.

The Initial Import process can be used for single tenant and multi-tenant sites, but not both. The system
evaluates the Use Multitenancy field value on the PEO Configuration record (System Admin
> Administrative Data > PEO Configuration) to determine this.

In single tenant environments:

l The MultiTenant API Configuration parameter must be set to 0.
l The Use Multitenancy field in PEO Configuration must be set to No.
l Client Master dataforms cannot have a PEOID set and the Import ID must be set as the Client

Number only.
l Initial Import maps, other than HRPAPI_initial_company, must have the Workspace Source

column set to the Client Number (ClientNumber).
In multi-tenant environments:

l The MultiTenant API Configuration parameter must be set to 1.
l The Use Multitenancy field in PEO Configuration must be set to Yes.
l Client Master dataforms must have a PEOID set and the Import ID must be set as PEOID:: Client

Number.
l Initial Import maps, other than HRPAPI_initial_company, must have the Workspace Source

column set to the Import ID (ClientNumberImportID).

Accessing the Admin Workspace

There is more than one way to access the Admin Workspace:
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1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

2. Type %Admin in the search box to filter the list of workspaces and locate Admin Workspace.

OR

1. On the modules bar, on the right side, click <username> > Modules.
The Modules Search dashboard opens. The Admin Workspace is listed at the top of the
dashboard.

Then, double-click the workspace row in the grid or click (Open) next to the workspace name.

Completing the Initial Import Form

To complete the Initial Import form:

1. Once in the Admin Workspace, type "Initial" in the dataform search box to display the Initial
Import tile.

2. Click the Initial Import tile to open the Initial Import dashboard.
This is where previously entered Initial Import records are listed and managed. The Status column
shows which records are New (i.e., not queued), Queued, or Completed. Inactive records display
in bold, italicized text.

3. Click Add.
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The Initial Import: Add window displays.

4. Complete the form.

API Type Defaults to PrismHR API. Click the down arrow to select HCM if you are
configuring the Initial Import form for a PrismHCM API import.

Note: The API Config field is filtered to display only PrismHR or
PrismHCM API configuration records based on your selection.

API Configs To Include Defaults to One or More. Valid selections are One or More and All. If
you select One or More, you can select the APIs you want to run from the
API Config field. If you select All, the API Config field is inaccessible as
all APIs associated with the API Type will run.

API Config If you selected One or More in API Configs to Include, click in the field
to select one or more API configurations from a filtered list of API
configurations associated with the API Type.

Mappings to Include Defaults to One or More. Valid selections are One or More and All. If
you select One or More, you can select the API mappings you want to
run from the Mappings to Update field. If you select All, the Mappings
to Update field is inaccessible as all Import Mappings associated with
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the API Type and API Configs to Include will run.

Mappings to Update If you selected One or More in Mappings to Include, click in the field to
select one or more Import Mappings from a filtered list of mappings
associated with the selected API Type and API Configs to Include.

Should Only Specific
Clients Be Updated?

Defaults to No. Valid selections are Yes and No. Leave the field set to No
if you want the specified initial imports to run for all clients (i.e., all
Import IDs). Select Yes if you want the specified initial imports to run for
selected clients. If you select Yes, the Client Import IDs field displays:

Client ImportIDs If Should Only Specific Clients Be Updated? is set to Yes, add one or
more Client Import IDs where you want the specified initial imports to
run. Separate multiple Client Import IDs with a comma.

Reason Enter a note detailing the reason for the initial import.

Status Displays the current status of the initial import form. This is a system-
generated value that cannot be manually edited.

Time Queue Displays a date and time stamp of when initial import form was last
queued. This is a system-generated value that cannot be manually
edited.

Log Data Tracks Initial Import form statuses (New, InProgress, Queued, Completed,
etc.) This is a system-generated value that cannot be manually edited.

5. What do you want to do?
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l Queue the initial import: Click Queue Record in the Action Center.

The Initial Import record is simultaneously saved and queued.
Click Cancel to close the Initial Import record and return to the Initial Import dashboard where
the Initial Import record is shown in Queued status.

l Save the Initial Import record without queuing it: Click Save.
The Initial Import record closes and you are returned to the Initial Import dashboard where the
Initial Import record is shown in New status.
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Queue the record when you are ready by returning to the Initial Import dashboard, clicking
(Open) next to the record to open the Initial Import form and then clicking Queue Record in the
Action Center of the form.

Related Topics:

l Preventing a Queued Initial Import from Running
l Scheduled Processes

Preventing a Queued Initial Import from Running

If you have already queued an Initial Import form but later decided that you do not want the scheduled
process to run it, you can inactivate the form. Inactive forms are not picked up by the scheduled
process. You can always return to an inactivated, queued form and activate it again when you are ready
for it to be picked up by the scheduled process the next time it runs.

Accessing the Admin Workspace

There is more than one way to access the Admin Workspace:

1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

2. Type %Admin in the search box to filter the list of workspaces and locate Admin Workspace.

OR
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1. On the modules bar, on the right side, click <username> > Modules.
The Modules Search dashboard opens. The Admin Workspace is listed at the top of the
dashboard.

Then, double-click the workspace row in the grid or click (Open) next to the workspace name.

Inactivating a Queued Initial Import Form

To inactivate a queued Initial Import form:

1. Once in the Admin Workspace, type "Initial" in the dataform search box to display the Initial
Import tile.

2. Click the Initial Import tile to open the Initial Import dashboard.
This is where previously entered Initial Import records are listed and managed. The Status column
shows which records are New (i.e., not queued), Queued, or Completed.

3. Click (Open) next to the queued record to open the Initial Import form
4. At the bottom of the form, uncheck the Active checkbox and click Save.
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You are returned to the Initial Import Dashboard where the record is shown in bold, italic text
indicating that it is inactive.
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Related Topics:

l Scheduling an Initial Import
l Scheduled Processes

Exporting from ClientSpace to PrismHR
The following topics discuss the importing data from PrismHR to ClientSpace.

Exporting to PrismHR

The Export to Prism functionality creates client shells in Prism so that users do not need to enter data
manually. This chapter describes the process of using the Prism API to export ClientSpace information
into Prism. There are several Prism-specific activities outside the scope of this help topic that must take
place to ensure the export process will be successful.

Configuring ClientSpace

Before you can begin the export process, you must configure ClientSpace to include Third Party
Applications, API account information, Prism Subscription dataforms, custom links, business rules,
ImportIDs for Lookups, and the Prism site.
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API Implementation: Exporting data

The Export functionality has an on-demand capability for real-time data management for Clients and
Employees between PrismHR and ClientSpace. Exporting data to PrismHR only functions in the on-
demand mode.

MANDATORY: You must configure ClientSpace before executing ANY of the Export functions.

Exporting data from ClientSpace into Prism consists of:

l Packaging ClientSpace Company and Employee data.
l Issuing that data to Prism to create basic Company and Employee objects in Prism.

Configuring the API account information

The API Configuration contains the information to connect to the specific PrismHR installation for the
client.

To configure the API:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. Click Add.
The New API Configuration form opens.

3. Complete the form.
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API Type Select PrismHR API.

Application Code Select PrismHRAPI as the Primary PrismHR server. There can be multiple
instances of this API configuration type for multiple PrismHR servers. Name
them PrismHRAPIx. The scheduled process will iterate through every API
Configuration where Application Code starts with PrismHRAPI%.

Application Name Type a description. This name is displayed in the ClientSpace lists. Use
PrismHR API.

UserName This is the username registered with PrismHR.

Password Provide the password associated with the account username.

Description Provide a brief description of the API.

Endpoint Type a formatted URL that points to PrismHR, such as
https://api.prismhr.com/api-1.18/services/. Must include the
trailing / character.

Secondary ID An identifier used to enable the monitoring of all Prism Clients at an
installation.

Logging Level Select a logging level:
l Level 0 (None): No log data is produced.
l Level 1 (Errors): Only errors are logged to the Scheduled Process

History Table.
l Level 2 (Verbose): All log data is stored in the Scheduled Process

History Table. This includes entry/status/exit entries for every Prism
API call and ClientSpace action (up to the Import Phase). Errors and
Information entries are created.

Active When this option is selected, the configuration is active (enabled).

Connection Tester Select ClientSpace.Core.DataAccess.RestPostTester and Save or Apply to
display the Test Connection button.

Test Connection When the Connection Tester field is set to
ClientSpace.Core.DataAccess.RestPostTester, clicking Test Connection
connects to the API and either returns a "Connected Successfully" message
or an "Unable to connect" message. The "Unable to connect" message lists
missing parameters contributing to the failure to connect.
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4. Click Save.

Configuring Client Master and Employee custom links

To trigger business rules (to validate and export data to PrismHR):

1. Go to System Admin > Advanced > Custom Links.
The Configure Links dashboard opens.

2. Locate the Client Master records. If none exist, then click Add.
See Configuring Custom Dataform Links for more detail on completing the form.

3. To edit each Client Master record, select and click Edit.
The Configure Links Detail form opens.

4. For the record Export Client to PrismHR (exporting the Client to PrismHR), configure the link as
follows:

Location Select Client Master.

Display Value Type Export Client to PrismHR.

Code Value Type ExportClient.

5. Click Save.
6. For the record Export Employees to PrismHR (exporting all Employees for a Client to PrismHR),

configure the link as follows:

Location Select Client Master.

Display Value Type Export Employees to PrismHR.

Code Value Type ExportEmployees.

7. Click Save.
8. For the record Export Employee to PrismHR (exporting a single Employee to PrismHR),

configure the link as follows:

ClientSpace Setup & Administration © 2025 PrismHR 828

Chapter 20 APIs



Location Select Employee.

Display Value Type Export Employee to PrismHR.

Code Value Type EEExport.

9. Click Save.

Configuring Client Master and Employee business rules

To configure the Client Master and Employee Business Rules:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. For each of the following entries, locate and then select Edit.

3. To Export Clients, activate the following rules:
n Dataform Client Master, Method Name HE_ValidateExportClient
n Dataform Client Master, Method Name ExportClientToHRP

4. To export all Employees, activate the following rules:
n Dataform Client Master, Method Name HE_ValidateExportEmployees
n Dataform Employee, Method Name ExportEmployeesToHRP

5. To export a single Employee, activate the following rules:
n Dataform Employee, Method Name HE_ValidateQueueEmployee

6. Click Save.

Available data

There are several required fields on the Client Master (and related forms) and Employee (and related
forms) dataform. In the following table, fields with an asterisk * indicate that the Export expects to
locate, in particular, Import IDs on several users, and lookups. Other fields are available, but not
required.
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Data Description

Client Export l Org Name (ClientName) *
l ORG.AKA (LegalName)
l Org County *
l Org Address1 *
l Org City *
l Org State (StateCode) *
l Org PostalCode (ZipCode) *
l CM Contract Type ImportID *
l CM Corporation Type ImportID *
l CM Contract Status ImportID *
l CM Contract Status ImportID (must be either A, T, I or P) *
l CM Status Date – translated to cmClientEntry.statusDate *
l CM.ContractEffectiveDate – translated to cmClientEntry.contractDate (only

if populated)
l H (DeliverChecks)
l ORG.Address2
l ORG.crBusinessType (CategoryCode)
l ORG.Phone (Telephone)
l ORG.Fax
l ORG.Email
l ORG.EmployerIDNumber (EIN)
l ALE ImportID (ALE on the CM) *
l Processing Team Payroll Specialist User - ImportID (Payroll REP id in Prism)

*
l Processing Team Sales Rep User - ImportID (SalesRep id in Prism)*
l Processing Team HR Consultant – ImportID (HRRep id in Prism) *
l Org Phone must be (xxx) xxx-xxxx *
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Data Description

Employee Export l EE.FirstName *
l EE.LastName *
l EE.DOB *
l EE.Address1 *
l EE.ZipCode *
l EE.City *
l EE.State (2 character) *
l EE.SSN *
l EEI.crEmploymentStatus.ImportID: *

o Terminated = T
o Otherwise, Active = A

l EEI.crEmploymentType.ImportID:
o Part Time = PT
o Otherwise, Full Time, FT

l CL.LocationCode (Work location code, must match Prism value) *
l EEI.JobCode (must match Prism job code for this client) *
l EEI.OriginalHireDate *
l EEI.HireDate *
l EEI.StartDate *
l EEI.luPayMethod.ImportID: *

o Salary = S
o Hourly = H
o Driver = D
o Commission = C

l EEI.HourlyRate (min 1)
l EEI.StandardHoursPerPeriod *
l EE.crMaritalStatus.ImportID: *

o Married = M
o Single = S
o Divorced = D
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Data Description

l EEI.HRPPayGroup (must match Prism pay group for this client) *
l EEI.luPayFrequency.ImportID: *

o Weekly = W
o Bi-Weekly 1 = B
o Bi-Weekly 2 = B
o Monthly = M
o Semi-Monthly = S
o Yearly = Y
o Otherwise, Hourly = H

l EE.crGender.ImportID: *
o Male = M
o Female = F

l EE.crEthnicClassification.ImportID: *
o Caucasian = W
o Asian = A
o Native American = N
o Hispanic = H
o Black = B
o Unknown = X

l EE.luWorkStateFilingStatus.ImportID (if required) *
l EE.luHomeStateFIlingStatus.ImportID (if required)
l EE.WorkStateTaxExemptAmt (if required) *
l EE.HomeStateTaxExemptAmt (if required)
l EE.WorkStatePrimaryAllowance (if required)
l EE.HomeStatePrimaryAllowance (if required)
l EE.HomeStateSecondaryAllowance (if required)

ImportIDs

Certain Lookups and other data require translation to Prism values. This is done using ImportIDs on the
following data:
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l CM.Contract Type
l CM.Contract Status
l HR Rep User
l Sales Rep User
l EE.Employment Status
l EE.Employment Type
l EE.Marital Status
l EE.Gender
l EE.Ethnic Classification
l EE.Work State Filing Status
l EE.Home State Filing Status
l EEI.Pay Method
l EEI.Pay Frequency

Prism site parameters

Before using the API, you must configure the Prism site with the following parameters.

Parameter

Valid User account l Username (case sensitive)
l Password (case sensitive)
l PEO ID (case sensitive)
l HRP API URL. The endpoint of the

WSDL on the server to be used

The Account must be Enabled
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Parameter

Prism requires the following for each Client: l Business Entity Type (Example: LLC, S
Corp, etc.) (Client Details)

l Payroll Check Account (Account)
l Garnishments Check Account

(Account)
l Receipts Account (Account)
l Processing Schedule (Control)
l GL Template (Control)
l Bill Format (Billing)
l Billing Template (Billing)
l Delivery Method (Payroll)
l Pay Groups (Payroll)

o Pay Group
o Description
o Pay Schedule
o Pay Date

Job Codes (Positions)

Exporting to PrismHR

Clients and Employees can be exported from ClientSpace to Prism. The export is performed on-demand
using Client Master and Employee header links and business rules. The Client Master must be exported
first to create a container in Prism in which to collect the Employees. This process consists of gathering
Prism required information in ClientSpace and (automatically) creating that Client in Prism. After the
Client passes the required data validation, it is flagged as ready for Export.

A set of ClientMaster Header links facilitate the Export of Client and Employees. When successful, Prism
provides a Client Number that is inserted on the Client Master for that Client. At this point, there may
be additional Prism configuration requirements before the Client is fully configured and ready to accept
employees. After the Prism Client is completely configured in Prism, ClientSpace Employees can then be
exported.

When properly configured, ClientSpace reports any missing data fields, including ImportID information
where required. When creating (exporting) a Client from ClientSpace to PrismHR, all active Contacts
associated with the Org that is related to the Workspace are created in PrismHR. Additionally, the
export process updates the Contact ImportID with ClientNumber-PrismHRContactID.

ClientSpace Setup & Administration © 2025 PrismHR 834

Chapter 20 APIs



Exporting Clients and Employees on-demand from the Client Master

Two links are available for on-demand exporting. The Export Client to PrismHR link creates a Client
entry in Prism. If successful, a subsequent link Export Employees to PrismHR appears. The following
screenshot shows the links in the Action Center.

Exporting Clients

The Export Client to PrismHR process creates a ClientSpace Client entry in Prism. Prism returns a
Client Number, which is then stored on the ClientSpace Client Master for the respective Client.
Although the Export Client to PrismHR process delivers much of the necessary Prism data, it does not
mean that the Client will be fully configured in Prism. You may have to manually configure additional
fields in Prism before this Client is ready to accept Employees.

Two business rules prepare a ClientSpace Client for export: ClientMaster.HE_ValidateExportClient
and ClientMaster.ExportClientToHRP.

Note: ClientSpace supports exporting Clients to PrismHR in multi-tenant environments (whereby an
install has multiple Prism API configurations and where the Client Number may not be unique across
Prism database instances.) See Multi-tenant Environments in ClientSpace.

To export Clients:

1. In the Action Center, click the link Export Client to PrismHR.
This action executes the validation rule HE_ValidateExportClient and the Business Rule
ExportClientToHRP with a Header Action of ExportClient.

2. A check is made for fields that are required by Prism to create a Client entry successfully:
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l Org Name l Org AKA

l ImportID l Org DBA

l Org County l Org Address1

l Org Address2 l Org City

l Org State l Org Postal Code

l CM Contract Type l CM Status

l CM Status Date l Org Business Type

l Org Phone l Org Fax

l Org Email l CM Contract Effective Date

l Org Employer ID Number l Admin

l Legal Entity l Processing Team Payroll Specialist

l User ID l Import ID

3. For missing fields: A Hard Error is thrown indicating the missing fields. The business rule does not
execute. The Export Status is set to Failed Validation.

4. If the Hard Error check passes, this rule sets the Client Master luExportStatus field to Ready and
clears the Export Log field.

5. The Business Rule does the following:
l Packages the Client data.
l Issues the data to Prism to create a Client.
l If the Export fails:

o NO MESSAGES ARE ISSUED! You must review the Export Status and Export Log
fields for results.

o The Export Status field is set to Failed API, and the Export Log field contains the
cause of the failure. Some of the errors may be ClientSpace related, and some may
be Prism related. Saved via Business Logic, HRP pipeline.

o At this point, correct the errors before proceeding.
l If the Export passes, the Export Status field is set to Client Export Complete. The Client

Number is populated with the value provided by Prism. Saved via Business Logic, HRP
pipeline.
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6. Complete the Client in Prism.

To view fields that can exported from ClientSpace to Prism:
Open the ClientSpace-PrismAPI Data Mapping spreadsheet.

Exporting Employees

The Export Employees to PrismHR process creates a ClientSpace Employee entry in Prism. Prism
returns an Employee Identifier that is then stored on the ClientSpace Employee record for the
respective Client/Employee. Prism will NOT allow Employees to be added to Clients that are not
properly configured or have incomplete data. You must verify that the Client is properly configured
AND manually set the Export Status on the Client Master.

The business rule ClientMaster.HE_ValidateExportEmployees prepares ClientSpace Employees for
export on the Client Master. A Client Master link Export Employees to PrismHR is displayed when the
ClientMaster luExportStatus field is empty or set to Client Setup Complete.

The following graphic illustrates the Export Employees to PrismHR action item on a client master.

Exporting Employees with Multiple Clients
Exporting an employee (or employees) from ClientSpace to PrismHR allows an employee social security
number (SSN) to exist in multiple clients in PrismHR. For example, exporting employees supports the
following employee/multi-client scenario:
l Client 123 and Client 456 both exist in ClientSpace and PrismHR
l An employee record exists for employee Bob Roberts with social security number (SSN) 123-45-

6789 in both ClientSpace and PrismHR for Client 123 with an employee ID of A1234
l Bob Roberts starts a part-time job with Client 456
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l An employee record for Bob is created in ClientSpace under Client 456 by using the same
employee data (SSN, date of birth, etc.)

l In ClientSpace, the system admin user uses the Employee Export option to export the employee
record to PrismHR.

l During the export, ClientSpace provides PrismHR with the employee SSN for Bob
l PrismHR allows the new employee to be created in Client 456 and will return an

EmployeeIdentifier.

Exporting all Employees

To export Employees:

1. When the Client Master has a Client Number, the link Export Employees to PrismHR becomes
available.

2. Click the link Export Employees to PrismHR.
This action validates required information for each Employee (HE_ValidateExportEmployees). If
any Employee fails, that Employee record is updated with a list of missing data. All Employees
must pass validation before proceeding. Saved via Business Logic, HRP pipeline.

3. A list of Employees (or an individual employee) ready for export is retrieved. That list includes any
Employees that meet the following criteria:
n CM.luExportStatus field = Client Setup Complete
n CM.ClientNumber field is not empty
n The Employee Identifier field is empty
n The Employee IsActive is True

4. For each Employee in the list:
n The Client Number associated with the Employee is retrieved.
n The following ClientSpace fields are sent. An asterisk * indicates a required field.

EmployeeID

ProjectID

FirstName *

LastName *
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BirthDate BirthDate is validated.

EmployerID

Address1

ZipCode

City

StateCode

SSN *

EmployeeStatusCode *

EmployeeTypeCode

WorkLocationCode *

JobCode *

OrigHireDate *

LastHireDate *

PEOStartDate *

PayMethod

PayRate

StandardHours *

FedFileStatus

PayGroup *

BenefitsGroup

AutoPay

PayPeriod

Gender

EthnicCode

The following fields are sometimes sent depending on the employee's work state:
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WorkStateFilingStatus

HomeStateFilingStatus

WorkStateExemptAmt

HomeStateExemptAmt

WorkStatePrimaryAllowance

HomeStatePrimaryAllowance

HomeStateSecondaryAllowance

5. Continue to build a set of Employees to be imported to Prism.
6. The set of Employees is then staged in Prism (importEmployees()). An HRP object is returned after

this call. That object is evaluated:
n If the HRP object Error is set to ‘pass’ meaning the employees were staged properly, the

HRP object import error node is evaluated. If that node is empty, the Employees staging
was successful and has passed validation. If an error is pending, the Employees that did not
pass validation is not exported (a log entry is generated).

n For the Employees that were properly staged, the set is now committed (commitEmployees
()).

n After committing, the Employees are updated in ClientSpace: Each Employee’s Identifier is
set.

7. If the validation passes, the rule ExportEmployeesToHRP executes.
n This rule packages the Employee and Employment data for each Employee of the current

Client.
n Issues the data, one Employee at a time, to Prism requesting that an Employee be imported

and committed.
8. If the Export fails:

n NO MESSAGES ARE ISSUED TO THE USER! The User must review the Export Status and
Export Log fields for results.

n The Export Status field is set to Failed API, and the Export Log field will contain the cause of
the failure. Some of the errors will be ClientSpace related, and some may be Prism related.

n At this point, correct the errors before proceeding.
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9. After the Export passes:
n The Export Status field is set to Employee Setup Pending. The Employee may have further

configuration requirements in Prism. Saved via Business Logic, Default pipeline.
n The Employee Identifier is populated by the value provided by Prism. Saved via Business

Logic, Default pipeline.

Exporting single Employees
The Action Center link, Export Employee to PrismHR appears only if the EmployeeIdentifier field is
empty and the Client Master Export Status equals Client Export Complete.

1. From the Employee record, in the Action Center, click Export Employee to PrismHR.
2. Review the steps in the previous procedure, exporting all Employees.

HCM Import API
The HCM Import API provides an initial and ongoing import between ClientSpace and HCM to retrieve
Client and Employee data from HCM to ClientSpace. Company, Department, Division, Employee,
Employment, Job, and Location data are imported for both initial and ongoing imports.

Importing from HCM to ClientSpace

Process Overview

l The HCMUser API is used by Azure Web services to login to HCM and retrieve the change events.
This also creates Queue records. The initial and ongoing imports then use these Queue records to
retrieve the HCM data using the HCMAPI config.
Note: Failure to log in terminates the process and a log entry is generated.

l A list of HCM subscriptions is retrieved from HCM. The subscriptions establish the type of
information that must be monitored for change events in the ongoing import. For more details,
also see HCM Import Subscription Processing .

l If running initial imports, the HCM Import Initial Sync scheduled process brings over Company
data and then brings over Department, Division, Employee, Employment, Job, and Location data
to ClientSpace if Active import maps exist for these categories.

l Thereafter, the HCM Import Ongoing scheduled process evaluates HCM events (Company and
Employee changes) that may affect previously imported Client and Employee data. The ongoing
scheduled process also monitors for changes and locates events that trigger the creation of new
Clients and Employees in ClientSpace. Active import maps must also exist for the ongoing import
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maps. All active ongoing import map configurations are processed each time the scheduled
process executes.

o The HCM Import Ongoing scheduled process imports ongoing data for clients only when
a matching Client Number exists in ClientSpace.

o ClientSpace ignores inactive Client Master records.
l Applicable HCM events are converted into Import Queue records.
l HCM data is extracted from the Import Queue records and loaded into ClientSpace through

scheduled processes.

Note: During an Import, if an exception occurs during the dataform save, the system logs an
appropriate exception in both the Import logs and the exception log.

Related Topics:

l Importing to ClientSpace from HCM Using Initial Import Sync
l Importing to ClientSpace from HCM Using Ongoing Import
l HCM Import Subscription Processing

Importing to ClientSpace from HCM Using Initial Import Sync
Scheduled process HCM Import Initial Sync obtains a list of all clients available through the HCMAPI
and creates Import records for each. Scheduled process HCM Import Initial Sync processes the clients
(company) and then imports the remaining Active Import Map data (i.e., department, division,
employee, employment, job and location).

Prerequisites
l The HCM Initial Import map for the client record (HCMAPI_initial_company*.csv) must be Active.

All other initial import records for the data you want to import (HCMAPI_initial_department*.csv,
HCMAPI_initial_division*.csv, HCMAPI_initial_employee*.csv, HCMAPI_initial_employment*.csv,
HCMAPI_initial_job*.csv and HCMAPI_initial_location*.csv) must also be Active to receive a full
compliment of files.

**These import map configurations should have been pushed to your site but may be
inactive. If you find these configurations do not exist on your site, log an Extranet case to
have these configurations added. See ClientSpace Data Mapping for the HCM Initial Import
API for a list of mapped fields.

l There must be a valid HCM user account in ClientSpace that matches an account in HCM. This is
set up on the HCMUser API. The account must have permissions in HCM to create subscriptions.

ClientSpace Setup & Administration © 2025 PrismHR 842

Chapter 20 APIs

Asking_For_Help_Extranet.htm


l The HCM API must be properly configured.

Note: You can enter an optional Additional Parameter in the HCM API Configuration record
named AllowClientStatuses which allows you to enter a comma-separated list of client status
values to allow when importing. In the example HCM API Configuration record below, only Prism
HCM records for clients in Active and Pending status will import into ClientSpace.
Prism HCM records for clients in Terminated status will not import. If you do not add the
AllowClientStatuses parameter, records will import for all client statuses, including Terminated.

If you try to configure this on your own and are not sure of your configuration or next steps,
STOP, and log an Extranet case. When enabled, the API overwrites existing data values,
potentially leading to data loss if not properly configured.

Running the Initial Import

To run the Initial Import:
• Run the HCM Import Initial Sync scheduled process. (System Admin >Advanced> Scheduled

Processes> Select HCM Import Initial Sync > Run Import button.)

ClientSpace Setup & Administration © 2025 PrismHR 843

Chapter 20 APIs

Asking_For_Help_Extranet.htm


• All Companies available on the HCM site are imported. 
• Import Queue records are generated for each Company. A list of all other Active Initial Import Maps

is retrieved. 
• Those Import Queue records are set to Status = InitialPending.
• The HCM Import Initial Sync should only execute once. If for some reason it needs to execute

multiple times, DELETE all of the Import Queue Records before proceeding. 
• A list of Import Queue records is retrieved. The quantity to process at once per import map is

defined in the HCMAPI API Configuration using the value set for the Additional Parameter
InitialImportClients.

• Import files are generated. In the HCMAPI API Configuration, if HRPRunImport=1, those Import
Queue records are marked as InitialCompleted. If HRPRunImport=0, those Import Queue records
are left at InitialPending and are retrieved again the next time the process is run.

• Assuming HRPRunImport=1, running the HCM Import Initial Sync again grabs the next set of
Import Queue records (i.e., those marked InitialPending). This continues until all Import Queue
records are processed (i.e., marked InitialCompleted).

Note: During an Import, if an exception occurs during the dataform save, the system logs an
appropriate exception in both the Import logs and the exception log.

Related Topics:

l Importing to ClientSpace from HCM Using Initial Import Sync
l Importing to ClientSpace from HCM Using Ongoing Import
l HCM Import Subscription Processing
l ClientSpace Data Mapping for the HCM Initial Import API

Importing to ClientSpace from HCM Using Ongoing Import
The HCM Import Ongoing process evaluates HCM events (Company and Employee changes) that may
affect existing ClientSpace Client and Employee data, as well as those events that create new Clients
and Employees. All active ongoing import map configurations are processed each time the scheduled
process executes on the same set of HCM Events. This minimizes the amount of data retrieved from
HCM. Data from HCM is extracted and loaded into ClientSpace through a scheduled process.

Note: During an Import, if an exception occurs during the dataform save, the system logs an
appropriate error the import log. The system only logs the error in the exception login if a
catastrophic error occurs.
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Prerequisites
l The HCM Ongoing Import map for the client record (HCMAPI_ongoing_company*.csv) must be

Active. All other ongoing import records for the data you want to import (HCMAPI_ongoing _
department*.csv, HCMAPI_ongoing _division*.csv, HCMAPI_ongoing _employee*.csv, HCMAPI_
ongoing _employment*.csv, HCMAPI_ongoing _job*.csv and HCMAPI_ongoing _location*.csv)
must also be Active.

**These import map configurations should have been pushed to your site but may be
inactive. If you find these configurations do not exist on your site, log an Extranet case to
have these configurations added. See ClientSpace Data Mapping for the HCM Ongoing
Import API for a list of mapped fields.

l There must be a valid HCM user account in ClientSpace that matches an account in HCM. This is
set up on the HCMUser API. The account must have permissions in HCM to create subscriptions.

l The HCM API must be properly configured.

Note: You can enter an optional Additional Parameter in the HCM API Configuration record
named AllowClientStatuses which allows you to enter a comma-separated list of client status
values to allow when importing. In the example HCM API Configuration record below, only Prism
HCM records for clients in Active and Pending status will import into ClientSpace.
Prism HCM records for clients in Terminated status will not import. If you do not add the
AllowClientStatuses parameter, records will import for all client statuses, including Terminated.
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If you try to configure this on your own and are not sure of your configuration or next steps,
STOP, and log an Extranet case. When enabled, the API overwrites existing data values,
potentially leading to data loss if not properly configured.

Running the Initial Import

To run the Initial Import:
• Run the HCM Import Initial scheduled process. (System Admin >Advanced> Scheduled

Processes> Select HCM Import Initial > Run Import button.)

A list of HCM Subscriptions is retrieved from HCM. For more information about subscription
processing, see HCM Import Subscription Processing .

• The HCMAPI parameter value for HRPRunImport is retrieved. If set to 0, it informs the system to
generate the import queue files but not import the files. If set to 1, it informs the system to generate
import queue files and import them.

• Events are evaluated and Import Queue records are generated.
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• Queued events are then processed for each Active Ongoing Import Map Configuration if
HRPRunImport is set to 1.

• After all Subscriptions are processed, the process logs out of the HCM web service.

Related Topics:

l Importing to ClientSpace from HCM Using Ongoing Import
l Importing to ClientSpace from HCM Using Initial Import Sync
l HCM Import Subscription Processing
l ClientSpace Data Mapping for the HCM Ongoing Import API

HCM Import Subscription Processing
When the HCM Import API runs, HCM subscriptions are processed:

l The subscription list in HCM is compared to the active subscription records in ClientSpace
(System Admin >Administrative Data> HCM Subscription).

l In ClientSpace, each active subscription record represents a schema. A schema defines the data
being imported: Client, Employee, Location, Division, Department and Job.
Note: Subscriptions establish the type of information that must be monitored for change events
for the ongoing import.

l For each active ClientSpace HCM subscription record, we look for a match in the
HCM subscription list. To support this comparison, we created an HCM Schema lookup group
and lookup values (System Admin >Lookups) that allows us to match an HCM code to a
Code/Decode value pairing in ClientSpace. The code and decode values in the HCM Schema
lookup group are as follows:

Code Decode

0 Client

1 Employee

4 Location

5 Division

6 Department

7 Job

l Each subscription record in ClientSpace is evaluated as follows:
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o On the ClientSpace HCM Subscription record for a schema, the ClientSpace Subscription
ID is compared to the HCM Subscription list for a match.

o If ClientSpace Subscription ID is empty, we subscribe to HCM for that schema, retrieve a
Subscription ID (GUID) from HCM and update the ClientSpace Subscription record with the
ClientSpace Subscription ID. We also update the Process Date and Process Time fields
with the current date and time.

o If the ClientSpace Subscription ID is NOT empty, and a match is found to HCM subscription
list, no updates are made. This is a good subscription.

o If the ClientSpace Subscription ID is NOT empty, and no match is found to HCM
subscription list, we subscribe to HCM for that schema, retrieve a Subscription ID (GUID)
from HCM and overwrite the bad ClientSpace Subscription ID on the ClientSpace
Subscription record with a good ClientSpace Subscription ID. We also update the Process
Date and Process Time fields with the current date and time.

l We repeat the evaluation step outline above until all ClientSpace subscription records are
processed.

l Finally, when all of the ClientSpace records have been processed, we unsubscribe from the
records in HCM where a match could not be found.

Related Topics:

l HCM Import Subscription Processing
l Importing to ClientSpace from HCM Using Initial Import Sync
l Importing to ClientSpace from HCM Using Ongoing Import
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ClientSpace Data Mapping for the HCM Initial Import API
These are the mapped fields for the HCM Initial Import.

Company

HCMAPI_initial_company*.csv

File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

AccountType Category Import_Organization

AssignedTo Assigned To Import_Organization

BusinessType Business Type Import_Organization

ClientName Name Import_Organization

ClientNumber Client Number Client Master

CorpType Corporation Type Client Master

DateOfFirstPayroll Date of 1st Payroll Client Master

DBA

DescrOfOps Description of Operations Client Master

EffDate Contract Effective Date Client Master

Fax

FEIN EIN Import_Organization

gen_ClientMaster_
Status

Status Client Master

HCMCompanyID HCM Company ID Client Master

NAICS NAICS Code Import_Organization

PEOID PEO ID Client Master

Phone Phone Import_Organization

Start Date Date of Incorporation Client Master
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Department

HCMAPI_initial_department*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

DepartmentCode Department Code Department Code

DepartmentName Department Name Department Code

Division

HCMAPI_initial_division*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

Address1 Address 1 Division Code

Address2 Address 2 Division Code

City City Division Code

DivisionCode Division Code Division Code

Name Division Name Division Code

Phone Phone Division Code

State State Division Code

Zip Zip Division Code

Employee

HCMAPI_initial_employee*.csv

File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

Address1 Address1 Employee

Address2 Address2 Employee

City City Employee
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File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

County County Employee

DOB DOB Employee

Email Work Email Employee

EmerContactFirstName First Name Employee

EmerContactLastName Last Name Employee

EmerContactPhone Home Phone Employee

EmerContactRelationship Relationship Employee

EmployeeIdentifier Employee Identifier Employee

Ethnicity Ethnicity Employee

FirstName First Name Employee

Gender Gender Employee

LastName Last Name Employee

MaritalStatus Marital Status Employee

MiddleName Middle Initial Employee

MobilePhone Mobile Employee

Phone Phone Employee

SSN SSN Employee

State State Employee

Zip Zip Code Employee
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Employment

HCMAPI_initial_employment*.csv

File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

CompensationType Pay Method Employment

EEOClass EEO Classification Employment

Employee Employee Employment

EmploymentStatus Employment Status Employment

EmploymentType Employment Type Employment

HasDeductions Has Garnishments?  Employment

HasDependents Has Dependents? Employment

HireDate Last Hire Date Employment

HomeDept Home Dept. Employment

IsFLSAExempt Is FLSA Exempt? Employment

JobTitle Job Title Employment

Location Location Employment

OriginalHireDate Original Hire Date Employment

PayPeriod Pay Frequency Employment

PayRate Hourly Rate Employment

StandardHours Standard Hours (per period) Employment

TermDate Termination Date Employment

TermReason Reason for Termination Employment

WorkState SUTA State Employment
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Job

HCMAPI_initial_job*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

JobCode Job Code Job Code

JobDescription Job Class Job Code

JobName Job Name Job Code

Location

HCMAPI_initial_location*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

Address1 Addr1 Client Location

Address2 Addr2 Client Location

ArchivedOn

City City Client Location

LocationCode Location Code Client Location

LocationName Location Name Client Location

State State Client Location

Zip Zip Code Client Location

Related Topics:

l ClientSpace Data Mapping for the HCM Initial Import API
l Importing to ClientSpace from HCM Using Initial Import Sync
l Importing to ClientSpace from HCM Using Ongoing Import
l HCM Import Subscription Processing

ClientSpace Data Mapping for the HCMOngoing Import API
These are the mapped fields for the HCM Ongoing Import.
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Company

HCMAPI_ongoing_company*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

AccountType Category Import_Organization

AssignedTo Assigned To Import_Organization

BusinessType Business Type Import_Organization

ClientName Name Import_Organization

ClientNumber Client Number Client Master

CorpType Corporation Type Client Master

DateOfFirstPayroll Date of 1st Payroll Client Master

DBA

DescrOfOps Description of Operations Client Master

EffDate Contract Effective Date Client Master

Fax

FEIN EIN Import_Organization

NAICS NAICS Code Import_Organization

Start Date Date of Incorporation Client Master

Status

Department

HCMAPI_ongoing_department*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

DepartmentCode Department Code Department Code

DepartmentName Department Name Department Code
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Division

HCMAPI_ongoing_division*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

Address1 Address 1 Division Code

Address2 Address 2 Division Code

City City Division Code

DivisionCode Division Code Division Code

Name Division Name Division Code

Phone Phone Division Code

State State Division Code

Zip Zip Division Code

Employee

HCMAPI_ongoing_employee*.csv

File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

Address1 Address1 Employee

Address2 Address2 Employee

City City Employee

County County Employee

DOB DOB Employee

Email Work Email Employee

EmerContactFirstName First Name Employee

EmerContactLastName Last Name Employee

EmerContactPhone Home Phone Employee
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File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

EmerContactRelationship Relationship Employee

EmployeeIdentifier Employee Identifier Employee

Ethnicity Ethnicity Employee

FirstName First Name Employee

Gender Gender Employee

LastName Last Name Employee

MaritalStatus Marital Status Employee

MiddleName Middle Initial Employee

MobilePhone Mobile Employee

Phone Phone Employee

SSN SSN Employee

State State Employee

Zip Zip Code Employee

Employment

HCMAPI_ongoing_employment*.csv

File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

CompensationType Pay Method Employment

EEOClass EEO Classification Employment

Employee Employee Employment

EmploymentStatus Employment Status Employment

EmploymentType Employment Type Employment

HasDeductions Has Garnishments?  Employment
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File Column Name
ClientSpace Dataform Field
Name

ClientSpace Dataform
Source

HasDependents Has Dependents? Employment

HireDate Last Hire Date Employment

HomeDept Home Dept. Employment

IsFLSAExempt Is FLSA Exempt? Employment

JobTitle Job Title Employment

Location Location Employment

OriginalHireDate Original Hire Date Employment

PayPeriod Pay Frequency Employment

PayRate Hourly Rate Employment

StandardHours Standard Hours (per period) Employment

Status

TermDate Termination Date Employment

TermReason Reason for Termination Employment

WorkState SUTA State Employment

Job

HCMAPI_ongoing_job*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

JobCode Job Code Job Code

JobDescription Job Class Job Code

JobName Job Name Job Code
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Location

HCMAPI_ongoing_location*.csv

File Column Name ClientSpace Dataform Field Name ClientSpace Dataform Source

Address1 Addr1 Client Location

Address2 Addr2 Client Location

ArchivedOn

City City Client Location

LocationCode Location Code Client Location

LocationName Location Name Client Location

State State Client Location

Zip Zip Code Client Location

Related Topics:

l ClientSpace Data Mapping for the HCM Ongoing Import API
l Importing to ClientSpace from HCM Using Initial Import Sync
l Importing to ClientSpace from HCM Using Ongoing Import
l HCM Import Subscription Processing

Salesforce API
The Salesforce API provides two-way communication between the Sales processes in ClientSpace and
Salesforce.

Salesforce API: Extended Overview
This topic provides an overview of ClientSpace Salesforce API functionality and answers some
frequently asked questions about the ClientSpace Salesforce API.

If you have specific questions about the ClientSpace Salesforce API or would like to work with us to
create a custom ClientSpace Salesforce integration, log an Extranet case.
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What Does the Salesforce API Do?

The Salesforce API is a two-way communication between the Sales processes in ClientSpace and
Salesforce. It is customized to your business needs by PrismHR. It maintains data synchronization
between a client’s ClientSpace installation and their respective Salesforce system. 

Note: A one-way configuration option is also available where you only export data to Salesforce from
ClientSpace OR import data to ClientSpace from Salesforce.

If you implement the two-way configuration option, Salesforce sends Accounts, Opportunities and
Contacts from Salesforce to ClientSpace at a specified Salesforce Stage.

ClientSpace uses this information to create Organizations, Workspaces and Contacts in ClientSpace.
ClientSpace then sends Organizations, Workspaces and Contacts information back to Salesforce
(primarily to make Salesforce status updates).

For a more detailed overview of the data relationships between Salesforce and ClientSpace, see
Salesforce API Data Relationships Overview.

Throughout the implementation, we reference common Salesforce terms such as Stage, Account,
Opportunity, Object, and Flow. If you are new to Salesforce or just need a refresher, check out
the Salesforce Terms topic. In this topic, we provide definitions of the Salesforce terms and list the
comparable ClientSpace terms.
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Understanding How the Salesforce API Supports the Deal Life Cycle

During the life cycle of a deal, either Salesforce or ClientSpace is responsible for the data. Typically,
Salesforce owns the data in the Lead Discovery Cycle. As changes are made in Salesforce, ClientSpace is
updated with those changes. When the deal has reached a certain level, ClientSpace no longer accepts
changes from Salesforce but keeps Salesforce up-to-date with certain data as changes are made in
ClientSpace. 

When ClientSpace dataforms (gen_) are updated from Salesforce, they are saved using Dataform
Pipeline Logic, which executes business rules and triggers email templates.

What is Required to Implement the Salesforce API?

You initiate the process by creating a case in the Extranet indicating that you are interested in the
Salesforce API. If you decide to proceed, a 16 hour project is created and assigned to a ClientSpace
team member who will assist you with the implementation. This kicks off the implementation period
which is broken into four phases.

Defining the Four Implementation Phases

In Phase 1, we ask you a series of questions to help us customize the implementation for your company.
In Phase 2, we assist you in performing the Salesforce setup steps. In Phase 3, we complete ClientSpace
setup steps. Finally, in Phase 4, we guide you in testing the integration and performing some cleanup
steps after testing is complete.

Review the primary steps of each implementation phase in the image below:
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What Are the Basic Fields that Can Be Mapped from Salesforce to ClientSpace?

The table below lists the basic fields that can be mapped from Salesforce to ClientSpace.

Salesforce ClientSpace

Technical Field Name Salesforce API Path object Field Label Field Name
Organization Dataform

sfAcct.Name Account/ Name Name
sfAcct.Owner Account/ Assigned To flUserIDOwner
sfAcct.Phone Account/ Phone Phone
sfAcct.Fax Account/ Fax Fax
sfAcct.Website Account/ Website Website
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Salesforce ClientSpace

sfOpptyty.LeadSource Opportunities/ Source crSource
sfAcct.Industry Account/ Business Type crBusinessType
sfAcct.BillingStreet Account/ Address1, Address2 Address1
sfAcct.BillingStreet Account/ Address2 Address2
sfAcct.BillingCity Account/ City City
SfAcct.BillingState Account/ State State
sfAcct.BillingPostalCode Account/ Postal Code PostalCode
sfAcct.BillingCountry Account/ Country Country
sfAccountID Account/ ImportID ImportID

Org Other Info Dataform

sfOppty.CloseDate Opportunities/ Expected Close Date ExpectedCloseDate
sfOppty.Type Opportunities/

sfOppty.Lead Source Opportunities/

sfOppty.Probability (%) Opportunities/ Probability of Close ProbabilityofClose
sfOppty.ID Opportunities/

Contact Dataform

sfContact.AccountId Contacts/ Organization fkOrganizationId
sfContact.Owner Contacts/ Assigned To fkAssignedToUserID
sfContact.FirstName Contacts/ First FirstName
sfContact.LastName Contacts/ Last LastName
sfContact.Title Contacts/ Job Title Title
sfContact.Phone + Ext Contacts/ Business Phone BusinessPhone
sfContact.Email Contacts/ Primary Email Email1
sfContact.MobilePhone Contacts/ Mobile CellPhone
sfContact.Fax Contacts/ Fax Fax
sfContact.MailingStreet Contacts/ Address 1 Address1
sfContact.MailingCity Contacts/ City City
sfContact.MailingState Contacts/ State State
sfContact.MailingPostalCode Contacts/ PostalCode PostalCode
sfContact.MailingCountry Contacts/ Country Country
sfContactID Contacts/ Import ID ImportId

Client Master Dataform

SIC Code luAltIndustryCode

Activation Date StartDate

sfAcct.ParentId Account/ Parent Company fkParentCompanyID
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Salesforce ClientSpace

Kill Reason luKillReason

sfOppty.Descriptions Opportunities/ Description of Operations DescriptionofOperations
sfOppty.StageName Opportunities/ Status Status

gen_ClientTeam

sfOppty.Owner Opportunities/  Sales Respresentative fkSalesRepUserID

Can I Map Custom Fields?

The ClientSpace Salesforce API allows you to connect custom Salesforce fields to fields in ClientSpace,
allowing you to implement an API unique to your business. The exchange of data between the systems
is highly configurable. Data elements are mapped at the field level for each system using standard
ClientSpace Import Map Headers and Details. 

We will work with you to make sure that the fields required for your business needs are mapped
appropriately.

Note: In Salesforce, "_c" is added to the end of the Field Name to indicate that it is a custom field:

Which Fields in ClientSpace Can Be Configured to Trigger an Export to Salesforce?

The following table lists the fields that can trigger an export from ClientSpace to Salesforce. These fields
are used to trigger a ClientSpace workflow (i.e., automation) that exports to Salesforce when a value in
the ClientSpace field listed below is changed. For the default PEO procedure (peo_salesforce_s_
available_cs_updates), these fields and the associated system objects are as follows.
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Associated System Objects Fields

Org Trigger l Name
l AKA
l Phone
l Fax
l crStatus
l Address1
l Address2
l City
l State
l PostalCode

l Country
l luCurrentPEO
l crSource
l crBusinessType
l Website
l IndustryCode
l EmployerIDNumber
l crCategory
l DoNotCallp

Org Other Info Trigger l EmployeeCount l Gross Payroll

Contact Trigger l fkOrganization
l fkAssignedToUserID
l FirstName
l LastName
l Title
l Category
l BusinessPhone
l Email1

l CellPhone
l Fax
l Address1
l City
l State
l PostalCode
l Country
l Active

Client Master Trigger l ClientNumber
l Status
l Dateof1stPayroll
l CongractEffectiveDate
l CorportationType

l luAItIndustryCode
l SalesRegion
l fkParentCompanyID
l luKillReason

Incident Trigger Fields (Task)* l Status

ContactManagementNote l Notes

Manual Sync l Sync with Prism HR
option on Client Master

l SFManualSync
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* Tasks in ClientSpace can be created by Salesforce task records from a Salesforce import. (See the
Process Overview diagram for details.) If one of the ClientSpace tasks that was imported from
Salesforce has a status change, it can trigger a Salesforce export.

Other FAQs

Here are some other frequently asked questions that our customers have about the ClientSpace
Salesforce Integration.

What Is a "Salesforce Expert"?

Earlier in this topic when we listed the primary steps in the four implementation phases of the
ClientSpace Salesforce API, we mentioned that in Phase 1 (Initial Prep), we will identify your company's
Salesforce Expert. As it relates to the implementation, a Salesforce Expert is someone at your company
with the expertise, access permissions, and availability to work with us as a resource during the
implementation period (especially during Phase 2 (Salesforce Setup). This can be your Salesforce Admin
or another person with the access permissions and knowledge to assist. The resource must be able to
perform tasks such as adding new fields or accounts as needed and participate in testing the interface.

SeeSalesforce API Implementation in Salesforce (Implementation Phase 2) for details of the specific
steps we ask the Salesforce Expert to perform.

What Format Do We Use to Provide the List of Fields to Map to the ClientSpace Team?

We recommend listing your fields in a new Excel Workbook and adding a tab for each Salesforce Object
that you would like to map to ClientSpace with columns on each tab for Field Name, Code Name, and
Field Type.

See Best Practices and Tips: Creating the Salesforce List of Fields to Map.

Do You Import All Salesforce Contacts into ClientSpace?

Your company decides which contacts are imported into ClientSpace. For instance, we can bring over all
contacts, the primary contact only, or no contacts at all.

Related Topics:

l Salesforce API Data Relationships Overview
l Importing Salesforce Data Overview
l Exporting Salesforce Data Overview
l Salesforce Terms
l Salesforce API Implementation in Salesforce (Implementation Phase 2)
l Salesforce API Implementation in ClientSpace (Implementation Phase 3)
l Salesforce API Testing (Implementation Phase 4)
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Salesforce Terms

This topic defines some common Salesforce terms related to the ClientSpace Salesforce Integration and
the comparable terms in ClientSpace.

l Account - In Salesforce, an Account is an organization, company, or consumer that you want to
track - for example, a customer, partner, or competitor. In ClientSpace, this is similar to a Client,
Organization, or Workspace.

l Opportunity - In Salesforce, an Opportunitytracks your sales and pending deals. In ClientSpace,
this is similar to a Lead or Organization.

l Contacts - In Salesforce, Contacts are the individuals associated with your accounts. Contacts is
a term also used in ClientSpace and it has a similar meaning.

l Stage - In Salesforce, what is referred to as a Stage is the same as a Status in ClientSpace.
Examples include Lead, Client, Terminated, etc.

l Object - In Salesforce, an Object allows you to store information for your Salesforce
organization. This is similar to a Dataform or Table in ClientSpace.

l Flow - In Salesforce, a Flow allows you to build a business automation, such as sending an email,
inserting, updating or deleting data, and much more. The automation is configured to trigger
based on an event. In ClientSpace, we call this a Workflow.

Related Topics:

l Salesforce API: Extended Overview
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Salesforce API Implementation in Salesforce (Implementation Phase
2)
In this topic we cover the details of the major steps required for the Salesforce Setup phase of the
Salesforce API implementation. In this phase, we work closely with your company's designated
Salesforce expert, asking them to perform the steps outlined here and assisting as needed.

Step 1: Request Access to a Sandbox Environment

If you prefer to test the implementation in a sandbox environment instead of in Production, create a
case with SalesForce.com to request access to a sandbox environment. We can use this environment for
testing before we finalize the production environment settings or we can test directly in the production
environment using a test account, opportunity, and contract.

Step 2: Create the Work Queue Object

The Work Queue object is monitored by ClientSpace for new updates. Create a new object named Work
Queue with the following fields.

Note: "_c" at the end of the field name indicates that it is a custom field.

Field Name Notes

Account_ID_c This is the 18 character ID of associated Account. Every Work
Queue record must have an Account.

Object_c This is the name of the Object for the record specified by the
Object Record ID field. Account, Opportunity or Contact.

Object_Record_ID_c This is the 18 character ID of the associated Object.

CS_Error_c Leave empty.

Completed__c Default to False (unchecked) upon record creation. ClientSpace will
handle setting this field once the Work Queue record is processed.

OwnerId The Salesforce Owner Id for this Object. Not used but must be
available. Leave empty.

Name Name of the company (if this is a Lead Object). This is a text field.
Not used but must be available. Leave empty.

Refer to the image below to review an example Work Queue with the fields added.
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Note: Only add the highlighted fields. Do not add any other fields unless instructed to by the
ClientSpace team member assisting you with the implementation.

Step 3: Create the Work Queue Object Flow

Create a flow to generate a Work Queue object when Opportunity , Account, or Contact reaches a
certain stage.

Note: The Salesforce stage that triggers the Flow is determined during the first implementation phase
(Phase 1: Initial Prep). See the Defining the Four Implementation Phases section in the Salesforce
API: Extended Overview for details.

Step 4: Create a Salesforce User

When you set up the Salesforce User:

l Set it up so that the password never expires. If you do not do this, the API user could be locked
out.

l Set the user as a ClientSpace team member at first. Then, after testing is complete, move the user
to a client's member account.

l Verify that the Salesforce User has access to every field being imported into Salesforce.

Step 5: Set Up the ClientSpace Integration Connected App/Obtain the Consumer Key and
Consumer Key Tokens

Add a Connected App named ClientSpace Integration, and complete the following fields:
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Field Name Value

Connected App Name ClientSpace Integration

Contact Email Enter the contact email address provided to you by the ClientSpace
team member assisting you with configuration.

Enable OAuth Settings Checked

Callback URL https://login.salesforce.com/services/

Selected Oauth Scopes Full access (full)

Manage user data via APIs (api)

Require Secret for Web Server
Flow

Checked

Require Secret for Refresh Token
Flow

Checked

A completed ClientSpace Integration Connected App setup appears similar to the following:
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Also remember to obtain the Consumer Key and Consumer Secret tokens for the App from Manage
Connected Apps. Provide this information to the ClientSpace team member who is assisting you with
the implementation. This information is added to the Salesforce API Configuration Parameters in
implementation Phase 3 (ClientSpace Setup). See Additional Salesforce Parameters.

If you need to come back to the Connected App configuration later to obtain the tokens, see Finding
the Consumer Key and Consumer Secret for steps.

Step 6: Verify Email Addresses

Ensure the Salesforce Sales Team members' emails are the same in ClientSpace and Salesforce.

Step 7: Clean Up Work Queue Records

On the Work Queue Objects tab, delete the Work Queue records.

Step 8: Create Test Opportunity and Account

Create a test Opportunity and Account called “zz Prismhr”.

Step 9: Provide the "Fields to Map" List

If you have not done so already, provide the list of fields you want to map from Salesforce to
ClientSpace to the ClientSpace team member assisting you with the implementation. This should
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include any basic fields listed in the Salesforce API: Extended Overview topic as well as any custom
fields you want to include.

We recommend listing your fields in a new Excel Workbook and adding a tab for each Salesforce Object
that you would like to map to ClientSpace with columns on each tab for Field Name, Code Name, and
Field Type.

See Best Practices and Tips: Creating the Salesforce List of Fields to Map.

Step 10: Identify Sales Flows Requiring Adjustment or Removal

A helpful tip for organizing flows is to create a list of flows and append an asterisk (*) after the item
name to indicate a new flow. Similarly append a pound sign (#) after the item name of old flows
requiring removal.

If any flows require the addition of fields, you must create additional objects for them and give the
correct permissions to the ClientSpace User in Salesforce. These new fields must also be provided to the
ClientSpace team member assisting with your implementation for mapping.

ALERT: Use caution when adding new objects for new fields and providing a list of fields to map
as adding an incorrect field to the mapping will stop the Salesforce API from working.

Related Topics:

l Salesforce API: Extended Overview
l Finding the Consumer Key and Consumer Secret

Finding the Consumer Key and Consumer Secret

The Consumer Key and Consumer Secret are Salesforce tokens that must be specified in the Additional
parameters section of the Salesforce API Configuration in ClientSpace. See Additional Salesforce
Parameters.

The client should provide these to the ClientSpace team member assisting with the Salesforce API
configuration. They are located on the Connected App record.

To find the Consumer Key and Consumer Secret in Salesforce:
After the Connected App is configured, obtain the Consumer Key and Consumer Secret tokens for that
App. The following sub-sections explain where to obtain the tokens.
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Using Salesforce Classic Experience:

1. In Setup, click Build > Create > Apps.
2. Click the Connected App Name (NOT Edit. NOT Manage.). You can also click on Edit and then

Save. This takes you to the same place.

Using Salesforce Lightning Experience:

1. In Setup, navigate to Apps > App Manager.
2. Find your Connected App in the list and select View from the associated list (on the far right of

the list view). You can also select Edit and Save.
3. Obtain the Callback URL (endpoint) from the same place.

Related Topics:

l Salesforce API Implementation in Salesforce (Implementation Phase 2)
l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Salesforce API Implementation in ClientSpace (Implementation Phase
3)
In this topic we cover the details of the major steps required for the ClientSpace Setup phase of the
Salesforce API implementation. Many of these steps are performed solely by the ClientSpace team
member assigned to your implementation. The team member may request client collaboration for
some steps.

Step 1: Complete Salesforce API Configuration in ClientSpace

See the following topics:

l Configuring the Salesforce API in ClientSpace
l Configuring Salesforce Enhanced Error Logging with Client Master Duplicate Import Validation

Step 2: Update Import Mappings/Fields

See the following topics:

l Configuring Import/Export Mapping
l Mapping Custom Salesforce Objects

Also see:
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l Importing Salesforce Data Overview
l Exporting Salesforce Data Overview
l Salesforce API Data Relationships Overview
l Finding the API Path in Salesforce

Step 3: Add the Salesforce Pipeline

Add the Salesforce pipeline to any Email Templates, Workflow Channels, and Business Rules as needed.

Step 4: Create a Salesforce User

Add a Salesforce User record.

See Configuring the Salesforce User.

Step 5: Create an SFDC API Log BI Report

See Business Intelligence Report: API log.

Related Topics:

l Salesforce API: Extended Overview

Configuring the Salesforce API in ClientSpace

In this topic we cover the details of the major steps required for the ClientSpace Setup phase of the
Salesforce API implementation. The ClientSpace team member assigned to assist you with the
implementation performs many of these steps but may call on a designated person at your company to
assist if need.

To configure ClientSpace:
1. Go to System Admin > Advanced > API Configuration.

The API Configuration dashboard opens.
2. Click Add.

The New API Configuration form opens.
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3. Complete the following fields:

API Type Select Web Service.

Application Code • SFDCDEV is the sandbox configuration
• SFDCPROD is the Production configuration

Application Name Type Salesforce Integration (user choice)

Username Enter the username of the API account.

Password Enter the password of the API account. The password is comprised of the
password AND the security token.

Description Provide a description (optional).

Endpoint Endpoint must be the base OAUTH server. This matches the
Callback URL setting in Salesforce.

Example: https://login.salesforce.com/services/

Note: You can specify a backup endpoint by configuring the
AlternateEndpoint parameter in the Additional Parameters section of the
API Configuration form.
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Secondary ID Not used. Leave blank.

Logging Level • 0 None
• 1 Only logs that the process ran and the date/time begin and end
• 2 Logs process details and results (for setup and debugging only)

Active Checked by default.

Configuration ID Auto-fills. No data entry required.

Connection Tester Select ClientSpace.Core.DataAccess.SalesforceConnectionTester and
Save or Apply to display the Test Connection button.

Connection Tester Select ClientSpace.Core.DataAccess.SalesforceConnectionTester.

Note: This field works in tandem with the Test Connection button. Once
configuration of the Salesforce API is completed, if the Connection Tester
field is set to ClientSpace.Core.DataAccess.SalesforceConnectionTester,
clicking Test Connection initiates an attempt to connect to the API and
either returns a "Connected Successfully" message or an "Unable to
connect" message. The "Unable to connect" message details list the missing
parameters contributing to the failure to connect.

4. Add Additional Parameters. Click Add Parameter to add a new row to the Additional Parameters
section if the parameter is not already listed.

Note: Additional Parameters are semi-colon delimited name=value pairs, such
as param1=value1;param2=value2. Spaces between parameters are not allowed.

Example: “;<space>param2=” is invalid.

Refer to Additional Salesforce Parameters for the complete list of available parameters.

5. Click Apply Save.

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Additional Salesforce Parameters

In the Add Parameter area of the API Configuration form (see the following image), you can customize
your connection to the data using additional parameters, entered as a set of parameter names and
values. Add these additional parameters by completing the Parameter - Value pairings, as shown.
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The following table provides details for the Parameter - Value pairings.

Parameter Value description

AdditionalInsertExportList Specify which ClientSpace forms are allowed to be inserted into
Salesforce. Add the form names (table names) to the Value field,
separating them by a semicolon if there is more than one.
See Mapping Custom Salesforce Objects for detailed configuration
steps on setting up the ClientSpace to Salesforce export.

AlternateEndpoint Specify an endpoint URL as a backup to the value shown in the
Endpoint field. If the original endpoint is broken and an alternate
endpoint is specified, when you click the View in Salesforce link on
an Organization record, you navigate to the alternate URL instead of
the URL entered in the Endpoint field.

autocreateorg l 1 = Automatically create an Organization record in Salesforce
when a new Organization is added in ClientSpace.

l 0 = Do no automatically create an Organization record in
Salesforce when a new Organization is added in ClientSpace.
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Parameter Value description

consumerkey This is the key (i.e., token) that ClientSpace (the consumer) uses to
identify itself to Salesforce.

Note: This key is provided to the ClientSpace team member
assisting with the Salesforce API implementation by the client's
Salesforce expert who has been designated to assist with the
implementation. The key comes from the ClientSpace Integration
Connected App setup in Salesforce. See Step 5 of Salesforce API
Implementation in Salesforce (Implementation Phase 2) or Finding
the Consumer Key and Consumer Secret for details.

consumersecret This is the key (i.e., token) that ClientSpace (the consumer) uses to
establish ownership of the consumer key.

Note: This key is provided to the ClientSpace team member
assisting with the Salesforce API implementation by the client's
Salesforce expert who has been designated to assist with the
implementation. The key comes from the ClientSpace Integration
Connected App setup in Salesforce. See Step 5 of Salesforce API
Implementation in Salesforce (Implementation Phase 2) or Finding
the Consumer Key and Consumer Secret for details.

csavailableupdates This procedure determines which ClientSpace changes are able to
trigger an export (defaults to peo_salesforce_s_available_cs_
updates). These must have associated Audit configurations in the
Field Change Audit table.
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Parameter Value description

csinstance This parameter supports ClientSpace sites using multiple instances
of ClientSpace with a single Salesforce instance. Add the parameter
to each instance of ClientSpace and enter the name of the instance
in the Value field. EX: CS1 for the first instance, CS2 for a second
instance, and so forth.

Note: You must also configure a new Work Queue field in
Salesforce (setup by Salesforce Administrator) named CS_Instance
to hold the instance value for each instance. Two underscores,
followed by "c" are added by Salesforce once you save the field
name, resulting in a field named CS_Instance__c.

csworkspacedataproc This procedure exports workspace data (defaults to peo_salesforce_
org_s_workspace_by_org).
Contact ClientSpace Professional Services about using this
parameter with a custom stored procedure. With this parameter and
a custom stored procedure, you can define variables to pull data
from fields in multiforms and map that data to fields in Salesforce.
For example, you can edit the import map header for the Salesforce
export and add fields to the import map header detail.

See the Configure the Import Map Detail for Fields from Multiforms
section in Configuring Import/Export Mapping for more
information.

csupdateproc This procedure sets _CSUpdateAllowed (defaults to peo_
salesforce_s_allow_cs_update). This procedure determines when
ClientSpace will begin ignoring Salesforce.

defaultorgowner Specify a LoginID (username) as the owner of organizations that are
imported from Salesforce, where the owner specified in Salesforce
does not have a ClientSpace user account.

ExcludeUserNames Specify a value that acts as a filter. User names that begin with the
filter value, such as abc, are excluded during the user security
import. The queue record is stamped with the message "User
'<userID>' has excluded name, this record will not be processed."
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Parameter Value description

exporttosf • 0 = No Export
(ClientSpace changes are not exported to Salesforce) defaults to
0

• 1 = Export to and Import from Salesforce

IgnoreWorkQueueErrors Allows the admin to ignore work queue failures and mark them as
completed, so they are not reprocessed.
• Value of 0 or 1, defaults to 0.
• Only applies to processing Work Queue records when there is a

failure (could not save a form).
• 0: Work Queue record is NOT marked Completed (this is how it

has worked in the past).
• 1: Work Queue record IS marked Completed and the

WorkQueueErrorFieldName field in Salesforce is updated with
the failure log info.

Note: If the client is using enhanced Salesforce v3 API error logging
to record hard errors in both ClientSpace and the Salesforce Work
Queue, the IgnoreWorkQueueErrors field must be set to 1. This
prevents the API from attempting to re-import a Work Queue item
and create a duplicate in ClientSpace.

This requires configuration in both ClientSpace and Salesforce. See
Configuring Salesforce Enhanced Error Logging with Client Master
Duplicate Import Validation for configuration details.

importfromsf • 0=Import data from Salesforce.
• 1 = Do not export data from Salesforce.
Note: If exporttosf (export to and from Salesforce) is set to 1, this
parameter is not needed. importfromsf is for one-way API
configuration only.

querysize 1000 (must be this value)

querybatchsize -1 (must be this value)

restversion This is the Salesforce REST application version. Must be provided by
the client.

sessionlength 29 (must be this value)
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Parameter Value description

timezoneoffset This parameter is used to adjust for UTC time difference between
the client time zone and Salesforce time, which is GMT time. It
adjusts imported and exported dates and times to match the
Salesforce DateTime and the client timezone DateTime as
appropriate.
l 0: Passes the value as is.
l –n: Subtract hours. For example, to subtract 5 hours, specify –

5.
l n: Add hours. For example, to add 5 hours, specify 5.

To correct the GMT offset added by Salesforce, ensure that the
timezoneoffset parameter is set to match the appropriate time
zone of the ClientSpace installation (Time Zone Name in App
Settings). In the Eastern time zone, this would be a value of -5.

EX 1 - timezoneoffset is a positive number: If timezoneoffset = 5
in ClientSpace, ClientSpace adds 5 hours to the time on import and
subtracts 5 hours from the time on export. In this scenario, if the
SalesForce DateTime is 7/24/2024 at 10:30 pm, once imported into
ClientSpace, the time is recorded as 7/25/2024 at 3:30 am.
Likewise, if the time is 7/24/2024 at 10:30 pm in ClientSpace, once
exported to Salesforce, the time is 7/23/2024 at 3:30 am.

EX 2 - timezoneoffset is a negative number: If timezoneoffset = -
5 in ClientSpace, ClientSpace subtracts 5 hours from the time on
import and adds 5 hours to the time on export. In this scenario, if
the SalesForce DateTime is 7/24/2024 at 10:30 pm, once imported
into ClientSpace, the time is recorded as 7/24/2024 at 5:30 pm.
Likewise, if the time is 7/24/2024 at 10:30 pm in ClientSpace, once
exported to Salesforce, the time is 7/25/2024 at 3:30 am.

Note: You must adjust timezoneoffset parameter to account for
Daylight Savings Time (DST), if DST is applicable in the client time
zone.
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Parameter Value description

updatestage • 0= Opportunity Stage is never updated when exporting.
• 1 = Opportunity Stage is updated when exporting.

(defaults to 1). Note: Export is based on Client Master status and
stage.

When the value = 1, the Opportunity Stage in Salesforce is updated
by the export. The update is based on the following translation of
the ClientSpace Client Master status and stage name. For example,
when updatestage=1 and the Client Master status has moved from
Accepted to Underwriting, then the stage is updated from Pricing to
Proposal.

ClientSpace Client Master status Stage name
Prospect Pricing
Submitted Pricing
Accepted Pricing
Underwriting Proposal
PricingApproved Proposal
Approved Negotiation
ContractPending Negotiation
Negotiation Negotiation
UnderContract (Onboarding) Closed Won
PendingActivation Closed Won
Terminated Closed Won
Dead Closed Lost
Expired Closed Lost

updateworkspacename • 0: Workspace name in ClientSpace is not updated when the
Work Queue record includes a change to the Organization
name. The system only updates the Organization name in
ClientSpace.

• 1: Workspace name and Organization name in ClientSpace are
updated when the Work Queue record includes a change to the
Organization name.
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Parameter Value description

version 3 (must be this value)
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Parameter Value description

WorkQueueErrorFieldName Allows the admin to configure a custom field in Salesforce Work
Queue item to capture API errors.

This error is stored in the designated field until the Salesforce Work
Queue record is successfully reprocessed (as indicated by a check
mark in the Completed checkbox on the Details tab of the Work
Queue record). Then, the error message is cleared.

To implement this parameter, Admin must have the ability to add an
available custom field to the work queue object in Salesforce that is
available for read/write through the API. This field must be a "Text
Rich" field and 100,000 characters in length to preserve log
formatting.
• Value of <FieldName__c> should be the name of the custom

work queue record field name. Defaults to "" (empty).
• If empty and IgnoreWorkQueueErrors = 1, the Work Queue is

completed, and no error message is sent to Salesforce.
• If <FieldName__c> and IgnoreWorkQueueErrors = 0, the

Work Queue is NOT completed and no error messages are sent
to Salesforce.

• If <FieldName__c> and field does not exist in the Work Queue,
based on IgnoreWorkQueueErrors, the Work Queue may be
completed with no error message sent to Salesforce.

• Field must be configured in Salesforce and available.
Note:

l If the client is using enhanced Salesforce v3 API error logging
to record hard errors in both ClientSpace and the Salesforce
Work Queue, set the value of the
WorkQueueErrorFieldName to Completed_Errors_c.

l "_c" is added automatically by the Salesforce system when a
custom field is added. You do not need to add it. Doing so will
result in an incorrectly named field of Completed_Errors_c_c.

This requires configuration in both ClientSpace and Salesforce. See
Configuring Salesforce Enhanced Error Logging with Client Master
Duplicate Import Validation for configuration details.
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Parameter Value description

WorkQueueInstance This parameter enables the system administrator to process certain
Work Queue records in Salesforce so that multiple instances of
ClientSpace can use the Salesforce API for a single instance of
Salesforce. To use this functionality, specify a value to match the
Salesforce Work Queue field.

Salesforce Work Queue field
l If this field is not found on the Work Queue, all Work Queue

records are retrieved, regardless of the API Config parameter
setting.

l If this field is found on the Work Queue, only those Work
Queue records stamped with the value in the API Config
parameter are retrieved.

Your Salesforce administrator must set up the field and apply the
rules necessary to insert the correct value into this field for each
Work Queue record inserted.

ClientSpace Additional Parameters
l When this field is not present, all Work Queue records are

retrieved.
l When this field is present with an empty Value, all Work

Queue records are retrieved.
l When this field is present with a populated Value, only Work

Queue records with the matching WorkQueueInstance value
in the ClientSpace API Config are processed.

WorkQueueRecordsToProcess Defines the max number of records to be processed at one time
(defaults to 2000).
• Can be set between 1 and 2000. Defaults to 2000.
• If 0 or less, it is set to 1.
• If > 2000, it is set to 2000.
• Retrieves the TOP(X) number of records from the work queue

ordered by LastModifiedDate ascending (the earliest records).

workspacetemplateguid Enter the GUID of the template project. When a Workspace is
created in ClientSpace, this Workspace Template will be used.
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Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)
l Salesforce API Testing (Implementation Phase 4)

Configuring Salesforce Enhanced Error Logging with Client Master Duplicate Import
Validation

Optionally, configure Salesforce and ClientSpace to log Client Master import hard errors (i.e., failures)
on the Salesforce API pipeline to both the ClientSpace Scheduled Process History log and the
Salesforce Work Queue. Once this feature is configured, if failures occur, the Work Queue record will be
marked Completed and failures are recorded in the Salesforce field configured in the API record as the
workqueueerrorfieldname parameter. This prevents Client Master records with hard errors from
importing into ClientSpace. Since failed records are marked Completed, Salesforce Work Queue errors
can be reviewed and corrected and manually marked as not completed in the queue. Then, the work
queue records can be processed again with the next scheduled import.

In ClientSpace:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. Select the Salesforce API record and click Edit. (SFDCDEV is the sandbox configuration and
SFDCPROD is the Production configuration.)
The API Configuration form opens.

4. Add or update the two Parameter and Value pairings shown:

5. Click Apply or Save.
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In Salesforce:

1. On the Work Queues tab, navigate to Setup > Edit Object.
2. In the Details panel, select Fields & Relationships.
3. Click New and add a custom field with the Field Label, Field Name, and Data Type pairings

shown to the Custom Field Definition window.

4. To change the Data Type to Rich Text Area, click Change Field Type on the Custom Field
Definition window and select the option. Also be certain to set a minimum field length of 100,000
characters, not to exceed the maximum character allowance of 131,072.

5. Click Save.

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)
l Additional Salesforce Parameters

Configuring Import/Export Mapping

The mapping of data between ClientSpace and Salesforce is defined using Import Map Headers.

Two Import Maps must be created:

• Export Map Header
• Import Map Detail
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Export Map Header

Field Description

Source File SFORCE_export_mapping*.csv

Dataform Import_Organization

Custom Import Class not yet implemented

Import Type Salesforce Export

Execution Pipeline ignored

Import Action ignored

Execute Business Logic ignored

Special Import checked

Import Map Header

Use Import Map Headers to map data between ClientSpace and Salesforce.

To create the Import Map Header:
1. Go to System Admin > Advanced > Configure Import.

The Import Map Header Search page is displayed.
2. Click Add.

The Import Map Header Detail form is displayed.
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3. Complete the form fields:

Field Description

Source File SFORCE_import_mapping*.csv

Dataform Import_Organization

Custom Import Class not yet implemented

Import Type Salesforce Import

Execution Pipeline ignored

Import Action ignored

Execute Business Logic ignored

Special Import selected

4. Click Save.
The next step is to add fields by configuring the import map detail.

To configure the Import Map Detail:
1. Open the newly created Import Map Header.

The Import Map Header Detail form is displayed.
2. In Action Items, click Fields.

The Import Map Search list is displayed, showing the existing fields.
3. To add a field, click Add.
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The Import Map Detail form is displayed.
4. Complete the form:

Field Description

Source Field Ignored. Enter text that describes the source of this detail (OrgName or
sfAcctName) for clarification.

Field and Project
Type

This is where the data from Salesforce will be stored. Select any non-parent
field type on any single-form.
• When mapping Organization, select Import_Organization project type.
• When mapping Contact, select Import_Contact project type.

API Path This is where the data from Salesforce will be retrieved. The format of this field
is SF_ObjectType/FieldName (e.g., Account/BillingStreet).
• The only valid SF_ObjectType values are Opportunity, Account, Contact,

Lead, Event, or Task. Other values are ignored.
• Can only contain an SF_ObjectType and up to two subfields, as in

Account/RecordType/Name.
• Cannot contain special characters (other than ‘/’) and no spaces.
• Salesforce fields that are Calculated are not exported by ClientSpace

because Salesforce does not allow them to be directly updated.
For details on locating the API Path, see Finding the API Path in Salesforce.

Data Type • Text: Most fields should be mapped as Text (even if the source or
destination fields are integers or dates/etc.)

• Lookup: Not yet implemented (use Text).
• Foreign Key

• Currently, this is only implemented for Imports and locating CS Users.
• It accepts a Salesforce User ID and locates that User in ClientSpace by

Email. A call is made to Salesforce using the SF User ID. The SF User
Email is located and used to find a matching Email in ClientSpace.

• Default Value
• A Default Value can be set in this field.
• If a Salesforce field does not exist, the API Path must be set to

Object/UseDefault. This default value is set in the appropriate
ClientSpace field. For Imports the Object is not important, the Default
Value is set in the CS field.

• Active, Required Value, and Required Column
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Field Description

• Only Active records are used.
• Required Value and Required Column settings are ignored.

• Minimum Required Field

5. Click Save.

To configure the Import Map Detail for fields from multiforms:

Note: Before you complete this procedure, you must contact Professional Services about setting up
the Salesforce API to use the csworkspacedataproc additional parameter with a custom stored
procedure. You will use the variables from the custom stored procedure to define the fields to
populate in Salesforce.

1. Go to System Admin > Advanced > Configure Import.
The system displays the Import Map Header Search page.

2. Click (Jump) for the row that contains the Salesforce mapping source file.
The system displays the Import Map Header Detail page.

3. In Action Items, click Fields.
The system displays the Import Map Search, showing the existing fields.

4. Click Add to create a new field map.
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5. Complete the following information in the form:

Field Description

File Column Enter the variable from the stored procedure for the field that you are
mapping to Salesforce.

Dataform This is field must be blank so that the system can pull data by using the
variable in the saved procedure that is associated with the Salesforce API
csworkspacedataproc additional parameter.

Data Type Select a Data Type:
• Text: Most fields should be mapped as Text (even if the source or

destination fields are integers or dates/etc.)
• Lookup: Not yet implemented (use Text).
• Foreign Key

• Currently, this is only implemented for Imports and locating CS
Users.

• It accepts a Salesforce User ID and locates that User in
ClientSpace by Email. A call is made to Salesforce using the SF
User ID. The SF User Email is located and used to find a matching
Email in ClientSpace.

• Default Value
• A Default Value can be set in this field.
• If a Salesforce field does not exist, the API Path must be set to

Object/UseDefault. This default value is set in the appropriate
ClientSpace field. For Imports the Object is not important, the
Default Value is set in the CS field.

• Active, Required Value, and Required Column
• Only Active records are used.
• Required Value and Required Column settings are ignored.

• Minimum Required Field

API Path This is where the data from Salesforce will be retrieved. The format of
this field is SF_ObjectType/FieldName (e.g., Account/BillingStreet).
• The only valid SF_ObjectType values are Opportunity, Account,

Contact, Lead, Event, or Task. Other values are ignored.
• Can only contain an SF_ObjectType and up to two subfields, as in
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Field Description

Account/RecordType/Name.
• Cannot contain special characters (other than ‘/’) and no spaces.
• Salesforce fields that are Calculated are not exported by ClientSpace

because Salesforce does not allow them to be directly updated.
For details on locating the API Path, see Finding the API Path in
Salesforce.

6. Click Save

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Mapping Custom Salesforce Objects

You can use the Salesforce Export API (SFORCE_export_mapping*.csv) to map ClientSpace forms and
fields to Salesforce objects and fields and export the data from ClientSpace to Salesforce to create new
Salesforce objects.

Step 1: Verify Datatypes

Before you get started, make sure you verify the datatypes of the fields you want to map in Salesforce
and ClientSpace. Mapped fields must have matching datatypes.

l In Salesforce: Go to Setup >Object Manager > Select Object >Fields And Relationships.
l In ClientSpace: Go to System Admin  > Advanced > Dataform Admin. Open the dataform

and select Fields. Hover your mouse pointer over a field in the Field column to view the datatype.

Step 2: Add the "AdditionalInsertExportList" Parameter to the Salesforce API Record

The AdditionalInsertExportList parameter must be added to the Salesforce API record (SFDCDEV or
SFDCPROD) to specify which ClientSpace forms are allowed to be inserted into Salesforce.

Note: In development sites, the Salesforce API name will be SFDCDEV. In production sites, the
Salesforce API name will be SFDCPROD.

To add the parameter:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.
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2. Select the Salesforce API record (SFDCDEV or SFDCPROD) and click Edit.
The API Configuration form opens.

3. Add the Parameter and add the form names (table names) to the Value field as shown below.
Separate them by a semicolon if there is more than one.

4. Click Apply or Save.

Step 3: Review Import Map Header Detail of the Salesforce Export API Record

The export process that inserts custom Salesforce objects uses the existing Salesforce Export API
(SFORCE_export_mapping*.csv). If you are already using the Salesforce Export API to update Salesforce
objects, it will already be configured for you. You can review the API settings and make changes if
necessary.

To review the Salesforce Export API settings:

5. Go to System Admin  > Advanced > Configure Import.
The Import Map Header Search dashboard opens.

6. Enter SFORCE in the Search field and click Search.
7. Click (Open) next to SFORCE_export_mapping*.csv or double-click the row.

The Import Map Header Detail form displays Salesforce Export API configuration as shown in the
example below.
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8. Review the field values. Note that the Import Type should be set to Both. For a complete list of
field definitions, refer to Configuring the Import Map Header.

9. If you made changes, click Save.

Step 4: Configure the Import Map Detail Record of the Salesforce Export API Record

In this step, add each field from ClientSpace that you want to send to a Salesforce object (i.e., form) and
field.

To configure the Salesforce Export API mapping:

1. Open the Salesforce Export API Import Map Header Detail record. (See Step 2 for details.)
2. In the right pane, click Fields.

The Import Map Search dashboard opens.
3. To add fields, click Add.

The Import Map Detail form opens.
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4. Map the fields as shown in the example image below. Refer to Configuring the Import Map Detail
for detailed steps and a list of all field descriptions.

How the Export Determines Whether to Insert or Update a Salesforce Object

When a change is made to a dataform with mapped fields, an audit record is created containing the
change. When the Salesforce Scheduled Process (Salesforce Sync Rest API) runs, ClientSpace uses the
External Source Linking table (System Admin > Imports > External Source Linking) to determine
whether to update or create an object. The External Source Linking dashboard displays a list of all API
objects. If you open an External Source Linking record and see entries for both a Clientspace Table
Name/ClientSpaceID pair along with an External Object (i.e., Salesforce object)/External Object ID pair,
this means that there is already a link between the objects in Salesforce and ClientSpace.
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If a change is made on the associated ClientSpace dataform, the audit record contents are used to
update the object in Salesforce the next time the scheduled process runs. If no Clientspace Table
Name/ClientSpaceID pair and External Object/External Object ID pair are shown on the External Source
Linking record, a new object will be inserted using the contents of the audit record the next time the
scheduled process runs.

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)
l External Source Linking
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Importing Salesforce Data Overview

Updates Allowed

• An internal flag _CSUpdateAllowed is used to determine if Salesforce data is allowed to be
imported into ClientSpace. This is a configurable setting that changes programmatically depending
on the state of the Client Master Status.

Work Queue

• Object must be named Work_Queue__c
• Must contain OpportunityID__c and Complete__c fields
• Complete__c must be set to false when the record is created in Salesforce
• Duplicate Opportunities in multiple Work Queue records are ignored
• If the import is successful,

• Work Queue OpportunityID__c is set to Empty
• Complete__c is set to true

Organization

• Creates new Org or updates an existing Org
• General Notes marked Updated/Created from the SalesforceAPI
• Org ImportID is set to Salesforce Account ID
• Only updates existing Org data with Salesforce data if _CSUpdateAllowed
• Org is saved from the database, no biz logic executed

Org Other Info

• Creates new Org Other Info or updates existing Org Other Info
• All fields and values are retrieved from the current installation (custom fields are available)
• Only updates existing Org Other Info data with Salesforce data if _CSUpdateAllowed (or when

creating a new record)
• Org Other Info is saved from the database, no biz logic executed

Client Master

• Creates new Client Master and workspace if associated Org has no workspace (must have client
template configured for this to function)
• Updates Client Team Sales Admin User after workspace is created (to Org Assigned To)
• The new Client Master is saved using the dataform pipeline Default
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• After the new Client Master is created (or Client Master exists)
• fkParentCompanyID is set to Salesforce Account/ParentId associated CS Organization (if

exists)
• All fields and values are retrieved from the current installation (custom fields are available)
• Adds Org Node for Biz Logic access (similar to a Client Master save from the UI)
• Only updates existing Client Master data with Salesforce data if _CSUpdateAllowed
• Updated Client Master is saved from the dataform pipeline SalesforceAPI

• Client Location
• Creates new Client Location or updates existing Client Location
• If new, sets LocationName("MAIN"), luLocationType("Main"), SyncToM("P"), SyncToB("P")
• All fields and values are retrieved from the current installation (custom fields are available)
• Only updates existing Client Location data with Salesforce data if _CSUpdateAllowed (or when

creating a new record)
• Client Location is saved from the dataform pipeline SalesforceAPI

• Contacts
• Retrieves all Salesforce Contacts associated with Salesforce Account
• Looks up each contact by ClientSpace ImportID
• Creates new Contact if ImportID not found
• Always set IsActive(True), SyncWithOrganizationAddress(false), ImportID(SF Contact ID)
• Ignores _CSUpdateAllowed (always syncs Salesforce data)
• Contact is saved from the database, no biz logic executed

• Contact Other Info
• Updates or creates Contact Other Info for each Salesforce Contact (from Contacts above)
• All fields and values are retrieved from the current installation (custom fields are available)
• Ignores _CSUpdateAllowed (always syncs Salesforce data)
• Contact Other Info is saved from the database, no biz logic executed

• Other Dataforms
• Any Dataform mapped (Import Map Header) is included
• Iterates through each mapped Dataform
• Retrieves existing Dataform from Workspace associated with Salesforce Account (CS

Organization)
• Creates dataform if one does not exist in Workspace
• Dataform is saved from the dataform pipeline SalesforceAPI
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• Only updates existing dataform data with Salesforce data if _CSUpdateAllowed (or when
creating a new record)

Related Topics:

l External Source Linking
l Exporting Salesforce Data Overview
l Salesforce API Data Relationships Overview

Exporting Salesforce Data Overview

Exports allowed

• A flag is used to determine whether or not ClientSpace will export data to Salesforce. This flag is set
via the API Configuration form. It cannot be changed programmatically.

Organization

• Update Opportunity and/or Account based on mappings (Org and Org Other Info).

Client

Client Master data is combined with other workspace data using the PEO stored procedure peo_
salesforce_org_s_workspace_by_org.

Contact

• Update Contact based on mappings (Contact and Contact Other Info).
• Create new contact based on mappings (Contact and Contact Other Info).
• Create converts the Org Assigned To to a Salesforce User or Salesforce Account Owner.

To add Client Master Export fields:
1. Add a custom version of this stored procedure to your system that includes the additional fields.

• update Opportunity and/or Account based on mappings (Client Master)
• set Opportunity.StageName based on ClientMaster.Status

2. For questions or help with this, log an Extranet case.

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

ClientSpace Setup & Administration © 2025 PrismHR 899

Chapter 20 APIs



Configuring the Salesforce User

Configure the Salesforce user in ClientSpace.

To configure the Salesforce user:

1. Go to System Admin > Users.
The Users dashboard opens.

2. Click Add.
The User Details form opens.

3. Complete the following fields:

Username Type sfservice.

First Type Salesforce.

Last Type Service User.

Email Enter the Admin Email address for ClientSpace (Go to System Admin
> Advanced > App Settings).

User Type Select External.

Authentication
Type

Select ClientSpace.

Default
Workspace

Select Admin Workspace.

Active Select this option to enable the username.

4. Click Save.

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Business Intelligence Report: API log

Create a report named SFDC API Log with the following settings to capture Salesforce API log data
(including any including errors) and put in the Administration Category :
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Tab Field/Value Notes

Fields l Date Create
l ProcessStartTime
l ProcessEndTime
l Error
l LogData

Show Full Date and Time on all Date or
Time fields. Example: 1/10/2024 4:57:43
PM

Filters Date Created In Time Period Today
fkScheduledProcessID Equals 67

67 in the example is the Scheduled
Process ID for Salesforce Sync Rest API.
Obtain the ID for your configuration from
the record title.

Data Sources SYSTEM - Scheduled Process History

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Salesforce API Data Relationships Overview

The Salesforce API Integration is a PEO process that maintains data synchronization between a Client’s
ClientSpace installation and their respective Salesforce system. 

During the life cycle of a Deal, either Salesforce or ClientSpace is responsible for the data. Typically,
when in the Lead Discovery cycle, Salesforce owns the data. As changes are made in Salesforce,
ClientSpace is updated with those changes. When the Deal has reached a certain level, ClientSpace will
no longer accept changes from Salesforce but will keep Salesforce up to date with certain data as
changes are made in ClientSpace. 

Although this is a PEO process, custom fields in both ClientSpace and Salesforce can be imported.
Configuration handles the specific fields to be managed. The exchange of data between the systems is
highly configurable. Data elements are mapped at the field level for each system using standard
ClientSpace Import Map Headers and Details. 

When ClientSpace dataforms (gen_) are updated from Salesforce, they are saved via Dataform Pipeline
Logic, which then executes business rules and triggers email templates.

Data Relationships for Salesforce API

The following diagram shows the relationships between Salesforce and ClientSpace objects. Only one
Opportunity can be mapped to ClientSpace per Organization, even though there can be multiple
Opportunities associated with an Account. Use the Opportunity RecordType.Name to identify the
correct Opportunity (see ClientSpace Configuration section).
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Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Finding the API Path in Salesforce

The API Path used to configure the Import Map details in ClientSpace can be found in Salesforce. To
view the necessary settings, the Salesforce user must have administrative rights.

Use the Lightning Maps to ensure appropriate field naming:
1. Select your username > Switch to Lightning Experience.
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You will see an option for Setup in the upper right.

2. Click and select Setup.
3. In Setup Home, select Objects and Fields > Object Manager.

The Object Manager page opens.

4. Select the appropriate Salesforce object.
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5. When the object opens, select Fields & Relationships to get the Field data you will use in your
ClientSpace mappings.

You will be presented with a page (or more depending on the object) containing the:

• Field Label (what appears in Salesforce)
• Field Name (the actual name of the field in the Salesforce database table)
• Type of Data

Related Topics:

l Salesforce API Implementation in ClientSpace (Implementation Phase 3)

Salesforce API Testing (Implementation Phase 4)
Testing of the Salesforce API can occur in the Sandbox or in Production. This part of the
implementation is completed with the assistance of a ClientSpace team member.

To test the Salesforce API:

1. When ready to test, turn on the Salesforce Sync Rest API Scheduled Process (System Admin
> Advanced > Scheduled Processes).

a. On the Scheduled Processes Admin dashboard, click (Open) next to the Salesforce
Sync Rest API Scheduled Process.

b. If the Next Run Date is set to a future date, change it to today's date.
c. Save the change and close the scheduled process.
d. Then, on the Scheduled Processes Admin dashboard, select the Salesforce Sync Rest

API Scheduled Process and then click the Run Process button.
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2. Manually create the work queue for the "zzPrismHR" test account, opportunity and contract,
copy/paste the SalesforceID into the work queue and check to see if records are created.
Note: If Completed is checked, the record will not be imported into Salesforce as this indicates
that it has already been successfully processed:

3. When finished testing, turn off the Salesforce Sync Rest API Scheduled Process.

Related Topics:

l Troubleshooting Salesforce API Issues

Troubleshooting Salesforce API Issues

Issue 1: The Salesforce API process is frozen or stuck.

Potential Fix: In ClientSpace, open the Salesforce Sync Rest API Scheduled Process (System Admin
> Advanced > Scheduled Processes, uncheck the Is Running checkbox and Save.

Issue 2:  An access token error not granted error displays in the SFDC API Log report.

Potential Fix: Reset the security token in the Salesforce site (My Personal Information > Reset My
Security Token). Then reset the password in the Salesforce site.

Issue 3:  The following error displays in the SFDC API Log report: "Severe Error occurred; error=Cannot
deserialize the currentJSON array (e.g. [1,2,3]) into type
'ClientSpace.API.Salesforce.Rest.DescribeObjectResult' because the type requires a JSON object (e.g.
{"name":"value"}) to deserialize correctly."

Potential Fix: Reset the username and password in the Salesforce site and in ClientSpace.
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Related Topics:

l Salesforce API Testing (Implementation Phase 4)

DocuSign
DocuSign is one of the most widely used e-signature applications in the world, allowing you to sign
documents anywhere from any email-enabled device without overnighting, faxing, or waiting.
ClientSpace integrates with DocuSign through an API configuration and the client's DocuSign account
information.

Configuring the
DocuSign
integration
comprises the
following steps:

1. Configure the
API record to
enable
ClientSpace
to log in to
DocuSign.

2. Configure the Workflow link for sending documents to DocuSign.
3. Configure the merge template for the DocuSign tags.
4. Upload the merge template to the Merge Admin in ClientSpace.
5. Configure the Email Template, which is the main conduit for the transfer of information between

ClientSpace and DocuSign.
6. Test the merge template.
7. Upload the merged file to the Collateral form.
8. Send to DocuSign.
9. Review the uploaded files queue to monitor the status.
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10. Notify users of status.
11. Manage any failed uploads.

What's next? When you have the username, password, and endpoint information, you can begin
configuring the API. Proceed to Configuring the DocuSign API Record.

Before You Begin
Note: The ClientSpace API for DocuSign requires the purchase of DocuSign licensing. Before
configuring DocuSign in your ClientSpace installation, please log an Extranet case to discuss DocuSign
licensing.

Before you begin the DocuSign configuration, your DocuSign Administrator must obtain the Username.

The ClientSpace staff member assigned to assist you with DocuSign API configuration provides the
Secondary ID and Key. You will need the login information at the end of the API configuration process
to authorize the connection from ClientSpace to DocuSign.

The table below lists the information you need before you begin to set up the DocuSign API in
ClientSpace.

You must have Description

Username DocuSign user account code. The account code is provided by DocuSign as the
API UserName and is in the form of a Globally Unique Identifier or GUID, a 32-
digit character string formatted as xxxxxxxx-xxxx-Mxxx-Nxxx-
xxxxxxxxxxxx.

Endpoint This is the server URL to which we connect.
In production environments, this is typically entered as
account.docusign.com.

Secondary ID Integration key provided by the ClientSpace staff member assigned to assist
you with DocuSign API configuration.

Key OAuth2 RSA Key required by DocuSign for all DocuSign API integrations after
12/31/2023. The ClientSpace staff member assisting you with the
implementation provides the Key.
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Configuring the DocuSign API Record
The API record connects ClientSpace to DocuSign. Your DocuSign administrator or a ClientSpace staff
member can assist you with DocuSign API configuration.

Ensure that you have the items marked with an asterisk (*) in the table below before you
start the configuration. Also see Before You Begin.

Step 1: Configure the API Record in ClientSpace

To configure the API record:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. To add a record, click Add. To edit an existing record, select the record and click Edit.
The API Configuration form opens.
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3. Complete the form fields.

API Type Select DocuSign.

Application
Code

Type DocuSign.

Application
Name

Type DocuSign.

Username* DocuSign user account code. Provided by DocuSign as the API UserName and
is in the form of a Globally Unique Identifier or GUID, a 32-digit character string
formatted as xxxxxxxx-xxxx-Mxxx-Nxxx-xxxxxxxxxxxx.

Your DocuSign Administrator can obtain the Username from Docusign.com
using the following steps:

1. On the Docusign.com site, in the left navigation pane under
"Integrations", select Apps and Keys.

2. In the "My Account Information" section, click the Copy to Clipboard

icon under User ID.

3. Paste the DocuSign User ID into the Username field of the ClientSpace
DOCUSIGN API Configuration window.

Description Provide a brief description of how you are using DocuSign in the ClientSpace
environment (i.e. Sales, Benefits, etc.)

Endpoint* This is the server URL to which we connect.
In production environments, this is typically entered as
account.docusign.com.

Secondary ID* Integration key provided by the ClientSpace staff member assigned to assist
you with DocuSign API configuration.

Active Check Active.

Logging Level Select Level 2 (Verbose). You can also view log details in the Uploaded Files
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Queue. See Viewing and Managing Document Statuses in the DocuSign
Process.

Logging Level Not used by the DocuSign API. Logging for the DocuSign API is determined by
the scheduled process. You can view log details in the Uploaded Files Queue.
See Viewing and Managing Document Statuses in the DocuSign Process.

Key* OAuth2 RSA Key required by DocuSign for all DocuSign API integrations after
12/31/2023. The ClientSpace staff member assisting you with the
implementation provides the Key.

Additional
Parameters

The following parameters are name-value pairs for additional configuration.

apipath Required. Type /restapi/v2.

apikey Required. This value will be provided by the ClientSpace Professional Services
representative assisting you with DocuSign API configuration.

endpoint Required. Type https://cs-functions-
prd.azurewebsites.net/api/DocuSignToken.

retrythreshold This is the number of times the system attempts to get a document if there are
connection issues. In the Uploaded Files Queue, Retry Count tracks the number
of errors when trying to get a DocuSign document. When the threshold is met:
• The Uploaded File Queue record is skipped.
• Triggers the DocuSignFail email template.
Default setting for the retrythreshold field is 5.
See Viewing and Managing Document Statuses in the DocuSign Process and
Notifying Users of Status.

RetryCount This is the number of times the system attempts to upload a document in
CS Failure or DS Failure status before stopping.

ExcludeVoidedFi
les

This parameter is for Envelopes voided from within DocuSign. When a
document is voided in DocuSign or from the Void workflow in ClientSpace, you
can set this parameter to allow voided documents to upload or prevent the
voided document from coming back into ClientSpace.
0: Voided documents are uploaded to the linked form or field. This is the
default setting if the parameter is not configured.
1: Voided documents are only uploaded to the Uploaded Files Queue record,
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and not the linked dataform.

DocuSignReque
stDays

Allows a signed document to be retrieved into ClientSpace by the Docusign
Get Docs Status scheduled process if a document status change is equal to or
less than the number of days specified here.

4. Click Save. 

Step 2: Enter the Redirect URI on DocuSign.com

This step must be completed by your DocuSign administrator or by the ClientSpace Professional
Services representative assisting you with DocuSign API configuration. The redirect URI must exactly
match one of those preregistered for the integration key in your DocuSign account. DocuSign provides
the URI.

To enter a redirect URI:

1. On the Docusign.com site, scroll down to the "Service Integration" section on the window
containing your Integration Key details.
Note: If this window is closed, click Actions > Edit next to the DocuSign integration record on the
Apps and Keys page under "Apps and Integration Keys". (The Apps and Keys page is accessed
from the DocuSign.com navigation pane under "Integrations".)
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2. In the "Additional Settings" section, under Redirect URIs, click Add URI.
3. Type the URI.

Note: The URI shown in the example above is for instructional purposes only. Your company's
URI, assigned by DocuSign, will be different from the example shown here.

4. Important: Click Save at the bottom of the page on Docusign.com to save your entry.

Step 3: Authorize the Connection in ClientSpace

This step must be completed by your DocuSign administrator. The ClientSpace Professional Services
representative assisting you with DocuSign API configuration can help you with this step.

To authorize the connection:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. Select the previously saved DocuSign API Configuration record and click Edit.

3. In the Action Center, click the Authorize icon.
A popup window displays requiring you to log in to DocuSign.

ClientSpace Setup & Administration © 2025 PrismHR 912

Chapter 20 APIs



4. Enter the DocuSign password.
The popup window refreshes to display a request for ClientSpace to access DocuSign.
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5. Click Allow Access.
If the configuration is correct, the popup window refreshes a final time to display an
"Authorization was successful" message.
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6. Close the popup window.

Step 4: Test the API Connection in ClientSpace

After you create the API record, it's a good idea to test the connection.

To test the connection:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Process Admin dashboard opens.

2. Look for the entry DocuSign Request Signature and ensure it is active.
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3. Select the entry DocuSign Request Signature and click Queue Process.
4. After the process runs, go to System Admin > Exception Log.

The Exception Log dashboard opens.
5. Look for an entry for the API connection. If there is an error, this means that the API credentials are

incorrect, preventing access to DocuSign. Review the API credentials, make adjustments, and test
again. If there is no error in the Exception Log, this means the API connection was successful.

6. When you have confirmed a good API connection, proceed to the next step, Configuring the
Workflow Link.

Configuring the Workflow Link
The next step is to set up a custom link on the Client Master, or other targeted dataform that initiates
the submit action to DocuSign.

To configure the link:

1. Go to System Admin > Advanced > Custom Links.
The Configure Links dashboard opens.

2. Click Add.
The Configure Links Detail form opens.
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3. Complete the form.

Location Select Client Master, or other targeted dataform that initiates the
submit action to DocuSign. This is the name of the dataform on which
you want the link to appear.

Display Value Type Send to DocuSign. This is how the link will display in the Action
Center > Workflow pane.

Group Select Action. This denotes the type of link you are creating and
drives the other fields on the form.

Sort Order Use the default value.

Display Action Select Submit w/Action.

Code Value Type SendDocuSign. This is the HdrAction that is produced when the
link Send to DocuSign is clicked (from the Client Master).

Confirmation Message Optional. Allows you to display an OK / Cancel dialog box with a
message before running the link action. Most often used with Action
Links.

Description Optional. A text description of what action the link performs may be
recorded here. This description displays when you hover over the link
on the dataform or system object.

Display this Link when
adding

Optional. Dataforms prior to saving do not normally display links. This
option allows you to display the link before the initial form save.

Pinned Open Optional. When this option is enabled (selected), it forces the link
always to be displayed in the Action Center. The link does not
collapse when the associated group is collapsed.

4. To add a link display condition, click Add.
Link display conditions might be used to control when the link appears, such as when the client is
in the approved status. For details on how to add a link display condition, see Configuring Link
Display Conditions.

5. To add link security, click the Security icon in the Action Center to access the Security Roles
window where you can add one or more roles and secure the custom link to unlimited roles. For
details on how to configure link security, see Configuring Link Security.
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6. Click Save.
7. Proceed to the next step, Configuring the merge template.

Configuring the merge template
The merge template is where you register the DocuSign tags such as Signature, Date, Name, and Title.
The tags reside in the contract document, such as a Client Service Agreement. You can use a Word doc,
an Excel file, or a PDF as your merge template. For our example, we are using a Word doc.

Let's say that you have a contract that needs a signature, perhaps a Client Service Agreement. You want
to use ClientSpace as the mechanism to automate the signing process so that you can also save the
contract in the CSA field on the Collateral form. You create the contract with the appropriate
statements, and at the end of the document is where you want dates, titles, names, and signatures.

1. Determine the required tags

Tags represent the input area for the contract signers to enter a date, name, title, and signature. You
can configure as many tags as required. You must use a unique symbol that differentiates the tag from
actual content. A pair of slashes is recommended because they are typically not used in content. You
can use a backslash \ or forward slash /. For contracts that require multiple signatures, increment the
tag numbers. For example, S1 represents the first signer, and S2 would represent the second signer, and
so on. Don't forget to add dates and other text for the subsequent signers, such as D2, and N2.

n Word docs: Place the tags where you need input.

Add the tag in a text box so that it can be easily adjusted up or down on the document.
DocuSign actions often appear lower in the application than where the tag is configured on
the merge template. Adding them in a text box allows you to make adjustments as to where
they appear on the document.

n Excel files: Place the tags in the appropriate cells.
n PDFs: Open the PDF, select Edit PDF, and add the tag as text by selecting Add Text. A text box

opens. Type the tag in the text box, such as \D1\.

2. Insert the tags

The next step is to configure your document so that you place the tags where the signers input data.
The following example illustrates how you would use tags in the input fields for Date, Name, and
Signature:

l \D1\ represents the Date for the first signer
l \S1\ represents the Signature for the first signer
l \N1\ represents the Name for the first signer
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When you have configured your contract with the necessary tags, save the file with a unique name,
such as Client Service Agreement.docx.

Before you go live with the merge template, change the DocuSign tag font color to white. This
prevents the tags from showing on the signed document. DocuSign can read the tags with a
white font color.

Now you are ready to proceed to the next topic, Uploading the merge template.

Uploading the merge template
Now you are ready to upload the merge template and then test it.

To upload the merge template:

1. Go to System Admin > Outputs > Merges.
The Merge Admin dashboard opens, showing a list of your existing merges.
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2. Click Add.
The Merge Admin Detail form opens.

3. Complete the form fields.

Name Type a descriptive name for this merge record, such as DocuSign Client
Service Agreement.

Template File This is where you upload the template file.

1. Click (Upload File).
The Upload File dialog box opens.

2. Click Choose File.
3. Locate the file on your computer and click Open.

The file name displays next to Choose File.
4. For Description, type a description of the uploaded file. Optional.
5. For Category, select an entry from the list. Optional.
6. Click Save.

Description Type a descriptive title of the merge record.

Type Select the file type of the file you just uploaded: Word, Excel, PDF.

Password Optional. Type a password to secure the administration of the merge
record.

Procedure Select a stored procedure from the list. The procedure you select is
determined by the data you need to merge into the document.
l For standard CSA documents, select a procedure with CSA in the

name.
l For Word output, you could select peo_merge_word_companydata.
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l For PDF output, you could select peo_merge_csa_pdf.

Output Type This field is visible when Type is Word. For Type Word, you can generate a
Word doc or a PDF.

4. Click Save.

Configuring the DocuSign Email Template
The Email Template is where you specify who is to receive the DocuSign notification and the tags that
represent dates, signatures, and titles. This is how ClientSpace informs DocuSign what to look for. At
this point, you have a merge template (in our example, a Word doc) that has been uploaded to
ClientSpace and a workflow link that will be used as the trigger for the Email Template.

Step 1: Initial

To configure a DocuSign email template:
1. Go to System Admin > Email Templates.

The Email Templates dashboard opens.
2. Click Add.

The Add Email Template form opens to Step 1 Initial.
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3. Complete the form.

Type Select DocuSign. This action enables the API Configuration field.

Triggering Form This is where your trigger originates. Select the form on which you added
the Workflow link, such as Client Master. (The Workflow link was added in
a previous step, Configuring the Workflow Link, in the Location field.)

Template Code Type DocuSign.

Template Name Type DocuSign.

API Configuration Select DocuSign.

4. Click Apply.
5. Click Next.
The Step 2: Content form opens.
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Step 2: Content

In the Content step, you provide a unique Subject for the email message.

To configure the content of the email:

1. Provide a unique Subject line of the email to be generated.
The subject is visible in the DocuSign email received. You can also use replacement fields in the
Subject. The available fields are based on the Triggering Form you selected in Step 1 Initial.

IMPORTANT: Ensure that you use a unique Subject on the DocuSign Email Template.
DocuSign Email Templates with the same configured Subject line, when sent to the recipient,
are grouped into the same email thread, which can confuse the recipient. Recipients could
potentially overlook other emails that request a signature.

2. To use replacement fields, click See Replace Fields.
The Replace Fields dialog box opens. For details about replacement fields, see Replacement Fields.

If you are configuring a DocuSign failure notification, consider using the {ProjectID},
{WorkspaceName} and {LinkToWorkspace} replacement fields. Adding these can fields
help you troubleshoot where an error occurred.

3. As you select items in the list, Copy becomes available.
4. When ready, click Copy to copy the items to your clipboard.
5. Back in the wizard, paste the items in Subject.
6. Click Next to proceed to Step 3: Addresses.
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Step 3: Addresses

In this step, you code your tags for DocuSign in the green Add section. The tags tell DocuSign what to
read to determine if the field is a signature, a date, or a text field. These are the tags that you registered
in your merge template. Ensure that your merge template tags match the Signature Anchor (in the
following procedure).

You can also send a document with the requirement for In Person Signing, which is used when a valid
DocuSign user acts as a signing host for a signer. The document is sent to the signing host who
physically delivers the document to the In Person Signer for signatures. For details on how to set this
up, see Configuring the DocuSign email template for In Person Signing.

To configure the tags:

1. Complete the form fields.

Address Source
Procedure

Select a stored procedure (optional) that can provide additional
address options based on system data. A stored procedure can be
selected from any stored procedure in the system with a name
containing emailtemplate_recipient_proc.

From Address Select the From Address for the email. You can select from a distinct
set of options:
• Admin Email: Uses the default admin email set in the systems App

Settings. Only User Developers can change this email address. For
assistance, please log an Extranet case.
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• AdHoc: Allows you to add the From list by typing it in manually.
• User: Select a specific user of the system by selecting them from a

list.
• Procedure: Select an address stored procedure and pick the From

Address.
• Field on a Form: Select a dataform from a list of single forms in

the system that have fields from which an email can be extracted.
Then pick the appropriate field.

2. To add your tags for DocuSign, click Add.
A new row opens for adding DocuSign fields on the merge document.

Source Source is the dataform where the field for the recipient is stored. The field can
be a contact or a user field. The document is sent directly to these users. For
Adhoc Email Address, enter the email address of the signer in the Address
field.

Type This field indicates the type of signature:
• Signer
• In Person Signer
If you select In Person Signer, see Configuring the DocuSign email template
for In Person Signing.

Address This is the email address of the person who must sign.
• When Source is a dataform, select the user or contact type field on the

form from which you would like to extract the email address.
• When Source is Address Source Procedure, select the appropriate

option.
• When Source is Adhoc Email Address, enter the email address to which

you would like to send, such as bsmith@test.com.

Note: If you select the AdHoc email address option and enter a
ClientSpace user's email address as a recipient, if the Enable Email for
this account field on their user profile is unchecked, they cannot receive
emails from ClientSpace and will therefore not receive the email generated
from this template.

Note that only a Global Administrator can change this setting.

Also see Personalizing Your User Profile.
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Legal Name This is the legal name of the person who must sign. The legal name is used
when selecting a signature in DocuSign.
• When the Source field is Adhoc Email Address, enter the Legal Name of

the signer that matches the Adhoc Email Address, such as Robert Smith.
• When the Source field is Current User, this field is set to TBD to indicate

that the current user is unknown until runtime. When the DocuSign
Request Signatures process runs, the Current User profile is used and the
Legal Name is determined by the first and last name of the current.

• When the Source field is set to a dataform, this field is set to TBD and
automatically filled from the User or Contact FirstName LastName
specified in Source and Address, when the email is sent.

In Person Signer
Source

See Configuring the DocuSign email template for In Person Signing.

In Person Signer
Name

See Configuring the DocuSign email template for In Person Signing.

Signature Order This field determines the order in which the signature fields are presented in
DocuSign. For documents that don't have a required signature order, a
recommended best practice is to use the order the signature tags are
presented in the merge document, from top to bottom, and left to right as the
signature order.
As you add tags, the process continues with ascending numbers, giving them
each a new number (reference the screenshot that follows this table).
However, the signing order is per recipient, each of that recipient's tags that
they need to address in DocuSign.

Signature Type Select a Signature Type. When you select a type,
this action places the appropriate DocuSign
action on the document. Additionally,
ClientSpace does not literally add check boxes
to the form. We put the action tag in the
document and let DocuSign do the heavy lifting
when the document is compiled. Signature
actions range from Approve, to Initial Here, to
Sign Here, and many other tags. For assistance
with custom tags, such as custom formatted
fields and radio buttons, log an Extranet case. To
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implement Radio Buttons as a Signature Type, you must configure Radio
Buttons as a custom type within DocuSign.

# Tabs If Ignore If Not Present is selected, it will clone that Recipient and Tab for the
number of Tags that are needed, appending "-1", "-2", and so on to the end of
the tag. This enables a dynamic number of Tags that are generated by merge
SQL and placed into the document while only having to set up one Recipient
record on the email template. Let's say you have a \Name\ tag for the signee's
name. Instead of creating separate \Name\-1, \Name\-2, \Name\-3 recipient
entries, create a single recipient entry with the tag of \Name\ and set the #
Tabs to 3. It is a best practice to check the Ignore if not present option,
otherwise DocuSign will reject the document if all tabs are not present.

By default, the # Tabs is set to 1. This means that this tag is only present one
time in the document. If you want to clone the tag and allow it to be used
multiple times throughout the document, change the # Tabs to the number of
potential tags you may have. Therefore, you only need to set this if you need
multiples of the same. If you use # Tabs for Radio Buttons or Yes/No actions, it
will fill all of those DocuSign tags the same way when the signer responds. For
example, if there are three Tabs for Yes/No action and the signer responds Yes
to one, it marks Yes to the remaining two as well because the tags have the
same label.

The Ignore If Not Present setting will not remove a Recipient from the
envelope that does not have any tags. It will only allow the document to
be sent if that tag is not found on the file. If configuring the Email
Template when a conditional recipient is necessary based on the
document, we recommend creating a separate Email Template for that
document type where that recipient will always have at least one tag. For
example, if the CEO needs to sign on one specific Contract version and
not another, a separate Email Template should be configured for that
specific contract version where an action is required for that signer. If
not, and the CEO signature tag is not found on the Contract that gets
sent to DocuSign, the CEO will still get the document via DocuSign
however they will not have any action to take to finalize the document
and complete it via the DocuSign process. This will require that the CEO
manually add an action to the document in DocuSign in order to finalize
it.

ClientSpace Setup & Administration © 2025 PrismHR 927

Chapter 20 APIs



Signature Anchor This is the custom tag that you embed in your DocuSign document that is
used to merge the signature action in DocuSign. While there is no set
standard, it is important to use a custom tag that does not occur naturally in
written text. An example of a signature location for Initial 1, for example, could
be \init1\ or for a signature, \S1\. The associated tag in the merged document
must match this signature pattern exactly.

Ensure the tags you used in your merge template match the tags in
Signature Anchor. See Configuring the merge template.

Display Text This value appears in the tooltip of the Signature field on the document that is
being signed. It is displayed near the signature location as instructions on
what to do in DocuSign. For example, an initial location might have a signature
display text of “Initial here”. Check boxes might state, “Select all that apply”
and so on.

Label Descriptive text that is displayed in the ClientSpace list to provide a more
complete description of that recipient item. For example, instead of multiple
Signature items in the list, you may want to use the label to indicate the type
of signature, such as Principal Signature or Risk Signature, and so on.

Ignore if not
present

DocuSign allows you to include a parameter on each Recipient/Tab in the
envelope called Ignore If Not Present. The DocuSign integration allows you to
define and include a recipient and associated tags in the envelope but not
throw an error if that tag is not found in the envelope's documents using the
Ignore If Not Present option on the recipient configuration. This makes tags
optional as the system allows the send to DocuSign with or without tags
marked in this way. When the # Tabs exceeds 1, you can enable this option by
selecting Yes. The default setting is No.

For Radio Buttons or Yes/No actions, ensure that each tag has a different label
value. When these tags have the same label, DocuSign applies the response
that the signer enters in one tag to the rest of the tags of that same
action/label.

For Email Templates with multiple documents that also have conditions on the
contract type or required addendums, use the Ignore if not present option.
Enabling this option allows the DocuSign email to be sent when that
document is not included.
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Required Indicate if this is a required field for the Signer during the
DocuSign process. This option helps to streamline the
process for signers when the fields are not applicable.
When selected (Yes), the Signer must sign the custom tag.
When not required (No), the tag appears as optional to the
Signer.

Note: For existing Email Templates (configured before R93), the tags are set
to Required unless you change them.

In the following example, each row represents a signer action such as signature, date, and title. The
Signature Anchor column (noted in the image) uses the tags from the merge template. This
example shows two signers (S1 is John Smith and S2 is Bob Jones), and each signer must indicate a
date and add their title.

After the first person has signed, the process sends to the next person to sign based on the
signature order. DocuSign reads all the tags for the first signer, then goes to next one. If the entries
are out of order in the Email Template, it does not matter. The processing order proceeds by signer.
Our example shows two signers, John Smith and Bob Jones. All the tags for John Smith are
processed before the tags for that of Bob Jones. This is the case even if the tags for the signers were
in a different order than shown in the example.

3. Click Next to proceed to Step 4: Conditions.

Configuring the DocuSign email template for In Person Signing

The DocuSign API supports In Person Signing, which acts as an electronic notary system that sends the
e-document to a third party who then has the document signed in their presence to verify the
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transaction.

For example, if you are meeting in person with someone, you can use In Person Signing to simplify the
signing process. With In Person Signing, a host facilitates a DocuSign session. The host must be a
DocuSign account holder. Signers are only required to be with the host to sign documents. Conducting
the in person signing session entails getting together with your signers and initiating the signing
session from your device. As the host, you start the signing session and then guide your signers
through the process.

In Person Signer and Signing Host

With the In Person Signing feature, you set up an envelope and assign it to a DocuSign user who will act
as a Signing Host for the process. The signer goes to the same physical location as the signing host; the
host then initiates the signing process and then helps the signer complete the electronic documents.

For the DocuSign API, you identify the Signing Host and the In Person Signer. In Person Signer
recipients are DocuSign users. Signing hosts are in the same physical location as the In Person Signer.
The document is sent to the signing host, who physically presents the document to the In Person Signer
for signatures. An in person signing can include both In Person Signers and regular recipients.

How In Person Signing works

Our scenario involves a signing host and an In Person Signer:

• The host is an insurance agent. The agent meets with a client to review a new health insurance
policy.

• The host is established as the Signing Host. The client is the In Person Signer.
• The host starts the signing process and guides the client through the signing process.
When starting the signing process, this is the message the signing host receives:

John Adams assigned you as the host for an in-person signing session for Nathan Hale. As a host,
you will:

1. Pass control of the signing session to the hosted signer.
2. Ask the signer to enter any required authentication information.
3. Help the signer sign and get a copy of the finished document.
4. Take control of the signing session.
5. Log in to your DocuSign account to complete the signing session.

Next:
• Pass control of the session to Nathan Hale.
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After signed by the In Person Signer:
• To complete the signing process, pass control back to <hostname>.

Next:
• The Signing Host is prompted to log into their DocuSign Account.
• After logging into the DocuSign Account and finishing that task, subsequent signers are emailed. If

you do not complete this step, the process halts.

To configure DocuSign for in person signing:
1. From Step 3 Addresses, complete the form fields.

Address Source
Procedure

Select a stored procedure (optional) that can provide additional address
options based on system data. A stored procedure can be selected from
any stored procedure in the system with a name containing
emailtemplate_recipient_proc.

From Address Select the From address for the email. You can select from a distinct set
of options:
• Admin Email: Uses the default admin email set in the systems App

Settings. Only User Developers can change this email address. For
assistance, please log an Extranet case.

• AdHoc: Allows you to add the From list by typing it in manually.

Note: If you select the AdHoc email address option and enter a
ClientSpace user's email address as a recipient, if the Enable Email
for this account field on their user profile is unchecked, they cannot
receive emails from ClientSpace and will therefore not receive the
email generated from this template.

Note that only a Global Administrator can change this setting.

Also see Personalizing Your User Profile.

• User: Select a specific user of the system by selecting them from a
list.

• Procedure: Select an address stored procedure and pick the From
address.

• Field on a Form: Select a dataform from a list of single forms in the
system that have fields from which an email can be extracted. Then
pick the appropriate field.
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2. To add a new recipient record to this notification, click Add.
A new row opens for adding recipients. Each recipient's source, type, and address must be unique.

Source This is the source of the Signing Host.
• For dataform sources, this is where the signing host's email address

and legal name are retrieved.
• For Source as Adhoc Email Address, enter the email address of the

signing host in Address.

Type For in person signers, select In Person Signer.

Address This is the email address of the signing host. This must be a valid
DocuSign user account or DocuSign will reject the document.
• When Source is a dataform, this is the signing host's email address.
• When Source is Adhoc Email Address, enter the email address of the

signing host.

Legal Name This is the legal name of the signing host. This must be a valid DocuSign
username or DocuSign will reject the document.
• When Source is Adhoc Email Address, enter the Legal Name of the

signing host.
• When Source is a dataform, this field is set to TBD and automatically

filled from the User or Contact FirstName LastName specified in
Source and Address.

In Person Signer
Source

This is the Source of the person who must sign in the presence of the
signing host.
• When Source is a dataform, this is the form from which to retrieve the

In Person Signer's Legal Name.
• When Source is Adhoc Email Address, enter the Legal Name of the

Person who must sign in the In Person Signer Name field.

In Person Signer Name This is the name of the person who must sign in the presence of the
signing host.
• When In Person Signer Source is a dataform, this is the field from

which to retrieve the In Person Signer's Legal Name.
• When In Person Signer Source is Adhoc Email Address, enter the In

Person Signer's Legal Name.

3. For details about completing the additional fields/columns, see Step 3: Addresses.
4. Click Apply.
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Step 4: Conditions

Conditions are display conditions and can also include Condition Expressions. Condition Expressions
use the labels that you define for your Display Conditions. For a detailed explanation about conditions,
see Condition Expressions.

To configure conditions:

1. Complete the fields:

No Primary Trigger When selected, no single condition must be met to trigger the email
template. When selected, the Primary Trigger Field is disabled.

Only Trigger Once When selected, the email template is triggered only once when the
conditions are first met. Do not select this option if you want the email
template to trigger each time the conditions are met.

Primary Trigger Field Optional. From the Triggering Form selected in Step 1, which, when
changed, triggers the event. This can also be a HdrAction, such as a
configured action link on the form.

The following statements refer to the condition entries in the Add area.
Condition entries are identified with a Label (the last column).
• If a Primary Trigger Field is selected, that field MUST change values to

trigger this template and evaluate the conditions.
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• If a Primary Trigger Field is not selected, only the conditions are
evaluated.

• If a Primary Trigger Field is selected, the conditions are combined
with the Primary Trigger Field using an implied AND.

• If no Condition Expression is used, the additional conditions are
treated as OR conditions.

The Primary Trigger Field only displays fields associated with the
triggering dataform and includes the ability to Add Untriggered Field.

To add display conditions:

2. Click Add.
A row opens with columns Source, Field, Operator, Value, and Label. The Add section is where you
can add more granular triggering conditions. Each row you add is a display condition. When
Condition Expression is empty, the display conditions process as ORs, meaning only one of the
conditions must be met for the email notification to trigger.

Source The Source list includes the triggering form and its tabs, the channel trigger
(i.e., the original form that started the channel), all triggerable, active single-
forms, and the tabs of those single-forms. Applicable server data procs, if
configured, may also be included.

When you select Task as the Triggering Form in Step 1 Initial, in this step
Source sets to Task.

Field Select the dataform or Stored Procedure
field to compare to the trigger value.
A few notes:
l Email Template triggering provides

multi-lookup fields (Multi Lookup
(MultiLookup)) as triggering conditions.

l Field supports parent form fields.
Available operators are Empty, Not
Empty, and Is Dirty.
Note: If you are creating a Scheduled
Email Template, the Is Dirty operator is
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not in the list as real time analysis of a field is required to determine an
"Is Dirty" state.

l Field supports the Active dataform setting. Available operators are
Does Not Equal, Equals, and Is Dirty (if choosing the triggering form as
the Source). Value options are Unchecked and Checked.
Note: If you are creating a Scheduled Email Template, the Is Dirty
operator is not in the list as real time analysis of a field is required to
determine an "Is Dirty" state.

l You can Add Untriggered Fields dynamically as well as current, active,
triggerable fields from the Source.

l When you select Task as the Triggering Form in Step 1 Initial, the
options for Field include all task fields. For example, when you select
Send Notification, and this option is enabled in the Task, then the email
notification is triggered.

To add a trigger field:

1. In Field, go to the end of the list and select Add Untriggered Field.
The Select an Untriggered Field dialog opens. Field contains a list of
fields currently not marked as Triggerable.

2. In Field, select an entry.
3. Click Ok.

The selected field is marked as triggerable and now appears in the Field
list.

Operator Choose the type of comparison. Each value from a Multi Lookup Trigger Field
can be added as a separate "=" condition. This supports complex AND, OR,
and NOT conditions as well.

Note:

l Is Dirty is not available in the Operator list when the Source is set to
something other than the Triggering Form.

l If you are creating a Scheduled Email Template, the Is Dirty operator is
not in the list as real time analysis of a field is required to determine an
"Is Dirty" state.

Value The criteria against which the trigger field is compared. For a condition that is
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typeahead1 method so that you do not need to look up the User ID for the
text field.

Label The label to use when constructing Condition Expressions for triggering.
ClientSpace assigns a label to a new condition with the naming convention C#.
For example, C1 for the first condition that you create, C2 for the second, and
so on. You can change the label name by selecting the name of the label and
typing a new name for the label. For example, you can select the C1 label and
enter Condition1 as the new label name.

Tip: Make this label short and representative of the Trigger Field. Labels are
used in the Condition Expression field.

Condition
Expression

Allows for AND, OR, and NOT conditions using the trigger conditions (Label)
from the Add section. Using the Label field that corresponds to the entries in
the Add section, you can combine the conditions into more complex
expressions. The Condition Expression field could state, for example
(Condition1 AND Condition2) OR (Condition3 AND Condition4) OR
Condition5. Condition Expressions adhere to AND/OR/NOT across tabbed
dataform conditions. For a detailed explanation about conditions, see
Condition expressions.

When the Condition Expression field is empty, the row entries are treated
as OR conditions. Only one of the conditions must be met.

To clone a trigger condition:
To save some time, you can clone a trigger condition and then edit as appropriate.

1As you type in the field, one or more matches for the term are found and immediately presented.
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1. In the Add section, locate an entry that you want to copy.

2. Click Clone.
A new row opens, with the trigger condition copied. Source, Field, and Operator are copied.

3. You can now edit the new condition as appropriate.
4. Click Apply or Save.

5. Click Next to proceed to Step 5: Attachments.
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Step 5: Attachments

This is where you tell ClientSpace which files to send to DocuSign. You can point to files from multiple
fields, and when ClientSpace sends it to DocuSign, it combines all into one document. You have the
option to Merge All Documents, so when the documents are pulled back into ClientSpace, they can
come in as one big file – and put it in Link To Field. The DocuSign functionality runs business logic on
the destination dataforms where the files are returned completed and the signed file is pinned as a new
version in the field.

If you are using the Attachments feature to include additional documents (multiples) in an envelope, it
places the documents back in the field from which they came when the process completes. It is possible
to pull them back out as separate documents. When we do this, we place the completed doc in the field
from which it was retrieved.

To assist in generating the merge files to prepare to send to DocuSign, the _GenerateMergeFile
business rule can be configured to run the merge document and deposit the file in a field. This business
rule can be configured multiple times to generate each file needed. After the business rules are run, you
can review the documents in their individual file fields before you click the workflow link to send the
files to DocuSign for signatures. See Business Rule Methods: Generating Merge Files.

To complete the Attachments step:

1. Complete the form.
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Mail Merge The options in this field are Merge Admin records where merge
templates have been uploaded. When you select a merge in this
field, it tells the system to run the merge document and send it at
the same time. You can view or edit the merged file before sending
to DocuSign. The merge and send occur immediately after the
clicking Send to DocuSign. Typically, you would set up another
Email Template to also notify users or the client that a DocuSign
email is coming.

Link To Form Link To Form is a required field that informs the system of the form
to which the document(s) will be attached after being signed and
returned to the system. The Triggering Form field value from the
Initial tab auto-fills the Link To Form field by default. You can edit
the default value by selecting a single-form or a triggering multi-
form (if applicable) from the drop down list.

Rename Signed Merge Renamed files can be Mail Merge files, or merged attachment files
if you have selected Merge All Documents. During the process
that links the signed document to a form, the document is renamed
by prepending the original document name with an identifying tag,
such as a signer's name, that you specify here. By default, the
original file name of signed and returned files are always prepended
with "COMPLETED_". Any value you specify here is added before the
original file name using the following format: COMPLETED_Rename
Signed Merge field value}_{Original File Name}.

Merge All Documents? Check Merge All Documents? if you want all signed and attached
documents to be merged into a single document. When you select
this option, you can also attach the merged document to a specified
Link To Field but this is not required.

Link To Field Once you check Merge All Documents?, the Link To Field
displays. Optionally, select a file upload field from the Link To Field
drop down list to which to attach the merged document.

If you leave Merge All Documents? selected but do not choose a
Link To Field, the merged document is added to the Attachments
Action Center panel on the dataform.
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Add In the Add rows, specify the fields where ClientSpace retrieves the
file for DocuSign. You can specify files from multiple fields.

1. Click Add.
A row opens.

2. Select the Dataform where the file resides.
3. Optionally, enter a value to prepend to the original document

name when the document is signed and returned. This could
be an identifying tag, such as a signer's name. By default, the
files are also prepended with COMPLETED_ when they are
signed and returned.

• If a value is entered in the Rename column for a file, the
returned file name has the following format: COMPLETED_
{Rename field value}_{Original File Name}.

• If no value is entered in the Rename column for a file, the
returned file name has the following format: COMPLETED_
{Original File Name}.

Note: The Rename column is not available if you check the
Merge All Documents? checkbox to merge all documents into
one file.

4. Select the dataform Field where the file resides. Any file name
updates to completed single files will be made to this location.

2. Click Save.
You are returned to the Email Templates list.

3. For the new Email Template, select the Published option.

What's next?

If you edited the merge template (Word document) from the time the original file was uploaded, then
you must upload it again. See Uploading the merge template. Now you are ready to proceed to the
next step, testing the tags. Go to Testing the merge document.

Testing the merge document
The next step is to run a test with the merge document to review your tags. Most likely, you will need to
add a link to the Client Master or the targeted dataform to run the merge document.
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Configure the Reports link

Let's add a link for testing the merge document. It displays in the Action Center > Reports pane.

To configure the link:

1. Go to System Admin > Advanced > Custom Links.
The Configure Links dashboard opens.

2. Click Add.
The Configure Links Detail form opens.

3. Complete the form.

Location Select Client Master.

Display Value Enter your link name. This is how the link will display in the Action
Center > Reports pane. For example, our CSA document has
DocuSign tags that we want to review. We added a link named CSA.

Group Select Report. This denotes the type of link you are creating and
drives the other fields on the form.

Display Action Select Run Report.

Report/Merge Select CSA.

4. Click Save.

Test the merge

Now let's test the merge document.

1. Go to the Client Master for your targeted client.
2. In the Action Center toolbar, click (Reload).
3. In Action Center > Reports, click CSA.

The merge process executes, and when done, the file is downloaded.
4. Open the file and review the tags.
5. After you confirm the tags are correct, in your merge template (a Word doc in our example),

change the font color to white. This prevents the tags (D1, S1, T1, for example) from showing on
the signed document. DocuSign can still read the tags.

6. If you changed the merge document (font color or any other changes), you must upload the
merge template file to the Merge Admin again.
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7. To test the merge document again, go to a Workspace and run the Reports link to view the
outputted merge file. We covered that process in an earlier step: Uploading the merge template.

Uploading the merge file
On our Collateral dataform, the Email Template is configured to take the merge file from the CSA field.
So, the next step is to upload the merge file to the CSA field. In our example, the merge file is named
Client Service Agreement.pdf.

To upload the file:

1. From the open Client Master, jump to the Workspace. In the Action Center, in the toolbar, click
(Go to Workspace).

2. In the Action Center, in Links, click Collateral.
The Collateral form opens.

3. In CSA, click (upload).
The Upload File dialog box opens.

4. Click Choose File.
5. Locate your merge file and click Open.

You are returned to the Upload File dialog box.
6. Click Save.

The merge file name displays in the CSA field.

Sending to DocuSign
Now you are ready to send your document to DocuSign. However, before you send, let's check to see if
the required scheduled processes are active.

Are the scheduled processes active?

The following scheduled processes must be active before you send the document:

l DocuSign Get Docs Status
l DocuSign Request Signature
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Active entries are available when you view the Schedule Process Admin list. Additionally, review the
schedule for these processes to determine if the frequency is appropriate.

To review the scheduled process status:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. If the processes are not listed, open More, select All, and click Search.
The list displays active and archived entries. Archived entries are bold and italicized.

3. If the processes are NOT active, please log an Extranet case for assistance.

To review the schedule:

1. Go to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin dashboard opens.

2. Open the entry (click Jump).
The form opens.

3. Review the Frequency, Frequency Type, and Valid Days.
4. For any changes, please log an Extranet case for assistance.

You might want to consider setting:

l DocuSign Request Signature to run every 1 minute.
l DocuSign Get Docs Status to run every 5 minutes.

Send to DocuSign

After you have confirmed that the scheduled processes are active, you are ready to send the document.

To send to DocuSign:

1. From the Client Master, in the Action Center > Workflow, click Send to DocuSign.
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2. Next, you are ready to monitor the Uploaded Files Queue to see the documents that were sent
and their status. Go to Viewing and Managing Document Statuses in the DocuSign Process.

Viewing and Managing Document Statuses in the DocuSign Process

The Uploaded Files Queue Dashboard

The Uploaded Files Queue dashboard provides insight into where your document is in the DocuSign
process and is updated automatically from the DocuSign Get Docs Status scheduled process. The
Uploaded Files Queue is a link on the Imports tile in System Admin. If there is an active DocuSign API
record, the Uploaded Files Queue is visible on the Imports tiles. Otherwise, it is hidden.

l The Uploaded Files Queue records initiate with a Status of New.
l If the files cannot be sent to DocuSign, the Uploaded Files Queue displays a Status of CS Failure

or DS Failure. CS Failure tracks DocuSign upload failures that occur due to a ClientSpace issue. DS
Failure tracks upload failures that occur due to a DocuSign issue.

l If the document in CS Failure status fails to upload, you can reset the Status back to New (see To
reset the status of failed documents:) which changes the Queue Status to new and resets the
Retry Count to 0. You can also use the Mass Update > Reset Retry Count feature to reset the
Retry Count of one or more failed documents to 0 (see To reset the Retry Count of failed
documents using Mass Update).

Note: You can also gather additional information on a failed upload from the Exception Log.
SeeViewing DocuSign Exception Errors.
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l When a DocuSign required tag is missing from one of the files, additional information is
displayed in the Uploaded Files Queue record.

o When this occurs, you must re-run the merge file, upload the correct file to the field, and
trigger the Send to DocuSign again.

o After the DocuSign Request Signature scheduled process runs, the Uploaded Files Queue
Status changes to Out for Signature.

l If a document not signed or voided in 120 days, the document Status is automatically updated to
Archived.

l Additionally, you can create a workflow to notify users when signed documents come back into
ClientSpace.

To access the Uploaded Files Queue dashboard:

1. Go to System Admin > Imports > Uploaded Files Queue.
The Uploaded Files Queue dashboard opens. From here, you can search, view, and delete entries.

2. Select an entry and click View. Alternatively, you can  (Jump) to the record from the row entry.
The Uploaded Files Queue Detail page opens. The page is read-only.
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To view signed and unsigned files attached to this record:

3. Click Attachments.

Queue Status Displays the current status in the DocuSign pipeline.

Signers Displays a list of signers and associated email addresses who received the
DocuSign item along with the requested action for them to take.

Log Data Presents detailed information about the DocuSign process.

To reset the status of failed documents:
For failed documents, you can reset the Status back to New using Reset Status, which is only available
when Status equals CS Failure.

1. On the Uploaded Files Queue dashboard, failed entries show Status as CS Failure. Locate the
failed entry and click (Jump).
The Uploaded Files Queue Detail page opens. Retry Count reflects the number of times the
system attempted to get the document.

2. In the Action Center, click Reset Status.
The Status resets to New, and the Retry Count is set to 0 (zero).
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To reset the Retry Count of failed documents using Mass Update:
For a single or multiple failed documents, you can also use a Mass Update option to set the Reset
Count to 0 so that the failed document uploads can be reprocessed.

1. On the Uploaded Files Queue dashboard, click Select next to one or more failed entries showing a
Status of CS Failure and then select Mass Update > Retry Count.

Note: 

l You can display a Retry Count column on Uploaded Files Queue to view the current Retry
Count setting. To display the column, click the vertical three dot menu (i.e., Kebab menu)

on any column header, select Columns and then select Retry Count.

l If you open a failed entry on the Uploaded Files Queue and click (Jump), the Uploaded
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Files Queue Detail page opens where the Retry Count is now set to 0 (zero).

Related Topics:

l Viewing DocuSign Exception Errors

Notifying Users of Status
DocuSign user notifications can occur through a workflow when a file has returned, or a system email
template when a DocuSign call fails.

System Email Template - Failure

ClientSpace users are notified when a DocuSign call fails through the System Email Template,
DocuSignFail. The template sends a notification to the Created By user on Insert or Update when the
Status equals CS Failure and includes the Log Data from the related Uploaded Files Queue record. The
email template is Active by default.

The system uses the retry threshold count for the DocuSign API configuration to determine when to
trigger the DocuSignFail email template. If a DocuSign call fails, the system evaluates the number of
retry attempts for the DocuSign call and the max number of retries set in the retrythreshold field for
the DocuSign API configuration. If the number of retries for the DocuSign call is less than the threshold,
the system will try again before triggering the DocuSignFail email template. If the number of retries
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equals the threshold, the system will trigger the DocuSignFail email template. See Configuring the
DocuSign API Record for more information about the retry threshold.

Workflow

You can create a workflow to notify users when a file has returned to ClientSpace. Use the following
HrdActions in the Workflow:

l DOCUSIGN_COMPLETED indicates the signing process completed.
l DOCUSIGN_DECLINED indicates the process was declined by a signer.
l DOCUSIGN_VOIDED indicates the process was voided (canceled).

When creating your workflow:

1. In Step 1 Channel, set the following:

Execution Pipeline Select DocuSign.

Triggering Form Select the form to which the completed files are uploaded. In our
example, we used the Collateral dataform.

Field Select HdrAction.

Value In Value:

1. Select Other Value.
The Header Action Value dialog box opens.

2. In Value, type one of the following:
n DOCUSIGN_COMPLETED
n DOCUSIGN_DECLINED
n DOCUSIGN_VOIDED

3. Click Ok.

2. For more details on creating a Workflow, see Configuring your Workflow Channel.

Voided documents
The DocuSign process handles voided documents, allowing the user to void a document that has
already begun processing through the DocuSign system. The document is voided by using a rule on a
workflow. The rule changes the status to Voided. This approach is a reactive measure to voiding
documents.

You can void documents using the following business rules:
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l The biz rule (core) _VoidDocuSignDocument updates the Uploaded Files Queue record status to
voided.

o The scheduled process DocuSign Request Signature voids the envelope(s) in DocuSign.
o The Scheduled process DocuSign Get Docs Status retrieves any voided documents. It

attaches to the dataform if configured to attach (otherwise, the voided document is
attached only to the Uploaded Files Queue record).

l A soft error (core) _SE_VoidDocuSignDocument warns the user that documents (envelopes) will
be voided. This rule also identifies the number of envelopes that are affected.

Both rules are configurable with the following parameters:

l DataformOnly (option). When selected, it only voids envelopes (and thereby documents)
associated with the Dataform on which the rule is configured. When cleared, voids all envelopes
in the Workspace associated with the Dataform on which the rule is configured.

l AllowVoidStatus (comma-delimited string). Provides the status of Uploaded Files Queue records
that can be voided. See the Signature Status lookup group for valid statuses and use the CODE in
this parameter, separated by a comma, with no spaces.

As a preventive measure, your administrator can set an option (ExcludeVoidedFiles) in the DocuSign
API configuration parameters to prevent voided documents from coming back into ClientSpace. See
Configuring the DocuSign API Record.

Viewing DocuSign Exception Errors

The Exception Log

The Exception Log dashboard, when used in conjunction with the Uploaded Files Queue dashboard, can
provide additional insight when you are troubleshooting DocuSign upload failures, particularly "retry
threshold" failures.

To access the Exception Log dashboard:

1. Go to System Admin > Exception Log.
The Exception Log dashboard opens. The Error Name and Error Text columns display helpful
information. In the case of a "retry threshold" error, the Envelope ID and Queue ID of the failed
record are shown.
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2. Alternatively, you can  (Jump) to the record details from the row entry.
The Exception Details page opens. The page is read-only.

Related Topics:

l Viewing and Managing Document Statuses in the DocuSign Process

CCMSI
CCMSI is a third-party administrator for workers' compensation programs. ClientSpace provides a
connection to the CCMSI API, which allows you to enter the data into ClientSpace and export it to
CCMSI. ClientSpace correlates the Workers' Comp Claim data and exports it to CCMSI, providing the
convenience of maintaining the data in one place.

NOTE:  You must be a CCMSI customer to use the API.
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To get started, you need the following information from CCMSI:

n CCMSI Username
n CCMSI Password
n CCMSI secondary ID
n URL that points to your organization's API services on CCMSI

Topics in this section

Configuring the CCMSI connection 952
Member Number and Location Number 954
CCMSI lookups 956
CCMSI client analyst users 956

Configuring the CCMSI connection
The following procedure guides you through configuring the CCMSI connection. First, configure the
connection. Then, activate the CCMSI links for the Comp Claim dataform: CCMSI Location Number,
CCMSI Member Number, CCMSI Initial Report, and Submit to CCMSI.

To configure the API:

1. Go to System Admin > Advanced > API Configuration.
The API Configuration dashboard opens.

2. Highlight the row for CCMSIAPI and double-click or click (Open).
The CCMSIAPI API Configuration form opens.
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3. Complete the following fields:

Username The organization CCMSI username.

Password The organization CCMSI password.

Endpoint The URL that points to the API services for your organization. This is specific
to each client.

Secondary ID The organization CCMSI member number. This is the client identifier, which
is part of the authenticator object – the Username and Password, specific to
each client, is related to the Secondary ID.

4. Click Save.

To activate the links:

1. Go to System Admin > Advanced > Custom Links.
The API Configuration dashboard opens.

2. Filter the list to search for CCMSI, using %CCMSI.
The filtered list displays showing four entries. From here, open an entry and activate the link.

ClientSpace Setup & Administration © 2025 PrismHR 953

Chapter 20 APIs



3. For each entry, open and select the Active option.

4. Click Save.

To confirm the business rule SubmitClaimToCCMSI is active:

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Search for SubmitClaimToCCMSI and open the rule.
The Rule Details form opens.

3. Select the Active option (if not already selected), and click Save.

Member Number and Location Number
You must provide the CCMSI Member Number and CCMSI Location Number to successfully transmit
data from ClientSpace to CCMSI. This is performed from links on the Client Master and the Client
Location.

If any of these data points are missing, on the Comp Claim, you will receive a hard error when you click
the Submit to CCMSI link. If the Comp Claim cannot be submitted to CCMSI for any reason, the CCMSI
Initial Report link on the Comp Claim will display the failed error with details.

To enter the CCMSI Member Number:

1. Open the Client Master.
2. In the Action Center, expand Links and click CCMSI Member Number.

The External Source Linking dialog box opens.
3. In External Object ID, enter the CCMSI Member Number.
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4. Click Save.

To enter the CCMSI Location Number:

1. Open the Client Location dataform.
2. In the Action Center, expand Links and click CCMSI Location Number.

The External Source Linking dialog box opens.
3. In External Object ID, enter the CCMSI Location Number.

4. Click Save.
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CCMSI lookups
To send injury cause, nature, and body part data to CCMSI, additional configuration is needed. On the
following Comp Claim Injury field lookup values Additional Settings should be configured with the
NCCI Code value.

l Cause of Injury (AccidentCause lookup group)
l Nature of Injury (TypeofInjury lookup group)
l Injured Body Parts (InjuredArea lookup group)

Lookup values must have the NCCI Code that matches the code value required by CCMSI.

CCMSI client analyst users
Users who are client analysts in CCMSI must have an External Source Linking record created on their
ClientSpace User Profile.
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To add the user's ClientAnalysisCode:

1. In ClientSpace, open the user's User Profile.
The User Details form opens.

2. On the Action Center toolbar, click (More Options) and select External Source Linking.
The External Source Linking dashboard opens.

3. Click Add.
The External Source Linking dialog box opens.

4. Complete the fields.

API Configuration Select CCMSI API.
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External Object Type ClientAnalysisCode.

External Object ID Enter the user's CCMSI code.

5. Click Save.

Marketo
Marketo provides marketing automation and lead management software for B2B marketers. The
ClientSpace API integrates with Marketo to push contact information into the Marketo system. The
ClientSpace contact records are stamped with the Marketo ID, enabling information synchronization
between the applications using a scheduled process. A Marketo ID field is on the ClientSpace Contact
form, in the Other Information fieldset.

PlanHub
PlanHub allows you to create instant, customized 401k cost comparison proposals for your clients and
prospects, as well as to enroll your contacts into an automated email campaign to nurture them
towards sales-readiness with the value of the 401k at the forefront. For more information about
PlanHub, see their website.

Why do I care about this?
With the ClientSpace PlanHub integration, you can request a Slavic 401k PlanHub proposal from within
ClientSpace – offering you an integrated solution. From ClientSpace, you can create instant, customized
401k cost comparison proposals for your clients.

What does it do?
The ClientSpace PlanHub integration passes the prospect’s FEIN to Slavic401k, and if successful, a PDF
version of the PlanHub proposal is received and uploaded to the Slavic PlanHub dataform. When the
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PlanHub proposal is received, it can trigger established workflows to notify individuals for any
additional next steps.

Procedure overview
To integrate the PlanHub proposal, you must work with ClientSpace Professional Services. For
assistance, log an Extranet case. The following table lists the tasks and responsible group for
implementing the ClientSpace PlanHub integration.

Task Who performs this task?

Set up the API configuration Professional Services

Enable the business rules Professional Services

Enable and configure the scheduled process Professional Services

Review the PlanHub dataform security Client

Configure the Client Master links to PlanHub Available in the application. May be
enabled by Professional Services.

Identify and set up the workflow processes Client

Demonstration Professional Services

Gradient AI
Gradient AI is a provider of artificial intelligence analysis solutions for the insurance industry. Their
solutions are designed to improve loss ratios and profitability by predicting underwriting and claims
risks, and suggest appropriate premium pricing. Gradient AI solutions use your data and regional data
to make sure suggested prices are accurate based on risk and location.

ClientSpace currently offers two Gradient AI API integrations:

• Gradient AI Health Benefits uses artificial intelligence to analyze your offered benefits plans and
compare them to potentially thousands of other offered benefits plans submitted by other PEOs in
your area. If you are a small to mid-size PEO and you do not have an on-site benefits expert, a
Gradient AI Health Benefits analysis can provide insight into how your pricing stacks up against
others to help you to determine if you are pricing benefits properly. See Gradient AI Health Benefits.

• Gradient AI Risk uses artificial intelligence to analyze Pricing Console batch information such as
payroll, headcount, workers compensation position codes, and worker's compensation loss history
(if available). Data from the submitted Pricing Console batch is processed by Gradient AI in real time
and results are aggregated by each worker's compensation policy included in the batch. The results
include information such as predicted losses and a suggested premium (i.e., Target Premium). See
Gradient AI Risk.
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Note: A relationship and contract with Gradient AI is necessary to utilize either of these
API connections.

Gradient AI Health Benefits
The Gradient AI Health Benefits API in ClientSpace allows you to receive assessments of your offered
benefits plans by using Gradient AI's artificial intelligence models to compare your submissions to its
large database of offered benefits submissions from other PEOs in your area.

Why do I care about this?

The Gradient AI Health Benefits API can help you determine whether you are overpricing or
underpricing benefits based on your underwriting groups and region.

What does it do and how do I use it?

To receive an assessment of your offered benefits plan, you must submit your offered benefits and
Health Census information to Gradient AI. There are two ways to do this:

l Initiate the Submit Action Manually - Complete a Gradient Health Census report using a template
we provide. Attach the completed health census report to the Benefits Batch dataform in the
Completed Health Census file upload field. Then, click the Submit to Gradient AI link to submit
your offered benefits and Health Census information to Gradient AI.

l Automate the Submit Action - If your organization can configure Salesforce to export completed
Health Census reports to ClientSpace and attach them to the correct Benefits dataforms in the
Completed Health Census file upload field, you can use the _GAICensusValidation ClientSpace
business rule method on the Salesforce API pipeline to submit offered benefits and Health
Census information to Gradient AI. Submissions occur when the Completed Health Census file
upload field is populated (i.e., "Not Empty" and "Is Dirty".)

Even if you choose to automate submissions, the Submit to Gradient AI link remains available
for use.

To use the manual submission method:

1. Go to a workspace and open a Benefits Batch dataform to record the benefits you want to offer to
your client's employees.

2. Then, click the Gradient Health Census link and fill out the form.
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The Gradient Health Census report is an Excel spreadsheet template used to add pertinent
employee information such as employee names, employee IDs, dates of birth, residence zip codes,
coverage types and underwriting groups.

3. Enter all employees that you want to include in your submission to Gradient AI.
When completed, the Gradient Health Census appears similar to the following:

4. Next, attach the Gradient Health Census report to the Benefits Batch Dataform by clicking Attach
File in the Completed Health Census file upload field.

5. When you are ready to submit offered benefits and Health Census information to Gradient AI,
click the Submit to Gradient AI link.

ClientSpace validation runs to ensure coverage types are not blank and that there are valid
subscribers and underwriting groups. If an error is found, it will display at the top of the Benefits
Batch form. You must correct these errors and resubmit again.

Once you successfully submit the Health Census data to Gradient AI, Gradient AI checks the data
more extensively. For instance, specific coverage types are validated. You will receive an
"Accepted" "Succeeded" or "Failed" email notification based on Gradient's analysis.

6. Click the Gradient AI Health Results link on the Benefits Batch dataform to view the Gradient AI
Health Results dashboard. If the submission was successful, the dashboard lists a record for each
underwriting group included in the submission.

The same notification details that you receive via email are also logged on the Gradient
AI Health Results window in the Validation section.

7. Click (Open) next to a line item to view the results for an underwriting group. If a record in the
submission has a Status of "Failed", review the Log field for validation errors and other error
details.

Note: A summary of key findings also displays in the widgets located at the top of the Benefits
Batch window.
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To configure the automated submission method:
Work with your Salesforce system administrator to set up Salesforce to insert health census data into
the Completed Health Census file upload fields of the correct Benefits Batch dataforms in ClientSpace.

When this is done, complete one-time business rule configuration in ClientSpace. Once the ClientSpace
business rule configuration is complete, offered benefits and Health Census information will be
submitted to Gradient AI when the Completed Health Census file upload field on the Benefits Batch
dataform is populated (i.e., "Not Empty" and "Is Dirty").

1. Go to System Admin > Advanced > Manage Rules.
The Custom Logic Rules dashboard opens.

2. Locate the Benefits Batch "Health Census Validation (Salesforce API)" rule and click (Open)next
to it.

3. Verify the following settings, editing if necessary.

Method _GAICensusValidation

Primary Trigger Field Completed Health Census

Primary Trigger Operator Not Empty

Secondary Trigger Field Completed Health Census

Secondary Trigger Operator Is Dirty

Pipeline Salesforce API

Save Action Insert

System Checked

4. Click Save.

To track automated submissions and view results:
With the manual method, the logged in user who clicks the Submit to Gradient AI link is the
Submitted By user and only the Submitted By user receives "Accepted", "Succeeded" and
"Failed" notifications. These email notifications are not sent for the automated method since a business
rule is initiating submissions instead of a logged in user. However, all notifications are still recorded on
the Gradient AI Health Results window in the Validation section:
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1. Access the Gradient AI Health Results window by clicking the Gradient AI Health Results link on
the Benefits Batch dataform to view the Gradient AI Health Results dashboard.
If a submission was successful, the dashboard lists a record for each underwriting group included
in the submission.

2. Click (Open) next to a line item to review the Gradient AI notification details in the Status and
Log fields. If a record in the submission has a Status of "Failed", review the Log field for validation
errors and other error details.

Miscellaneous notes
l The Gradient Health Benefits API returns an assessment for each unique underwriting group

listed in the Offered Benefits Plan (as reflected in the Gradient Health Census report).
l If the Gradient Health Benefits API is not able to return an assessment due to an issue with the

submission, such as Gradient AI underwriting group not matching an underwriting group you
entered in the Gradient Health Census report, a "Failed" status is logged in the Validation section
(Log field) of the Gradient AI Health Results window. If the submission was manual, the
Submitted By user will also receive an email notification.

l For manual submissions, Gradient AI Health Benefits notifications are only sent to the user who
clicked the Submit to Gradient AI link (i.e., the Submitted By user). The Submitted By user
name displays on the Benefits Batch dataform in the "Gradient AI Benefits" section.

Implementation procedure overview

A relationship and contract with Gradient AI is necessary to utilize the Gradient AI Health Benefits API in
ClientSpace. To integrate the Gradient AI Health Benefits API proposal, you must work with ClientSpace
Professional Services. For assistance, log an Extranet case. The following table lists the tasks and
responsible group for implementing the ClientSpace Gradient AI Health API integration.

Task Who performs this task?

Set up the API configuration Professional Services

Enable the business rules Professional Services

Review the Gradient AI Health Benefits dataform security Client

Configure the Benefits Batch dataform links to Gradient AI Available in the application. May be
enabled by Professional Services.

Identify and set up the workflow processes Client

Demonstration Professional Services
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Gradient AI Risk
The Gradient AI Risk API in ClientSpace allows you to receive real-time assessments of your Pricing
Console batch information worker's compensation predicted losses and a suggested premium (i.e.,
Target Premium) for each worker's compensation policy included in the batch.

Why do I care about this?

Real-time data determines the best worker's compensation policy pricing based on a variety of risk
factors and your geographic region.

What does it do and how do I use it?

Gradient AI uses information from the States and Codes section of the Pricing Console such as State,
Code, GrossPayroll, and EEs:

Gradient AI also uses historical worker's compensation loss information, if entered. Though this
information is optional, providing it can greatly increase the accuracy of your results. Enter this
information by clicking the Loss History link on the Pricing Batch dataform:

When you are ready to submit the pricing console information to Gradient AI, click the Submit To
Gradient AI link.

Results are returned in real time. Click the Gradient AI Risk Underwriting link on the Pricing Batch
dataform to view the results.

Gradient AI aggregates the results by worker's compensation policy. Therefore, you will see one line
item listed per policy:
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The Rating State column displays the state associated with the policy. If a policy includes multiple
states under the same worker's compensation policy, the state with the most payroll displays as the
Rating State:

Return to the Pricing Console main dataform to view results summary dashboard information at the top
of the form. The dashboard on the left shows a summary of key information across all submitted
worker's compensation policies. The dashboard on the right displays a summary of key information for
each submitted policy:

Implementation procedure overview

A relationship and contract with Gradient AI is necessary to utilize the Gradient AI Risk API in
ClientSpace. To integrate the Gradient AI Risk API proposal, you must work with ClientSpace
Professional Services. For assistance, log an Extranet case. The following table lists the tasks and
responsible group for implementing the ClientSpace Gradient AI Risk API integration.

Task Who performs this task?

Set up the API configuration Professional Services

Enable the business rules Professional Services

Review the Gradient AI Risk dataform security Client

Configure the Pricing Console > Pricing Batch dataform links
to Gradient AI

Available in the application. May be
enabled by Professional Services.

Identify and set up the workflow processes Client

Demonstration Professional Services

Benefit Plan API
The Benefit Plan API is a one-way export API that allows you to export benefit plan setup information
from ClientSpace to PrismHR. Once this information is in PrismHR, you can enroll employees and
manage the plans in PrismHR.

l Attachments and Templates: Benefit Plan API Export Field Mapping and Benefit Rules (Excel File)
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Benefit Plan API Configuration
To configure the Benefit Plan API, you will need to perform the following steps:

l Step 1: Configure Benefit Plan API Business Rules
l Step 2: Configuring the Benefit Plan API Custom Link

Benefit Plan API Export Prerequisites
The Benefits API export is run from a client workspace. Before that can occur, you must have set up your
master plans and set up offered benefits for your clients.

Master Plan Setup

l Set up or verify the master plans in the Admin Workspace.
Note: The Admin workspace can be accessed by searching for "Admin" in the Workspace Search
dashboard. Once you are in the Admin Workspace, enter "Benefits Plan" in the search for
dataform field and then click the Benefits Plan tile to view existing master plans or add a new
plan. To view an existing plan, double-click the row or click (Open) next to the plan.

l Set or verify the available Rate Groups for each master plan.

l Set or verify Benefits Tiers.
Note: To access the Benefits Tier Definition window, on the Admin Workspace, enter "Benefits
Tier" in the search for dataform field and then click the Benefits Tier Definition tile.

l Admin level plans must also be created along with their associated premium and billing rates.
These items must align so that they can be identified when exported into PrismHR from
Clientspace (i.e., Benefit Plan Identifier(UniquePlanCode) = Benefit Plan ID and Rate Group title =
Rate Group).

Adding or Updating Offered Benefits

Once master benefit plans are set up and the underwriting and pricing are added, add the plans you
will be offering to your clients for the current enrollment period to the Benefits Batch. The Benefits
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Batch is used to track all the plans you make available to a client in an enrollment year. This is set up at
the client (i.e., workspace) level.

To add or update offered benefits on a client's workspace:

1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

2. Select a workspace and click (Open).
The Workspace page opens.

3. Move down the page to the administrative tiles where you see the dataform categories.

4. Enter "Benefits Batch" in the search for dataform field and then click the Benefits Batch tile.
The Benefits Batch window displays.

5. Click (Open) next to an existing Benefits Batch OR click Add to add a new Benefits Batch.
The Enrollment window displays.

6. In the Action Center, under Links, click the next to the Offered Benefit Plans link to add an
offered benefit OR click on the link text to select an existing offered benefit plan to edit.
The Offered Benefits Plan window displays.

7. Complete the form as applicable. Minimally, the following fields should be filled in for a successful
export:
Benefit Plan, Rate Group, Effective Date, and Benefit Group.

The combination of the Benefit Plan, Rate Group and Benefit Group comprise a unique
benefit plan. These fields must match corresponding fields in PrismHR for a Benefit Plan
export to occur. For a complete list of all of the Benefit Plan fields and Benefit Plan Rules that
export to PrismHR, click the "ClientSpace to Prism Benefit Plan Export Field Mapping
and Benefit Rules (Excel file)" link located on the Attachments and Templates article.
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Category This is not a data entry field. This is a filter setting used to filter the Benefit Plan
lookup to only display a list of benefit plans that match your selection.

Benefit Plan This is the master plan that the offered benefit is based on.

Rate Group Select the appropriate Rate Group from the associated master plan.

Effective
Date

Benefit plan data will not export to PrismHR if a plan Effective Date is not entered.

Benefit
Group

A Benefit Group allows you to add an additional layer of specialization to a plan.
Example: You could create a Benefit Group record named "25PLUS" to classify
employees who have been with your client's organization for more than 25 years
and modify the employer contributions in PrismHR to provide a seniority-based
discount to employees in this group.

You also define the enrollment waiting period on the Benefit Group record.

Employer
Contributio
ns

Edit the Employer Contributions to indicate how much to contribute to the
employee. Modify the monthly premium from the master plan Rate Group for each
coverage type only if necessary as this information is cloned from the master plan
and should rarely require overriding.
Note: As you make changes to this section, the Employer Contributions section is
updated to reflect employer costs while the grid located at the top if the Offered
Benefits Plan window is updated to reflect both the Employer and Employee
contribution for each coverage type.
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To edit Employer Contributions, select an option from the Contribution Method
field: 
• Contribute EO Premium - This is the default selection. 100% of the employee

premium is paid by the Employer up to the Max Dollar Amount. The Max
Dollar Amount is set by default as the EO monthly premium for the associated
Rate Group.

• Manually Set Percentages - Manually adjust the default percentages of
employer contribution and/or adjust the specified Max Dollar Amount for all
coverage types.

• Match EO Contribution - Manually adjust the default percentages of employer
contribution and/or adjust the specified Max Dollar Amount for the
EO coverage type only. The other coverage types will be recalculated based on
these values

• Match EO Contribution - Add an employer contribution for an eligible
dependent in the Dependent Contrib% field. The system recalculates all of the
other coverage types where dependents are being covered. For instance, if you
leave the EO% set to 100% and enter 50% in the Dependent Contrib% field,
this indicates that in addition to paying 100% of the employee premium, the
company will cover 50% of dependent premiums. The employer contribution
percentages and the Max Dollar Amount fields of the other coverage types is
recalculated to include the total employer contribution with the dependent
contribution factored in.

Setup
Details

Setup Details export to PrismHR. They provide billing and payroll deduction
information about the benefit plan to PrismHR.
• One Month Prepay -Determines whether to bill the client and deduct the

amounts from the employees for the next month in the current month. For
example, bill and deduct in July for August. This is not applicable for weekly
plans.

• Add One Month for Prepay -Whether the system should check for and use any
new rates and rules in the upcoming month. For example, during a July payroll,
PrismHR checks if there are rules and rates that go into effect in August. This is
not applicable for weekly plans.

• Annual Periods -Calculates the employee deduction amount into either 48 or
52 deduction periods.

• Coverage Ends On - Indicates the date coverage ends when an employee is
terminated. For example, select "Ends at End of Month" to have the coverage
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end on the final day of the month when an employee was terminated.
• Benefits Billing Frequency - Determines when plan billing occurs. If you select

one of the monthly options, PrismHR bills the client the whole portion at the
beginning of the month, and then gives credits for the other pay periods in that
month. If you do not make a selection, the system uses the pay period. Weekly
plans always use "Pay Period".

• Payroll Deduction Frequency - Determines whether to override the employee's
normal payroll deduction frequency. The standard is to deduct each pay
period. However, you can change this to "Monthly" for instance.

8. Click Apply or Save.
9. Repeat the steps in this topic until all of the offered benefits for this client are set up. Once you

have finished setting up offered benefits and the client has reviewed them and picked the ones
they want to offer to their employees, you can select and reject offered benefits in ClientSpace.
This step is required before you can export benefit plans to PrismHR as only "Selected" plans can
be exported. See Selecting or Rejecting Benefit Plans to Export.

Selecting or Rejecting Benefit Plans to Export
Once you have offered benefit plans set up in ClientSpace, you can select the plans that the client wants
to offer to their employees and reject the ones that they do not want to offer by selecting Select or
Reject in the Offered Benefits Plan workflow. Only "Selected" plans will be exported to PrismHR.

For more information on setting up offered benefit plans, refer to Benefit Plan API Export
Prerequisites.

To select or reject offered benefits on a client's workspace:

1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

2. Select the desired workspace and click (Open).
The Workspace page opens.

3. Move down the page to the administrative tiles where you see the dataform categories.
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4. Enter "Offered Benefits" in the search for dataform field and then click the Offered Benefits Plan
tile.
The Offered Benefits Plan window displays.

Alternatively, you can access offered benefits by searching for"Benefits Batch", click the
Benefits Batch tile and then selecting the Offered Benefit Plans link in the Action Center.

5. Click (Open) next to the Offered Benefits Plan you want to select or reject.
The Offered Benefits Plan details for the selected plan are displayed.

6. In the Action Center, under Workflow, click Select to select this plan for export to PrismHR or click
Reject to exclude the plan from being exported.

A confirmation message displays.
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7. Click OK.
Once you have finished selecting all of the plans for your client, you can export the plan
information to PrismHR. See Exporting Benefit Plans to PrismHR.

Exporting Benefit Plans to PrismHR
Once you have selected the offered benefits that your client wants to offer to their employees, you can
export the selected plan data to PrismHR using the Benefits API.

The combination of the Benefit Plan, Rate Group and Benefit Group comprise a unique benefit
plan. These fields must match corresponding fields in PrismHR for a Benefit Plan export to occur.
For a complete list of all of the Benefit Plan fields and Benefit Plan Rules that export to PrismHR,
click the "ClientSpace to Prism Benefit Plan Export Field Mapping and Benefit Rules (Excel file)"
link located on the Attachments and Templates article.

To export benefit plans to PrismHR:

1. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

2. Select a workspace and click (Open).
The Workspace page opens.

3. Move down the page to the administrative tiles where you see the dataform categories.
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4. Enter "Benefits Batch" in the search for dataform field and then click the Benefits Batch tile.
The Benefits Batch window displays.

5. Click (Open) next to the Benefits Batch containing the plan information you want to export.
(The batch Status shown in the grid should be listed as "Pending".)

6. On the Benefits Batch window, in the Action Center under Workflow, select Export Plans to
Prism.
Note: You can export plans that have not been activated yet. However, since the Benefits API
export is a one-way export, remember to update the plan statuses in ClientSpace once they are
activated.
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If no errors occur during export, a confirmation message displays indicating that the export was
successful. You can then verify the exported data in PrismHR. See Viewing Exported Benefit Plans
in PrismHR.

Viewing Exported Benefit Plans in PrismHR
Once benefit plans have been exported to PrismHR, you can view the plan information.

To view exported plan information in PrismHR:

1. On the PrismHR Client menu, select Benefit Plan Setup.

The Benefit Plan Setup window displays.

2. Select a Plan Class of Group Benefit and select the Plan that you exported.
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The following field data exports from ClientSpace to PrismHR. Note that all fields may not export if
they are not required fields and were not populated in ClientSpace prior to exporting.

You can also access a spreadsheet with list of all of the Benefit Plan fields and Benefit Plan Rules
that export to PrismHR by clicking the "ClientSpace to Prism Benefit Plan Export Field Mapping
and Benefit Rules (Excel file)" link in theAttachments and Templates article.

ClientSpace Field Form PrismHR Field(s) Form

Category gen_BenefitsBenefitPlan Plan Class Benefit
Plan
Setup

UniquePlanCode gen_BenefitPlan Plan Benefit
Plan
Setup

luSelectionStatus gen_BenefitsBenefitPlan Status Benefit
Plan
Setup

EffectiveDate gen_BenefitPlan Start Date

Stop Date

Benefit
Plan
Setup

FkPlanTierID* gen_BenefitsBenefitPlan Billing Rate Group

Premium Rate Group

Pending Rate Group

Pending Rate Group
Effective Date

Benefit
Plan
Setup
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ClientSpace Field Form PrismHR Field(s) Form

IsOneMonthPrepay gen_BenefitsBenefitPlan One Month Prepay Benefit
Plan
Setup

IsAddOneMonthforPrepay gen_BenefitsBenefitPlan Add One Month for Prepay Benefit
Plan
Setup

luAnnualPeriods gen_BenefitsBenefitPlan Annual Period Benefit
Plan
Setup

luCoverageEndsOn gen_BenefitsBenefitPlan Coverage Ends On Benefit
Plan
Setup

luBenefitsBillingFrequency gen_BenefitsBenefitPlan Benefit Billing Frequency Benefit
Plan
Setup

luPayrollDeductionFrequency gen_BenefitsBenefitPlan Payroll Deduction
Frequency

Benefit
Plan
Setup

Percentage** gen_BenefitPlanTier Premium Risk Factor

Effective Date

Benefit
Plan
Setup

*Rate Group values must match each other in ClientSpace and PrismHR in order to be set properly by
the export. In ClientSpace, the code value in the Title field of the Rate Group Detail window is
compared to PrismHR Billing Rate Groups list.

** In ClientSpace, there is a single Rate Group field on the Offered Benefit Plan that holds the value for
either a Rate Group or a Risk Factor while in PrismHR there is a Billing Rate Group field for Rate Group
and a Risk Factor section for premium risk factors. ClientSpace uses the Rate Source field value located
on the ClientSpace Rate Group Detail window to determine whether to export into the Billing Rate
Group field or Risk Factor section of the PrismHR Benefits Plan Setup window. If the Rate Source field
value is "Percentage", it is exported as a Risk Factor. If the Rate Source field value is "Manual", it is
exported as a Rate Group.
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Also note that when a Risk Factor is exported, a value of "Global" is defaulted in the Billing Rate Group
field.

Related Topics:

l Exporting Benefit Plans to PrismHR

SIDES ClientSpace Integration Overview
What are SIDES and SIDES E-Response?

The State Information Data Exchange System (SIDES) and SIDES E-Response are software tools that
empower states, employers, Third Party Administrators (TPAs) and Professional Employer Organizations
(PEOs) to quickly, accurately, and securely respond to unemployment insurance requests.
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Developed through a strategic partnership between the U.S. Department of Labor (USDOL) and state
unemployment insurance (UI) agencies, SIDES and SIDES E-Response offer a nationally standardized
format to better anticipate and supply the data needed for responding to UI claim information
requests. SIDES is a subdivision of the National Association of State Workforce Agencies (NASWA).
NASWA is a governing entity sponsored by the USDOL.

Currently 47 states and 3 jurisdictions participate in SIDES. To learn more about SIDES, visit the
website of any participating state or jurisdiction or visit the National Association of State
Workforce Agencies SIDES website.

What about the other SIDES exchanges or "streams"? Does ClientSpace integrate with all
of them?

SIDES has six exchanges or "streams" that all work together to support steps in the unemployment
insurance claim process:

l Separation Information (SI) Exchange - Expedites sending separating information once a claim is
filed with the state.

l Monetary and Potential Charges (MPC) Exchange - Electronically notifies employers of wages
used to setup a claim and allows them to verify correct wages are being used for every claim.

l Additional Fact-Finding (ADF) Exchange - Allows states to electronically communicate with
employers and TPAs in relation to unique questions during a claim investigation.

l Determinations & Decisions (DD) Exchange - Notifies employers of non-monetary decisions
electronically and allows quick expediting of appeals.

l Earnings Verification (EV) Exchange - Automates audits and responses through automated
delivery of requests and outstanding tasks.

l Benefit Charges (BC) Exchange - Assists with the detection of improper payments and provides
final charge notices electronically at the end of a billing cycle.

Visit the SIDES Solutions page of the Unemployment Insurance Information Technology
Support Center (UI ITSC) for more details on SIDES exchanges.

Currently, ClientSpace interface integrates with the Separation Information exchange only. If you are
interested in other exchanges, please submit a case so that we can consider it for a future
enhancement.

What is the difference between SIDES E-Response and the SIDES ClientSpace
Integration?

SIDES E-Response is a free website where employers and their representatives submit UI responses
directly to state unemployment agencies using a PIN provided by each State Workforce Agency where
you manage employees. The website is free, only requires an internet connection and is easy to use, but
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if you operate in multiple states, you must request credentials from each State Workforce Agency
where you manage employees which can be a hassle to manage if you operate in multiple states. SIDES
E-Response is best suited for employers or TPAs with a limited number of annual UI claims. If you
operate in multiple states or have more than 30 UI information requests per week, SIDES E-Response
may not be sufficient for efficiently managing UI responses.

The SIDES ClientSpace integration is an automated data exchange interface between ClientSpace and
SIDES and is best suited for larger employers, PEOs, and TPAs who typically deal with more than 30 UI
information requests per week or who operate in multiple states. ClientSpace retrieves the claims from
SIDES and places them in the correct workspace.

How often are claims received from SIDES?

A scheduled process runs every hour to send new claims and amendments. (However, some states may
only upload claims once per day.) Note that this is a two-way exchange. Therefore, any updates from
SIDES are also received and applied.

What are some of the major benefits of using the SIDES ClientSpace Integration?

For larger employers, PEOs, and TPAs who manage many UI claims during the year, there are many
benefits to using the SIDES ClientSpace integration. Here are just a few of the major benefits:

l Direct Import into ClientSpace - Instead of receiving claims from states the traditional way (via
mail) or needing to manage multiple pins to use SIDES E-Response, claims are imported directly
into ClientSpace from the state. ClientSpace imports the claims, creates a record for each claim
and lists each claim in the Unemployment Claim dashboard of the correct workspace based on
the company the claim is associated with and the employee’s social security number.

If ClientSpace cannot match the claim to a company and SSN, the claim is listed in the
Unemployment Claim dashboard of the Client Services Department workspace. The Client
Services Department workspace is treated as a temporary holding workspace where
unmatched claims reside until they are researched. After researching an unmatched claim,
workflow is in place to allow you to manually move it to the appropriate workspace or
process the claim with a relevant response such as "Never Employed Here" or "Fraudulent
Claim".

l Standardized Claim Questions - The questionnaire (which is standardized across all states) is
attached to the ClientSpace claim record on the Separation Information Response tab for ease
of reporting.

l On-the Fly Entry Validation and Pre-Submission Validation - The responses you enter to key
fields, such as Preparer Type and Employer reason for separation, determine which fields and
field sets display. For example, selecting Discharged in the Employer reason for separation
field triggers the display of the Discharge & Suspension fieldset containing additional relevant
fields.
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You must fill in the required fields before submitting the claim. You should also review all of
the optional fields. Optional fields are not required for answering a claim but may be
provided to allow you to supply more information. Providing this information may reduce
requests from the state for amendments.

If you miss a required field, enter incorrect dates, or miss completing a supporting form (such as
Remuneration, Prior Incident, or Witness) that was activated based on your responses, when you
attempt to submit the claim, pre-submission validation in ClientSpace runs and may display an
error message listing the missed requirements.

Pre-submission validation in ClientSpace saves you time by capturing most missing
requirements. SIDES validation captures any remaining missed requirements. Reply Failure
(SIDES) is an unsuccessful claims status update that you may receive after a claim is sent to
SIDES and the SIDES validation revealed a data issue or a missing requirement that was not
captured by the ClientSpace pre-submission validation process.

l Employee Record Reference and Wage Auto-fill - Efficiency in answering claims is further
enhanced by being able to quickly open the ClientSpace employee record from within the
Unemployment Claim record to reference employment details. A Get Wages link in the Action
Center Workflow allows you to retrieve an employee's wage information from PrismHR and auto-
fill the fields in "Earnings and Schedule" section of the questionnaire (depending on your
responses).

l Single Click Submission - Once the questionnaire is completed, clicking Submit to SIDES in the
Action Center Workflow runs a validation process to ensure the claim is complete and queues a
claim response for submission to the state. A scheduled process in ClientSpace runs hourly and
picks up any claims that are queued for submission and sends them to the state(s) for processing.

l "Start to Finish" Claims Management - Once a claim is submitted, the Claim Status and
SIDE Status fields on the claim record are updated as the claim progresses through SIDES
processing. For instance, if the state successfully receives the claim and has all the information it
needs to begin processing the claim, the status may change from "Queued" to "Decision
Pending". All claim statuses are tracked in ClientSpace, including any manual statuses you may set
once the integrative part of SIDES claims processing is complete.

The Claim Status field is used for general claims management regardless of whether you are
using the SIDES integration. The SIDES Status field is a "read only" field that tracks the
integrative part of SIDES claims processing only. This allows you to isolate "SIDES only" activities
when needed, such as when generating reports.

For instance, SIDES may return a final status of "Claim Answered (SIDES)" and a claimant may
choose to appeal a decision not in their favor. The process for starting an appeal is not done
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through the SIDES integration but you can continue managing the claim in ClientSpace by
manually setting a Claim Status of "On Appeal".

Access claims and view a claim's current Claim Status at-a-glance in two places:

UI Claims Dashboard - Status Column
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Unemployment Claim window - Claim Status Column

How do you use the ClientSpace SIDES Integration? What is the workflow like?

SIDES claims are processed on the UI Claims dashboard or on the Unemployment Claim dashboard of a
selected workspace. Let's review highlights of the workflow here. For detailed procedural steps, refer to
Processing SIDES Claims.
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Processing SIDES Claims

To process a new SIDES claim:

1. In the modules bar, select UI Claims.
A list of all UI Claims displays.
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OR

Open a specific workspace and go to the Unemployment Claim window to only work on
UI Claims received for that workspace.

a. From the modules bar, click Workspaces.
The Workspace Search dashboard opens.

b. Select a workspace and click (Open).
The Workspace page opens.

c. Move down the page to the administrative tiles where you see the dataform categories.
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d. Enter "Claim" in the search for dataform field and then click the Unemployment Claim tile.
The Unemployment Claim window displays.
Note: This view includes a Source column for identifying SIDES claims at-a-glance.

2. Locate a SIDES claim to process and open it.
Note: New claims have a Claim Status and SIDES Status of "Received". The Claim Status field is
used for general claims management regardless of whether you are using the SIDES integration.
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The SIDES Status field is a "read only" field that tracks the integrative part of SIDES claims
processing only. This allows you to isolate "SIDES only" activities when needed, such as when
generating reports.

Refer to Managing Unemployment Claims for additional information on searching for
claims.

3. In the Action Center, under Workflow, click Begin Processing Claim.
The Separation Information Response tab displays. The Claim Status and SIDES Status change
to Information Requested indicating that the state requires information (that you will provide on
the Separation Information Response tab).

If you need to reference a Separation Information Response SIDES field identifier, hover
your mouse pointer over the info bubble icon next to a field.

4. On the UI Claim Home tab ( ), verify the value displayed in the Employee Start Date field
located in the "Claim Data" section and manually edit the date, if necessary.

This is the date that will be used as the position start date relevant to the claim. By default,
ClientSpace sets the value in Employee Start Date using the Start Date field value from the
most recent employment record. There are instances where this may not be the correct
date. For example, if an employee was temporarily laid off for a week and the claim for that
layoff period was not processed until after they were rehired, using the Start Date of the
most recent employment record is not correct as it reflects the recent rehire date instead of
the Start Date of the position the employee was in at the time of lay off.

5. Click the Separation Information Response tab to begin completing the questionnaire, making
certain to complete the sections in the order shown so that you can complete the key fields
Preparer Type and Employer reason for separation in the Claim Details fieldset before moving
to other sections. Additionally, if you believe the claim to be fraudulent, be certain to check the
Fraudulent Claim? flag located under Preparer Type.

The responses you enter to Preparer Type and Employer reason for separation determine
which other fields and fieldsets display.

Note that in addition to displaying separation reasons, the Employer reason for separation field
also includes several dispositions for handling invalid claims:

l 20-Never Employed Here
l 21-TPA does not represent this employer
l 22-PEO does not represent this employer
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6. Continue completing the questionnaire until all required fields and relevant optional fields are
completed.

Optionally, if wage data is required, you can click Get Wages in the Action Center under
Workflow to auto-fill fields in Earnings & Schedule section from PrismHR instead of entering
this information manually. If you need to correct imported wage date OR enter wage
information manually, check the Wage Information Override flag in the Wage Information
section.

7. What do you want to do?
l Do you want to complete an additional form first, such as a Remuneration form,

before continuing with system validation of requirements (which may flag other
missing forms and required information)?

a. Click Apply to save the fields you entered on the Separation Information
Response tab and keep the claim record open.

b. In the Action Center, under Links, click Add next to the desired form.
The new form becomes the active work item in the Work Center (i.e., left pane).
The Claim record remains available in the Work Center and you can return to it
once you complete and save the additional form.

c. When all known required forms are completed, click Submit to SIDES.
Clicking Submit to SIDES starts a validation process to ensure the claim is
complete.

o If responses are valid and no additional required fields or forms are
missing, the claim is submitted and the Claim Status and SIDES Status
fields are changed to Queued, and you can proceed with step 7.

o If additional fields or forms are incomplete or there are invalid responses
(such as incorrect dates), they will be listed in an error message.
Continue with these steps before proceeding with step 7.

d. Complete or correct required fields listed in the submission error message.
e. Complete any remaining required forms listed in the submission error message.
f. Click Submit to SIDES again to submit the claim.

l Do you want to continue with system validation of requirements (which will flag
missing forms and other required information)?

a. Click Submit to SIDES.
Clicking Submit to SIDES starts a validation process to ensure the claim is
complete.

o If responses are valid and no required fields or forms are missing, the
claim is submitted, the Claim Status and SIDES Status fields are changed
to Queued, and you can proceed with step 7.
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o If fields or forms are incomplete or there are invalid responses (such as
incorrect dates), they will be listed in an error message. Continue with
these steps before proceeding with step 7.

b. Complete or correct any remaining required fields listed in the submission error
message.

c. Complete any required forms listed in the submission error message in the Action
Center. Under Links, click Add next to the desired form. The new form becomes
the active work item in the Work Center (i.e., left pane). The Claim record remains
available in the Work Center and you can return to it once you complete and save
the additional form.

d. Click Submit to SIDES again to submit the claim.
Note: 

l The scheduled process to send submitted SIDES claims, receive new SIDES claims, and
receive the state's responses to submitted claim runs every hour. Note that some states
may only upload claims once per day.

l Sometimes, when a secure connection cannot be made to the SIDES broker, SIDES claims
submitted for processing can become stuck in "Processing" status. The system
automatically resubmits claims for processing that have been stuck in "Processing" status
for more than two hours.

8. Check the UI Claims dashboard or the Unemployment Claims window of specific workspaces
often for claim statuses and determine an action (if any) based on the status.
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UI Claims Dashboard - Status Column
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Unemployment Claim window - Claim Status Column

Refer to SIDES Status Definitions to review the list of SIDES-related statuses and their meanings.

SIDES Status Definitions
Below is a list of statuses related to SIDES claims and their definitions. These statuses, except where
indicated, are used to update both the Claim Status and SIDES Status fields. The Claim Status field is
used for general claims management regardless of whether you are using the SIDES integration. The
SIDES Status field is a "read only" field that tracks the integrative part of SIDES claims processing only.
This allows you to isolate "SIDES only" activities when needed, such as when generating reports.
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Claim Status Meaning

Received Received is the initial status of a claim in the Claim Status and
SIDES Status fields when a claim is imported from SIDES into
ClientSpace for the first time.

Information
Requested

The Claim Status and SIDES Status fields automatically change from
Received to Information Requested once you click Begin
Processing Claim in the Action Center Workflow section to begin
completing the state's questionnaire. This status indicates you are in
the process of answering the claim.

Queued The Claim Status and SIDES Status fields automatically change to
Queued after you complete the questionnaire, click Submit to
SIDES and the claim passes pre-submission validation in ClientSpace.
The claim remains in Queued status until it is exported to SIDES. 

Note: The scheduled process to export submitted SIDES claims,
import new SIDES claims, and send/receive responses to submitted
claims runs every hour. Note that some states may only upload new
claims once per day.

Reply Failure
(SIDES)

Reply Failure (SIDES) is an unsuccessful status that can occur after
Queued status. This status in the Claim Status and SIDES Status
fields indicates that the claim was sent to SIDES but when SIDES tried
to accept the claim, there was a data issue or a missing requirement
that was not captured by the ClientSpace pre-submission validation
process.
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Claim Status Meaning

Processing Processing is an interim procedural status used by the ClientSpace
system only. Although it is listed in the Claim Status and
SIDES Status drop down lists, it is not a status that you assign. The
Processing status is assigned by ClientSpace to identify a claim as
already submitted to SIDES so that the scheduled process will skip
over it. This prevents duplicated submissions.

Note: Sometimes, when a secure connection cannot be made to the
SIDES broker, SIDES claims submitted for processing can become
stuck in "Processing" status. The system automatically resubmits
claims for processing that have been stuck in "Processing" status for
more than two hours.

Amending The Claim Status and SIDES Status field values automatically change
to Amending once you click the Amend the Response link to
complete an amendment requested by the state. Clicking Resubmit
to SIDES link places the claim back into Queued status in both status
fields so that the scheduled process can send the amendment to
SIDES.

Decision Pending The Decision Pending claim status is not specific to SIDES claims, but
is used for claims management, including SIDES claims management.
In relation to SIDES claims, Decision Pending is the status received
from SIDES after SIDES has received the claim and has all the
information required to make a decision on the claim. This status
often follows the Queued status (if the claim was successfully
submitted) and is reflected in both the Claim Status and
SIDES Status fields.
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Claim Status Meaning

Claim Answered
(SIDES)

Claim Answered (SIDES) is a successful status received from
SIDES indicating that the claim has been processed and the PEO has
satisfied the response. Note that this may or may not indicate a final
claim disposition. It is, however, the last automatically applied status
to the Claim Status and SIDES Status fields. For example, if a
claimant contests a decision that is not in their favor and wants to file
an appeal, you may initiate an appeal and manually change the status
from Claim Answered (SIDES) to a different status (such as On
Appeal).

On Appeal,
Determination, and
other statuses

You may see other statuses listed in the Claim Status lookup list.
These statuses are manual statuses used for general claims
management and may vary depending on your configuration. If
you manually apply one of these statuses in the Claims Status field, it
will not affect the SIDES Status field since it is only used to track the
SIDES integrative process only.

For example, as mentioned in an earlier example, you could set a
contested claim to On Appeal when a claimant files an appeal Then,
once all appeals are exhausted and the state makes a final
determination, you could set the claim status to Appeal
Determination.

Helpful Hints: State Information Data Exchange System (SIDES)
Below are some helpful hints to guide you in completing the SIDES questionnaire.

Note: Whenever a field from the SIDES questionnaire is listed, it appears in bold text with its SIDES field
identifier shown in parentheses. If you need to know an identifier while completing Separation
Information Response tab, hover your mouse pointer over the info bubble icon next to a field.

1. Remuneration forms are required if Did the claimant have remuneration?(B-74) is “Yes”. Up to
15 Remuneration forms are allowed.

2. Pension and 401K forms are required if Is/will the claimant receive a company pension/401K
disbursement?(B-210) is “Pension”, “401K” or “Pension and 401K”.

a. If the answer is “Pension”, a record with a type of “Pension” is required.
b. If the answer is “401K”, a record with a type of “401K” is required.

3. The Witnesses form is required when Were there witnesses?(B-157) is “Yes”.
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4. Prior Incidents are required if Were there prior incidents?(B-94) is “Yes”. Up to 5 Prior Incidents
forms are allowed.

5. The Failed to Report form is required if Resignation reason is “Failure to Report for
Work/Abandonment”.

6. The External Contacts form is optional and is only sent if Is/was the claimant receiving WC?(B-
201) is “Yes” or Is/will the claimant receive a company pension/401K disbursement?(B-210)
is “Pension”, “401K” or “Pension and 401K”.

7. The Previous Temp Assignments form is required if Why is the claimant not working on an
assignment?(B-195) is “Assignment completed, contact established, claimant declined new
assignment”. Up to 5 Previous Temp Assignment forms are allowed.

8. If the claimant is working a temporary assignment for a Temporary Staffing Agency, checking
Temporary staffing employer/assignment(B-246) triggers the display of additional questions
requiring a response to the state.

9. If you believe the claim is fraudulent, check Fraudulent Claim?(B-225). This triggers the display
of additional questions requiring a response to the state that you must answer along with any
other required information on the dataform.

10. Attachments may be sent by the states and added to the claim via the Action Center for you to
complete and return to the state. The state sends these forms for one of the following reasons:

Reason Explanation

Informational only (Not
Claimant or Employer
specific)

The state may request information regarding the process
that is not employer or claimant specific.

Informational only
(Claimant or Employer
specific)

The state may request information regarding the
employer or claimant that is not being captured on the
Separation Information Response tab or on other
relevant supporting forms.

Requires Action (State
Standard question set)

The state may have questions about your answers to the
standard question set. These must be reviewed and
answered.

Requires Action (Adhoc
questions added by the
state)

The state may have adhoc questions not related to the
standard question set. These must be reviewed and
answered.

Optional Fact Finding The state may have fact finding questions. These are
optional informational questions that are not required
for submitting an initial response.
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11. Is/was the claimant receiving WC?(B-201) is optional. However, if answered, it will trigger the
display of other required questions which must be answered before you can submit the claim.

12. 20, 21, and 23 should only be selected in the specific situations outlined below:

Separation
Reason

Use When...

20 The claimant was never employed by the employer.

21 The claimant’s employer is not currently represented by the TPA.
Note: This option is only available for selection when Preparer
Type(B-52) is “Third-Party Administrator”.

23 The claimant’s employer is not currently represented by the PEO.

13. The checkbox Do you want to send the employer’s contact information to the State? is
optional and only shows if Employer reason for separation(B-20) is “21-TPA does not represent
this employer” or “23-PEO does not represent the employer”. If checked, the following
information is sent to the state:

l Employer’s name (Organization Name)
l Employer Contact Name (Primary Contacts Name)
l Phone number (Organization Phone)
l Street Address (Organization Address)
l City (Organization City)
l State (Organization State)
l ZipCode (Organization ZipCode)
l Contract Termination Date (From most recent termination record that is active)

14. Selecting “99-Not providing/Refusing to provide” as Employer reason for separation (B-20) to
answer a claim is permitted. However, SIDES views this response unfavorably. You should avoid
using this code as SIDES may respond by discontinuing access to their API.

Moving a SIDES Claim
The process of moving a SIDES claim is the same as moving any UI claim in ClientSpace. The only
difference is that ClientSpace attempts to match SIDES claims to the correct workspaces for you initially.
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Therefore, in most cases, the only claims requiring a manual move to a new location are the ones that
could not be automatically matched to the correct workspace.

When ClientSpace cannot match a claim by company and SSN, the claim is listed in the Unemployment
Claim dashboard of the Client Services Department workspace. The Client Services Department
workspace is treated as a temporary holding workspace where unmatched claims reside until they are
researched. After researching an unmatched claim, workflow allows you to manually move it to the
appropriate workspace or process the unmatched claim in the Client Services Department workspace
with a relevant response, such as "Never Employed Here" or "Fraudulent Claim".

The steps to move a claim from the UI Claims dashboard are located in the Move Unemployment
Insurance Claims section of the Managing Unemployment Claims topic.

Amending a SIDES Claim
After the initial submission of a SIDES claim to the state, the state may request an amendment so that
you can provide additional information. The amendment is requested external to ClientSpace.

To amend a SIDES Claim:

1. In the Action Center, under Workflow, click the Amend the Response? link.
An Amended Response fieldset displays at the top of the page. A field containing the amended
response count auto-populates.
Note: A claim can be amended up to 9 times.

2. Complete the Description field. Enter the reason for the amended response or a brief description
of what is being changed.

3. Make any other changes as necessary.
Note: Changes can be made to fields already answered if information has changed.

4. After changes are made and ready to be submitted, click Resubmit to SIDES link to put the claim
back into Queued status. The scheduled process picks up the changes and sends them to the
state.
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Chapter 21
Security
Administering security rights is an important part of any business. The following topics will help you get
started with securing ClientSpace to match your organization's current security model.

Users Dashboard
Use the Users Dashboard to manage user profiles for users. A Global Admin can use the Users
Dashboard to:

l Search for a single user.
l Search for a group of users. You can, for instance, search for users by Department or search for a

group of users by Immediate Supervisor to locate a smaller subset of users within a department
using the More search option.

l Add or Edit user accounts.
l Manage licenses.
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l Assign a user template and assume a user profile for testing.
l Reset a user password and unlock a user.

The following graphic illustrates the Users dashboard.

Related Topics:

l Viewing the User Audit Trail
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Adding and Editing User Accounts
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Chapter 22
Multi-tenant Environments in ClientSpace
ClientSpace supports multi-tenant environments whereby an install has multiple Prism
API configurations and where the Client Number may not be unique across Prism database instances.

Note: Contact ClientSpace Professional Services to implement multi-tenancy configuration. Do NOT
try to implement this feature without ClientSpace Professional Services. Attempting to implement
this feature on your own can lead to major problems with ongoing imports.

Where is multi-tenancy enabled?
Multi-tenancy is enabled in System Admin > Administrative Data > PEO Configuration by setting
the Use Multi-tenancy field database. There are other requirements that must be set up by
Professional Services.

How multi-tenant API feeds work
Importing

ClientSpace imports data from multiple PrismHR databases into the appropriate workspaces by
combining the PEO ID and the Client Number values into an Import ID on the Client Master record.
The ImportID follows the format PEOID::ClientNumber (for example, PEOSolutions::165 signifies the
PrismHR database installation for PEO Solutions and Client Number 165 from that database).
ClientSpace uses this ImportID format to ensure that the system imports client data to the correct
workspace when importing the data from multiple PrismHR databases.

Additionally, you can control whether a new workspace is automatically created from an import file for
each PrismHR API feed individually using a CanCreateWorkspaces API parameter in PrismHR API
import map detail settings (System Admin > Advanced > API Configuration). See the Additional
Parameters section of Ongoing Imports: Configuring the API for Import Map Details for more details.
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Exporting

Client data can be exported from the Client Master record in ClientSpace to PrismHR in multi-tenant
environments. When Export Client to Prism is clicked on the Client Master to export the client data,
the PEO ID on the Client Master and the Secondary ID on the API Config forms are used to determine
the correct Prism instance. The two field values must match.

Note: There is error handling to check for a missing PEO ID or an invalid PEO ID (whereby the PEO ID
on the Client Master does not match the Secondary ID on the API Configuration.)

l If the PEO ID is missing, the following error message displays: "Your export cannot be
completed without a PEOID. Add the correct PEOID on the Client Master so we know where to
export this."

l If the PEO ID is invalid, the following error message displays: "The PEOID '{PEOID}' on this
client's Client Master is invalid. Please correct the PEOID on the Client Master before trying to
export this again."

How multi-tenant business rules are applied
The ClientSpace business rules engine contains a Workspace Templates field in the Manage Rules
configuration to support multi-tenancy:

This field allows you to configure rules to only be triggered when the executing dataform was created
from one of the selected workspace templates. If no specific template(s) are selected, the Workspace
Templates field will default to "All Templates".

Client Master Import ID Validation
Two of the business rules, SE_ValidateClientNumberChange (soft error validation) and HE_
ValidateClientNumberChange (hard error validation), are used in both multi-tenant and single-tenant
environments to validate a change to the Client Number. In a multi-tenant environment, these rules
also trigger when a change is made to the PEO ID since PEO ID is a component of the Import ID. In a
multi-tenant environment, changes to either the PEO ID or the Client Number could cause client data
imports to stop working.

Note: Both rules also require the Client Master status to be Client, Pending Termination or Terminated
for triggering to occur.
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If you are using Soft Error validation ( SE_ValidateClientNumberChange) with Use Multi-Tenancy
enabled, the following messages are used when a user changes the PEO ID, the Client Number or
both the Client Number and PEO ID, respectively:
l "Changing the PEO ID will cause the Import ID's and Employee Identifiers to be regenerated,

which could affect imported data. Are you sure you want to continue?"
l "Changing the Client Number will cause the Import ID's and Employee Identifiers to be

regenerated, which could affect imported data. Are you sure you want to continue?"
l "Changing the Client Number or PEO ID will cause the Import ID's and Employee Identifiers to be

regenerated, which could affect imported data. Are you sure you want to continue?"

If you are using Hard Error validation (HE_ValidateClientNumberChange) with Use Multi-Tenancy
enabled, the following messages are used when a user changes the PEO ID, the Client Number or
both the Client Number and PEO ID, respectively:
l "The PEO ID cannot be changed after the Status is set to Client."
l "The Client Number cannot be changed after the Status is set to Client."
l "The Client Number or the PEO ID cannot be changed after the Status is set to Client."

Organization ID Updates
The SetOrgImportID rule writes the PEO ID and Client Number field values from the Client Master
record to the Organization Details record Import ID field in the same format used on the Client Master
record: PEOID::ClientNumber.

See an example in the image below:
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The rule is triggered when:

l The Client Number and PEO ID on the Client Master record are populated (i.e., not empty).
l A change occurs (i.e., an "Is Dirty" condition exists) on Client Number and/or PEO ID on the

Client Master record.
Note: 
l If the status of the Client Master record is Client, Pending Termination or Terminated and the HE_

ValidateClientNumberChange business rule is Active, hard error validation will trigger when
changes are made to the PEO ID or Client Number in multi-tenant environments and prevent
updates from being saved to the PEO ID or Client Number. If this happens, the
SetOrgImportID rule cannot trigger.

l Though the SetOrgImportID rule was created for multi-tenant sites, enabling Use Multi-
Tenancy (System Admin > Administrative Data > PEO Configuration) is not required for
the rule to work.

Benefits Batch, Benefit Group, and Employee Benefits Detail Import
ID Updates
To support the benefit renewal process in multi-tenant environments, business rules are configured to
use the SetImportID business rule method to set the Import ID on the Benefits Batch, Benefits Group,

ClientSpace Setup & Administration © 2025 PrismHR 1005

Chapter 22 Multi-tenant Environments in ClientSpace



and Employee Benefits Detail dataforms.

For the Benefits Batch form:
l The rule is triggered when Client Master Import ID, Benefits Batch Effective Date and Benefit

Batch Type are not empty and the Benefits Batch Effective Date or Benefit Batch Type is
updated.

l If any of the required values are empty, the Import ID field is empty.
l The Import ID is created by combining the Client Master Import ID, Benefits Batch Effective

Date and Benefit Batch Type values.
l The ImportID follows the format {ClientMaster.ImportID}- {BenefitBatch.EffectiveDate} -

{BenefitBatch.luType}.

Example: PEOSolutions::165-20240101-RFP where PEOSolutions::165 signifies the
Client Master Import ID, 20240101 signifies Benefits Batch Effective Date and RFP signifies the
Benefits Batch Type.

For the Benefit Group form:
l The rule is triggered when Client Master Import ID and Benefit Groups Group Code are not

empty and either of these fields is updated.
l If any of the required values are empty, the Import ID field is empty.
l The Import ID is created by combining the Client Master Import ID and Group Code values.
l The ImportID follows the format {ClientMaster.ImportID}-

{OfferedPlanClassification.ClassificationCode}.

Note: The OfferedPlanClassification.ClassificationCode is the Group Code on the Benefit Groups
form.

Example: PEOSolutions::165-Main where PEOSolutions::165 signifies the Client Master Import
ID and Main signifies the Group Code value from the Benefit Groups form.

For the Employee Benefit Detail form:

l The rule is triggered when Client Master Import ID and Employee Identifier are not empty and
the Plan ID, Effective Date, IsActive checkbox, Employee ID or Client Master Import ID is
updated.

l If any of the required values are empty, the Import ID field is empty.
l The Import ID is created by combining the Client Master Import ID, Employee Identifier, Plan

ID and Effective Date values.
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l The ImportID follows the format {ClientMaster.ImportID}- {Employee Identifier} - {Plan ID} -
{Effective Date}.

Example: PEOSolutions::165-D456477-645-20240423 where PEOSolutions::165 signifies the
Client Master Import ID, D456477 signifies the Employee Identifier from the Employee record,
645 signifies the Plan ID from the Employee Benefits Detail form and 20240423 signifies the
Effective Date from the Employee Benefits Detail form.

How the PrismHR link works
When you click the PrismHR link on the Workspace Landing page to connect to PrismHR, ClientSpace
uses the PEOID field value from the workspace's Client Master dataform to identify the correct PrismHR
instance to log into.

How searching for clients works in a multi-tenant
environment
Since the Client Number will not always be unique across the PrismHR databases in a multi-tenant
environment. The PEO ID serves as a secondary ID that you can use to filter by on the following module
dashboards:

l Cases
l Clients
l Employees
l WC Claims
l UI Claims
l Benefits Batch Search

Note: Even if the PEO ID is not unique, a search that includes the PEO ID may help to narrow your
results.

The PEO ID field in the More search of these dashboards is a Text datatype field. You must type the
entire PEO ID when filtering. The search requires an exact match to return results.

You can also add the PEO ID column to these dashboards. By default, the PEO ID column is hidden.
Add it by clicking the vertical three dot (i.e., Kebab) icon on any column heading and selecting PEO
ID on the Columns list:
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How the Email Integration feature works in a multi-tenant
environment
Email integration processes an external email account and creates a Client Service Case (dataform). Part
of this process requires ClientSpace to determine the correct workspace for case creation. In a single-
tenant environment, the body of an email is searched for the CLID (Client Number) token, and if
found, the business object is called to interpret the CLID and return the appropriate workspace
ID++++.

In multi-tenant environments, the CLID includes both the Client Number and the PEO ID from the
Client Master record of a workspace in the following format:

PEOID::ClientNumber

Note that this is the same formatting convention of the workspace Import ID used to import data from
multiple PrismHR databases into the appropriate workspaces. Just as with an Import ID, including both
the Client Number and the PEO ID in the CLID ensures that the correct workspace in the correct Prism
database instance is identified. Also see Email Integration Processing.

Chapter 22
Configuring Custom Help Links

What Are Help Links?

Anywhere you see a white circle with a question mark , it indicates the availability of Help.

• When accessed from the Work Center, ClientSpace Help Center opens.
• When accessed from a dataform, it opens a list of Help links that are specific to the form from which

they are accessed.
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You can also use the general search function located at the top of the list of links if the topic you
need is not listed.

Pre-set links can take the form of:

l Help topics
l Videos
l Call outs

When you click a link, topics and videos display in the ClientSpace Help Center on a separate tab of
your browser:
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If the link is to a callout, it displays on the dataform you are viewing. These are typically used to describe
how a single field is used. The field being "called out" is highlighted while the other dataform fields are
temporarily dimmed and inaccessible until you close the box:
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What Are Custom Help Links?
Help links can be a combination of preset Help links that were already configured for you in ClientSpace
when it was installed and custom Help links that you define. You must be a Global Administrator to
configure custom Help links. The custom Help link can be a URL to an article, video, or guide.

When you configure the custom Help link, you can apply settings such as when you want the link to
become available, an "expiration date" for a link (if applicable) and which department(s) have access to
the link.

Configuring Custom Help Links

To configure custom help links:
1. Click your username in the top right corner of the ClientSpace window. EX: developer
2. Click System Admin .

The System Administration dashboard opens.

3. Click Help Links.
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The search view for all Help links in the ClientSpace system displays.

4. Click Add to add a new Help Link.
5. Complete the fields as appropriate. Required fields display in red text, preceded by an asterisk.

Target Type Select the form (i.e., Case History, Client Master, etc.) where you want the link to
display from the drop down list.

Sort Order Prioritize where the item displays in the list of other Help links. The higher the
number, the lower it is on the list.

Note: Leave the field set to 0 to sort in alphabetical order.

Link Text Type the name of the Help link. This is what displays in the list of Help links.

Detail Type the URL of the link.

Type Select the type of Help link: Article, Video, or Guide.

Category Unused field.

Publish Date The date you want the Help link to begin displaying. By default, the field auto-fills
when the current date and time but you can edit the field.
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Expiration Date The date you want the Help link to stop displaying. The link will not be visible on
or after the date you enter. Leave the field blank if the link should never expire.

Active By default, the Active checkbox is checked. Remove the check mark to make the
Help link InActive. InActive links are no longer displayed in the list of Help links.

Department(s) To restrict which users see the Help link, click in the field to display the list of
departments and select a department. To select multiple departments, repeat the
action of clicking in the field and selecting a department until all desired
selections are displayed in the Department(s) field.

6. Click Apply or Save.
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Chapter 23
Troubleshooting
Got a problem? Find step-by-step instructions on resolving specific ClientSpace issues here.

This chapter includes issue resolution topics for:

• Application troubleshooting
• Administration troubleshooting
• Outlook add-in and modules issues

Application troubleshooting
Application issues occur during normal use, sometimes the error codes are helpful, sometimes not, but
if you have the code, try using the error info in the search box. The following documented errors
comprise a list of troubleshooting tips.

"Invalid Cast Exception" when using Business Intelligence

Problem: You run a report that has an embedded drill down link and when you click the link an error is
thrown: "Invalid cast exception - an error has occurred while processing this request".

Cause: Column additions in the middle of the report have caused the drill down link to break as the
referenced column has been moved.

Solution: Adding a column to the middle of a report with drill downs will shift the column count below
the new column by one. This can be corrected by either:

• Move the new column to the end of the report.
• Update your embedded drill down links to account for the new column.
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"You are not authorized to view this page" on Pricing Console

Problem: You attempt to access the ClientSpace pricing console and you receive the error "You are not
authorized to view this page".

Cause: You do not have sufficient security rights to add/edit one of the Pricing Console associated
functions or dataforms (Client Master, Pricing Batch, State or Code).

Solution: Update the Role security to include appropriate rights to View/Add/Edit the forms using the
following steps. There are several security entities in use by the Pricing Console. The most common are:

• CRM - creating and managing Organizations - At least View rights
• biz_workflow_cm_create_batch - creating batches from the Client Master - At least Add Rights to

create new batch
• PricingConsole - access to the pricing console - At least View rights
• QuickEdit - At least Add rights

• QuickEdit_subfields - for each field on the Quick Edit form there are available view/Add/Edit
rights, these will need to be set for each field (if editing of pricing rows is allowed)

At least View rights are also required for the related Dataform entities such as:

• gen_PricingBatch
• gen_Pricing
• gen_PricingBatchState
• gen_PricingCompCode
• gen_ClientMaster
If any of the dataforms are secured the user will need to be in a role with appropriate rights for the
dataform, such as Add or Edit rights.

See Administering role security.
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Pricing Console errors

Problem: You attempt to open the pricing console and receive SQL errors relating to Arithmetic
Overflow.

Cause: Field value is not properly set or way outside normal parameters. Something such as the Admin
% field being set to 150000%. Downstream calculations that use this number will fail.

Solution: Fix erroneous data

1. Find the erroneous field on one of the Pricing Forms - either Batch, State, or Code.
2. Because you cannot access these forms through the Pricing Console, you need to go to the

Workspace in question and Access Dataforms from the Workspace Action Menu.
3. Navigate to the forms in question, find the offending field, and correct the value.

Dataform save error: "Object reference not set to an instance of an object..."

Problem: You attempt to add a new field to a dataform and receive the error "Whoops - something
went wrong..." When you check the exception logs you find the slightly more detailed error: "Object
reference not set to an instance of an object. URL: http://yourinstall.clientspace.net/Next/Admin
/ProjectAttribute/Detail" the system will not allow you to save the field.

Cause: You have attempted to use a field name that is already in use on the dataform. This could be a
system generated field, such as CreateDate, UpdateDate, CreatedByUserID, UpdatedByUserID, etc. SQL
will not allow you to create two columns on the same table with exactly the same name, hence the
error.

Solution: Change the field name and re-save. Avoid using any of the names for the existing fields on
the dataform, or any of the system protected fields. If you are unsure of the preexisting field names, you
should run the Dataform Specification report to get a list of all the current dataform field names.

Error when editing field information: "Incorrect syntax near ',' "

Problem: When trying to edit the Field configuration on a dataform, the following error appears:

Incorrect syntax near ','.
Incorrect syntax near the keyword 'with'. If this statement is a common table
expression, an xmlnamespaces clause or a change tracking context clause, the
previous statement must be terminated with a semicolon.

Cause: A lookup field does not have a Lookup Group defined and is being set as a Multiform Column.
The lookup group is used to decode the column for the list, so the system effectively doesn't know how
to decode the column.

Solution: Open the Lookup field that is defined as a Multiform Column and add a Lookup Group. See
Configuring lookups.
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Error when running PDF Merge: "Rebuild failed: trailer not found"

Problem: You attempt to run a merge to PDF and when the PDF opens, fields are not being displayed
properly and some of the data is missing. When you check the exception logs, you find the error:
"Rebuild failed: trailer not found.; Original message: Error reading string at file pointer #######"

Cause: Adobe Acrobat reader is not installed on the machine or is corrupted. The PDF is attempting to
open in your default web browser but cannot be read properly by the browser.

Solution: Install / reinstall Adobe Acrobat Reader. See instructions at Adobe.com:
https://acrobat.adobe.com/us/en/products/pdf-reader.html

Error: "Column headers have not been defined for this dataform."

Problem: You are creating a new multiform in the application and when you attempt to review the
form on a workspace you receive the error: Column header has not been defined for this dataform or
this dataform has been incorrectly defined as a One to Many relationship. Go to the Dataform Admin
section under System Admin to set up column headers.

Cause: Multiform list has not been defined.

Solution: See Defining dataform multiform list column headers.

Error: "Failed to save dashboard: Category\DashboardName"

Problem: You are attempting to edit a dashboard embedded Report Title or Description and you
receive the error "Error Failed to save dashboard: CategoryName\DashboardName"

Cause: Neither the Title nor description on Reports from the dashboard UI accepts special characters,
including numeric characters such as equals signs.

Solution: Change your Description or title so that it does not contain a special character.
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Error: 'The OpenDataSource Method or Property Is Not Available'

Problem: When trying to run a merge, the error message, “The OpenDataSource Method or property is
not available because this command is not available for reading” appears. The merge document opens,
however, it returns no data.

Cause: Microsoft Word 2013 defaults to open a document in read only mode. The data cannot be
written into the merge because Word does not allow editing in read only mode.

Solution: Change default settings in Word.

1. Open a Word document.
2. Open Word options from the File toolbar.
3. On the bottom of the General tab clear the option Open e-mail attachments and other

uneditable files in reading view. This prevents Word from opening in read-only view, therefore
the data will merge.

Exception log error: "The Condition Expression cannot contain one of the SQL keywords: DELETE,
SELECT, DROP, etc. Link Configuration ID: ###"

Problem: Exception log contains the error: "The Condition Expression cannot contain one of the SQL
keywords: DELETE, SELECT, DROP, UPDATE, EXEC, EXECUTE, INSERT, ALTER or CREATE. Link
Configuration ID: ###"

Cause: Link Display condition is configured with SQL Protected Word. The underlying code has been
designed to eliminate the possibility of SQL Injection, and so will throw an error if any of the words
DELETE, SELECT, DROP, UPDATE, EXEC, EXECUTE, INSERT, ALTER or CREATE are used when configuring
Link Condition Expressions.

Solution: Edit the Link Display Configuration conditions to remove the SQL Protected word. Also
remove the Protected word from the Condition Expression line so it matches the Display Configuration
labels.

Both the Label and the Condition expression should avoid using the word SELECT.
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File Attach/Upload error: "You may not upload files with an extension of .XXXX."

Problem: Attempting to upload a file to ClientSpace either through dataform attachment or Email
integration and you receive the following message: "ClientSpace.Business.pwInvalidFileExtension: You
may not upload files with an extension of .XXXX. Contact the system administrator to request a change
to the accepted file types or zip the file before uploading." (replacing .XXXX with the invalid file
extension).

Cause: The File type you are attempting to upload has not been added to the list of Valid File
Attachment Extensions. For example, the system allows .jpg files, but not .jpeg files.

Solution: Add the file extension to the Lookup group for ValidAttachExt, which will allow the file to be
uploaded.

1. Go to System Admin > Lookups.
2. Click Add.
3. In Group, select ValidAttachExt.
4. In Code, enter the file extension with no periods (Example: jpg).
5. In Decode, copy and paste the Code value.
6. Save the record.
7. Try to upload your file again.

Import error: "Server Error accessing the file - Import failed."

Problem: Attempting to upload a file using System Admin > Imports > Manage Import and you
receive the error "Server Error accessing the file - Import failed."

Cause: Improper Source File configuration on the import config that conflicts with an existing import.
For example, creating an import config with a source file of EmployeeConversion*.csv when an
employee*.csv import already exists.

Solution: Alter the Source File name in the Import Configuration to make it unique. Alter the name of
the file being uploaded to match the new Source File value.
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Import file macro error: "The path you selected may be bad"

Problem: You are attempting to create a CSV file for import into ClientSpace using the
CreateClientSpaceCSV macro. When you attempt to save the file, you get a message "Error: The path
you selected may be bad"

Cause: Some part of the save path you have chosen is missing or incorrect.

Solution: Correct the save path you are using. Some solutions for this are:

• You are attempting to save to a directory that does not exist: Create the directory first as the
Macro save will not give you the option to create the directory as part of the Save function like
Windows does.

• You have not provided a file name for the CSV file: You may be using an older version of this
macro. The latest version attached to KnowledgeSpace should generate the file name based on the
Worksheet Tab Name. If it doe not, simply append a file name to the path you are using for save,
making sure to use the correct .csv file extension.

Merge error: "Call was rejected by the callee"

Problem: You are running a merge and when the system attempts to open the Office document,
instead of opening Office you receive the error: "Call was rejected by the callee"

Cause: An instance of that merge is already open - likely with some kind of system prompt.

Solution: Sometimes when opening merges rapidly you will open a copy of the merge document,
attempt to close it and then re-open the merge again. When this happens, it is not uncommon to miss
the system prompt for "Would you like to save changes to document XXXXX?" These save prompts will
block other instances of office from opening. You may also receive this if an instance of the office
application is hung in the background.

1. Check to see if the office application is open and prompting you to save changes.
2. If so, save or cancel and close the currently open document.
3. If Office does not appear open, check the task manager to see if the application is not responding.

• Right click the task bar at the bottom of your screen in Windows and select Task Manager.
• Look for an instance of the Office application such as Word or Excel.
• If you find an instance of the application that does not appear to be open on your desktop, in

Task Manager, right-click the application and choose End Task.
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Merge formula issues

Problem: When you open an Excel merge you receive an error such as "Excel completed file level
validation and repair. Some parts of this workbook may have been replaced or discarded. Removed
Records: Formula from /xl/calcChain.xml part (Calculation properties)"

Cause: Repeating row data above a formula in the workbook has caused the cell references in a formula
to become broken.

Solution: Update the template document to move all of your calculations above the repeating row data
on the worksheet. If you need this data presented below the repeating row information, hide the fields
at the top of the workbook and point to these fields using cell references below the repeating row data.

Merge links produce error: "Object doesn't support this property or method code: 0"

Problem: PDF Merge Links no longer work - Get an error when clicking link "An error has occurred in
the script on the Page Line 88 Char 9 Error: Object doesn't support this property or method code: 0 Do
you want to continue running scripts on this page? Yes or No."

Cause: Pop-up blocker settings interfere with merge document opening.

Solution:

1. In your browser pop up blocking settings, add the domain name for your ClientSpace installation,
such as *.clientspace.net

2. Click Save.

nwDataInvalidKey error

Problem: You are logged in and working in the system, then when you move to another part of the
application you receive the error 'Error: nwDataInvalidKey - System Error'.

Cause: Browser has for some reason dropped the session and is no longer logged in.

Solution:

1. Close all browser windows and log back in.
2. Or in the browser, go to File > New Session and create a new session.
3. Then log back in through the new session and close the old.
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Pricing error: "An error occurred executing the business rule: RecalculatePricing"

Problem: Attempt to save pricing and receive the error "An error occurred executing the business rule:
RecalculatePricing. The ClientSpace Exception Log will contain more details about this error." This often
occurs when attempting to open the Pricing Console. Checking the exception logs reveals something
like "System.Data.SqlClient.SqlException (0x80131904): Arithmetic overflow error converting money to
data type numeric."

Cause: One of the fields that is used in the pricing calculation has an invalid amount entered (too large).
During pricing these fields are used in calculation and when multiplied by other fields can result in a
value that cannot be represented by the system.

Solution: Correct the bad value and save the record.

1. Review each of the pricing dataforms (Pricing Batch, State, and Code) by opening Workspace >
Action Center > Dataforms for the workspace in question to open a list of dataforms in the
workspace.

2. Look for overtly large numbers stored in one of the form fields, such as 3000% in a mod field, or
1870000 in the employee count field.

3. Adjust the number to the actual (correct) number and save the record.
4. Try to open the pricing console again.

pwPermissionViolation when accessing linked dataform

Problem: You attempt to access a linked form from a dataform and despite having role access to the
linked form you receive the error "Error: pwPermissionViolation - Permission Denied"

Cause: Some dataforms are not stored at the client workspace level, but instead centrally stored on the
Admin Workspace, or another workspace such as the Sales Team workspace. If the user in question
does not have access to the central workspace, they will receive a permissions error.

Solution: Provide access to the workspace where the form is stored.

1. Go to Admin Workspace.
1. Select the workspace in question.
2. In the Action Center, select Users .
3. Click Add to add new users to the workspace.
4. In Add Workspace Users, select the required users from the list.
5. Click Ok.
6. The new user is added to the list.
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System exception: 'Out of Memory' error

Problem: You are unable to access different parts of the Application - most commonly the Client
Workspaces. Application throws the error: 'System Exception: Out of Memory Error'

Cause: Possible server drive space issues. This sometimes happen if large log files or temp files were
auto-generated by a server application.

Solution: Contact PrismHR:

1. Login to the Extranet.
2. Log an Extranet case. Provide as much detail as you can about how to replicate the issue.

The UPDATE statement conflicted with the FOREIGN KEY constraint "FK_gen_CompClaim_gen_
AdminWorkersCompPolicy".

Problem: During a loss runs import the import log contains a generic "A business logic error was
encountered for line...check the exception log ..."

Cause: The Comp Claim system in ClientSpace validates the information necessary to complete claim
logging. One of these data items is the associated Workers' Comp Policy. The rule called by the comp
policy import preprocess is HE_VerifyCompPolicyIsLocated. If you do not enable this rule on the
Imports pipeline, the system allows the comp claim dataform save to happen without a verified
fkAdminWorkersCompPolicyID. Subsequently the foreign key relationship that is expected later in the
save process does not exist.

Solution: If you are importing claim information you must enable the HE_VerifyCompPolicyIsLocated
rule on the Imports pipeline. This unfortunately causes imported records without a valid
fkAdminWorkersCompPolicyID to fail.
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Unable to open Pricing Console on Workspace. "System Error - An error occurred while attempting to
process your request"

Problem: Attempting to open the pricing console on a particular Client Workspace fails with the Error:
"System Error - An error occurred while attempting to process your request. If the error persists, please
contact the system administrator." Checking the Exception logs under Admin Settings may reveal some
form of Mathematical overrun error.

Cause: On open, the pricing console recalculates pricing, using the values stored on the Pricing Batch,
Pricing State, and Pricing Codes dataforms, as well as defaults stored in various places throughout the
system The most common issue responsible for this type of issue is bad data on one of the pricing
dataforms, causing the pricing calculations to far exceed the limits of the fields in which the calculated
values will be stored. Accidentally typing a large number of Employees on a pricing code form, or an
extremely large percentage on a pricing modifier field will cause the type of mathematical overrun error
in question.

Solution: Correct the bad data using the following steps:

1. Go to Workspaces.
2. Locate and open the workspace in question.
3. In the Action Center, from the menu, select Dataforms.
4. In Workspace Dataforms, search to find the Pricing Dataforms.
5. Open the dataform.
6. Carefully examine each of the pricing dataforms and find the offending bit of bad data, 1,000,000

employees on a pricing code, or a 3000% modifier would cause these types of issues.
7. Correct the bad data and Save the form.
8. Check the Pricing Console again.

Error: "New mask conflicts with existing data. Contact the system administrator for further assistance."

Problem: You are editing an existing dataform field that uses the decimal or percent datatype and you
attempt to alter the mask value. Upon save you receive a message stating: "New mask conflicts with
existing data. Contact the system administrator for further assistance." The record will not save.

Cause: The system allows the precision (numbers to the right of the decimal) of a mask to be changed
when data has been saved into a decimal or percentage field, but the numbers to the left of the decimal
point cannot be altered without significantly changing the value of the data stored in the field. For this
reason, these types of changes are not allowed.

Solution: To adjust a decimal or percent field to alter the values left of the decimal, you must delete the
field and recreate it on the form. Doing so deletes all the data stored within the field, so this action
should not be undertaken lightly. If you have questions about the effects of deleting a field on your
data or need assistance creating a solution, log an Extranet case.
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Client stuck in Pending Termination

Problem: You have a client workspace that is in Pending Termination status and the status is not
getting changed to Terminated by the scheduled process. The TerminatePending scheduled process
normally compares the run date of the scheduled process and the Termination date on the Term form
and any client where the termination date is equal to or lesser than the date of the scheduled process,
and the Status is Pending Termination, the status is changed to Terminated.

Cause: Termination form Termination Date is set to a future date.

Solution: Update Termination Date and manually queue the terminate process.

1. Open the termination form on the client workspace and correct the date to today's date or earlier.
2. Go to System Admin > Advanced > Scheduled Processes.
3. Manually queue the TerminatePending scheduled process to term the client workspace.
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Application Error: "An error has occurred on this page - please notify support if this error persists."

Problem: You are moving from tab to tab on an Email Template and the error message above displays.

Cause: Compatibility issue with LastPass Chrome Extension.

Solution 1: Adjust Chrome Extension Settings.

Note: This solution is recommended as it always works to correct the issue by preventing the extension
from running on the ClientSpace site. As an added bonus, ClientSpace input fields will no longer have a
LastPass icon displayed in them.

1. In Chrome, click the Extensions icon.

2. Select Manage Extensions.

The Extensions page opens to the My Extensions tab.

3. Click the Details button on the LastPass: Free Password Manager tile.
4. Scroll down to the Site Access section and change the value in the Allow this extension to read

and change all your data on websites you visitfield to On Click.

Solution 2: Adjust LastPass Options.

Note: This solution may not work every time. If a user clicks rapidly through Email Template tabs, the
error may still occur. Additionally, while LastPass does have a Never URLs option, it will not disable the
extension. Therefore, the error may still occur and all input fields will still display a LastPass icon.

1. In LastPass, select Options > Advanced.
2. Enable the Respect AutoComplete=off: allow websites to disable Autofill check box.

Administration troubleshooting
Administering an application can have its challenges. Are you experiencing challenges? Try using the
following solutions to overcome those obstacles.
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"The request failed with the error message: Object moved" Error when running merge

Problem: You attempt to run a merge and you receive the error: "The request failed with the error
message: Object moved"

Cause: The Merge template document is no longer attached to the merge under Merge Admin.

Solution: Update the Merge Configuration with a Template Document.

1. Go to System Admin > Outputs > Merges.
The Merge Admin dashboard opens.

2. From the list, select the merge in question and click Edit.
The Merge Admin Detail form opens.

3. In Template File, click (upload) and browse to the appropriate document.
4. Save your changes.

Allow Import option is cleared on Organization

Problem: The allow import option on the Organization record appears to be cleared somehow and
nobody seems to know who is clearing it.

Cause: The system automatically clears this option when the Create Prospect link is selected in the
header of the Organization.

Solution: Log an Extranet case.

Activity search is missing salesperson’s activities

Problem: The Activity Search page on the Org is not displaying the Salespersons calendar events. If you
log in as a global admin, the activities appear correctly.

Cause: Salesperson does not have access to the designated Sales workspace. Activities such as Tasks,
Notes, and Calendar events need to be attached to a workspace. Before you select the Generate Quote
link, a workspace has not been generated for the Organization, so any activity is attached to the default
Sales Workspace set under System Admin > App Settings > Default Workspaces. If the salesperson
in question is not set as a user of that workspace, the activities do not appear for them.

Solution: Add the Salesperson to the default Sales Workspace.

1. Find the default sales workspace by navigating to System Admin > Advanced > App Settings.
2. Go to Workspaces and open a workspace.
3. In the Action Center, in the menu, select Users.
4. Click Add and select the user from the list then click Ok.

This action adds the salesperson as a valid user of this workspace.
5. Verify that the user can now see their Activities.
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All Dataform fields disabled on an Active dataform

Problem: When opening a dataform, the form is marked as Active, but all the fields on the form are
disabled. The form may or may not be secured.

Cause: The client workspace has been marked Inactive, so all associated forms are also inactive.

Solution: Re-Activate the workspace.

1. First, determine with the client if they want the Workspace to be marked as inactive. There are valid
business reasons for this.

2. If this is not the case, go to the Client workspace in question.
3. In the Action Center menu, select Settings.
4. Select the Active option.
5. Click Save.
This action re-activates the workspace and all associated dataforms.
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Calculated Commissions missing from Pricing Console Profit Matrix

Problem: When we enter a Commission Detail record on a Client workspace, the System does not show
the calculated commission amount in the Pricing Console Profit pop-up matrix.

Cause: Misconfiguration of Sales Entity record causes Commission effective date to be set incorrectly.

Solution: Correct the Sales Entity configuration and manually change commission record date for all
auto-generated records.

1. Go to Admin Workspace > Sales > Sales Entity.
The Sales Entity dashboard opens.

2. Open the Sales Entity record in question and look at the Commission information recorded:

3. Sales Entity records allow you to set up to 3 tiers of commissions for each sales entity. In the
example above the Sales Entity has two tiers or periods configured.

4. The first period starts the first year (1) of the Client's Contract Effective date and calculates
commission based on 4.5% of Admin on the Client.
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5. The second period starts in the 3rd year (3) of the Client's contract and calculates commission based
on 2.0% of Profit on the Client.

6. So, if the Client's contract effective date was March 1, 2014, the Salesperson would be paid 4.5% of
the admin fee starting March 1, 2014, and running through February 28, 2016, then starting in the
third year of the contract (March 1, 2016)

7. The salesperson would be paid 2.0% of the Admin collected from the client.**
After correcting the Sales Entity record you will need to fix the Sales commission detail records for each
affected workspace.

1. Go to the workspace in question and open the Commission detail records for the affected Sales
user or Agent.

2. Update the Effective Date field on the Commission record to the appropriate value. This effective
date is calculated on Workspace creation using the Contract Effective Date and the Start Year
information configured above on the Sales Entity record.

3. Save the commission detail record(s) and review the Profit Matrix on the client again to ensure
commissions are being calculated properly.

Information about Sales Entity Configuration can be found by reviewing the contextual help text. On
any dataform, point to the field label and if the label changes color, then there is related help text to be
found by clicking the label.

Cannot Login or Assume an external user

Problem: A user cannot login and as a Global Admin you are unable to assume the external user.

Cause: The external user account is linked to a template workspace.

Solution

1. Go to System Admin > Users.
2. Search for the user.
3. Change the Default Workspace to that user's company workspace.
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Cause, nature of injury, or body part missing on Workers' Comp Claim

Problem: The cause, nature, or body part drop-down list is not appearing when filling out a Workers'
Compensation Claim.

Cause: The metadata form for each of those fields is not configured.

Solution: The metadata form needs to be set on the Lookup Group detail.

1. Go to System Admin > Lookups.
The Lookups dashboard opens. The lookup groups that correspond with the three lookup fields are
AccidentCause, TypeofInjury, and InjuredArea.

2. Locate a lookup group and click Edit.
Use the % quick search to quickly locate each one.
The Lookup Details form opens. The following example shows the Lookup Details for
AccidentCause.
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3. In the Action Center, click Open Metadata.
The metadata form opens.

4. For the lookup group in question, select a value.
5. Click Save.
6. Repeat the procedure for each group: AccidentCause, TypeofInjury, and InjuredArea.
After the metadata is configured, each individual drop-down value in the detail fields can be configured
to show or hide based on the selected Category field.

Certificates of Insurance are not being emailed properly

Problem: A ClientSpace user completes and authorizes a Certificate of Insurance, and an email is sent
to the Certificate Holder appropriately, but the person who authorized the Cert will sometimes not
receive the email.

Cause: The system is designed to automatically email the Certificate Holder and the person who
created the certificate, not the person who accepts or authorizes the certificate. If these are the same
person, they will receive the email, but if the certificate is created by person #1 and accepted /
authorized by person #2, only person #1 will receive the email.

Solution: If you are authorizing a cert and were not the creator of the cert:

1. In the Action Center, click Subscribers.
2. Add yourself to the notification list on the cert manually.

Client stuck in Pending Termination status

Problem: Customer has a client workspace that is in Pending Termination status and the status is not
getting changed to Terminated by the scheduled process. The TerminatePending scheduled process
normally compares the run date of the scheduled process and the Termination date on the Term form
and any Client where the Termination date is equal to or lesser than the date of the scheduled process,
and the Status is Pending Termination, the status is changed to Terminated.

Cause: Scheduled process has not run.

Solution: Manually run the scheduled process.

1. Check the scheduled process by going to System Admin > Advanced > Scheduled Processes.
The Scheduled Processes Admin list is displayed.

2. From the list, look for Terminate Pending.
3. Make sure it is scheduled properly, specifically look at the next run date. The scheduled process is

typically set to run hourly at least every weekday and the next run date should be today.
4. If the Next Run Date is set to a future date, change it to today and manually run the scheduled

process.
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Commissions not included in gross profit calculations

Problem: Salesperson commissions are not included in Gross Profit Calculations.

Cause: Effective Date of the Commission record is set to a future date, so it is not included in pricing
calculations.

Solution: Either add a current commission record or edit an existing record to make the effective date
less than or equal to the current date.

1. From the modules bar, select Admin Workspace.
The Admin Workspace tiles display.

2. Select Sales Entity.
The Sales Entity dashboard opens.

3. From the list, select the salesperson in question and click Edit.
The Sales Entity form opens.

4. Check the Effective Date on the record.
5. If the commission structure is age banded, a new record may need to be created to cover the

current time period.
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6. Otherwise, edit the existing record to include the current time period by changing either the
Effective Date (start) or Expiration Date (end) of the existing record.

7. Save your changes.
For more information about the PEO pricing system and how commissions work, log an Extranet case.

Configured links do not display in form header

Problem: You have configured a custom link, but when you go to a dataform with the configured link,
sometimes it does not display.

Cause: The dataform is a single form and has actually not yet been saved. Because the system
dynamically generates the fields when you open the dataform, it looks like the form is there, when there
is no copy of the form attached to the workspace.

Solution: Make changes and save the form or set the Custom Link to Display when Adding.

Dataform Links require a dataform in which to attach.

Two ways to resolve this:

• Any change that is saved to the dataform causes the page to re-load, which loads the header and
display the links.

• Alternately you can set the link to display on Add by selecting the Display this link when adding
option on the link configuration and saving the change.
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Critical case notifications being received by users not working on the case

Problem: You have departmental manager users that are receiving case notifications for Client Service
Cases in which they are not the Owner or Assigned To.

Cause: There is logic in the system when the priority is Critical to also notify the Admin Role for the
Assigned To Department. For example, the Users in the Benefits Reconciliation and Administration_
Admin role were notified because the Assigned To user is in the Benefits Reconciliation and
Administration Department.

Solution: There is no way to disable Critical Case notifications on a per person or department basis. It is
not recommended to disable them for an entire organization.

CSC Escalation Notices not being sent to escalation users

Problem: A user has been set as the level 1 or level 2 escalation user on a particular Client Service Case
type, but they are not receiving notices, or are receiving them outside of the expected escalation times.

Cause: Misconfiguration

Solution: Several items need to be configured properly for these escalation notices to be delivered to
the appropriate users.

1. The ServiceCaseNotification scheduled process needs to be configured to fire at or less than the
lowest escalation time, otherwise you can create cases with 1 hour escalations but the notifications
will only cue up for the next run of the scheduled process.

2. To be notified, the user needs to be in a role containing the entity biz_ClientServiceCase_Email_
Notifications.

3. Check if the user is in a role containing this entity by going to System Admin > Security >
Roles.

4. Add Search filters for the User Name and the Entity Name of biz_ClientServiceCase_Email_
Notifications.

5. Click Search.
6. If there are no results, remove the Entity Name search parameter and re-search.
7. Edit an appropriate role and Add the biz_ClientServiceCase_Email_Notifications with View rights.
8. Save the record.
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Data will not merge to Presentation tabs on Excel Merge

Problem: You attempt to run an Excel merge and the data appears to be merging to the Data
(CSExport) tab, but none of your formulas or presentation tabs seem to work.

Cause: Server Side Merge does not have rights to Edit document. The older Security Policy Editor
method obtained these rights by default.

Solution: Allow the data to process to the other tabs by clicking Enable Editing at the top of the Excel
document.
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Dataform or Task fields do not enable

Problem: Trying to save changes to an inactive Task or Case, most commonly trying to re-activate
using a Header Link, but the Form remains disabled.

Cause: Form is attached to a disabled workspace.

Solution: If changes to the form are necessary, you must re-activate the workspace to make the
changes.

1. Go to the workspace in question. To find inactive workspaces, from the Clients list, in More, select
All.

2. From the list, select the workspace in question and click Edit.
The Client form opens.

3. At the bottom of the Client form, select the Active option.

4. Save your changes. You will then be able to update your task or Dataform.
5. When completed, determine whether the Workspace should be inactivated and if so, reverse the

steps to activate the workspace.

Delete Role is not working

Problem: The Delete button in Role Admin does not appear to work. You get a confirmation pop-up
and click Yes. The role row disappears from the list, but it is back when you Search.

Cause: If the role being deleted is a Departmental Role (_Member or _Admin), they are System Roles
and are linked to the department.

Solution: You cannot delete roles with _Admin or _Member. These roles are associated with
Departments and the association keeps them from being deleted. If you need to delete the entire
department and associated roles, log an Extranet case. There are possible repercussions when making
this change. Configuring Organization and Workspace Security.
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Duplicate Employee in Dataform list

Problem: Open a Client Workspace and go to Employees and one or more of the employees in the list
appear to have duplicate records.

Cause: Inner Join in List Select statement causing multiple rows to come back due to multiple active
Employment records.

Solution: Inactivate the appropriate Employment record.

To inactivate the appropriate Employment record, you must first understand how the historical
employment records are generated. When a change for an employee job history (employment) record
arrives in the system, the original record is cloned, and then inactivated. The original record is then
updated to reflect the new changes before being saved. This process should leave only one record in
the system with the IsActive flag selected. Sometimes however this process may fail, leaving multiple
employment records marked as IsActive.

The Employee dataform list will erroneously join the employee once to each of these records, resulting
in a list containing seemingly duplicate employees when there is in fact only one employee records and
multiple employment records.

To correct the issue:
1. Open one of the employee records.
2. Using the header link, open each employment record and look at the Administrative fields at the

bottom of the records to find the RecordID.
3. The Employment record with the lowest ID number (oldest record) should remain Active. (IsActive

option should be selected.)
4. All other Employment records for this employee should have the IsActive option cleared to

inactivate them.
5. Remember to Save your changes.
6. As you inactivate these Employment records, you will see the duplicate employee records

eliminated from the list.

Duplicate Employment records in ClientSpace

Problem: In reviewing Employee Information in ClientSpace, it is reported that some employees have
multiple employment records, all but one of which are inactive.

Cause: Employment is a historized form - storing a historical track of Employee job changes.

Solution: During the historize process the current record is cloned when there are changes and then
saved as inactive, then the current record is updated and saved as the IsCurrent record. This is done to
preserve the foreign key relationships between the Employment record and any child records it may
have such as I-9 records. There should only be one active employment record at any given time.
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Error when using Pricing Workflow: "This RFP cannot be submitted because there is a lock on this FEIN."

Problem: You are attempting to move a Client Workspace through the pricing workflow. The
workspace has related companies already in ClientSpace when you receive the error: "This RFP cannot
be submitted because there is a lock on this FEIN."

Cause: Related Client Workspace is locked to prevent accidental duplication of FEIN on unrelated
companies.

Solution: Unlock related Workspace

1. Find the related workspace that is already in Client status and navigate to the Client Master using
Workspace Search.

2. Clear the Locked option and Save the record.
3. Try moving the new workspace through pricing again.
4. The appropriate workspace will be locked during the pricing process.

Field security behaving differently in NEXT

Problem: Security behaves differently in NEXT than it does in Classic in that in Classic users have access
to the fields in a specific fieldset, but in NEXT they do not.

Cause: In Classic, a secured fieldset only needed View rights to edit the fields inside it. In NEXT, the user
needs to be in a role with View and Edit rights.

Solution: Add Edit rights to the Role that includes the fieldset Entity in question.

1. Go to System Admin > Security > Roles.
The Security Roles dashboard opens.

2. Search for Roles with the security entity in question. This should be in the format gen_
DataformName_FieldsetName.

3. Ensure that you update the role selections to include View and Edit as in the example.
4. Save your settings.
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Field value still required on Dataform cloning trigger

Problem: You are attempting to set up a trigger condition for Dataform Cloning using the Empty or
Not Empty options, which should not require a Dataform Field Value, but that field is still required to be
able to save the form.

Cause: Bug in the JavaScript on the page.

Solution: Fill the Dataform field value with a value which is appropriate for the Trigger field and save
the form. The value clears and the Dataform field value marked not required on Save.
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Limited or no access to Workspaces

Problem: You have a user working in the system, but they do not appear to have access to all
workspaces. Some of them don't appear in the Workspace Search list.

Cause: User account is not on the Template Workspace User List.

Solution: Add the user account to the template user list.

To add users to the Workspace list:
Add the User directly to the Workspace. This may be necessary for installations that have lots of
Workspaces, or complex TOC security.

1. Go to System Admin > Workspace Templates.
The Workspace Template Search dashboard opens.

2. Open the workspace template in question.
The template opens.

3. In the Action Center, select More Options > Users.
The list of users that are pre-filtered for this workspace are displayed.

4. Click Add.
The Add Workspace Users form opens.

5. From the list, select the user in question and click Ok.
The user is added to the Workspace Users list.
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Missing Create Prospect link on Organization Header

Problem: The Create Prospect link does not appear on the header of Organizations.

Cause: Missing security

Solution: The Create Prospect link has its own security and logic behind it that determines how it
presents. For this link to be available, the user must have edit rights to the organization, either through
their user or a role in which they are a member being present on the security tab of the organization
with Edit rights to that Org. There is also template logic that determines how the link will react when
selected. If the user has access to a single template, the Create Prospect link will create a workspace
from that template. If the user has access to multiple templates, the Create Prospect link will present the
user with a list of these template workspaces and allow them to choose which one to clone. There are
two security Entities that come into play in the PEO system for displaying and populating the Create
Prospect link: the CRM entity as well as the template_YourTemplateName_member entity.

1. First, the user will either need to be a Global Admin, or be included on the Security tab of the
Organization in question with Edit rights to the Organization (normally either the Sales user that
created the organization or the Admin for that users default department).

2. The user will also need to have the Can Create Workspaces option selected on the user profile.
3. The CRM Entity controls Organization access. To generate workspaces from an Organization, you

will need Edit access to the organization.
4. Workspaces are generated from templates, so to have access to this functionality, the user will need

template member access.
5. The format for template member entities is the template name, bracketed by the words 'template'

and 'member so: 'template_YourTemplateName_member'.
6. Both of these entities should be added to a role in which the user belongs under the Role Admin

dashboard located under System Admin > Roles.

Options missing when you add filters to Ad-Hoc Report

Problem: You are creating an Ad-Hoc report and when you add multiple filters to the report, some of
the filters do not have all of the options that you would expect.

Cause: Filters in the Izenda reporting tool are additive, so if the first filter in say a pricing report selects
only workspaces in the Prospect status, the second filter for Pricing State will be affected - if there are
no Prospects in Georgia, Georgia will not appear as a valid option in the Pricing State filter list.

Solution: If you do not want this behavior to occur, simply move your least restrictive filters to the top
of the filter definition page. In the example above, moving the Pricing State filter above the Status filter
will resolve the issue.
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Organization created via SFDC API Assigned To incorrect user

Problem: Organizations created through the SFDC API are being generated with an AssignedTo user of
Salesforce Service, instead of the appropriate sales user.

Cause: No matching (or blank) Sales user email address in ClientSpace or Salesforce.

Solution: Check the Sales user account email address in ClientSpace and Salesforce. If the values do not
match, update one or both email addresses so they are identical in both systems, then re-run the
Salesforce Sync.

Organization dashboard list crashes on open

Problem: You are attempting to open the Organization Dashboard, but on open, when the list refresh
should happen, no records are returned, and the entire list disappears.

Cause: Timeout issue on the initial load of data into the list. This is caused by too many records being
returned in the default search.

Solution: Reset the default rows per page returned to the list.

1. Go to System Admin > Advanced > App Settings.
The App Settings form opens.

2. Check the Rows per Page setting. It is likely set to a very high number.
3. Reset the Rows per Page to a more reasonable number, we recommend 250.
4. Save the record.
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Payroll statistics getting regenerated causing duplicate statistics for PayPeriods

Problem: When reviewing Client payroll statistics information, you find the PayPeriod amounts are
double, triple or even more times greater than they should be.

Cause: Missing data fields on the Voucher import records, or mis-configured Import Configs cause the
fkPayrollStatisticsID to not get updated, which in turn causes dupe Payroll Statistics records to be
produced.

Solution: The process that generates the Payroll Statistics records and updates the vouchers uses many
concurrent Voucher record fields to tie these records together - these fields include Voucher.State,
Voucher.CompCode,, Voucher.STARTDATE, Voucher.ENDDATE, Voucher.PAYDATE, AND
Voucher.PAYCYCLE. If any of these fields are missing either from the Import Config, or the Voucher
record that is being produced from the payroll system, the Voucher updates will fail. The following
steps will help to determine the cause, and associated resolution for the issue.

1. Go to System Admin > Imports > Manage Import.
2. Examine the Import Configuration for the Voucher files, and make sure that each of the fields:

Voucher.State, Voucher.CompCode, Voucher.STARTDATE, Voucher.ENDDATE, Voucher.PAYDATE,
AND Voucher.PAYCYCLE, are in the configuration. Make note of the appropriate field name from
the voucher file being produced by the payroll system.

3. If any of these fields are missing, update the Import Config to include them by first showing inactive
fields, and re-activating the field for import. If the field is missing, add it to the import configuration.

4. If all of the fields appear on the import configuration, the problem most likely is in the imported file
itself.

5. Check the Voucher file by going to System Admin > Imports > Manage Import.
6. Open the record in question by double-clicking in the list or highlighting the record and selecting

Details.
7. Choose View File and look for each of the above fields, ensure the column names match the import

configuration and that the columns hold data. If they do not, correct the issue.
8. When you are sure the fields are properly named, populated and configured for import, and can see

the fields being filled on the voucher records, create an Extranet case to have the duplicate Payroll
Statistics records removed from your system, and the newly generated records synchronized with
the associated voucher records.

If you are unable to determine the cause, or unable to re-configure your imports, log an Extranet case.
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Pricing Console is not showing external commissions

Problem: There are zeros listed for external commissions in the client pricing console, even though
there is a broker attached to the client.

Cause: The Effective Date of the commission record is set for a date not yet recognized by the system
as it is in the future. This makes the commissions not effective at the current time.

Solution:

1. From the Workspace landing page, at the bottom, select Sales > Commission.
The Commission dashboard opens.

2. Select the appropriate commission record.
3. Change the Effective Date to a date prior to or the current date. Example: Today's date is 5/1/15,

change it to 5/1/15 or an earlier date such as 4/15/15.
4. Save the record.
The system will now recognize the commission record as being effective.
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Pricing cannot be generated because a Pricing Policy cannot be determined for a state

Problem: When creating pricing by using the Add State and Code approach with a contract type set to
use state master, the system displays an error indicating that the pricing policy cannot be determined.

The following message is an example for the state of Texas:

"The Pricing cannot be generated because a Pricing Policy cannot be determined for TX. Please contact
your system administrator."

Cause: The system cannot determine the policy to use since the state is not set to use a default policy
for the selected Comp Model on State Pricing, and the contract type is set to use the state master.

Solution:

1. On the Pricing Console for the workspace, select the state in the State column of the State and
codes section.

2. On the Pricing State console, determine the value in the Comp Model field of the Work Comp
section.

If the Comp Model field contains:

• Master, the system is attempting to use the value from the Default Master Comp Policy field
on the State Master, but that field is empty.

• Client, the system is attempting to use the value from the Default Base Client Policy field on
the State Master, but that field is empty.

• MCP, the system is attempting to use the value from the Default Base MCP Policy field on the
State Master, but that field is empty.

3. Go to System Admin > Administrative Data > State Master.
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4. Select the state.
5. Select an item or add a new item in the Default Master Comp Policy field and Save the record.
The system will now create pricing by using the pricing policy default indicated by the Comp Model and
the state.

Quick Create link displaying on Client Master

Problem: The quick create link (Add Codes) is displaying on the Client Master page in ClientSpace. This
link should be hidden on the Client Master so that codes may only be added through the Pricing
Console.

Cause: Custom Link configuration has been changed to remove the Pinned Open configuration

Solution: Because of the way the links are generated in the right navigation menu, this link needs to be
Pinned Open. The right navigation dynamically generates and displays the list of unpinned links, so the
quick create link that was hidden when the page loads, is dynamically re-added to the page when you
select More. Edit the Custom Link configuration for this link and ensure the Pinned Open option is
selected.

Receive hard error on Pricing Submit: Workers' Comp Below Cost

Problem: You are a Global Admin attempting to submit pricing with deep Workers' Comp discounts,
but the system throws a hard error about the Comp Pricing being below cost.

Cause: There is validation that happens during the submit process to ensure the cost to billing ratio is
not exceeded. In some cases, however, you may want to forgo these validations as you will make up any
losses through another portion of pricing.

Solution: Disable the validation on submit using the Override Validations option on the Pricing Batch
dataform. Select this secured option will allow a Global Admin or administrative user with appropriate
rights to skip the pricing validations for this batch.
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Report is missing columns in Business Intelligence

Problem: You have designed an Ad Hoc report and when you view it in Ad Hoc Reporting it is too wide
for the page, but a scroll bar allows you to access the missing columns. Opening the report in Business
Intelligence however these columns are missing and inaccessible.

Cause: Enable Responsive Design feature is enabled on the report. This feature, introduced in a
version 6.9.0.6 of Izenda reporting makes the report columns responsive to changing page size, such as
on a tablet or mobile device and removes columns from the right side of the report to allow it to fit the
current screen. This will even drop columns on long reports that will not fit within the monitor space.
This feature is enabled by default on reports.

Solution: There are multiple solutions to this issue which you use should be based on how frequently
the report is accessed and in what format

Resize solution: Report is mostly used on a monitor and fits within the screen:

For cases where the report will rarely need to be resized because it is not used by mobile users and fits
nicely into the desktop real estate we recommend changing the zoom level in the browser - this is easy
for the end user to do without having to make changes to the report that would affect all users. To
change the zoom level:

Internet Explorer: Do one of the following:

n Press Ctrl and use the scroll wheel of your mouse or use Ctrl - (Control + Minus or Dash key) to
zoom out

n OR use the Zoom level in the lower right corner of the browser to adjust the zoom to an
appropriate level.

FireFox: Do one of the following:

n Press Ctrl and use the scroll wheel of your mouse or use Ctrl - (Control + Minus or Dash key) to
zoom out.

n OR use the Zoom by going to Settings > Zoom in the upper right of the browser to adjust the
zoom to an appropriate level.

Chrome: Do one of the following:

n Press Ctrl and use the scroll wheel of your mouse or use Ctrl - (Control + Minus or Dash key) to
zoom out.

n OR use the Zoom by going to Settings > Zoom in the upper right of the browser to adjust the
zoom to an appropriate level.

Change Report Settings: Report does not easily fit within the monitor screen area
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When you do not want to constantly resize the report and it is rarely used by mobile applications that
would require responsive design, you can disable this feature on a report by report basis.

1. Open the report in design mode.
2. Click the Style tab of the report.
3. Go to the series of options that affect page visualization.
4. Clear the Enable Responsive Grid option.
5. Save the report.

Scheduled Processes not running, not stuck in running state

Problem: Client calls because their scheduled processes, such as send mail, do not appear to be
running, but they are not hung up in the running state.

Cause: There is a scheduled process on the Virtual Hosting server (Extranet) that kicks off the scheduled
processes on the hosted client sites. If this process hangs up on Extranet, it will never start the client
processes.

Solution:

1. Open the Extranet and go to System Admin > Scheduled Processes.
2. Check the Scheduled Processes to see if the Kickoff Client Processes is stuck in the Running state.
3. If so, edit this process and clear the Running option and click Save.
4. Manually re-run this process by selecting it in the list and clicking Run Process.

SendMail or other Scheduled Process does not appear to be working

Problem: Client calls because a scheduled process they expect to have run (SendMail for example)
does not appear to be working. When you examine the scheduled processes, the one in question has a
last run time and is active. The process also appears to be currently running.

Cause: Sometimes the scheduled processes will hang - they start, but then fail prior to completion. If
this happens, the Running flag that is set at the beginning of the scheduled process never gets reset,
since the system only allows one instance of a running process, it will not restart until the Running flag
is reset.

Solution: Reset the Running flag

1. Manually open the scheduled process and clear the Running option to reset this flag.
2. Save and close the record.
3. Manually run the process using Run Process from the Scheduled Process dashboard.

ClientSpace Setup & Administration © 2025 PrismHR 1049

Chapter 23 Troubleshooting



Terminated user still appears in drop-down lists

Problem: You have an ex-employee who has been terminated, their ClientSpace account de-activated,
but the user name still appears in drop-down lists such as on the Client Team dataform.

Cause: Inactive user is still a Role Member for the role associated with the list.

Solution: Clean up user roles

You can cleanup user roles by removing users from the role or removing roles from the user.

CASE 1: Remove the user from the Role:

1. Find out which role is associated with the user filtered by role (element type) field on the Client
Team dataform by completing the following:
• Go to System Admin > Advanced > Dataform Admin
• Edit the Client Team dataform
• Select Fields in the Action Center.
• Open the field for the role.
• Select the Advanced Settings property. The role is represented by the alphanumeric string

stored in the Advanced Settings field.

2. Copy the info in the Advanced Settings field and go to System Admin > Security > Roles and
find the Role ID that was stored in Advanced Settings.

3. Open the record by clicking Edit or double-clicking the row.
4. Select the Users tab.
5. Select the Show Inactive option and search.
6. You should now be able to highlight and delete the user name from the role list.
CASE 2: Remove the Roles from the User:

1. Open the user profile in question by going to System Admin > Users ~User Profile~ > Roles.
2. Select each of the Roles on this tab and delete them.
3. Save the record.
CASE 3: Edit Advanced Settings and set the "ShowInactiveUsers" parameter to false:

1. Open the field for the role by completing the following:
• Go to System Admin > Advanced > Dataform Admin
• Edit the Client Team dataform
• Select Fields in the Action Center.
• Open the field for the role.
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2. Select the Advanced Settings property.
3. Add the "ShowInactiveUsers":false parameter to the Advanced Settings field and click Save.
4. Save the changes to the field.

Current Year is not available for OSHA Reports

Problem: You attempt to run the OSHA or OSHA 300 report in ClientSpace, but the Year that you need
to run the report for is not available in the filter criteria.

Cause: The current year lookup has not been created yet. These reports utilize a special lookup group
called OSHAYear

Solution: Add the necessary years to the OSHAYear lookup group. See To add values to the new group:
in Configuring lookups.

Third Party Application Key was not found

Problem: Client attempted a third-party login to the Extranet via the ClientSpace Module and receives
the error "The third party application key was not found. Click the button below to login."

Cause: The Third Party Application Key has not been set up properly on either the Client site or the
Extranet

Solution: Log an Extranet case for assistance in configuring the Third Party Application Key.

Unable to Add State or Code to Pricing using Quick Edit

Problem: A ClientSpace user attempted to add a WC state and code to the pricing console prior to
submitting the deal to underwriting and he received an error message - "An error occurred executing
the business rule: Recalculate Pricing."

Cause: Insufficient Rights on the Quick Edit form. This form has required fields that can be secured, if
the user does not have view rights to the fields, they disappear and cause the error.

Solution: Update one of the user roles to have at least View rights to all applicable fields on the Quick
Edit form (Or create a Quick Edit Role). Ensure the user in question is a member of that role.
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Unable to approve Comp Code

Problem: You are attempting to approve pricing and every time you try to clear the Needs Review
option on a Pricing Comp Code, it gets re-selected on Save.

Cause: The Comp Model is not set on the associated Pricing State Master dataform.

Solution: The Comp Model needs to be set on the associated Pricing State of the Pricing Console on
the Workspace that is having problems.

1. To keep this from reoccurring, the Comp Model needs to be changed in the Admin Workspace.
2. Go to the Admin Workspace > State Master and select the state that the comp code is in.
3. Set the Comp Model for the State and Save the record.

Unable to change Contract Type or Legal Entity after Pricing submission

Problem: You have submitted a deal for pricing but realize the Contract Type or Legal Entity listed on
the Client Master is incorrect. When you attempt to edit these fields, even as a Global Admin, they are
read-only.

Cause: Contract Type and Legal Entity settings can factor into pricing, and can change pricing
dramatically, so these fields are locked by design during the submission process.

Solution: Re-price the deal. Re-pricing a deal effectively resets it, unlocking these fields for edit.

Unable to see Activities

Problem: You have a user that is in roles with the CRM Entity, but they still do not see any Activities on
the workspace dataforms.

Cause: Missing Organization Access

Solution: Because Activities are tied to the Organization record, for a user to access those notes they
need not only the CRM entity on one of their user roles, but access to the organizations in question. If
this is a Sales user, this access automatically shows up as they create Organizations and associated
Workspaces. For Non-Sales, internal users, they need to either be added to the security tab of the
Organizations for which they need CRM Note access or added to a role that has CRM Admin access.
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Unable to view or download Organization attachments

Problem: Organization users do not have access to view or download attachments from an ORG

Cause: Affected user does not have access to the CRM Attachments workspace.

Solution: Prior to a workspace being created, any attached items need to be associated with a
workspace, so the system uses the CRM Attachments workspace. Add the affected user to security on
the CRM attachment workspace using the following steps:

1. First, determine the workspace in your installation that is being used as the default Sales
Workspace. This can be found in App Settings.

2. Go to System Admin > Advanced > App Settings > Default Workspaces to find the name of
the default sales workspace.

3. You can provide Workspace access to a single user by opening the user profile under System Admin
| Users | Edit user, selecting the Workspaces tab and choosing Add to search for the default sales
Workspace name and add this workspace to the users Workspace list.

4. Save the user record.

Unintended Case Notifications being sent

Problem: A critical case was logged, and many users were notified who were not on the notifications
list for the case.

Cause: The Business Rule Send Notifications notifies members of the associated Department Admin
role for the Assigned To user when a critical case is created.

Solution: The Send Notifications business rule is core functionality of ClientSpace, which controls all
case notifications. You may want to consider cleaning up the Departmental Admin Roles in ClientSpace
to remove non-essential users. If this does not fit your business model, log an Extranet case to discuss
custom development.
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Users not available when adding Activities to an Organization

Problem: You attempt to configure an activity such as a Calendar event on a ClientSpace Organization,
but the user you would add to the Calendar attendees is not available from the Attendee list

Cause: The user in question does not have access to the CRM Sales Workspace.

Solution: Prior to an Organization having a workspace generated and becoming a Client, the Org does
not have its own related workspace. These pre-workspace organizations will all share a workspace
called CRM Sales Workspace.

To make the users available for activities, you need to add them as users of this workspace:
1. Open the workspace in question.
2. In the Action Center menu, select Users .

The list of users with access to the workspace are displayed.
3. Click Add.

The Add Workspace Users dialog box opens.
4. Select the user and click Ok.
There will be a slight delay while the workspace provides this user access.
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Users not listed in drop-down list

Problem: On the task notification list, not all the users are listed.

Cause: This list shows all users that have access to the Workspace the task is associated with. If the task
is not associated with a workspace, then the task is attached to the CRM Sales Workspace.

Solution: The User needs to be added to the Workspace. There are two ways this can be done.

1. Go to System Admin > Users.
2. Open the user's profile.
3. In the Action Center, click (Workspaces).
4. Add the Workspace to that tab to give access to the workspace.
5. Go to the Workspace, and in the Action Center menu, select Users .
6. Click Add to open a list of users.
7. Select the User and click Ok.

Note: By giving a user access to a Workspace Template, you are giving that user access to all
Workspaces created from that template.

View File does not give the Open option, only Save

Problem: You attempt to click on a linked file to open it, and instead of getting the dialog that allows
you to either Open or Save the file, you only have the option to Save.

Cause: File name to long causing truncation of file extension.

Solution: Check the length of the file name. Extremely long file names can push the file extension past
the field limitations, truncating the file name and dropping the extension.

• If this has happened, save the file with a shorter file name and the proper file extension, then re-
attach the file.

• The Open option will then be available.
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Workflow does not always work appropriately

Problem: Automated business rules can be used to process workflow and sometimes do not work as
expected.

Cause: Business Rule trigger conditions are not being adequately met in the expected order, causing
rules to fire prematurely.

Solution: Understand the workflow involved and review the ordering of rule firing. Business rules fire
on save and always as follows:

• Hard Errors in their listed order - then
• Soft Errors in their listed order - and finally
• Business logic rules in their listed order
If a hard error is preventing a trigger condition for a business logic rule, or business logic rules are
ordered such that trigger conditions are not met, workflow may work, but only intermittently. If you
have questions about the design of your workflow or need help, log an Extranet case.
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Workspace / Organization missing from search

Problem: You attempt to use a search dashboard such as the Client Service Case Search or
Organization Search and the Org/Workspace you are searching for does not appear in the Client Filter
parameter.

Cause: Org / Workspace has been marked as Inactive.

Solution:

• Select the Active option at the bottom of the Org detail page to activate the Org.

• Or, you can select Active in the Workspace settings.
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Workspace search issue

Problem: When we enter a particular client name in the workspace name search field, that workspace
does not show in the drop-down list to select. The search function seems to work correctly for all other
workspaces, but not this particular one. The workspace in question is active.

Cause: Workspaces Associated Organization has been inactivated. The Workspace type ahead search
functions will use the Organization data and will ignore inactivated Orgs.

Solution: Edit the Organization record and make sure the Active option located just below the Org
header is select. If not, select it.
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Organizations or Contact Tasks not automatically attaching to the Sales Workspace

Problem: Organizations or Contact tasks not automatically attaching to the Sales workspace even
though the Default workspace is set under App Settings.

Cause: When you create a task or calendar event from an Org or Contact prior to Creating a workspace
for that Org the tasks will generally get attached to the Sales Workspace designated in the App Settings
page. However, the ClientSpace system allows for multiple workspaces to be designated as CRM
related. When this happens, you are presented with a list of CRM related workspaces on Task Creation.

Solution: Either select the appropriate workspace from the DropDown list, or if there is a workspace
improperly set as "CRM related" then correct this by performing the following steps.

1. Find the Name of the Workspace you need to adjust through the Select Workspace quick jump.
2. Open the Workspace Search dashboard and navigate to that workspace.
3. From the Workspace go to the Workspace Maintenance > Workspace Settings area at the top of

the TOC.
4. Clear the CRM Related option and save the record.

Unable to use Time Tracking - Category field is blank

Problem: You attempt to use Time Tracking on a dataform in your environment, but the Category field
on the Time Tracking record is blank. As this is a required field you are unable to save the record.

Cause: Time Tracker Categories have not yet been configured in your environment

Solution: Configure Time Tracking Categories

To configure Time Tracking categories in your environment:
1. First, check to be sure that all the appropriate Category Groups have been configured for your

environment. Go to System Admin > Lookups.
The Lookups list is displayed.

2. Filter for the Group Time Tracker Category.
3. Review this lookup and If required, add any additional time tracker groups you need.
4. Go to System Admin > Advanced > Time Tracker Categories.
5. To add a category, click Add.

The Time Tracker Categories Details form opens.
6. Provide a Category Name and select an appropriate Category Group.
7. Click Save and continue until all Time Tracker Categories have been configured.
8. Verify your new categories by adding a time tracker record and reviewing the Time Tracker

Categories list.
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Parent-Child relationship between dataforms, but child form link does not appear

Problem: User has added a Parent-Child relationship between two dataforms by Adding a Parent Form
field to the Child dataform. The new field appears to be configured properly, but the Related dataform
drop-down still does not appear on the Parent Form.

Cause: Child form is not a member of the Template Workspace. Both the parent and child dataforms
need to be members of the Template workspace for the relationship to work.

Solution:

1. Go to System Admin > Workspace Templates.
2. Select the Template in question.
3. When on the Template Workspace, in the Action Center menu, select Dataforms .
4. Ensure that both the Parent and Child dataforms are added to this workspace (it is not necessary for

the child form to be on the TOC as it can be accessed through the Parent Form).

Outlook add-in and modules issues
Sometimes the most interesting ClientSpace issues aren't in ClientSpace.

"No HTTP resource was found that matches the request URI"

Problem: When trying to post to ClientSpace, receive an error "No HTTP resource was found that
matches the request URI"

Solution: The workaround solution is to remove the "s" from HTTPS and then add it back.

In your browser settings, ensure that your pop-up blocker is disabled.

To apply the workaround solution:

1. In Settings, in the URL field, remove the "s" from HTTPS.
2. Tab out of the field.
3. Click Post to ClientSpace.

The error displays.
4. In the URL field, add the "s" back to HTTP.
5. Tab out of the field.
6. Click Post to ClientSpace.

The problem should be resolved. If you need additional assistance, please log an Extranet case.
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"Error: pwInternetExplorerRequiredException - Internet Explorer Required" Error when using Create
Case or Task from Outlook Add-in

Problem: A user attempts to create a case or task from the Outlook add in and they receive the error
"Error: pwInternetExplorerRequiredException - Internet Explorer Required". When checked they are on
an appropriate version of Internet Explorer and the browser settings appear correct.

Cause: Microsoft will often push changes to Internet Explorer through Windows updates that can cause
unexpected behavior in the browser.

Solution: Update to the latest version of the browser and check to ensure the update did not overwrite
any of the browser configuration settings. This error is most commonly caused by the compatibility
mode settings getting changed.

Additional considerations for Internet Explorer 10+: With Internet Explorer 10 and up, Microsoft made
some major changes to the way the browser handles JavaScript and other web technologies, which can
cause unexpected behavior in the application. To avoid these issues, you should set your browser to use
compatibility mode for the ClientSpace application.

Set Compatibility mode through the following steps:
1. Open Internet Explorer and go to your ClientSpace login page – some users have reported that the

login page does not load under I.E. 10, that is OK, we just need to get the URL from the browsers
address bar.

2. Select the domain portion of the URL. In the example this would be clientspace.net, your install may
be different.

3. In Internet Explorer, go to the tools menu:
• If you do not have an Option for Tools, right-click the top of your browser and ensure the Menu

Bar is selected.
• Then go to Tools > Compatibility View Settings.
• Add the domain portion of the URL that you just selected into the Add this website: field (this

defaults in some cases) and click Add. This will set the browser to use compatibility mode for
any page where the URL ends in that domain (in our example, clientspace.net).

ClientSpace Setup & Administration © 2025 PrismHR 1061

Chapter 23 Troubleshooting



4. Save your settings, and you are done.
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"null" Error when using ClientSpace Outlook add-in

Problem: You open Outlook and log into ClientSpace using the outlook add in, but when you attempt
to Create a case or task you receive an error that simply says "null".

Cause: Older versions of the Outlook Add-In allowed you to store an invalid URL configuration which
contained a trailing slash (https://your.clientspace.net/). This has been corrected with later versions of
the application which strip the trailing slash from the URL on save.

Solution: Remove the trailing slash from the URL by logging out and logging back in to the ClientSpace
Outlook Add-In.**

** A best practice would be to uninstall the Outlook Add-In and re-install it from the latest version that
can be found in the Admin Workspace in ClientSpace. For Instructions to uninstall / re-install the add-
in, see Email add-in for Outlook.

404 Error: File or Directory not found when attaching files from Outlook

Problem: You attempt to attach a file using the Outlook Add-In and you receive the error "Server Error:
404 - File or directory not found. The resource you are looking for might have been removed, had its
name changed, or is temporarily unavailable.

Cause: You have exceeded the maximum file size for attaching through the Outlook Add-in.

Solution: The maximum file size for the Outlook Add-in is 5mb, however you can upload up to a 20mb
file through the ClientSpace UI. Try zipping the file to make it smaller then uploading from Outlook, or
open ClientSpace and manually attach the file in the UI.

This error also occurs if the File attachment size (20 mb) is exceeded anywhere within the application.
Try zipping or reducing the file below the 20mb limit to resolve this issue.
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Cannot attach from Outlook add-in

Problem: Unable to attach email or emails with attachments from Outlook Add-In. No error message is
given, you connect to ClientSpace from the add-in and select a dataform/Workspace, but the
attachment never happens.

Cause: Conflicting outlook plugin is causing part of the process (normally the pop-ups for selecting a
contact / confirmation message).

Solution:

1. In Outlook, go to File > Options > Add-ins > Manage COM Add-ins and click Go.
2. In the dialog that opens clear all non-Microsoft Add-ins (other than the ClientSpace Add-in) that

are enabled, making note of which add-ins you disable.
3. Save your changes and return to Outlook
4. Try attaching a document to ClientSpace.
5. Open ClientSpace and verify the attachment function worked correctly.
6. If you are now able to attach into ClientSpace, one of the other Outlook Add-ins is conflicting with

the ClientSpace Add-in. Reverse the process of disabling add-ins one at a time, enabling an add-in,
saving the setting, and attempting to attach to ClientSpace.

7. When you find a conflicting add-in make which stops the attachment process, make note of this,
disable it again and continue re-enabling the other add-ins and testing, as there may be several
that have conflicts.

8. When you have a list of conflicting add-ins, contact your local IT department, and discuss the issue.
They may be able to help by either removing the conflicting add-ins or configuring them in such a
way that they no longer conflict with the ClientSpace Outlook Add-in.

Contact is defaulted on attaching from Outlook

Problem: When a client is trying to attach an email from the Outlook add-in, Outlook does not prompt
to select the associated contact. Instead, the Contact is defaulted to an apparently random contact in
the system.

Cause: One of the email addresses on the email is incorrectly associated with a contact record in
ClientSpace. This was most likely caused by a user input mistake.

Solution: Update incorrect email address on contact.

1. Find the contact that is being selected in the system using the Contacts Module.
2. Replace the incorrect email address on the contact with the appropriate email address for the

contact.
3. The Outlook add-in should now correctly search for related contacts when attaching an email to

ClientSpace, providing a list of contacts, or prompting the user to select a contact.
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Edit Case or Task missing from Outlook button bar

Problem: For some ClientSpace emails the Edit Case or Edit Task button appears to be missing when
using the Outlook Add-In.

Cause: Email Header information has been stripped off - likely by the Clients Network security. The
Outlook add-in reads the emails header information to determine if the email has links to an editable
element in ClientSpace such as a task or case.

Solution: Check the header information for the email in question:

1. In Outlook, open the email in a separate window by double clicking the email in the Inbox list.
2. Go to File > Info > Properties and look at the Internet Headers section.

This section should contain information about the ClientSpace element that produced the email. It
is possible that a firewall or some other Network Security device has removed this header
information. If this area has been stripped of information, contact your local IT department to see if
it is possible to remove these restrictions.
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Edit linked document functionality missing from Outlook add-in

Problem: Previously, when opening an email in Outlook, there was an option to edit the case. That
option seems to be missing on some emails.

Cause: Firewall / Antivirus settings are stripping email header information. The URL link used by the edit
functionality is stored in the header information of the email itself. Certain Firewall and / or
antivirus/malware systems can strip this information from the email, removing the remote edit
functionality in the Outlook Add-in. Check this by opening the email in a separate window (pop-out in
MS Outlook), then go to File Properties to see the Internet headers information. If this is missing or has
replaced by a message such as "Removed by Symantec Firewall", the ClientSpace domain needs to be
authorized.

Solution: Contact your Network security administrator about the problem. They may be able to add the
pertinent ClientSpace domain to your Network security unrestricted list, thereby allowing the header
information from ClientSpace to remain on the emails.

Error: 'The MS Interop assemblies are not installed, unable to continue installation.'

Problem: You are attempting to install the Outlook Add-in for ClientSpace when the installer fails with
the error 'The MS Interop assemblies are not installed, unable to continue installation.'

Cause: Insufficient rights on the installing account. The Installer needs complete access to the Windows
system registry, attempting to install with a non-administrator account on the machine can cause the
install to fail.

Solution: Re-install the Outlook add-in using an account with Administrator access on the machine.

1. Check the version of Outlook on the machine where you would like to install the Add-in.
2. Download the appropriate version of the installer to the local machine.
3. Run the setup.exe file by right clicking the file and choosing Run as Administrator.
4. Follow the installer step-by-step to complete the installation.
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Outlook add-in disables each time Outlook restarts

Problem: Each time the user opens Outlook, the ClientSpace Outlook Add-In is disabled.

Cause: Insufficient rights when running Outlook client

Solution: Run Outlook as administrator

1. Find the icon used to start Outlook, either on the desktop, Windows Taskbar, or the program menu.
2. Right-click the icon and go to Properties > Compatibility > and select Run this program as

Administrator.

3. Save the changes.
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Outlook add-in disables on Outlook close

Problem: When you open Outlook the ClientSpace add-in is disabled. You can re-enable the add-in
using the steps Outlined here but when you close Outlook, the add-in is disabled again.

Cause: Outlook must be run with administrative privileges.

Solution:

1. Close any instances of Outlook
2. Find the shortcut icon used to open Outlook.
3. Right-click the icon and choose Properties > Shortcut > Advanced and select Run as

Administrator.
4. Save your changes.
5. Re-open Outlook.
6. If the Add-in is not enabled, enable it.
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Outlook add-in error: "fnShow: Access Denied"

Problem: You attempt to use the Outlook Add-In to connect to ClientSpace and perform an action,
such as creating a case. The Client Service Case detail form is presented, but when you try to select a
Category (or any other lookup) you received the error: "fnShow: Access Denied" and cannot proceed
further.

Cause: Internet Explorer setting is causing windows to default to the 64-bit version of IE when open the
browser from the add-in.

Solution: Update Internet Explorer settings to disable "Protected Mode"

1. Close Outlook on the affected machine.
2. Go to Internet Options, either through the control panel or by accessing in IE through Tools >

Internet Options.
3. Go to the Security tab
4. Clear Enable Protected Mode and click OK to save you settings. This will require a re-start of

Internet Explorer.
5. Close all instances of Internet Explorer.
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6. Open Outlook and log in to the ClientSpace Outlook Add-In.
Your local IT administrator may have locked these settings down on your machine for security
purposes. If you are unable to change these settings, your IT admin will need to perform these actions
as an administrator of the machine. More information on this issue may be found in the following
Microsoft Article: https://support.microsoft.com/en-us/help/2864914/enhanced-protected-mode-add-
on-compatibility

Outlook add-in error: "Object doesn't support this property or method"

Problem: While attempting to use the Outlook add-in you click the action button (Create Task, create
case etc...) and you receive the error "Object doesn't support this property or method" you are
prompted for whether to continue to run scripts on the page. Regardless of what answer you provide,
canceling the error shows a blank gray screen and the word "Loading..."

Cause: The ClientSpace site is no longer in the list of sites for which pop-ups are allowed - this
commonly happens after a Windows Update.

Solution: Add the ClientSpace site domain to the list of allowed sites for pop-ups.

In Internet Explorer:
1. Go to Tools > Pop-Up Blocker > Pop-up Blocker Settings.
2. Add the appropriate domain of the URL (for example, clientspace.net) to the list of allowed sites.

You can find this domain at the end of the ClientSpace URL.
3. Save your settings.
4. Close and open Outlook.

Outlook add-in error: "Your cached credentials are bad."

Problem: Unable to login to ClientSpace using the Outlook Add-In. When the user attempts to login
they receive the error "Your cached credentials are bad". Uninstalling and re-installing, then re-entering
the user's credentials does not resolve the issue.

Cause: Login credentials that are cached on the machine do not match the current username/password
in ClientSpace. This should be removed and reset with an Uninstall/Reinstall, but in some cases it does
not.

Solution:

1. Try having a different ClientSpace user log in to the Outlook add-in on the affected machine using
their credentials.

2. Then log out and log back in as the affected user.
3. This will sometimes force the cached credentials to be reset. If this does not resolve the issue, log an

Extranet case for support.
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Outlook add-in keeps inactivating

Problem: Outlook software disables the ClientSpace add-in whenever Outlook is closed and reopened.

Cause: Installation defaults to "everyone" during the install process, but there is a security setting on
the machine policy that prevents the logged in user from accessing non-profile specific data.

Solution:

1. Uninstall and re-install the Outlook add-in.
2. Select the option for Just Me, which should install the app with the proper rights.

Outlook add-in will not enable

Problem: Outlook add-in appears to be installed properly, but the Kandu Icon does not appear in the
Ribbon bar and no functionality is available.

Cause: Add-in is disabled

Solution: Re-Install the appropriate Outlook Add-in module

1. Uninstall the Outlook Add-in through the Add/Remove programs control panel in Windows.
2. Re-install the appropriate Add-in for the Outlook version - x86 (32 bit) or x64 (64 bit).
3. Open Outlook.
4. Go to File > Add Ins.
5. At the bottom of the screen select Disabled -Items.
6. When the Disabled window opens, select ClientSpace Add-in and click Enable.
7. ClientSpace Add-in will disappear from the Disabled window.
8. Choose Com Add-Ins from the bottom left and click Go.
9. Select the Enable box and Save.
10. Log the user into ClientSpace.
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PDF active report displays "Garbage" characters instead of report data

Problem: You run an Active Report which outputs to PDF, but when the report opens you find a page
full of unreadable "garbage" characters instead of the report data.

Issue 1
Cause: An unreadable or missing font has been used in the report that Adobe Acrobat is unable to
process. Acrobat provides you the ability to add fonts to the application from your local desktop. If
these fonts aren't included in the report set, when the report tries to open the application cannot
display the information and the data becomes garbled.

Solution: Create a support ticket with PrismHR. We may need to edit the Active report to use a more
generic font and re-save the report.

Issue 2

Cause: The Active Reports PDF print functionality does not react well when the ClientSpace web
environment is extremely active while running large PDF reports. A bad interaction between the Active
Reports PDF distiller application and the ClientSpace Web Application pool can cause the PDF Distiller
to generate these types of "Garbage" reports

Solution: Create a support ticket with PrismHR. Recycling the Application pool on your site manually
will often resolve these intermittent issues.

Persistent PDF Issues
On very rare occasions the number of users / report interactions on an install can cause the bad
interaction between the PDF Distiller application and the ClientSpace Web application pool to occur
frequently. In these instances, it may be necessary to schedule a more frequent recycle of the
ClientSpace application pool for your site. Create a support ticket with PrismHR. For assistance in
determining if this additional step is necessary, log an Extranet case.
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Script error when attaching email from Outlook

Problem: User receives a script error when typing in the Workspace field when trying to Attach Email
from the Outlook Add-in.

Cause: There is a slash after the URL stored on the ClientSpace login page.

Solution: Log out of the Outlook Add-in. When logging back in, remove the slash from the end of the
URL.***

**Current versions of the Outlook add-in resolve this issue by stripping the trailing slash from the URL
when saving the login information. A best practice would be to uninstall and re-install from the latest
version on the Admin Workspace.

Error messages: ClientSpace and PrismHRAPI
When ClientSpace cannot communicate with the PrismHR API, an error message is displayed:
"Unfortunately, the service is currently unavailable. Please try again later. [Message ID: {Error Code}]"

Use the following table for the Error Code and its meaning.

Error Code Meaning Message

Error [10002] (no "peo_id" or auth "key"
in querystring)

"Unable to validate User in ClientSpace, insufficient
credentials provided. Please contact your ClientSpace
Administrator."

Error [10003] (no AppCode matching
PEOID)

"Unable to validate User in ClientSpace for PeoID '{0}'.
Please contact your ClientSpace Administrator."
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Error Code Meaning Message

Error [10004] (could not retrieve
APIConfig by AppCode)

"Unable to connect to obtain an API Configuration for
validation. Please contact your ClientSpace
Administrator."

Error [10005] (could not obtain a
LoginClient via APIConfig
endpoint)

"Unable to connect to obtain a PrismHR Login Client for
validation. Please contact your ClientSpace
Administrator."

Error [10006] (could not obtain a
LoginResponse object)

"Unable to connect to PrismHR for validation. Please
contact your ClientSpace Administrator."

Error [10007] (obtained a LoginResponse
but the errorCode != 0, bad
login to PrismHR)

"Unable to log in to PrismHR, Error = '{0}'. Please contact
your ClientSpace Administrator and report this error."

Error [10008] (successful LoginResponse
from PrismHR but did not
contain a
PrismHRSessionID)

"Unable to obtain a valid Session from PrismHR. Please
contact your ClientSpace Administrator."

Error [10009] (no SignOnResponse when
validating Token)

"Unable to validate this User's Authentication Key, no
response from PrismHR. Please contact the System
Administrator of the system from which you are trying to
log in."

Error [10010] (obtained a
SignOnResponse but the
errorCode != 0, invalid
Token)

"Unable to validate User in PrismHR, Error = '{0}'. Please
contact your ClientSpace Administrator and report this
error."

Error [10011] (not a valid TPA user) "This User or your Server is not configured for Single
Sign On in ClientSpace. Please contact your ClientSpace
Administrator."

Error [10012] (Exception, loglevel2, bad
endpoint)

"Unable to validate User in ClientSpace, a severe error
occurred during processing. Please contact your
ClientSpace Administrator and report error '{0}'"
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Error Code Meaning Message

Error [10013] (Exception, loglevel1, bad
endpoint)

"Unable to validate User in ClientSpace, a severe error
occurred during processing. Please contact your
ClientSpace Administrator and report error '{0}'"

Error [10014] (Exception, but no
APIConfig available)

"Unable to validate User in ClientSpace, a severe error
occurred during processing (no API Configuration form).
Please contact your ClientSpace Administrator."

Error [10015] (ProcessTrustedLogin
failed)

"Unable to log in to ClientSpace. Please contact your
ClientSpace Administrator."

Error messages: ClientSpace and PrismHRAPI Staffing
Placement Refresh
When ClientSpace cannot communicate with the PrismHR API while using the “Refresh Placement List”
functionality, an error message is displayed: "Unable to retrieve list (Error Code: {Error Code}). Please
contact your ClientSpace Administrator."

Use the following table for the Error Code and its meaning.

Error Code Meaning Message

Error [900] (no "peo_id" in querystring and no
“Secondary ID" found on “PRISMHRAPI”
APIConfig)

Unable to retrieve list (Error Code: 900).
Please contact your ClientSpace
Administrator.

Error [901] (could not retrieve APIConfig by AppCode) Unable to retrieve list (Error Code: 901).
Please contact your ClientSpace
Administrator.

Error [902] (could not obtain a LoginResponse via
APIConfig endpoint)

Unable to retrieve list (Error Code: 902).
Please contact your ClientSpace
Administrator.

Error [903] (obtained a LoginResponse but no
PlacementList returned via clientID &
employeeID)

Unable to retrieve list (Error Code: 903).
Please contact your ClientSpace
Administrator.
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Error Code Meaning Message

Error [904] (obtained PlacementListXml but no
PlacementListResponse node)

Unable to retrieve list (Error Code: 904).
Please contact your ClientSpace
Administrator.

Error [905] (no "peo_id" in querystring and no
“Secondary ID" found on “PRISMHRAPI”
APIConfig)

Unable to retrieve list item (Error Code:
905). Please contact your ClientSpace
Administrator.

Error [906] (could not retrieve APIConfig by AppCode) Unable to retrieve list item (Error Code:
906). Please contact your ClientSpace
Administrator.

Error [907] (could not obtain a LoginResponse via
APIConfig endpoint)

Unable to retrieve list item (Error Code:
907). Please contact your ClientSpace
Administrator.

Error [908] (obtained a LoginResponse but no
Placement returned via vendorID,
staffingClient, placementID)

Unable to retrieve list item (Error Code:
908). Please contact your ClientSpace
Administrator.

Error [909] (obtained PlacementXml but no
PlacementResponse node)

Unable to retrieve list item (Error Code:
909). Please contact your ClientSpace
Administrator.

Related Topics:

l Refreshing the Staffing Placement List
l Staffing Placement dataform

Clearing the browser cache in Internet Explorer
Internet Explorer often saves or caches copies of frequently visited pages. This is one way the browser
can speed up your Internet experience. However, this caching can cause issues if it saves a bad version
of a page. Learning to clear the browser cache helps remove these pages and forces your browser to
get the latest version of a page, which can clear up some basic Internet issues.

To clear the browser cache in Internet Explorer:
1. Open Internet Explorer.
2. Go to Tools > Internet Options.

The Internet Options dialog box opens.
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3. In the General tab, in Browsing history, select Delete.
The Delete Browsing History dialog box opens.

4. Select (at a minimum) the Temporary Internet files and website files and Cookies and website
data.

5. Click Delete.
You are returned to the main Internet Options dialog box.

6. Click OK.
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